Cristina Bachmann, Heiko Bischoff, Marion Bröer, Sabine Pfeifer, Heike Schilling

Thanks to: Ashley Shepherd

The information in this document is subject to change without notice and does not represent a commitment on the part of Steinberg Media Technologies GmbH. The software described by this document is subject to a License Agreement and may not be copied to other media except as specifically allowed in the License Agreement. No part of this publication may be copied, reproduced, or otherwise transmitted or recorded, for any purpose, without prior written permission by Steinberg Media Technologies GmbH. Registered licensees of the product described herein may print one copy of this document for their personal use.

All product and company names are ™ or ® trademarks of their respective owners. Windows 7 is a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. The Mac logo is a trademark used under license. Macintosh and Power Macintosh are registered trademarks. MP3SURROUND and the MP3SURROUND logo are registered trademarks of Thomson SA, registered in the US and other countries, and are used under license from Thomson Licensing SAS.

Release Date: December 16, 2010


All rights reserved.
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>117</td>
<td>Fades, crossfades and envelopes</td>
</tr>
<tr>
<td>118</td>
<td>Creating fades</td>
</tr>
<tr>
<td>120</td>
<td>The Fade dialogs</td>
</tr>
<tr>
<td>121</td>
<td>Creating crossfades</td>
</tr>
<tr>
<td>121</td>
<td>The Crossfade dialog</td>
</tr>
<tr>
<td>122</td>
<td>Auto fades and crossfades</td>
</tr>
<tr>
<td>123</td>
<td>Event envelopes</td>
</tr>
<tr>
<td>124</td>
<td>The arranger track</td>
</tr>
<tr>
<td>125</td>
<td>Introduction</td>
</tr>
<tr>
<td>125</td>
<td>Setting up the arranger track</td>
</tr>
<tr>
<td>126</td>
<td>Working with arranger events</td>
</tr>
<tr>
<td>128</td>
<td>Flattening the arranger chain</td>
</tr>
<tr>
<td>129</td>
<td>Live mode</td>
</tr>
<tr>
<td>130</td>
<td>Arranging your music to video</td>
</tr>
<tr>
<td>131</td>
<td>The transpose functions</td>
</tr>
<tr>
<td>132</td>
<td>Introduction</td>
</tr>
<tr>
<td>132</td>
<td>Transposing your music</td>
</tr>
<tr>
<td>135</td>
<td>Other functions</td>
</tr>
<tr>
<td>138</td>
<td>Using markers</td>
</tr>
<tr>
<td>139</td>
<td>Introduction</td>
</tr>
<tr>
<td>139</td>
<td>The Marker window</td>
</tr>
<tr>
<td>141</td>
<td>The marker track</td>
</tr>
<tr>
<td>143</td>
<td>Marker key commands</td>
</tr>
<tr>
<td>143</td>
<td>Exporting and importing markers</td>
</tr>
<tr>
<td>145</td>
<td>The Mixer</td>
</tr>
<tr>
<td>146</td>
<td>Overview</td>
</tr>
<tr>
<td>148</td>
<td>Configuring the Mixer</td>
</tr>
<tr>
<td>152</td>
<td>Basic mixing procedures</td>
</tr>
<tr>
<td>155</td>
<td>Audio-specific procedures</td>
</tr>
<tr>
<td>164</td>
<td>Routing</td>
</tr>
<tr>
<td>166</td>
<td>MIDI-specific procedures</td>
</tr>
<tr>
<td>167</td>
<td>Utilities</td>
</tr>
<tr>
<td>169</td>
<td>VST Mixer Diagrams</td>
</tr>
<tr>
<td>172</td>
<td>Control Room (Cubase only)</td>
</tr>
<tr>
<td>173</td>
<td>Virtual Control Room – The concept</td>
</tr>
<tr>
<td>173</td>
<td>Configuring the Control Room</td>
</tr>
<tr>
<td>177</td>
<td>The Control Room Mixer</td>
</tr>
<tr>
<td>182</td>
<td>Studios and Studio Sends</td>
</tr>
<tr>
<td>185</td>
<td>The Control Room Overview</td>
</tr>
<tr>
<td>186</td>
<td>Direct Monitoring and latency</td>
</tr>
<tr>
<td>187</td>
<td>Audio effects</td>
</tr>
<tr>
<td>188</td>
<td>About this chapter</td>
</tr>
<tr>
<td>188</td>
<td>Overview</td>
</tr>
<tr>
<td>189</td>
<td>Insert effects</td>
</tr>
<tr>
<td>194</td>
<td>Send effects</td>
</tr>
<tr>
<td>198</td>
<td>Using the side-chain input</td>
</tr>
<tr>
<td>200</td>
<td>Using external effects</td>
</tr>
<tr>
<td>200</td>
<td>Editing effects</td>
</tr>
<tr>
<td>200</td>
<td>Effect presets</td>
</tr>
<tr>
<td>203</td>
<td>Installing and managing effect plug-ins</td>
</tr>
<tr>
<td>206</td>
<td>VST instruments and instrument tracks</td>
</tr>
<tr>
<td>207</td>
<td>Introduction</td>
</tr>
<tr>
<td>207</td>
<td>VST instrument channels vs. instrument tracks</td>
</tr>
<tr>
<td>207</td>
<td>VST instrument channels</td>
</tr>
<tr>
<td>209</td>
<td>Instrument tracks</td>
</tr>
<tr>
<td>211</td>
<td>What do I need? Instrument channel or instrument track?</td>
</tr>
<tr>
<td>211</td>
<td>Instrument Freeze</td>
</tr>
<tr>
<td>212</td>
<td>VST instruments and processor load</td>
</tr>
<tr>
<td>212</td>
<td>Using presets for VSTi configuration</td>
</tr>
<tr>
<td>215</td>
<td>About latency</td>
</tr>
<tr>
<td>216</td>
<td>External instruments (Cubase only)</td>
</tr>
<tr>
<td>217</td>
<td>Surround sound (Cubase only)</td>
</tr>
<tr>
<td>218</td>
<td>Introduction</td>
</tr>
<tr>
<td>219</td>
<td>Preparations</td>
</tr>
<tr>
<td>220</td>
<td>Using the SurroundPanner V5</td>
</tr>
<tr>
<td>226</td>
<td>Exporting a surround mix</td>
</tr>
<tr>
<td>227</td>
<td>Automation</td>
</tr>
<tr>
<td>228</td>
<td>Introduction</td>
</tr>
<tr>
<td>228</td>
<td>Working with automation curves</td>
</tr>
<tr>
<td>228</td>
<td>Enabling and disabling the writing of automation data</td>
</tr>
<tr>
<td>229</td>
<td>Writing automation data</td>
</tr>
<tr>
<td>230</td>
<td>Editing automation events</td>
</tr>
<tr>
<td>232</td>
<td>Automation track operations</td>
</tr>
<tr>
<td>235</td>
<td>The Automation panel (Cubase only)</td>
</tr>
<tr>
<td>241</td>
<td>Automation Preferences</td>
</tr>
<tr>
<td>241</td>
<td>MIDI controller automation</td>
</tr>
</tbody>
</table>
244 Audio processing and functions
245 Background
245 Audio processing
253 Applying plug-ins (Cubase only)
254 The Offline Process History dialog
255 Freeze Edits
256 Detect Silence
257 The Spectrum Analyzer
259 Statistics
259 About time stretch and pitch shift algorithms

261 The Sample Editor
262 Window overview
266 General functions
272 Warping audio
276 Working with hitpoints and slices
281 VariAudio (Cubase only)
292 Flattening realtime processing

294 The Audio Part Editor
295 Background
295 Opening the Audio Part Editor
296 Operations
298 Options and Settings

299 The Pool
300 Background
300 Window overview
302 Operations

311 The MediaBay
312 Introduction
313 Working with the MediaBay
314 The Define Locations section
315 The Locations section
316 The Results list
318 Previewing files
321 The Filters section
323 The Attribute Inspector
327 The Loop Browser, Sound Browser, and Mini Browser windows
327 Preferences
328 Key commands
328 Working with MediaBay-related windows
329 Working with Volume databases

331 Working with track presets
332 Introduction
332 Types of track presets
333 Applying track presets
335 Creating a track preset
336 Creating tracks from track presets or VST presets

337 Track Quick Controls
338 Introduction
338 Assigning parameters to quick controls
339 Connecting quick controls with remote controllers
340 Quick controls and automatable parameters

342 Remote controlling Cubase
343 Introduction
343 Setting Up
344 Operations
345 The Generic Remote device
347 Track Quick Controls
347 Apple Remote (Macintosh only)

348 MIDI realtime parameters and effects
349 Introduction
349 The Inspector – general handling
349 The Inspector sections
353 MIDI effects
355 Managing plug-ins

356 Using MIDI devices
357 Background
357 MIDI devices – general settings and patch handling
362 About Device panels (Cubase only)
364 About Studio Connections

366 MIDI processing
367 Introduction
368 Making your settings permanent
369 Dissolve Part
370 Bounce MIDI
370 Repeat Loop
371 Other MIDI functions
Table of Contents

509 Video
510 Introduction
510 Before you start
511 Preparing a video project in Cubase
513 Video files in the Project window
514 Playing back video
516 Editing video
516 Extracting audio from a video file
516 Replacing the audio in a video file

517 ReWire
518 Introduction
519 Launching and quitting
519 Activating ReWire channels
519 Using the transport and tempo controls
520 How the ReWire channels are handled in Cubase
520 Routing MIDI via ReWire2
520 Considerations and limitations

521 File handling
522 Importing audio
525 Exporting and importing OMF files (Cubase only)
527 Exporting and importing standard MIDI files
529 Exporting and importing MIDI loops
529 Exporting and importing track archives (Cubase only)

531 Customizing
532 Background
532 Workspaces
534 Using the Setup options
535 Customizing track controls
536 Appearance
537 Applying colors in the Project window
539 Where are the settings stored?

541 Key commands
542 Introduction
542 Setting up key commands
545 Setting up tool modifier keys
546 The default key commands

550 Part II: Score layout and printing (Cubase only)

551 How the Score Editor works
552 About this chapter
552 Welcome!
552 How the Score Editor operates
552 MIDI notes vs. score notes
553 Display Quantize
555 Entering notes by hand vs. recording notes

556 The basics
557 About this chapter
557 Preparations
557 Opening the Score Editor
557 The project cursor
557 Playing back and recording
558 Page Mode
558 Changing the zoom factor
559 The active staff
559 Making page setup settings
559 Designing your work space
561 About the Score Editor context menus
561 About dialogs in the Score Editor
562 Setting clef, key, and time signature
565 Transposing instruments
566 Printing from the Score Editor
566 Exporting pages as image files
567 Working order
567 Force update

568 Transcribing MIDI recordings
569 About this chapter
569 About transcription
569 Getting the parts ready
569 Preparing parts for score printout
570 Staff settings
570 Situations which require additional techniques
571 Inserting Display Quantize changes
572 The Explode function
572 Using “Scores Notes To MIDI”
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>573</td>
<td>Entering and editing notes</td>
</tr>
<tr>
<td>574</td>
<td>About this chapter</td>
</tr>
<tr>
<td>574</td>
<td>Score settings</td>
</tr>
<tr>
<td>575</td>
<td>Note values and positions</td>
</tr>
<tr>
<td>576</td>
<td>Adding and editing notes</td>
</tr>
<tr>
<td>578</td>
<td>Selecting notes</td>
</tr>
<tr>
<td>579</td>
<td>Moving notes</td>
</tr>
<tr>
<td>580</td>
<td>Duplicating notes</td>
</tr>
<tr>
<td>580</td>
<td>Cut, copy, and paste</td>
</tr>
<tr>
<td>581</td>
<td>Editing pitches of individual notes</td>
</tr>
<tr>
<td>582</td>
<td>Changing the length of notes</td>
</tr>
<tr>
<td>582</td>
<td>Splitting a note in two</td>
</tr>
<tr>
<td>583</td>
<td>Working with the Display Quantize tool</td>
</tr>
<tr>
<td>583</td>
<td>Split (piano) staves</td>
</tr>
<tr>
<td>583</td>
<td>Strategies: Multiple staves</td>
</tr>
<tr>
<td>584</td>
<td>Inserting and editing clefs, keys, or time signatures</td>
</tr>
<tr>
<td>585</td>
<td>Deleting notes</td>
</tr>
<tr>
<td>586</td>
<td>Staff settings</td>
</tr>
<tr>
<td>587</td>
<td>About this chapter</td>
</tr>
<tr>
<td>587</td>
<td>Staff settings</td>
</tr>
<tr>
<td>587</td>
<td>Making settings</td>
</tr>
<tr>
<td>587</td>
<td>Working with staff presets</td>
</tr>
<tr>
<td>588</td>
<td>Staff names</td>
</tr>
<tr>
<td>588</td>
<td>Key and clef</td>
</tr>
<tr>
<td>588</td>
<td>Display Quantize and Interpretation Options</td>
</tr>
<tr>
<td>591</td>
<td>Display Transpose</td>
</tr>
<tr>
<td>591</td>
<td>The Options tab</td>
</tr>
<tr>
<td>592</td>
<td>The Polyphonic tab</td>
</tr>
<tr>
<td>592</td>
<td>The Tablature tab</td>
</tr>
<tr>
<td>593</td>
<td>Polyphonic voicing</td>
</tr>
<tr>
<td>594</td>
<td>About this chapter</td>
</tr>
<tr>
<td>594</td>
<td>Background: Polyphonic voicing</td>
</tr>
<tr>
<td>595</td>
<td>Setting up the voices</td>
</tr>
<tr>
<td>597</td>
<td>Strategies: How many voices do I need?</td>
</tr>
<tr>
<td>597</td>
<td>Entering notes into voices</td>
</tr>
<tr>
<td>597</td>
<td>Checking which voice a note belongs to</td>
</tr>
<tr>
<td>598</td>
<td>Moving notes between voices</td>
</tr>
<tr>
<td>599</td>
<td>Handling rests</td>
</tr>
<tr>
<td>599</td>
<td>Voices and Display Quantize</td>
</tr>
<tr>
<td>600</td>
<td>Creating crossed voicings</td>
</tr>
<tr>
<td>601</td>
<td>Automatic polyphonic voicing – Merge All Staves</td>
</tr>
<tr>
<td>602</td>
<td>Converting voices to tracks – Extract Voices</td>
</tr>
<tr>
<td>603</td>
<td>Additional note and rest formatting</td>
</tr>
<tr>
<td>604</td>
<td>About this chapter</td>
</tr>
<tr>
<td>604</td>
<td>Background: Note stems</td>
</tr>
<tr>
<td>604</td>
<td>Setting stem direction</td>
</tr>
<tr>
<td>605</td>
<td>Stem length</td>
</tr>
<tr>
<td>606</td>
<td>Accidentals and enharmonic shift</td>
</tr>
<tr>
<td>606</td>
<td>Changing the note head shape</td>
</tr>
<tr>
<td>607</td>
<td>Other note details</td>
</tr>
<tr>
<td>608</td>
<td>Coloring notes</td>
</tr>
<tr>
<td>608</td>
<td>Copying settings between notes</td>
</tr>
<tr>
<td>608</td>
<td>Handling beaming</td>
</tr>
<tr>
<td>612</td>
<td>About tied notes</td>
</tr>
<tr>
<td>614</td>
<td>Graphic moving of notes</td>
</tr>
<tr>
<td>614</td>
<td>Cue notes</td>
</tr>
<tr>
<td>615</td>
<td>Grace notes</td>
</tr>
<tr>
<td>616</td>
<td>Tuplets</td>
</tr>
<tr>
<td>618</td>
<td>Working with symbols</td>
</tr>
<tr>
<td>619</td>
<td>About this chapter</td>
</tr>
<tr>
<td>619</td>
<td>Background: The different layers</td>
</tr>
<tr>
<td>620</td>
<td>The Symbols Inspector</td>
</tr>
<tr>
<td>621</td>
<td>Important! – Symbols, staves, and voices</td>
</tr>
<tr>
<td>622</td>
<td>Adding symbols to the score</td>
</tr>
<tr>
<td>623</td>
<td>Selecting symbols</td>
</tr>
<tr>
<td>629</td>
<td>Moving and duplicating symbols</td>
</tr>
<tr>
<td>632</td>
<td>Changing length, size, and shape</td>
</tr>
<tr>
<td>633</td>
<td>Deleting symbols</td>
</tr>
<tr>
<td>633</td>
<td>Copy and paste</td>
</tr>
<tr>
<td>633</td>
<td>Alignment</td>
</tr>
<tr>
<td>634</td>
<td>Symbol details</td>
</tr>
<tr>
<td>640</td>
<td>Working with chords</td>
</tr>
<tr>
<td>641</td>
<td>About this chapter</td>
</tr>
<tr>
<td>641</td>
<td>Inserting Chord symbols</td>
</tr>
<tr>
<td>643</td>
<td>Global chord settings</td>
</tr>
<tr>
<td>645</td>
<td>Working with text</td>
</tr>
<tr>
<td>646</td>
<td>About this chapter</td>
</tr>
<tr>
<td>646</td>
<td>Adding and editing text symbols</td>
</tr>
<tr>
<td>648</td>
<td>Different types of text</td>
</tr>
<tr>
<td>652</td>
<td>Text functions</td>
</tr>
<tr>
<td>655</td>
<td>Working with layouts</td>
</tr>
<tr>
<td>-----</td>
<td>---------------------</td>
</tr>
<tr>
<td>656</td>
<td>About this chapter</td>
</tr>
<tr>
<td>656</td>
<td>Background: Layouts</td>
</tr>
<tr>
<td>656</td>
<td>Creating a layout</td>
</tr>
<tr>
<td>656</td>
<td>Opening a layout</td>
</tr>
<tr>
<td>656</td>
<td>Layout operations</td>
</tr>
<tr>
<td>657</td>
<td>Using layouts – an example</td>
</tr>
<tr>
<td>658</td>
<td>Marker Track to Form</td>
</tr>
<tr>
<td>659</td>
<td>Working with MusicXML</td>
</tr>
<tr>
<td>660</td>
<td>Introduction</td>
</tr>
<tr>
<td>661</td>
<td>Importing and exporting MusicXML files</td>
</tr>
</tbody>
</table>

### 663 Designing your score: additional techniques

- 664 About this chapter
- 664 Layout settings
- 665 Staff size
- 665 Hiding/showing objects
- 666 Coloring notes
- 667 Multiple rests
- 667 Editing bar lines
- 668 Creating upbeats
- 669 Setting the number of bars across the page
- 670 Moving bar lines
- 670 Dragging staves
- 672 Adding brackets and braces
- 672 Auto Layout
- 674 Reset Layout
- 674 Breaking bar lines

### 676 Scoring for drums

- 677 About this chapter
- 677 Background: Drum maps in the Score Editor
- 677 Setting up the drum map
- 679 Setting up a staff for drum scoring
- 679 Entering and editing notes
- 679 Using “Single Line Drum Staff”

### 680 Creating tablature

- 681 About this chapter
- 681 Creating tablature automatically
- 682 Creating tablature manually
- 682 Tablature number appearance
- 683 Editing
- 683 Note head shape
Part I:
Getting into the details
1

About this manual
Welcome!

This is the Operation Manual for Steinberg’s Cubase. Here you will find detailed information about all the features and functions in the program.

About the program versions

The documentation covers two program versions, Cubase and Cubase Artist, for two different operating systems or “platforms”, Windows and Mac OS X.

Some features described in the documentation are only applicable to the Cubase version. Whenever this is the case this will be clearly indicated in the heading of the related subject.

Some features and settings are also specific to one of the platforms. This is clearly stated in the applicable cases. If nothing else is said, all descriptions and procedures in the documentation are valid for all Cubase versions for both Windows and Mac OS X.

The screenshots are taken from the Windows version of Cubase.

Key command conventions

Many of the default key commands in Cubase use modifier keys, some of which are different depending on the operating system. For example, the default key command for Undo is [Ctrl]-[Z] under Windows and [Command]-[Z] under Mac OS X.

When key commands with modifier keys are described in this manual, they are shown with the Windows modifier key first, in the following way:

[Win modifier key]/[Mac modifier key]-[key]

For example, [Ctrl]/[Command]-[Z] means “press [Ctrl] under Windows or [Command] under Mac OS X, then press [Z]”.

Similarly, [Alt]/[Option]-[X] means “press [Alt] under Windows or [Option] under Mac OS X, then press [X]”.

This manual often refers to right-clicking, for example, to open context menus. If you are using a Mac with a single-button mouse, hold down [Ctrl] and click.
Setting up your system
Setting up audio

⚠ Make sure that all equipment is turned off before making any connections!

Connecting audio

Exactly how to set up your system depends on many different factors, e.g. the kind of project you wish to create, the external equipment you want to use, or the computer hardware available to you. Therefore, the following sections can only serve as examples.

How you connect your equipment, i.e. whether you use digital or analog connections, also depends on your individual setup.

Stereo input and output – the simplest connection

If you only use a stereo input and output from Cubase, you can connect your audio hardware, e.g. the inputs of your audio card or your audio interface, directly to the input source and the outputs to a power amplifier and speaker.

A simple stereo audio setup

This is probably the simplest of all setups – once you have set up the internal input and output busses, you can connect your audio source, e.g. a microphone, to your audio interface and start recording.

Multi-channel input and output

Most likely however, you will have other audio equipment that you want to integrate with Cubase, using several input and output channels. Depending on the equipment available to you, there are two ways to go: either mixing using an external mixing desk, or mixing using the Mixer inside Cubase.

- External mixing means having a hardware mixing device with a group or bus system that can be used for feeding inputs on your audio hardware.
- In the example below, four busses are used for feeding signals to the audio hardware’s inputs. The four outputs are connected back to the mixer for monitoring and playback. Remaining mixer inputs can be used for connecting audio sources like microphones, instruments, etc.

A multi-channel audio setup using an external mixer

⚠ When connecting an input source (like a mixer) to the audio hardware, you should use output busses, sends or similar that are separate from the mixer’s master output to avoid recording what you are playing back. You may also have mixing hardware that can be connected via FireWire.
• When using the Mixer inside Cubase, you can use the inputs on your audio hardware to connect microphones and/or external devices. Use the outputs to connect your monitoring equipment.

Cubase only: You can create very complex setups using external instruments and external effects, and integrate Cubase seamlessly with all your external equipment using the Control Room feature (see the chapters “VST Connections” on page 29 and “Control Room (Cubase only)” on page 172).

Mixing inside Cubase

Connecting for surround sound (Cubase only)

If you plan to mix for surround sound, you can connect the audio outputs to a multi-channel power amplifier, driving a set of surround channels.

Recording from a CD player

Most computers come with a CD-ROM drive that can also be used as a regular CD player. In some cases the CD player is internally connected to the audio hardware so that you can record the output of the CD player directly into Cubase (consult the audio hardware documentation if you are uncertain).

• All routing and level adjustments for recording from a CD (if available) are done in the audio hardware setup application (see below).

• You can also grab audio tracks directly from a CD in Cubase (see the chapter “File handling” on page 521).

Word clock connections

If you are using a digital audio connection, you may also need a word clock connection between the audio hardware and external devices. Please refer to the documentation that came with the audio hardware for details.

It is very important that word clock synchronization is done correctly or there might be clicks and crackles in recordings that you make!

About recording levels and inputs

When you connect your equipment, you should make sure that the impedance and levels of the audio sources and inputs are matched. Typically, different inputs may be designed for use with microphones, consumer line level (-10dBV) or professional line level (+4dBV), or you may be able to adjust input characteristics on the audio interface or in its control panel. Please check the audio hardware documentation for details.

Using the correct types of input is important to avoid distortion or noisy recordings.

Cubase does not provide any input level adjustments for the signals coming in to your audio hardware, since these are handled differently for each card. Adjusting input levels is either done in a special application included with the hardware or from its control panel (see below).
Making settings for the audio hardware

Most audio cards come with one or more small applications that allow you to configure the inputs of the hardware to your liking. This includes:

- Selecting which inputs/outputs are active.
- Setting up word clock synchronization (if available).
- Turning monitoring via the hardware on/off (see "About monitoring" on page 19).
- Setting levels for each input. This is very important!
- Setting levels for the outputs, so that they match the equipment you use for monitoring.
- Selecting digital input and output formats.
- Making settings for the audio buffers.

In many cases all available settings for the audio hardware are gathered in a control panel, which can be opened from within Cubase as described below (or opened separately, when Cubase isn’t running). In some cases, there may be several different applications and panels — please refer to the audio hardware documentation for details.

Plug and Play support for ASIO devices

The Steinberg MR816 hardware series supports Plug and Play in Cubase. These devices can be plugged in and switched on while the application is running. Cubase will automatically use the driver of the MR816 series and will re-map the VST connections accordingly.

Steinberg cannot guarantee that this will work with other hardware. If you are unsure of whether your device supports plug and play, please consult its documentation.

⚠️ If a device that does not support Plug and Play is connected/disconnected while the computer is running, it may get damaged.

Selecting a driver and making audio settings in Cubase

The first thing you need to do is select the correct driver in Cubase to make sure that the program can communicate with the audio hardware:

1. Launch Cubase and select Device Setup from the Devices menu.
2. In the Devices list to the left, click on “VST Audio System”.
   The VST Audio System page is shown.

3. On the ASIO Driver menu, select your audio hardware driver.
   There may be several options here that all refer to the same audio hardware. When you have selected a driver, it is added to the Devices list.

⚠️ Under Windows, we strongly recommend that you access your hardware via an ASIO driver written specifically for the hardware. If no ASIO driver is installed, we recommend that you check with your audio hardware manufacturer if they have an ASIO driver available, for example, for download via the Internet. You can use the Generic Low Latency ASIO driver if no specific ASIO driver is available.

4. Select the driver in the Devices list to open the driver settings for your audio hardware.
5. Bring up the control panel for the audio hardware and adjust the settings as recommended by the audio hardware manufacturer.
• Under Windows, you open the control panel by clicking the Control Panel button. The control panel that opens when you click this button is provided by the audio hardware manufacturer – not Cubase (unless you use DirectX, see below). Hence it will be different for each audio card brand and model. The control panels for the ASIO DirectX driver and the Generic Low Latency ASIO Driver (Windows only) are exceptions, in that they are provided by Steinberg and described in the dialog help, opened by clicking the Help button in the dialog. See also the notes on DirectX below.

• Under Mac OS X, the control panel for your audio hardware is opened by clicking the “Open Config App” button on the settings page for your audio device in the Device Setup dialog. Note that this button is available only for some hardware products. If “Open Config App” is not available in your setup, refer to the documentation that came with your audio hardware for information on where to make hardware settings.

6. If you plan to use several audio applications simultaneously, you may want to activate the “Release Driver when Application is in Background” option on the VST Audio System page. This will allow another application to play back via your audio hardware even though Cubase is running.

The application that is currently active (i.e. the “top window” on the desktop) gets access to the audio hardware. Make sure that any other audio application accessing the audio hardware is also set to release the ASIO (or Mac OS X) driver so Cubase can use it when it becomes the active application again.

7. If your audio hardware receives clock signals from an external sample clock source, you may want to activate the “Externally Clocked” option on the page for the driver. This is described in detail in the section “If your hardware setup is based on an external clock source” on page 18.

8. If your audio hardware and its driver support ASIO Direct Monitoring, you may want to activate the Direct Monitoring checkbox on the page for the driver.

Read more about monitoring later in this chapter and in the chapter “Recording” on page 89.

9. Click Apply and then OK to close the dialog.

If your hardware setup is based on an external clock source

For proper audio playback and recording, it is essential that you set the project’s sample rate to the sample rate of the incoming clock signals. If you load a project with a sample rate that is different from your clock source, the program will try to change the settings of the clock source, which may not be what you want.

By activating the “Externally Clocked” option, you “tell” Cubase that it receives external clock signals and therefore derives its speed from that source. The program will not try to change the hardware sample rate any longer. The sample rate mismatch is accepted and playback will therefore be faster or slower. For more information about the Sample Rate setting, see “The Project Setup dialog” on page 54.

When a sample rate mismatch occurs, the Record Format field on the status line is highlighted in a different color.

If you are using audio hardware with a DirectX driver (Windows only)

⚠️ A DirectX driver is the next best option to a specific ASIO driver and the Generic Low Latency ASIO driver.

Cubase comes with a driver called ASIO DirectX Full Duplex, available for selection on the ASIO Driver pop-up menu (VST Audio System page).

⚠️ To take full advantage of DirectX Full Duplex, the audio hardware must support WDM (Windows Driver Model) in combination with DirectX version 8.1 or higher. In all other cases, the audio inputs will be emulated by DirectX (see the dialog help for the ASIO DirectX Full Duplex Setup dialog for details about how this is reported).

⚠️ During the installation of Cubase, the latest DirectX version will be installed on your computer.
When the ASIO DirectX Full Duplex driver is selected in the Device Setup dialog, you can open the ASIO Control Panel and adjust the following settings (for more details, click the Help button in the control panel):

- **Direct Sound Output and Input Ports**
  In the list on the left in the window, all available Direct Sound output and input ports are listed. In many cases, there will be only one port in each list. To activate or deactivate a port in the list, click the checkbox in the left column. If the checkbox is ticked, the port is activated.

- **You can edit the Buffer Size and Offset settings in this list if necessary, by double-clicking on the value and typing in a new value.**
  In most cases, the default settings will work fine. Audio buffers are used when audio data is transferred between Cubase and the audio card. While larger buffers ensure that playback will occur without glitches, the latency (the time between the moment Cubase sends out the data and when it actually reaches the output) will be higher.

- **Offset**
  If a constant offset is audible during playback of Audio and MIDI recordings, you can adjust the output or input latency time using this value.

### Setting up the input and output ports

Once you have selected the driver and made the settings as described above, you need to specify which inputs and outputs will be used and name these:

1. In the Device Setup dialog, select your driver in the Devices list on the left to display the driver settings for your audio hardware.

2. To hide a port, click in the “Visible” column for the port (deselecting the checkbox). Ports that are not visible cannot be selected in the VST Connections window where you set up your input and output busses – see the chapter “VST Connections” on page 25.

   - **⚠️** If you attempt to hide a port that is already used by a bus you will be asked whether this is really what you want – note that this will disable the port!

3. To rename a port, click on its name in the “Show as” column and type in a new name.

   - It is a good idea to give your ports names that are related to the channel configuration (rather than to the actual hardware model)!

   For example, if you are using a 5.1 surround audio setup (Cubase only), you could name the six ports Left, Right, Center, Lfe, Left Surround, and Right Surround. This makes it easier to transfer your projects between different computers, e.g. in different studios – if the same port names are used on both computers, Cubase will automatically handle the bus connections properly when you open the project on the other computer.

4. Click OK to close the Device Setup dialog and apply your changes.

### About monitoring

In Cubase, monitoring means listening to the input signal while preparing to record or while recording. There are three ways to monitor:

- **External monitoring**
  External monitoring (listening to the input signal before it goes into Cubase) requires an external mixer for mixing the audio playback with the input signal. This can be a classic mixing desk or a mixer application for your audio hardware, if this has a mode in which the input audio is sent back out again (usually called “Thru”, “Direct Thru” or similar).

- **Via Cubase**
  In this case, the audio passes from the input into Cubase, possibly through Cubase effects and EQ and then back to the output. You control monitoring via settings in Cubase. This allows you to control the monitoring level from Cubase and add effects to the monitored signal only.
ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may support ASIO Direct Monitoring (this feature may also be available for audio hardware with Mac OS X drivers). In this mode, the actual monitoring is done in the audio hardware, by sending the input signal back out again. However, monitoring is controlled from Cubase. This means that the audio hardware’s direct monitoring feature can be turned on or off automatically by Cubase.

Monitoring is described in detail in the chapter “Recording” on page 89. However, when setting up, there is one thing to note:

- If you want to use the external monitoring via your audio hardware, make sure that the corresponding functions are activated in the card’s mixer application.
- If you are using RME Audio Hammerfall DSP audio hardware, make sure that the pan law is set to -3dB in the card’s preferences.

Setting up MIDI

⚠ Make sure that all equipment is turned off before making any connections!

This section describes how to connect and set up MIDI equipment. If you have no MIDI equipment, you can skip this section. Note that this is only an example – you might need or want to hook things up differently!

Connecting the MIDI equipment

In this example we assume that you have a MIDI keyboard and an external MIDI sound module. The keyboard is used both for feeding the computer with MIDI messages for recording and for playing back MIDI tracks. The sound module is used for playback only. Using Cubase’s MIDI Thru feature (described later) you will be able to hear the correct sound from the sound module while playing the keyboard or recording.

⚠ If you plan to use more than three sound sources, we recommend that you either use an interface with more than one output, or a separate MIDI Thru box instead of the Thru jacks on each unit.

Setting MIDI Thru and Local On/Off

On the MIDI page in the Preferences dialog (located on the File menu under Windows and on the Cubase menu under Mac OS X), you will find a setting called “MIDI Thru Active”. This is related to a setting in your instrument called “Local On/Off” or “Local Control On/Off”.

- If you use a MIDI keyboard instrument, as described earlier in this chapter, MIDI Thru should be activated and that instrument should be set to Local Off (sometimes called Local Control Off – see the instrument’s operation manual for details).
Setting up your system

The MIDI signal from the keyboard will be recorded in Cubase and at the same time be re-routed back to the instrument so that you hear what you are playing, without the keyboard “trig-gering” its own sounds.

• If you use a separate MIDI keyboard – one that does not pro-duce any sounds itself – MIDI Thru in Cubase should also be activated, but you don’t need to look for any Local On/Off set-ting in your instruments.
• The only case where MIDI Thru should be deactivated is if you use Cubase with only one keyboard instrument and that instru-ment cannot be set to Local Off mode.
• MIDI Thru will be active only for MIDI tracks that are record en-abled and/or have the Monitor button activated. See the chap-ter “Recording” on page 89 for more information.

Setting up MIDI ports in Cubase

The Device Setup dialog lets you set up your MIDI system as follows:

• When you change MIDI port settings in the Device Setup dialog, these are automatically applied.

Showing or hiding MIDI Ports

The MIDI ports are listed in the Device Setup dialog on the MIDI Port Setup page. By clicking in the “Visible” column for a MIDI input or output, you can specify whether or not it is listed on the MIDI pop-up menus in the program.

If you are trying to hide a MIDI port which is already se-lected for a track or a MIDI device, a warning message will appear, allowing you to hide – and disconnect – the port or to cancel the operation and keep the MIDI port visible.

Setting up the “All MIDI Inputs” option

When you record MIDI in Cubase, you can specify which MIDI input each recording MIDI track should use. How-ever, you can also select the “In ‘All MIDI Inputs’” option for an input port, which causes any MIDI data from any MIDI input to be recorded.

The “In ‘All MIDI Inputs’” option on the MIDI Port Setup page allows you to specify which inputs are included when you select All MIDI Inputs for a MIDI track. This can be es-spe-cially useful if your system provides several instances of the same physical MIDI input – by deactivating the dupli-cates you make sure only the desired MIDI data is recorded.

• If you have a MIDI remote control unit connected, you should also make sure to deactivate the “In ‘All MIDI Inputs’” option for that MIDI input. This will avoid accidentally recording the data from the remote control when the “All MIDI Inputs” option is selected as input for a MIDI track.

When “MIDI Thru” is active in Cubase, MIDI data received is immediately “echoed” back out.

When Local Control is turned on in the instrument, the keys you press will be played by the “Synth” inside the instrument. When Local Control is turned off, this connection is cut off.

When you press a key, it is sent out via MIDI to Cubase.

MIDI data coming in to the instrument is played by the “Synth” inside it.

When “MIDI Thru” is active in Cubase, MIDI data received is immediately “echoed” back out.
Connecting a synchronizer

⚠ Make sure that all equipment is turned off before making any connections!

When using Cubase with external tape transports, you will most likely need to add a synchronizer to your system. All connections and setup procedures for synchronization are described in the chapter “Synchronization” on page 493.

Setting up video

Cubase plays back video files in a number of formats, such as AVI, QuickTime, or MPEG. QuickTime is used as playback engine. Which formats can be played back depends on the video codecs installed on your system, see the chapter “Video” on page 509.

There are several ways to play back video, e.g. without any special hardware, using a FireWire port, or using dedicated video cards, see “Video output devices” on page 511.

If you plan to use special video hardware, install it and set it up as recommended by the manufacturer.

Before you use the video hardware with Cubase, we recommend that you test the hardware installation with the utility applications that came with the hardware and/or the QuickTime Player application.

Optimizing audio performance

This section gives you some hints and tips on how to get the most out of your Cubase system, performance-wise. Some of this text refers to hardware properties and can be used as a guide when upgrading your system. This text is very brief. Look for details and current information on the Cubase web site!

Two aspects of performance

There are two distinct aspects of performance with respect to Cubase.

Tracks and effects

Simply put: the faster your computer, the more tracks, effects and EQ you will be able to play. Exactly what constitutes a “fast computer” is almost a science in itself, but some hints are given below.

Short response times (latency)

Another aspect of performance is response time. The term “latency” refers to the “buffering”, i.e. the temporary storing, of small chunks of audio data during various steps of the recording and playback process on a computer. The more and larger those chunks, the higher the latency.

High latency is most irritating when playing VST instruments and when monitoring through the computer, i.e. when listening to a live audio source via the Cubase Mixer and effects. However, very long latency times (several hundred milliseconds) can also affect other processes like mixing, e.g. when the effect of a fader movement is heard only after a noticeable delay.

While Direct Monitoring and other techniques reduce the problems associated with very long latency times, a system that responds fast will always be more convenient to work with.

• Depending on your audio hardware, it may be possible to “trim” your latency times, usually by lowering the size and the number of buffers.

For details, refer to the audio hardware documentation, or, if you are using a DirectX driver under Windows, the dialog help.

System factors that affect performance

RAM

Generally speaking, the more RAM is installed in your computer, the better.

⚠ On computers running a Windows 32-bit operating system, a running application can address a maximum of 2 GB of RAM. On a Macintosh computer running Mac OS X, this limit is 4 GB. The 64-bit versions of Windows and Mac OS X are able to assign considerably more than 4 GB of RAM to a running 64-bit application.

This limitation is imposed by the operating system, and it is independent of the amount of RAM that you may have installed in your computer!
Some program functions may “eat up” all the available memory, e.g. recording, the use of effect plug-ins, and the pre-loading of samples (see also “RAM requirements for recording” on page 92 and “Smart plug-in processing” on page 188).

⚠️ When a function has used up all the memory made available by the operating system, the computer will crash.

Always keep in mind the RAM limitation of your operating system when setting up your projects.

CPU and processor cache

It goes without saying that the faster the computer processor, the better. But there are a number of factors that affect the apparent speed of a computer: the bus speed and type (PCI is strongly recommended), processor cache size and of course, the processor type and brand. Cubase relies heavily on floating point calculations. When shopping for a processor, please make sure that you get one that is powerful in calculating floating point arithmetics.

Note also that Cubase features full support for multi-processor systems. So, if you own a computer system with more than one processor, Cubase can take advantage of the total capacity and evenly distribute the processing load to all available processors. For further information, see “Multi processing” on page 24.

Hard disk and controller

The number of hard disk tracks you can record and play back at the same time also depends on the speed of your hard disk and hard disk controller. If you use E-IDE disks and controllers, make sure that the transfer mode is DMA Busmaster. Under Windows, you can check the current mode by launching the Windows Device Manager and looking for properties of the IDE ATA/ATAPI Controller’s primary and secondary channel. DMA transfer mode is enabled by default, but may be turned off by the system should hardware problems occur.

⚠️ Again, we strongly recommend that you use audio hardware for which there is a specific ASIO driver!

This is especially true when using Cubase for Windows:

- Under Windows, ASIO drivers written specifically for the hardware are more efficient than the Generic Low Latency ASIO Driver or a DirectX driver and produce shorter latency times.
- Under Mac OS X, audio hardware with properly written Mac OS X (Core Audio) drivers can be very efficient and produce very low latency times. However, there are additional features currently only available with ASIO drivers, such as the ASIO Positioning Protocol.

Making settings that affect performance

Audio hardware and driver

The hardware and its driver can have some effect on regular performance. A badly written driver can reduce the performance of your computer. But where the hardware driver design makes the most difference is with latency.

Audio buffer settings

Audio buffers affect how audio is sent to and from the audio hardware. The size of the audio buffers affects both the latency and the audio performance. Generally, the smaller the buffer size, the lower the latency. On the other hand, working with small buffers can be demanding for the computer. If the audio buffers are too small, you may get clicks, pops or other audio playback problems.

- Under Mac OS X, you can adjust the size of the buffers on the VST Audio System page in the Device Setup dialog.
- Under Windows, you adjust the buffer size settings in the control panel for the audio hardware.

You may also find buffer settings in the control panel for the audio hardware.

- Under Windows, you adjust the buffer size settings in the control panel for the audio hardware (opened by clicking the Control Panel button on the driver page in the Device Setup dialog).
Optimizing processor scheduling (Windows only)

To get the lowest possible latencies when using ASIO under Windows (on a single-CPU system), the “system performance” has to be optimized for background tasks:

1. Open the Control Panel and select the System settings.
   The System Properties dialog opens.
2. On the left, select the “Advanced system settings” option.
   The System Properties dialog opens.
3. Select the Advanced tab and click the “Settings…” button in the Performance section.
   The Performance Options dialog opens.
4. Select the Advanced tab and activate the “Adjust for best performance of: Background services” option.
5. Click OK to close the dialogs.

Multi processing

On the VST Audio System page you will find the “Advanced options” section. Here you find advanced settings for the VST Engine, including a Multi Processing option. When this is activated and there is more than one CPU in your system, the processing load is distributed evenly to all available CPUs, allowing Cubase to make full use of the combined power of the multiple processors.

About the VST Performance window

The VST Performance window is opened from the Devices menu. The window shows two meter displays: The ASIO meter, which indicates CPU load, and the Disk meter, which shows the hard disk transfer rate. It is recommended that you check this from time to time, or keep it always open. Even if you have been able to activate a number of audio channels in the project without getting any warning, you may run into performance problems when adding EQ or effects.

- The ASIO meter (at the top) shows the ASIO time usage, i.e. the time required to complete the current processing tasks. The more tracks, effects, EQ, etc. you use in your project, the longer processing will take, and the longer the ASIO meter will show activity.
  If the overload indicator (on the far right) lights up, you need to decrease the number of EQ modules, active effects, and/or audio channels playing back simultaneously.
- The lower bar graph shows the hard disk transfer load.
  If the overload indicator (on the far right) lights up, the hard disk is not supplying data fast enough to the computer. You may need to reduce the number of tracks playing back by using the Disable Track function (see “About track disable/enable” on page 86). If this does not help, you need a faster hard disk.
  The overload indicator may occasionally blink, e.g. when you locate during playback. This does not indicate a problem, but happens because the program needs a moment for all channels to load data for the new playback position.
- The ASIO and Disk load meters can also be shown on the Transport panel (as “Performance”) and on the Project window toolbar (as “Performance Meter”). There they are shown as two miniature vertical meters (by default at the left side of the panel/toolbar).
3

VST Connections
About this chapter

This chapter focuses on the settings you can perform in the VST Connections window. Here you can set up input and output busses, group and FX channels, external effects, and external instruments. Furthermore you can use this window to configure the Control Room (Cubase only) and access the Control Room itself.

Since input and output busses are vital for working with Cubase, a large part of this chapter concentrates on busses and this is also the reason why you find this chapter at the beginning of the Operation Manual. How to use the busses is described in detail in the section “Routing” on page 164.

The VST Connections window

The VST Connections window is opened from the Devices menu. It contains the following tabs:

- The Inputs and Outputs tabs allow you to set up and configure input and output busses, see “Setting up busses” on page 26.
- The Group/FX tab allows you to create group and FX channels/tracks and to make output assignments for these, see “Setting up group and FX channels” on page 29.
- The External FX tab (Cubase only) allows you to create effect send/return busses for connecting external effects which can then be selected via the effect pop-up menus from inside the program. For further information, see “External instruments/effects (Cubase only)” on page 30 and “Using external effects (Cubase only)” on page 200.
- The External Instruments tab (Cubase only) allows you to create input/output busses for connecting external instruments. For further information, see “External instruments/effects (Cubase only)” on page 30 and the chapter “VST instruments and instrument tracks” on page 206.
- The Studio tab (Cubase only) is where you enable and configure the Control Room, see “VST Connections – Studio tab” on page 174.

Setting up busses

Cubase uses a system of input and output busses to transfer audio between the program and the audio hardware.

- Input busses let you route audio from the inputs on your audio hardware into the program. This means that when you record audio, you will always do this through one or several input busses.
- Output busses let you route audio from the program to the outputs on your audio hardware. When you play back audio, you will always do this through one or several output busses.

Once you understand the bus system and know how to set up the busses properly, it will be easy to go on with recording, playing back, mixing, and doing surround work (Cubase only).

Strategies

The bus configuration is saved with the project – therefore it is a good idea to add and set up the busses you need and save these in a template project (see “Save as Template” on page 51).

When you start working on new projects, you start from this template. That way you get your standard bus configuration without having to make new bus settings for each new project. If you need to work with different bus configurations in different projects, you can either create several different templates or store your configurations as presets (see “Presets” on page 29). The templates can of course also contain other settings that you regularly use – sample rate, record format, a basic track layout, etc.

So, which type of busses do you need? This depends on your audio hardware, your general audio setup (e.g. surround speaker setup) and what kind of projects you work with.
Let’s say you are using audio hardware with eight analog inputs and outputs and digital stereo connections (10 inputs and outputs all in all). Furthermore, you work with a surround setup in 5.1 format (Cubase only). In this scenario, you may want to add the following busses:

Input busses

• Most likely you need at least one stereo input bus assigned to an analog input pair. This will let you record stereo material. If you want to be able to record in stereo from other analog input pairs as well, you add stereo input busses for these, too.
• Although you can record mono tracks from one side of a stereo input, it may be a good idea to add a dedicated mono input bus. This can be assigned to an analog input to which you have connected a dedicated microphone pre-amp, for example. Again, you can have several different mono busses.
• You probably want a dedicated stereo input bus assigned to the digital stereo input, for digital transfers.
• Cubase only: If you want to transfer surround material directly to a surround track, e.g. from surround-configured recording equipment, you need an input bus in that surround format – in this example, this will be a 5.1 input bus.

Output busses

• You probably want one or several stereo output busses for monitoring and listening to stereo mixes.
• For digital transfers, you need a stereo bus assigned to the digital stereo output as well.
• Cubase only: You need a surround bus in the format of your speaker configuration (in this example, 5.1) assigned to the correct outputs (which in turn are connected to the correct speakers). You may want additional surround busses if you tend to work in different surround formats.

⚠️ Different busses can use the same inputs/outputs on the audio hardware! For example, you may want a stereo output bus assigned to the same outputs as the front stereo channels in your surround bus – this enables you to listen to stereo mixes without having to reconnect your speakers.

Preparations

Before you set up busses, you should name the inputs and outputs on your audio hardware. For example, if you are using a 5.1 surround speaker setup, you should name the outputs according to which speaker they are connected to (Left, Right, Center, and so on).

The reason for this is compatibility – it makes it easier to transfer projects between different computers and setups. For example, if you move your project to another studio, the audio hardware may be of a different model. But if both you and the other studio owner have given your inputs and outputs names according to the surround setup (rather than names based on the audio hardware model), Cubase will automatically find the correct inputs and outputs for your busses and you will be able to play and record without having to change the settings.

To assign names to the inputs and outputs of your audio hardware, proceed as follows:

1. Open the Device Setup dialog from the Devices menu.
2. On the VST Audio System page, make sure that the correct driver for your audio hardware is selected. If this is the case, your audio card is listed in the Devices list on the left of the Device Setup window.
3. In the Devices list, select your audio card. The available input and output ports on your audio hardware are listed on the right.
4. To rename a port, click on its name in the Show As column and enter a new name.
   • If needed, you can also disable ports by deactivating them in the Visible column. Disabled ports are not shown in the VST Connections window. If you attempt to disable a port that is used by a bus, you will be asked whether this is really what you want – note that this will remove the port from the bus!
5. Click OK to close the Device Setup dialog.
   ➤ If you open a project created on another computer and the port names do not match (or the port configuration is not the same – e.g. the project is created on a system with multi-channel I/O and you open it on a stereo in/out system), the Missing Ports dialog will appear. This allows you to manually re-route ports used in the project to ports available in your system.
**Mac OS X only: Port selection and activation**

On the settings page for your audio card (opened via the Device Setup dialog, see above), you can specify which input and output ports are active. This allows you to use the Microphone input instead of the Line input or even to deactivate the audio card input or output completely, if required.

- This function is only available for Built-In Audio, standard USB audio devices and a certain number of other audio cards.

**Adding input and output busses**

Depending on whether you have selected the Inputs or the Outputs tab in the VST Connections window, the corresponding busses are listed, with the following information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus Name</td>
<td>Lists the busses. You can select and rename busses by clicking on them in this column.</td>
</tr>
<tr>
<td>Speakers</td>
<td>Indicates the speaker configuration (mono, stereo, surround formats (Cubase only)) of each bus.</td>
</tr>
<tr>
<td>Audio Device</td>
<td>This shows the currently selected ASIO driver.</td>
</tr>
<tr>
<td>Device Port</td>
<td>If a bus entry is expanded to show all speaker channels, this column shows which physical inputs/outputs on your audio hardware are used by the bus. If the bus entry is collapsed, only the first port used by this bus is visible here.</td>
</tr>
<tr>
<td>Click (Outputs tab only)</td>
<td>You can route the click to a specific output bus, regardless of the actual Control Room output, or even when the Control Room is disabled.</td>
</tr>
</tbody>
</table>

To add an input or output bus, proceed as follows:

1. Open the Inputs or Outputs tab depending on the type of bus that you want to add.
2. Click the Add Bus button. A dialog opens.
3. Select a (channel) configuration. The Configuration pop-up menu contains a Mono and a Stereo option as well as several surround formats (Cubase only). Additional surround formats are listed on the “More…” submenu.
   - Alternatively, you can right-click in the VST Connections window and add a bus in the desired format directly from the context menu.
   - The new bus appears with the ports visible.
4. For each of the speaker channels in the bus, click in the Device Port column to select a port on your audio hardware.
   - The pop-up menu that opens lists the ports with the names you have assigned in the Device Setup dialog.

**Setting the Main Mix bus (the default output bus)**

The Main Mix is the output bus that each new audio, group or FX channel is automatically routed to.

Any of the output busses in the VST Connections window can be the default output bus. By right-clicking on the name of an output bus, you can set it as the Main Mix bus.

![Setting the default output bus.](image)

- The Main Mix is indicated by an orange colored speaker icon next to its name.
Adding child busses (Cubase only)

A surround bus is essentially a set of mono channels – 6 channels in the case of the 5.1 format. If you have a mono track in the project, you can route it to a separate speaker channel in the bus (or route it to the parent surround bus and use the SurroundPanner to position it in the surround image). But what if you have a stereo track that you simply want to route to a stereo channel pair within the bus (Left and Right or Left Surround and Right Surround, for example)? For this you need to create a child bus.

Proceed as follows:

1. In the Bus Name column, select the surround bus and right-click on it to open the context menu.

2. Select a channel configuration from the “Add Child Bus” submenu.

As you can see, you can create stereo child busses (routed to various speaker channel pairs in the surround bus) or other surround bus formats (with fewer channels than the “parent bus”).

The child bus that you created will be available for routing in the Mixer. It is a part of the parent surround bus, which means that it has no separate channel strip.

Although child busses are probably most useful in output busses, you can also create child busses within a surround input bus – for example if you want to record a stereo channel pair (e.g. front left-right) in the surround bus to a separate stereo track.

Presets

On the Inputs and Outputs tabs you will find a Presets menu. Here you can find three different types of presets:

- A number of standard bus configurations.
- Automatically created presets tailored to your specific hardware configuration.

On startup, Cubase analyzes the physical inputs and outputs provided by your audio hardware and creates a number of hardware-dependent presets with the following possible configurations:

- One stereo bus.
- Various combinations of stereo and mono busses.
- A number of mono busses.
- Cubase only: one 5.1 bus (if you have 6 or more inputs).
- Cubase only: various combinations of 5.1 and stereo busses (if you have 6 or more inputs).
- Cubase only: various combinations of 5.1 and mono busses (if you have 6 or more inputs).
- Your own user presets that you can save by clicking the Store button (“+” symbol). You can then select the stored configuration directly from the Presets pop-up menu at any time. To remove a stored preset, select it and click the Delete button (“-” symbol).

Setting up group and FX channels

The Group/FX tab in the VST Connections window shows all group channels and FX channels in your project. You can create new group or FX channels by clicking the corresponding Add button. This is the same as creating group channel tracks or FX channel tracks in the Project window (see “Using group channels” on page 165 and the chapter “Audio effects” on page 187).

However, the VST Connections window also allows you to create child busses for group and FX channels (Cubase only). This is useful if you have group or FX channels in surround format and want to route stereo channels to specific channel pairs in these.

Creating a child bus for a group or FX channel in surround format is similar to creating a child bus for input and output busses, see “Adding child busses (Cubase only)” on page 29.
About monitoring

The VST Connections window allows you to set up the busses used for monitoring, activate/deactivate the Control Room and open the Control Room Mixer. For details about using the Control Room and setting up the Studio tab in the VST Connections window, see the chapter “Control Room (Cubase only)” on page 172.

When the Control Room is disabled on the Studio tab of the VST Connections window, the Main Mix bus is used for monitoring. In this case you can adjust the monitoring level in the regular Project Mixer, see the chapter “The Mixer” on page 145.

In Cubase Artist, the Main Mix bus is always used for monitoring.

External instruments/effects (Cubase only)

Cubase supports the integration of external effect devices and external instruments, e.g. hardware synthesizers, into the sequencer signal flow.

You can use the External Instruments tab and the External FX tab in the VST Connections window to define the necessary send and return ports and access the instruments/effects through the VST Instruments window.

Requirements

- To use external effects, you need audio hardware with multiple inputs and outputs. To use external instruments, a MIDI interface must be connected to your computer. An external effect will require at least one input and one output (or input/output pairs for stereo effects) in addition to the input/output ports you use for recording and monitoring.
- As always, audio hardware with low-latency drivers is a good thing to have. Cubase will compensate for the input/output latency and ensure that the audio processed through external effects is not shifted in time.

Connecting the external effect/instrument

To set up an external effect or instrument, proceed as follows:

1. Connect an unused output pair on your audio hardware to the input pair on your external hardware device. In this example, we assume that the hardware device has stereo inputs and outputs.
2. Connect an unused input pair on your audio hardware to the output pair on your hardware device.

⚠️ Please note that it is possible to select input/output ports for external effects/instruments that are already used (i.e. that have been selected as inputs/outputs in the VST Connections window). If you select a used port for an external effect/instrument, the existing port assignment will be broken. Note that you will not get a warning message!

Once the external device is connected to the audio hardware of your computer, you have to set up the input/output busses in Cubase.

Setting up external effects

To set up an external effect in the VST Connections window, proceed as follows:

1. Open the External FX tab and click the “Add External FX” button. A dialog opens.

2. Enter a name for the external effect and specify the send and return configurations. Depending on the type of effect, you can specify mono, stereo or surround configurations.
You also need a MIDI device that corresponds with the external effect. You can then click the “Associate MIDI Device” button to connect the two. You can use the MIDI Device Manager to create a new MIDI device for the effect. Note that delay compensation will only be applied for the effect when you use MIDI devices. For information about the MIDI Device Manager and user device panels see the chapter “Using MIDI devices” on page 356.

3. Click OK. This adds a new external FX bus.

4. Click in the Device Port column for the “left” and “right” ports of the Send Bus and select the outputs on your audio hardware that you want to use.

5. Click in the Device Port column for the “left” and “right” ports of the Return Bus and select the inputs on your audio hardware that you want to use.

6. If you like, make additional settings for the bus. These are found in the columns to the right. Note that you can adjust these while actually using the external effect – which may be easier as you can hear the result.

The following options are available:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay</td>
<td>If your hardware effect device has an inherent delay (latency), enter this value here, as it allows Cubase to compensate for that delay during playback. You can also let the delay value be determined by the program: Right-click the Delay column for the effect and select “Check User Delay”. Note that you do not have to take the latency of the audio hardware into account – this is handled automatically by the program.</td>
</tr>
<tr>
<td>Send Gain</td>
<td>Allows you to adjust the level of the signal being sent to the external effect.</td>
</tr>
<tr>
<td>Return Gain</td>
<td>Allows you to adjust the level of the signal coming in from the external effect. Note however that excessive output levels from an external effect device may cause clipping in the audio hardware. The Return Gain setting cannot be used to compensate for this – you have to lower the output level on the effect device instead.</td>
</tr>
<tr>
<td>MIDI Device</td>
<td>When you click in this column, a pop-up menu opens where you can disconnect the effect from the associated MIDI device, select a MIDI device, create a new device or open the MIDI Device Manager to edit the MIDI device. When Studio Manager 2 is installed, you may also select an OPT editor to access your external effect.</td>
</tr>
<tr>
<td>Used</td>
<td>Whenever you insert an external effect into an audio track, this column shows a checkmark (“x”) to indicate that the effect is being used.</td>
</tr>
</tbody>
</table>

Note that external device ports are exclusive, see “Connecting the external effect/instrument” on page 30.

How to use the external effect

If you now click an insert effect slot for any channel, you will find the new external FX bus listed on the “External Plug-ins” submenu.

When you select it, the following happens:

- The external FX bus is loaded into the effect slot just like a regular effect plug-in.
- The audio signal from the channel is sent to the outputs on the audio hardware, through your external effect device and back to the program via the inputs on the audio hardware.
- A parameter window opens, showing the Delay, Send Gain and Return Gain settings for the external FX bus. You can adjust these as necessary while playing back. The parameter window also provides the “Measure Effect’s Loop Delay for Delay Compensation” button. This is the same function as the “Check User Delay” option in the VST Connections window. It provides Cubase with a Delay value to be used for delay compensation. When you have defined a MIDI device for the effect, the corresponding Device window will be opened. When Studio Manager 2 is installed, and you have set up a corresponding OPT editor, this OPT editor is displayed.

Measure Effect’s Loop Delay button

The default parameter window for an external effect

Like any effect, you can use the external FX bus as an insert effect or as a send effect (an insert effect on an FX channel track). You can deactivate or bypass the external effect with the usual controls.
### Setting up external instruments

To set up an external instrument in the VST Connections window, proceed as follows:

1. Open the External Instrument tab and click the “Add External Instrument” button.
   A dialog opens.

2. Enter a name for the external instrument and specify the number of required mono and/or stereo returns. Depending on the type of instrument, a specific number of mono and/or stereo return channels is required.
   - You also need a MIDI device that corresponds with the external instrument. You can then click the “Associate MIDI Device” button to connect the two.
   You can use the MIDI Device Manager to create a new MIDI device. For information about the MIDI Device Manager and user device panels, see the chapter "Using MIDI devices" on page 356.

3. Click OK.
   This adds a new external instrument bus.

4. Click in the Device Port column for the “left” and “right” ports of the Return Bus and select the inputs on your audio hardware to which you connected the external instrument.

5. If you like, make additional settings for the bus.
   These are found in the columns to the right. Note that you can adjust these while actually using the external instrument – which may be easier as you can hear the result. The following options are available:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return Gain</td>
<td>Allows you to adjust the level of the signal coming in from the external instrument. Note however that excessive output levels from an external device may cause clipping in the audio hardware. The Return Gain setting cannot be used to compensate for this – you have to lower the output level on the device instead.</td>
</tr>
<tr>
<td>MIDI Device</td>
<td>When you click in this column, a pop-up menu opens where you can disconnect the instrument from the associated MIDI device, select a MIDI device, create a new device or open the MIDI Device Manager to edit the MIDI device. When Studio Manager 2 is installed, you may also select an OPT editor to access your external instrument.</td>
</tr>
<tr>
<td>Used</td>
<td>Whenever you insert the external instrument into a VST instrument slot, this column shows a checkmark (“✓”) to indicate that the instrument is being used.</td>
</tr>
</tbody>
</table>

- Note that external device ports are exclusive, see “Connecting the external effect/instrument” on page 30.

### How to use the external instrument

Once you have set up the external instrument in the VST Connections window, you can use it as a VST instrument. Open the VST Instruments window and click on an empty instrument slot. On the Instrument pop-up menu, your external instrument is listed on the External Plug-ins submenu.

When you select the external instrument in the VST Instruments window, the following happens:

- A parameter window for the external device opens automatically. This may either be the Device window, allowing you to create a generic device panel, an OPT editor window or a default editor. For information about the Device window, the MIDI Device Manager and User device panels, see the chapter “Using MIDI devices” on page 356.

To send MIDI notes to the external instrument, open the Output Routing pop-up menu in the Inspector for the corresponding MIDI track and select the MIDI device to which the external instrument is connected. This ensures use of delay compensation. The instrument will now play any MIDI notes it receives from this track and return them to Cubase through the return channel(s) you have set up.

The external instrument will behave like any other VST instrument in Cubase.
About the Favorites buttons

In the VST Connections window, both the External FX tab and the External Instruments tab feature a Favorites button.

Favorites are device configurations that you can recall at any time, like a library of external devices that are not constantly connected to your computer. They also allow you to save different configurations for the same device, e.g. a multi-effect board or an effect that provides both a mono and a stereo mode.

To save a device configuration as a favorite, proceed as follows:

- When you have added a new device in the VST Connections window, select it in the Bus Name column and click the Favorites button. A context menu is displayed showing an option to add the selected effect or instrument to the Favorites.
- You can recall the stored configuration at any time by clicking the Favorites button and selecting the device name from the context menu.

About the “plug-in could not be found” message

When you open a project that uses an external effect/instrument, you may get a “plug-in could not be found” message. This will happen when you remove an external device from the VST Connections window although it is used in a saved project, or when transferring a project to another computer on which the external device is not defined. You may also see this message when opening a project created with an earlier version of Cubase.

In the VST Connections window, the broken connection to the external device is indicated by an icon in the Bus Name column.

To reestablish the broken connection to the external device, simply right-click the entry for the device in the Bus Name column and select “Connect External Effect”. The icon is removed, and you can use the external device within your project as before.

⚠ Note that busses set up for external effects or external instruments are saved “globally”, i.e. for your particular computer setup.

Freezing external effects/instruments

Just as when working with regular VST instruments and effects, you can also choose to freeze external effects and instruments. The general procedure is described in detail in the chapters “Audio effects” on page 187 and “VST instruments and instrument tracks” on page 206.

⚠ Note that you have to perform Freeze in realtime. Otherwise external effects will not be taken into account.

When freezing external instruments or effects, you can adjust the corresponding tail value in the Freeze Channel Options dialog:

- Use the arrow buttons next to the Tail Size value field to set the desired Tail length, i.e. the range after the part boundary is also to be included in the freeze. You can also click directly in the value field and enter the desired value manually (the maximum value being 60s).
- When the Tail Size is set to 0s (default), the freezing will only take into account the data within the Part boundaries.
Editing operations

On the different tabs of the VST Connections window the corresponding busses or channels are shown in a table containing a tree view with expandable entries. After you have set up all the required busses for a project it might be necessary to edit the names and/or change port assignments. Cubase provides a number of features to make such tasks easier.

Expanding and collapsing entries

- Bus entries can be expanded or collapsed to show or hide the corresponding speaker channels or sub-busses by clicking the “+” or “-” sign in front of the corresponding list entry.
- To expand or collapse all entries on a tab at the same time, use the “+ All” button or the “- All” button (respectively) above the tree view.

Determining how many busses a device port is connected to

To give you an idea how many busses a given port is already connected to, the busses are shown in square brackets on the Device Port pop-up menu, to the right of the port name.

Up to three bus assignments can be displayed in this way. If more connections have been made, this is indicated by a number at the far right.

Therefore, if you see the following:

Adat 1 [Stereo1] [Stereo2] [Stereo3] (+2)…

this means that the Adat 1 port is already assigned to three stereo busses plus two additional busses.

Identifying exclusive port assignments

In some cases (i.e. for certain channel types such as Studio channels), the port assignment is exclusive. Once a port has been assigned to such a bus or channel, it must not be assigned to another bus, otherwise the connection to the first bus will be broken.

To help you identify such exclusive port assignments and avoid accidental reassignment, the corresponding ports are marked in red on the Device Port pop-up menu.

Selecting/Deselecting multiple entries

- Using the key commands [Ctrl]/[Command]-[A] (Select All) and [Shift]-[Ctrl]/[Command]-[A] (Select None), you can select and deselect all entries in the Bus Name column.

Note that for this to work, the table on the current tab needs to have the focus. This can be achieved by clicking anywhere on the background of the table.

- By holding [Shift] when selecting entries in the Bus Name column, you can select multiple entries at the same time.

This is useful for automatic renaming or changing the port assignments globally, see below.

⚠️ If you select a subentry (e.g. a speaker channel in a bus) the parent entry is automatically selected as well.

Selecting entries by typing the name

In the Bus Name list you can jump to an entry by typing the first letter of the bus name on the keyboard.

⚠️ This will only work if the table has the focus. To do this, simply select any list entry.

Navigating the Bus Name list using the [Tab] key

By pressing the [Tab] key you can jump to the next entry in the Bus Name list, allowing you to rename your busses quickly. Similarly, by pressing [Shift]-[Tab] you can return to the previous list entry.

Automatically renaming selected busses

You can rename all the selected busses at once using incrementing numbers or letters.

- To use incrementing numbers, select the busses that you want to rename and enter a new name for one of the busses, followed by a number.

For example, if you have eight inputs that you want to be named “In 1, In 2, …, In 8”, you select all the busses and enter the name “In 1” for the first bus. All other busses are then renamed automatically.
• To use letters from the alphabet, proceed as with numbers, but enter a capital letter instead of a number.
For example, if you have three FX channels that you want to be named “FX A, FX B, and FX C”, you select all the channels and enter the name “FX A” for the first. All other channels are then renamed automatically. The last letter that can be used is Z. If you have more selected entries than there are letters available, the remaining entries will be skipped.

⚠️ When using letters instead of numbers, it is important to note that these must be preceded by a space.
If you leave out the space before the letter or if you do enter neither a letter nor a number, only the first selected entry is renamed.

⚠️ You do not have to begin renaming with the topmost selected entry. The renaming will start from the bus where you edit the name, will go down the list to the bottom and then continue from the top until all selected busses have been renamed.

Changing the port assignment for a single bus
To change the port assignment for a single bus, you proceed as when you added it: Make sure that the channels are visible and click in the Device Port column to select ports.

Changing the port assignment for multiple busses
To change the port assignment (or the output routing in case of groups/FX channels) for multiple entries in the Bus Name column at the same time, you need to select the corresponding busses first.

• To assign different ports to the selected busses, press [Shift], open the Device Port pop-up menu for the first selected entry (i.e. the topmost bus) and select a device port.
All subsequent busses are automatically connected to the next available port.

⚠️ Cubase only: Exclusive ports (e.g. ports already assigned to Control Room channels) will be skipped!

• To assign the same port to all selected busses, press [Shift]-[Alt]/[Option], open the Device Port pop-up menu for the first selected entry (i.e. the topmost bus) and select a device port.

⚠️ You can also set all selected busses or channels to Not Connected.

Removing busses
To remove a bus you do not need, select it in the list, right-click and select Remove Bus from the pop-up menu, or press [Backspace].
The Project window
Window Overview

The Project window is the main window in Cubase. This provides you with an overview of the project, allowing you to navigate and perform large scale editing. Each project has one Project window.

About tracks

The Project window is divided vertically into tracks, with a timeline running horizontally from left to right. The following track types are available:

<table>
<thead>
<tr>
<th>Track type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>For recording and playing back audio events and audio parts. Each audio track has a corresponding audio channel in the Mixer. An audio track can have any number of automation tracks for automating Mixer channel parameters, effect settings, etc.</td>
</tr>
<tr>
<td>Folder</td>
<td>Folder tracks function as containers for other tracks, making it easier to organize and manage the track structure. They also allow you to edit several tracks at the same time, see “Organizing tracks in folder tracks” on page 79.</td>
</tr>
<tr>
<td>FX Channel</td>
<td>FX channel tracks are used for adding send effects. Each FX channel can contain up to eight effect processors — by routing effect sends from an audio channel to an FX channel, you send audio from the audio channel to the effect(s) on the FX channel. Each FX channel has a corresponding channel strip in the Mixer — in essence an effect return channel, see the chapter “Audio effects” on page 187. All FX channel tracks are automatically placed in a special FX channel folder in the track list, for easy management. An FX channel can also have any number of automation tracks for automating Mixer channel parameters, effect settings, etc.</td>
</tr>
<tr>
<td>Group Channel</td>
<td>By routing several audio channels to a Group channel, you can sum them, apply the same effects to them, etc. see “Using group channels” on page 165. A Group channel track contains no events as such, but displays settings and automation curves for the corresponding Group channel. Each Group channel track has a corresponding channel strip in the Mixer. In the Project window, Group channels are organized as tracks in a special Group Tracks folder.</td>
</tr>
</tbody>
</table>
The tracks in the Project window contain parts and/or events. Events are the basic building blocks in Cubase. Different event types are handled differently in the Project window:

- Video events and automation events (curve points) are always viewed and rearranged directly in the Project window.
- MIDI events can always be found in MIDI parts, which are containers for one or more MIDI events. MIDI parts are rearranged and manipulated in the Project window. To edit the individual MIDI events in a part, you have to open the part in a MIDI editor (see "The MIDI editors" on page 374).
- Audio events can be displayed and edited directly in the Project window, but you can also work with audio parts containing several events. This is useful if you have a number of events which you want to treat as one unit in the project. Audio parts also contain information about the time position in the project.

An audio event and an audio part

Getting on-the-fly info with the Arrow tool

If the "Select Tool: Show Extra Info" option is activated in the Preferences dialog (Editing–Tools page), a tooltip will be shown for the Arrow tool, displaying information depending on where you point it. For example, in the Project window event display, the tool will show the current pointer position and the name of the track and event you are pointing at.
The track list

The track list displays all the tracks used in a project. It contains name fields and settings for the tracks. Different track types have different controls in the track list. To see all available controls, you may have to resize the track in the track list (see “Resizing tracks” on page 73).

The track list showing a MIDI track, an audio track with an automation track, and a VST instrument track

- Using the Track Controls Settings dialog you can decide which controls are visible for each track type, see “Customizing track controls” on page 535.

The Inspector

The area to the left of the track list is called the Inspector. This shows additional controls and parameters for the track you have selected in the track list. If several tracks are selected, the Inspector shows the setting for the first (topmost) selected track.

Opening the Inspector

To show the Inspector, proceed as follows:

1. On the toolbar, click the “Set up Window Layout” button. A transparent pane appears, covering the Project window.

2. In the gray area in the middle, activate the Inspector option.

Inspector handling

For most track classes, the Inspector is divided into a number of sections, each containing different controls for the track. Which sections are available in the Inspector depends on the selected track.

- You can hide or show sections by clicking on their names. Clicking the name for a hidden section brings it into view and hides the other sections. [Ctrl]/[Command]-clicking the section name allows you to hide or show a section without affecting the other sections. [Alt]/[Option]-clicking a section name shows or hides all sections in the Inspector.

- You can also use key commands to show different Inspector sections. These are set up in the Key Commands dialog, see “Setting up key commands” on page 542.

  Hiding a section does not affect its functionality. For example, if you have set up a track parameter or activated an effect, your settings will still be active even if you hide the respective Inspector section.
Not all Inspector tabs are shown by default. You can show/hide Inspector sections by right-clicking on an Inspector tab and activating/deactivating the desired options on the Inspector Setup context menu.

⚠️ Make sure that you right-click on an Inspector tab and not on the empty area below the Inspector, as this will open the Quick context menu instead.

### Inspector sections

The Inspector contains the controls that can be found on the track list, plus some additional buttons and parameters. In the table below, these additional settings and the different sections are listed. Which sections are available for which track type is described in the following sections.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto Fades Settings</strong> button</td>
<td>Opens a dialog in which you can make separate Auto Fade settings for individual tracks on page 123.</td>
</tr>
<tr>
<td><strong>Edit Channel Settings</strong></td>
<td>Opens the Channel Settings window for the track, allowing you to view and adjust effect and EQ settings, etc., see &quot;Using Channel Settings&quot; on page 158.</td>
</tr>
<tr>
<td><strong>Volume</strong></td>
<td>Use this to adjust the level for the track. Changing this setting will move the track’s fader in the Mixer window, and vice versa. See &quot;Setting volume in the Mixer&quot; on page 152 to learn more about setting levels.</td>
</tr>
<tr>
<td><strong>Pan</strong></td>
<td>Use this to adjust the panning of the track. As with the Volume setting, this corresponds to the Pan setting in the Mixer.</td>
</tr>
<tr>
<td><strong>Delay</strong></td>
<td>This adjusts the playback timing of the audio track. Positive values delay the playback while negative values cause the track to play earlier. The values are set in milliseconds.</td>
</tr>
<tr>
<td><strong>Input Routing</strong></td>
<td>This lets you specify the input bus or MIDI input for the track. See “Setting up busses” on page 26 for information about input busses.</td>
</tr>
<tr>
<td><strong>Sends section</strong></td>
<td>Allows you to route an audio track to one or several FX channels, the chapter “Audio effects” on page 187.</td>
</tr>
<tr>
<td><strong>Equalizers section</strong></td>
<td>Lets you adjust the EQs for the track. You can have up to four bands of EQ for each track, see “Making EQ settings” on page 169. The Edit button at the top of the section opens the Channel Settings window for the track.</td>
</tr>
<tr>
<td><strong>Equalizer Curve section</strong></td>
<td>Lets you adjust the EQs for the track graphically, by clicking and dragging points in a curve display.</td>
</tr>
<tr>
<td><strong>Studio Sends (Cubase only)</strong></td>
<td>The Studio Sends are used to route cue mixes to Control Room Studios. For a detailed description of Studios and Studio Sends, see the chapter “Control Room (Cubase only)” on page 172.</td>
</tr>
<tr>
<td><strong>Surround Pan (Cubase only)</strong></td>
<td>When the SurroundPanner is used for a track, this is also available in the Inspector. For further information, see &quot;Using the SurroundPanner V5&quot; on page 220.</td>
</tr>
<tr>
<td><strong>Channel section</strong></td>
<td>Shows a duplicate of the corresponding Mixer channel strip. The channel overview strip to the left lets you activate and deactivate insert effects, EQs and sends.</td>
</tr>
<tr>
<td><strong>Notepad section</strong></td>
<td>This is a standard text notepad, allowing you to jot down notes about the track. If you open the File menu and select “Notepad Data…” from the Export submenu, your data will be exported as text file and opened in an external text editor from where you can print it. Note that you have to save your project first. If you have entered any notes about a track, the icon next to the “Notepad” heading will light up to indicate this. Moving the pointer over the icon will display the Notepad text in a tooltip.</td>
</tr>
<tr>
<td><strong>User Panel (Cubase only)</strong></td>
<td>Here you can display device panels, e.g. for external MIDI devices, audio track panels or VST insert effect panels. For information on how to create or import MIDI device and user panels, see the separate PDF document “MIDI Devices”.</td>
</tr>
<tr>
<td><strong>Quick Controls</strong></td>
<td>Here you can configure quick controls, e.g. to use remote devices, see the chapter &quot;Track Quick Controls&quot; on page 337.</td>
</tr>
</tbody>
</table>

### Audio tracks

For audio tracks, all settings and sections listed above are available.
**Instrument tracks**

As explained in the chapter “VST instruments and instrument tracks” on page 206, the Inspector for an instrument track shows some of the sections from VST instrument channels and MIDI tracks.

**MIDI tracks**

When a MIDI track is selected, the Inspector contains a number of additional sections and parameters, affecting the MIDI events in realtime (e.g. on playback). Which sections are available for MIDI tracks is described in the chapter “MIDI realtime parameters and effects” on page 348.

**Arranger track**

For the arranger track, the Inspector displays the lists of available arranger chains and arranger events. See the chapter “The arranger track” on page 124 for details.

**Folder tracks**

When a folder track is selected, the Inspector shows the folder and its underlying tracks, much like a folder structure in the Windows Explorer or Mac OS X Finder.

⇒ You can click one of the tracks shown under the folder in the Inspector to have the Inspector show the settings for that track. This way, you do not have to “open” a folder track to make settings for tracks within it.

**FX channel tracks**

When an FX channel track is selected, the following controls and sections are available:

- Edit button
- Volume control
- Pan control
- Output Routing pop-up menu
- Inserts section
- Equalizers section
- Equalizer Curve section
- Sends section (Cubase only)
- Studio Sends section (Cubase only)
- Surround Pan section (Cubase only)
- Channel section
- Notepad section

FX channel tracks are automatically placed in a special folder, for easier management. When this folder track is selected, the Inspector shows the folder and the FX channels it contains. You can click one of the FX channels shown in the folder to have the Inspector show the settings for that FX channel – this way you do not have to “open” a folder track to access the settings for the FX channels in it.

**Group channel tracks**

When a group channel track is selected, the following controls and sections are available:

- Edit button
- Volume control
- Pan control
- Output Routing pop-up menu
- Inserts section
- Equalizers section
- Equalizer Curve section
- Sends section
- Studio Sends section (Cubase only)
- Surround Pan section (Cubase only)
- Channel section
- Notepad section

Just like FX channel tracks, all group channel tracks are placed in a separate folder — when this is selected, the Inspector shows the folder and the group channels it contains. You can click one of the group channels shown in the folder to have the Inspector show the settings for that group channel — this way, you do not have to “open” a folder track to access the settings for the group channels in it.

**Marker tracks**

When the marker track is selected, the Inspector shows the marker list. For more information, see the chapter “Using markers” on page 138.

**Ruler tracks**

For ruler tracks, the Inspector is not used.

**Transpose track**

When the transpose track is selected, the following controls and sections are available:

- Mute button
- Keep Transpose in Octave range
The transpose track controls are described in detail in the chapter “The transpose functions” on page 131.

Signature track and tempo track

For the signature track and the tempo track, the Inspector displays a list of all time signature events or tempo events. See the chapter “Editing tempo and signature” on page 462 for details.

Video tracks

When a video track is selected, the Inspector contains a lock button for locking the track (see the section “Locking events” on page 65), a Mute button for interrupting video playback and two settings for video thumbnails: Show Frame Numbers and Show Thumbnails (see the section “Video files in the Project window” on page 513).

Video tracks make use of the Notepad Inspector tab.

The toolbar

The toolbar contains tools and shortcuts for opening other windows and various project settings and functions.

You can show/hide most of the toolbar elements (except the Activate Project and “Set up Window Layout” buttons) by activating/deactivating the corresponding options on the context menu. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constrain Delay Compensation</td>
<td>This is described in the section “Constrain Delay Compensation” on page 216.</td>
</tr>
<tr>
<td>Media &amp; Mixer Windows</td>
<td>When this is activated, buttons for opening or closing the MediaBay, the Pool, the Mixer, and the Control Room Mixer (Cubase only) are displayed on the toolbar.</td>
</tr>
<tr>
<td>Performance Meter</td>
<td>When this is activated, meters for ASIO time usage and hard disk transfer load are displayed, see “About the VST Performance window” on page 24.</td>
</tr>
<tr>
<td>Automation Mode</td>
<td>When this is activated, the automation mode and a button to open/close the Automation panel are displayed on the toolbar. For details, see the chapter “Automation” on page 227.</td>
</tr>
</tbody>
</table>

How to further set up the toolbar is described in the section “Using the Setup options” on page 534.

Using the toolbox

The toolbox can be opened instead of the standard context menus in the event display and editors. It makes the editing tools from the toolbar conveniently available at the mouse pointer position.

• To open the toolbox by right-clicking (Win)/[Ctrl]-clicking (Mac), activate the “Popup Toolbox on Right Click” option in the Preferences dialog (Editing–Tools page). When this option is activated, you need to press any modifier key and right-click (Win)/[Ctrl]-click (Mac) to open the context menu. When it is deactivated, you need to press a modifier key to open the toolbox instead of the context menu.
• To change the number of rows in which the tools are arranged on the toolbox, keep the right mouse button pressed on the toolbox until the mouse pointer changes to a double arrow, and drag to the bottom or right. The tools can be arranged in one, two, or three horizontal or vertical rows.

The status line
The status line is displayed below the toolbar in the Project window.

It displays the following information:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Time Max</td>
<td>This displays the time you have left for recording, depending on your project settings and the available hard disk space. Click in this field to display the remaining record time in a separate window.</td>
</tr>
<tr>
<td>Record Format</td>
<td>This displays the sample rate and the bit resolution used for recording.</td>
</tr>
<tr>
<td>Project Frame Rate</td>
<td>This displays the frame rate used in the project.</td>
</tr>
<tr>
<td>Project Pan Law</td>
<td>This displays the current Pan Law setting.</td>
</tr>
</tbody>
</table>

Clicking on any of the fields except the Record Time Max display opens the Project Setup dialog, where you can adjust the settings (see “The Project Setup dialog” on page 54).

Cubase permits different sample rate settings for a project and the audio hardware. However, as a result the audio files in a project will not play back in their original pitch. If the “Record Format” field is highlighted in a different color, there is a sample rate mismatch and you should check the settings in the Project Setup dialog.

• To show or hide the status line, click the “Set up Window Layout” button on the toolbar and activate or deactivate the Status Line option.

The info line
The info line is displayed below the status line in the Project window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ] Bar</td>
<td></td>
<td>5.1.0</td>
<td>7.1.0</td>
</tr>
</tbody>
</table>

The info line shows information about the currently selected event or part in the Project window. You can edit almost all values on the info line using regular value editing. Length and position values are displayed in the format currently selected for the ruler (see “The ruler” on page 44).

• To show or hide the info line, click the “Set up Window Layout” button on the toolbar and activate or deactivate the Info Line option.

The following elements can be selected for display and editing on the info line:

• Audio events
• Audio parts
• MIDI parts
• Video events
• Markers
• Automation curve points
• Transpose events
• Arranger events

When several elements are selected

• If you have selected several elements, the info line shows information about the first item in the selection. The values are displayed in color to indicate that several elements are selected.

• If you edit a value on the info line, the value change is applied to all selected elements, relatively to the current values.

If you have selected two audio events, the first being one bar long and the second two bars, the info line shows the length of the first event (one bar). If you now change this value to 3 bars in the info line, the other event will be resized by the same amount – and will thus be 4 bars long.

• To enter absolute values for the selected elements, press [Ctrl]/[Command] while modifying the value on the info line. In the example above, both events would be resized to 3 bars.

[Ctrl]/[Command] is the default modifier key for this – you can change this in the Preferences dialog (Editing–Tool Modifiers page, in the Info Line category).
**Editing transpose and velocity for MIDI parts**

When one or several MIDI parts are selected, the info line contains Transpose and Velocity fields.

- Adjusting the Transpose field transposes the selected parts in semitone steps. Note that this transposition does not change the actual notes in the part – it is just a "play parameter", affecting the notes on playback. The transposition you specify for a part on the info line is added to the transposition set for the whole track. For more information on transposing, see the chapter "The transpose functions" on page 131.

- Adjusting the Velocity field shifts the velocity for the selected parts – the value you specify is added to the velocities of the notes in the parts. Again, this velocity shift only affects the notes on playback, and again, the value you specify is added to the Vel.Shift. value set for the whole MIDI track in the Inspector.

**The overview line**

The overview line is displayed below the info line in the Project window. In the overview line, events and parts on all tracks are displayed as boxes.

- To show/hide the overview line, proceed as for the info line (see above), but activate the Overview Line option instead.

You can use the overview line to zoom in or out, and for navigating to other sections of the project. This is done by moving and resizing the track view rectangle in the overview line:

- The track view rectangle indicates the section of the project currently displayed in the event display.
- You zoom in or out horizontally by resizing the rectangle. Resize it by dragging the edges of the rectangle.

- You can drag the track view rectangle to view other sections of the project. This can also be done by clicking anywhere in the upper part of the overview – the track view rectangle will be moved to where you clicked.

**The ruler**

The ruler at the top of the event display shows the timeline. Initially, the Project window ruler uses the display format specified in the Project Setup dialog (see "The Project Setup dialog" on page 54), as do all other rulers and position displays in the project. However, you can select an independent display format for the ruler by clicking the arrow button to the right of it and selecting an option from the pop-up menu (you can also bring up this pop-up menu by right-clicking anywhere in the ruler).

<table>
<thead>
<tr>
<th>Option</th>
<th>Positions and lengths displayed as</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bars + Beats</td>
<td>Bars, beats, sixteenth notes and ticks. By default there are 120 ticks per sixteenth note, but you can adjust this with the &quot;MIDI Display Resolution&quot; setting in the Preferences dialog (MIDI page).</td>
</tr>
<tr>
<td>Seconds</td>
<td>Hours, minutes, seconds and milliseconds.</td>
</tr>
<tr>
<td>Timecode</td>
<td>This format displays hours, minutes, seconds, and frames. The number of frames per second (fps) is set in the Project Setup dialog with the Frame Rate pop-up menu (see &quot;The Project Setup dialog&quot; on page 54).</td>
</tr>
<tr>
<td>Samples</td>
<td>Samples.</td>
</tr>
<tr>
<td>fps (User)</td>
<td>Hours, minutes, seconds and frames, with a user-definable number of frames per second. You set the desired number of fps in the Preferences dialog (Transport page).</td>
</tr>
<tr>
<td>Time Linear</td>
<td>When this is selected, the ruler will be linear relative to time. This means that if there are tempo changes on the tempo track, the distance between the bars will vary in Bars + Beats mode.</td>
</tr>
<tr>
<td>Bars + Beats Linear</td>
<td>When this is selected, the ruler will be linear relative to the meter position – bars and beats. This means that if there are tempo changes on the tempo track, there will still be the same distance between bars in Bars + Beats mode. If the ruler is set to a time-based mode, the distance between seconds will vary depending on the tempo changes.</td>
</tr>
</tbody>
</table>

- The selection you make here affects the ruler, the info line and tooltip position values (which appear when you drag an event in the Project window). You can also select independent formats for other rulers and position displays.
• To set the display format globally (for all windows), use the primary display format pop-up on the Transport panel, or hold down [Ctrl]/[Command] and select a display format in any ruler.

• If you use the “Timecode” or “User” options and the “Show Timecode Subframes” option are activated in the Preferences dialog (Transport page), the frames will also display subframes. There are 80 subframes per frame.

Using multiple rulers – ruler tracks
As described above, the Cubase Project window contains a main ruler at the top of the event display, displaying the timeline from left to right.

If needed, you can have several rulers in the Project window, by adding ruler tracks to the project. Each ruler track contains an additional ruler.

• To add a ruler track, open the “Add Track” submenu from the Project menu and select “Ruler”. A ruler track showing an additional ruler is added to the track list.

You can add any number of ruler tracks to a project, and position them as needed by dragging them up or down in the track list. Each of the rulers can show a separate display format.

• To select a display format for a ruler track, click on its name in the track list and select an option from the pop-up menu.

Note that ruler tracks are completely independent from the main event display ruler, as well as rulers and position displays in other windows. This means that:

• Each ruler track in a project can have its own display format.

• Ruler tracks are not affected by the display format setting in the Project Setup dialog (see “The Project Setup dialog” on page 54).

• Ruler tracks are not affected if you set the display format globally with the primary time display in the Transport panel.

Φ Ruler tracks are affected by the “Show Timecode Subframes” option in the Preferences dialog (Transport page, see above).

The Snap function
The Snap function helps you to find exact positions when editing in the Project window. It does this by restricting horizontal movement and positioning to certain positions. Operations affected by Snap include moving, copying, drawing, sizing, splitting, range selection, etc.

• You turn Snap on or off by clicking the Snap icon on the toolbar.

When you are moving audio events with Snap activated, it is not necessarily the beginning of the event that is used as Snap position reference. Instead, each audio event has a snap point, which you can set to a relevant position in the audio (such as a downbeat, etc.).

The snap point is preferably set in the Sample Editor since it allows for a higher degree of precision (see “Adjusting the snap point” on page 268). However, you can also set the snap point directly in the Project window, in the following way:

1. Select an event.

2. Place the project cursor at the desired position within the selected audio event.
3. Pull down the Audio menu and select “Snap Point To Cursor”.
   The snap point is set at the cursor position.

The snap point for an event is displayed as a vertical line in the Project window.

The Snap Type pop-up menu

To determine how the Snap function works, open the Snap Type pop-up menu and select one of the available options.

In the Snap Type pop-up menu the following options are available:

Grid
If you select this Snap type, the Snap positions are set with the Grid Type pop-up menu. The options depend on the display format selected for the ruler. For example, if the ruler is set to show bars and beats, the grid can be set to bars, beats, or the quantize value set with the selected quantize preset. If a time or frame-based ruler format is selected, the Grid Type pop-up menu contains time or frame-based grid options, etc.

Grid Relative
If you select this Snap type, events and parts will not be “magnetic” to the grid. Rather, the grid determines the step size for moving the events. This means that a moved event will keep its original position relative to the grid.

For example, if an event starts at the position 3.04.01 (one beat before bar 4), Snap is set to Grid Relative and the Grid Type pop-up menu is set to “Bar”, you can move the event in steps of one bar – to the positions 4.04.01, 5.04.01 and so on. The event will keep its relative position to the grid, i.e. stay one beat before the bar lines.

- This only applies when dragging existing events or parts – when you create new events or parts this snap type works like “Grid”.

Events
This grid type makes the start and end positions of other events and parts become “magnetic”. This means that if you drag an event to a position near the start or end of another event, it is automatically aligned with the start or end of the other event. For audio events, the position of the snap point is also magnetic (see “Adjusting the snap point” on page 268).

- Note that this includes marker events on the marker track. This allows you to snap events to marker positions, and vice versa.

Shuffle
Shuffle is useful when you want to change the order of adjacent events. If you have two adjacent events and drag the first one to the right, past the second event, the two events will change places.

When Seconds is selected as ruler format, the Grid Type pop-up menu contains time-based grid options.
The same principle works when changing the order of more than two events:

![Diagram showing events 1, 2, 3, 4, 5 with arrows indicating movement]

Dragging event 2 past event 4...

...changes the order of events 2, 3 and 4.

**Magnetic Cursor**

This grid type lets the project cursor become “magnetic”. Dragging an event near the cursor causes the event to be aligned with the cursor position.

**Grid + Cursor**

This is a combination of “Grid” and “Magnetic Cursor”.

**Events + Cursor**

This is a combination of “Events” and “Magnetic Cursor”.

**Events + Grid + Cursor**

This is a combination of “Events”, “Grid” and “Magnetic Cursor”.

**Snap to Zero Crossing**

When this option is activated on the toolbar, splitting and sizing of audio events is done at zero crossings (positions in the audio where the amplitude is zero). This helps you avoid pops and clicks which might otherwise be caused by sudden amplitude changes.

**Auto-Scroll**

When the Auto-Scroll option is activated, the waveform display will scroll during playback, keeping the project cursor visible in the window. You can find the Auto-Scroll button on the toolbars of the Project window and all editors.

- If the “Stationary Cursors” option is activated in the Preferences dialog (Transport page), the project cursor will be positioned in the middle of the screen (if possible).

**Suspending Auto-Scroll**

When editing parts or events during playback with Auto-Scroll enabled, you may suddenly “lose sight” of the edited material as the display follows the project cursor.

If you do not want the Project window display to change when editing during playback, you can activate the “Suspend Auto-Scroll when Editing” button. You will find this button right next to the Auto-Scroll button. When this option is enabled, auto-scrolling is suspended as soon as you click anywhere in the event display during playback.

Proceed as follows:

1. Open a project that contains audio or MIDI parts/events.
2. Enable both the “Auto-Scroll” and the “Suspend Auto-Scroll when Editing” buttons.
3. Start playback.
4. Edit an audio or MIDI part/event of your project (e.g. click and drag it to a different location on its track). The Auto-Scroll button turns orange.

Auto-Scrolling is now suspended, i.e. when the project cursor moves to the right edge of the Project window, the display will not follow to keep the cursor visible.

As soon as playback stops or when you click the Auto-Scroll button again, Cubase will return to the normal Auto-Scroll behavior.
Working with projects
Creating new projects

The Project Assistant dialog is opened by selecting the “New Project…” command on the File menu. In this dialog you can access recently opened projects and create new projects, which can either be empty or based on a template.

The Project Assistant dialog will also open in the following cases:

- If you launch Cubase with the “Show Project Assistant” option selected on the “On Startup” pop-up menu in the Preferences dialog (General page).
- If you hold down [Ctrl]/[Command] while launching Cubase.

Opening recent projects

The Recent category in the category bar of the Project Assistant dialog contains a list of recently opened projects. When you select an item in this category, the Create button changes to “Open”, allowing you to open the corresponding project. This list is similar to the list in the Recent Projects submenu of the File menu.

Choosing a template

In the category bar of the Project Assistant dialog, the available factory templates are sorted into the predefined categories Recording, Production, Scoring, and Mastering. Furthermore, there is a More category which contains the default project template (see “Setting up a default template” on page 51) and all templates that are not assigned to any of the other categories.

When you click on one of the category items, the list below the category bar shows the available factory templates for this category that were installed with Cubase. Any new templates that you create (see “Save as Template” on page 51) are added at the top of the corresponding list for convenient access.

- To create an empty project that is not based on a template, select the “Empty” entry in the More category and click the Create button.

An empty project is also created if no template is selected in the currently shown category.

- You can rename or delete a template by right-clicking it in the list and selecting the corresponding option on the context menu.

- To open the folder in which the selected template is stored in the Windows Explorer/Mac OS Finder, right-click the template in the list and select “Show in Explorer” (Win) or “Reveal in Finder” (Mac).

Choosing a project location

The options in the lower part of the dialog allow you to specify where the project is stored.

- Select “Use default location” to create the project in the default project location (as shown in the path field), and click Create.

In the “Project folder” field you can specify a name for the project folder. If you do not specify a project folder here, the project will reside in a folder named “Untitled”.

- To change the default project location, simply click in the path field. A file dialog opens, allowing you to specify a new default location.

- Select “Prompt for project location” and click Continue to create the project in a different location.

In the dialog that appears, specify a location and a project folder.
Open Other
The “Open Other” button allows you to open any project file on your system. This is identical to using the Open command from the File menu, see below.

Opening projects
The “Open…” command on the File menu is used for opening saved project files. Project files created with Cubase (file extension “.cpr”), Nuendo (file extension “.npr”) and Sequel (extension “.steinberg-project”) can be opened.

- If you open a project from a different program version that contains data for functions not available in your version, this data may get lost when saving the project with your version.

- Several projects can be open at the same time. This is useful if you want to copy parts or entire sections from one project to another.

- If there is already an open project, you will be asked if you want to activate the new project.

- Click No to open the project inactive. This significantly reduces load times, especially for large projects.

- Click Activate to open and activate the new project. The active project is indicated by the lit Activate Project button in the upper left corner of the Project window. To activate a different project, simply click its Activate Project button.

- You can also open project files by selecting an entry from the “Recent Projects” submenu of the File menu. This submenu lists the projects you have recently worked with, with the most recent at the top of the list. The list can also be found in the Project Assistant dialog, see “Creating new projects” on page 49.

- You can also set Cubase to automatically open a project when you launch the program (see “Startup Options” on page 54).

About the “Missing Ports” dialog
If you open a Cubase project created on a different system (other audio hardware), the program tries to find matching audio inputs and outputs for the i/o busses (this is one of the reasons why you should use descriptive, generic names for your input and output ports – see “Preparations” on page 27).

If the program cannot resolve all audio/MIDI inputs and outputs used in the project, a Missing Ports dialog will open. This allows you to manually re-route any ports specified in the project to ports available in your system.

Closing projects
The Close command on the File menu closes the active window. If a Project window is active, selecting this closes the corresponding project.

- If the project contains unsaved changes, you are asked whether you want to save it before closing.

- If you select “Don’t Save” and have recorded or created new audio files since saving, you will be asked if you want to delete or keep these.

Saving projects
Save and Save As
The commands Save and Save As allow you to save the active project as a project file (file extension “.cpr”). The Save command stores the project under its current name and location, while Save As allows you to rename and/or relocate the file. If a project has not been saved yet or if it has not been changed since it was last saved, only Save As is available.

Generally, we recommend that you save project files in their project folders, to keep the projects as manageable as possible.
A word about file extensions

Under Windows, file types are indicated by three letter file name extensions (such as *.cpr for Cubase project files).

Under Mac OS X, it is not necessary to use file name extensions, since the file types are stored internally in the files. However, if you want your Cubase projects to be compatible with both platforms, make sure that the “Use File Extension in File Dialog” option is activated in the Preferences dialog (General page). When this is activated, the proper file name extension is automatically added when you save a file.

Save New Version

This function is only available as a key command, by default [Ctrl]/[Command]-[Alt]/[Option]-[S]. When you use this function, an identical, new project file is being created and activated.

The new file will get the same name as the original project, but with an incremental number attached. For example, if your project is called “My Project”, you will get new versions called “My Project-01”, “My Project-02”, and so on.

Save New Version is useful if you are experimenting with edits and arrangements and want to be able to go back to a previous version at any time. The newest versions are always listed on the Recent Projects submenu of the File menu for instant access (see also “Opening recent projects” on page 49).

Save as Template

This function allows you to save the current project as a template. When you create a new project, the available templates are listed, allowing you to base the new project on a template.

Proceed as follows:

1. Set up a project.
2. Select “Save As Template…” from the File menu and enter a name for the new project template.
3. In the Attribute Inspector section you can assign the template to one of the four template categories shown in the Project Assistant dialog (see “Creating new projects” on page 49) and/or enter a description for the template. Simply select a category value from the Template Category pop-up menu and/or enter a description in the Content Summary field.

If you do not choose a Template Category attribute, the new template will be shown in the More category in the Project Assistant dialog.

3. Click OK to save the template.

Templates can contain clips and events just like regular projects.

If this is not what you want, make sure to remove all clips from the Pool before you save the project as a template.

Templates are always stored in the Templates folder, see “Where are the settings stored?” on page 539.

Setting up a default template

If you always want the same default project to open when you launch Cubase, you can save a default template. Proceed as follows:

1. Set up a project.
2. Select “Save As Template…” from the File menu and save the project template with the name “default”.
3. Open the Preferences dialog and select the General page.
4. Open the “On Startup” pop-up menu and select “Open ‘Default’ Template”.

The next time you launch Cubase, the default template will automatically be opened. For details on the other Startup options, see “Startup Options” on page 54.

Reverting to the last saved version

If you select “Revert” from the File menu, you will be asked whether you really want to revert to the last saved version of the project. If you click “Revert”, all changes you have made since saving will be discarded.

If you have recorded or created new audio files since saving, you will be asked whether you want to delete or keep these.
Auto Save

If you activate the Auto Save option in the Preferences dialog (General page), Cubase will automatically save backup copies of all open projects with unsaved changes.

These backup copies are named "<project name>-xx.bak", where xx is an incremental number. Unsaved projects are backed up in a similar way as "UntitledX-xx.bak", with X being the incremental number for unsaved projects. All backup files are saved in the project folder.

• Use the “Auto Save Interval” setting to specify the time intervals in which a backup copy will be created.
• Use the “Maximum Backup Files” option to specify how many backup files will be created with the Auto Save function.

When the maximum number of backup files is reached, the existing files will be overwritten (starting with the oldest file).

⇒ With this option only the project files themselves will be backed up. If you want to include the files from the Pool and save your project in a different location, you need to use the “Back up Project” function.

The Archive and Backup functions

Prepare Archive

The “Prepare Archive” function verifies that every clip referenced in the project is located in the same folder, and takes actions if that is not the case:

• Any files that are located outside the current project folder will be copied into it.

Please note that audio files residing within the project folder are not copied to the audio folder. Therefore, you have to copy them there manually before backing up the audio folder or save them separately during backup, see below.

• If any processing has been applied, you will be asked whether you want to Freeze Edits.

If you do this, you do not have to archive the Edits folder. Everything belonging to the project will be contained in the project file and the Audio folder.

Once you have performed a Prepare Archive operation, you can use the “Back Up Project” function to create a backup of the project file, containing copies of all necessary media files (with the exception of VST Sound content, see below).

It is not necessary to archive the Images folder, since these images can be recreated by Cubase. You may also find a file with the extension “.csh” in the project folder. This contains image information for edited clips and other data that can be recreated, so it can safely be deleted.

⚠️ Video clips are always referenced and not stored in the project folder.

Back up Project

This function is very useful if you want to create a backup copy of a project for your archive. It can also be used to prepare projects for delivery so that they only contain the necessary work data (while leaving the original project untouched). When you back up a project, all media files (except those coming from VST Sound archives) can be included as a copy.

⚠️ VST Sound content provided by Steinberg is copy-protected and will not be included in the backup project. If you want to use a backup copy of a project using such data on a different computer, make sure that the corresponding content is also available on that computer.
1. Select “Back up Project…” from the File menu.
A file dialog opens in which you can choose an existing empty folder or create a new folder to save the project.

2. Click OK.
The “Back up Project Options” dialog opens.

This dialog contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>Enter a project name if you want to change it from the default (the current name of the project).</td>
</tr>
<tr>
<td>Keep Current Project Active</td>
<td>When this option is activated, the current project will still be the active project after clicking OK. If you wish to switch to the new backup project instead, deactivate this option.</td>
</tr>
<tr>
<td>Minimize Audio Files</td>
<td>If this is activated, only the audio file portions that are actually used in the project will be included. This can significantly reduce the size of the project folder (if you are using small sections of large files), but it also means you cannot use other portions of the audio files if you continue working with the project in its new folder.</td>
</tr>
<tr>
<td>Freeze Edits</td>
<td>This will perform a Freeze Edits operation, making all processing and applied effects permanent to each clip in the Pool, see “Freeze Edits” on page 255.</td>
</tr>
<tr>
<td>Remove Unused Files</td>
<td>When this is activated, only files in the Pool that are actually used in the project will be stored in the new folder.</td>
</tr>
<tr>
<td>Do Not Back up Video</td>
<td>When this is activated, any video clips on the video track or in the Pool of the current project will not be included in the backup project.</td>
</tr>
</tbody>
</table>

3. Make the desired settings.

4. Click OK.
A copy of the project is saved in the new folder. The original project is not affected.

Cleanup
The Cleanup function on the File menu helps you to save hard disk space by locating and – if you like – deleting unused audio files in the project folders on your disk.

1. Select “Cleanup…” from the File menu.
If there are any open projects, an alert shows. Clicking “Close” closes all open projects and brings up the dialog “Cleanup Cubase Project Folders”.

2. To restrict the Cleanup function to a certain folder, click the “Search Folder” button and select the folder.
The default setting is that the Cleanup function is applied to all folders on all hard disks. Only select a specific folder if you are certain it does not contain audio files used in other projects outside the folder), see below. You can reset the function to search all folders by opening the “Search Folder” dialog again and clicking “Cancel”.

3. Click the Start button.
Cubase will now scan the selected folder (or all hard disks) for Cubase project folders and check for audio and image files (in the Audio, Edits and Images subfolders) that are not used by any project. The found files are listed in the dialog.

4. When the scan is complete, you can select files by clicking in the list.
Use [Ctrl]/[Command]-click to select several files, and [Shift]-click to select a range of files. You can also click the Select All button to select all files in the list.

In the following situations, the Cleanup function will list files that are not unused:

- If you have moved or renamed files or folders (without updating the project files to use the new paths), there is no way for Cubase to know that these files are used in a project.
- If you perform the Cleanup function on a folder in which there are audio files belonging to other projects (outside the folder), these files will be considered “unused”.
- Also, make sure that you do not delete any files used in other applications, or files that you generally want to keep!

However, you can always safely delete image files since these can be reconstructed by the program, if necessary.

5. Delete any files you do not want to keep by selecting them and clicking Delete.

6. Close the dialog by clicking the Close button.
Startup Options

The “On Startup” pop-up menu in the Preferences dialog (General page) allows you to specify what happens when you launch Cubase.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do Nothing</td>
<td>Cubase launches without opening a project.</td>
</tr>
<tr>
<td>Open Last Project</td>
<td>The last saved project is opened on launch.</td>
</tr>
<tr>
<td>Open ‘Default’ Template</td>
<td>The default template is opened, see “Setting up a default template” on page 51.</td>
</tr>
<tr>
<td>Show Open Options Dialog</td>
<td>The Open dialog opens on launch, allowing you to manually locate and open the desired project.</td>
</tr>
<tr>
<td>Show Project Assistant</td>
<td>The Project Assistant dialog opens on launch, allowing you to open a recently opened project or to create a new project from one of the templates (see “Creating new projects” on page 49).</td>
</tr>
</tbody>
</table>

The following settings are available in the Project Setup dialog:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author</td>
<td>Here you can add a name that will be written as the project author into the iXML chunk when exporting audio files with the corresponding option activated (see “AIFF files” on page 489). The default setting for this can be set in the Preferences dialog (General–Personalization page).</td>
</tr>
<tr>
<td>Company</td>
<td>Here you can add a name that will be written as the company name into the iXML chunk when exporting audio files with the corresponding option activated (see “AIFF files” on page 489). The default setting for this can be set in the Preferences dialog (General–Personalization page).</td>
</tr>
</tbody>
</table>
### Setting | Description
--- | ---
Start | The start time of the project. Allows you to have the project start at another time than zero. Also used for setting the sync start position when synchronizing Cubase to external devices (see the chapter “Synchronization” on page 493). The format of this value is always in timecode. When you change this setting you will be asked whether you want to keep the project content at its timecode positions. “Yes” means that all events will stay at their original timecode positions – i.e. they will be moved in relation to the start of the project. “No” means that all events keep their position relative to the project start.
Length | The length of the project.
Frame Rate | This setting determines both the timecode standard and frame rate for the project, see the section “Timecode standards” on page 495. The frame rate of a video file used in a project should match the frame rate set for a project. The “Get From Video” button allows you to set the project frame rate to the frame rate of an imported video file, see the section “Adopting the video frame rate” on page 512. When synchronizing Cubase to an external device, make sure that this setting corresponds to the frame rate of any incoming timecode. However, there might be situations where perfect synchronization does not matter to you and you do not want to change the project frame rate. In this case, the frame rate mismatch will be indicated on the Transport panel in the Sync section.
Display Format | This is the global display format used for all rulers and position displays in the program, except ruler tracks (see “Ruler tracks” on page 41). However, you can make independent display format selections for the individual rulers and displays if you like. For descriptions of the different display format options, see “The ruler” on page 44.
Display Offset | Offsets the time positions displayed in the ruler, etc., allowing you to compensate for the Start position setting. Typically, if you synchronize Cubase to an external source starting at a frame other than zero, you set the Start position to this value. However, if you still want the display in Cubase to start at zero, set the Display Offset to the same value.
Bar Offset | This works just like “Display Offset” described above, in that it offsets the time positions in the ruler by a number of bars, allowing you to compensate for the Start position setting. The difference is that Bar Offset is only used when the “Bars+Beats” display format is selected (see “The ruler” on page 44).

### Setting | Description
--- | ---
Sample Rate | The sample rate at which Cubase records and plays audio. The order of the menu items depends on the sample rates available for your audio hardware. Supported settings are displayed in the upper part of the menu, non-supported settings are displayed in the lower part. Regarding the sample rate, there are two possible scenarios: Either your audio hardware generates the audio clock signals itself or it is clocked externally, i.e. receives signals from an external sample clock source (see “If your hardware setup is based on an external clock source” on page 18). If the sample rate is generated internally, the following applies: When you select a sample rate non-supported by your audio hardware (from the lower part of the menu), it is highlighted in a different color and the corresponding tooltip shows a warning. In this case you must set a different sample rate to make your audio files play back properly. When you specify a project sample rate that your audio hardware supports but which is different from the current audio hardware sample rate, and you confirm your settings by clicking OK, the sample rate setting of the audio hardware is automatically changed to the project sample rate.
Bit Resolution/Record File Type | When you record audio in Cubase, the files that are created will be of this resolution and file type, see “Selecting a recording file format” on page 92.
Stereo Pan Law | Decides whether panning uses power compensation or not, see “About the “Stereo Pan Law” setting” on page 157.

⚠️ While most Project Setup settings can be changed at any time, you should set the sample rate directly after creating a new project! If you change the sample rate at a later stage, you must convert all audio files in the project to the new sample rate to make them play back properly.
Zoom and view options

Zooming in the Project window is done according to the standard zoom techniques, with the following special notes:

• When you are using the Zoom tool (magnifying glass), the result depends on the “Zoom Tool Standard Mode: Horizontal Zooming Only” option in the Preferences dialog (Editing–Tools page).
  
  If this is activated and you drag a selection rectangle with the Zoom tool, the window will only be zoomed horizontally (track height will not change).
  
  If the option is off, the window will be zoomed both horizontally and vertically.

• When using the vertical zoom sliders, the tracks are scaled relatively.
  
  In other words, if you have made any individual track height adjustments (see below), the relative height differences are maintained.

You find the following options are available on the Zoom submenu on the Edit menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Zooms in one step, centering on the project cursor.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zooms out one step, centering on the project cursor.</td>
</tr>
<tr>
<td>Zoom Full</td>
<td>Zooms out so that the whole project is visible. “The whole project” means the timeline from the project start to the length set in the Project Setup dialog (see above).</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>Zooms in horizontally and vertically so that the current selection fills the screen.</td>
</tr>
<tr>
<td>Zoom to Selection (Horiz)</td>
<td>Zooms in horizontally so that the current selection fills the screen.</td>
</tr>
<tr>
<td>Zoom to Event</td>
<td>This option is available only in the Sample Editor (see “Zooming” on page 266).</td>
</tr>
<tr>
<td>Zoom In Vertically</td>
<td>Zooms in one step vertically.</td>
</tr>
<tr>
<td>Zoom Out Vertically</td>
<td>Zooms out one step vertically.</td>
</tr>
<tr>
<td>Zoom In Tracks</td>
<td>Zooms in on the selected track(s) one step vertically.</td>
</tr>
<tr>
<td>Zoom Out Tracks</td>
<td>Zooms out the selected track(s) one step vertically.</td>
</tr>
<tr>
<td>Zoom Selected Tracks</td>
<td>This zooms in vertically on the selected track(s) and minimizes the height of all other tracks.</td>
</tr>
<tr>
<td>Undo/Redo Zoom</td>
<td>These options allow you to undo/redo the last zoom operation.</td>
</tr>
</tbody>
</table>

• If the “Zoom while Locating in Time Scale” option is activated in the Preferences dialog (Transport page), you can also zoom by clicking in the ruler and dragging up or down with the mouse button pressed.
  
  Drag up to zoom out; drag down to zoom in.

• You can zoom the contents of parts and events vertically, using the waveform zoom slider in the top right corner of the event display.
  
  This is useful when viewing quiet audio passages.

⚠️ To get an approximate reading on the level of the audio events by viewing the waveforms, make sure this slider is all the way down. Otherwise, zoomed waveforms may be mistaken for clipped audio.

• If you activate the option Quick Zoom in the Preferences dialog (Editing page), the contents of parts and events will not be continuously redrawn when you zoom manually.
  
  Instead, the contents are redrawn once you have stopped changing the zoom – activate this if screen redraws are slow on your system.

Zoom presets and cycle markers

The pop-up menu to the left of the horizontal zoom control allows you to select, create and organize zoom presets. These are useful if you want to toggle between different zoom settings (e.g. one where the whole project is displayed in the project window and another with a high zoom factor for detailed editing). With this pop-up menu, you can also zoom in on the area between cycle markers in the project.

Click here…

…to open the context menu.
The upper part of the menu lists the zoom presets:

- To store the current zoom setting as a preset, select Add from the pop-up menu. A dialog opens, allowing you to type in a name for the preset.
- To select and apply a preset, select it from the pop-up menu.
- The “Zoom Full” preset is always available. Selecting this option zooms out so that the whole project is visible. “The whole project” means the timeline from the project start to the length set in the Project Setup dialog (see “The Project Setup dialog” on page 54).
- If you want to delete a preset, select “Organize…” from the pop-up menu. In the dialog that opens, select the preset in the list and click the Delete button. The preset is removed from the list.
- If you want to rename a preset, select “Organize…” from the pop-up menu. In the dialog that opens, select the desired preset in the list and click the Rename button. A second dialog opens, allowing you to type in a new name for the preset. Click OK to close the dialogs.

⚠️ Zoom presets are global for all projects, i.e. they are available in all projects you open or create.

The middle part of the pop-up menu lists any cycle markers you have added to the project:

- If you select a cycle marker from this menu, the event display is zoomed in to encompass the marker area.
- You cannot edit the cycle markers in this pop-up menu. For information on editing markers, see “The Marker window” on page 139.

⚠️ Only the cycle markers you create in the current project are available on the menu.

The Zoom history

Cubase maintains a history of recent zoom stages, allowing you to undo and redo zoom operations. This way you can zoom in several steps and then easily go back to the zoom stage at which you started.

There are two ways to invoke Undo Zoom and Redo Zoom:

- Use the items on the Zoom submenu on the Edit menu. You can also assign key commands for these.
- Double-click with the Zoom tool (magnifying glass) to Undo Zoom. Press [Alt]/[Option] and double-click to Redo Zoom.

Adjusting how parts and events are shown

The Preferences on the File menu (the Cubase menu, under Mac OS X) contains several settings for customizing the display in the Project window.

The Event Display page contains common settings for all track types:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Event Names</td>
<td>Determines whether the names of parts and events are shown in the Project window.</td>
</tr>
<tr>
<td>Show Data on Small Track Heights</td>
<td>If this is activated, the contents of events and parts will be shown, even if the height of a track is very small.</td>
</tr>
</tbody>
</table>

The Event Display–Audio page contains settings for audio events:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interpolate Audio Images</td>
<td>If the option is deactivated, single sample values are drawn as “steps”. If the option is activated they are interpolated to form “curves”.</td>
</tr>
<tr>
<td>Show Event Volume Curves</td>
<td>If this is activated the “volume curves” created with the volume and fade handles are always shown – if not, the curves are only shown for selected events.</td>
</tr>
<tr>
<td>Show Waveforms Color</td>
<td>Determines whether audio waveforms are shown at all. When this is activated, the backgrounds of audio waveforms are displayed in a different way, reflecting the waveform dynamics. This is especially useful to get an overview when working with small track heights.</td>
</tr>
</tbody>
</table>

The Event Display–MIDI page contains settings for MIDI parts:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Edit Action</td>
<td>Determines which editor is opened when you double-click a MIDI part, or select it and press [Ctrl][Command]-[E]. Note that this setting is overridden for tracks with drum maps if the “Edit as Drums when Drum Map is assigned” option (see below) is activated.</td>
</tr>
<tr>
<td>Part Data Mode</td>
<td>Determines if and how events in MIDI parts are shown in the Project window: as lines, as score notes, as drum notes, or as blocks. If “No Data” is selected, events will not be shown at all. Note that this setting is overridden for tracks with drum maps if the “Edit as Drums when Drum Map is assigned” option (see below) is activated.</td>
</tr>
<tr>
<td>Show Controllers</td>
<td>Governs whether non-note events (controllers, etc.) are shown in MIDI parts in the Project window.</td>
</tr>
</tbody>
</table>
Audio handling

When you work with audio files, it is crucial to understand how audio is handled in Cubase:

When you edit or process audio in the Project window, you always work with an audio clip that is automatically created on import or during recording. This audio clip refers to an audio file on the hard disk that itself remains untouched. This means, that audio editing and processing is “non-destructive”, in the sense that you can always undo changes or revert to the original versions.

An audio clip does not necessarily refer to just one original audio file! If you apply some processing to a specific section of an audio clip, for example, this will create a new audio file containing only this section. The processing will then be applied to the new audio file only, leaving the original audio file unchanged. Finally, the audio clip is automatically adjusted, so that it refers both to the original file and to the new, processed file. During playback, the program will switch between the original file and the processed file at the correct positions. You will hear this as a single recording, with processing applied to one section only. This feature makes it possible to undo processing at a later stage, and to apply different processing to different audio clips that refer to the same original file.

An audio event is the object that you place on a time position in Cubase. If you make copies of an audio event and move them to different positions in the project, they will still all refer to the same audio clip. Furthermore, each audio event has an Offset value and a Length value. These determine at which positions in the clip the event will start and end, i.e. which section of the audio clip will be played back by the audio event. For example, if you resize the audio event, you will just change its start and/or end position in the audio clip – the clip itself will not be affected.

Audio region

An audio region is a section within a clip with a length value, a start time, and a snap point. Audio regions are shown in the Pool and are best created and edited in the Sample Editor.

If you want to use one audio file in different contexts, or if you want to create several loops from one audio file, convert the corresponding regions of the audio clip to events and bounce them into separate audio files. This is necessary since different events that refer to the same clip access the same clip information.

Auditioning audio parts and events

Audio parts and events can be auditioned in the Project window with the Play tool:

When auditioning, audio will be routed directly to the Control Room (Cubase only), if the Control Room is activated. When the Control Room is deactivated, the audio will be routed to the default output bus, bypassing the audio channel's settings, effects and EQs. In Cubase Artist, the Main Mix bus is always used for monitoring.

1. Select the Play tool.
2. Click where you want playback to start, and keep the mouse button pressed. Only the track on which you click is played back, starting at the click position.
3. Release the mouse button to stop playback.
Scrubbing audio

The Scrub tool allows you to locate positions in the audio part or event by playing back, forwards or backwards, at any speed:

1. Select the Play tool and click a second time on the icon. A pop-up menu opens.
2. Select “Scrub”.
3. Click at the desired position of your audio event or part and keep the mouse button pressed. The project cursor moves to the position where you click. The mouse pointer is not visible anymore.
4. Drag to the left or right. The project cursor moves correspondingly and the audio is played back. The speed and the pitch of the playback depend on how fast you move the mouse.

You can adjust the volume of the Scrub function in the Preferences dialog (Transport–Scrub page).

- When scrubbing with the mouse, insert effects are always bypassed.
- It is also possible to “scrub” all audio and video tracks of your project with the Jog wheel and Shuttle Speed control on the Transport panel see “Playing back with the shuttle speed control” on page 85.

Scrubbing can be quite a burden on your system. If playback problems occur, try deactivating the “Use High Quality Scrub Mode” option in the Preferences dialog (Transport–Scrub page). The resampling quality will then be lower, but scrubbing will be less demanding on the processor. This can be useful when scrubbing in large projects.

Editing parts and events

This section describes techniques for editing in the Project window. If not explicitly stated, all descriptions apply to both events and parts, even though we use the term “event” for convenience.

- When you are using the tools for editing, you can in many cases get additional functions by pressing modifier keys (e.g. pressing [Alt]/[Option] and dragging with the Arrow tool creates a copy of the dragged event).

On the following pages, the default modifier keys are described – you can customize these in the Preferences dialog (Editing–Tool Modifiers page), see “Setting up tool modifier keys” on page 545.

Selecting events

Selecting events is done using any of the following methods:

- Use the Arrow tool. The standard selection techniques apply.
- Use the Select submenu on the Edit menu. The options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects all events in the Project window.</td>
</tr>
<tr>
<td>None</td>
<td>Deselects all events.</td>
</tr>
<tr>
<td>Invert</td>
<td>Inverts the selection – all selected events are deselected and all events that were not selected are selected instead.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all events that are partly or wholly between the left and right locator.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all events that begin to the left of the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all events that end to the right of the project cursor.</td>
</tr>
<tr>
<td>Equal Pitch</td>
<td>These are available in the MIDI Editors (see “Selecting notes” on page 383) and the Sample Editor (see “Using the Select menu” on page 269).</td>
</tr>
<tr>
<td>Select Controllers in Note Range</td>
<td>This is available in the MIDI Editors (see “Selecting controllers within the note range” on page 384).</td>
</tr>
<tr>
<td>All on Selected Tracks</td>
<td>Selects all events on the selected track.</td>
</tr>
<tr>
<td>Events under Cursor</td>
<td>Automatically selects all events on the selected track(s) that are “touched” by the project cursor.</td>
</tr>
</tbody>
</table>
### Option | Description
--- | ---
Select Event | This is available in the Sample Editor (see “Window overview” on page 262).  
Left/Right Selection Side to Cursor | These two functions are only used for range selection editing (see “Creating a selection range” on page 66).

⚠️ Note that these functions work differently when the Range Selection tool is selected (see “Creating a selection range” on page 66).

- Select all events on a track by right-clicking on it in the track list and selecting “Select All Events” from the context menu.
- It is also possible to select ranges, regardless of the event and track boundaries. This is done using the Range Selection tool (see “Range editing” on page 66).
- Use the arrow keys on the computer keyboard to select the closest event to the left, right, above, or below. If you press [Shift] and use the arrow keys, the current selection will be kept, allowing you to select several events.

By default, tracks are selected with the up/down arrow keys on the computer keyboard. Therefore using these to select events, too, can be confusing. If you want to use the navigation controls for track selection only (a most vital operation in both editing and mixing), you can activate the “Use Up/Down Navigation Commands for selecting Tracks only” option in the Preferences dialog (Editing page). The following applies:

- When this option is deactivated and no event/part is selected in the Project window, the up/down arrow keys on the computer keyboard are used to step through the tracks in the track list.
- When this option is deactivated and an event/part is selected in the Project window, the up/down arrow keys still step through the tracks in the track list – but on the currently selected track, the first event/part will automatically be selected as well.
- When this option is activated, the up/down arrow keys are only used to change the track selection – the current event/part selection in the Project window will not be altered.

- If the “Auto Select Events under Cursor” option is activated in the Preferences dialog (Editing page), all events on the selected track(s) that are “touched” by the project cursor are automatically selected. This can be helpful when rearranging your project, because it allows you to select whole sections (on all tracks) by selecting all tracks and moving the project cursor.

### Using the cross hair cursor

Also in the Preferences dialog (Editing–Tools page), you can find the Cross Hair Cursor section. When enabled, a cross hair cursor is displayed when working in the Project window and in the editors, facilitating navigation and editing, especially when arranging large projects. You can set up the colors for the line and the mask of the cross hair cursor, and define its width. The cross hair cursor works as follows:

- When the Selection tool (or one of its subtools) is selected, the cross hair cursor appears when you start moving/copying a part/event, or when using the event trim handles.
- When the Pencil tool, the Scissors tool, or any other tool that makes use of this function is selected, the cross hair cursor appears as soon as you move the mouse over the event display.
- The cross hair cursor is only available for tools where such a function is of any use. The Mute tool, for example, does not use a cross hair cursor, as you have to click directly on an event to mute it.
Moving events

To move events in the Project window, use the following methods:

• Click and drag to a new position.

All selected events are moved, maintaining their relative positions. You can only drag events to tracks of the same type. If Snap is activated, this determines to which positions you can move the events (see "The Snap function" on page 45). Note also that you can restrict movement to be either horizontal or vertical only, by holding down [Ctrl]/[Command] while dragging.

⚠️ You will note that there is a slightly delayed response when you move an event by dragging. This helps you avoid accidentally moving events when you click on them in the Project window. You can adjust this delay with the Drag Delay setting in the Preferences dialog (Editing page).

• Select the event and edit the Start position in the info line.

• Use the “Move to” options on the Edit menu.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cursor</td>
<td>Moves the selected event to the project cursor position. If there are several selected events on the same track, the first event will start at the cursor, and the following will be lined up end-to-start after the first one.</td>
</tr>
<tr>
<td>Origin</td>
<td>Moves the selected events to their original positions, i.e. the positions at which they were originally recorded.</td>
</tr>
<tr>
<td>Front/Back</td>
<td>This function does not actually change the position of the events, but moves the selected events to the front or back, respectively. This is useful if you have overlapping events and want to see one that is partially obscured. For audio events, this is an extra important feature, because only the visible sections of events will be played back. Moving an obscured audio event to front (or moving the obscuring event to back) will allow you to hear the whole event on playback. Note that it is also possible to use the &quot;To Front&quot; function on the event context menu for this.</td>
</tr>
</tbody>
</table>

⚠️ Use the Nudge buttons on the toolbar. These move the selected events to the left or right. The amount of movement depends on the selected display format (see "The Project Setup dialog" on page 54) and the value set on the Grid pop-up menu.

⚠️ When the Range Selection tool is used, the Nudge buttons move the selection range (see “Moving and duplicating” on page 67).

⚠️ The Nudge buttons are not visible on the toolbar by default. You can decide which items are visible by right-clicking on the toolbar and activating the corresponding option on the context menu (see “The setup context menus” on page 534).

• Use the Up/Down key commands, found in the Nudge category in the Key Commands dialog. These commands allow you to nudge one or more events (except folder parts) up or down to the nearest track.

Nudging up/down will not create new tracks: If there is no destination track that matches the track configuration of the nudged event, nothing happens.

Exceptions

• If you select events in Lane Display mode, these are moved to the upper or lower lane.

• If you select MIDI events in the In-Place Editor, the MIDI events are nudged up or down.

Duplicating events

Events can be duplicated in the following ways:

• Hold down [Alt]/[Option] and drag the event to a new position.

If Snap is activated, this determines to which positions you can copy the events (see “The Snap function” on page 46).

⚠️ If you hold down [Ctrl]/[Command] as well, movement direction is restricted to either horizontal or vertical. That means if you drag an event vertically it cannot be moved horizontally at the same time.
Audio and MIDI parts can also be duplicated by clicking on the part, pressing [Alt]/[Option]-[Shift], and dragging. This creates a shared copy of the part. If you edit the contents of a shared copy, all other shared copies of the same part are automatically edited in the same way.

Note:
- When you duplicate audio events, the copies are always shared. This means that shared copies of audio events always refer to the same audio clip (see “Audio processing” on page 245).
- You can convert a shared copy to a real copy by selecting “Convert to Real Copy” from the Functions submenu on the Edit menu. This creates a new version of the clip (that can be edited independently) and adds this to the Pool. Note that no new files are created by this operation – for that you need to use the “Bounce Selection” function from the Audio menu (see “Exporting regions as audio files” on page 307).
- Selecting “Duplicate” from the Functions submenu on the Edit menu creates a copy of the selected event and places it directly after the original. If several events are selected, all of these are copied “as one unit”, maintaining the relative distance between the events.
- Selecting “Repeat…” from the Functions submenu on the Edit menu opens a dialog, allowing you to create a number of copies (regular or shared) of the selected events. This works just like the Duplicate function, but you can specify the number of copies.
- You can also perform the Repeat function by dragging: Select the events to repeat, press [Alt]/[Option], click the handle in the lower right corner of the last selected event and drag to the right. The longer to the right you drag, the more copies are created (as shown by the tooltip).

Using Cut, Copy and, Paste
You can cut or copy selected events, and paste them in again, using the functions on the Edit menu.
- When you paste an audio event, it is inserted on the selected track, positioned so that its snap point is aligned with the cursor position. If the selected track is of the wrong type, the event will be inserted on its original track. See “The Snap function” on page 45 for information about the snap point.
- If you use the “Paste at Origin” function on the Function submenu of the Edit menu, the event is pasted at its original position (the position from which you cut or copied it).

Renaming events
By default, audio events show the name of their clip, but you can enter a separate descriptive name for separate events if you like. This is done by selecting the event and typing in a new name in the “Description” field on the info line.
- You can also give all events on a track the same name as the track by changing the track name, holding down a modifier key and pressing [Return]. See “Audio handling” on page 58.

Splitting events
You can split events in the Project window in the following ways:
- Click with the Scissors tool on the event you want to split. If Snap is activated, this determines the exact split position (see “The Snap function” on page 45). You can also split events by pressing [Alt]/[Option] and clicking with the Arrow tool.
• Select “Split at Cursor” from the Edit menu, Functions submenu.
This splits the selected events at the position of the project cursor. If no events are selected, all events (on all tracks) that are intersected by the project cursor will be split.

• Select “Split Loop” from the Edit menu, Functions submenu.
This splits events on all tracks at the left and right locator positions.

If you split a MIDI part so that the split position intersects one or several MIDI notes, the result depends on the “Split MIDI Events” option in the Preferences dialog (Editing–MIDI page). If the option is activated, the intersected notes will be split (creating new notes at the beginning of the second part). If it is deactivated, the notes will remain in the first part, but “stick out” after the end of the part.

Gluing events together
You can glue events together using the Glue Tube tool. There are three possibilities:

• Clicking on an event with the Glue Tube tool glues it together with the next event on the track. The events do not have to touch one another.
  The result is a part containing the two events, with one exception: If you first split an event and then glue the two sections together again (without moving or editing them first), they become a single event again.

• You can select several events on the same track and click on one of them with the Glue Tube tool.
  A single part is created.

• When you hold down [Alt]/[Option] while clicking on an event with the Glue Tube tool, this event will be glued together with all following events on this track.
  You can change the default key command for this in the Preferences dialog (Editing–Tool Modifiers page).

Resizing events
Resizing events means to move their start or end positions individually. In Cubase, there are three modes for resizing:

<table>
<thead>
<tr>
<th>Resizing mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Sizing</td>
<td>The contents of the event stay fixed, and the start or end point of the event is moved to &quot;reveal&quot; more or less of the contents.</td>
</tr>
</tbody>
</table>

To select one of the resizing modes, select the Arrow tool and then click again on the Arrow tool icon on the toolbar. This opens a pop-up menu from which you can select one of the options.

The icon on the toolbar will change, indicating the selected resizing mode.

The actual resizing is done by clicking and dragging the lower left or right corner of the event. If Snap is activated, the Snap value determines the resulting length (see “The Snap function” on page 45).

Normal sizing

Sizing moves contents

• If several events are selected, all will be resized in the same way.
It is also possible to resize events by using the Trim buttons (located in the Nudge palette) on the toolbar. This will move the start or end position of the selected event(s) by the amount set on the Grid Type pop-up menu. The sizing type currently selected applies to this method too, with the exception of “Sizing Applies Time Stretch” which is not possible with this method. You can also use key commands for this (by default, press [Ctrl]/[Command] and use the left and right arrow key).

- Note that the Nudge palette is not visible on the toolbar by default. See “The setup context menus” on page 534 for instructions on how to show and hide items on the toolbar.
- When resizing events, any automation data will not be taken into account.

Resizing events using time stretch
If you want to resize a part and make its contents “fit” the new size, you should use this sizing mode. Proceed as follows:

1. Click the Arrow icon on the toolbar and click again to select the “Sizing Applies Time Stretch” option from the pop-up menu.
2. Point close to the end point of the part you want to stretch.
3. Click and drag left or right.
   When you move the mouse, a tooltip shows the current mouse position and length of the part. Note that the snap value applies, as with any part operation.

4. Release the mouse button.
   The part is “stretched” or “compressed” to fit the new length.

- For MIDI parts, this means that the note events are stretched (moved and resized).
  Note Expression (Cubase only) and controller data will be stretched, too.
- For audio parts, this means that the events are moved, and that the referenced audio files are time stretched to fit the new length.
  A dialog shows the progress of the time stretch operation.
- In the Preferences dialog (Editing–Audio page), you can adjust which algorithm is used for the time stretch algorithm. For more information about time stretch, see “Time Stretch” on page 252.

Sliding the contents of an event or part
You can move the contents of an event or part without changing its position in the Project window. By default, this is done by pressing [Alt]/[Option]-[Shift], clicking in the event or part and dragging to the left or right.

- When sliding the contents of an audio event, you cannot slide past the start or end of the actual audio clip. If the event plays the whole clip, you cannot slide the audio at all.

Grouping events
Sometimes it is useful to treat several events as one unit. This can be done by grouping them: Select the events (on the same or different Tracks) and select “Group” from the Edit menu.

Grouped events are indicated by a group icon on the right.
If you edit one of the grouped events in the Project window, all other events in the same group are affected too (if applicable).
Group editing operations include:

- Selecting events.
- Moving and duplicating events.
- Resizing events.
- Adjusting fade-in and fade-out (audio events only, see “Creating fades” on page 118).
- Splitting events (splitting one event will automatically split any other grouped events that are intersected by the split position).
- Locking events.
- Muting events.
- Deleting events.

Locking events

If you want to make sure that you do not edit or move an event by accident, you can lock it. Locking can affect one (or any combination) of the following properties:

<table>
<thead>
<tr>
<th>Lock Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>If this is locked, the event cannot be moved.</td>
</tr>
<tr>
<td>Size</td>
<td>If this is locked, the event cannot be resized.</td>
</tr>
<tr>
<td>Other</td>
<td>If this is locked, all other editing of the event is disabled. This includes adjusting the fades and event volume, processing, etc.</td>
</tr>
</tbody>
</table>

- To specify which of these properties are affected by the Lock function, use the “Lock Event Attributes” pop-up menu in the Preferences dialog (Editing page).

- To lock events, select them and select “Lock…” from the Edit menu. The events will be locked according to the options specified in the Preferences dialog.

The padlock symbol indicates that one or more of the lock options are activated for the event.

- You can adjust the lock options for a locked event by selecting it and selecting “Lock…” from the Edit menu again. This opens a dialog in which you can activate or deactivate the desired lock options.
- To unlock an event (turn off all lock options), select it and select “Unlock” from the Edit menu.
- It is also possible to lock a whole track, by clicking the padlock symbol in the track list or in the Inspector. This disables all editing of all events on the track.

Muting events

To mute individual events in the Project window, proceed as follows:

- To mute or unmute a single event, click on it with the Mute tool.

- To mute or unmute several events, select them – either by using the standard selection techniques, or by using one of the options on the Select submenu on the Edit menu – and click on one of the selected events with the Mute tool. All selected events will be muted.

- You can also click in an empty area with the Mute tool and drag a selection rectangle around several events you want to mute or unmute, and then click on one of them with the Mute tool.

- You can mute events by selecting them and selecting “Mute” from the Edit menu. Similarly, you can unmute the selected events by selecting “Unmute” from the Edit menu.

- You can also change the mute status of selected events on the info line.

Muted events can be edited as usual (with the exception of adjusting fades), but are not played back.

Muted events are “grayed out”.

Working with projects
• You can also mute whole tracks by clicking the Mute ("M") button in the track list, the Inspector or the Mixer. Clicking the Solo ("S") button for a track mutes all other tracks. Note that there are two modes for the track solo function:
   - If the "Enable Solo on Selected Track" option is activated in the Preferences dialog (Editing–Project & Mixer page) and you have soloed a track, selecting another track in the track list will automatically solo that track instead – the solo state "moves" with the track selection.
   - If the option is not activated, the track you solo stays soloed, regardless of the selection.

Removing events
To remove an event from the Project window, use any of the following methods:
• Click on the event with the Erase tool. Note that if you press [Alt]/[Option] while you click, all following events on the same track will be deleted, but not the event you clicked and all events before it.
• Select the event(s) and press [Backspace], or select "Delete" from the Edit menu.

Creating new files from events
An audio event plays a section of an audio clip, which in turn refers to one or more audio files on the hard disk. However, in some situations you may want to create a new file that consists only of the section played by the event. This is done with the function “Bounce Selection” on the Audio menu:
1. Select one or several audio events.
2. Set up fade in, fade out and event volume (on the info line or using the volume handle) as desired. These settings will be applied to the new file. For details on fades and event volume, see “Creating fades” on page 118.
3. Select “Bounce Selection” from the Audio menu. You are asked whether you want to replace the selected event or not.
   • If you click “Replace”, a new file is created, containing only the audio in the original event. A clip for the new file is added to the Pool, and the original event is replaced by a new event playing the new clip.
   • If you click “No”, a new file is created and a clip for the new file is added to the Pool. The original event is not replaced.

You can also apply the Bounce Selection function to an audio part. In that case, the audio from all events in the part will be combined into a single audio file. If you choose “Replace” when asked, the part will be replaced with a single audio event playing a clip of the new file.

Range editing
Editing in the Project window is not necessarily restricted to handling whole events and parts. You can also work with selection ranges, which are independent from the event/part and track boundaries.

The range selection tool can also be used for comping (see “Comping operations” on page 77). Furthermore you can define Edit groups with the range selection tool. These allow you to quickly group events and parts across multiple tracks without having to select all the events or parts (see “About Group Editing (Cubase only)” on page 80).

Creating a selection range
To make a selection range, drag with the Range Selection tool.

When the Range Selection tool is selected, the Select submenu on the Edit menu has the following items for making selection ranges:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Makes a selection that covers all tracks, from the start of the project to the end (as defined by the Length setting in the Project Setup dialog).</td>
</tr>
<tr>
<td>None</td>
<td>Removes the current selection range.</td>
</tr>
<tr>
<td>Invert</td>
<td>Only used for event selection (see “Selecting events” on page 59).</td>
</tr>
<tr>
<td>In Loop</td>
<td>Makes a selection between the left and right locator, on all tracks.</td>
</tr>
<tr>
<td>From Start to</td>
<td>Makes a selection on all tracks, from the start of the project to the project cursor.</td>
</tr>
<tr>
<td>Cursor</td>
<td>From End</td>
</tr>
<tr>
<td>All on Selected</td>
<td>Makes a selection on all tracks, from the project cursor to the end of the project.</td>
</tr>
<tr>
<td>Tracks</td>
<td>Only used for event selection (see “Selecting events” on page 59).</td>
</tr>
<tr>
<td>Select Event</td>
<td>This is available in the Sample Editor (see “Using the Select menu” on page 269).</td>
</tr>
</tbody>
</table>
Double-clicking on an event with the Range Selection tool creates a selection range encompassing the event. If you hold down [Shift] you can double-click several events in a row, and the selection range will expand to encompass them all. Double-clicking a second time on an event opens it for editing in the Sample Editor.

**Making selection ranges for several non-contiguous tracks**

You can create selection ranges that cover several tracks. It is also possible to exclude tracks from a selection range:

1. Create a selection range from the first to the last desired track.
2. Press [Ctrl]/[Command] and click in the selection range on the tracks that you want to exclude from the selection.
3. In the same manner, you can add a track to the selection range by [Ctrl]/[Command]-clicking in the selection range area on the track.

### Editing selection ranges

#### Adjusting the size of the selection range

You can adjust the size of a selection range in the following ways:

- By dragging its edges.
  - The pointer takes the shape of a double arrow when you move it over an edge of the selection range.

- By holding down [Shift] and clicking.
  - The closest selection range edge will be moved to the position at which you clicked.

- By adjusting the selection range start or end position on the info line.

- By using the Trim buttons on the toolbar.
  - The left Trim buttons will move the start of the selection range and the right buttons will move the end. The edges will be moved by the amount specified on the Grid pop-up menu.

- By using the Nudge buttons on the toolbar.
  - These will move the whole selection range to the left or the right. The amount of movement depends on the selected display format (see “The Project Setup dialog” on page 54) and the value specified on the Grid pop-up menu.

⚠️ Note that the contents of the selection are not moved – using the Nudge buttons is the same as adjusting the start and end of the selection range at the same time, by the same amount.

⚠️ The Trim buttons and the Nudge buttons are located in the Nudge palette, which is not visible on the toolbar by default.

See “The setup context menus” on page 534 for instructions on how to show and hide items on the toolbar.

#### Moving and duplicating

- To move a selection range, click and drag it to a new position.
  - This will move the contents of the selection range to the new position. If the range intersected events or parts, these will be split before moving, so that only the sections within the selection range are affected.

- To duplicate a selection range, hold down [Alt]/[Option] and drag.
  - You can also use the Duplicate, Repeat and Fill Loop functions, just as when duplicating events (see “Duplicating events” on page 61).
Using Cut, Copy, and Paste

When working with selection ranges, you can either use Cut, Copy and Paste on the Edit menu, or use the functions “Cut Time” and “Paste Time” on the Range submenu on the Edit menu. These work differently to their related functions on the Edit menu:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Cuts out the data in the selection range and moves it to the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the data in the selection range to the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes the clipboard data at the start position and track of the current selection. Existing events are not moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Paste at Origin</td>
<td>Pastes the clipboard data back at its original position. Existing events are not moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Cut Time</td>
<td>Cuts out the selection range and moves it to the clipboard. Events to the right of the removed range are moved to the left to fill out the gap.</td>
</tr>
<tr>
<td>Paste Time</td>
<td>Pastes the clipboard data at the start position and track of the current selection. Existing events are moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Paste Time at Origin</td>
<td>Pastes the clipboard data back at its original position. Existing events are moved to make room for the pasted data.</td>
</tr>
</tbody>
</table>

Deleting selection ranges

Again, you can either use “regular” Delete or “Delete Time”:

- If you use the Delete function on the Edit menu (or press [Backspace]), the data within the selection range is replaced by empty track space. Events to the right of the range keep their position.
- If you use “Delete Time” on the Edit menu’s Range submenu, the selection range is removed and events to the right are moved to the left to close up the gap.

Other functions

On the Range submenu on the Edit menu, you will find three more range editing functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Copy</td>
<td>This copies everything in the selection range.</td>
</tr>
<tr>
<td>Split</td>
<td>Splits any events or parts that are intersected by the selection range, at the positions of the selection range edges.</td>
</tr>
</tbody>
</table>

Region operations

Regions are sections within a clip, with various uses. While regions are perhaps best created and edited in the Sample Editor (see “Working with regions” on page 270), the following region functions are available in the Advanced submenu of the Audio menu:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crop</td>
<td>All events or parts that are partially within the selection range are cropped, that is, sections outside the selection range are removed. Events that are fully inside or outside the selection range are not affected.</td>
</tr>
<tr>
<td>Insert Silence</td>
<td>Inserts empty track space from the start of the selection range. The length of the silence equals the length of the selection range. Events to the right of the selection range start are moved to the right to “make room”. Events that are intersected by the selection range start are split, and the right section is moved to the right.</td>
</tr>
</tbody>
</table>

The Edit History dialog

In the Edit History dialog you can undo and redo many edit actions. Actions that can be undone include all functions in the Project window as well as in the editors. It is also possible to undo audio processes or applied plug-in effects. However, these are better removed and modified using the Offline Process History (see “The Offline Process History dialog” on page 254).

In the Preferences dialog (General page) you can limit the Undo function by setting the number in the “Maximum Undo” field to the desired value. This is useful if you run out of hard disk space, for example.
To undo and redo your actions, proceed as follows:

1. On the Edit menu, select “History…”. The Edit History dialog opens.

   ![Edit History Dialog](image)

The dialog contains a list of all your edits, with the most recent action at the bottom of the list. The Action column displays the name of the action while the Time column tells you when this action was performed. In the Details column further details are shown. Here you can enter new text by double-clicking in the column.

2. Move the horizontal, colored line upwards to the desired position to undo your actions. You can only undo your actions in reverse order, i.e. the last performed action is the first action to be undone.

3. Move the line down the List again to redo an action that was undone previously.

The Preferences dialog

![Preferences Dialog](image)

When you open the File menu (the Cubase menu on a Mac) and select “Preferences…”, the Preferences dialog opens. This dialog provides a large number of options and settings that control the global behavior of Cubase.

The dialog has a number of pages, each containing options and settings belonging to a particular topic.

- In the list on the left, click on one of the entries to open the corresponding page.
- You can find detailed descriptions of all Preferences options in the dialog help, opened by clicking the Help button at the bottom left of the dialog.

About preference presets

In the Preferences dialog it is possible to save complete or partial preference settings as presets. This lets you recall settings quickly and easily.
**Saving a preference preset**

When you have made your preferences settings, proceed as follows to save all settings as a preset:

1. Make sure that the “Store marked preferences only” option is not activated. This is because this option is used for saving partial settings (see below), as opposed to complete settings.

2. Click the Store button in the lower left section of the Preferences dialog.

A dialog opens, allowing you to type in a name for the preset.

3. Click OK to save the preset.

Your saved settings are now available from the Preference Presets pop-up menu.

**Loading a preference preset**

To load a saved preference preset, simply select a preset from the Preference Presets pop-up menu. The preset is applied immediately.

**Saving partial preferences settings**

It is also possible to save partial preferences settings. This is useful when you have made settings that only relate to a certain project or situation, for example. When you apply a saved partial preference preset, you only change the saved settings. All other preferences will be left unchanged.

When you have made your specific preferences settings, proceed as follows to save the partial settings as a preset:

1. Activate “Store marked preferences only”. A new “Store” column is added to the Preferences list.

2. Click in the Store column of the Preferences items you wish to save.

A dialog opens, asking you to type in a name for the preset. It is a good idea to choose a descriptive name for a partial preference preset, preferably relating to the saved settings (for example “Editing–Controls”).

3. Click OK to save.

Your saved settings are now available from the Preference Presets pop-up menu.
Working with tracks and lanes
Setting up tracks

Adding tracks
To add a track to the project, proceed as follows:
1. Open the “Add Track” submenu from the Project menu or from the track list context menu. The new track is added below the currently selected track in the track list.

2. Select the desired track type.
If you select the Audio, MIDI, Group Channel, or Instrument option from the Add Track submenu, a dialog opens, allowing you to insert several tracks in one go. Just enter the desired number of tracks in the Count field.

- For audio and group channel tracks, the channel configuration – mono, stereo or surround configuration (Cubase only) – can be set in the Configuration pop-up menu.

- The “Add Track Using Track Preset” option allows you to select a Track Preset. This is described in the chapter “Working with track presets” on page 331.

Once you have created tracks, you can manipulate and rearrange them in various ways. This is explained in the following sections.

Removing tracks
To remove tracks, you have the following options:
- Select the track you want to remove, open the Project menu and select “Remove Selected Tracks”.
- In the track list, right-click on the track you want to remove, and select “Remove Selected Tracks” from the context menu.
- You can also remove all tracks not containing any events by selecting “Remove Empty Tracks” from the Project menu.

Naming tracks
To rename a track, proceed as follows:
1. Double-click in the name field and type in a new name for the track.
2. Press [Return] to close the name field.

- If you want all events on the track to get the same name, hold down any modifier while pressing [Return].

- If “Parts get Track names” is activated in the Preferences dialog (Editing page) and you move an event from one track to another, the moved event will automatically be named according to its new track. Otherwise the event will retain the name of the track it was previously on.

Coloring tracks
All tracks are automatically assigned a color.
- To control which colors are used for new tracks, use the “Auto Track Color Mode” pop-up menu in the Preferences dialog (Editing–Project & Mixer page). The available options are described in the section “Applying track colors automatically” on page 537.

- To change the color for existing tracks, use the Select Colors pop-up menu on the toolbar. This is described in detail in the section “About the Select Colors pop-up menu” on page 538.

- To change the color for a track you can also press [Ctrl]/[Command], point the mouse at the strip where the track color is shown and click. The color strip is shown, allowing you to select the desired color. This method works in several places where the track color is visible, i.e. in the track list, the track name field in the Inspector, and the channel name field in the Mixer.

- To override the track color for individual events and parts, use the Color tool or the Select Colors pop-up menu. For more information, see “Coloring tracks, parts, or events manually” on page 538.
Resizing tracks

- To change the width of the track list area, drag the border between the track list and the event display.
- To change the height of an individual track, click on its lower border in the track list and drag up or down.
- To change the height of all tracks simultaneously, hold down [Ctrl]/[Command] and resize one of the tracks in this way.

If “Snap Track Heights” is activated on the Track Scale pop-up menu (see below), the track height will change in fixed increments when you resize it.

⚠️ This behavior is different when “Enlarge Selected Track” is activated on the Edit menu (see “About the Enlarge Selected Track option” on page 73).

- To set the number of tracks to view in the current Project window, use the Track Scale pop-up menu (opened by clicking the arrow button above the vertical zoom control). The track height will be adjusted to show only the number of tracks specified on the pop-up menu. By selecting “Zoom N Tracks” from the pop-up you can manually set the number of tracks to fit in the current Project window.

Data display on the tracks

Changing the width and the height of tracks naturally has an effect on how the track controls and the parts or events on the track are displayed. The following happens when you resize a track’s height or width:

- The track controls will be placed where they best “fit in” by default. The controls shown for tracks in the track list will adapt to the track size.

If you prefer to have the controls in fixed positions, deactivate the “Wrap Controls” option in the Track Controls settings dialog (see “Customizing track controls” on page 535).

- The contents of events and parts will not be shown if the height of a track is very small.

You can change this behavior by activating “Show Data on Small Track Heights” in the Preferences (Event Display).

About the Enlarge Selected Track option

When this option is activated on the Edit menu (or in the Preferences dialog, Editing–Project & Mixer page), the selected track is enlarged automatically. This is useful if you are stepping through the tracks in the track list, to check or edit the settings. The tracks will revert to the size they had before when they are deselected. You can adjust the size directly in the track list if the default enlargement factor does not suit you.

While this is the program behavior you will want in most cases, it may be a disadvantage when changing the track height you started out with for one or more tracks (i.e. their “original” height, before “Enlarge Selected Track” was activated). As soon as you try to resize a track, it is selected and automatically enlarged. Instead of turning off “Enlarge Selected Track”, resizing the desired track(s) and activating “Enlarge Selected Track” again, you can resize a track in the track list without selecting it.

Proceed as follows:

1. Move the mouse pointer over the lower border of the (unselected) track you want to resize. The mouse pointer turns into a divider symbol.
2. Hold down [Alt]/[Option] and drag the lower border of the track until it reaches the desired height.

Now, when you select this track, (and “Enlarge Selected Track” is activated), it will be enlarged. It will revert to the changed size, when you select a different track.

By default, lanes (see “Working with lanes” on page 76) have a track height of 4 rows. If you still have difficulties to discern the recorded takes, you can size the lanes individually as usual. Lanes can be reordered as usual.
Defining the track time base

In the Inspector or track list you can set the time base individually for each track, by clicking on the “Toggle Time-base” button. Tracks can be either musical (tempo) or linear (time) based or follow the Transport Main display:

• Musical
  On a track using musical time base, the positions of events are represented as meter values (bars, beats, 1/16th notes and ticks, with 120 ticks per 1/16th note). If you change the playback tempo, the events will play back at an earlier or later time. Musical time base is indicated by a note symbol.

• Time Linear
  On a track using linear time base, the events will be positioned on specific time positions – changing the playback tempo will not affect the time position of events. Linear time base is indicated by a clock symbol.

• Follow Transport Main Display
  This uses the primary time format setting on the Transport panel. When this is set to “Bars+Beats”, tracks with musical time base will be added. When this is set to any of the other options (Seconds, Timecode, Samples, etc.), all new tracks will use linear time base.

Which time base suits better depends on the type of project and recording situation.

⚠️ Internally, events on musical time based tracks use the same high precision for positioning (64 bit floating point values) as linear time based events. However, switching between linear and musical time base results in a very small loss of precision (introduced by the mathematical operations used for scaling values in the two different formats). Therefore you should avoid switching repeatedly between the two modes.

⚠️ In the Preferences dialog (Editing page), you can find the “Default Track Time Type” option (Cubase only). This allows you to specify the default track time type for new tracks (audio, group/FX, MIDI, and marker tracks).

For more information about tempo changes, see the chapter “Editing tempo and signature” on page 462.

Editing tracks

Adding events to a track

There are a number of ways to add events to a track:

• By recording (see “Basic recording methods” on page 90).
• By dragging files and dropping them on the track at the desired position.
  You can drag from the following locations: the desktop, the MediaBay and its related windows (see the chapter “The MediaBay” on page 311), the Pool, a library (a Pool file that is not attached to a project) (Cubase only), the “Find media” dialog, another open Project window, the Audio Part Editor, the Sample Editor (press [Ctrl]/[Command] and drag to create an event of the current selection, or click in the left column of the region list and drag to create an event from a region).

When you drag the clip into the Project window, its position will be indicated by a marker line and a numerical position box.

• By importing an audio or video file using the Import submenu on the File menu.
  When you import a file this way, a clip is created for the file and an event that plays the whole clip is inserted on the selected track, at the position of the project cursor.

• By importing a MIDI file using the Import submenu.
  See “Exporting and importing standard MIDI files” on page 527.
• By grabbing audio CD tracks and converting them to audio files.
  See “Importing audio CD tracks” on page 522.
• By importing only the audio portion of a video file and converting it to an audio file.
  See “About thumbnail cache files” on page 513.
• By using Copy and Paste on the Edit menu.
  This allows you to copy all kinds of events between projects. You can also copy events within the project, e.g. from the Sample Editor.
• By drawing.
  This is possible for marker and automation tracks e.g. For audio, MIDI and instrument tracks, you can only draw parts (see “Creating parts” on page 78).
Creating parts

Parts are containers for MIDI or audio events, or even for tracks (see “Working with folder parts” on page 79).

Creating MIDI parts

A MIDI part is automatically created when you record. This will contain the recorded events. However, you can also create empty MIDI parts and later add events to them.

There are two ways to do this:

• Draw a part on a MIDI track with the Pencil tool. You can also draw parts by pressing [Alt]/[Option] and using the Arrow tool.

• Double-click with the Arrow tool on a MIDI track, between the left and right locator.

Creating audio parts

There is no way of automatically creating audio parts on recording. On recording audio events are created always. To create audio parts, you have the following possibilities:

• Use the “Events to Part” function on the Audio menu to gather existing audio events into a part. This creates an audio part containing all selected audio events on the same track. To remove the part and make the events appear as independent objects on the track again, select the part and use the “Dissolve Part” function on the Audio menu.

• Draw a part on an audio track with the Pencil tool. You can also draw parts by pressing [Alt]/[Option] and using the Arrow tool.

• Double-click with the Arrow tool on an audio track, between the left and right locator.

To add events to a MIDI part, you use the tools and functions in a MIDI editor (see “The Key Editor – Overview” on page 377).

Selecting tracks

• To select a track, click on it in the track list. A selected track is indicated by a light gray color in the track list.

• To select several tracks press [Ctrl]/[Command] and click on them.

• To select a continuous range of tracks [Shift]-click on them.

You can also set up Cubase to select tracks on the following actions by activating Preferences:

• Selecting a channel in the mixer
  The respective track is automatically displayed in the track list as well. For this to work you need to activate the “Scroll to Selected Track…” option in the Preferences dialog (Editing–Project & Mixer).

• Selecting an event in the Project Window
  The corresponding track is automatically selected, if the “Track Selection Follows Event Selection” option is activated in the Preferences dialog (Editing).

• Activating the solo button for the track
  The track gets automatically selected, if the “Select Channel/Track on Solo” option is activated in the Preferences dialog (Editing–Project & Mixer).

• Clicking the Edit button (e) for the track
  The track gets automatically selected, if the “Select Channel/Track on Edit Settings” option is activated in the Preferences dialog (Editing–Project & Mixer).

Duplicating tracks

• To duplicate a track together with all contents and channel settings, right-click the track list and select “Duplicate tracks” from the context menu, or select “Duplicate tracks” from the Project menu.

The duplicated track will appear below the original track.
Moving tracks
- To move a track, click and drag it up or down in the list.
- To move one or several selected tracks to a folder, select “Move Selected Tracks to New Folder” from the context menu.

Disabling tracks
Audio tracks can be disabled by selecting “Disable Track” from the track list context menu. Disabling a track is similar to muting it (see “Muting events” on page 65), since a disabled track will not be played back. However, disabling a track not only “zeros” the output volume from the track, but actually shuts down all disk activity for it. For more information, see “About track disable/enable” on page 86.

Track folding
On the Project menu you will find the Track Folding submenu, allowing you to quickly show, hide or invert what is displayed in the Project window event display. This enables you for example to divide the project into several parts (by creating several folder tracks for the different project elements) and showing/hiding their contents by selecting a menu function (or using a key command). You can also fold in automation tracks this way. The following options are available:

- **Toggle Selected Track**
  When you select this menu option, the fold state of the selected track is reversed, i.e. if the track was folded in (its elements (subtracks) were hidden), it is now unfolded (all subtracks displayed) and vice versa.

- **Fold Tracks**
  Select this menu option to fold in all open folder tracks in the Project window. Please note that the exact behavior of this function depends on the “Deep Track Folding” setting in the Preferences dialog, see below.

- **Unfold Tracks**
  Select this menu option to unfold all folder tracks in the Project window. Please note that the exact behavior of this function depends on the “Deep Track Folding” setting in the Preferences dialog, see below.

- **Flip Fold States**
  Select this menu option to flip the fold states of the tracks in the Project window. This means that all tracks that were folded in will be unfolded and all unfolded tracks will be folded in, respectively.

- **Move Selected Tracks to New Folder**
  This menu option is available, if at least one folder track is available. Selecting this option moves all selected tracks to the folder track.

You can assign key commands for these menu options in the Key Commands dialog (Project category).

In the Preferences dialog (Editing–Project & Mixer page), you can find the following option affecting the track folding behavior:

- **Deep Track Folding**
  When this is activated, any folding settings you make in the Track Folding submenu of the Project menu also affect the subelements of the tracks, i.e. if you fold in a folder track which contains 10 audio tracks 5 of which have several automation tracks open, all these audio tracks within the folder track will be folded in as well.

Working with lanes
To simplify matters, the descriptions in the following paragraphs focus on cycle recordings with takes. However, you can also apply lane operations and comping methods on overlapping events or parts that you assemble on one track!

If you perform a cycle recording in the “Keep History” or in “Cycle History + Replace” modes (audio) or in the “Stacked” or “Mix-Stacked” modes (MIDI), the recorded cycle laps are shown on the track with the last recorded take active and shown on top.

The “Show Lanes” mode provides a very comfortable working environment and a good overview of all your takes. If you activate the “Show Lanes” button, the recorded takes are shown on separate lanes.

Click the “Show Lanes” button…

...to display the recorded takes on different lanes.

© Working with tracks and lanes
Lanes are handled differently, depending on whether you work with audio or MIDI:

- **Audio**
  As each audio track can only play back one single audio event at a time, you will only hear the take that is activated for playback (e.g., the last lap of a cycle recording).

- **MIDI**
  Overlapping MIDI takes (parts) can be played back simultaneously. For example, if you recorded in “Mix-Stacked” mode, you hear all takes from all cycle laps. There is no playback priority between lanes on a MIDI track.

Lanes can be reordered, sized, and zoomed like regular tracks.

In the following you will learn how to play back, cut, and activate different takes on different lanes.

**Comping operations**

After recording different takes in a cycle recording and activating the “Show Lanes” button to display the recorded laps on separate lanes, you have several possibilities to assemble a “perfect” take. This process is often referred to as comping. You can comp your takes using the Object Selection or the Range Selection tools.

**Comping with the Object Selection tool**

With the Object Selection tool selected, you can perform the following actions:

- To select a take for playback, click on it in the event display. The selected take is displayed in the current track color on the lane and on the main track. All other takes are dimmed. On playback, you will only hear the selected take.

- To audition a certain section of a take, hold down [Ctrl]/[Command] and click with the Speaker tool. This works even if the take is not selected for playback.

- To cut a take, hold down [Alt]/[Option] and click at the desired position. The cutting affects all lanes of a track. If you cut a MIDI part and the cut position intersects one or several MIDI notes, the result depends on the “Split MIDI Events” option in the Preferences dialog, see “Splitting events” on page 62.

- To adjust the cut position, position the mouse pointer over a cut and move the cut point to the left or to the right. This way you can fine-tune your edits. If you position the mouse pointer in the lower part of a cut take, you will adjust the length instead.

- To correct the timing of a take, select the desired take, hold down [Ctrl]/[Command]-[Alt]/[Option] (the tool modifier for Slip Event) and drag with the mouse. The mouse pointer changes its shape to indicate that you can change the timing.

**Comping with the Range Selection tool**

With the Range Selection tool selected, you can perform the following actions:

- To bring the selected range to front, select a range on a lane and double-click it.

Double-clicking the range brings it to front.
To glue cuts, select a range that spans all the cuts that you want to glue and double-click. The gluing affects all the lanes of a track.

To correct the timing of a range, hold down [Ctrl]/[Command]-[Alt]/[Option] (the tool modifier for Slip Event) and drag with the mouse. The mouse pointer changes its shape to indicate that you can change the timing.

For all comping operations except “Slip Events”, Snap is taken into account.

Cubase only: You can also perform a multi-track comping using edit groups (see “About Group Editing (Cubase only)” on page 80), for example, to comp two guitar tracks recorded with different microphones.

**Comping with the cursor keys**

Another way of comping is to use the cursor keys to navigate through the takes and the lanes and the “Move To Front (Uncover)” key command (by default [U]) to bring the active take to front.

**Using the Solo button**

To solo a lane, you can activate the Solo button for it. This allows you to hear the lane in project context. If you want to hear the take without project context, you will also have to activate the main track’s Solo button.

The Solo button also comes in handy in case you used the lowermost lane for assembling your “perfect take” instead of using the comping techniques.

**Additional steps**

After rearranging the overlapping events so that you hear what you want, you can perform additional steps.

**Audio**

1. Apply auto fades and crossfades to the comped events.
2. Select all events and select “Delete Overlaps” from the Advanced submenu on the Audio menu to put all events in the top lane and resize the events so that overlapping sections are removed.
3. Open the Audio menu and select the “Bounce Selection” function to create a new and continuous event of all selected events.

**MIDI**

1. Open your takes in a MIDI editor to perform fine adjustments like removing or editing notes.
2. Select all parts in the Project window and use the “Merge MIDI in Loop” option from the MIDI menu with the “Erase Destination” option activated to create a single MIDI part containing your “perfect take”.

Before…

…and after gluing.
Organizing tracks in folder tracks

Creating Folder tracks
Moving tracks into a folder is a way to structure and organize tracks in the Project window. By grouping tracks in folder tracks, you can solo and mute them in a quicker and easier way and perform editing on several tracks as one entity. Folder tracks can contain any type of track including other folder tracks.

Working with folder tracks

• Creating a folder track
On the Project menu open the “Add Track” submenu and select “Folder”, or right-click the track list and select “Add Folder Track” from the context menu.

• Moving tracks into a folder
Open the Project menu and use the “Move Selected Tracks To New Folder” command from the Track folding submenu, right-click on the track in the track list and select the command from the context menu or set up and use the corresponding key command (found in the Project category of the Key Commands dialog).

• Removing tracks from a folder
Drag a track out of the folder and release it in the track list to remove it from the folder.

• Hiding/showing tracks in a folder
Click on the “Expand/Collapse Folder” button (the folder icon) to hide or show the tracks located in a folder or use the corresponding options in the Track Folding submenu of the Project menu (see “Track folding” on page 76). Hidden tracks are played back as usual.

• Hiding/showing data on folder tracks
Right-click on the folder track to open the context menu and from the “Show Data on Folder Tracks” submenu select one of the options. This menu is also available in the Preferences (Editing page). The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always Show Data</td>
<td>The data on the folder track is always visible.</td>
</tr>
<tr>
<td>Never Show Data</td>
<td>The data on the folder track is never visible.</td>
</tr>
<tr>
<td>Hide Data When Expanded</td>
<td>The data on the folder track is only visible if the folder is not expanded.</td>
</tr>
</tbody>
</table>

• Muting and soloing folder tracks
Click the Mute or Solo button on the folder track to mute or solo all tracks in the folder as one unit.

Working with folder parts
A folder part is a graphic representation of events and parts on the tracks in the folder. Folder parts indicate the position and length of the events and parts, as well as on which track they are (their vertical position). If part colors are used, these are also shown in the folder part.

Any Project window editing you perform to a folder part affects all the events and parts it contains. You can select several folder parts if you like – this allows you to handle and edit them together. The editing you can perform includes:

• Moving a folder part. This will move its contained events and parts (possibly resulting in other folder parts, depending on how the parts overlap).
• Using cut, copy and paste.
• Deleting a folder part. This will delete its contained events and parts.
• Splitting a folder part with the Scissors tool.
• Gluing folder parts together with the Glue tube tool. This will only work if the adjacent folder parts contain events or parts on the same track.
• Resizing a folder part resizes the contained events and parts according to the selected resizing method.
• Muting a folder part. This will mute its contained events and parts.

Tracks inside a folder can be edited as one entity by performing the editing directly on the folder part containing the tracks. You can also edit individual tracks within the folder by showing the contained tracks, selecting parts and opening editors as usual.

Double-clicking a folder part opens the editors for the corresponding track classes present in the folder. The following applies:
• All MIDI parts located on the tracks within the folder are displayed as if they were on the same track, just like when opening the Key Editor with several MIDI parts selected. To be able to easily discern the different tracks in the editor, give each track a different color in the Project window and use the “Part Colors” option in the editor (see “Coloring notes and events” on page 382).
• If the folder contains tracks with audio events and/or audio parts, the Sample and/or Audio Part Editors are opened with each audio event and audio part in a separate window.

About Group Editing (Cubase only)

One very convenient feature in Cubase is the Group Editing mode for folders. It allows you to quickly group events and parts across multiple tracks without having to select all the events or parts. This is useful for multi-track recordings of drum sets e.g., where you often want to edit the different drum tracks (bass drum, snare, toms, etc.) together. Edit groups are also useful, if you want to quantize multiple tracks, see “Quantizing multiple audio tracks (Cubase only)” on page 114.

You activate the Group Editing mode by clicking the “=” button in the track list for a folder or by using the default key command [K] (“Toggle Edit Group on Selected Tracks”).

If the Group Editing mode is activated and you select an event, a part or a range on a track inside the folder track, other events, parts or ranges that have the same start and end time and the same playback priority, are also selected and temporarily grouped.

Temporarily means that on every new selection with the Object Selection or the Range Selection tool, Cubase looks for corresponding events or parts inside the folder and groups them. If you edit the start or end point of a single event or part before activating the “=” button for group editing, will cause this event or part to be excluded from the group.

Edit actions in Group Editing mode affect all grouped events, parts or ranges. If you select another take by using the small “To Front” arrow at the right side of one event of an Edit Group e.g., all other tracks inside the Edit Group also switch to the corresponding take. This is very useful for comparing takes of a multi-track recording.

◇ The Group Editing setting overwrites any regular group settings in the edit group. For further information, see “Grouping events” on page 64.
Dividing the track list

It is possible to divide the track list into two parts. Both sections will have independent zoom and scroll controls (if needed), but resizing the window vertically will affect the lower section only (if possible). This is useful if you are working with a video track along with multi-track audio, for example. This way, you can place the video track in the upper track list, letting you scroll the audio tracks separately in the lower track list, referencing them against the video track.

- To divide the track list, click the “Divide Track List” button in the top right corner of the Project window just below the ruler.

- To revert to a single track list, click the button again.

When the track list is divided into two parts, the following applies:

- If you add tracks from the Add Track submenu of the Project menu, video tracks, marker tracks, and arranger tracks are automatically placed in the upper part of the track list.

- If the track list already contains tracks any video, marker, or arranger tracks, these are automatically moved to the upper part when you divide the track list. All other types of tracks are placed in the lower part.

- If you add tracks from the context menu invoked by right-clicking the track list, the tracks are added to the part of the track list in which you click.

- You can move any type of track from the lower track list to the upper and vice versa by right-clicking it in the track list and selecting “Toggle Track List” from the context menu.

- You can resize the upper part by clicking and dragging the divider between the track list sections.
7

Playback and the Transport panel
Background
This chapter describes the various methods available for controlling playback and transport functions in Cubase.

The Transport panel
The Transport panel contains the main transport functions in Cubase, as well as many other options related to playback and recording.

The following sections can be shown on the Transport panel, from left to right:

- Virtual Keyboard, see "The Virtual Keyboard" on page 88.
- Performance, this is related to the VST Performance window, see "About the VST Performance window" on page 24.
- Record Mode, see "Recording audio" on page 97 and "Recording MIDI" on page 102.
- Locators, see "Setting the left and right locators" on page 85 and "About Pre-roll and Post-roll" on page 105.
- Jog/Scrub, "Playing back with the shuttle speed control" on page 85 and "Project scrubbing – the jog wheel" on page 86.
- Main Transport, see below.
- Arranger, see "The arranger track" on page 124.
- Master + Sync, see "Using the metronome" on page 106.
- Marker, see "Using markers" on page 138, "Editing tempo and signature" on page 462, and "Synchronized operation" on page 500.
- MIDI Activity, see below.
- Audio Activity, see below.
- Audio Level Control, see below.

The main transport controls
In the Main Transport area you will find the basic transport controls as well time display options, see "Setting the time format in the Transport panel" on page 84.

- The main transport functions (Cycle/Stop/Play/Record) can also be shown on the toolbar. In addition, various play options are available on the Transport menu.

The MIDI Activity, Audio Activity and Audio Level Control sections
These sections are useful to monitor the MIDI and audio input and output signals. The Audio Level Control section furthermore contains clipping indicators and an output level control.

- The audio activity and clipping indicator as well as the output level control refer to the Control Room channel (Cubase only), if the Control Room is activated. Otherwise, these controls refer to the Main Mix Output bus as defined on the Outputs tab in the VST Connections window. For information on the Control Room, see the chapter "Control Room (Cubase only)" on page 172. In Cubase Artist, the Main Mix bus is always used for monitoring.

Hiding and showing the Transport panel
The Transport panel is shown automatically when you launch a new project. To hide or show it, select "Transport Panel" on the Transport menu (or use the corresponding key command – by default [F2]).

Changing the Transport panel setup
You can customize the appearance of the Transport panel by right-clicking anywhere on the panel and selecting/deselecting the corresponding options on the context menu. This is described in detail in the section "The setup context menus" on page 534.

The numeric keypad
In the default Key Command settings, various Transport panel operations are assigned to the numeric keypad on the computer keyboard. The keypads are slightly different on PC and Macintosh computers:

ugValCo| numeric key | function |
-------|-------------|----------|
[enter] | play        | play     |
[+] | fast forward | fast forward |
[-] | rewind      | rewind |
[*] | record      | record |
[÷] (Win)/[/] (Mac) | cycle on/off | cycle on/off |
[.] | return to zero | return to zero |
[0] | stop        | stop |
[1] | go to left locator | go to left locator |
Operations

Setting the project cursor position

There are several ways to move the project cursor position:

• By using Fast Forward and Rewind.
• By using the Jog/Shuttle/Nudge control on the Transport panel (see “Playing back with the shuttle speed control” on page 85).
• By dragging the project cursor in the lower part of the ruler.
• By clicking in the ruler. Double-clicking in the ruler moves the cursor and starts/stops playback.
• If the “Locate when Clicked in Empty Space” option is activated in the Preferences dialog (Transport page) you can click anywhere in an empty section of the Project window to move the cursor position.
• By changing the value in any of the position displays.
• By using the position slider above the transport buttons in the Transport panel.

The range of the slider relates to the Length setting in the Project Setup dialog. Hence, moving the slider all the way to the right will take you to the end of the project.

• By using markers (see the chapter “Using markers” on page 138).
• By using playback options (see “Playback functions” on page 87).
• By using the arranger function (see “The arranger track” on page 124).
• By using functions on the Transport menu.

On the Transport menu, the following functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locate Selection/Locate Selection End</td>
<td>Moves the project cursor to the beginning or end of the current selection. For this to be available, you must have selected one or more events or parts, or made a selection range.</td>
</tr>
<tr>
<td>Locate Next/Previous Marker</td>
<td>This moves the project cursor to the closest marker to the right or left (see “Marker tracks” on page 41).</td>
</tr>
<tr>
<td>Locate Next/Previous Event</td>
<td>This moves the project cursor forwards or backwards respectively, to the closest beginning or end of any event on the selected track(s).</td>
</tr>
</tbody>
</table>

If Snap is activated when dragging the project cursor, the Snap value is taken into account. This is helpful for finding exact positions quickly.

There are also numerous key commands available for moving the project cursor (in the Transport category in the Key Commands dialog). For example, you can assign key commands to the “Step Bar” and “Step Back Bar” functions, allowing you to move the project cursor in steps of one bar, backwards and forwards.

Setting the time format in the Transport panel

The time unit shown in the ruler can be independent from the time unit shown in the main time display on the Transport panel. This means that you can display timecode in the transport position display and bars and beats in the ruler, for example. In addition, there is a secondary time display to the right of the primary time display which is also independent, giving you three different time units shown at the same time. In the Project window, you can also create additional ruler tracks – see “Using multiple rulers – ruler tracks” on page 45.

The following rules apply:

• If you change the time format of the primary time display on the Transport panel, the time format of the ruler will be changed as well.

This is the same as changing the display format in the Project Setup. Therefore, to have different display formats in the ruler and the main time display you should change the format in the ruler.
The primary time display format is set on the pop-up menu to the right in the main position display. This setting also determines the time format displayed for the left and right locators on the Transport panel. The secondary time display is completely independent, and the display format is set on the pop-up menu to the right in the secondary time display. You can swap time formats between the primary and secondary time displays by clicking the double arrow symbol (Exchange Time Formats) between them.

Setting the left and right locators

The left and right locators are a pair of position markers used for specifying punch-in and punch-out positions during recording, and as boundaries for cycle playback and recording.

When cycle mode is activated on the Transport panel, the area between the left and right locators will be repeated (cycled) on playback. However, if the right locator is positioned before the left, this will work as a “jump” or “skip mode” – when the project cursor reaches the right locator it will immediately jump to the left locator position and continue playback from there.

There are several ways to set locator positions:

- To set the left locator, press [Ctrl]/[Command] and click at the desired position in the ruler.

Similarly, pressing [Alt]/[Option] and clicking in the ruler sets the right locator. You can also drag the locator “handles” directly in the ruler.

- Click and drag in the upper half of the ruler to “draw” a locator range.

If you click on an existing locator range, you can drag to move it.

- Pressing [Ctrl]/[Command] and pressing [1] or [2] on the numeric keypad sets the left or right locator to the project cursor position.

Similarly, you can press [1] or [2] on the numeric keypad (without [Ctrl]/[Command]) to set the project cursor position to the left or right locator position. Note that these are default key commands – you can change these if you like.

- By creating cycle markers you can store any number of left and right locator positions, which can be recalled by simply double-clicking on the corresponding marker (see “Editing markers on the marker track” on page 142).

- The “Locators to Selection” item on the Transport menu (default key command [P]) sets the locators to encompass the current selection. This is available if you have selected one or several events or made a selection range.

- You can also adjust the locators numerically on the Transport panel. Clicking the L/R buttons in the locator section on the Transport panel will move the project cursor to the respective locator. If you press [Alt]/[Option] and click the L or R button, the corresponding locator will be set to the current project cursor position.

Playing back with the shuttle speed control

The shuttle speed control (the outer wheel on the Transport panel) allows you to play back the project at any speed (four times the playback speed at maximum), forwards or backwards. This is a quick way to locate or “cue” to any position in the project.

- Turn the shuttle speed wheel to the right to start playback.

The further to the right you move the wheel, the faster the playback speed.

- If you turn the wheel to the left instead, the project will play backwards.

The speed depends on how far to the left you turn the wheel.
The “Use Inserts While Scrubbing” option in the Preferences (Transport–Scrub page) allows you to activate insert effects for scrubbing with the shuttle speed control. By default, insert effects are bypassed.

- You can also access the shuttle speed control via a remote control device.

**Project scrubbing – the jog wheel**

The middle wheel on the Transport panel serves as a jog wheel. By clicking and turning it to the right or left you will move the playback position manually forwards or backwards – much like scrubbing on a tape deck. This helps you pinpoint exact locations in the project.

- Note that the jog wheel is an “endless rotary encoder” – you can turn it as many times as needed to move to the desired location.
- The faster you turn the wheel, the faster the playback speed. The original playback speed is the fastest speed possible.
- If you click the jog wheel during playback, playback automatically stops and scrubbing starts.
- The “Use Inserts While Scrubbing” option in the Preferences dialog on the Transport–Scrub page allows you to activate insert effects for scrubbing with the jog wheel. By default, insert effects are bypassed.

- You can also use a jog wheel on a remote controller for scrubbing.

**Nudging the project cursor**

The “+” and “−” buttons in the middle of the Shuttle/Jog section allow you to nudge the project cursor position one frame at a time to the right or left.

**Options and Settings**

**The “Return to Start Position on Stop” preference**

This setting is found on the Transport page in the Preferences dialog (opened from the File menu under Windows, or the Cubase menu under Mac OS X).

- If “Return to Start Position on Stop” is activated when you stop playback, the project cursor will automatically return to the position where recording or playback last started.
- If “Return to Start Position on Stop” is deactivated, the project cursor will remain at the position where you stop playback.

Pressing Stop again will return the project cursor to the position where recording or playback last started.

**About track disable/enable**

For audio tracks, the track context menu contains an item named “Disable Track”. This shuts down all disk activity for the track, as opposed to using Mute, which merely turns down the output volume for a track. For example, if you often record “alternative takes” you can easily build up a large number of takes on different tracks. Even though these tracks are muted, they are actually still “playing back” from the hard disk during playback. Because this puts an unnecessary load on your disk system, using “Disable Track” is recommended for such situations.

- Select “Disable Track” for tracks that you want to keep in the project for later use but do not want to play back now. The track color changes to indicate that the track is disabled.
- Select “Enable Track” from the track context menu to re-enable disabled tracks.
Playback functions

Apart from the standard transport controls on the Transport panel, you can also find a number of functions on the Transport menu that can be used to control playback. The items have the following functionality:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post-roll from Selection Start/End</td>
<td>Starts playback from the beginning or end of the currently selected range and stops after the time set in the Post-roll field on the Transport panel.</td>
</tr>
<tr>
<td>Pre-roll to Selection Start/End</td>
<td>Starts playback from a position before the start or end of the currently selected range and stops at the selection start or end, respectively. The playback start position is set in the Pre-roll field on the Transport panel.</td>
</tr>
<tr>
<td>Play from Selection Start/End</td>
<td>Activates playback from the beginning or end of the current selection.</td>
</tr>
<tr>
<td>Play until Selection Start/End</td>
<td>Activates playback two seconds before the start or end of the current selection and stops at the selection start or end, respectively.</td>
</tr>
<tr>
<td>Play until Next Marker Range</td>
<td>This activates playback from the project cursor and stops at the next marker.</td>
</tr>
<tr>
<td>Loop Selection</td>
<td>This activates playback from the start of the current selection and keeps starting over again when reaching the selection end.</td>
</tr>
</tbody>
</table>

⚠️ The functions listed above (except “Play until Next Marker”) are only available if you have selected one or more events or made a selection range.

⚠️ In the Preferences dialog (Editing–Audio page) you will find the “Treat Muted Audio Events like Deleted” option. When you activate this option, any events overlapped by a muted event will become audible.

About Chase

Chase is a function that makes sure your MIDI instruments sound as they should when you locate to a new position and start playback. This is accomplished by the program transmitting a number of MIDI messages to your instruments each time you move to a new position in the project, making sure all MIDI devices are set up correctly with regard to program change, controller messages (such as MIDI Volume), etc.

For example, let’s say you have a MIDI track with a program change event inserted at the beginning. This event makes a synth switch to a piano sound.

At the beginning of the first chorus you have another program change event which makes the same synth switch to a string sound.

You now play back the song. It begins with the piano sound and then switches to the string sound. In the middle of the chorus you stop and rewind to some point between the beginning and the second program change. The synth will now still play the string sound although in this section it really should be a piano!

The Chase function takes care of that. If program change events are set to be chased, Cubase will track the music back to the beginning, find the first program change and transmit it to your synth, setting it to the correct sound.

The same thing can apply to other event types as well. The Chase Events settings in the Preferences dialog (MIDI page) determine which event types will be chased when you locate to a new position and start playback.

mayın Event types for which the checkbox is activated here will be chased.

• In this section of the Preferences dialog, you will also find the “Chase not limited to Part Boundaries” option. When you activate this option, MIDI controllers are also chased outside the part boundaries, i.e. the Chase will be performed on the part touched by the cursor as well as on all the parts to the left of it. Please note that this option should be deactivated for very large projects, as it considerably slows down operations such as positioning and solos. When you deactivate this option, the MIDI controllers are only chased within the parts under the position cursor.
The Virtual Keyboard

The Virtual Keyboard can be displayed in the Transport panel. It allows you to play and record MIDI notes by using your computer keyboard or mouse. This is useful if you have no external MIDI instrument at hand and you do not want to draw in notes with the Pencil tool. The Virtual Keyboard can perform all functions that can be controlled by external MIDI keyboards, e.g. playing and recording MIDI notes.

• You can choose between two different keyboard display modes: computer keyboard and piano keyboard. To switch between these two modes, click the “Change Virtual Keyboard Display Type” button in the lower right corner of the Virtual Keyboard section or use the [Tab] key.

<table>
<thead>
<tr>
<th>The Virtual Keyboard in computer keyboard display mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Virtual Keyboard in piano keyboard display mode</td>
</tr>
</tbody>
</table>

To record MIDI using the Virtual Keyboard, proceed as follows:

1. Create or choose a MIDI or an instrument track and activate the “Record Enable” button for it.

2. Open the Virtual Keyboard by selecting “Virtual Keyboard” on the Devices menu, by pressing [Alt]/[Option]-[K] or by right-clicking on the Transport panel and selecting “Virtual Keyboard” on the context menu. The Virtual Keyboard is displayed in the Transport panel.

3. Activate the Record button and press a key on your computer keyboard to enter a note. You can also click on the keys of the Virtual Keyboard to enter notes.

| Options and settings |

• You can also press several keys simultaneously to enter polyphonic parts. The maximum number of notes that can be played at one time varies between the different operating systems and hardware configurations.

4. Use the fader “Note velocity level” to the right of the virtual keyboard to adjust the volume. You can also use the up and down arrow keys for this.

5. Enter the desired notes this way.

6. When you are done, hit the Stop button and close the Virtual Keyboard. When the Virtual Keyboard is hidden, all key commands are available again.

When the Virtual Keyboard is displayed, the usual key commands are blocked because they are reserved for the Virtual Keyboard. The only exceptions are: [Ctrl]/[Command]-[S] (Save), Num [*] (Start/Stop Record), [Space] (Start/Stop Playback), Num [1] (Jump to left locator), [Delete] or [Backspace] (Delete), Num [/] (Cycle on/off), [F2] (Show/Hide Transport panel), and [Alt]/[Option]-[K] (Show/Hide Virtual Keyboard).
8

Recording
Background

This chapter describes the various recording methods that you can use in Cubase. As it is possible to record both audio and MIDI tracks, both recording methods are covered in this chapter.

Before you start

This chapter assumes that you are reasonably familiar with certain basic recording concepts, and that the following initial preparations have been made:

• You have properly set up, connected and calibrated your audio hardware.

• You have opened a project and set the project setup parameters to your specifications. Project setup parameters determine the record format, sample rate, project length, etc. that affect the audio recordings you make during the course of the project, see “The Project Setup dialog” on page 54.

• If you plan to record MIDI, your MIDI equipment has to be set up and connected correctly.

Basic recording methods

This section describes the general methods used for recording. However, there are additional preparations and procedures that are specific to audio and MIDI recording respectively. Make sure to read these sections before you start recording (see “Audio recording specifics” on page 92 and “MIDI recording specifics” on page 100).

Record-enabling tracks

Cubase can record on a single track or on several tracks (audio and/or MIDI) simultaneously. To make a track ready for recording, activate the Record Enable button for the track in the track list, in the Inspector, or in the Mixer.

Record Enable in the Inspector, track list, and Mixer

If “Enable Record on Selected Audio Track” or “Enable Record on Selected MIDI Track” is activated in the Preferences dialog (Editing–Project & Mixer page), audio or MIDI tracks are automatically record-enabled when you select them in the track list.

You can set up key commands to record-enable all audio tracks simultaneously and to deactivate Record Enable for all audio tracks (Arm/Disarm all Audio Tracks). You will find these commands in the Key Commands dialog, in the Mixer category (see “Setting up key commands” on page 542).

The exact number of audio tracks you can record simultaneously depends on your computer CPU and hard disk performance. In the Preferences dialog (VST page), you can find the “Warn on Processing Overloads” option. When this is activated, a warning message will be displayed as soon as the CPU clip indicator (on the Transport panel) lights up during recording.
**Activating recording**

Activating recording, i.e. performing and setting up manual and automatic punch in recording is identical for audio and MIDI.

- Punching in and out on MIDI recordings with pitch-bend or controller data (modulation wheel, sustain pedal, volume, etc.) may lead to strange effects (apparently hanging notes, constant vibrato, etc.). If this happens, you may need to use the Reset item on the MIDI menu (see “The Reset function” on page 104).

**Manually**

You activate recording by clicking the Record button on the Transport panel or toolbar or by using the corresponding key command (by default [*] on the numeric keypad).

Recording can be activated in Stop mode (from the current cursor position or from the left locator) or during playback:

- If you activate recording in Stop mode, and the “Start Record at Left Locator” option is activated on the Transport menu, recording will start from the left locator. The pre-roll setting or the metronome count-in will be applied (see “About Pre-roll and Post-roll” on page 105).
- If you activate recording in Stop mode, and “Start Record at Left Locator” is deactivated, recording will start from the current project cursor position.
- If you activate recording during playback, Cubase will immediately enter Record mode and start recording from the current project cursor position. This is known as “manual punch in”.

- If you are synchronizing the Cubase transport to external equipment (Sync is activated on the Transport panel) and you activate recording, the program will go into “record ready” mode (the record button on the Transport panel will light up). In this case, recording will start when a valid timecode signal is received (or when you click the Play button). See the chapter “Synchronization” on page 493 for more information.

**Automatically**

Cubase can automatically switch from playback to recording at a given position. This is known as “automatic punch in”. A typical use for this is if you need to replace a section of a recording, and want to listen to what is already recorded, up to the recording start position. Proceed as follows:

1. Set the left locator to the position where you want recording to start.
2. Activate the Punch In button on the Transport panel.
3. Activate playback from some position before the left locator.

When the project cursor reaches the left locator, recording is automatically activated.

**Stopping recording**

Again, this can be done automatically or manually:

- If you click the Stop button on the Transport panel (or use the corresponding key command, by default [0] on the numeric keypad), recording is deactivated and Cubase goes into Stop mode.
- If you click the Record button (or use the key command for recording, by default [*]), recording is deactivated but playback continues. This is known as “manual punch out”.
- If the Punch Out button is activated on the Transport panel, recording will be deactivated when the project cursor reaches the right locator. This is known as “automatic punch out”. By combining this with automatic punch in, you can set up a specific section to record – again very useful if you want to replace a certain part of a recording (see also “Stop after Automatic Punch Out” on page 105).
Cycle recording

Cubase can record and play back in a cycle – a loop. You specify where the cycle starts and ends by setting the left and right locators. When the cycle is active, the selected section is seamlessly repeated until you hit Stop or deactivate cycle mode.

- To activate cycle mode, click the cycle button on the Transport panel.

To record in cycle mode, you can start recording from the left locator, from before the locators or from within the cycle, in Stop mode or during playback. As soon as the project cursor reaches the right locator, it will jump back to the left locator and continue recording a new lap.

The results of cycle recording depend on the selected cycle record mode and are different for audio (see “Recording audio” on page 97) and MIDI (see “Recording MIDI” on page 102).

Audio recording specifics

Selecting a recording file format

The format for recorded files is set in the Project Setup dialog on the Project menu. There are three settings: Sample Rate, Bit Resolution, and Record File Type. While the sample rate is set once and for all when you start working on a new project, the bit resolution and file type can be changed at any time.

Record File Type

The Record File Type setting determines which type of files will be created when you record:

<table>
<thead>
<tr>
<th>File type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wave File</td>
<td>Wave files have the extension “.wav” and are a common file format on the PC platform.</td>
</tr>
<tr>
<td>Wave 64 File</td>
<td>Wave 64 is a proprietary format developed by Sonic Foundry Inc. Audio-wise it is identical to the Wave format, but the internal file structure makes much larger file sizes possible. This is useful for long live recordings, where the audio files can become huge.</td>
</tr>
</tbody>
</table>

- If you select Broadcast Wave File or AIFF format, you can specify Author, Description and Reference text strings that will be embedded in the recorded file. This is done on the Record–Audio–Broadcast Wave page in the Preferences dialog.

Bit Resolution

The available options are 16 bit, 24 bit, and 32 bit float. Use the following guidelines:

- Normally, select the record format according to the bit resolution delivered by your audio hardware. For example, if your audio hardware has 20 bit A/D converters (inputs), you may want to record at 24 bit resolution to capture the full bit resolution. On the other hand, if your hardware has 16 bit inputs, it is pointless to record with a higher bit resolution – this will only make the audio files larger, with no difference in audio quality. The exception is if you record with effects – see “Recording with effects (Cubase only)” on page 98.

- The higher the bit resolution, the larger the files and the more strain is put on the disk system. If this is an issue, you may want to lower the record format setting.

For further information on the options in the Project Setup dialog, see “The Project Setup dialog” on page 54.

RAM requirements for recording

When recording live music performances, you will often simultaneously record on a large number of tracks at the same time.

Each track on which you record requires a certain amount of RAM, and the memory usage increases the longer the recording lasts.
Please consider the RAM limitation (see “RAM” on page 22) of your operating system when setting up your project for recording.

⚠️ When a recording has used up all the memory made available by the operating system, the computer may crash.

For each audio channel, 2.4 MB of RAM are required for mixer settings, etc. One minute of audio recording with a sample rate of 96 kHz on a mono track will increase memory usage by another 176 KB (Windows Task Manager, average).

Examples:

- Recording on a 32-bit system with 64 mono tracks at a sample rate of 44.1 kHz, lasting 60 minutes. This would require a total of 403 MB of memory – not a problem on a modern computer.
- Recording on a 32-bit system with 128 mono tracks at a sample rate of 96 kHz, lasting 60 minutes. This would require 1658 MB of memory – dangerously close to the 2 GB limit for RAM on a 32-bit Windows computer.

⚠️ Also note that the maximum file size for regular Wave files is 2 GB. If you want to record larger files, use the Waves 64 format (see “Record File Type” on page 92).

Setting up the track

Creating a track and selecting the channel configuration

Audio tracks can be configured as mono, stereo, or surround tracks (Cubase only). This allows you to record or import a file containing multiple channels and treat it as one entity, with no need to split it up into several mono files, etc. The signal path for an audio track maintains its channel configuration all the way from the input bus, via EQ, level and other Mixer settings to the output bus.

You specify the channel configuration for a track when you create it:

1. Select “Add Audio Track” from the track list context menu or the Project menu (or, if an audio track is already selected, double-click in an empty area of the track list). A dialog opens with a channel configuration pop-up menu.

2. Select the desired format from the pop-up menu. In Cubase Artist, you choose between mono and stereo. In Cubase, the most common formats are listed directly on the pop-up menu, with the remaining surround formats listed on the “More…” submenu. For a list of the available surround formats, see “Output bus configuration” on page 219.

- The Browse item in this dialog allows you to browse your disks for created track presets, which can be used as a basis (or template) for tracks. This is described in detail in the chapter “Working with track presets” on page 331.

3. Click the Add Track button. A track is added, set to the specified channel configuration. In the Mixer, a corresponding channel strip appears. You cannot change the channel configuration for a track.

Selecting an input bus for a track

Here we assume that you have added and set up the required input busses (see “Setting up busses” on page 26). Before you record, you need to specify from which input bus the track will record. You can do this in the Inspector or in the Mixer.

- In the Inspector, you select an input bus on the Input Routing pop-up menu in the top section. As described in the section “The Inspector” on page 39, the Inspector shows the settings for the selected track.
In the Mixer, you select an input bus on the Input Routing pop-up menu at the top of the track’s channel strip. If this pop-up menu is not shown, you need to open the Mixer Routing View by clicking the “Show Routing” button in the extended Mixer common panel or by selecting “Show Routing View” from the Window submenu of the Mixer context menu. See “Configuring the Mixer” on page 148 for more information about the Mixer.

Recording from busses (Cubase only)

You can also select an output bus, a group bus or an FX channel bus as an Input for your recording.

Let’s assume you want to create a downmix of separate tracks, e.g. bass drum, hi-hats, snare, etc.

Proceed as follows:

1. Set up your separate tracks as desired and add a group track.
2. For each of the drum tracks, open the Output Routing pop-up menu and select the Group track as output.
3. Create a new audio track, open the Input Routing pop-up menu for it and select the Group track as input for this audio track.
4. Record enable this audio track and start recording.

Now, the output of the group track will be recorded on the new track and you will get a mix of your separate tracks.

You can also select an FX channel as recording source. In this case, only the output of the FX channel will be recorded.

For more information about the routing possibilities, see “Routing” on page 164.

Selecting a folder for the recorded audio files

Each Cubase project has a project folder containing (among other things) an “Audio” folder. By default, this is where recorded audio files are stored. However, you can select record folders independently for each audio track if needed.

Proceed as follows:

1. To select the same record folder for several audio tracks, select them by pressing [Shift] or [Ctrl]/[Command] and clicking on them in the track list.
2. Right-click the track list for one of the tracks to bring up the context menu.
3. Select “Set Record Folder”.
4. Navigate to the desired folder (or create a new folder with the Create button).

Tip: if you want to have separate folders for different types of material (speech, ambient sounds, music, etc.), you can create subfolders within the project’s “Audio” folder and assign different tracks to different subfolders. This way, all audio files will still reside within the project folder, which will make managing the Project easier.

It is possible to have different tracks record to totally different locations, even on different disks. However, if you need to move or archive the project, there is a risk of missing some files. The solution is to use the “Prepare Archive” function in the Pool to gather all external files into the project folder first, see “Prepare Archive” on page 309.

Setting input levels

When recording digital sound, it is important to set the input levels correctly – loud enough to ensure low noise and high audio quality, but not so loud that clipping (digital distortion) occurs.

Clipping typically occurs in the audio hardware when a too loud analog signal is converted to digital in the hardware’s A/D converters.

It is also possible to get clipping when the signal from the input bus is written to a file on your hard disk. This is because in Cubase, you can make settings for the input bus, adding EQ, effects, etc. to the signal as it is being recorded. This may raise the level of the signal, causing clipping in the recorded audio file.
To check the level of the “unprocessed” signal coming into the audio hardware, you need to switch the level meters to “Meter Input”. In this mode, the input channel level meters will show the level of the signal at the input of the bus, before any adjustments such as input gain, EQ, effects, level or pan:

1. Right-click in the Mixer window to open the context menu.
2. Select the Global Meter Settings submenu and make sure that “Meter Input” is activated.
3. Play back the audio and check the level meter for the input channel.

The signal should be as loud as possible without exceeding 0 dB (the Clipping indicator for the input bus should not light up).

4. If necessary, adjust the input level in one of the following ways:
   - Adjust the output level of the sound source or external mixer.
   - Use the audio hardware’s own application program to set the input levels (if possible).
   - If your audio hardware supports the ASIO Control Panel function, it may be possible to make input level settings. To open the ASIO control panel, open the Device Setup dialog via the Devices menu and, in the list to the left (below “VST Audio System”), select your audio card. When this is selected, you can open the Control Panel by clicking the Control Panel button in the settings section to the right.

The next step is to check the level of the audio being written to a file on your hard disk. This is only necessary if you have made any adjustments to the input channel (level settings, EQ, insert effects, etc.).

Also note the following:
   - If you record in 32-bit float format, the bit resolution will not be reduced – which means there is no risk of clipping at this stage. Also, this preserves the signal quality perfectly. Therefore, you should consider using 32-bit float format when you are recording with effects (see “Recording with effects (Cubase only)” on page 98).

   - If you record in 16- or 24-bit format, the available headroom is lower, which means clipping can occur if the signal is too loud. To avoid this, set the signal as described below.
   1. Bring up the Mixer context menu, open and select Global Meter Settings “Meter Post-Fader”.
   2. Set up the input channel, by adding EQ and/or effects. With some effects you may want to adjust the level of the signal going into the effect – use the Input Gain knob for this. Note that you need to press [Shift] or [Alt]/[Option] to adjust the Input Gain.

   Adjusting the Input Gain.

3. Play back the audio and check the level meter of the input channel.

   The signal should be reasonably loud without exceeding 0 dB (the Clipping indicator for the input bus should not light up).

4. If necessary, use the input channel fader to adjust the signal level.

**Audio pre-record**

This feature allows you to capture up to 1 minute of any incoming audio you play in Stop mode or during playback, “after the fact”. This is possible because Cubase can capture audio input in buffer memory, even when not recording.

Proceed as follows:

1. Open the Preferences dialog (Record–Audio page).
2. Specify a time (up to 60 seconds) in the “Audio Pre-Record Seconds” field.
   This activates the buffering of audio input, making Pre-Record possible.
3. Make sure an audio track is record-enabled and receives audio from the signal source.
4. When you have played some audio material you want to capture (either in Stop mode or during playback), click the Record button.
5. After a few seconds stop the recording. An audio event is created, starting at where the cursor position was when you activated recording. If you were in stop mode and the cursor was at the beginning of the project, you may have to move the event to the right in the next step. If you were playing along to a project you leave the event where it is.

6. Select the Arrow tool and place the cursor on the bottom left edge of the event so that a double arrow appears, then click and drag to the left. Now the event is extended and the audio you played before activating record is inserted – this means that if you played along during playback, the captured notes will end up exactly where you played them in relation to the project.

Monitoring
In this context, “monitoring” means listening to the input signal during recording. There are three fundamentally different ways to do this: via Cubase, externally (by listening to the signal before it reaches Cubase), or by using ASIO Direct Monitoring (which is a combination of both other methods – see below).

Monitoring via Cubase
If you monitor via Cubase, the input signal is mixed in with the audio playback. The advantage of this is that you can adjust the monitoring level and panning in the Mixer, and add effects and EQ to the monitor signal just as during playback (using the track’s channel strip – not the input bus!).

The disadvantage of monitoring via Cubase is that the monitored signal will be delayed according to the latency value (which depends on your audio hardware and drivers). Therefore, monitoring via Cubase requires an audio hardware configuration with a low latency value. You can check the latency of your hardware in the Device Setup dialog (VST Audio System page).

If you are using plug-in effects with large inherent delays, the automatic delay compensation function in Cubase will increase the latency. If this is a problem, you can use the Constrain Delay Compensation function while recording, see “Constrain Delay Compensation” on page 216.

When monitoring via Cubase, you can select one of four Auto Monitoring modes in the Preferences dialog (VST page):

- Manual
  This option allows you to turn input monitoring on or off by clicking the Monitor button in the Inspector, the track list or in the Mixer.

- While Record Enabled
  With this option, you will hear the audio source connected to the channel input whenever the track is record enabled.

- While Record Running
  This option switches to input monitoring only during recording.

- Tapemachine Style
  This option emulates standard tapemachine behavior: input monitoring in Stop mode and during recording, but not during playback.

  - In the Preferences dialog (VST–Metering page) you can find the “Map Input Bus Metering to Audio Track (in Direct Monitoring)” option.

When Direct Monitoring is activated in the Device Setup dialog, this option allows you to map the input bus metering to monitor-enabled audio tracks. This gives you the opportunity to watch the input levels of your audio tracks when working in the Project window.

When Direct Monitoring is activated in the Device Setup dialog, this function works as follows:

- When “Map Input Bus Metering to Audio Track (in Direct Monitoring)” is activated, audio tracks show the metering signal from the input bus they are routed to as soon as the track is record enabled.

  Note that the tracks are mirroring the input bus signal, i.e. you will see the same signal in both places. When using mapped metering, any functions (e.g. trimming) you apply to the audio track are not reflected in its meters.

- When “Map Input Bus Metering to Audio Track (in Direct Monitoring)” is not activated, metering works as usual.
External monitoring

External monitoring (listening to the input signal before it goes into Cubase) requires some sort of external mixer for mixing the audio playback with the input signal. This can be a stand-alone physical mixer or a mixer application for your audio hardware, if this has a mode in which the input audio is sent back out again (usually called “Thru”, “Direct Thru” or similar).

When using external monitoring, you cannot control the level of the monitor signal from within Cubase or add VST effects or EQ to the monitor signal. The latency value of the audio hardware configuration does not affect the monitor signal in this mode.

If you want to use external monitoring, you need to make sure that monitoring via Cubase is not activated as well. Select the “Manual” monitoring mode in the Preferences dialog (VST page) and do not activate the Monitor buttons.

ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may support ASIO Direct Monitoring (this feature may also be available for audio hardware with Mac OS X drivers). In this mode, the actual monitoring is done in the audio hardware, by sending the input signal back out again. However, monitoring is controlled from Cubase. This means that the audio hardware’s direct monitoring feature can be turned on or off automatically by Cubase, just as when using internal monitoring.

- To activate ASIO Direct Monitoring, open the Device Setup dialog on the Devices menu and activate the Direct Monitoring checkbox on the page for your audio hardware. If the checkbox is grayed out, your audio hardware (or its driver) does not support ASIO Direct Monitoring. Consult the audio hardware manufacturer for details.
- When ASIO Direct Monitoring is activated, you can select a monitoring mode in the Preferences dialog (VST page), as when monitoring via Cubase (see “Monitoring via Cubase” on page 96).

Recording audio

You can record audio using any of the general recording methods (see “Basic recording methods” on page 90). When you finish recording, an audio file is created in the Audio folder within the project folder. In the Pool, an audio clip is created for the audio file, and an audio event that plays the whole clip appears on the recording track. Finally, a waveform image is calculated for the audio event. If the recording was very long, this may take a while.

- Depending on the audio hardware, it may also be possible to adjust the monitoring level and panning from the Mixer (including the Control Room section, but excluding the Talkback and External Return channels – Cubase only) by adjusting the volume faders, and the input gain controls and the send levels for Control Room studios. Consult the documentation of the audio hardware if in doubt.
- VST effects and EQ cannot be applied to the monitor signal in this mode, since the monitor signal does not pass through Cubase.
- Depending on the audio hardware, there may be special restrictions as to which audio outputs can be used for direct monitoring.

For details on the routing of the audio hardware, see its documentation.

The latency value of the audio hardware configuration does not affect the monitor signal when using ASIO Direct Monitoring.

When using Steinberg hardware (MR816 series) in combination with ASIO Direct Monitoring, monitoring will be virtually latency-free.

If you are using RME Audio Hammerfall DSP audio hardware, make sure that the pan law is set to -3 dB in the card’s preferences.

If the “Create Audio Images During Record” option is activated in the Preferences dialog (Record–Audio page), the waveform image will be calculated and displayed during the actual recording process. This realtime calculation uses some processing power – if your processor is slow or if you are working on a CPU-intensive project, consider deactivating this option.
Undoing recording

If you decide that you do not like what you just recorded, you can delete it by selecting Undo from the Edit menu. The following will happen:

- The events you just created will be removed from the Project window.
- The audio clips in the Pool will be moved to the Trash folder.

The recorded audio files will not be removed from the hard disk. However, since their corresponding clips are moved to the Trash folder, you can delete the files by opening the Pool and selecting “Empty Trash” from the Media menu, see “Deleting from the hard disk” on page 303.

About overlap and the Audio Record Modes

The Audio Record Mode setting lets you decide what happens to your recording and to any existing events on the track where you are recording. This is necessary because you will not always record on an empty track. There may be situations where you record over existing events — especially in cycle mode.

To select an Audio Record Mode, proceed as follows:

1. On the Transport panel, click the audio symbol in the upper left section.

   ![Click here…](Image)

   …to open the Audio Record Mode panel.

2. Activate the desired option.

   The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keep History</td>
<td>Existing events (or portions of events) that are overlapped by a new recording are kept.</td>
</tr>
<tr>
<td>Cycle History + Replace</td>
<td>Existing events (or portions of events) that are overlapped by a new recording are replaced by the new recording. However, if you record in cycle mode, all takes from the current cycle recording are kept.</td>
</tr>
<tr>
<td>Replace</td>
<td>Existing events (or portions of events) that are overlapped by a new recording are replaced by the last recorded take.</td>
</tr>
</tbody>
</table>

3. Click anywhere outside the panel to close the Audio Record Mode panel.

To learn how to create a “perfect take” by combining the best parts from the different cycle laps, see “Working with lanes” on page 76.

Handling overlapping audio

The basic rule for audio tracks is that each track can only play back a single audio event at a time. If two or more events overlap, you will only hear one of them: the one that is actually visible (e.g. the last lap of a cycle recording).

If you have a track with overlapping (stacked) events/regions, use one of the following methods to select the event/region that is played back:

- Open the context menu for the audio event in the event display and select the desired event or region from the “To Front” or “Set to Region” submenu.
- Use the handle in the middle of a stacked event and select an entry from the pop-up menu that appears.
- Activate the “Show Lanes” button and click on the desired take.

For details about lane editing, see “Working with lanes” on page 76.

Recording with effects (Cubase only)

Normally you record the audio signals “dry” and add effects non-destructively during playback as described in the chapter “Audio effects” on page 187. However, Cubase also allows you to add effects (and/or EQ) directly while recording. This is done by adding insert effects and/or making EQ settings for the input channel in the Mixer.

This will make the effects become part of the audio file itself – you cannot change the effect settings after recording.
About the record format

When you record with effects, consider setting the bit resolution to 32 Bit Float. This is done in the Project Setup dialog opened via the Project menu. Note that this is not required in any way – you can also record with effects in 24 or 16 Bit format. However, there are two advantages to the 32 Bit Float format:

- You do not risk clipping (digital distortion) in the recorded files. This can be avoided with 24 or 16 Bit recording as well, but requires more care with the levels.

- Cubase processes audio internally in 32 Bit Float format – recording in the same format means the audio quality will be kept absolutely pristine. The reason is that the effect processing in the input channel (as well as any level or EQ settings you make there) is done in 32 Bit Float format. If you record at 16 or 24 Bit, the audio will be converted to this lower resolution when it is written to file – with possible signal degradation as a result.

An example

This example shows how to apply the “SoftClipper” effect while recording. The principle is the same for all effects (or combinations of effects).

1. Set up an audio track for recording and select the desired input bus.

   For best results, also activate monitoring as this allows you to hear and try out your settings before actually recording. See “Monitoring via Cubase” on page 96 for a description of monitoring via Cubase.

2. Open the Mixer and make sure that the full extended view is shown.

   To show the extended Mixer view, either click the arrow icon (“Show Extended Mixer”) in the Common Panel, select “Show Extended View” from the Window submenu of the Mixer context menu or use a key command (this can be set in the Key Commands dialog, see “Setting up key commands” on page 542).

3. Locate the input channel (bus) from which you record. If the input channels are hidden, click on the Show/Hide Input Channels button to the left.

4. Check the input level (of the signal coming into the audio hardware) as described in the section “Setting input levels” on page 94 and adjust the level of the source audio if necessary.

5. Pull down the View Options pop-up menu for the input channel and select “Inserts”.

   The View Options pop-up menu is opened by clicking the arrow button between the fader panel and the extended panel.

Now the extended panel for the input channel shows the insert slots.

6. Click on an insert slot and select an effect from the context menu.

   As you see, the included effects are sorted into submenus – you will find the SoftClipper effect on the “Distortion” submenu.

   The effect is loaded and activated and its control panel is automatically opened.

7. Adjust the effect parameters to your liking.

   For detailed information on the Effect parameters, see the separate PDF document “Plug-in Reference”.

8. When the effect is set up as desired, you can check the level of the input channel by setting the Meters to post-fader (see “Setting input levels” on page 94).

   Use the input channel fader to adjust the level if needed.

10. When you are finished, you can play back the recorded audio track.

As you can hear, the effect you applied is now a part of the actual audio file.

11. If you do not want to record more with the same plug-in, deactivate it by clicking in the insert slot and selecting “No Effect”.

**Recovery of audio recordings after system failure**

Normally, when a computer crashes, all changes made to your current project since you last saved it will be lost. Usually, there is no quick and easy way to recover your work.

With Cubase, when your system crashes while you are recording (because of a power cut or other mishap), you will find that your recording is still available, from the moment when you started recording to the time when your computer crashed.

When you experience a computer crash during a recording, simply relaunch the system and check the project record folder (by default this is the Audio subfolder inside the project folder). It should contain the audio file you were recording at the time of the crash.

⚠️ This feature does not constitute an “overall” guarantee by Steinberg. While the program itself was improved in such a way that audio recordings can be recovered after a system failure, it is always possible that a computer crash, power cut, etc. might have damaged another component of the computer, making it impossible to save or recover any of the data.

⚠️ Please do not try to actively bring about this kind of situation to test this feature. Although the internal program processes have been improved to cope with such situations, Steinberg cannot guarantee that other parts of the computer are not damaged as a consequence.

---

**MIDI recording specifics**

### Activating MIDI Thru

Normally, when working with MIDI, you will have MIDI Thru activated in Cubase, and Local Off selected in your MIDI instruments. In this mode, everything you play during recording will be “echoed” back out again on the MIDI output and channel selected for the recording track.

1. Make sure that the “MIDI Thru Active” option is activated in the Preferences dialog (MIDI page).

2. Record enable the tracks on which you want to record.

Now, incoming MIDI is “echoed” back out again for all record-enabled MIDI tracks.

If you just want to use the Thru function for a MIDI track without recording, activate the monitor button for the track instead. This is useful, for instance, if you want to try out different sounds or play a VST instrument in realtime without recording your playing.

### Setting MIDI channel, input, and output

#### Setting the MIDI channel in the instrument

Most MIDI synthesizers can play several sounds at the same time, each on a different MIDI channel. This is the key to playing back several sounds (bass, piano, etc.) from the same instrument. Some devices (such as General MIDI compatible sound modules) always receive on all 16 MIDI channels. If you have such an instrument, there is no specific setting you need to make in the instrument. On other instruments, you will have to use the front panel controls to set up a number of “Parts”, “Timbres” or similar so that they receive on one MIDI channel each. See the manual that came with your instrument for more information.
Naming MIDI ports in Cubase

MIDI inputs and outputs are often displayed with unnecessarily long and complicated names. However, you can rename your MIDI ports to more descriptive names:

1. Open the Device Setup dialog from the Devices menu.
2. Select the MIDI Port Setup item in the Device list. The available MIDI inputs and outputs are listed. Under Windows, which device to choose depends on your system.
3. To change the name of a MIDI port, click in the “Show As” column and type in a new name. After closing the dialog, the new name will appear on the MIDI Input and Output Routing pop-up menus.

Setting the MIDI input in the Inspector

You select MIDI inputs for tracks in the Inspector (the area to the left of the track list in the Project window):

1. Select the track by clicking in the track list. To select multiple tracks, press [Shift] or [Ctrl]/[Command] and click. The Inspector shows the settings for the first selected track (for details, see “The Inspector” on page 39).
2. Click the track name in the Inspector to make sure that the topmost section is shown.
3. Pull down the Input Routing pop-up menu and select an input. The available MIDI inputs are shown. The items on the menu depend on the type of MIDI interface you are using.
   - If you select the “All MIDI Inputs” option, the track will receive MIDI data from all available MIDI inputs.
   - If you hold down [Shift]-[Alt]/[Option] and select a MIDI input, this will be used for all selected MIDI tracks.

Setting the MIDI channel and output

The MIDI channel and output settings determine where the recorded MIDI is routed during playback, but are also relevant for MIDI Thru in Cubase. Channel and output can be selected in the track list or in the Inspector. The procedure below describes how to make the settings in the Inspector, but it can be done in largely the same manner in the track list as well.

1. To select the tracks and show the settings in the Inspector, proceed as when selecting a MIDI input (see above).
2. Pull down the Output Routing pop-up menu and select an output. The available MIDI outputs are shown. The items on the menu depend on what type of MIDI interface you are using.
   - If you hold down [Shift]-[Alt]/[Option] and select a MIDI output, this is selected for all selected MIDI tracks.
3. Use the Channel pop-up menu to select a MIDI channel for the track.
   - If you set the track to MIDI channel “Any”, each MIDI event on the track will be sent out on the channel stored in the event itself. In other words, the MIDI material will be played back on the channels used by the MIDI input device (the MIDI instrument you play during recording).
Selecting a sound

You can select sounds from within Cubase by instructing the program to send Program Change and Bank Select messages to your MIDI device. This is done using the “Patch Selector” and “Bank Selector” fields in the Inspector or track list.

Program Change messages give access to 128 different program locations. If your MIDI instruments have more than 128 programs, Bank Select messages (set in the “Bank Selector” field) allow you to select different banks, each containing 128 programs.

- Bank Select messages are recognized differently by different MIDI instruments. The structure and numbering of banks and programs may also vary. Consult the documentation of your MIDI instruments for details.

- Note that it is also possible to select sounds by name. For descriptions of how to set this up, see the separate PDF document “MIDI Devices”.

Recording MIDI

You can record MIDI according to the basic recording methods (see "Basic recording methods" on page 90). When you finish recording, a part containing MIDI events is created in the Project window.

About overlap and the MIDI Record Mode

MIDI tracks are different from audio tracks when it comes to overlapping parts: All events in overlapping parts are always played back. If you record several parts in the same locations (or move parts so that they overlap), you will hear the events in all parts.

When recording overlapping parts, the result depends on the MIDI Record Mode setting on the Transport panel. To select a MIDI Record Mode, proceed as follows:

1. On the Transport panel, click the MIDI symbol in the lower left section.

2. Activate the desired option.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Parts</td>
<td>Existing parts that are overlapped by a new recording are kept. The new recording is saved as a new part.</td>
</tr>
<tr>
<td>Merge</td>
<td>Existing events in parts that are overlapped by a new recording are kept. The newly recorded events are added to the existing part.</td>
</tr>
<tr>
<td>Replace</td>
<td>Existing events in parts that are overlapped by a new recording are replaced.</td>
</tr>
</tbody>
</table>

The MIDI Cycle Record Modes

When you record MIDI in cycle mode, the result depends not only on the MIDI Record Mode, but also on which Cycle Record Mode is selected in the MIDI Cycle Record Mode section:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mix</td>
<td>For each completed lap, everything you record is added to what was previously recorded. This is useful for building up rhythm patterns. Record a hi-hat part on the first lap, the bass drum part on the second lap, etc.</td>
</tr>
</tbody>
</table>
To learn how to create a “perfect take” by combining the best parts from the different cycle laps after a stacked recording, see “Comping operations” on page 77.

About the Automatic MIDI Record Quantize function

If Auto Quantize is activated on the Transport panel (the “Auto Q” button), the notes you record are automatically quantized according to the current Quantize settings. For more information about quantizing, see “Quantizing MIDI and audio” on page 108.

Recording different types of MIDI messages

- **Continuous messages**
  Pitchbend, aftertouch, and controllers (like modulation wheel, sustain pedal, volume, etc.) are considered as MIDI continuous events (as opposed to the momentary key down and key up messages). If you move the pitchbend wheel on your synthesizer while recording, this movement is recorded together with the key (Note On and Note Off messages), just as you would expect. But the continuous messages can also be recorded after the notes have been recorded (or even before). They can also be recorded on their own tracks, separately from the notes to which they belong.

  Say, for instance, that you record one or several bass parts on track 2. If you now set another track, like track 55, to the same output and MIDI channel as track 2, you can make a separate recording of just pitchbends for the bass parts on track 55. This means that you activate recording as usual and only move the pitchbend wheel during the take. As long as the two tracks are set to the same output and MIDI channel, it will appear to the MIDI instrument as if the two recordings were made at the same time.

- **Program Change messages**
  Normally, when you switch from one program to another on your keyboard (or whatever you use to record), a number corresponding to that program is sent out via MIDI as a Program Change message. These can be recorded on the fly with the music, recorded afterwards on a separate track, or manually entered in the Key or List Editors.

- **System Exclusive messages**
  System Exclusive (SysEx) is a special type of MIDI message used to send data that only makes sense to a unit of a certain make and type. SysEx can be used to transmit a list of the numbers that make up the settings of one or more sounds in a synth. For details about viewing and editing SysEx messages, see the section “Working with SysEx messages” on page 407.

---

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overwrite</td>
<td>As soon as you play a MIDI note (or send any MIDI message), all MIDI you have recorded on previous laps is overwritten from that point. Make sure that you stop playing before the next lap begins – otherwise you will overwrite the entire take.</td>
</tr>
<tr>
<td>Keep Last</td>
<td>Each completed lap replaces the previously recorded lap. If you deactivate recording or press Stop before the cursor reaches the right locator, the previous take will be kept. If you do not play or input any MIDI during a lap, nothing happens (the previous take will be kept).</td>
</tr>
<tr>
<td>Stacked</td>
<td>Each recorded cycle lap is turned into a separate MIDI part and the track is divided into “lanes”, one for each cycle lap. The parts are stacked above each other, each on a different lane. All takes but the last one are muted.</td>
</tr>
<tr>
<td>Mix Stacked</td>
<td>Same as Stacked, but parts are not muted.</td>
</tr>
</tbody>
</table>

To learn how to create a “perfect take” by combining the best parts from the different cycle laps after a stacked recording, see “Comping operations” on page 77.

Notes
When you press and release a key on your synth or other MIDI keyboard, a Note On (key down) and a Note Off (key up) message are sent out. The MIDI note message also contains the information which MIDI channel was used. Normally, this information is overridden by the MIDI channel setting for the track, but if you set the track to MIDI channel “Any”, the notes will be played back on their original channels.
The Reset function

The Reset function on the MIDI menu sends out note-off messages and resets controllers on all MIDI channels. This is sometimes necessary if you experience hanging notes, constant vibrato, etc. when punching in and out on MIDI recordings with pitchbend or controller data.

There are two other options to perform a reset:
- Cubase can automatically perform a MIDI reset on stop. You can turn this function on or off in the Preferences dialog (MIDI page).
- Cubase can automatically insert a reset event at the end of a recorded part. Open the Preferences dialog (MIDI page) and activate the "Insert Reset Events after Record" option. The inserted Reset event will reset controller data such as Sustain, Aftertouch, Pitchbend, Modulation, Breath Control, etc. This is useful if a MIDI part is recorded and the Sustain pedal is still held after stopping recording. Usually, this would cause all following parts to be played with Sustain, as the Pedal Off command was not recorded. This can be prevented by activating "Insert Reset Events after Record".

Retrospective Record

This feature allows you to capture any MIDI notes you play in Stop mode or during playback and turn them into a MIDI part "after the fact". This is possible due to the fact that Cubase can capture MIDI input in buffer memory, even when not recording.

Proceed as follows:

1. Enable the Retrospective Record option in the Preferences dialog (Record–MIDI page). This activates the buffering of MIDI input, making Retrospective Record possible.
2. Make sure a MIDI track is record-enabled.
3. When you have played some MIDI material you want to capture (either in Stop mode or during playback), select Retrospective Record from the Transport menu (or use the key command, by default [Shift]-[Num[*]).

The content of the MIDI buffer (i.e. what you just played) is turned into a MIDI part on the record enabled track. The part will appear where the project cursor was when you started playing – this means that if you played along during playback, the captured notes will end up exactly where you played them in relation to the project.

- The Retrospective Record Buffer Size setting in the Preferences dialog (Record–MIDI page) determines how much data can be captured.

MIDI Preferences

There are several other options and settings in the Preferences that affect MIDI recording and playback:

MIDI page

- Length Adjustment
  Adjusts the length of notes so that there is always a short time between the end of one note and the start of another (of the same pitch and on the same MIDI channel). The time is set in ticks. By default there are 120 ticks per 1/16 note, but you can adjust this with the MIDI Display Resolution setting on the same page.

Record–MIDI page

- Snap MIDI Parts to Bars
  When this is activated, recorded MIDI parts will automatically be lengthened to start and end at whole bar positions. If you are working in a Bars+Beats-based context, this can make editing (moving, duplicating, repeating, etc.) easier.
- Solo Record in MIDI Editors
  If this is activated and you open a part for editing in a MIDI editor, its track is automatically record-enabled. Furthermore, Record Enable is deactivated for all other MIDI tracks until you close the editor again. This makes it easier to record MIDI data when you are editing a part – you will always be sure the recorded data ends up in the edited part and not on any other track.
- MIDI Record Catch Range in ms
  When you record starting at the left locator, this setting helps you make sure that the very start of the recording is included. A very annoying scenario is when you have recorded a perfect MIDI take, only to find out that the very first note was not included – because you started playing a little bit too early! If you raise the Record Catch Range, Cubase will catch the events played just before the recording start point, eliminating this problem.

For a description of the other options, click the Help button in the Preferences dialog.
Filtering MIDI

The MIDI–MIDI Filter page in the Preferences dialog allows you to prevent certain MIDI messages from being recorded and/or “thruput” (echoed by the MIDI Thru function).

The dialog is divided into four sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Activating any of these options prevents that type of MIDI message from being recorded. It can, however, be thruput, and if already recorded, it will play back normally.</td>
</tr>
<tr>
<td>Thru</td>
<td>Activating any of these options prevents that type of MIDI message from being thruput. It can, however, be recorded and played back normally.</td>
</tr>
<tr>
<td>Channels</td>
<td>If you activate a channel button, no MIDI messages on that MIDI channel will be recorded or thruput. Already recorded messages will, however, be played back normally.</td>
</tr>
<tr>
<td>Controller</td>
<td>Allows you to prevent certain MIDI controller types from being recorded or thruput. To filter out a controller type, select it from the list at the top of the Controller section and click “Add”. It will appear on the list below. To remove a controller type from the list (allow it to be recorded and thruput), select it in the lower list and click “Remove”.</td>
</tr>
</tbody>
</table>

Options and Settings

Recording-related Transport Preferences

A couple of settings in the Preferences dialog (Transport page) are relevant for recording. Set these according to your preferred method of work:

Deactivate Punch In on Stop

If this is activated, punch in on the Transport panel is automatically deactivated whenever you enter Stop mode.

Stop after Automatic Punch Out

If this is activated, playback will automatically stop after automatic punch out (when the project cursor reaches the right locator and punch out is activated on the Transport panel). If the post-roll value on the Transport panel is set to a value other than zero, playback will continue for the set time before stopping (see below).

About Pre-roll and Post-roll

The pre-roll and post-roll value fields (below the left/right locator fields) on the Transport panel have the following functionality:

- By setting a pre-roll value, you instruct Cubase to “roll back” a short section whenever playback is activated. This applies whenever you start playback, but is perhaps most relevant when recording from the left locator (punch in activated on the Transport panel) as described below.
- By setting a post-roll value, you instruct Cubase to play back a short section after automatic punch out before stopping. This is only relevant when punch out is activated on the Transport panel and “Stop after Automatic Punch Out” is activated in the Preferences dialog (Transport page).
- To turn pre-roll or post-roll on or off, click the corresponding button on the Transport panel (next to the pre/post-roll value) or use the “Use Pre-roll” and “Use Post-roll” options on the Transport menu.
An example:
1. Set the locators to where you want to start and end recording.
2. Activate Punch in and Punch out on the Transport panel.
3. Activate the “Stop after Automatic Punch Out” option in the Preferences dialog (Transport page).
4. Set suitable pre-roll and post-roll times by clicking in the corresponding fields on the Transport panel and typing in time values.
5. Activate pre-roll and post-roll by clicking the buttons next to the pre-roll and post-roll times so that they light up.
6. Activate recording.
The project cursor “rolls back” by the time specified in the pre-roll field and playback starts. When the cursor reaches the left locator, recording is automatically activated. When the cursor reaches the right locator, recording is deactivated, but playback continues for the time set in the post-roll field before stopping.

Using the metronome

The metronome can output a click that can be used as a timing reference. The two parameters that govern the timing of the metronome are tempo and time signature, as set on the tempo track and signature track, or in the Tempo Track Editor (see “Editing the tempo curve” on page 465). The metronome can use either an audio click played back via the audio hardware, send MIDI data to a connected device which will play back the click or both.

You can also set up a precount (count-in) that will be heard when you start recording from Stop mode. This can be musical or time based.

- To activate the metronome click, activate the Click button on the Transport panel. You can also select the “Metronome On” option on the Transport menu or use the corresponding key command (by default [C]).
- To activate the precount, click the Precount button on the Transport panel. You can also select the “Precount On” option on the Transport menu or set up a key command for this.

Metronome settings

You make settings for the metronome in the Metronome Setup dialog, opened from the Transport menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metronome in Record/Play</td>
<td>Allows you to specify whether the metronome is heard during playback, recording or both (when Click is activated on the Transport panel).</td>
</tr>
</tbody>
</table>

The following precoun options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precount Bars</td>
<td>Sets the number of bars the metronome counts in before recording starts.</td>
</tr>
<tr>
<td>Use Project Count Base</td>
<td>If this option is activated, the metronome plays one click per beat according to the project count base.</td>
</tr>
<tr>
<td>Use Count Base</td>
<td>If this option is activated, a field appears to the right where you specify the “rhythm” of the metronome. For example, setting this to “1/8”, gives you eighth notes (two clicks per beat). It is also possible to create unusual metronome rhythms such as triplets.</td>
</tr>
<tr>
<td>Use Time Sign. at Rec. Start Time</td>
<td>When this is activated, the precount automatically uses the time signature and tempo set at the position where recording starts.</td>
</tr>
<tr>
<td>Use Time Sign. at Project Time</td>
<td>When this is activated, the precount uses the time signature set on the tempo track. Furthermore, any tempo changes on the tempo track during the precount are applied.</td>
</tr>
<tr>
<td>Use Signature</td>
<td>This lets you set a time signature for the precount. In this mode, tempo changes on the tempo track do not affect the precount.</td>
</tr>
</tbody>
</table>
Further configuration options for MIDI and audio clicks are available in the Click Outputs section:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate MIDI Click</td>
<td>Selects whether or not the metronome sounds via MIDI.</td>
</tr>
<tr>
<td>MIDI Port/Channel</td>
<td>This is where you select a MIDI output and channel for the metronome click.</td>
</tr>
<tr>
<td>Hi Note/Velocity</td>
<td>Sets the MIDI note number and velocity value for the “high note” (the first beat in a bar).</td>
</tr>
<tr>
<td>Lo Note/Velocity</td>
<td>Sets the MIDI note number and velocity for the “low notes” (the other beats).</td>
</tr>
<tr>
<td>Activate Audio Click</td>
<td>Selects whether or not the metronome sounds via the audio hardware.</td>
</tr>
<tr>
<td>Beeps</td>
<td>When this is selected, the audio clicks will be beeps generated by the program. Adjust the pitch and level of the beeps for the “Hi” (first) beat and “Lo” (other) beats using the sliders below.</td>
</tr>
<tr>
<td>Sounds</td>
<td>When this is selected, you can click in the “Sound” fields below to load any audio files for the “Hi” and “Lo” metronome sounds. The sliders set the level of the click.</td>
</tr>
</tbody>
</table>

Note that an automatic punch-out at the right locator position that you may have set on the transport panel, will be ignored in Lock Record mode.

**Record Time Max display**

The Record Time Max display lets you see how much time you have left for recording. The available time depends on the current setup, for example, on the amount of tracks that are record-enabled, your project setup (e.g. the sample rate), and the amount of hard disk space available.

You can show and hide the display using the “Record Time Max” option on the Devices menu.

* The remaining record time is also shown in the status line above the track list.

⚠️ If you are storing your tracks on different drives (by using individual record folders), the time display refers to the medium with the least storage space available.
Quantizing MIDI and audio
Introduction

What is quantizing?
Quantizing is a function that moves recorded audio or MIDI, positioning it on the nearest grid position that is musically relevant. Quantizing can be used to correct errors, or in a creative way.

In Cubase, you can quantize audio and MIDI to a grid (see “Options for quantizing to a musical grid” on page 113) or to a groove (see “Options for quantizing to a groove” on page 113). You can also quantize multiple audio tracks simultaneously while keeping their phase relation (see “Quantizing multiple audio tracks (Cubase only)” on page 114).

Audio and MIDI can be quantized at the same time. However, what exactly happens during quantizing differs for audio and MIDI:

- Audio quantizing affects the audio event starts (see “Audio – quantizing audio event starts” on page 110), or the content of your audio (see “Audio Warp Quantize” on page 110).

- MIDI quantizing can affect the starts of MIDI events in a part (see “MIDI – quantizing MIDI event starts” on page 110), the MIDI event lengths (see “Quantize MIDI Event Lengths” on page 110), or the MIDI event ends (see “Quantize MIDI Event Ends” on page 111).

When you apply quantizing, the result is based on the original position of the events. Therefore, you can freely try out different quantize settings without the risk of “destroying” anything.

Where are the quantize functions located?

Quantize functions on the Edit menu

To apply the quantize function, you can either open the Edit menu and select Quantize, or use the default key command [Q].

To apply one of the advanced quantizing functions, open the Edit menu and select the desired function on the Advanced Quantize submenu.

Quantize functions on the toolbar

The Quantize section on the Project window toolbar provides the following parameters:

- The "Q" button
  If you click the "Q" button, it toggles to "iQ". This changes the mode from default to iterative quantize (see “iQ option and Iterative Strength setting” on page 112).

- The Quantize Presets pop-up menu
  On this pop-up menu, you can select a preset for quantizing (see “Quantize Presets pop-up menu” on page 111).

- The “Open Quantize Panel” button
  By clicking on this button you can open the Quantize Panel (see “The Quantize Panel” on page 111).
Quantize functions on the Quantize Panel

The Quantize Panel provides different settings and parameters (see “The Quantize Panel” on page 111). You can open it by clicking on the corresponding button on the toolbar or by opening the Edit menu and selecting “Quantize Panel”.

Quantize functions on the Transport panel (MIDI only)

On the Transport panel, you can activate the Auto Q button. The Auto Q function quantizes MIDI automatically on recording, according to the settings on the Quantize Panel.

Quantize functions in the key commands

In the Key Commands dialog (Quantize Category), you can set up key commands for the quantize functions. For further information about key commands, see “Key commands” on page 541.

Quantize functions

Quantize

The Quantize function is found on the Edit menu. You can also use the key command [Q] or the “Quantize” button on the Quantize Panel. What exactly happens when you use the Quantize function depends on whether you apply it to audio or MIDI.

Audio – quantizing audio event starts

If you select one or several audio events or a sliced loop and use the Quantize function, the audio event starts are quantized.

The event snap points (or, if no snap point is available, the event start) that ended up slightly beside exact note positions are moved to the nearest position of the grid. The grid is set up in the Quantize pop-up menu.

MIDI – quantizing MIDI event starts

If you select several MIDI notes in a part and use the Quantize function on the Edit menu, the MIDI note starts are quantized, i.e. The starts of MIDI notes that ended up slightly beside exact note positions are moved to the nearest position of the grid. The grid is set up in the Quantize pop-up menu. The note lengths are maintained.

Reset Quantize

This command on the Edit menu reverts your audio or MIDI to its original, unquantized state. This function is independent from the regular Undo History.

Advanced Quantize functions

Audio Warp Quantize

The “Audio Warp Quantize” function on the Edit menu, Advanced submenu, quantizes the content of your audio event by applying time stretch. The following happens:

- If you have already set up hitpoints, these will be taken. Otherwise, hitpoints are detected automatically. For further information on hitpoints, see “Working with hitpoints and slices” on page 276.
- For each hitpoint, a warp tab is created. For further information on hitpoints, see “Warping audio” on page 272.
- The warp tabs that are located close to a beat or bar position are matched with the nearest grid positions as set up on the Quantize pop-up menu. This stretches your audio. The audio event gets a warp tab at the event start and one at the event end. These warp tabs are also aligned to the nearest position in the grid.

Quantize MIDI Event Lengths

The “Quantize MIDI Event Lengths” function on the Edit menu, Advanced Quantize submenu, quantizes the length of MIDI notes without changing their start positions. At its most basic level, this function sets the length of the notes to the Length Quantize value on the MIDI editor toolbar by cutting their ends.
However, if you have selected the “Quantize Link” option on the Length Quantize pop-up menu, the function resizes the notes according to the quantize grid, taking the Swing, Tuplet, and Catch Range settings into account.

**Quantize MIDI Event Ends**

The “Quantize MIDI Event Ends” function on the Edit menu, Advanced Quantize submenu, moves the ends of your MIDI notes to the nearest grid positions, taking the Quantize pop-up menu setting into account.

**Freeze MIDI Quantize**

The Freeze MIDI Quantize function on the Edit menu, Advanced Quantize submenu, makes the start and end positions of MIDI events permanent. This is useful in situations where you want to quantize a second time, based on the current quantized positions rather than the original positions.

**Create Groove Quantize Preset**

This lets you create a groove quantize preset from a MIDI part, a sliced audio part, or an audio event containing hitpoints.

To extract the timing, i.e. generate a groove quantize map based on hitpoints that you have created in the Sample Editor, proceed as follows:

1. Open the Sample Editor for the audio event from which you want to extract the timing.
2. Create and edit hitpoints.

For further information, see “Working with hitpoints and slices” on page 276.

3. On the Hitpoints tab in the Sample Editor, click the “Create Groove” button.

The groove is extracted.

If you open the Quantize pop-up menu on the Project window toolbar, you will find an additional item at the bottom of the list, with the same name as the file from which you have extracted the groove. You can select it as a base for quantizing, just like any other quantize value.

4. To save the groove, open the Quantize Panel and store it as a preset, see “Save/Remove Preset” on page 111.

### The Quantize Panel

You can open the Quantize Panel by clicking on the corresponding button on the toolbar or by opening the Edit menu and selecting “Quantize Panel”.

Using the Quantize Panel, you can quantize audio or MIDI to the grid or to a groove. Depending on what method you choose, different parameters are shown on the Quantize Panel. However, there is also a set of common settings.

#### Common settings

**Quantize Presets pop-up menu**

On this pop-up menu, you can select a quantize or a groove preset.

**Save/Remove Preset**

The preset controls allow you to store the current settings as a preset, making them available on all Quantize Presets pop-up menus. To save a preset, proceed as follows:

1. Set up the quantize parameters as desired. This includes Swing, Catch Range, etc.
2. Click the Save Preset button (the plus sign) to the right of the Quantize Presets pop-up menu. A preset name is generated automatically, according to your settings.

- If you want to rename the preset, open the Quantize Presets pop-up menu, select “Rename Preset” and enter the desired name in the dialog that appears.
- To remove a user preset, select it and click the “Remove Preset” button.

**Non-Quantize**

This setting allows you to set a “distance” in ticks (120 ticks correspond to one 16th note), so that events that are within the specified distance from the nearest quantize grid position are not quantized. This allows you to keep slight variations when you quantize, but still correct notes that are too far away from the grid.
Grid display

In the middle of the Quantize Panel the grid display is shown. The green lines indicate the quantize grid, i.e. the positions that audio or MIDI is moved to.

Randomize

This setting allows you to set a “distance” in ticks (120 ticks correspond to one 16th note), so that your audio or MIDI is quantized to random positions within the specified distance from the quantize grid. This creates a loose quantizing and allows for slight variations. At the same time, it prevents your audio or MIDI from ending up too far away from the grid.

Move MIDI CC

If this is activated, controllers related to MIDI notes (pitch-bend, etc.) are automatically moved with the notes when these are quantized.

Auto Apply

If you activate this option, any changes you make are immediately applied to the selected parts or events. A way of using this feature is to set up a playback loop and adjust the settings until you get the desired result.

iQ option and Iterative Strength setting

If you quantize your audio or MIDI with the iQ option activated, a “loose” quantization is applied. This means that your audio or MIDI moves only part of the way to the closest quantize grid position. You can specify an Iterative Strength value to the right of the iQ option. This lets you specify how close your audio or MIDI moves towards the grid.

Iterative quantizing is based on the current, quantized positions and not on the original event positions. This makes it possible to repeatedly use Iterative Quantize, gradually moving your audio or MIDI closer to the quantize grid until you have found the desired timing.

Reset Quantize

This button is identical with the Reset Quantize function on the Edit menu (see "Reset Quantize" on page 110).

⚠️ If you move an audio event manually, the original start time is changed to the new position. Therefore, the Reset Quantize function has no effect on an event that has been moved manually.

Quantize

Clicking this button applies your settings.
Options for quantizing to a musical grid
Quantizing to a grid is useful if you want to place your recorded audio or MIDI on the nearest position that is musically relevant.

Grid
On this pop-up menu you can determine the basic value for the quantize grid.

Swing
This parameter lets you offset every second position in the grid, creating a swing or shuffle feel. When you adjust the Swing parameter, the result is shown in the grid display.

This setting is only available when a straight value is selected for the grid and Tuplet is off (see below).

Catch Range
This parameter allows you to specify that only audio or MIDI within a certain distance from the grid lines is affected by quantizing. This allows for complex quantization tasks, e.g. quantizing only the heavy beats near each beat, and not the events in-between.

With a value of 0%, all audio or MIDI is affected by quantizing. With higher percentages, wider Catch Ranges are shown around the green lines in the grid display and only the events within a Catch Range are quantized.

Tuplet
This parameter allows you to create rhythmically more complex grids by dividing the grid into smaller steps.

Options for quantizing to a groove
Groove quantizing is intended for creating certain rhythmic feels by matching your recorded music to a timing grid generated from a MIDI part or an audio loop.

To extract the groove from a MIDI part, from an audio loop, an audio event with hitpoints, or sliced audio, select the desired material and drag it onto the grid display in the middle of the Quantize Panel. Alternatively, you can use the “Create Groove Quantize Preset” function (see “Create Groove Quantize Preset” on page 111).

Position
This parameter lets you determine how much the timing of the groove affects the music (expressed as a percentage). 0% means that the timing of the music remains unaffected, while 100% means that the timing is adjusted to match the groove completely.

Velocity (MIDI only)
This parameter lets you determine how much the velocity values within the groove affect the music. Note that not all grooves contain velocity information.
Length (MIDI only)
Use this parameter to specify how much the length of the notes is affected by the groove. This is done by modifying the note-off value.

⇒ For drums, the Length setting will be ignored as drum sounds cannot be sustained.

Pre-Quantize
This pop-up menu lets you quantize your audio or MIDI to a musical grid before groove quantizing. This helps you to get the notes closer to their groove destination.

For example, if you apply a shuffle groove to a 16th note pattern, you can try to set up a Pre-Quantize value of 16 to "straighten up" the timing before applying the groove quantizing.

Max. Move
Here, you can specify a note value that defines the maximum distance by which your audio or MIDI is moved within the quantize grid. This prevents you from moving material that you do not want to move.

Orig. Position
If you activate this option, the selected audio or MIDI reverts to its original position on the grid when quantizing.

Quantizing multiple audio tracks (Cubase only)
You can quantize multiple audio tracks at the same time. However, to maintain phase accuracy, all tracks have to be sliced at exactly the same start and end positions. Only then the resulting slices can be quantized without risk of getting phase errors.

Multi-track quantization comprises the following steps:
• Creating edit groups and calculating hitpoints (preparations)
• Creating slices
• Setting up quantize options
• Crossfading

These steps are described in the following paragraphs.

Preparations
To prepare your audio tracks for quantization, proceed as follows:

1. Place the audio tracks that you want to quantize simultaneously in a folder track.
   For further information on folder tracks, see "Organizing tracks in folder tracks" on page 79.

2. Activate the “=” button for Group Editing for the folder track.
   When you select one event, all other events belonging to the edit group are also selected. This ensures that all edits are performed on all audio tracks inside the edit group, see "About Group Editing (Cubase only)" on page 80.

3. Open the Sample Editor and calculate hitpoints for at least one of the audio tracks in the group.
   Calculating hitpoints for the "main" track that provides the characteristic groove (e.g. kick, snare, hihat) will suffice. For further information on calculating hitpoints, see "The Sample Editor" on page 261.

4. Open the Quantize Panel.
If you open the Quantize Panel for an edit group and at least one of the tracks has hitpoints, the “Slice Rules” section appears.

The section “Slice Rules”
In this section you determine how the audio events are sliced at the hitpoints.

Hitpoint Tracks
In this column, all audio tracks of your edit group that have hitpoints are displayed.

Priority
In this column, you define a priority for each track. This specifies which hitpoints are used to slice your audio events.

- Click on the stars and drag the mouse to the right or to the left to specify a priority.
  - If you drag the mouse to the far left so that no star is shown, the corresponding track has no priority and will not be considered for slicing.
  - The track with the highest priority will define where the audio is sliced, i.e., the audio on all tracks will be sliced at all hitpoints of this track.
  - If you set up the same priority for several tracks, the cutting position is defined by the track, with the first hitpoint within the range defined by the Range parameter (see below). This will be decided for each cutting position anew.

If the zoom factor is high enough, cutting positions are marked in the Project window by vertical lines:

- The red lines indicate the cutting position on the main track, i.e. on the track whose hitpoint defines the cutting position.
- The black lines indicate the cutting position on all other tracks.

Range
With this parameter, you can set the minimum distance between two hitpoints on different tracks. Hitpoints that are located within this range are considered as marking the same beat, according to the following rules:

- One of the tracks has a higher priority, its hitpoint will be used as cutting position.
- The tracks have the same priority, the first hitpoint in the range will be used.

Offset
With this parameter, you can determine an offset, allowing for slight variations of the cutting position. The Offset value determines how far before the actual hitpoint position an audio event is sliced. This is useful if you want to create crossfades at the slice positions (see “The Crossfades section” on page 116). Furthermore, it helps to avoid cutting off signals on tracks that do not contain any hitpoints.

Slice
If you click the Slice button all audio events of the edit group are sliced at exactly the same positions according to your settings. The event snap points are set to the position of the hitpoint with the highest priority.

The original start time will be attached to the resulting audio events. If you move an audio event manually, the origin start time is reset to the new position (like MIDI) and functions like Undo Quantize have no longer effect on such events.

Reset
This undoes the slicing and restores the original state of the audio events.
The Quantize section

After having sliced your audio events, you can proceed with setting up the quantize parameters, see “Options for quantizing to a musical grid” on page 113 or “Options for quantizing to a groove” on page 113.

Quantize

Click this button to apply your settings and quantize your audio.

The Crossfades section

The Crossfades section only appears after you have sliced your audio. The functions in this section are designed to correct the overlaps or the gaps that might appear due to the re-positioning of your audio after using the Quantize function.

Crossfade

Clicking this button cuts the end of the first event at the start position of the following event (in case of overlaps), and stretches the second event until it starts at the end of the previous event (in case of gaps).

Making crossfade settings

In some cases, you might want to achieve seamless transitions, i.e. apply crossfades after closing the gaps. For this purpose, use the following parameters:

- Open Crossfade Editor
  This opens the Crossfade editor, where you can specify curve kind, length, and other parameters for your crossfades, see “The Crossfade dialog” on page 121.

- Length
  With this parameter you can specify the length of the crossfade area.

- Nudge Crossfade Left/Right
  Clicking these buttons moves the fade area in the audio event to the left or to the right in steps of one millisecond. This is useful if the Offset value in the section “Slice Rules” was not high enough, and you want to avoid that the crossfade cuts an attack.
Fades, crossfades and envelopes
Creating fades

There are two types of fade ins and fade outs in audio events in Cubase: event-based fades that you create by using the fade handles and clip-based fades created by processing (see “Clip-based fades” on page 119).

Event-based fades

Selected audio events have triangular handles in the upper left and right corners. These can be dragged to create a fade in or fade out, respectively.

Creating a fade in. The fade is automatically reflected in the shape of the event’s waveform, giving you a visual feedback of the result when dragging the fade handle.

Fades created with the handles are not applied to the audio clip as such but calculated in realtime during playback. This means that several events referring to the same audio clip can have different fade curves. It also means that having a large number of fades may require more processing power.

- If you select multiple events and drag the fade handles of one of them, the same fade is applied to all selected events.
- A fade can be edited in the Fade dialog, as described on the following pages.
- You open the dialog by double-clicking in the area above the fade curve, or by selecting the event and selecting “Open Fade Editor(s)” from the Audio menu (note that this will open two dialogs if the event has both fade in and fade out curves).
- If you adjust the shape of the fade curve in the Fade dialog, this shape will be maintained when you later adjust the length of the fade.
- You can make the fade longer or shorter at any time, by dragging the handle.
- If the “Show Event Volume Curves Always” option is activated in the Preferences dialog (Event Display–Audio page), fade curves are shown in all events, regardless of whether they are selected or not.
- If the option is deactivated, the fade curves are shown in selected events only.
- If the “Use Mouse Wheel for Event volume and Fades” option is activated in the Preferences dialog (Editing–Audio page), pressing [Shift] while moving the mouse wheel moves the volume curve up or down.
- In the Key Commands dialog (Audio category) you can set up key commands for changing the event volume curve and any fade curves, see “Key commands” on page 541.
- Cubase only: As an alternative to dragging the fade handles, you can use the “Fade In to Cursor” and “Fade Out to Cursor” options on the Audio menu to create fades. Position the project cursor on an audio event where you want a fade in to end or a fade out to begin, and select the appropriate option from the Audio menu. A fade will then be created, ranging from the event’s start or end to the position of the cursor.

Creating and adjusting fades with the Range Selection tool

Event-based fades can also be created and adjusted with the Range Selection tool.

Proceed as follows:

1. Select a section of the audio event with the Range Selection tool.
2. Pull down the Audio menu and select “Adjust Fades to Range”.

The result depends on your selection:

- If you select a range from the beginning of the event, a fade in is created within the range.
- If you select a range that reaches the end of an event, a fade out is created in the range.
• If you select a range encompassing a middle section of the event, but not reaching neither the start nor the end, a fade in is created from the beginning of the event to the beginning of the selected range, and a fade out is created from the end of the selected range to the end of the event.

⚠️ You can select multiple audio events on separate tracks with the Range Selection tool, and apply the fade to all of them simultaneously.

**About the volume handle**

A selected audio event also has a square handle in the top middle: the volume handle. It provides a quick way of changing the volume of an event in the Project window. Note that dragging the volume handle also changes the value on the info line.

The volume change is displayed numerically on the info line.

Drag the Volume handle up or down to change the volume of the event.

The event waveform reflects the volume change.

**Removing fades**

To remove the fades for an event, select the event and select “Remove Fades” from the Audio menu.

If you want to remove the fades in a specific range only, select the fade area with the Range Selection tool and select “Remove Fades” from the Audio menu.

**Clip-based fades**

If you have selected an audio event or a section of an audio event (using the Range Selection tool), you can apply a fade in or fade out to the selection by using the “Fade In” or “Fade Out” function on the Process submenu of the Audio menu. These functions open the corresponding Fade dialog, allowing you to specify a fade curve. Fades created this way are applied to the audio clip rather than to the event.

⚠️ The length of the fade area is determined by your selection. In other words, you specify the length of the fade before you open the Fade dialog. You can select multiple events and apply the same processing to all of them simultaneously.

• If you later create new events that refer to the same clip, these will have the same fades.
• You can remove or modify the fades at any time using the Offline Process History (see “The Offline Process History dialog” on page 254).

If other events refer to the same audio clip, you will be asked whether you want the processing to be applied to these events or not.

• Continue will apply the processing to all events that refer to the audio clip.
• New Version will create a separate, new version of the audio clip for the selected event.
• You can also activate the “Please, don’t ask again” option. Regardless of whether you then choose “Continue” or “New Version”, any further processing will conform to the option you select.

You can change this setting at any time in the Preferences dialog (Editing–Audio page), under “On Processing Shared Clips”.

---

Fades, crossfades and envelopes
The Fade dialogs

The Fade dialogs appear when you edit an existing fade or use the Fade In/Fade Out functions on the Process submenu of the Audio menu. The picture below shows the Fade In dialog; the Fade Out dialog has identical settings and features.

If you open the Fade dialog(s) with several events selected, you can adjust the fade curves for all these events at the same time. This is useful if you want to apply the same type of fade in to more than one event, etc.

The available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curve Kind</td>
<td>These buttons determine whether the fade curve consists of spline curve segments (left button), damped spline segments (middle button), or linear segments (right button).</td>
</tr>
<tr>
<td>Fade display</td>
<td>This shows the shape of the fade curve. The resulting waveform shape is shown in dark gray, with the current waveform shape in light gray. Click on the curve to add points, and click and drag existing points to change the shape. To remove a point from the curve, drag it outside the display.</td>
</tr>
<tr>
<td>Curve shape</td>
<td>These buttons give you quick access to some common curve shapes.</td>
</tr>
<tr>
<td>Restore button</td>
<td>This button is only available when editing fades made by dragging the fade handles. Click this to cancel any changes you have made since opening the dialog.</td>
</tr>
<tr>
<td>Fade Length Value</td>
<td>This parameter is only available when editing fades made by dragging the fade handles. It can be used to enter fade lengths numerically. The format of values displayed here is determined by the Time Display in the Transport panel. When you activate the Apply Length option, the value entered in the Fade Length value field is used when clicking Apply or OK. When you set the current fade as the default fade, the length value is included as part of the default settings.</td>
</tr>
</tbody>
</table>

Applying a fade

Depending on whether you are editing a fade made with the fade handles or applying a fade using processing, different buttons are shown in the bottom row of the Fade dialog.

The Edit Fade dialogs have the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Applies the set fade curve to the event, and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog without applying any fade.</td>
</tr>
<tr>
<td>Apply</td>
<td>Applies the set fade curve to the event, without closing the dialog.</td>
</tr>
</tbody>
</table>

The Process Fade dialogs have the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Plays back the fade area. Playback will repeat until you click the button again (the button is labeled “Stop” during playback).</td>
</tr>
<tr>
<td>Process</td>
<td>Applies the set fade curve to the clip, and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog without applying any fade.</td>
</tr>
</tbody>
</table>
Creating crossfades

Overlapping audio material on the same track can be crossfaded, for smooth transitions or special effects. You create a crossfade by selecting two consecutive audio events and selecting the Crossfade command on the Audio menu (or by using the corresponding key command, by default \(X\)). The result depends on whether the two events overlap or not:

- If the events overlap, a crossfade is created in the overlapping area. The crossfade will be of the default shape (linear, symmetric), but you can change this as described below.

- The default crossfade length and shape are set in the Crossfade dialog (see “The Crossfade dialog” on page 121).

- If the events do not overlap but are directly consecutive (lined up end-to-start, with no gap) it is still possible to crossfade them — provided that their respective audio clips overlap! In this case, the two events are resized so that they overlap, and a crossfade of the default length and shape is applied.

- If the events do not overlap and cannot be resized enough to overlap, a crossfade cannot be created.

- You can specify the length of the crossfade using the Range Selection tool: make a selection range covering the desired crossfade area and use the Crossfade command on the Audio menu. The crossfade is applied to the selected range (provided that the events or their clips overlap, as described above).

- You can also make a selection range after creating the crossfade and use the function “Adjust fades to Range” on the Audio menu.

- Once you have created a crossfade, you can edit it by selecting one or both crossfaded events, and selecting “Crossfade” from the Audio menu again (or by double-clicking in the crossfade zone). This opens the Crossfade dialog.

Removing crossfades

To remove a crossfade, proceed as follows:

- Select the corresponding events and select “Remove Fades” from the Audio menu.

- Use the Range Selection tool to select all fades and crossfades you wish to remove, and select “Remove Fades” from the Audio menu.

- Select a crossfade by clicking, and drag it outside the track.

The Crossfade dialog

Options and settings

The Crossfade dialog contains separate, but identical, sections for the fade-in and fade-out curve settings in the crossfade on the left, and common settings on the right:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fade curve</td>
<td>These displays show the shape of the fade out and fade in curve, respectively. Click on a curve to add points, click and drag existing points to change their shape, or drag a point outside the display to remove it.</td>
</tr>
<tr>
<td>Curve buttons</td>
<td>The curve kind buttons determine whether the corresponding fade curve consists of spline curve segments (left button), damped spline segments (middle button) or linear segments (right button). The curve shape buttons give you quick access to some common curve shapes.</td>
</tr>
</tbody>
</table>
Auto fades and crossfades

Cubase features an Auto Fade function that can be set both globally, and separately for each audio track. The idea behind the Auto Fade function is to create smoother transitions between events by applying short (1–500 ms) fade ins and fade outs.

⚠️ As event-based fades are calculated in realtime during playback, a higher number of audio events provokes to a higher the demand on the processor when Auto Fades is activated.

Making global Auto Fade settings

1. To make Auto Fades settings globally for a project, select “Auto Fades Settings…” from the Project menu. This opens the Auto Fades dialog for the project.

2. Use the Length value field to specify the length of the Auto Fades or Crossfades (1–500 ms).

3. Use the checkboxes in the upper right corner to activate or deactivate Auto Fade In, Auto Fade Out, and Auto Crossfades.

4. To adjust the shapes of Auto Fade In and Auto Fade Out, select the Fades tab and make settings as in the regular Fade dialogs (see “The Fade dialogs” on page 120).

---

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal Gain</td>
<td>Activate this parameter to adjust the fade curves so that the summed fade in and fade out amplitudes will be the same all along the crossfade region. This is often suitable for short crossfades.</td>
</tr>
<tr>
<td>Equal Power</td>
<td>Activate this parameter to adjust the fade curves so that the energy (power) of the crossfade will be constant all along the crossfade region. Equal Power curves have only one editable curve point. You cannot use the Curve kind buttons or the presets when this mode is selected.</td>
</tr>
<tr>
<td>Play buttons</td>
<td>These buttons allow you to audition the whole crossfade, or the fade out part, or the fade in part. You can set up key commands for this in the following categories of the Key Commands dialog: Media category – Preview Start (triggers crossfade playback), Preview Stop (stops crossfade playback), Transport category – StartStop (triggers playback), Stop (stops global playback) and StartStop Preview (triggers crossfade playback). For further information, see “Key commands” on page 541.</td>
</tr>
<tr>
<td>Pre-roll and Post-roll</td>
<td>Activate pre-roll to start playback before the fade area. Activate post-roll to stop playback after the fade area. In the time fields you can enter the desired time (in seconds and milliseconds) for the pre-roll and post-roll length.</td>
</tr>
<tr>
<td>Length</td>
<td>This specifies the length of the crossfade area. Cubase tries to center the crossfade, i.e. the length change will be applied equally to both sides. To be able to resize a crossfade, it must be possible to resize the corresponding event. For example, if the fade out event already plays its audio clip to the end, its end point cannot be moved any further to the right.</td>
</tr>
<tr>
<td>Presets section</td>
<td>Click the Store button to the right of the Presets pop-up menu to store the settings of your crossfade so that you can apply them to other events later. To rename a preset, double-click on the name and type in a new one. To remove a preset, select it on the pop-up menu and click the Delete button.</td>
</tr>
<tr>
<td>Default buttons</td>
<td>Click the As Default button to store the current settings as default. These settings will then be used whenever you create new crossfades. Click the Recall Default button to apply the curves and settings of the default crossfade to the Crossfade dialog.</td>
</tr>
</tbody>
</table>
5. To adjust the shape of the Auto Crossfade, select the “Crossfades” tab and make settings as in the regular Crossfade dialog (see “The Crossfade dialog” on page 121).

6. If you want to use your settings in future projects, click the “As Default” button.

7. Click OK to close the dialog.

**Making Auto Fade settings for individual tracks**

By default, all audio tracks will use the settings you have made in the project’s Auto Fades dialog. However, since Auto Fades use computing power, a better approach may be to turn Auto Fades off globally and activate them for individual tracks, as needed:

1. Right-click the track in the track list and select “Auto Fades Settings…” from the context menu (or select the track and click the “Auto Fades Settings” button in the Inspector).

   The Auto Fades dialog for the track opens. This is identical to the project’s Auto Fades dialog, with the addition of a “Use Project Settings” option.

2. Deactivate the “Use Project Settings” option.

   Any settings you now make are applied to the track only.

3. Set up the Auto Fades as desired and close the dialog.

**Reverting to project settings**

If you want a track with individual Auto Fade settings to use the global Auto Fade settings, open the Auto Fades dialog for the track and activate the “Use Project Settings” checkbox.

---

**Event envelopes**

An envelope is a volume curve for an audio event. It is similar to the realtime fades, but allows you to create volume changes within the event, not only at the start or end.

To create an envelope for an audio event, proceed as follows:

1. Zoom in on the event so that you can view its waveform properly.

2. Select the Pencil tool.

   When you move the Pencil tool over an audio event, a small volume curve symbol is shown next to the tool.

3. To add an envelope point, click in the event with the Pencil tool.

   An envelope curve and a curve point appear.

4. Drag the curve point to adjust the envelope shape.

   The waveform image reflects the volume curve.

   • You can add as many curve points as you like.

   • To remove a curve point from the envelope, click on it and drag it outside the event.

   • The envelope curve is a part of the audio event – it will follow when you move or copy the event.

     After copying an event with an envelope, you can make independent adjustments to the envelopes in the original event and the copy.

     • It is also possible to apply an envelope to the audio clip using the Envelope function on the Process submenu of the Audio menu (see “Envelope” on page 246).

     • To remove an event envelope curve from a selected event, open the Audio menu and select the Remove Volume Curve option.
11

The arranger track
**Introduction**

The arranger track allows you to work with sections of your project in a non-linear fashion, to simplify arranging to the maximum extent. Instead of moving, copying and pasting events in the Project window to create a linear project, you can define how different sections are to be played back, like a playlist.

For this, you can define arranger events, order them in a list, and add repeats as desired. This offers a different and more pattern-oriented way of working, which complements the usual linear editing methods in the Project window.

You can create several arranger chains, making it possible to store different versions of a song within the project without sacrificing the original version. When you have created an arranger chain that you like, you have the option of “flattening” the list, which creates a normal linear project based on the arranger chain.

You can also use the arranger track for live performances on the stage, in clubs or at parties.

**Setting up the arranger track**

Let’s say you have prepared a number of audio files that form the base of a typical pop song, with introduction, verse, chorus and bridge. Now you want to arrange these files.

The first step is to create an arranger track. On the arranger track, you define specific sections of the project by creating arranger events. These can be of any length, may overlap and are not bound to the start or end of existing events and parts. Proceed as follows:

1. Open the project for which you want to create arranger events.

2. Open the Project menu and select Arranger from the Add Track submenu (or right-click the track list and select the corresponding option from the context menu).
   An arranger track is added. There can be only one arranger track in a project, but you can set up more than one arranger chain for this track, see “Managing arranger chains” on page 127.

3. On the Project window toolbar, make sure that Snap is activated and that the Snap Type is set to a mode that allows your arranger events to snap to appropriate positions in the project.

   Snap to events is activated, i.e. when drawing in the Project window, new events will snap to existing events.

4. On the arranger track, use the Pencil tool to draw an event of the desired length. An arranger event is added, called “A” by default. Any following events will be named in alphabetical order.

   • You can rename an arranger event by selecting it and changing its name in the Project window info line or by holding down [Alt]/[Option], double-clicking on the name in the arranger chain (see below) and entering a new name.

   You may want to name your arranger events according to the structure of your project, e.g. Verse, Chorus, etc.

5. Create as many events as you need for your project.

   When arranger events have been created, the music sequence is determined by the arranger events.

Events can be moved, resized and deleted using the standard techniques. Please note:

   • If you want to change the length of an event, select the Arrow tool and click and drag the lower corners of the event in the desired direction.

   • If you copy an arranger event (by [Alt]/[Option]-dragging or by using copy/paste), a new event will be created with the same name as the original.

   However, this new event will be totally independent from the original event.
• Double-clicking on an arranger event adds it to the current arranger chain.

**Working with arranger events**

You now have a number of arranger events that form the basic building blocks for your arrangement. The next step is to arrange these events using the functions of the Arranger Editor.

**Creating an arranger chain**

You can set up an arranger chain in the Arranger Editor or in the Inspector for the arranger track. The Arranger Editor is opened by clicking the “e” button in the Inspector or in the track list.

On the right in the Arranger Editor, the available arranger events are listed, in the order they appear on the timeline. To the left you find the actual arranger chain, which shows in which order the events will be played back, from top to bottom, and how many times they are repeated.

Initially the arranger chain is empty – you set it up by adding events from the list to the chain. There are several ways to add events to the arranger chain:

• By double-clicking on the name of an event in the window section on the right (or in the Project window).
When an event is selected in the arranger chain on the left, this will add the event above the selected event. When no events are selected in the arranger chain, the event will be added at the end of the list.

• By selecting one or more events in the list, right-clicking and selecting “Append Selected In Arranger Chain”. This will add the selected events at the end of the list.

• By dragging and dropping arranger events from the list on the right to the arranger chain on the left. A blue insertion line shows you where the dragged event will end up.

• By dragging arranger events from the Project window into the arranger chain.

If you followed our example, you should now have arranger events arranged in a very basic pop song pattern. However, we have used audio files that are only a few bars long – to turn our pattern into a “song” (or at least into a basic sketch of the song structure), these files must be looped. This is where the Repeats function comes in.

If you want an event to repeat several times, proceed as follows:

• Click in the Repeats field for an event, type in the desired number of repeats and press [Enter].

When playing back the arranger chain, the Counter column indicates which repeat of this event is currently playing.

• Click in the Mode field for an event and select the desired repeat mode.

<table>
<thead>
<tr>
<th>Option</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td></td>
<td>In this mode, the arranger chain will be played back as you set it up.</td>
</tr>
</tbody>
</table>
When you now play back the arranger chain, you will hear the complete arrangement. Proceed as follows:

1. Make sure that Arranger mode is activated. In Arranger mode the project will be played back using the arranger settings.

2. Position the Arranger Editor window so that you can see the arranger track in the Project window, and click in the arrow column for the event at the top of the list. You will see the project cursor jump to the beginning of the first event specified in the arranger chain.

3. Activate playback, either from the Arranger Editor or on the Transport panel. The events are played back in the specified order.

### Editing the arranger chain

In the arranger chain on the left, you can do the following:

- Select multiple events by [Ctrl]/[Command]-clicking or [Shift]-clicking as usual.
- Drag events to move them in the list.
- Drag events holding [Alt]/[Option] to create copies of the selected items. The insert location for both move and copy operations is indicated by a colored insertion line. A blue line indicates that the move or copy is possible; a red line indicates that moving or copying events to the current position is not allowed.
- Use the Repeats column to specify how many times each event is to be repeated.
- Click the arrow to the left of an event in the arranger chain to move the playback position to the start of that event.

- To remove an event from the list, right-click on it and select “Remove Touched” from the context menu. To remove several events, select them, right-click and select “Remove Selected”.

### Navigating

To navigate between arranger events, you use the arranger transport buttons:

These controls are available in the Arranger Editor, on the Project window toolbar, and on the Transport panel.

In the Arranger Editor, the event that is currently played back is indicated by an arrow in the leftmost column, and the indicators in the Counter column.

### Managing arranger chains

You can create several arranger chains. This way, you can create alternative versions for playback. In the Arranger Editor, the toolbar buttons on the right are used for this:

- To remove an event from the list, right-click on it and select “Remove Touched” from the context menu. To remove several events, select them, right-click and select “Remove Selected”.

### Option | Button | Description
--- | --- | ---
Repeat forever | | In this mode, the current arranger event will be repeated in a loop until you either click on another event in the Arranger Editor or press play once again.
Pause after repeats | | In this mode, the playback of the arranger chain will be stopped after having played back all repeats of the current arranger event.

### Option | Button | Description
--- | --- | ---
Click this to rename the current arranger chain. | |  creates a new, empty arranger chain.
Creates a duplicate of the current arranger chain, containing the same events. | |  Removes the currently selected arranger chain. Only available if you have created more than one arranger chain.

* In the Inspector, these functions are accessed from the Arranger pop-up menu (opened by clicking on the Arranger name field).
The arranger chains you create will be listed on the Name pop-up menu, found in the Arranger Editor to the left of the buttons, at the top of the arranger track Inspector, and in the track list. Please note that to be able to select another arranger chain from the pop-up menu, the Arranger mode must be activated.

Flattening the arranger chain

When you have found an arranger chain that suits your purposes, you can “flatten” it, i.e. convert the list into a linear project. Proceed as follows:

1. Click the Flatten button (or select Flatten Chain from the pop-up menu in the Inspector for the arranger track). The events and parts in the project are reordered, repeated, resized, moved and/or deleted (if these are not within the boundaries of any used arranger event), so that they correspond exactly to the arranger chain.

2. Activate Playback. The project will now play back exactly as in Arranger mode, but you can view it and work with it as usual.

⚠️ Flattening the arranger chain may remove events and parts from the project. Only use the Flatten function when you know you do not want to edit the arranger track/chain any more. If in doubt, save a copy of the project before flattening the arranger chain.

Flattening options

Sometimes it might be useful to keep the original arranger events even after flattening the arranger track. By using flattening options you can define which chain is flattened, where it is stored and how it is named together with other options.

1. Click the Flattening options button.

2. In the window that opens, select the desired options.

In the Source section you can specify which arranger chains are flattened. The available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Chain</td>
<td>If you activate this option, only the current chain will be flattened.</td>
</tr>
<tr>
<td>Checked Chains</td>
<td>If you activate this option, you can select the arranger chains you want to flatten in the list to the left.</td>
</tr>
<tr>
<td>All Chains</td>
<td>If you activate this option, all arranger chains of the current project will be flattened.</td>
</tr>
</tbody>
</table>

The Destination section allows you to choose where the result of the flattening is saved. The available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Project</td>
<td>This is only available if you have selected “Current Chain” as Source. If you activate this option, the result of the flattening of the current chain will be saved in the current project.</td>
</tr>
<tr>
<td>New Project</td>
<td>If you activate this option, you can flatten one or several chains in a new project. In this case it might be useful to use naming options. If you activate “Append Chain Name”, the Chain Names will be appended in brackets to the project name. If you activate “Use Chain Name”, the new projects will have the name of the current arranger chains. If you activate “Add Number”, the new projects will be named like the old ones and a number will be appended in brackets.</td>
</tr>
</tbody>
</table>
In the Options section you can make further settings. The available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keep Arranger Track</td>
<td>If you activate this option, the arranger track will be kept when flattening the arranger chain. Activate “Rename Arranger Events” to append a number to the events, according to their use. For example, if you use arranger event “A” two times, the first occurrence will be renamed “A 1” and the second “A 2”.</td>
</tr>
<tr>
<td>Make Real Event Copies</td>
<td>Normally, you will get shared copies when flattening the arranger track. If you activate this option, real copies will be created instead.</td>
</tr>
<tr>
<td>Don’t Split Events</td>
<td>If this option is activated, MIDI notes that start before or are longer than the arranger event will not be included. Only MIDI notes that begin and end inside the arranger event boundaries will be taken into account.</td>
</tr>
<tr>
<td>Open New Projects</td>
<td>If you activate this option, a new project will be created for every flattened arranger chain. If you activate the “Cascade New Projects” option the opened projects will be cascaded.</td>
</tr>
</tbody>
</table>

3. You can now flatten the arranger track by clicking the Flatten button. If you realize that you want to do further arrangements, you can click the “Go Back” button and make your adjustments. Your Flattening settings will be kept.

4. Click the “Go Back” button to go back to the Arranger Editor or close the window by clicking its Close button.

**Live mode**

If you have set up an arranger track and play it back, you have also the possibility to influence the playback order “live”. Note that the Arranger mode has to be activated to be able to use the Live mode.

1. Set up an arranger chain in the Inspector or in the Arranger Editor for an arranger track, activate the Arranger mode and play back your project. Now you can use your arranger events listed in the lower section of the Inspector to play back your project in Live mode.

In the Jump Mode pop-up menu, you can define how long the active arranger event will be played, before jumping to the next one. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Jumps to the next section immediately.</td>
</tr>
<tr>
<td>4 bars, 2 bars</td>
<td>When one of these modes is selected, a grid of 4 or 2 bars (depending on the setting) will be placed on the active arranger event. Whenever the respective grid line is reached, playback will jump to the next arranger event. An example: Let’s say you have an arranger event which is 8 bars long and the grid is set to 4 bars. When the cursor is anywhere within the first 4 bars of the arranger event when you hit the next arranger event, playback will jump to the next event when the end of the fourth bar of the arranger event is reached. When the cursor is anywhere within the last 4 bars of the arranger event, playback will jump to the next event at the end of the event. When an event is shorter than 4 (or 2) bars and this mode is selected, playback will jump to the next section at the event end.</td>
</tr>
<tr>
<td>1 bar</td>
<td>Jumps to the next section at the next bar line.</td>
</tr>
</tbody>
</table>
The arranger track

- You can stop Live mode by clicking the Stop button or go back to “normal” playback in Arranger mode by clicking on any arranger event in the upper list. In the latter case, playback will be continued from the arranger event where you clicked.

Arranging your music to video

The relative time of your arranger track can be taken as a reference instead of the project time. This is useful, if you want to use the arranger track to compose music for video and fill a specific video section with music, by repeating the corresponding number of arranger events.

If you position your external sync master device to a position that does not match the Project Start time, Cubase will jump automatically to the right position in the arranger track and will start playback from there, i.e. the correct relative position and not the absolute project time will be found. The reference for the external timecode can be MIDI or any other timecode that can be interpreted/read by Cubase.

An example:

1. Set up a project with a MIDI track and three MIDI parts. The first part should start at position 00:00:00:00 and end at position 00:01:00:00, the second should start at position 00:01:00:00 and end at position 00:02:00:00 and the third should start at position 00:02:00:00 and end at position 00:03:00:00.

2. Activate the Sync button on the Transport panel.

3. Add an arranger track and create arranger events that match the MIDI parts.

4. Set up the arranger chain “A-A-B-B-C-C”, activate the Arranger mode and play back your project.

5. Start external timecode at position 00:00:10:00 (within the range of “A”).

Now, let’s see what happens if your external sync master device starts at a position that does not match the Project Start time:

6. Start at 00:01:10:00 (within the range of what originally was “B”).

In your project, the position 00:01:10:00 will be located and you will hear “A” playing, because it plays twice in the arranger track.

7. Start external timecode at position 00:02:10:00 (within the range of what originally was “C”).

In your project, the position 00:02:10:00 will be located and you will hear “B” playing, because it plays “later” in the arranger track.

If the Arranger mode is not activated or no arranger track exists, Cubase will work as usual.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 beat</td>
<td>Jumps to the next section at the next beat.</td>
</tr>
<tr>
<td>End</td>
<td>Plays the current section to the end, then jumps to the next section.</td>
</tr>
</tbody>
</table>

1 beat

Jumps to the next section at the next beat.

End

Plays the current section to the end, then jumps to the next section.
The transpose functions
Introduction

Cubase offers transpose functions for audio, MIDI and instrument parts and for audio events. These allow you to create variations of your music or change the harmonics of an entire project or separate sections.

Transpose can be applied on three levels:

- **To the entire project**
  By changing the project Root Key in the Project window toolbar, the whole project will be transposed (see "Transposing an entire project with the root key" on page 132).

- **To sections of the project**
  By creating transpose events on the transpose track, you can set transpose values for separate sections of your project (see "Transposing separate sections of a project using transpose events" on page 134).

- **To individual parts or events**
  By selecting individual parts or events and changing their transpose value in the info line, you can transpose individual parts or events (see "Transposing individual parts or events using the info line" on page 135).

⚠️ The transpose functions do not change the actual MIDI notes or the audio, but only affect the playback.

Apart from the transpose features described in this chapter, you can also transpose all MIDI notes on the selected track using the MIDI modifiers (see "Transpose" on page 350), selected notes using the Transpose dialog (see "Transpose" on page 367), and MIDI tracks using MIDI effects (see the separate PDF document “Plug-in Reference”).

Transposing your music

In the following sections we will describe the different possibilities of transposing your music. Note that these can also be combined. However, we recommend you to set the root key first, before recording or changing transpose values on the transpose track.

⚠️ As a general rule, always set the root key first when you work with content with a defined root key.
The entire project will be played back with this root key. To do so, the separate loops are transposed to match the project root key. For example, if you have imported a bass loop in C and the project root key is set to E, the bass loop will be transposed up by 4 semitones.

3. With the root key set, record some audio or MIDI. The recorded events will get the project root key.

4. When you are done, you can change the project root key and your events will follow.

⚠️ If you work with drums or percussion, exclude these from being transposed by setting the “Global Transpose” setting on the info line to “Independent” (see “The Global Transpose setting” on page 136).

If the events do not contain root key information

Let’s say you have created a project by recording audio and importing some MIDI loops, and you want to match the root key of the whole project to the register of a certain singer.

Proceed as follows:

1. Open the Project menu and select “Transpose” from the Add Track submenu (or right-click the track list select the corresponding option from the context menu). A transpose track is created. You can only have one transpose track in a project.
2. Set the project to the desired root key by selecting the corresponding option from the Root Key pop-up menu in the Project window toolbar.
3. Right-click the transpose track in the track list and select “Set root key for unassigned events” from the context menu. This sets the project root key for all parts or events not containing any root key information. This option is only available, if a project root key has been set.

⚠️ If you work with drums or percussion, exclude these from being transposed by setting the “Global Transpose” setting on the info line to “Independent” (see “The Global Transpose setting” on page 136).

Recording with a project root key

Let’s say that you want to record a guitar line for a project that is in D♯ minor, but your guitar player prefers to play in A minor. In this case, change the project root key to A, so that you can record your guitar. Proceed as follows:

1. Open your project and set the project root key to A. All parts and events will be transposed in order to match the root key.
2. Listen to your project and verify that no drums and percussions have been transposed. If drums have been transposed, select them and set their Global Transpose setting to “Independent”.
3. Record your guitar line as desired.
4. When you are done and satisfied with the result, you can change the project root key back to D♯ minor and your events will follow.

⚠️ For recorded audio events and MIDI parts, the “Global Transpose” setting on the info line is automatically set to “Follow”, i.e. the events or parts will get the project root key.
Changing the root key of single events or parts

If you want to check if an audio event or part has root key information or if you want to change it, proceed as follows:

1. Open the Pool and display the Key column by activating the Root Key option on the View/Attributes pop-up menu.
2. Click in the Key column for the desired audio event and set the root key according to your needs. You can also check and assign root keys in the MediaBay.
   - If you change the root key of an audio part or event, the corresponding audio file will not change. To save the root key in the audio file, you have to use the “Bounce Selection” function on the Audio menu.

To check or change the root key setting of a MIDI part, proceed as follows:

1. Select your MIDI part in the Project window and check the Project window info line.

A MIDI part with the root key set to “D”

2. Click on the root key value in the info line to open the corresponding pop-up menu and select the desired root key.

⚠️ If you change the project root key after setting the event root key, the events will keep their own root key settings, and will be transposed to match the project root key. If you record an audio or a MIDI part and the project root key is specified, this root key is automatically set.

Transposing separate sections of a project using transpose events

Sometimes you may want to transpose only certain sections of your project, e.g. to create harmonic variations. This can be done by creating transpose events. Transpose events allow you to add a relative transpose offset by specifying transpose values in semitones. For example, you can brighten up your loops in C major by transposing them by 5 semitones, so that the subdominant on F major is played back, or you can turn your hit more interesting by transposing the last chorus one semitone upwards.

1. Open the Project menu and select “Transpose” from the Add Track submenu (or right-click the track list select the corresponding option from the context menu).

A transpose track is created. You can only have one transpose track in a project.

2. Select the Pencil tool and click in the transpose track to create a transpose event.

A transpose event will be created from the point where you clicked until the end of the project.

3. To create another transpose event, click with the Pencil tool on the first transpose event.

You can add more transpose events by clicking with the pencil tool.

4. Click in the transpose value field and enter the transpose value for the transpose event.

By default, the transpose value of new transpose events is set to 0.

You can enter the desired value with the computer keyboard, use the mouse wheel or [Alt]/[Option]-click on the transpose value to open a value fader. You can specify values between -24 and 24 semitones.

5. Play back your project.

The parts of your project on the same position as the transpose events will be transposed according to the specified transpose values.
You can also transpose the whole project using the transpose track. This is useful if your singer does not reach a certain pitch, for example. You could then transpose the whole project by approx. -2 semitones. Always remember to verify that the “Global Transpose” setting for drums and percussion is set to “Independent” on the info line (see “The Global Transpose setting” on page 136).

You can erase and move transpose events, but you cannot mute, cut or glue them. The “Locators to Selection” option does not apply on transpose events.

Transposing individual parts or events using the info line

You can also transpose individual audio and MIDI parts and events via the info line (or the Inspector). This transposition will be added to the global transposition (i.e. the root key or the transpose events). Proceed as follows:

1. Select the event that you want to transpose.
2. In the Project window info line, adjust the Transpose value as desired.

A global transpose change will not overwrite individual part or event transpose, but will be added to the transpose value for the part or event. In this case, it might be useful to keep the transposition within the octave range (see “Keep Transpose in Octave Range” on page 136).

Other functions

Indicate Transpositions

When you transpose your music, you may sometimes want to visually compare the original sounds and the transposed music. For MIDI parts, you can check this by opening the Key Editor and clicking the “Indicate Transpositions” button. This will help you see how your MIDI notes will be transposed. If the button is activated, the Key Editor will show the note pitch you will hear, if it is deactivated, the Key Editor shows the original pitch of the notes in your MIDI part. By default, the “Indicate Transpositions” button is deactivated.

A MIDI part as originally recorded

When you activate “Indicate Transpositions” you will see how your MIDI part will be transposed.
The Global Transpose setting

If you are working with drum and percussion loops or special effects (FX) loops, you will want to exclude these from being transposed. This can be achieved by locking them using the Global Transpose setting. Proceed as follows:

1. Open your project.
2. Select the desired event or part and set the “Global Transpose” setting on the info line to “Independent”. A symbol will be displayed in the lower right corner of the selected part or event, indicating that it will not be transposed neither by changing the root key nor by specifying transpose events.

3. You can now change the project root key. The “Independent” parts or events will not be affected by the root key changes.

If you import ready-made parts or events that are tagged drums or FX, Global Transpose will be automatically set to Independent.

If you record audio or MIDI, Global Transpose will be set to “Independent”, provided that the transpose track exists and you have specified at least one transpose event (even when the transpose value is not defined). In this case, your recording will sound exactly the way you played it. The transpose events will not be taken into account during recording and the recorded event will not get the project root key.

Have a look at the following example:

1. Set up a project with the root key in C.
2. Add a transpose track and enter transpose events with the values 0, 5, 7 and 0.
3. Record some chords with your MIDI keyboard. For our example, record C, F, G and C.

The transpose events are not taken into account and the result of your recording will be C, F, G and C. No root key will be set.

Recorded events are independent from Global Transpose.

If no transpose track exists or if no transpose event has been added, Global Transpose will be set to Follow.

If Global Transpose is set to Follow, the selected part will follow all global transpositions.

Locking the transpose track

If you want to prevent your transpose events from being changed by mistake, activate the Lock button on the transpose track. This way, you will not be able to move your transpose events or change their transpose values.

Muting transpose events

Sometimes it might be useful to disable the transpose track, e.g. to hear the original sound of individual tracks. If you activate the mute button on the transpose track, your transpose events will not be taken into account during playback.

Keep Transpose in Octave Range

The “Keep Transpose in Octave Range” button on the transpose track (the button with an up and down arrow in brackets) keeps the transposition in the octave range. This option is activated by default. This way, nothing will be transposed by more than seven semitones. This ensures that your music never sounds unnatural because the pitch was raised too high or too low.
To understand the principle behind this, follow the example below:

1. Create a MIDI part, enter a C major chord, open the Key Editor and activate “Indicate Transpositions”. This way you can observe and understand what happens when you change the transposition.

2. Add a transpose track and create a transpose event. By default, the transpose value is set to 0.

3. Make sure that the “Keep Transpose in Octave Range” button is activated on the transpose track and change the transpose value of the transpose event to 7. Your chord will be transposed accordingly.

4. Set the transpose value to 8 semitones. As “Keep Transpose in Octave Range” is activated, your chord will now be transposed to the nearest interval or pitch.

If you enter a transpose value of 7, your chord will be transposed by seven semitones upwards. In this example, this would be G3/B3/D4.

⚠️ If you mainly work with audio loops, we recommend activating “Keep Transpose in Octave Range”.

Your chord has been transposed to the nearest pitch, this results in G#2/C3/D#3.
Using markers
Introduction

Markers are used to locate certain positions quickly. If you often find yourself jumping to a specific position within a project, you should insert a marker at this position. You can also use markers to make range selections (see “Using markers to make range selections in the Project window” on page 142) or for zooming (see “Zooming to cycle markers” on page 139). Markers are located on the marker track.

There are two types of markers: position markers and cycle markers.

Position markers

As the name implies, position markers allow you to store a specific position. Position markers on the marker track are shown as marker events: vertical lines with the marker description (if assigned) and number beside it. If you select a marker track, all its markers are shown in the Inspector.

Cycle markers

By creating cycle markers you can store any number of left and right locator positions as start and end positions of a range and recall them by double-clicking on the corresponding marker. Cycle markers are shown on marker tracks as two markers bridged by a horizontal line. Cycle markers are ideal for storing sections of a project. By defining cycle markers for sections of a song, e.g. “Intro”, “Verse”, and “Chorus”, you can quickly navigate to the song sections and repeat the section by activating the Cycle button on the Transport panel.

Using cycle markers

Cycle markers represent ranges in your project. Therefore you can use them for moving the left and right locators:

- If you double-click on a cycle marker or select it from the Cycle pop-up menu in the track list, the left and right locators are moved to encompass the cycle marker. Now you can move the project cursor position to the start or the end of the cycle marker by moving it to the corresponding locator (e.g. by using the keys [1] and [2] on the numeric keypad).

Editing cycle markers using tools

Cycle markers can be edited on marker tracks using the following tools (Snap is taken into account):

<table>
<thead>
<tr>
<th>Tool</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow tool</td>
<td>Drag the start or end handle of a cycle marker with the Arrow tool to change its start or end position, or drag the upper border to move the whole cycle marker. Double-click on a cycle marker to set the left and right locators.</td>
</tr>
<tr>
<td>Selection Range</td>
<td>Double-click on a cycle marker – this creates a selection range spanning all tracks in the project. You can also select a range inside the cycle marker and press [Ctrl]/[Command]-[X] to trim or to divide a cycle marker.</td>
</tr>
<tr>
<td>Pencil</td>
<td>Press [Ctrl]/[Command] and use the Pencil tool to create new cycle markers.</td>
</tr>
<tr>
<td>Eraser</td>
<td>Click with the Eraser tool to delete a cycle marker. If you hold down [Alt]/[Option] when you click, all consecutive markers are also be deleted.</td>
</tr>
</tbody>
</table>

Zooming to cycle markers

- When you select a cycle marker on the Zoom pop-up menu, the event display is zoomed in to show the selected range only (see the section “Zoom presets and cycle markers” on page 56).
- You can also zoom in by pressing [Alt]/[Option] and double-clicking on the cycle marker in the event display.

The Marker window

![Marker window](image)

In the Marker window you can view and edit markers. The markers on the marker track are displayed in the marker list in the order in which they occur in the project.
To open the Marker window, you have the following possibilities:

- Open the Project menu and select “Markers”.
- Click the Show button in the marker section on the Transport panel.
- Use a key command (by default [Ctrl]/[Command]-[M]).

The Type pop-up menu

- By selecting an entry from the Type pop-up menu, you specify which markers (position markers, cycle markers, or all) are shown in the marker list.

Adding, moving, and removing markers

- To select a marker, click on it in the Marker window.
- To edit a selected marker, click on it. Select multiple markers by [Shift]-clicking or [Ctrl]/[Command]-clicking them.
- To add a position marker, open the Functions pop-up menu and select the “Insert Marker” option. A position marker is added at the current project cursor position on the marker track. You can also use key commands for this, see “Marker key commands” on page 143.
- To add a cycle marker, open the Functions pop-up menu and select the “Insert Cycle Marker” option. This adds a cycle marker between the left and right locators on the marker track.
- To move one or more markers to a specific position, set the project cursor to this position, select the markers, and select “Move Markers to Cursor” from the Functions pop-up menu. You can also move markers by entering the new position numerically in the Position column. If a cycle marker is selected, the Move operation affects the cycle marker start position.
- To remove a marker, select it and select the “Remove Marker” option from the Functions pop-up menu.

Auto-Scroll with Project Cursor

This option helps you to keep track of the locate arrow, even if your project contains a large number of markers. When this option is activated, the Marker window is automatically scrolled to keep the locate arrow visible.

Navigating in the marker list

You can navigate in the marker list using your computer keyboard and select entries by pressing [Enter]. This is a quick and easy way to jump to markers during playback or recording:

- To move to the previous/next marker in the list, press [Up Arrow]/[Down Arrow].
- To jump to the first/last marker, press [PageUp]/[PageDown].

Marker attributes

The following marker attributes are shown in the marker list of the Marker window:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locate (left-most column)</td>
<td>An arrow indicates which marker is at the project cursor position (or closest to the project cursor). If you click in this column, the project cursor is moved to the corresponding marker position. This column cannot be hidden.</td>
</tr>
<tr>
<td>ID</td>
<td>This column shows the marker ID numbers, see “About marker IDs” on page 141.</td>
</tr>
<tr>
<td>Position</td>
<td>In this column you can view and edit the markers’ time positions (or start positions for cycle markers). This column cannot be hidden.</td>
</tr>
<tr>
<td>End</td>
<td>In this column you can view and edit the end positions of cycle markers, see “Cycle markers” on page 139.</td>
</tr>
<tr>
<td>Length</td>
<td>In this column you can view and edit the length of cycle markers, see “Cycle markers” on page 139.</td>
</tr>
<tr>
<td>Description</td>
<td>Here you can enter names or descriptions for markers.</td>
</tr>
</tbody>
</table>

Editing attributes

- To edit a marker attribute, select the corresponding marker, click in the desired attribute column, and make your settings.
- To change the attributes of several markers, select the markers and click the checkbox for the desired attribute. All selected markers will change their attributes accordingly. Note that this does not work when clicking on a timecode value or a text field.

To navigate in the list of marker attributes, you can also use the [Tab] key and the arrow keys.
Sorting and reordering columns
You can customize the display of the marker attributes in the marker list by sorting or reordering the columns. Proceed as follows:

- To sort the marker list by a specific attribute, click on the corresponding column header.
- To reorder the marker attributes, drag and drop the corresponding column headers.
- To adjust the width of a column, place the mouse pointer between two column headers and drag left or right. The pointer changes to a divider when you place it between two column headers.

If you move a marker from one marker track to another by drag & drop in the Project window and the marker ID is already used on this track, the inserted marker automatically gets a new ID.

Reassigning marker IDs
Sometimes, especially when setting markers on the fly, you may forget or miss to set a marker. When added later, this marker’s ID will not correspond to its position on the marker track. Therefore, it is possible to reassign the IDs for all markers on a track.

Proceed as follows:
1. Open the Marker window.
2. Open the Functions pop-up menu and select either “Reassign Position Marker IDs” or “Reassign Cycle Marker IDs”. The marker IDs of the selected type are reassigned to match the order of markers on the marker track.

The marker track
The marker track is used for adding and editing markers.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle follows when locating to Markers</td>
<td>This sets the left and right locators automatically to a position or cycle marker, when locating to this marker. This is useful if you need to set the locators on the fly, e.g. during recording for Punch In/Punch Out.</td>
</tr>
<tr>
<td>Show marker IDs on marker track</td>
<td>When this option is activated, the marker IDs are shown on the marker track.</td>
</tr>
<tr>
<td>Sync Selection</td>
<td>When this option is activated, the Marker window selection is linked to the selection in the Project window.</td>
</tr>
</tbody>
</table>

About marker IDs
Each time you add a marker, it is automatically and sequentially assigned an ID number, starting from 1. IDs for cycle markers are shown in brackets and start from [1]. ID numbers can be changed at any time - this allows you to assign specific markers to key commands.

If you move a marker from one marker track to another by drag & drop in the Project window and the marker ID is already used on this track, the inserted marker automatically gets a new ID.

Reassigning marker IDs
Sometimes, especially when setting markers on the fly, you may forget or miss to set a marker. When added later, this marker’s ID will not correspond to its position on the marker track. Therefore, it is possible to reassign the IDs for all markers on a track.

Proceed as follows:
1. Open the Marker window.
2. Open the Functions pop-up menu and select either “Reassign Position Marker IDs” or “Reassign Cycle Marker IDs”. The marker IDs of the selected type are reassigned to match the order of markers on the marker track.

The marker track
The marker track is used for adding and editing markers.

In the track list area for the marker track you can find three pop-up menus, which help you to select or zoom to the markers that you select:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locate pop-up menu</td>
<td>If you select a position or a cycle marker in this pop-up menu, the corresponding marker in the event display or in the Marker window is selected.</td>
</tr>
<tr>
<td>Cycle pop-up menu</td>
<td>If you select a cycle marker in this pop-up menu, the left and right locators are set to the corresponding cycle marker.</td>
</tr>
<tr>
<td>Zoom pop-up menu</td>
<td>If you select a cycle marker in this pop-up menu, the view zooms to the corresponding cycle marker.</td>
</tr>
</tbody>
</table>
Markers shown on the marker track are exactly the same as shown in the Marker window, and any changes made on the marker track are reflected in the Marker window and vice versa.

Adding, moving, and removing the marker track

- To add the marker track to the project, select Marker from the Add Track submenu of the Project menu.
- To move the marker track to another position in the track list, click and drag it up or down.
- To remove the marker track, right-click it in the track list and select “Remove Selected Tracks” from the context menu.
- An empty marker track can also be removed by selecting “Remove Empty Tracks” from the Project menu. Note that Remove Empty Tracks also removes any other tracks that are empty.

Editing markers on the marker track

The following editing functions can be performed directly on the marker track:

- Adding position markers “on the fly”. Use the [Insert] key (Win) or the “Add Marker” button in the track list for the marker track to add position markers at the current cursor position during playback.
- Adding a cycle marker. Clicking the “Add Cycle Marker” button in the track list for the marker track adds a cycle marker spanning the area between the left and right locator.
- Selecting markers. You can use standard selection techniques like a selection rectangle, or use [Shift]-clicking to select separate markers. When selecting markers on the marker track, they are also selected in the Marker window.
- Drawing in position markers. By using the Pencil tool (or pressing [Alt]/[Option] and using the Arrow tool), you can create position marker events at any position on the track. If Snap is activated on the toolbar, this determines at which positions you can draw markers.
- Drawing in cycle markers. To draw a cycle marker range, press [Ctrl]/[Command] and use the Pencil tool or the Arrow tool. If Snap is activated on the toolbar, this determines at which positions you can draw markers.
- Resizing cycle markers. Select a cycle marker by clicking on it. Two handles appear at the bottom of the start and end events. If you click and hold one of the handles you can drag the event left or right to resize the cycle marker. This can also be done numerically on the info line.
- Moving markers. Click and drag to move the selected markers. You can also edit marker positions on the info line. As usual, Snap is taken into account.
- Removing markers. This is done exactly the same way as for other events, i.e. by selecting them and pressing [Delete], using the Erase tool, etc.

Using markers to make range selections in the Project window

Besides enabling you to quickly move the project cursor and the locators, markers can be used in conjunction with the Range Selection tool to make range selections in the Project window. This is useful if you quickly want to make a selection that spans all tracks in the project.

Moving and copying sections

To quickly move or copy complete sections of the project (on all tracks), proceed as follows:

1. Set markers at the start and end of the section that you want to move or copy.
2. Select the Range Selection tool and double-click on the marker track between the markers.
   Everything in the project within the marker boundaries is selected. Any functions or processing you perform now affect the selection only.
3. Click on the marker track in the selected range and drag the range to a new position.
Using markers

• If you hold down [Alt]/[Option] while you drag the range, the selection in the Project window is copied instead.

Marker key commands

You can check or change any key command assignments for the marker commands in the Transport categories of the Key Commands dialog. In the following section, the available key commands for markers are listed.

Key commands in the Transport Category:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
<th>Default key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Cycle Marker</td>
<td>Creates a new cycle marker between the left and the right locator.</td>
<td>-</td>
</tr>
<tr>
<td>Insert Marker</td>
<td>Creates a new marker at the current project cursor position.</td>
<td>[Insert] (Windows only)</td>
</tr>
<tr>
<td>Locate Next Marker</td>
<td>Moves the project cursor to the right to the next marker position (if any).</td>
<td>[Shift]-[N]</td>
</tr>
<tr>
<td>Locate Previous Marker</td>
<td>Moves the project cursor to the left to the previous marker position (if any).</td>
<td>[Shift]-[B]</td>
</tr>
<tr>
<td>Play until next marker</td>
<td>Plays back your project from the current project cursor position to the next marker position.</td>
<td>-</td>
</tr>
<tr>
<td>Recall Cycle Marker 1-9</td>
<td>Moves the left and right locators to encompass the specified cycle marker (1 to 9).</td>
<td>[Shift]-Num[1] to Num[9]</td>
</tr>
<tr>
<td>Recall Cycle Marker X</td>
<td>Moves the left and right locators to encompass the specified cycle marker. After pressing the assigned key command, you can enter the desired marker ID.</td>
<td>-</td>
</tr>
<tr>
<td>Set Marker 1-9</td>
<td>Moves the specified marker (1 to 9) to the current project cursor position.</td>
<td>[Ctrl]-[1] to [9]</td>
</tr>
<tr>
<td>To Cycle Marker 1-9</td>
<td>Moves the project cursor to the start position of the specified cycle marker (1 to 9).</td>
<td>-</td>
</tr>
<tr>
<td>To Cycle Marker X</td>
<td>Moves the project cursor to the start position of a marker. After pressing the assigned key command, you can enter the desired marker ID.</td>
<td>-</td>
</tr>
<tr>
<td>To Marker 1-9</td>
<td>Moves the project cursor to the specified marker (ID 1 to 9).</td>
<td>[Shift]-[1] to [9]</td>
</tr>
<tr>
<td>To Marker X</td>
<td>Moves the project cursor to the position of the specified marker. After pressing the assigned key command, you can enter the desired marker ID.</td>
<td>-</td>
</tr>
</tbody>
</table>

Where no default key command is specified, you need to define your own stroke sequence in the Key Commands dialog, see “Key commands” on page 541.

Exporting and importing markers

In Cubase, markers and marker tracks can be imported and exported in different ways. You have the following possibilities:

• You can import/export markers contained in MIDI files.
• You can import/export track archives that contain marker tracks (Cubase only).

Importing markers via MIDI import

You can import position markers by importing MIDI files containing markers. This is useful if you want to use your marker tracks in other projects or if you want to share them with other Cubase users. Any markers you have added are included in the MIDI file as standard MIDI file marker events. Make sure that the “Import Markers” option is activated in the Preferences dialog (MIDI–MIDI File page).

The following settings are imported:

• The start position of position markers and cycle markers
For a description of how to import MIDI files, see “Importing MIDI files” on page 528.

Exporting markers via MIDI

You can export your markers as part of a MIDI file. If you activate “Export Markers” in the Export Options dialog, any markers are included in the MIDI file.

The following settings are exported:

• The start position of position markers and cycle markers
☐ To be able to export markers via MIDI export, your project must contain a marker track.

For a description of how to export MIDI files, see “Exporting MIDI files” on page 527.
Importing markers as part of a track archive (Cubase only)

You can import position markers and cycle markers by importing track archives containing a marker track.

The following settings are imported:

- The start and end positions of cycle markers
- The marker IDs

For a description of how to import track archives, see "Importing tracks from a track archive" on page 529.

Exporting markers as part of a track archive (Cubase only)

If you want to use your marker track in other projects, for example to share it with other users, you can export it as part of a track archive. Select the marker track that you want to export and select "Selected Tracks…" from the Export submenu of the File menu.

The following settings are exported:

- The start and end positions of cycle markers
- The marker IDs

For a description of how to export track archives, see "Exporting tracks as track archives" on page 529.
The Mixer
Overview

The Mixer offers a common environment for controlling levels, pan, solo/mute status, etc. for both audio and MIDI channels. Furthermore it is a convenient environment for setting up the input/output routing for multiple tracks or channels at the same time.

This chapter contains detailed information about the elements used when mixing audio and MIDI, or routing audio. You will also learn about the various ways you can configure the Mixer.

Some mixer-related features are not described in this chapter. These are the following:

- Setting up and using audio effects. See the chapter “Audio effects” on page 187.
- Setting up and using MIDI effects. See the chapter “MIDI realtime parameters and effects” on page 348.
- Surround Sound (Cubase only). See the chapter “Surround sound (Cubase only)” on page 217.
- Automation of all Mixer parameters. See the chapter “Automation” on page 227.

- Mixing down several audio tracks (complete with automation and effects if you wish) to a single audio file. See the chapter “Export Audio Mixdown” on page 484.

Opening the Mixer

The Mixer can be opened in several ways:

- By selecting Mixer from the Devices menu.
- By clicking the Mixer icon on the toolbar. If this icon is not visible, you need to activate the “Media & Mixer Windows” option on the toolbar context menu first.

- By using a key command (by default [F3]).
- By clicking the Mixer button in the Devices panel. You open the Devices panel by selecting Show Panel from the Devices menu.

Opening multiple Mixer windows (Cubase only)

Several separate Mixer items are available on the Devices menu. These are not separate Mixers, but rather separate views of the same Mixer.

- Each of the Mixer windows can be configured to show any combination of channels, channel types, narrow and wide channel strips, etc.

For example, you can configure one Mixer window to show MIDI channel strips, another to show input and output channels, and another to show all audio-related channels.
You can also save channel configurations as view sets (see "Channel view sets" on page 151), which are then accessible from all Mixer windows.

All options for configuring the Mixer described in this chapter are identical for all Mixer windows.

The use of multiple Mixer windows combined with the ability to recall different Mixer configurations enables you to focus on the task at hand and keep window scrolling down to a minimum.

What channel types can be shown in the Mixer?

The following track-based channel types are shown in the Mixer:

• Audio
• MIDI
• Effect return channels (referred to as FX channels in the Project window)
• Group channels
• Instrument track channels

The order of audio, MIDI, instrument, group, and effect return channel strips (from left to right) in the Mixer corresponds to the track list in the Project window (from top to bottom). If you reorder tracks of these types in the track list, this will be mirrored in the Mixer.

In addition to the above, the following channel types are also shown in the Mixer:

• Activated ReWire channels, see the chapter "ReWire" on page 517.

ReWire channels cannot be reordered and always appear to the right of other channels in the main Mixer pane.

• VST instrument channels, see the chapter "VST instruments and instrument tracks" on page 206.

VST instrument (VSTi) channels can be reordered in the track list which will in turn be mirrored in the Mixer.

Input and output busses in the Mixer

The busses you set up in the VST Connections window are represented by input and output channels in the Mixer. They are shown in separate panes (to the left and right of the regular channel strips), with their own dividers and horizontal scrollbars. Input and output channel strips are very similar. The only difference between the two is that input channels have no Solo buttons.

• You can hide and show these panes by activating or deactivating the "Hide Input Channels" or "Hide Output Channels" button on the common panel (see "The common panel" on page 149).

For input and output channel strips the following controls are available:

• You can check and adjust the input level using the Input Gain knobs and/or the level fader.

See "Setting input levels" on page 94.

• You can change the phase of the input signal.

This is done by clicking the Input Phase button next to the Input Gain control.
• You can add effects or EQ to the busses. See “Recording with effects (Cubase only)” on page 98 for an example of how to add effects to your recording at the input bus stage.

⚠️ The settings you make for the input channel will be a permanent part of the recorded audio file!

• You can open the Channel Settings window to add effects or EQ. These will affect the whole bus. Examples of effects you may want to add here include compressors, limiters and dithering, see the chapter “Audio effects” on page 187.

For information on how to set up input and output busses, see the chapter “VST Connections” on page 25.

How to route audio channels to busses is described in the section “Routing audio to output busses in the Mixer” on page 165.

⚠️ If the Control Room is disabled (see the chapter “Control Room (Cubase only)” on page 172), the Main Mix (the default output) bus is used for monitoring. For information about Monitoring, see “About monitoring” on page 30.

Configuring the Mixer

The Mixer window can be configured in various ways to suit your needs and to save screen space. You can decide which types of channels are displayed (see “Showing/hiding channel types” on page 149), and expand the view to open additional sections above the fader display (see below). On the left is the common panel which allows for global settings affecting all channels (see “The common panel” on page 149).

Normal vs. extended channel strips

While the fader panel in the Mixer is always visible, you can show/hide extended channel strips and the routing section at the top of the channel strips. The corresponding buttons can be found on the common panel on the left of the Mixer window. For details about the common panel, see “The common panel” on page 149.

The fader panel shows the basic controls – faders, pan controls and an associated vertical row of buttons. The extended panel can be set to show EQs, send effects, insert effects, etc. The routing panel contains input and output routing pop-up menus (where applicable), along with Input Phase and Input Gain controls for audio-related channel strips or an Input Transformer control for MIDI channel strips.

The extended panel and the routing panel can be shown and hidden as follows:

• On the common panel, click the “Show Extended Mixer” button or the “Show Routing View” button (respectively). These options are also available on the Window submenu of the Mixer context menu.

Showing the extended Mixer panel

• On the common panel, click the “Hide Extended Mixer” button or the “Hide Routing View” button (respectively). These buttons (down arrows) are only visible when the corresponding section is open. These options are also available on the Window submenu of the Mixer context menu.

Hiding the routing panel
The common panel

The common panel can be found on the left of the Mixer window. It contains settings for changing the look and behavior of the Mixer, as well as global settings for all channels.

In standard mode (extended view is hidden), the common panel contains the following controls:

- Showing/hiding channel types

In the lower part of the common panel you will find a vertical strip with icons representing the different channel types:

- To hide or show a channel type, click the corresponding icon.
- To show all hidden channel types again, click the “Reveal All Channels” button.

Configuring the extended channel strips

Using the icons in the extended area of the common panel you can determine globally what is displayed in the extended Mixer panel for all channel strips. Depending on the channel type, the following options are available:

- For a description of the options available for audio-related channels, see “Options for extended audio channel strips” on page 155. The options for MIDI channels are described in the section “Options for extended MIDI channel strips” on page 166.
- To apply the global view settings also to the input and output channels, press [Alt]/[Option] while clicking on an icon.
- To set up the extended channel strip individually for a channel, you can use the View Options pop-up menu, see below.
The View Options pop-up menu

Each channel strip in the Mixer features a View Options pop-up menu, which is used for two things:

- To determine what is shown in the extended panel for individual channels in the Mixer. The corresponding options are only available when the extended Mixer view is open.
- To set the “Can Hide” status for individual channels in the Mixer, see below.

The View Options pop-up menu is opened by clicking the down arrow located just above the fader panel of a channel strip.

Showing/hiding individual channels

Additionally to hiding or showing channel types via the common panel, you can show or hide individual channel strips. Proceed as follows:

1. Pull down the View Options pop-up menu for a channel that you want to hide and activate the “Can Hide” option (or [Alt]/[Option]-click in the top middle section of the channel strip). The “/” icon is shown if “Can Hide” is activated for a channel strip.

2. Repeat this for all the channels that you want to hide.

3. On the common panel, click the “Hide Channels set to ‘Can Hide’” button. This hides all channels set to “Can Hide”. To show them again, click the button again, or click the “Reveal All Channels” button at the bottom of the common panel.

Below the “Hide Channels set to ‘Can Hide’” button, there are three additional buttons. These have the following functionality:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Target Channels to ‘Can Hide’</td>
<td>This activates “Can Hide” for all channels that you specified as “Command Targets”, see below.</td>
</tr>
<tr>
<td>Remove ‘Can Hide’ from Target Channels</td>
<td>This deactivates “Can Hide” for all channels that you specified as “Command Targets”, see below.</td>
</tr>
<tr>
<td>Remove ‘Can Hide’ from All Channels</td>
<td>This deactivates “Can Hide” for all channels in the Mixer.</td>
</tr>
</tbody>
</table>

About the Command Target

Command targets let you specify which channels are affected by Mixer “commands” (all the functions that key commands can be assigned to), e.g. what to display in the extended Mixer, or the width setting of the channel strips. You can set command targets using the common panel or the context menu.

The Command Target Controls on the common panel

The following options are available:

- All Channels – Select this if you want your commands to affect all channels.
- Selected Only – Select this if you want your commands to affect the selected channels only.
- Exclude Inputs – Select this if you do not want your commands to affect the input channels.
- Exclude Outputs – Select this if you do not want your commands to affect the output channels.
Channel view sets

Channel view sets are saved configurations of the Mixer window, allowing you to quickly switch between different layouts for the Mixer. The following settings are stored in view sets:

- Settings for individual channel strips (e.g. narrow or wide mode and whether the channel strip is hidden or set to “Can Hide”).
- The global hide/show status for channel types.
- The panel hide/show status (fader panel, extended panel, routing panel).
- Configuration of the extended view.

To create a view set, proceed as follows:

1. Set up the Mixer configuration that you want to save.
2. At the bottom of the common panel, click the “Store View Set” button (the “+” sign).
3. A dialog opens, allowing you to enter a name for the view set.
4. Click OK to store the current Mixer view set.

- You can now return to this stored configuration at any time by clicking the “Select Channel View Set” button (the down arrow to the left of the “Store View Set” button) and selecting it from the pop-up menu.

- To remove a stored channel view set, select it and click the “Remove View Set” button (the “-” sign).

⚠️ Some remote control devices support this function, which means that you can use the remote device to switch between the channel view sets.

Setting the width of channel strips

Each channel strip can be set to either “Wide” or “Narrow” mode by using the “Channel Narrow/Wide” button on the left above the fader strip.

- Narrow channel strips contain a narrow fader, miniature buttons, and the View Options pop-up menu.

In the extended panel, only the Channel Overview and the Meter are shown in narrow mode. (All other parameters are shown again when you return to wide mode.)

The Window submenu

The Mixer context menu, opened by right-clicking anywhere on the Mixer window background, contains a Window submenu. Its options are handy for quickly switching to another open Mixer window, showing/hiding the different Mixer panes, etc. It contains the following options:

- Show Routing View
  Allows you to show/hide the topmost section of the Mixer which contains the input/output routing settings.

- Show Extended View
  Allows you to show/hide the middle section of the Mixer, where you can display different settings for the channels (EQs, Send effects, etc.).

- Next Mixer
  This displays the next Mixer window (if you have several Mixer windows open).
Basic mixing procedures

Setting volume in the Mixer

In the Mixer, each channel strip has a volume fader.

- For audio channels, the faders control the volume of the channels before they are routed (directly or via a group channel) to an output bus.

  Cubase only: Each channel can in turn handle up to 6 speaker channels – see the chapter “Surround sound (Cubase only)” on page 217.

- An output channel fader determines the master output level of all audio channels routed to that output bus.

- MIDI channels handle fader volume changes in the Mixer by sending out MIDI volume messages to the connected instrument(s).

  Connected instruments must be set to respond to MIDI messages (such as MIDI volume in this case) for this to function properly.

- The fader settings are displayed numerically below the faders, in dB for audio-related channels and as MIDI volume (0 to 127) for MIDI channels.

  You can click in the fader value fields and type in a new volume value.

- To make fine volume adjustments, hold down [Shift] when you move the faders.

- If you hold down [Ctrl]/[Command] and click on a fader, it is reset to its default value, i.e. to 0.0 dB for audio-related channels, or to 100 for MIDI channels.

  Most Mixer parameters can be reset to their default values like this.

You can use the faders to set up a volume balance between the audio and MIDI channels, and perform a manual mix by moving the faders and other controls while playing back. Using the Write function (see “Enabling and disabling the writing of automation data” on page 228), you can automate the levels and most Mixer actions.

⚠ It is also possible to create volume envelopes for separate events in the Project window or Audio Part Editor (see “Event envelopes” on page 123), or to make static volume settings for an event on the info line or with the volume handle (see “About the volume handle” on page 119).

About the level meters for audio channels

When playing back audio in Cubase, the level meters in the Mixer show the level of each audio channel.

- Directly below the level meter is a small level readout – this shows the highest registered level in the signal. Click this to reset the peak levels.

- Peak levels can also be shown as static horizontal lines in the meter, see “Changing the meter characteristics” on page 162.

  Cubase uses 32 bit floating point processing internally, so there is virtually limitless headroom – signals can go way beyond 0dB without clipping. Having higher levels than 0dB for individual audio channels is therefore not a problem in itself. The audio quality will not be degraded by this.

However, when many high level signals are mixed in an output bus, this may require that you lower the output channel level a lot (see below). Therefore it is good practice to keep the maximum levels for individual audio channels roughly around 0dB.

⚠ When Direct Monitoring is used and the “Map input bus metering to Audio track (in Direct Monitoring)” option is activated in the Preferences dialog (VST–Metering page), the level meters in the Mixer show the level of the input bus instead.

About the level meters for input and output channels

Input and output channels have clipping indicators.

- When you are recording, clipping can occur when the analog signal is converted to digital in the audio hardware. With Cubase, it is also possible to get clipping in the signal being recorded to disk (when 16 or 24 bit record format is used and you have adjusted the Mixer settings for the input channel). For more information, see “Setting input levels” on page 94.

- In the output busses, the floating point audio is converted to the resolution of the audio hardware. In the integer audio domain, the maximum level is 0dB – higher levels cause the clipping indicator for each bus to light up. If the clipping indicators light up for a bus, this indicates actual clipping – digital distortion which is to be avoided.

⚠ If the clipping indicator lights up for an output channel, lower the level until the indicator is no longer lit.
About the Input Gain control

Each audio-related channel and input/output channel features an Input Gain knob. It controls the gain for the incoming signal, before EQ and effects.

The Input Gain knob is not meant to be used as a volume control in the Mixer, as it is not suited for continuous level adjustments during playback. However, it can be used to cut or boost the gain. This is useful in the following circumstances:

• To change the level of a signal before the effects section. The level going into certain effects can change the way the signal is affected. A compressor, for example, can be "driven" harder by raising the input gain.

• To boost the level of poorly recorded signals.

To change the input gain value, you need to press [Shift] before you can adjust the control (that way accidental gain changes are avoided). If you press [Alt]/[Option], you can adjust the Input Gain using a fader. Alternatively, you can directly enter a new value in the value field.

About the Input Phase control

Each audio-related channel and input/output channel has an Input Phase button (to the left of the Input Gain control). When this button is activated, the phase polarity is inverted for the signal. Use this to correct for balanced lines and mics that are wired backwards, or mics that are "out of phase" due to their positioning.

• Phase polarity is important when mixing together two similar signals.

If the signals are "out of phase" with respect to one another, there will be some cancellation in the resulting audio, producing a hollow sound with less low-frequency content.

Level meters for MIDI channels

The level meters for MIDI channels do not show actual volume levels. Instead, they indicate the velocity values of the notes played back on MIDI tracks.

MIDI tracks set to the same MIDI channel and output

If you have several MIDI tracks set to the same MIDI channel (and routed to the same MIDI output), making volume and pan settings for one of these MIDI tracks/Mixer channels also affects all other Mixer channels set to the same MIDI channel/output combination.

Using Solo and Mute

You can use the Mute and Solo buttons to silence one or several channels.

The following applies:

• The Mute button silences the selected channel. Clicking the Mute button again unmutes the channel. Several channels can be muted simultaneously. Muting group channels can have two different results depending on how the Preferences are set (see "Settings for group channels" on page 165).
• Clicking the Solo button for a channel mutes all other channels. A soloed channel is indicated by a lit Solo button, and also by the lit Global Solo icon on the common panel. Click the Solo button again to turn off Solo.

• Several channels can be soloed at the same time. However, if you press [Ctrl]/[Command] and click the Solo button for a channel, any other soloed channels are automatically un-soloed (i.e., this Solo mode is exclusive).

• [Alt]/[Option]-clicking a Solo button activates “Solo Defeat” for that channel. In this mode the channel will not be muted if you solo another channel. To turn off Solo Defeat, [Alt]/[Option]-click the Solo button again.

Solo Defeat is activated for this channel.

• You can un-mute or un-solo all channels simultaneously by clicking the Global Mute or Global Solo icon on the common panel.
Audio-specific procedures

This section describes the options and basic procedures regarding audio channels in the Mixer. The following graphic shows different types of (non-extended) audio-related channels (from left to right): an audio track, a group channel, an instrument track, an FX channel, and a VST instrument channel:

All audio-related channel types have the same channel strip layout, with the following exceptions:
- Only audio track channels have an Input Routing pop-up menu.
- Only audio and instrument track channels have Monitor and Record Enable buttons.
- Instrument track and VST instrument channels have an additional button for opening the instrument’s control panel.

About the Insert/EQ/Send indicators and bypass buttons

The three buttons in each audio channel strip have the following functionality:
- If an insert or send effect, or an EQ module is activated for a channel, the corresponding button is lit. The effect indicator buttons are blue, and the EQ indicator buttons are green.
- If you click any of these buttons when lit, the corresponding EQ or effects section is bypassed. Bypass is indicated by the color yellow. Clicking the button again deactivates bypass.

Options for extended audio channel strips

When using the extended view (see “Normal vs. extended channel strips” on page 148), the upper panel can be set to show different views for each audio-related channel strip. You can select what to display in the extended panel individually for each channel or globally for all channels.

The following views are available:
- A blank panel (“Empty”).
- The Inserts section, with 8 effect pop-up menus, a bypass and an edit button. The inserts can also be found in the Inspector and the Channel Settings window, see “Using Channel Settings” on page 158.
- The EQ section, either with value sliders (“EQs”) or as numerical settings with a curve display (“EQs curve”). These two views have exactly the same controls but different graphic layouts. The EQ section is also available in the Channel Settings window. For EQ parameter descriptions, see “Making EQ settings” on page 159.
- The Sends section, with 8 effect pop-up menus and send level value sliders. The sends can also be found in the Inspector and the Channel Settings window, see “Using Channel Settings” on page 158.
• You also have the option of displaying four sends at a time (the Sends 1–4 and 5–8 menu items). These modes offer the additional benefit of displaying send levels as dB values.

• Cubase only: The Panner section (where applicable). If the channel is routed to a surround bus, you can view a compact version of the SurroundPanner in the extended panel. Double-click on it to open the full SurroundPanner panel.

• The Meter section.
  Select the Meter option to view large level meters in the extended panel. These operate exactly like the regular meters.

• The Overview section.
  Select the Overview option if you want to know which insert effects, EQ modules, and send effects are activated for the channel. You can click the On/Off buttons to activate and deactivate the corresponding insert effect, EQ module, or send effect.

• Cubase only: The User Panel section.
  Select the User Panel option to view the available device panels for the audio track, including panels for inserted VST effects, see “Audio tracks” on page 40. You can access the available panels via the User pop-up menu in the extended Mixer panel.

In narrow mode, only the Channel Overview and the Meter sections can be shown in the extended channel strip. If you have selected any of the other options, the Channel Overview is displayed in narrow mode. When you switch back to wide mode, the corresponding settings become available again.

Listen mode (Cubase only)

Additionally to the Solo/Mute functions, which affect the actual mix, Cubase features a Listen function. It allows you to quickly check the signal coming from selected channels without interrupting and interfering with the actual mix.

For example, during a recording session this allows the sound engineer in the control room to attenuate the signal coming from one of the musicians while the recording continues undisturbed.

In the Control Room Mixer you can enable/disable the Listen function for the Phones and Control Room channels, decide whether the signal is read pre-fader or post-fader, and hear the signals from the listen-enabled channels in context by adding a dimmed version of the mix signal. For more information about the functions available in the Control Room Mixer, see “The Control Room Mixer” on page 177.

In the Mixer you can listen-enable any track by activating the corresponding Listen button:

• Clicking the Listen button for a channel routes that channel to the Control Room without interrupting the normal signal flow. A listen-enabled channel is indicated by a lit Listen button, and also by the lit global Listen button on the common panel.

  The Listen button for a channel strip and the global Listen button on the common panel

• Click the Listen button again to turn off Listen mode. You can also turn off Listen mode for all listen-enabled tracks at the same time by clicking the global Listen button on the common panel.

  In the Key Commands dialog (Mixer category) you can also set up a key command to enable/disable Listen for a channel (see “Key commands” on page 541).

Setting pan in the Mixer

For each audio-related channel with at least a stereo output configuration you will find a miniature pan control at the top of the channel strip. Cubase only: This control is different for stereo and surround configurations.

Panning channels with a stereo output configuration

The pan control at the top of stereo audio channel strips is used to position a channel in the stereo spectrum.

The stereo pan control

The following applies when using the pan control:

• To make fine pan adjustments, hold down [Shift] when you move the pan control.
• To select the (default) center pan position, hold down [Ctrl]/[Command] and click on the pan control.

• To view the pan settings in a separate window, where you can change the settings using sliders, double-click on the pan control.

**About the three stereo pan modes (Cubase only)**

By default, stereo pan controls the balance between the left and right channels. However, if you want to set pan independently for the left and right channel, you can select a different pan mode.

If you right-click in the pan control field for a stereo audio channel, you can select one of three pan modes:

- **Stereo Balance Panner** controls the balance between the left and right channels.
  - This is the default mode.

- If Stereo Dual Panner is selected, there will be two pan controls with the upper controlling pan for the left channel, and the lower controlling pan for the right channel.
  - This allows you to set pan independently for the left and right channels. Note that it is possible to reverse the left and right channels, i.e. the left channel can be panned to the right and vice versa. You can also "sum" two channels by setting them to the same pan position (i.e. mono). However, this will increase the volume of the signal.

- If Stereo Combined Panner is selected, the left and right pan positions are shown as two lines with a blue/gray area between them.
  - In this mode, the left and right pan controls are linked, and can be moved left and right like a single pan control (keeping their relative distance).

If you reverse the left and right channels, the area between the pan controls is red instead of blue/gray.

When moving combined pan controls so that the left or right pan control reaches its maximum pan value, it naturally cannot go any further. If you continue to move further in the same direction, only the other pan control will move, thus altering the set relative pan range until both channels are panned fully to one side. If you move the pan controls in the opposite direction without releasing the mouse, the previously set pan range will be restored.

- The pan settings made with the Dual Panner are reflected in the Combined Panner and vice versa.
- You can specify the default pan mode for inserted audio tracks in the Preferences dialog (VST page).

**About the “Stereo Pan Law” setting**

In the Project Setup dialog you will find a pop-up menu named “Stereo Pan Law”, which allows you to select one of several pan modes. These modes are required for power compensation. Without power compensation, the power of the sum of the left and right side is higher (louder) if a channel is panned center than if it is panned left or right.

To remedy this, the Stereo Pan Law setting allows you to attenuate signals panned center, by -6, -4.5 or -3 dB (default). Selecting the 0dB option effectively turns off constant-power panning. Experiment with the modes to see which fits best in a given situation. You can also select “Equal Power” on this pop-up menu, which means that the power of the signal will remain the same regardless of the pan setting.

**Panning multi-channel audio (Cubase only)**

Channels with a multi-channel output configuration feature a miniature SurroundPanner control at the top of the channel strip. For further information on multi-channel audio and the SurroundPanner V5, see the chapter “Surround sound (Cubase only)” on page 217.
Panning Bypass

You can bypass the panning for all audio-related track types. To do this, press [Shift]–[Alt]/[Option] and click on the pan setting for the respective channel (on the fader panel or in the extended Mixer view).

When panning is bypassed for a channel, the following happens:

- Mono channels are panned center.
- Stereo channels are panned left and right.
- Surround channels are panned center (Cubase only).

To deactivate Panning Bypass, simply press [Shift]-[Alt]/[Option] and click again.

Using Channel Settings

For each audio channel strip in the Mixer and in the Inspector and track list for each audio track, there is an Edit button (“e”).

Clicking this opens the VST Audio Channel Settings window. By default, this window contains:

- A section with eight insert effect slots (see “Audio effects” on page 187).
- Four EQ modules and an associated EQ curve display (see “Making EQ settings” on page 159).
- A section with eight sends (see “Audio effects” on page 187).
- A duplicate of the Mixer channel strip (without the extended panel but with the input and output settings panel).

You can customize the Channel Settings window, by showing/hiding the different panels and/or by changing their order:

- To specify which panels are shown or hidden, right-click in the Channel Settings window, and activate/deactivate the corresponding options on the Customize View submenu of the context menu.
- To change the order of the panels, select “Setup…” on the Customize View pop-up menu and use the “Move up” and “Move Down” buttons.

For further information, see the chapter “Customizing” on page 531.

Every channel has its own Channel Settings window (although you can view each in the same window if you like – see below).

Click the Edit button to open the Channel Settings window.

The Channel Settings window in its default configuration is used for the following operations:

- Apply equalization, see “Making EQ settings” on page 159.
- Apply send effects, see “Audio effects” on page 187.
- Apply insert effects, see “Audio effects” on page 187.
- Copy channel settings and apply them to another channel, see “Copying settings between audio channels” on page 161.

All channel settings are applied to both sides of a stereo channel.

Changing channels in the Channel Settings window

You can view any channel’s settings from a single window.

If the “Sync Project and Mixer Selection” option is activated in the Preferences dialog (Editing–Project & Mixer page), this can be done “automatically”:

- Open the Channel Settings window for a track and position it so that you can see both the Project window and the Channel Settings window.
Selecting a track in the Project window automatically selects the corresponding channel in the Mixer (and vice versa). If a Channel Settings window is open, this will immediately switch to show the settings for the selected channel. This allows you to have a single Channel Settings window open in a convenient position on the screen, and use it for all your EQ and channel effect settings.

You can also select a channel manually (thereby changing what is shown in the open Channel Settings window). Proceed as follows:

1. Open the Channel Settings window for any channel.
2. Open the “Choose Edit Channel” pop-up menu by clicking the arrow button to the left of the channel number at the top of the Fader view.
3. Select a channel from the pop-up menu to show the settings for that channel in the open Channel Settings window.

- Alternatively, you can select a channel in the Mixer by clicking its channel strip (make sure not to click on a control as this will change the respective parameter setting instead).

This selects the channel, and the Channel Settings window is updated.

- To open several Channel Settings windows at the same time, press [Alt]/[Option] and click the Edit buttons for the respective channels.

Making EQ settings

Each audio channel in Cubase has a built-in parametric equalizer with up to four bands. There are several ways to view and adjust the EQs:

- By selecting one of the EQ display modes from the View Options pop-up menu (“EQs” or “EQs Curve”) for the extended channel strip in the Mixer. These modes contain the same settings but present them in different ways:

  In “EQs” mode, the top value slider controls the gain, the middle controls frequency and the lower sets the filter type and the Q parameter for each EQ band.

  In “EQs Curve” mode, EQ settings are shown as a curve. Parameters are set by clicking on the value and adjusting with the fader that appears.

- By selecting the Equalizers or Equalizer Curve tab in the Inspector. The Equalizers section is similar to the EQs mode in the extended Mixer or the Equalizers section in the Channel Settings window, while the Equalizer Curve section shows a display in which you can “draw” an EQ curve. Setting EQ in the Inspector is only possible for track-based audio channels.

  By default, only the Equalizers tab is shown. To display the Equalizer Curve tab, right-click on an Inspector tab (not in the empty area below the Inspector) and activate the Equalizer Curve option.

- By using the Channel Settings window. This offers both parameter sliders and a clickable curve display (the Equalizer + Curve pane) and also lets you store and recall EQ presets.

Below we describe how to set up EQ in the Channel Settings window, but the parameters are the same in the Mixer and Inspector (apart from the presets and reset function, which are not available in the Mixer).
The Equalizers + Curve pane in the Channel Settings window consists of four EQ modules with parameter sliders, an EQ curve display and some additional functions at the top.

Using the parameter controls

1. Activate an EQ module by clicking its On/Off button. Although the modules have different default frequency values and different Q names, they all have the same frequency range (20Hz to 20kHz). The only difference between the modules is that you can specify different filter types for each individual module (see below).

2. Set the amount of cut or boost with the gain control – the upper slider. The range is ± 24dB.

3. Set the desired frequency with the frequency slider. This is the center frequency of the frequency range (20Hz to 20kHz) to be cut or boosted.

4. Click on the filter name above the bottom slider and select a filter type from the pop-up menu. The “eq1” and “eq4” bands can act as parametric, shelving, or high/low-pass filters, while “eq2” and “eq3” will always be parametric filters.

5. Set the Q value with the bottom slider. This determines the width of the affected frequency range. Higher values give narrower frequency ranges.

6. To invert an EQ band (i.e. reflect the curve along the x axis), click the Inverse button to the right of its On/Off button. This button is hidden when the EQ module is deactivated. This is very useful if you want to filter out unwanted noise. While looking for the frequency to omit, it sometimes helps to boost it in the first place (set the filter to positive gain). After you have found it, you can use the Inverse button to cancel it out.

7. If needed, you can activate and make settings for up to four modules.
   • Note that you can edit the values numerically as well, by clicking in a value field and entering the desired gain, frequency, or Q value.

Using the curve display

When you activate EQ modules and make settings, you will see that your settings are automatically reflected in the curve display above. You can also make settings directly in the curve (or combine the two methods any way you like):

1. To activate an EQ module, click in the curve display. This adds a curve point and one of the modules below is activated.

2. Make EQ settings by dragging the curve point in the display. This allows you to adjust gain (drag up or down) and frequency (drag left or right).

3. To set the Q parameter, press [Shift] and drag the mouse up or down. You will see the EQ curve become wider or narrower as you drag.
   • You can also restrict the editing by pressing [Ctrl]/[Command] (sets gain only) or [Alt]/[Option] (sets frequency only) while you drag the curve point.

4. To activate another EQ module, click somewhere else in the display and proceed as above.

5. To turn off an EQ module, double-click its curve point or drag it outside the display.

6. To invert the EQ curve (i.e. reflect it along the x axis), click the Inverse Equalizers button to the right of the curve display.
EQ bypass
Whenever one or several EQ modules are activated for a channel, the EQ button lights up in green in the Mixer channel strip, Inspector (Equalizer and Channel sections), track list, and Channel Settings window (top right corner of the EQ section).
You can also bypass all EQ modules. This is useful, as it allows you to compare the sound with and without EQ. Proceed as follows:

• In the Mixer, the track list and in the Channel section in the Inspector, click the EQs state button so that it turns yellow.
  To deactivate EQ bypass, click the button again, so that it turns green again.
• In the Inspector (Equalizers tab) and in the Channel Settings window, click the Bypass button (next to the EQ button) so that it turns yellow.
  Click again to deactivate EQ bypass mode.

EQ reset
On the Presets pop-up menu in the Channel Settings window and in the Inspector, you will find the Reset command. Select this to turn off all EQ modules and reset all EQ parameters to their default values.

Using EQ presets
Some useful basic presets are included with the program. You can use them as they are, or as a starting point for further “tweaking”.

• To call up a preset, pull down the presets pop-up menu in the Channel Settings window or in the Inspector and select one of the available presets.
• To store the current EQ settings as a preset, select “Save Preset…” from the Presets pop-up menu and enter the desired name for the preset in the dialog that opens.

• To rename the selected preset, select “Rename Preset” on the pop-up menu and enter a new name.
• To delete the selected preset, select “Remove Preset” on the pop-up menu.

You can also apply EQ (and Insert) settings from track presets, see “Applying inserts and EQ settings from track presets” on page 334.

EQ in the channel overview
If the Channel section is selected in the Inspector or if the Overview section is displayed in the extended Mixer view, you will get an overview of which EQ modules, insert effects and sends are activated for the channel.

By clicking on any of the module numbers (1 to 4), you can turn the corresponding EQ module on or off.

Copying settings between audio channels
It is possible to copy all channel settings for an audio channel and paste them to one or several other channels. This applies to all audio-based channel types. For example, you can copy EQ settings from an audio track and apply these to a group or VST instrument channel, if you want them to have the same sound.
Proceed as follows:

1. In the Mixer, select the channel you want to copy settings from.
2. On the common panel, click the “Copy First Selected Channel’s Settings” button.
3. Select the channel(s) you want to copy the settings to and click the “Paste Settings to Selected Channels” button (below the “Copy First Selected Channel Settings” button).

The settings are applied to the selected channel(s).

You can copy channel settings between different types of channels, but only those channels will be used for which corresponding settings are available in the target channel.

- For example, since input/output channels do not have send effects, copying from them will leave the sends settings in the target channel unaffected.
- In case of surround sound (Cubase only), any insert effects routed to surround speaker channels become muted when the settings are pasted to a mono or stereo channel.

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter). Note that you can turn this on or off by clicking in any audio level meter in the Mixer.

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
- If Hold Forever is activated, the peak levels are shown until meters are reset (by clicking the numerical peak display below the meter).

Changing the meter characteristics

On the Mixer context menu, there is a submenu named “Global Meter Settings”. Here you can make settings for the preferred meter characteristics, with the following options:

- If Hold Peaks is activated, the highest registered levels are “held” and are shown as static horizontal lines in the meter.
Saving and loading Mixer settings

It is possible to save complete Mixer settings for all or all selected audio-related channels in the Mixer. These can later be loaded into any project. Channel settings are saved as Mixer settings files. These have the file extension "*.vmx".

Saving selected channels or all Mixer settings

Right-clicking somewhere in the Mixer panel or in the Channel Settings window brings up the context menu where the following Save options can be found:

• “Save Selected Channels” will save all channel settings for the selected channels.
  The input/output routing is not saved.

• “Save All Mixer Settings” saves all channel settings for all channels.

When you select any of the above options, a standard file dialog opens where you can select a name and storage location on your disk for the file.

Loading selected channels

To load Mixer settings saved for selected channels, proceed as follows:

1. Select the same number of channels as when you saved your Mixer settings.

2. Open the Mixer context menu and select “Load Selected Channels”.
   A standard file dialog opens, allowing you to locate the saved file.

3. Select the file and click Open.
   The channel settings are applied to the selected channels.

⚠️ When applying Mixer settings to fewer channels than Mixer settings available in the saved file, some of the saved settings are not needed and will be “left over”. Since the saved settings are applied from “left to right” (as shown in the Mixer), the settings for the channels furthest to the right are the ones that are not applied to any channels.

Loading all Mixer settings

Selecting “Load All Mixer Settings” from the context menu allows you to open a saved Mixer settings file, and have the stored settings applied to all channels for which information is included in the file. All channels, output settings, VST instruments, sends and “master” effects will be affected.

⚠️ This function does not automatically add channels! For example, if the saved Mixer settings are for 24 channels, and the Mixer you apply it to contains 16 channels, only the settings for channels 1 to 16 are applied.
Routing

When you play back an audio track (or any other audio-related channel), you route it to an output bus. In the same way, when you record on an audio track you select from which input bus the audio is received.

The input and output routing for a channel can be set up via the Inspector or the Mixer. For large projects, it is convenient to use the Mixer for this, since it allows you to set inputs and outputs for multiple channels at the same time.

• In the Inspector, you can select input and output busses using the Input and Output Routing pop-up menus.

• In the Mixer, you can select busses in the routing panel at the top of each channel strip.

For more information about the routing panel, see “Normal vs. extended channel strips” on page 148.

• If you press [Shift]-[Alt]/[Option] and select an input or output bus in the track list or the routing panel in the Mixer, it will be chosen for all selected channels.

This makes it easy to quickly set several channels to use the same input or output. Similarly, if you press [Shift] and select a bus, the following selected channels will be set to use incrementing busses – the second selected channel will use the second bus, the third will use the third bus and so on.

⚠️ For audio-related channel types other than audio track channels (e.g. VST instrument channels, group channels, and FX channels), only the Output Routing pop-up menu is available.

When selecting an input bus for a track you can only select busses that correspond to the track’s channel configuration. Here are the details for input busses:

- Mono tracks can be routed to mono input busses or individual channels within a stereo or surround input bus (Cubase only).
- Mono tracks can be routed to External Inputs configured on the Studio tab of the VST Connections window. These can be mono or individual channels within a stereo or surround bus (Cubase only). They can also be routed to the Talkback input.
- Mono tracks can also be routed to mono output busses, mono group output busses or mono FX channel output busses, provided that these will not lead to feedback.
- Stereo tracks can be routed to mono input busses, stereo input busses or stereo child busses within a surround bus (Cubase only).
- Stereo tracks can be routed to External Inputs that are configured in the Studio tab of the VST Connections window. These can be mono input busses or stereo input busses. They can also be routed to the Talkback input.
- Stereo tracks can also be routed to mono or stereo output busses, mono or stereo group output busses and mono or stereo FX channel output busses, provided that these will not lead to feedback.
- Surround tracks can be routed to surround input busses (Cubase only).
- Surround tracks can be routed to External Inputs that are configured in the Studio tab of the VST Connections window, provided that these have the same input configuration (Cubase only).
- Surround tracks can also be routed to output busses, provided that these have the same input configuration or will not lead to feedback (Cubase only).

For output busses any assignment is possible.

⚠️ Assignments that will lead to feedback are not available in the pop-up menu. This is also indicated by a one-way symbol.

To disconnect input or output bus assignments, select “No Bus” from the corresponding pop-up menu.
Routing audio to output busses in the Mixer

Output busses let you route audio from the program to the outputs on your audio hardware. To route the output of an audio channel to one of the active busses, proceed as follows:

1. Make sure that the routing panel is visible (see “Normal vs. extended channel strips” on page 148).
2. Pull down the Output Routing pop-up menu at the top of the channel strip and select one of the busses. This pop-up menu contains the output busses configured in the VST Connections window, as well as available group channels (provided that the busses and groups are compatible with the speaker configuration for the channel – see “Routing” on page 164).

For details on routing surround channels (Cubase only), see “Routing” on page 219.

Using group channels

You can route the outputs from multiple audio channels to a group. This enables you to control the channel levels using one fader, apply the same effects and equalization to all the channels, etc.

For example, group channels can be used as “effect racks” (see the chapter “Audio effects” on page 187).

To set up a group channel, proceed as follows:

1. Pull down the Project menu, open the Add Track submenu and select the “Group Channel…” option.
2. Select the desired channel configuration and click the Add Track button. A group channel track is added to the track list and a corresponding group channel strip is added to the Mixer. By default, the first group channel strip is labeled “Group 1”, but you can rename it just like any channel in the Mixer.
3. Pull down the Output Routing pop-up menu for a channel you want to route to the group channel, and select the group channel. The output of the audio channel is now redirected to the selected group.
4. Do the same for the other channels you wish to route to the group.

You can select a group channel as input for an audio track, e.g. to record a downmix of separate tracks (see “Recording from busses (Cubase only)” on page 94).

Settings for group channels

The group channel strips are almost identical to audio channel strips in the Mixer. The descriptions of the Mixer features earlier in this chapter apply to group channels as well. Some things to note:

- You can route the output of a group to an audio channel (see “Recording from busses (Cubase only)” on page 94), to an output bus or to another group.
- You cannot route a group to itself.
- There are no Input Routing pop-up menus, Monitor buttons or Record Enable buttons for group channels.
- Solo functionality is automatically linked for channels routed to a group and the group channel itself. This means that if you solo a group channel, all channels routed to the group are automatically soloed as well. Similarly, soloing a channel routed to a group will automatically solo the group channel.
- Mute functionality depends on the “Group Channels: Mute Sources as well” setting in the Preferences dialog (VST page).

By default, when you mute a group channel, no audio will pass through the group. However, other channels that are routed directly to that group channel will remain unmuted. If any of those channels have aux sends routed to other group channels, FX channels or output busses, those will still be heard.

If the “Group Channels: Mute Sources as well” option is activated in the Preferences dialog (VST page), muting a group channel will cause all other channels directly routed to it to be muted as well. Clicking the Mute button again will unmute the group channel and all other channels directly routed to it. Channels that were muted prior to the group channel being muted will not remember their mute state and become unmuted with the group channel.

⚠️ The “Group Channels: Mute Sources as well” option does not affect how mute automation is written. Writing mute automation for a group channel only affects the group channel and not the channels routed to it. When writing automation, you will see the other channels being muted as well upon muting a group channel. However, during playback, only the group channel will respond to the automation.
### MIDI-specific procedures

This section describes basic procedures for MIDI channels in the Mixer.

#### MIDI channel strips

The MIDI channel strips allow you to control volume and pan in your MIDI instrument (provided that the instrument is set up to receive the corresponding MIDI messages). The settings here are also available in the Inspector for MIDI tracks.

#### Options for extended MIDI channel strips

When using the extended view (see “Normal vs. extended channel strips” on page 148), the upper panel can be set to show different views for each MIDI channel strip. You can select what to display in the extended panel individually for each channel or globally for all channels (see “Configuring the extended channel strips” on page 149). The following views are available:

- A blank panel (“Empty”).
- The Inserts section, with 4 insert effect slots for the channel.
- The Sends section, with 4 send effect slots for the channel.
- The Meter section.
- The Overview section.
- Cubase only: The User Panel section.

If you select the EQ, the Studio Sends, or the SurroundPanners (Cubase only) option on the common panel, the view for MIDI channels does not change. These apply to audio-related channels only.

#### Panning MIDI channels

For MIDI channels, the pan control sends out MIDI pan messages. The result depends on how your MIDI instrument is set to respond to pan – check your documentation for details.

#### Using Channel Settings

For each MIDI channel strip in the Mixer (and MIDI track in the track list or the Inspector), there is an Edit (“e”) button. Clicking this opens the MIDI Channel Settings window.

By default, this window contains a duplicate of the Mixer channel strip, a section with four MIDI inserts and a section with four MIDI send effects.

You can customize the Channel Settings window by showing/hiding the different panels and/or by changing their order:

- To specify which panels are shown or hidden, right-click in the Channel Settings window and activate/deactivate the corresponding options on the Customize View submenu of the context menu.
- To change the order of the panels, select Setup on the Customize View pop-up menu and use the “Move up” and “Move Down” buttons in the dialog that opens.
Every MIDI channel has its own Channel Settings window.

Utilities

Link/Unlink channels

This function is used to “link” selected channels in the Mixer so that any change applied to one channel will be mirrored by all channels in that group. Only channels of the same type (audio-related or MIDI) can be linked with each other. You can link as many channels as you like, and you can also create as many groups of linked channels as you like. To link channels in the Mixer, proceed as follows:

1. Press [Ctrl]/[Command] and click on all the channels you want to link. [Shift]-clicking allows you to select a continuous range of channels.

2. On the Mixer context menu, select the Link Channels option.

- To unlink channels, select one of the linked channels and select “Unlink Channels” from the Mixer context menu.

The channels are unlinked. Note that you do not have to select all the channels that are linked, only one of them.

- It is not possible to remove individual channels from the link.
What will be linked?

The following rules apply to linked channels:

- Only level, mute, solo, select, monitor and record enable will be linked between channels.
  Effect/EQ/pan/input and output routing settings are not linked.

- Any individual channel settings you have made before linking will remain until you alter the same setting for any of the linked channels.
  For example, if you link three channels and one of them was muted at the time you applied the Link Channel function, this channel will remain muted after linking. However, if you mute another channel, all linked channels will be muted.

- Fader levels will be “ganged”.
  The relative level offset between channels will be kept if you move a linked channel fader.

  The three channels shown are linked. Moving one fader changes the levels for all three channels, but keeps the relative level mix.

- By pressing [Alt]/[Option], you can make individual settings and changes for channels that are linked.

Linked channels have individual automation tracks.
These are completely independent, and are not affected by the Link function.
VST Mixer Diagrams

⚠ Note that the AFL/PFL Listen Bus architecture is available only in Cubase.

Channel Objects
Control Room Objects (Cubase only)

Control Room Channel

- Monitoring Sources
- Signal Source
- Listen Dim
- Inserts 1 - 6
- Level, Dim, Ref, Mute
- Inserts 7 - 8
- Downmix (MixConvert)
- Monitor Channels 1 - 4

Monitor Channels

- Level Meter
- Control Room Channel
- Inserts 1 - 8
- Click Generator
- ASIO Output

Monitor Channels 1 - 4

The Mixer
Control Room (Cubase only)
Virtual Control Room – The concept

The concept behind the Control Room features in Cubase is to divide the studio environment into the performing area (studio) and the engineer/producer area (control room) common to traditional studios. Previously, an analog console or some method of speaker control and monitor routing was necessary to provide this functionality to the DAW environment.

With its Control Room Mixer and Control Room Overview features, Cubase provides all the functionality of the analog console’s monitoring section, along with many more features, in a virtual, VST-based audio environment where flexibility and instant recall are expected.

Control Room features

The following features are available for the Control Room Mixer:

- Support for up to four sets of monitors with various speaker configurations from mono up to 6.0 Music or Cine speaker systems.
- Dedicated Headphone output.
- Support for up to four discrete cue mix outputs called “Studios”.
- Dedicated Talkback channel with flexible routing and automatic record defeat.
- Support for up to six external inputs with configurations up to 6.0 surround.
- Click track routing and level control to all Control Room outputs.
- Flexible Listen bus options with the Listen Dim setting that allows listen-enabled tracks to be heard in context with the whole mix.
- Listen bus enabling on both Control Room and Headphone outputs.
- User-definable downmix settings using the MixConvert plug-in for all speaker configurations.
- Individual speaker soloing for all speaker configurations.
- Multiple inserts on each Control Room channel for metering and surround decoding among other possibilities.
- Monitor Dim function with adjustable level.
- User-defined Calibrated Monitor level for postproduction mixing in a calibrated environment.
- Adjustable Input Gain and Input Phase on all external inputs and Speaker outputs.
- Full-sized meters on every Control Room channel.
- Support for up to four aux sends (Studio Sends) for creation of discrete cue mixes for performers. Each Studio output has its own cue mix.
- The ability to disable the Control Room Section when working with an external monitoring solution or console.

Control Room operations

In traditional analog studios, the control room section of the console contained the most used set of controls in the whole studio.

The need to constantly be able to switch monitoring sources, adjust the volume of monitors and route various cue mixes and other sources to headphone systems is the norm in most sessions. Meeting the needs of several performers in the studio plus a producer and the engineer becomes a constant task that requires flexibility and ease of operation. Communication between everyone must be flawlessly clear without intruding on the creativity of performers.

The Cubase Control Room Mixer is designed to fill those needs with a simple yet highly flexible solution. The virtual mixing environment of VST is the ideal solution to the varied needs of a control room matrix. With a virtual mixer, a high degree of customization and precise settings are possible with the ability to completely recall these settings at any time.

Configuring the Control Room

The Control Room features are configured in several locations within Cubase.

- The hardware inputs and outputs for the Control Room channels are defined in the VST Connections window on the Studio tab. Here you can also enable and disable the Control Room.
- The Control Room Overview gives you a visual overview of the Control Room channels and signal flow. It is opened via the Devices menu.
- The Control Room Mixer allows operation of the Control Room features. It can be opened from the Project window toolbar (Media & Mixer Windows section), the Devices menu, or the Studio tab in the VST Connections window.
- Some general Control Room settings can be found in the Preferences dialog (VST–Control Room page).
VST Connections – Studio tab

The Studio tab of the VST Connections window is where you configure the inputs and outputs for the Control Room Mixer. You can also enable or disable the Control Room and open the Control Room Mixer. The channel width of the Control Room channel is shown in the Configuration field on the top right of the tab. For more information about the VST Connections window, see the chapter “VST Connections” on page 25.

The Studio tab of the VST Connections window showing several Control Room channels

By default, one stereo Monitor channel is created after installing Cubase.

About the Control Room channels

There are different types of channels that you can create, each defining either an input or output of the Control Room Mixer. As more channels are created, the Control Room Mixer expands to display controls for each channel.

Of all Control Room channels only Monitor channels can share hardware inputs or outputs with another bus or channel, as defined in the VST Connections window (see “Adding input and output busses” on page 28). As you create connections for each Monitor channel, those device ports that have already been used for other busses or channels are shown in red on the Device Port pop-up menu. If you select a port marked in red, the previous connection of this port is lost.

In order to avoid confusion due to suddenly missing port connections on other tabs, you may want to set all the outputs to “Not Assigned” while the Control Room is being set up.

Monitors

Each Monitor channel is a set of outputs that are connected to monitor speakers in the Control Room. Up to four Monitor channels can be created for the different sets of speakers in a studio. Monitor channels can be configured for a mono, stereo or up to 6.0 surround speaker configuration.

The Control Room Mixer allows you to switch speakers easily. Each set of Monitors can have its own custom downmix settings, input gain and input phase adjustments.

Phones

The Phones channel is used by the engineer in the control room for checking cue mixes and as another option for listening to the mix or external inputs on a pair of headphones. Furthermore, the Phones channel can be used for previewing, see “Control Room preferences” on page 182. It is not intended for cue mixes that performers use while recording.

The Phones channel is stereo only.

Studios

Studio channels are intended for sending cue mixes to performers in the studio during recording. They have talkback and click functions and can monitor the main mix, external inputs or a dedicated cue mix. Up to four Studios can be created allowing four discrete cue mixes for performers.

For example, if you have two available headphone amplifiers for performers to use, create two Studio channels, one for each headphone mix.

Studio channels can either be mono or stereo.

External inputs

External inputs are used for monitoring external devices such as CD players, multi-channel recorders or any other audio source. Up to six external inputs can be created with various configurations from mono up to 6.0 surround.

If you select external inputs as input source of an audio channel, you can record them. In this case, you will not need to assign the device ports to the input channel (see “Routing” on page 164).
Talkback

The Talkback is a mono input used for a communications system between the control room and performers in the studio. Only one mono Talkback channel is available.

The Talkback channel can be routed to each Studio channel with variable levels in order to optimize communication between the control room and performers.

Additionally, the Talkback is available as a possible input source for audio tracks. You can record from the Talkback just like any other input.

Inserts are available on the Talkback and all other Control Room channels. A compressor/limiter can be inserted on the Talkback channel to ensure that erratic levels do not bother performers and clear communication with everyone is possible.

Creating a Control Room channel

To create a new channel for the Control Room, proceed as follows:

1. Open the Studio tab of the VST Connections window and click the Add Channel button. A pop-up menu lists all available channel types along with how many of each type are available.

   Instead of clicking the Add Channel button you can also select a channel type on the context menu of the Studio tab.

2. Select the type of channel you wish to create. For most channel types a dialog opens, allowing you to choose the configuration of the channel (stereo, 5.1, etc.).

The new channel is displayed in the VST Connections window. For each audio path an audio device must be selected. You can assign device ports to channels in the same fashion as assigning any VST connection.

Note that the port assignments for all Control Room channels except Monitor channels are exclusive, meaning that you cannot assign the same device port to any bus or channel and a Control Room channel at the same time.

Exclusive assignment of Monitor channels

Even though the port assignment to the Control Room channels is generally exclusive, it might be useful to create Monitor channels that share device ports with each other as well as inputs and outputs. This can be helpful if you use the same speakers as a stereo pair and also as the left and right channels of a surround speaker configuration. Switching between monitors that share device ports will be seamless, providing any downmix of multi-channel audio to stereo if needed. Only one monitor set can be active at a time.

If your scenario does not require you to assign ports to several Monitor channels, it is recommended to activate the “Exclusive Device Ports for Monitor Channels” option in the Preferences dialog (VST–Control Room page). This way you can make sure that you do not accidentally assign ports to inputs/outputs and Monitor channels at the same time.

The state of the “Exclusive Device Ports for Monitor Channels” preference is saved together with the Control Room presets. Therefore, if you recall a preset, your current setting in the Preferences dialog might be overwritten.

Outputs – Main Mix

For the Control Room to function correctly, the Main Mix on the Outputs tab must be assigned to the set of outputs that actually contains your final mix signal. If you only have one output bus, it will be the Main Mix by default.

If you have more than one output bus defined, you can choose another bus as Main Mix by right-clicking on the name of the output and selecting “Set ‘Out’ as Main Mix”. The Main Mix is marked by a small speaker icon to the left of its name.

Note that the port assignments for all Control Room channels except Monitor channels are exclusive, meaning that you cannot assign the same device port to any bus or channel and a Control Room channel at the same time.

Inserts are available on the Talkback and all other Control Room channels. A compressor/limiter can be inserted on the Talkback channel to ensure that erratic levels do not bother performers and clear communication with everyone is possible.

Selecting an output bus as Main Mix in the VST Connections window.

Outputs other than the Main Mix are not routed through the Control Room Mixer.
Output click enabling

There may be a situation when you want the click to be routed always to a specific output bus, regardless of the actual Control Room settings, or indeed when the Control Room is disabled. In these cases, enable the click on specific outputs using the Click column on the Outputs tab in the VST Connections window.

![Image showing the Outputs tab with Main Mix and a second surround output that is click enabled.](image)

Disabling the Control Room

Once you have created all the channels for your studio configuration, the Control Room functions are available for use. If you need to use Cubase without the Control Room functions, you can simply disable the Control Room using the On/Off button on the Studio tab of the VST Connections window. Any channels you have created are saved, and when you enable the Control Room again, that configuration is reloaded.

![Image showing the Studio tab with Control Room disabled.](image)

You can also create presets for the Control Room configuration in the same manner as for inputs and outputs, see “Presets” on page 29.

⚠️ The click will only be heard in outputs that are assigned to device ports. Note that the click can also be routed to device ports using the Control Room features.

⚠️ Be aware that some audio interfaces allow very flexible routing within the hardware itself. Certain routing configurations can cause overloads and possible damage to speaker equipment. Consult the hardware documentation for further information.
The Control Room Mixer

The Control Room Mixer is where you can access all the features of the Control Room. It is designed to display information and controls only for the channels you have defined in the VST Connections window. For example, if you have not defined any Studio channels, they will not appear in the Control Room Mixer. If you want to see all possible channels, use the Control Room Overview instead (see “The Control Room Overview” on page 185).
The Control Room Mixer has a variety of controls, some that are similar to the Project Mixer and some that are unique to Control Room operations. In the following each control is briefly described:

1. Input Phase
   Each external input and Monitor speaker output has an Input Phase reversal switch. When lit, all audio paths within the channel have their phase reversed.

2. Input Gain
   Each external input, Monitor speaker output and the Talkback input has an Input Gain control. When an external input or Monitor becomes active, the Gain settings are recalled.

3. Channel inserts
   Each channel in the Control Room Mixer has inserts available. For detailed information about inserts in the Control Room Mixer, see “Configuring the Control Room Mixer” on page 180.

4. Channel configuration
   This displays the current configuration of audio paths in the channel, e.g. Stereo or 5.1.

5. Channel labels
   This displays the name of the channel as defined in the VST Connections window.

6. Expansion controls
   There are several arrow buttons that open and close additional panels of the Control Room Mixer. By default, the extended panels are hidden. For more information, see “Configuring the Control Room Mixer” on page 180.

7. Control Room and Headphone input selectors
   These buttons allow you to select input sources for the Control Room and Headphone channels. The choices are External Input, Monitor Mix, or any one of the four Studio channels.

8. Use Reference Level
   When you click this button, the Control Room level is set to the reference level set in the Preferences dialog, e.g. a level for calibrated mixing environments such as film dubbing stages. Press [Alt]/[Option] and click this button to set the Reference Level setting in the Preferences dialog to the current Control Room level.

9. Show Meters/Inserts button
   This allows you to switch between the display of meters and inserts for the extended Mixer view.

10. Listen Bus AFL/PFL
    This button determines whether the signal of a listen-enabled channel is routed to the Control Room channel after applying the fader and pan settings (AFL) or before (PFL) (see “Listen mode (Cubase only)” on page 156).

11. Listen Activate/Deactivate All Listen
    When lit, this indicates that one or more channels in the Project Mixer are listen-enabled. Clicking this button deactivates Listen for all channels.

12. Listen DIM Level
    This gain control adjusts the volume of the Main Mix when channels have been put in Listen mode. This allows you to keep listen-enabled channels in context with the Main Mix. If the Listen DIM level is set to minus infinity, you will only hear the listen-enabled channels. Any other setting leaves the Main Mix at a lower level.

13. DIM Signal
    This turns the Control Room level down by a preset amount (the default setting is -30dB). This allows a quick reduction in monitor volume without disturbing the current monitor level. Clicking on the DIM button again returns the monitor level to the previous setting. The default value can be changed by adjusting the “Main Dim Volume” setting in the Preferences dialog (VST–Control Room page).

14. Activate Talkback
    Click the TALK button to turn on the Talkback system, allowing communication between the control room and performers in the studio. There are two modes of operation: momentary mode used by clicking and holding the Talk button, and latch mode where clicking once turns the Talkback on until you click it again to turn it off.

15. Talkback DIM Level
    When the Talkback is enabled, this control allows you to determine how much the output of all the channels in the Control Room Mixer is reduced. This prevents unwanted feedback. If the Talkback DIM level is set to 0dB, no change occurs in the Control Room channels.

16. Cycle Downmix Preset Selection
    The Control Room allows four different speaker downmix settings for auditioning with various speaker configurations. Clicking this button cycles through the four downmix presets. Various icons appear to show which preset is active.

17. Cycle Monitor Selection
    Pressing this button changes the Monitor selection to the next available set. As Monitors are changed, so are the downmix presets, Monitor inserts, Input Gain, and Input Phase controls associated with that Monitor set.

18. Listen Enable for Output
    This activates the Listen bus function for either the Control Room or Headphone output. If this is not enabled, the Listen bus will not be routed to that channel.

19. Listen Level for Output
    This level adjustment determines how loud Listen bus signals are when routed to the Control Room or Headphone output. Clicking on the number pops up a fader control for adjustment.

20. Activate channel buttons
    These buttons turn each channel’s output on or off. When lit, the channel is on.
21. Channel labels
These labels reflect the names entered in the VST Connections window.

22. Talkback Enable to Studio and talkback amount
In order for Talkback signals to be routed to a Studio, the Talkback Enable to Studio button must be lit. Clicking on it turns it on or off. When Talkback Enable is deactivated, the Talkback DIM setting has no effect on this output.

The value below the button controls the amount of Talkback signal fed to the output of each Studio.

23. Metronome Level and Pan
The Level and Pan controls determine how the Metronome will be heard in each channel. These controls are independent for each channel.

24. Activate Metronome Click
This determines whether click signals are sent to each channel. When lit, click signals will be heard in that output.

25. Channel Level control
This is the main volume for each Control Room output. These faders do not affect recording input levels or the Main Mix level for exporting mixdowns.

26. Studio input selectors
For Studio channels, the input choices are External Input, Aux (from Studio Sends), or Monitor Mix.

27. Signal Presence Indicators
In the Preferences dialog, there is an option to display these Signal Presence Indicators as a substitute for the full size meters.

28. External input selectors
Up to six external inputs are available. These buttons determine which external input is currently being used. The names for the external inputs are displayed here as they were entered in the VST Connections window.

29. Individual Speaker Solos
Each speaker icon is a solo button for that channel. [Shift]-clicking a speaker will solo all the speakers in that row (front or rear). [Ctrl]/[Command]-clicking on a speaker that is already soloed will mute that speaker and solo all other channels.

30. LFE Solo
The “+” icon solos the LFE channel.

31. Solo Left and Right/Front/Rear Channels
These buttons solo the left and right channels, the front channels, or the rear channels (from left to right).

32. Cancel Speaker Solo
This button defeats all speaker solos, resetting them to normal playback.

33. Listen to Rear Channels on Front Monitors
This button solos the rear channels and routes them to the front speakers.

34. Listen to Solo Channels on Center Monitor
When this button is enabled, all speakers that are soloed will be heard in the center channel if there is one in the configuration. If not (as with stereo) the soloed channel will be heard equally in both left and right speakers.

35. Open MixConvert Settings
Clicking on this tab opens the MixConvert plug-in used to downmix multi-channel signals for monitoring. With this plug-in you can modify the settings for each downmix preset.

Note that you can also double-click in the center of the speaker solo area to open the MixConvert plug-in.
36. Downmix Preset Selection
With these buttons you can select the downmix preset for the current Monitor. Automatic configuration of the downmix settings follows a logi
cal path. For example, if you have defined one set of 5.1 monitors and an
other set of stereo monitors, Cubase will create a 5.1 to stereo downmix
preset and another downmix to mono.

37. Downmix labels
This area displays the names of the four downmix presets. You can click
on a name to change it. A "?" appears when there is no preset defined
for that downmix.

38. Monitor selection
With these buttons you can select the current Monitor set. Each Monitor
has its own settings including downmix preset, solo enables, inserts, in-
put gain and input phase. These settings are automatically recalled when
a Monitor is selected.

39. Monitor labels
This area displays up to four Monitors. The names are entered in the VST
Connections window when you define a Monitor channel.

Configuring the Control Room Mixer
In order to display more controls in the Control Room
Mixer, the small arrows in the lower left and right corners
can be clicked to open or close the extended speaker
controls on the right ("Show Right Strip") and the External
Input and Talkback controls on the left ("Show Left Strip").

The arrow in the upper right corner of the Control Room
Mixer ("Show Extended View") extends the Mixer vertically
to display meters and inserts. A second arrow appears
above the inserts and meter display. Extending the Mixer
using this arrow ("Show Routing View") exposes the Input
Gain and Input Phase controls, the channel configuration
and the name of each channel. Each panel can be closed
by clicking the corresponding down arrow.

The different Control Room Mixer panels are handled in
the same way as the Project Mixer panels, see “Configur-
ing the Mixer” on page 148.

⚠️ You can also use the Window submenu of the Con-
trol Room Mixer context menu to show/hide the dif-
f erent panels, just as in the Project Mixer.

Control Room inserts and meters
In the extended view of the Control Room Mixer the me-
ters are visible. They function the same way as the ones in
the Project Mixer.

When you click the Show Meters/Inserts button to the right
of the meters display, the view changes to show inserts in-
stead of meters. Alternatively, these can also be displayed
by deactivating the Show Meters option on the Window
submenu of the Control Room Mixer context menu.

Each Control Room channel has a set of inserts configured
as six pre-fader and two post-fader inserts. External input
channels only have the six pre-fader inserts and Monitor
channels have eight inserts (post Control Room fader).

If you do not wish to see full sized meters but still want
some indication of signal activity, activate the “Signal
Presence Indicators” option in the Preferences dialog
(VST–Control Room page). They will be displayed next to
the input selection buttons and indicate signal presence
for all inputs.

Control Room Mixer channels with active Signal Presence indicators

Inserts for external inputs
Each external input has its own set of six inserts. By click-
ing the button next to the name of an external input on the
left of the Mixer window, the inserts associated with that
channel are displayed in the extended view.
Inserts for the Talkback channel

The Talkback channel has a separate set of eight inserts. In order to view and adjust them, the Talkback must be enabled via the TALK button located in the bottom right section of the Control Room Mixer. Click once on the TALK button to activate the Talkback system. The inserts for external inputs are now replaced with the Talkback inserts. Once the Talkback is disabled, the view reverts to external input inserts.

⚠️ You can easily identify the inserts for the Talkback since they have six pre-fader and two post-fader inserts while the external inputs only have six pre-fader inserts. If the Control Room Mixer is fully expanded, the name displayed at the very top of the Mixer reflects which channel is currently visible in the extended panel.

Monitor inserts

Each Monitor channel has a set of eight inserts, all of which are post Control Room fader. The Monitor inserts are most useful for surround decoding or brickwall limiting to protect sensitive monitor speakers.

The Main Mix and the Control Room channel

The channel configuration of the Main Mix determines the channel configuration of the Control Room channel. Switching between a project that has a stereo Main Mix to a project that has a 5.1 Main Mix will cause the Control Room channel in the Control Room Mixer to change from a stereo to a 5.1 configuration.

The Control Room configuration also determines the layout of the Speaker Solo panel. If the channel is stereo, the solo panel only contains a left and a right speaker.

Any external input that has more channels than the Main Mix will not be heard correctly when routed to the Control Room channel. Only the channels available will be heard.

⚠️ If a 5.1 external input is routed to a stereo Control Room channel, only the left and right channels are heard even if a 5.1 Monitor is selected. Only two channels can be routed through a stereo Control Room channel.

Suggested settings

With all the versatility that the Control Room provides there are also opportunities for confusion when first setting up the Control Room. The following list contains suggestions that can help to quickly set up the Control Room and get started for recording and mixing.

- If you do not have a master recording device and only use the Export Mixdown function to create final mix files, set your Main Mix output to “Not Assigned”. This eliminates many confusing errors and unpredictable behavior since outputs and Control Room Monitors can share hardware outputs. The Main Mix is automatically routed to the Control Room channel and will not be affected.
- Create one stereo Monitor to familiarize yourself with the Control Room level controls, DIM settings, the Listen bus, and other monitoring features. Once you have become acquainted with some of these functions, create additional Monitors for every set of speakers you intend to use.
- Use the inserts on Monitor channels for surround decoding and bass management plug-ins among other things.
- Use the inserts on the Control Room channel for metering and spectral analysis plug-ins. All solos including the Listen bus will come through the Control Room channel allowing analysis of individual sounds.
- A brickwall limiter in the last insert of the Control Room channel can prevent accidental overloads and damage to speaker systems.
- Use the inserts for the Talkback channel to control the dynamics of the talkback microphone. This will help protect performers’ hearing and ensure that everyone can be heard over the talkback microphone.
- Use the Gain settings on the external inputs to level balance CD players and other sources to the Main Mix level for A/B comparisons.
- Use the Gain settings on each Monitor to level balance all your monitor systems. Switching between sets of speakers will result in the same playback volume.
- Use the calibrated Control Room level for film or DVD mixing. Set this level to the proper speaker volume as determined by the mixing standard you choose to follow.
Control Room preferences

There are several preferences for the Control Room Mixer. These are found in the Preferences dialog (VST–Control Room page).

Most of these preferences deal with what options are visible in the Control Room Mixer. This allows you to customize the layout of the Mixer and only have the controls visible that you use the most.

The other preferences have the following functionality:

- **Show Control Room Volume in Transport Panel**
  This option makes the small fader at the right-hand side of the Transport panel control the Control Room level. When this option is not activated (or the Control Room is disabled), that fader controls the level of the Main Mix bus.

- **Disable Talkback during Recording**
  This option deactivates the Talkback channel when the transport enters record mode. It is advisable to set the Talkback DIM level to 0 dB when using this feature so as not to radically change the mix level when punching in and out of record mode.

- **Use Phones Channel as Preview Channel**
  When activated, the Headphone output is used for Preview options such as import preview, scrubbing, offline process preview and certain Sample Editor operations. Note that when using the Headphones output for preview, the Control Room channel will no longer output preview audio.

- **Dim Studio during Talkback**
  When this option is enabled, the cue mix heard in a Studio will be dimmed (by the amount set in the Talkback Dim Level field below the TALK button) for as long as the Talkback channel is used. When disabled, the cue mix level remains the same during Talkback.

- **Exclusive Device Ports for Monitor Channels**
  When activated, the port assignment for Monitor channels is exclusive (see “Exclusive assignment of Monitor channels” on page 175).

- **Reference Level**
  This setting determines the Control Room level used when the Reference Level button is activated.

- **Main Dim Volume**
  This is the amount of gain reduction applied to the Control Room channel when the DIM button is activated.

Studios and Studio Sends

Studio Sends are displayed in the Cubase Project Mixer and the Inspector. Each Studio Send is intended for the creation of a discrete cue mix for performers to listen to during recording. Studio Sends are essentially stereo aux sends that are routed to Studio outputs in the Control Room Mixer. There are up to four Studios and Studio Sends available.

Configuring Studio Sends

Studio Sends only become available when a Studio channel has been created in the VST Connections window. Otherwise they remain grayed out. For every Studio defined in the VST Connections, each channel in the Project Mixer has an additional aux send with level, pan and pre/post-fader selection. This aux send is used to create a mix for a performer to listen to while recording.

- In the Project Mixer, the Studio Sends are accessed by choosing the Studio Sends option from the View options pop-up menu in each channel or by clicking the star icon (“Show Studio Sends”) on the common panel of the extended Project Mixer.

The Studio Sends view in the Project Mixer
• In the Inspector, a Studio Sends tab can be found. This displays all Studio Sends for the selected track. Please note that not all Inspector sections are available by default. To show/hide a section, right-click on an Inspector section and select/deselect the corresponding option on the context menu.

The Studio Sends tab in the Inspector

Each Studio can have a unique name in order to help identify what it is being used for. For example, the four Studios could be named as follows:

• Vocalist Mix
• Guitarist Mix
• Bassist Mix
• Drummer’s Mix

The name of each Studio is displayed in the Control Room Mixer. To hear the Studio Sends mix in the Studio output, the input selector for each Studio must be set to “Aux”.

A Studio channel in the Control Room Mixer with its input set to Aux.

Setting up a Studio cue mix

The Studio Sends are very flexible. There are several ways to create a cue mix for each Studio in a very fast and efficient manner. Simple “more me” mixes and more complex discrete mixes are easily accommodated by the Studio Sends.

Using fader and pan settings from the Project Mixer

You can create a cue mix from the fader and pan levels already used in the Project Mixer and then alter them to meet the needs of an individual performer. You can do this with any single channel or group of channels at any time.

To copy fader and pan information from the main mix, proceed as follows:

1. In the Project Mixer, select all the channels that you wish to copy settings from. The following operations affect only selected channels.

2. In the Control Room Mixer, right-click anywhere on a Studio channel strip to open the context menu that has the Studio’s name as a submenu. This submenu contains all the Studio Send functions for that Studio. If you open the context menu outside of a Studio channel strip, the submenu will be for All Studios.
The Control Room Mixer’s context menu

3. Choose the “Use Current Mix Levels” option to copy the fader levels on the selected tracks to the Studio Sends.
   This option sets all Studio Send levels for the selected tracks to the same level as the main channel fader. It also changes the Studio Send status to pre-fader so that changes in the main mix do not affect the Studio Sends.

4. Choose the “Use Current Pan Settings” option to copy pan information from the main mix to the Studio Sends on selected tracks.
   Studio Sends are either mono or stereo. If the Send is mono, the pan setting will still be copied. However, the output of the Studio Send will be a sum of the left and right channels.

5. Choose the “Enable Studio Sends” option to activate the Sends on selected channels.
   By default, Studio Sends are not enabled even when level and pan information is copied to them. You must enable them in order to hear the Studio cue mix.

   By copying the level and pan information from the main mix to the Studio Sends, a rough balance can be created in a matter of moments. Next, you may alter the level and pan settings on any channel’s Studio Sends to change the mix to meet the performer’s needs. This may require increasing the volume of the performer herself. This is often referred to as a “more me” mix.

   Adjusting the overall Studio Send level

   Levels in the main mix are often optimized for the loudest signal level possible without clipping. However, when you are creating a “more me” mix, you may find that there is not enough headroom available in the Studio Send to turn up channels without clipping becoming a possibility.

   Fortunately, the Studio Sends have an option to adjust multiple send levels at the same time, allowing you to keep the blend intact while lowering the overall volume to make room for “more me” signals.

   Once you have created a Studio Send mix, proceed as follows to adjust their relative levels:

   1. Select all the channels you wish to modify.
      Only selected channels are affected by the context menu commands.

   2. Right-click anywhere on the Studio channel strip in the Control Room Mixer to open the context menu for that Studio channel.
      You may also use the context menu outside of the Studio channel strip to adjust all four Studio Sends on the selected channels at the same time.

   3. Choose the “Change Studio Sends Level” option from the Studio submenu.
      This will bring up a gain window with a checkbox that reads “Relative Mode”. Make sure this is activated if you want to adjust already existing levels.

   4. Either use the up and down arrow buttons or click on the numeric readout to display a pop-up fader and adjust the gain as necessary.
      The level of all selected Studio Sends will be adjusted by the amount shown here. For example, if the amount reads -3dB, each Studio Send level is reduced by 3dB.

   5. Click OK to change the level.
      It is possible to view these changes as they occur if you have the Project Mixer open and the extended view set to show the Studio Sends.

   ! If you deactivate the Relative Mode option, all Studio Sends are set to the same absolute level. While the dialog window is still open, you may activate the Relative Mode checkbox again and reload the previous relative levels. Only when you click OK, the level settings are made permanent. Clicking Cancel returns all send levels to their previous settings.
Using Studio Sends from outputs

Each output also has Studio Sends. Studio Sends from the Main Mix output can be used to route the main mix instantly to the Studio output.

Any level changes made to the main mix are reflected in the signal sent by the Studio Send. Setting the level lower than 0 dB can leave headroom for “more me” signals in the Studio channel output.

Post-Fader Studio Sends

It is also possible to use the Studio Sends as post-fader aux sends. This is another way for the cue mix to follow changes made to the Main Mix. The Reset function is very helpful in this regard.

To reset the Studio Sends to the post-fader default level of -6 dB, proceed as follows:

1. Select all the channels you wish to reset. Studio Send commands only work on selected channels.
2. On the Studio channel strip right-click to open the context menu. In the Studio submenu, select the “Reset Studio Sends” command.
3. Selecting the “Reset Studio Sends” option changes the Send level of all selected channels to -6 dB and sets the signal source to post-fader.

Once all Studio Sends have been set to -6 dB, post-fader, any changes to the main mix will also change the Studio mix. For “more me” channels, simply turn up the level on that channel or even set the signal to pre-fader for absolute control.

Studio Send cue mix summary

Using various combinations of the above techniques allows you to create complex discrete cue mixes for performers in very little time. Modifications to these mixes can occur in the Project Mixer or the Inspector, giving you the most accessibility for quick changes.

To familiarize yourself with how the Studio Sends work, open the extended Project Mixer and set the view to the Studio Sends. Follow the above examples and watch how the Studio Sends react to various commands. This should help you get a feel for how they function and increase the workflow productivity of recording sessions.

The Control Room Overview

You can access the Control Room Overview from the Devices menu. The Control Room Overview is designed to display the current configuration of the Control Room. The window shows all possible channels, with active channels highlighted once they have been created in the VST Connections window. Channels that are grayed out have not been defined in the VST Connections window.

The Control Room Overview allows you to see the signal flow through the Control Room Mixer. All the routing functions of the Control Room Mixer are duplicated in the Overview.

Open the Control Room Mixer and the Control Room Overview windows side by side. As you operate the controls in the Mixer you will see the various pale squares light up in the Overview, indicating changes in signal flow. You can also click the squares in the Overview and watch the controls in the Mixer reflect the changes in signal flow.
Direct Monitoring and latency

The Control Room and Studio Sends functions use the internal processing power of the host computer system for all routing and processing, which means they are subject to the computer’s latency.

When recording with several performers at once, a system capable of running at very low ASIO buffer settings will be necessary to take full advantage of all the Studio Send features.

Studio Sends are not capable of controlling the Direct Monitoring features of various audio hardware interfaces. This means that unless the internal latency of the system is very low (128 samples or less), monitoring of record-enabled tracks through the Studio Sends will have some delay that can affect performers during recording.

In the situation where internal latency is too much for record monitoring, it is advisable to use the Studio Sends for monitoring of tracks that have already been recorded and use normal Direct Monitoring for tracks currently being recorded.
Audio effects
About this chapter

Cubase comes with a number of effect plug-ins included. This chapter contains general details about how to assign, use and organize effect plug-ins. The effects and their parameters are described in the separate PDF document “Plug-in Reference”.

⚠️ This chapter describes audio effects, i.e. effects that are used to process audio, group, VST instrument, and ReWire channels.

Overview

Audio effects can be used in Cubase as follows:

- **As insert effects.**
  An insert effect is inserted into the signal chain of an audio channel, which means that the whole channel signal passes through the effect. This makes inserts suitable for effects for which you do not need to mix dry and wet sound, e.g. distortion, filters or other effects that change the tonal or dynamic characteristics of the sound. You can have up to eight different insert effects per channel (and the same is true for input and output busses – for recording with effects and “master effects”, respectively).

- **As send effects.**
  Each audio channel has eight sends, each of which can be freely routed to an effect (or to a chain of effects). Send effects are practical for two reasons: you can control the balance between the dry (direct) and wet (processed) sound individually for each channel using the sends, and several different audio channels can use the same send effect. In Cubase, send effects are handled by means of FX channel tracks.

- **By using offline processing (Cubase only).**
  You can apply effects directly to individual audio events – this is described in the chapter “Audio processing and functions” on page 244.

About VST 3

The VST 3 plug-in standard offers many improvements over the previous VST 2 standard and yet retains full backwards compatibility.

In the program, effects compatible with previous VST versions will be easily recognized:

ι This functionality is provided to allow you to load older projects including their original plug-ins on current computers. However, the plug-ins will require higher CPU performance when compared to their native platform. Therefore, it is recommended to use 64-bit versions of such plug-ins or instruments once available.

Smart plug-in processing

The VST3 standard features “smart” plug-in processing, i.e., processing by a plug-in can be disengaged if there is no signal present. This can greatly reduce the CPU load, thus allowing for more effects to be used.

This is achieved by activating the “Suspend VST3 plug-in processing when no audio signals are received” option in the Preferences dialog (VST–Plug-ins page).

When this is activated, VST 3 plug-ins will not consume CPU power on silent passages, i.e. when no audio data runs through them.
However, be aware that this can lead to a situation where you added more plug-ins on “transport stop” than the system can handle on playback. Therefore, you should always find the passage with the largest number of events playing simultaneously to make sure that your system offers the required performance.

Activating this option can increase your system performance a lot in certain projects, but it also makes it more unpredictable whether the project can play back fine on any timecode position of the project.

About side-chain inputs
Several VST3 effects feature side-chain inputs. This means that the operation of the effect can be controlled via external signals routed to the side-chain input. The effect processing is still applied to the main audio signal, see “Using the side-chain input” on page 198.

About plug-in delay compensation
A plug-in effect may have some inherent delay or latency. This means that it takes a brief time for the plug-in to process the audio fed into it – as a result, the output audio will be slightly delayed. This especially applies to dynamics processors featuring “look-ahead” functionality.

Cubase provides full plug-in delay compensation throughout the entire audio path. All plug-in delays are compensated for, maintaining the sync and timing of all audio channels.

Normally, you do not have to make any settings for this. However, VST3 dynamics plug-ins with look-ahead functionality have a “Live” button, allowing you to disengage the look-ahead to minimize latency, if they are to be used during realtime recording (see the separate PDF document “Plug-in Reference”).

You can also constrain the delay compensation, which is useful to avoid latency when recording audio or playing a VST instrument in real time, see “Constrain Delay Compensation” on page 216.

About tempo sync
Plug-ins can receive timing and tempo information from the host application (in this case, Cubase). Typically, this is used to synchronize certain plug-in parameters (such as modulation rates or delay times) to the project tempo.

- This information is automatically provided to any VST plug-in (2.0 or later) that “requests it”.
  You do not have to make any special settings for this.

- You set up tempo sync by specifying a base note value. You can use straight, triplet or dotted note values (1/1 to 1/32).

Please refer to the separate PDF document “Plug-in Reference” for details about the included effects.

Insert effects

Background
As the name implies, insert effects are inserted into the audio signal path – this means that the audio channel data will be routed through the effect. You can add up to eight different insert effects independently for each audio-related channel (audio track, group channel track, FX channel track, VST instrument channel or ReWire channel) or output bus. The signal passes through the effects in series from the top downwards, with the signal path shown below:
As you can see, the last two insert slots (for any channel) are post-EQ and post-fader. Post-fader slots are best suited for insert effects where you do not want the level to be changed after the effect, such as dithering (see “Dithering” on page 193) and maximizers – both typically used as insert effects for output busses.

Applying several effects on several channels may be too much for your CPU to handle! If you want to use the same effect with the same settings on several channels, it may be more efficient to set up a group channel and to apply your effect only once, as a single insert for this group. You can use the VST Performance window to keep an eye on the CPU load.

**Routing an audio channel or bus through insert effects**

Insert effect settings are available in the Mixer (in extended mode), the Channel Settings window and the Inspector. The examples below show the Channel Settings window, but the procedures are the same for all the inserts sections:

1. Bring up the Channel Settings window.
   By default, the inserts are located to the far left.
2. Pull down the effect type pop-up menu for one of the insert slots, and select an effect.

The effect is loaded and automatically activated and its control panel opens. You can open or close the control panel for an effect by clicking the “e” button for the insert slot.

- If the effect has a dry/wet Mix parameter, you can use this to adjust the balance between the dry signal and the effect signal.
  
  See “Editing effects” on page 200 for details about editing effects.

- To remove an effect, pull down the effect type pop-up menu and select “No Effect”.
  
  To reduce the CPU load, do this for all effects that you do not intend to use.

- You can add up to 8 insert effects per channel this way.

- You can reorder the effects by clicking in the area above the name field and dragging the effect onto another slot.

- You can copy an effect into another effect slot (for the same channel or between channels) by holding down [Ctrl]/[Command] and dragging it onto another effect slot.

- Cubase only: You can apply or remove an effect to or from all the selected channels at once by holding down [Shift]-[Alt]/[Option] and selecting the desired effect from any of the effect slots.

**Deactivating vs. bypassing**

If you want to listen to the track without having it processed by a particular effect, but do not want to remove this effect completely from the insert slot, you can either deactivate or bypass it.

Deactivating means to terminate all processing, whereas bypassing means to play back only the unprocessed original signal – a bypassed effect is still processing in the background. Bypassing allows for crackle-free comparison of the original (“dry”) and the processed (“wet”) signal.

- To deactivate an effect, click the blue button on the left above the insert slot.
  
  Cubase only: If you hold down [Shift]-[Alt]/[Option] when clicking the button, you activate or deactivate this effect slot for all selected channels.

- To bypass an effect, click its Bypass button (the middle button above the insert slot).
  
  When an effect is bypassed, this button is yellow.

- To deactivate an effect, click the blue button on the left above the insert slot.
  
  Cubase only: If you hold down [Shift]-[Alt]/[Option] when clicking the button, you activate or deactivate this effect slot for all selected channels.

- To bypass an effect, click its Bypass button (the middle button above the insert slot).
  
  When an effect is bypassed, this button is yellow.
To bypass all inserts for a track, click the “Bypass Inserts” button. This button can be found on the right of the title bar of the Inserts section in the Inspector or the Channel Settings window. It lights up in yellow to indicate that the inserts of this track are bypassed. In the track list and the channel strip in the Mixer, the Inserts State button will also light up in yellow.

Insert effects in the channel overview

If the “Channel” section is selected in the Inspector or the “Channel Overview” view mode is selected in the extended Mixer, you will get an overview of which insert effects, EQ modules and effect sends are activated for the channel.

You can activate or deactivate individual insert effect slots by clicking the corresponding number (in the top part of the overview).

Using effects in multi-channel configurations (Cubase only)

Whether an effect plug-in supports mono, stereo, or multi-channel processing depends on the capabilities of the corresponding plug-in. Regardless of this, all VST2 and VST3 plug-ins can be inserted on tracks with a multi-channel configuration. Surround-capable plug-ins are applied to all speaker channels (or a subset of these), while mono or stereo effects can only process one or two channels.

For example, if you insert a plug-in on a 5.1 track, Cubase tries to apply a 5.1 configuration to this plug-in. If the plug-in is surround capable, this is accepted. However, if you insert a stereo insert effect, the first speaker channels of the track (L and R) are routed through the effect’s available channels, and the other channels of the track are left unprocessed. To apply the effect to other speaker channels, you can use the Routing Editor, which can be opened via the Channel Settings window.

Using the Routing Editor

To open the Routing Editor, proceed as follows:

1. Open the Channel Settings window for the track on which the effect is inserted.
2. On the Channel Settings context menu, open the “Customize View” submenu and select the “Insert Routing” option. The “Insert Routing” section is displayed. It contains a signal diagram.
3. Double-click on the diagram. The Routing Editor opens.
The columns in the diagram represent the channels in the current configuration, with signals passing from top to bottom. The gray field in the middle represents the actual effect plug-in.

- The squares above the effect represent inputs to the effect plug-in.
- The squares below the effect represent outputs from the effect plug-in.
- A line that passes through the effect (with no square input/output indicators) represent a bypass connection – the audio on that speaker channel passes the effect without being processed.
- A “broken” line indicates a broken connection – the audio on that speaker channel will not be sent to the output at all.

Here, the effect will process the L and R channels. The Ls, Rs, and C channels are not processed, while the Lfe connection is broken.

**Operations**

You can change the input/output assignment of the channels by moving connections to the left or right. To do this, use the arrow buttons to the right.

- The upper arrow buttons move the input connections, and the lower arrow buttons move the output connections.
  If the Link checkbox is activated, the input and output connections are always moved together. This is the mode to use when you simply want to process other channels than the default.

- If you move inputs or outputs independently, you create a “cross-connection”.

The audio on the Ls-Rs channels is processed in the plug-in and output on the L-R channels. Since the L-R channels are bypassed, this means the final L-R output will contain both the original L-R signals and the processed Ls-Rs signals.

- If a channel is bypassed (a straight line is shown through the plug-in), you can click on the line to break the connection.
  Click again to replace the broken connection with a bypass.
- Clicking Reset takes you back to the original setup.
  Changes you make in this editor are audible immediately.

**Adding insert effects to busses**

All input and output busses have eight insert slots, just like regular audio channels. The procedures for adding insert effects are the same.

- Adding insert effects to an input bus allows you to record with effects.
  The effects will become a permanent part of the recorded audio file (see the chapter “Recording” on page 89).
- Insert effects added to an output bus will affect all audio routed to that bus, like a "master insert effect".
  Typically you would add compressors, limiters, EQ or other plug-ins to tailor the dynamics and sound of the final mix. Dithering is a special case, as described below.

Input and output busses only appear as tracks in the track list after their automation Write buttons have been activated at least once. Only then will you be able to make Inserts settings for the corresponding busses in the Inspector section. However, you can always make Inserts settings in the Channel Settings window and the extended Mixer panel.
**Dithering**

Dithering is a method for controlling the noise produced by quantization errors in digital recordings. The theory behind this is that during low level passages, only a few bits are used to represent the signal, which leads to quantization errors and hence distortion.

For example, when “truncating bits”, as a result of moving from 24 to 16 bit resolution, quantization errors are added to an otherwise immaculate recording. By adding a special kind of noise at an extremely low level, the effect of these errors is minimized. The added noise could be perceived as a very low-level hiss under exacting listening conditions. However, this is hardly noticeable and much preferred to the distortion that otherwise occurs.

**When should I use dithering?**

- Consider dithering when you mix down to a lower resolution, either in realtime (during playback) or with the Export Audio Mixdown function.

A typical example is when you mix down a project to a 16-bit stereo audio file for audio CD burning.

What is a “lower resolution” then? Well, Cubase uses 32-bit float resolution internally, which means that all integer resolutions (16 bit, 24 bit, etc.) are lower. The negative effects of truncation (no dithering) are most noticeable when mixing down to 8 bit, 16 bit and 20 bit format; whether to dither when mixing down to 24 bits is a matter of taste.

**Applying dithering**

1. Open the VST Output Channel Settings window by clicking the “e” button for the Output channel in the Mixer. You can also display the Inserts section in the extended Mixer pane.

2. Open the Inserts pop-up menu for slot 7 or 8. The two last Insert effect slots (for all channels) are post-fader, which is crucial for a dithering plug-in. The reason is that any master gain change applied after dithering would bring the signal back to the internal 32 bit float domain, rendering the dithering settings useless.

3. Select the included UV22HR plug-in from the pop-up menu.

The included dithering plug-ins and their parameters are described in the separate PDF document “Plug-in Reference”. If you have installed another dithering plug-in that you prefer, you can of course select this instead.

4. Make sure that the plug-in is set to dither to the correct resolution.

This would be the resolution of your audio hardware (on playback) or the desired resolution for the mixdown file you want to create (as set in the Export Audio Mixdown dialog, see the chapter “Export Audio Mixdown” on page 484).

5. Use the other parameters in the control panel to set up the dithering to your liking.

**Using group channels for insert effects**

Like all other channels, group channels can have up to eight insert effects. This is useful if you have several audio tracks that you want to process through the same effect (e.g. different vocal tracks that you want to be processed by the same compressor).

Another special use for group channels and effects is the following:

If you have a mono audio track and want to process this through a stereo insert effect (e.g. a stereo chorus or an auto panner device), you cannot just insert the effect as usual. This is because the audio track is in mono – the output of the insert effect will be in mono as well, and the stereo information from the effect will be lost.

One solution is to route a send from the mono track to a stereo FX channel track, set the send to pre-fader mode and lower the fader completely for the mono audio track. However, this makes mixing the track cumbersome, since you cannot use the fader.

Here is another solution:

1. Create a group channel track in stereo and route it to the desired output bus.

2. Add the desired effect to the group channel as an insert effect.

3. Route the mono audio track to the group channel.

Now the signal from the mono audio track is sent directly to the group, where it passes through the insert effect, in stereo.
Freezing (rendering) insert effects for a track

Effect plug-ins can sometimes require a lot of processor power. If you are using a large number of insert effects for a track, you may reach a point where the computer cannot play back the track properly (the CPU overload indicator in the VST Performance window lights up, you get cracking sounds, etc.).

To remedy this, you can freeze the track, by clicking the Freeze button in the Inspector.

- The Freeze Channel Options dialog opens, allowing you to set a “Tail Size” time in seconds. This adds time at the end of the rendered file to allow reverb and delay tails to fully fade out.

- The program now renders the output of the track, including all pre-fader insert effects, to an audio file. This file is placed in the “Freeze” folder within the Project folder (Windows). On the Mac, the Freeze folder is stored under “User/Documents”.
- The frozen audio track is locked for editing in the Project window. The frozen insert effects cannot be edited or removed and you cannot add new insert effects for the track (except post-fader effects).

After freezing the Inserts for a track, you hear the track play back as before but the insert effects do not have to be calculated in real time, easing the load on the computer processor. Typically, you would freeze a track when it is finished and you do not need to edit it anymore.

- You can only freeze audio tracks this way, not group channel tracks or FX channel tracks.
- The last two insert effects will not be frozen. This is because these are post-fader insert slots.
- You can also freeze VST instruments and their insert effects – see the chapter “VST instruments and instrument tracks” on page 206.

Unfreezing

If you need to edit the events on a frozen track or make settings for the insert effects, you can unfreeze the track:

1. Click the Freeze button in the Inspector for the track. You will be asked whether you really want to unfreeze the channel and if you wish to keep or delete the freeze files.
2. Click “Unfreeze” or “Keep Freeze files”. This reactivates the frozen insert effects. Clicking “Keep Freeze Files” will unfreeze the channel but not delete the freeze files. After editing, you can freeze the track again.

Send effects

Background

As their name implies, send effects are outside of an audio channel’s signal path, i.e. the audio data to be processed must be sent to the effect (as opposed to insert effects, which are inserted into the channel’s signal path).

To this end, Cubase provides FX channel tracks. When you have created such a track, it is added to the track list and can be selected as a routing target in the Send slots of audio channels.

- When selecting an FX channel track in one of the send slots of an audio channel, the audio is sent to the FX channel and through any insert effects set up for it. The sends can be routed to different FX channels, and thus different FX channel insert effect configurations. You control the amount of signal sent to the FX channel by adjusting the effect send level.
- If you have added several effects to the FX channel, the signal passes through the effects in series, from the top (the first slot) downward. This allows for “custom” send effect configurations – e.g. a chorus followed by a reverb followed by an EQ and so on.
- The FX channel track has its own channel strip in the Mixer, the effect return channel. Here you can adjust the effect return level and balance, add EQ and route the effect return to any output bus.
- Each FX channel track can have any number of automation tracks, for automating various effect parameters. See the chapter “Automation” on page 227 for more information.
Setting up send effects

Adding an FX channel track

1. Pull down the Project menu, open the “Add Track” submenu and select “FX Channel”. A dialog opens.

2. Select a channel configuration for the FX channel track. Normally, stereo is a good choice since most effect plug-ins have stereo outputs.

3. Select an effect for the FX channel track. This is not strictly necessary at this point – you can also leave the plug-in pop-up menu set to “No Effect” and add effects to the FX channel later.

4. Click the Add Track button. An FX channel track is added to the track list, and the selected effect, if any, is loaded into the first insert effect slot for the FX channel (in that case, the lit Inserts tab for the FX channel track in the Inspector indicates that an effect has been assigned and automatically activated).

   • All FX channel tracks you create will appear in a dedicated “folder” track in the track list. This makes it easy to manage and keep track of all your FX channel tracks, and also allows you to save screen space by folding in the FX Channel folder.

Adding and setting up effects

As mentioned above, you can add a single insert effect when you create the FX channel track. To add and set up effects after the FX channel track is created, you can either use the Inspector for the track (click the Inserts tab) or the VST FX Channel Settings window:

1. Click the Edit (“e”) button for the FX channel track (in the track list, Mixer or Inspector). The VST FX Channel Settings window appears, similar to a regular Channel Settings window.

   On the left in the window you can find the Inserts section.

2. Make sure that the FX channel is routed to the correct output bus. This is done with the Output Routing pop-up menu at the top of the fader section (also available in the Mixer and Inspector).

3. To add an insert effect in an empty slot (or to replace the current effect in a slot), click in the slot and select an effect from the pop-up menu. This works just like when selecting insert effects for a regular audio channel.

4. When you add an effect, its control panel will automatically appear. When you set up send effects, you normally set the wet/dry Mix control to all “wet”. This is because you control the balance between the wet and the dry signal with the effect sends. For more information, see “Editing effects” on page 200.

   • You can add up to eight effects for an FX channel. The signal will pass through all the effects in series. It is not possible to adjust the send and return levels separately for the effects – this is done for the FX channel as a whole. If you want several separate send effects (where you can control the send and return levels independently), add more FX channel tracks instead – one for each effect.

   • You can reorder the effects by clicking in the area above the name field and dragging the effect onto another slot.
• You can copy an effect into another effect slot (for the same channel or between channels) by holding down [Ctrl]/[Command] and dragging it onto another effect slot.

• To remove an insert effect from a slot, click in the slot and select “No Effect” from the pop-up menu. To reduce the CPU load, do this for all effects that you do not intend to use.

• You can bypass individual effects (or all effects) by clicking the corresponding Bypass button(s) for the FX channel track. See “Routing an audio channel or bus through insert effects” on page 190.

• You can also adjust level, pan and EQ for the effect return in the FX Channel Settings window. This can also be done in the Mixer or in the Inspector. Remember that the more effect units you use, the higher the CPU load.

Making settings for the sends

The next step is to set up a send for an audio channel and route it to the FX channel. This can be done in the Mixer (in the extended panel), in the Channel Settings window, or in the Inspector for the audio track. The example below shows the Channel Settings window, but the procedure is similar for all the sections:

1. Click the “e” button for an audio channel to bring up its Channel Settings window. The send section is located to the left of the channel strip. Each of the sends has the following controls:
   - An On/Off button for activating/deactivating the effect
   - A send level slider
   - A pre/post-fader switch
   - An “e” (edit) button

   Note that the last three items are not shown until the send is activated and an effect has been loaded.

2. Pull down the Routing pop-up menu for a send by clicking in the empty slot, and select the desired routing destination.

   - If the first item on this menu (“No Bus”) is selected, the send is not routed anywhere.
   - Items called “FX 1”, “FX 2” etc. correspond to existing FX tracks. If you renamed an FX track (see “Adding an FX channel track” on page 195), that name will appear on this menu instead of the default.

   • The menu also allows for routing a send directly to output buses, separate output bus channels or Group channels.

   • Cubase only: You can apply or remove a send to or from all the selected channels at once by holding down [Shift]-[Alt]/[Option] and selecting the desired effect from any of the effect slots.

3. Select an FX channel track from the pop-up menu. Now the send is routed to the FX channel.

4. Activate the On/Off button for the effect send. Cubase only: If you hold down [Shift]-[Alt]/[Option] when clicking the button, you activate or deactivate this effect slot for all selected channels.

5. Click and drag the send level slider to a moderate value. The send level determines how much of the signal from the audio channel is routed to the FX channel via the send.
• In the Fader section of the Channel Settings window, select the FX channel from the pop-up menu and adjust its effect return level. By adjusting the return level, you control the amount of the signal sent from the FX channel to the output bus.

6. If you want the signal to be sent to the FX channel before the audio channel’s volume fader in the Mixer, click on the Pre-Fader button for the send so that it lights up.

A send set to pre-fader mode.

Normally you want the effect send to be proportional to the channel volume (post-fader send). The picture below shows where the sends are “tapped” from the signal in pre and post-fader mode:

- Use the channel’s Mute button to determine whether a send in pre-fader mode is affected. This is done with the “Mute Pre-Send when Mute” option in the Preferences dialog (VST page).
- When one or several sends are activated for a channel, the Send Effects buttons light up in blue.
- Cubase only: The FX channels themselves have sends, too.

Bypassing the sends

• In the Mixer, you can click on the lit (blue) Sends State button for a channel to bypass (disable) all its sends. When the sends are bypassed, the button is yellow. Click the button again to enable the sends.

• To bypass all sends for a track, click the “Bypass Sends” button. This button can be found on the right of the title bar of the Sends section in the Inspector or the Channel Settings window. It lights up in yellow to indicate that the inserts of this track are bypassed. In the track list and the channel strip in the Mixer, the Sends State button will also light up in yellow.
- You can also bypass individual sends in the channel overview. See “Insert effects in the channel overview” on page 191.

• You can also bypass the send effects by clicking the “Bypass Inserts” button for the FX channel. This bypasses the actual effects which may be used by several different channels. Bypassing a send affects that send and that channel only. If you bypass the insert effects, the original sound will be passed through. This may lead to unwanted side effects (higher volume). To deactivate all effects, use the mute button in the FX channel.

Setting pan for the sends (Cubase only)

There are several possibilities to set up pan for the sends:
- To position the send signal at center pan in the stereo FX channel (or anywhere you like), route a send from a mono channel to a stereo FX channel track.
• To use the pan control as a crossfader, determining the balance between the stereo sides when the stereo send signal is mixed to mono, route a send from a stereo channel to a mono FX channel track.

• To use the surround panner to position the send signal in the surround image, route a send from a mono or stereo channel to an FX channel track in surround format.

You set up send panning in the following way:

1. Open the Channel Settings window for the audio channel.

2. Right-click somewhere in the Channel Settings window (not the EQ display), to open the context menu and open the Customize View submenu.

3. From the submenu, select “Send Routing” and “Control Strip”.

   In the Send Routing section of the Channel Settings window, each send is shown as a small routing diagram showing a pre/post selector to the right and a pan fader (where applicable). In the Control Strip section, you can activate the “Send Routing Panners follow Channel Panner” option. The send panners will then follow the pan for the channel, making the stereo imaging as clear and true as possible. This behavior can also be set as default for all channels. The corresponding setting is available in the Preferences dialog (VST page).

   ![Send Routing Panners follow Channel Panner](image)

   The Sends, Send Routing, and Control Strip sections in the Channel Settings window

4. Click and drag the pan control for the desired send(s) in the display.

   You can reset the pan control to the center position by [Ctrl]/[Command]-clicking on the pan control.

• If the FX channel is configured in a surround format, the pan control will be a miniature surround panner, similar to the one found in the Mixer. You can click and drag the “ball” in the miniature panner display to position the send in the surround field, or double-click in the display to bring up the surround panner. See the chapter “Surround sound (Cubase only)” on page 217 for details.

   If both the send (the audio channel) and the FX channel are in mono, the pan control is not available.

### Using the side-chain input

Many VST 3.0 effects feature a side-chain input. Side-chaining allows you, for example, to lower the music volume when someone is speaking (“ducking”) or to use compression (e.g. on a bass sound) when the drums are hit, thereby “harmonizing” the intensity of the two instruments. Another possibility is to use the side-chain signal as a source for modulation.

The effect types which feature side-chain functionality are Delay, Dynamics, Modulation, and Filter.

⚠️ For detailed descriptions of the plug-ins that feature side-chaining, see the separate PDF document “Plug-in Reference”.

Certain combinations of tracks and side-chain inputs may lead to feedback loops and added latency. If this is the case, the side-chain options will not be available.

### Creating a Ducking delay

The delay repeats can be silenced by side-chain signals exceeding a certain threshold.

You can use this feature to create a so-called “ducking delay” for your vocals. Let’s say you want to add a delay effect that is audible only when no signal is present on the vocal track. For this, you need to set up a delay effect which is deactivated every time the vocals start again.

Proceed as follows:

1. Select the vocal track.

2. On the Project menu, select “Duplicate Tracks”.

   Now you can use the vocal events on the second track to silence the delay effect.
3. Open the Inserts tab for the first Vocal track in the Inspector and select “PingPongDelay” from the Effects pop-up menu. The control panel for the effect opens.

4. On the control panel for the effect, make the desired effect settings and activate the Side-Chain button. Try out the effect settings to find out which settings will work best with your project. For detailed descriptions of the parameters, see the separate PDF document “Plug-in Reference”.

5. In the track list, select the second vocal track.

6. Pull down the Output Routing pop-up menu and on the Side-Chain submenu, select the PingPongDelay effect you set up for the vocal track. This way, the signals from the second (duplicate) track are routed to the effect (and do not end up in the mix).

Now every time the signals on the vocal track exceed the threshold, the delay will be deactivated. Since the threshold for the delay effect is fixed, you may have to adjust the volume of track 2, in this example, to ensure that vocal parts of low or middle volume will also silence the delay effect.

---

### Triggering a compressor using side-chain signals

Compression, expansion or gating can be triggered by side-chain signals exceeding a specified threshold.

You may run into a situation where you want to lower the volume of one instrument every time another instrument is played. For example, you may want to lower the volume of the bass guitar during the bass drum hits. This can be achieved by applying compression to the bass guitar signal every time the drum signals are present on the respective track.

Proceed as follows:

1. Select the bass guitar track.

2. Open the Inserts tab in the Inspector, click in an insert slot to open the effect selection pop-up menu and, on the Dynamics submenu, select “Compressor”.

3. Make the desired effect settings (you will most likely have to adjust them later to get the right compression level) and activate the Side-Chain button.

4. Select the bass drum track.

5. Open the Sends Inspector section, click in a send slot and from the Side-Chain submenu, select the Compressor effect you created for the bass guitar track. Adjust the Send level.

When you now play back the project, the bass guitar will be compressed whenever the signals on the bass drum track exceed the threshold.

### Side-chain and Modulation

Side-chain signals bypass the built-in LFO modulation and instead apply modulation according to the envelope of the side-chain signal. Since each channel will be analyzed and modulated separately, this allows for creating astonishing spatial modulation effects. Feel free to experiment with the functions to see what they have to offer!
About drag & drop
When you drag effects from one insert slot to another (on the same channel or between different channels), the following applies:

- When you move an effect within a channel (e.g. from slot 4 to slot 6), the side-chain connections will be kept.
- When you drag and drop an effect between two channels, the side-chain connections will not be kept.
- When copying an effect into another effect slot (for the same or a different channel), the side-chain connections will not be copied, i.e. they will be lost.

Using external effects (Cubase only)
Although this program comes with a top selection of VST effect plug-ins, and although there is a huge range of additional plug-ins available on the market, you may still have some hardware effect units that you want to use – valve compressors, reverb units, vintage tape echo machines, etc. By setting up external FX busses you can make your outboard equipment part of the Cubase virtual studio!

An external FX bus is a combination of outputs (sends) and inputs (returns) on your audio hardware, along with a few additional settings. All external FX busses you have created will appear on the effect pop-up menus and can be selected like the internal effect plug-ins. The difference is that if you select an external effect as an insert effect for an audio track, the audio will be sent to the corresponding audio output, processed in your hardware effect (provided that you have connected it properly) and returned via the specified audio input.

Creating and handling of external effects is described in detail in the chapter “VST Connections” on page 25.

Editing effects
All inserts and sends have an Edit (“e”) button. Clicking this opens the control panel for the effect, in which you can make parameter settings.

The contents, design and layout of the control panel depend on the selected effect. However, all effect control panels have an On/Off button, a Bypass button, Read/Write automation buttons (for automating effect parameter changes, see the chapter “Automation” on page 227), a preset pop-up menu and a Preset Management pop-up menu for saving and loading effect presets. Some plug-ins also feature a side-chain button, see “Using the side-chain input” on page 198.

Effect presets
Effect preset management in Cubase is very versatile. In the MediaBay – or with certain limits in the Save Preset dialog – you can assign attributes to presets which allow you to organize and browse them according to various criteria. Cubase comes with a huge array of categorized track and VST presets that you can use straight out of the box. You can also preview effect presets before loading them which considerably speeds up the process of finding the right effect preset.

Effect presets can be divided into the following main categories:

- VST presets for a plug-in

These are stored parameter settings for a specific effect.
• Inserts presets that contain insert effect combinations. These can contain the whole insert effects rack, complete with settings for each effect, see “Saving insert effect combinations” on page 203.

Selecting effect presets

Most VST effect plug-ins come with a number of useful presets for instant selection.

To select an effect preset in the Presets browser, proceed as follows:

1. Load an effect, either as a channel insert or into an FX channel. The control panel for the effect is displayed.
2. Click in the preset field at the top of the control panel. This opens the Presets browser.
3. In the Results section, select a preset from the list.
4. Activate playback to audition the selected preset. Simply step through the presets until you find the right sound. It may be helpful to set up cycle playback of a section to make comparisons between different preset settings easier.
5. When you have found the preset that you want, double-click on it (or click outside the Presets browser). The preset is applied.

• To return to the preset that was selected when you opened the Presets browser, click the “Revert to Last Setting” button.

• You can also open the Presets browser by clicking the button to the right of the preset field and selecting “Load Preset” from the pop-up menu.

• The preset handling for VST 2 plug-ins is slightly different, see “About earlier VST effect presets” on page 202.

The Browser sections

The Presets browser contains the following sections:

• The “Results” section lists the available presets for the selected effect.
• The Filters section shows the available preset attributes for the selected effect. This section is similar to the Filters section in the MediaBay, see “The Filters section” on page 321. To show the Filters section, click the “Set Up Window Layout” button and activate the Filters option.
• The Location Tree section allows you to specify the folder that is searched for preset files. To show the Location Tree section, click the “Set Up Window Layout” button and activate the Location Tree option. Note that this is only available if the Filters section is also active.

Saving effect presets

You can save your edited effect settings as presets for further use (e.g. in other projects):

1. Open the Preset Management pop-up menu.
2. Select “Save Preset…” from the pop-up menu. The Save Preset dialog opens.

![Save Preset dialog]

3. In the New Preset section, enter a name for the new preset.
   - If you want to save attributes for the preset, click the button below the “New Preset” section at the bottom left. The Attribute Inspector section opens, allowing you to define attributes for the preset. For further information about attributes, see “The Attribute Inspector” on page 323.

4. Click OK to store the preset and exit the dialog.

   User-defined presets are saved in the following location:
   - Windows: `\Users\<user name>\AppData\Roaming\VST3\presets\<company>\<plug-in name>`
   - Mac: `/Users/<user name>/Library/Audio/Presets/<company>/<plug-in name>`

   You cannot change the default folders, but you can add further subfolders inside the individual effect preset folders (by clicking the New Folder button).

---

**About earlier VST effect presets**

As stated previously, you can use any VST 2.x plug-ins in Cubase. For a description of how to add VST plug-ins, see “Installing and managing effect plug-ins” on page 203.

When you add a VST 2 plug-in, any previously stored presets for it will be in the old FX program/bank format (.fxp/.fxb). You can import such files, but the preset handling will be slightly different. You will not be able to use the new features like the Attribute Inspector until you have converted the old “.fxp/.fxb” presets to VST 3 presets. If you save new presets for the included VST 2 plug-ins, these will automatically be saved in the new “.vstpreset” format.

⚠️ All VST 2 presets can be converted to VST 3 presets.

**Importing and converting FXB/FXP files**

To import FXB/FXP files, proceed as follows:

1. Load any VST 2 effect you may have installed, and open the Preset Management pop-up menu.

2. Select “Import FXB/FXP…” from the pop-up menu. This menu item is only available for VST 2 plug-ins.

3. In the file dialog that opens, locate the FXP file and click Open.
   - If you load a bank (.fxb), it will replace the current set of all effect programs. If you load a single program, it will replace the currently selected effect program only. Note that such files exist only if you created your own .fxp/.fxb presets with a previous version of Cubase (or any other VST 2 application).

4. After importing, you can convert the current program list to VST presets by selecting “Convert Program List to VST Presets” from the Preset Management pop-up menu. After converting, the presets will be available in the Presets browser, and you can use the Attribute Inspector to add attributes and audition the presets. The converted presets will be stored in the VST3 Preset folder.
Saving insert effect combinations

You can save the complete insert effect rack for a channel together with all parameter settings as an inserts preset. Inserts presets can be applied to audio, instruments, FX channel, or group tracks.

Proceed as follows:

1. Select the desired track in the track list and open the Inserts Inspector section.
2. Load a combination of insert effects and adjust the parameters (or select effect presets) for each effect.
3. At the top of the Inserts tab, click the VST Sound button to open the Preset Management pop-up menu for the inserts and select “Save Preset…”.
   
4. In the dialog that opens, type in a name for the preset.
5. Select the track (audio/group/instrument/FX channel) you wish to apply the new preset to, and open the Preset Management pop-up menu.
   
6. Select the preset you created from the pop-up menu. The effects are loaded into the Insert slots of the new track, and the control panels for all effects are opened.

• You can use the Preset Management pop-up menu to save your settings as preset, or to rename or remove the current preset.

Extracting insert effect settings from track presets

You can extract the effects used in a track preset and load them into your inserts “rack”:

• On the Preset Management pop-up menu, select “From Track Preset…” to open a dialog where all track presets are shown.
• Select an item in the list to load the effects used in the track preset.

Track presets are described in the chapter “Working with track presets” on page 331.

Installing and managing effect plug-ins

Cubase supports two plug-in formats; the VST 2 format (with the file name extensions “.dll” on the PC and “.VST” on the Mac) and the VST 3 format (extension “.vst3” on both platforms). The formats are handled differently when it comes to installation and organizing.

Installing additional VST plug-ins

Installing VST 3 plug-ins under Mac OS X

To install a VST 3.x plug-in under Mac OS X, quit Cubase and drag the plug-in file into one of the following folders:

• /Library/Audio/Plug-Ins/VST3/
   This is only possible if you are the system administrator. Plug-ins installed in this folder will be available to all users, for all programs that support them.
• /Users/<user name>/Library/Audio/Plug-Ins/VST3/
   “<user name>” is the name you use to log on to the computer (the easiest way to open this folder is to go to your “Home” folder and use the path /Library/Audio/Plug-Ins/VST3/ from there). Plug-ins installed in this folder are only available to you.

When you launch Cubase again, the new effects will appear on the effect pop-up menus. In the VST 3 protocol, the effect category, subfolder structure, etc. are built-in and cannot be changed. Therefore you will find the effect(s) in the assigned category folder(s) on the Effect pop-up menu.
Installing VST 2.x plug-ins under Mac OS X

To install a VST 2.x plug-in under Mac OS X, quit Cubase and drag the plug-in file to one of the following folders:

• /Library/Audio/Plug-Ins/VST/
  This is only possible if you are the system administrator. Plug-ins installed in this folder will be available to all users, for all programs that support them.

• `<user name>/Library/Audio/Plug-Ins/VST/`
  `<user name>` is the name you use to log on to the computer (the easiest way to open this folder is to go to your “Home” folder and use the path /Library/Audio/Plug-Ins/VST/ from there). Plug-ins installed in this folder are only available to you.

When you launch Cubase again, the new effects will appear on the effect pop-up menus.

—if an effect plug-in comes with its own installation application, you should use this. As a general rule, always read the documentation or readme files before installing new plug-ins.

Installing VST 3 plug-ins under Windows

Under Windows, VST 3 plug-ins are installed by dragging the files (with the extension “.vst3”) into the VST3 folder in the Cubase application folder. When you launch Cubase again, the new effects will appear on the Effect pop-up menus. In the VST 3 protocol, the effect category, sub-folder structure, etc. are built-in and cannot be changed. Therefore you will find the new effect(s) in the assigned category folder(s) on the effect pop-up menu.

Organizing VST 2 plug-ins

If you have a large number of VST 2 plug-ins, having them all on a single pop-up menu in the program may become unmanageable. For this reason, the VST 2 plug-ins installed with Cubase are placed in appropriate subfolders according to the effect type.

• Under Windows, you can organize VST plug-ins by moving, adding or renaming subfolders within the Vstplugins folder.
  When you launch the program and pull down an effects pop-up menu, the subfolders will be represented by hierarchical submenus, each listing the plug-ins in the corresponding subfolder.

• Under Mac OS X, you cannot change the hierarchic arrangement of the “built-in” VST plug-ins. However, you can arrange any additional plug-ins you have installed (in the /Library/Audio/Plug-Ins/VST/ folders, see above) by placing them in subfolders. In the program, the subfolders will be represented by hierarchical submenus, each listing the plug-ins in the corresponding subfolder.

About the effects from previous Cubase versions

Effect plug-ins from previous versions of Cubase are available through the Steinberg web site. Go to http://knowledgebase.steinberg.net, search for “legacy plug-ins” and follow the link to the download page you require.

Installing older plug-ins will allow you to import projects created with previous versions of Cubase, without losing effect settings.

The Plug-in Information window

On the Devices menu, you will find an item called “Plug-in Information”. Selecting this opens a dialog listing all the available VST compatible plug-ins in your system (including VST instruments), along with all MIDI plug-ins.
Managing and selecting VST plug-ins

To display all available VST plug-ins, open the “VST PlugIns” tab.

- To enable a plug-in (make it available for selection), put a checkmark in the left column. Only the enabled plug-ins will appear on the effect menus.
- The Instances column indicates how many instances of the plug-in are currently used in Cubase. Clicking in this column for a plug-in which is already in use produces a pop-up showing exactly where each use occurs.
  - A plug-in may be in use even if it is not enabled in the left column.

You might for example have opened a project containing effects that are currently disabled on the menu. The left column only determines whether or not the plug-in will be visible on the effect menus.

- All columns can be resized by dragging the divider in the column header.

The other columns show the following information about each plug-in:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the plug-in.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The manufacturer of the plug-in.</td>
</tr>
<tr>
<td>File</td>
<td>This shows the complete name of the plug-in (with extension).</td>
</tr>
<tr>
<td>Category</td>
<td>This indicates the category of each plug-in (such as VST instruments, surround effects, etc.).</td>
</tr>
<tr>
<td>Version</td>
<td>Shows the version of the plug-in.</td>
</tr>
<tr>
<td>SDK</td>
<td>Shows with which version of the VST protocol a plug-in is compatible.</td>
</tr>
<tr>
<td>Latency</td>
<td>This shows the delay (in samples) that will be introduced if the effect is used as an Insert. This is automatically compensated for by Cubase.</td>
</tr>
<tr>
<td>Side-Chain Inputs</td>
<td>Shows the number of side-chain inputs for a plug-in.</td>
</tr>
<tr>
<td>I/O</td>
<td>This column shows the number of inputs and outputs for each plug-in.</td>
</tr>
<tr>
<td>Path</td>
<td>The path and name of the folder in which the plug-in file is located.</td>
</tr>
</tbody>
</table>

VST 2.x Plug-in Paths button

This opens a dialog where you can see the current paths to where VST 2.x plug-ins are located. You can add/remove folder locations by using the corresponding buttons. If you click “Add”, a file dialog opens, where you can select a folder location.

About the “shared” plug-ins folder (Windows and VST 2.x only)

You can designate a “shared” VST 2.x plug-ins folder. This will allow VST 2.x plug-ins to be used by other programs that support this standard.

You designate a shared folder by selecting a folder in the list and clicking the “Set As Shared Folder” button in the VST 2.x Plug-in Paths dialog.

Exporting plug-in information files

You can also save plug-in information as an XML file, e.g. for archiving purposes or troubleshooting. The Export function is available for VST, MIDI and Audio Codec plug-ins. Proceed as follows:

1. Right-click on the desired tab in the Plug-in Information window to open the context menu and select “Export”. A file dialog opens.
2. In the dialog, specify a name and location for the Plug-in Information export file and click OK to export the file.
   - The Plug-in Information file contains information on the installed/available plug-ins, their version, vendor, etc.
   - The XML file can then be opened in any editor application supporting the XML format.

Update button

Clicking this button will make Cubase re-scan the designated VST folders for updated plug-in information.
VST instruments and instrument tracks
Introduction

VST instruments are software synthesizers (or other sound sources) that are contained within Cubase. They are played internally via MIDI. You can add effects or EQ to VST instruments, just as with audio tracks.

Some VST instruments are included with Cubase, others can be purchased separately from Steinberg and other manufacturers.

This chapter describes the general procedures for setting up and using VST instruments. The included VST instruments and their parameters are described in the separate PDF document “Plug-in Reference”.

Depending on the VST version the instrument is compatible with, an icon may be displayed in front of the instrument name, see “About VST 3” on page 188.

VST instrument channels vs. instrument tracks

Cubase allows you to make use of VST instruments in two different ways:

- By activating instruments in the VST Instruments window. This creates a VST instrument channel, which can be played by one (or several) MIDI track(s) routed to it.
- By creating instrument tracks. Instrument tracks are a combination of a VST instrument, an instrument channel, and a MIDI track. You play and record MIDI note data directly for this track.

Both methods have their advantages and should be selected according to what best suits your needs. The following sections describe the two approaches.

VST instrument channels

You can access a VST instrument from within Cubase by creating a VST instrument channel and associating this channel with a MIDI track. Proceed as follows:


2. Click in one of the empty slots to open the instrument pop-up menu and select the desired instrument.

3. You will be asked if you want to create an associated MIDI track connected to the VST instrument. Click Create. The instrument is loaded and activated, and its control panel opens. A MIDI track with the name of the instrument is added to the track list. The output of this track is routed to the instrument.

In the Preferences dialog (VST–Plug-ins page), you can specify what happens when loading a VST instrument in an instrument slot. Open the pop-up menu “Create MIDI track when loading VSTi” and select one of the available options:

- When you select “Always”, a corresponding MIDI track will always be created.
- When you select “Do not”, no track will be created and only the instrument will be loaded.
- Select “Always ask to” if you want to decide whether a MIDI track is created whenever you load an instrument.

You can also use modifiers to specify what happens when you load a VST instrument (overriding the Preference setting):

- When you hold down [Ctrl]/[Command] while selecting a VST instrument for an instrument slot, a corresponding MIDI track with the name of the instrument is automatically created.
- When you hold down [Alt]/[Option] while selecting a VST instrument for an instrument slot, no MIDI track will be created for the instrument.
• If you do not want the plug-in control panels to open every time you load a plug-in, open the Preferences dialog (VST–Plug-ins page) and deactivate “Open Effect Editor After Loading it”.
You can open a plug-in panel at any time by clicking the “e” button of the corresponding plug-in slot.

4. If you now look in the Project window track list, you will find that a dedicated folder for the chosen instrument has been added, within a “VST Instruments” folder (where all your VST instrument channels will be listed).
The separate folder for the added VST instrument contains two types of automation tracks: one for automating the plug-in parameters and one for each Mixer channel used by the VST instrument. For example, if you add a VST instrument with four separate outputs (four separate Mixer channels), the folder will contain five automation tracks. To keep the screen less cluttered, you may want to close the folder for the VST instrument until you need to view or edit any of the automation tracks. For details about automation, see the chapter “Automation” on page 227.

• When you select the MIDI track routed to the VST instrument, you will see that the Inspector contains a separate section for the instrument.
This section contains the audio channel settings for the VST instrument (inserts, EQs, Sends, and fader settings). The tab has two buttons for opening the Channel Settings window (for the VST instrument channel) and the Edit Instrument button which opens the control panel for the VST instrument.

5. Depending on the selected VST instrument, you may also need to select a MIDI channel for the track.
For example, a multitimbral VST instrument can play back different sounds on different MIDI channels – check the documentation for the VST instrument for MIDI implementation details.

6. Make sure that the “MIDI Thru Active” option is activated in the Preferences dialog (MIDI page).

7. Activate the Monitor button for the MIDI track (in the track list, Inspector, or Mixer).
When this is activated (or when the track is record enabled), incoming MIDI is passed on to the selected MIDI output (in this case the VST instrument), see the chapter “Recording” on page 89.

8. Open the Mixer.
You will find one or more channel strips for the audio outputs of the VST instrument. VST instrument channel strips have the same features and functionality as group channel strips, with the addition of an Edit button at the bottom of the strip for opening the VST instrument control panel.
You will also find Output Routing pop-up menus at the top of the channel strips, e.g. for routing the VST instrument channels to output channels or groups.

9. Play the VST instrument from your MIDI keyboard.
You can use the Mixer settings to adjust the sound, add EQ or effects, etc., just as with regular audio channels. Of course, you can also record or manually create MIDI parts that play back sounds from the VST instrument.

⚠ You can have multiple VST instruments activated at the same time, either different instruments or multiple instances of the same instrument. However, software instruments can consume a lot of CPU power – keep an eye on the VST Performance window to avoid running out of processor power (see also “Instrument Freeze” on page 211).

• VST instrument channels give you full access to multitimbral instruments.
You can have several MIDI tracks routed to the VST instrument, each playing a different part.

• Similarly, you can route channels to any available output provided by the VST instrument.

The VST Instruments window
When a VST instrument is loaded, six controls are displayed for this slot in the VST Instruments window.

• The button on the far left is used for the Freeze function, see “Instrument Freeze” on page 211.

• The On/Off button is used to activate or deactivate the VST instrument.
When an instrument is selected from the instrument pop-up menu, it is activated automatically, i.e. the On/Off button is lit.
For some instruments you may also bypass the instrument by clicking the Bypass button to the right of the On/Off button.
• Click the Edit ("e") button to open the control panel for the VST instrument.

• Below the Edit button is a small LED that will light up when MIDI data is received by the instrument.

• The rightmost button allows you to activate the desired output for the instrument. This is useful when you are using VST instruments that have a large number of audio busses, which may be confusing. Click one of the entries in the pop-up list to activate/deactivate output busses for this instrument.

Instrument tracks

An instrument track is a combination of a VST instrument, a MIDI track, and a VST instrument channel, in other words: it is a track coupled with a sound – it allows you to think in terms of sounds rather than in terms of track and instrument settings.

Adding instrument tracks

To open and use an instrument track, proceed as follows:

1. Pull down the Project menu, open the Add Track submenu and select “Instrument”.
   You can also right-click the track list and select “Add Instrument Track” on the context menu.

2. The Add Instrument Track dialog opens. You can select an instrument for the track from the pop-up menu (but you can also leave this until later if you wish). Specify the number of instrument tracks you wish to create in the “Count” field. If you click the Browse button, the dialog expands to show the Presets browser, where you can browse for sounds, see “Using the Presets browser” on page 213.

3. Click the Add Track button. If you have selected an instrument in the Add Track dialog, the new track gets the name of the instrument. Otherwise, the track is named “Instrument track”.

Properties

Each instrument track has a corresponding channel strip in the Mixer.

• In the Inspector, you can select a VST instrument from the Instrument pop-up menu. When you select an instrument from this pop-up menu, its control panel will open automatically.

• You can also exchange the “sound” of an instrument track (i.e. the VST instrument and its settings) by extracting these data from another instrument track or a VST preset, see “Extracting sound from an instrument track or VST preset” on page 335.

• On the Input Routing pop-up menu, you can select a MIDI input. Instrument tracks have only one MIDI input.

• To open the control panel for the VST instrument, click the “Edit Instrument” button in the Inspector.

• As with MIDI tracks, you can perform the usual MIDI editing procedures on the instrument track, like duplicate, split, or repeat the track, drag and drop the MIDI parts of an instrument track, etc. For more information, see the chapter “MIDI realtime parameters and effects” on page 348.

• As with the MIDI track inspector and track controls, you can adjust track delay, choose MIDI input, work with VST instrument panels, etc. For more information, see the chapter “MIDI realtime parameters and effects” on page 348.

• Instrument tracks have all options that VST instrument channels have, i.e. inserts, sends, EQ, etc.

VST instruments used in instrument tracks do not appear in the VST Instruments window. For an overview of all used VST instruments, open the Plug-in Information window via the Devices menu. For further information, see the section “The Plug-in Information window” on page 204.
Restrictions

- Instrument tracks have no MIDI sends.
- MIDI volume and pan cannot be controlled (there is no "MIDI fader" tab in the Inspector); instead, the VST instrument volume and pan are used (via the "Channel" tab in the Inspector). This applies also to the respective automation parameters.
- Due to there being only one volume and pan control for the instrument track, the Mute button will mute the complete track including the VST instrument. (As opposed to a MIDI track with an assigned VST instrument, for which muting the MIDI track still allows you to monitor and record the VST instrument.)
- Instrument tracks always have one stereo output channel only. This means that VST instruments that do not provide a stereo output as their first output channel cannot be used with instrument tracks, and must be loaded via the VST Instruments window.
- Due to the limitation to one output channel, instrument tracks play only the first voice of a multi-timbral VST instrument. If you want to use all voices, you have to load the instrument via the VST Instruments window and set up a MIDI channel to play it.

Import and export options

Importing MIDI loops

You can import “MIDI loops” (file extension “*.midiloop”) in Cubase. These files contain MIDI part information (MIDI notes, controllers, etc.) as well as all the settings that are saved in instrument track presets (see “About track presets and VST presets” on page 212). This way, you can easily reuse instrument patterns you really like in other projects or applications, for example.

Proceed as follows:

1. Open the MediaBay window via the Media menu.
2. In the Results section, open the “Show Media Types” dialog and select “MIDI Loops & Plug-in Presets” (see “Filtering according to media type” on page 316). This is not necessary, but will help you locate your MIDI loops more quickly.
3. In the Results list, select a MIDI loop and drag it to an empty section in the Project window. An instrument track is created and the instrument part is inserted at the position where you dragged the file. The Inspector will reflect all settings saved in the MIDI loop, e.g. the VST instrument that was used, applied insert effects, track parameters, etc.
- You can also drag MIDI loops onto existing instrument or MIDI tracks. However, this will only import the part information. This means this part will only contain the MIDI data (notes, controllers) saved in the MIDI loop, but no inspector settings or instrument parameters.

Exporting MIDI loops

Exporting MIDI loops is a great way of saving a MIDI part together with its instrument and effect settings. This allows you to easily reproduce patterns you created without having to search for the correct sound, style, or effect.

Proceed as follows:

1. Select the desired instrument part.
2. Pull down the File menu, open the Export submenu, and select “MIDI Loop…”. A file dialog opens.
3. In the “New MIDI Loop” section, enter a name for the MIDI loop.
- If you want to save attributes for the MIDI loop, click the button below the “New MIDI Loop” section at the bottom left. The Attribute Inspector section opens, allowing you to define attributes for your MIDI loop.
4. Click OK to close the dialog and save the MIDI loop. MIDI Loop files are saved in the following folder:
   - Windows: \Users\<user name>\AppData\Roaming\Steinberg\MIDI Loops
   - Mac: /Users/<user name>/Library/Application Support/Steinberg/MIDI Loops/

This default folder cannot be changed, but you can create subfolders within this folder to organize your MIDI loops. Simply click the “New Folder” button in the Save MIDI Loop dialog.
Exporting instrument tracks as MIDI file

You can also export instrument tracks as standard MIDI files, see “Exporting MIDI files” on page 527.

Please note the following:

• As there is no MIDI patch information in an instrument track, this information is missing in the resulting MIDI file.
• If you activate “Export Inspector Volume/Pan”, volume and pan information of the VST instrument will be converted and written into the MIDI file as controller data.

What do I need? Instrument channel or instrument track?

• If you need a particular sound without knowing which VST instrument to use, create an instrument track and use the preview features of the Presets browser to find the sound you want.
• Do likewise if the instrument track restrictions described above do not matter.
• If you are planning to create an instrument track preset, complete with inserts and EQ settings, you have to use an instrument track.
• If you need to use multitimbral parts and/or multiple outputs, set up a VST instrument channel.

Instrument Freeze

Like all plug-ins, VST instruments may require a lot of processor power. If you are using a moderately powerful computer or if you are using a large number of VST instruments, you may come to a point where your computer cannot handle all VST instruments playing back in realtime (the CPU overload indicator in the VST Performance window lights up, you get crackling sounds, etc.).

Enter the Instrument Freeze function! This is how it works:

• When you freeze a VST instrument, the program renders an audio file of the instrument output (taking into account all unmuted MIDI parts routed to that VST instrument). This file is placed in the “Freeze” folder within the Project folder.
• All MIDI tracks routed to the VST instrument, or the instrument track associated with the VST instrument, are muted and locked (the controls for these tracks will appear “grayed-out” in the track list and Inspector).
• When you start playback, the rendered audio file is played back from an “invisible” audio track, routed to the VST instrument’s Mixer channel. Thus, any effects, EQ, or mixing automation will still be applied.
• You can also freeze the Mixer channel of the VST instrument. This freezes any pre-fader insert effects for the channels, just as when freezing audio tracks (see “Freezing (rendering) insert effects for a track” on page 194).

The result of the Freeze is that you get exactly the same sound as before, but the computer processor does not have to calculate the sound of the VST instrument in real-time.

Performing the freeze

The instrument freeze function is available in the VST Instruments window, the track list, and the Inspector for instrument tracks.

1. Set up the project so that the VST instrument plays back the way you want it to. This includes editing the MIDI tracks routed to the VST instrument, or editing the instrument track, and making parameter settings for the VST instrument itself. If you have automated parameter changes for the VST instrument, make sure that the Read (R) button is activated.

2. Open the VST Instruments window from the Devices menu, or, if you are using an instrument track, select the track and open the top Inspector tab.

3. Click the Freeze button for the VST instrument (the button to the left of the VST instrument slot), or the Freeze button in the Inspector for the instrument track.
The Freeze Instrument Options dialog opens with the following options for the Freeze operation:

- Select “Freeze Instrument Only” if you do not want to freeze any insert effects for the VST instrument channels. Use this if you are using insert effects on the VST instrument channel(s) and want to be able to edit, replace, or remove these after freezing the VST instrument.

- Select “Freeze Instrument and Channels” if you want to freeze all pre-fader insert effects for the VST instrument channels.
   If your VST instrument channels are set up with the desired insert effects and you do not need to edit these, select this option.

- You can set a Tail Size time to let sounds complete their normal release cycle. Otherwise, the sound might be cut off at the very end of the freeze file.

- When you activate “Unload Instrument when Frozen”, the frozen VST instrument will be removed. This is useful if you are freezing an instrument that uses a lot of RAM, e.g. for pre-loading samples. By unloading the instrument, the RAM becomes available for other plug-ins, etc.

4. Click OK.
   A progress dialog is shown while the program renders the VST instrument audio to a file on your hard disk.

   The Freeze button lights up. If you check the Project window at this point, you will find that the relevant MIDI/instrument tracks have grayed out controls in the track list and Inspector. Furthermore, the MIDI parts are locked and cannot be moved.

5. Play back the project.
   You will hear exactly the same sound as before freezing the VST instrument – but the CPU load will be considerably less!

   - If you selected “Freeze Instrument and Channels”, any insert effects used by the VST instrument are also frozen (except for the post-fader inserts). However, you can always adjust level, pan, sends, and EQ for frozen VST instruments.

Unfreezing

If you need to make adjustments (either to the MIDI tracks, to the VST instrument parameters or to the VST instrument channels if these were frozen) you need to unfreeze the VST instrument:

1. Click the Freeze button for the VST instrument again (either in the VST Instruments window or in the Inspector). You will be asked to confirm this operation.
2. Click “Unfreeze”.
   The tracks and VST instrument are restored and the rendered “freeze file” is deleted.

VST instruments and processor load

If you are working with VST 3 instruments, another way to relieve processor load is the “Suspend VST3 plug-in processing when no audio signals are received” option in the Preferences dialog (VST–Plug-ins page). This is described in the section “Smart plug-in processing” on page 188.

Using presets for VSTi configuration

About track presets and VST presets

Track presets and VST presets allow you to quickly set up tracks or instruments with all the settings required for the sound you want. Cubase provides various types of presets for various purposes. Two of these are of relevance for VST instruments:

- Track presets for instrument tracks store the parameter settings of a VST instrument together with all track/channel settings (applied audio insert effects, etc.). Instrument track presets can only be applied to instrument tracks, not to instrument channels activated in the VST Instruments window.
- VST presets store all panel settings for a plug-in (VST instruments and VST effects), but no track/channel settings.

Note that you can create instrument tracks from VST 3 presets, i.e. selecting a VST 3 preset will create an instrument track with all settings stored in the VST preset plus an “empty” track.
As described in the chapter “Audio effects” on page 187, there are two types of VST presets that can be used: the VST 2 standard FXB/FXP files and the VST 3 preset standard with the extension “.vstpreset”. Some of the included VST instruments use the VST 2 preset standard, and others use the VST 3 standard.

All VST 2 instruments can import FXB/FXP files and also convert them to the VST 3 standard. Once converted, you can use all VST 3 features, see “About earlier VST instrument presets” on page 215.

Ö For further information on track presets and VST presets, see the chapter “Working with track presets” on page 331.

**Browsing for sounds**

One important and often time-consuming aspect of music creation is the search for the right sounds. You might spend a huge amount of time trying out the presets for a particular instrument only to find out later that the preset for another instrument contains the sound you were looking for. This is why Cubase features extensive browsing possibilities, allowing you to preview all available presets without having to load them first!

In addition, you can filter your search by specifying category, style, etc. For example, if you are looking for a bass sound, simply select the Bass category to browse and preview all bass sounds for all instruments. If you know you want a synth bass sound, select Synth Bass as sub-category to filter out all other sounds, etc.

You can also browse and preview track presets for instrument tracks, i.e. instrument sounds plus all track settings and all channel insert effect settings for this track.

These features combined speed up the process of finding the right sound immensely.

• When creating your own presets, it is always a good idea to set up attributes for them, as it allows you to fully use the browsing features for your files, too.

This is described in the section “Editing attributes (tagging)” on page 324.

**Using the Presets browser**

You can open the Presets browser for an existing track or when creating a new track. Proceed as follows:

• In the Add Instrument Track dialog, click the Browse button. The dialog expands to show the Presets browser.

• Click in the “Load Track Preset” field at the top of the Inspector (above the track name) or right-click the track in the track list and select “Load Track Preset…”.

To find an appropriate preset, proceed as follows:

1. Select a preset from the Results list. If needed, filter the list by activating the attributes you are looking for in the Filters section. This section is similar to the Filters section in the MediaBay, see “The Filters section” on page 321.

2. Play a few notes on your MIDI keyboard to hear the preset sound. You can switch between presets and hear the sound while you play. Alternatively, you can play back/loop a MIDI part on a track.

3. When you have found the preset that you want, double-click on it (or click outside the Presets browser). The preset is applied.

• To return to the preset that was selected when you opened the Presets browser, click the “Revert to Last Setting” button.
Using the “Choose Track Preset” dialog

1. Right-click the track list to open the context menu and on the Add Track submenu select “Add Track Using Track Preset...”.

The Choose Track Preset dialog opens. It contains the same sections as the Presets browser.

2. Select a preset from the Results list.

The Results section of the Choose Track Preset dialog displays all preset sounds for all track types and VST instruments.

3. To preview the presets, you have to play MIDI notes on a MIDI keyboard or load a MIDI file because there is no track connected.

The previewing options are described in detail in the section “Previewing VST presets and track presets for MIDI and instrument tracks” on page 319.

WARNING: The Preview functions work in the same way in the MediaBay and its related dialogs. Note however that not all Preview functions available in the MediaBay are also available in the dialogs.

4. When you have found the right sound, click the Add Track button to close the dialog.

An instrument track is created with all track and/or instrument settings that were saved in the preset.

Selecting VST instrument presets

The previous sections focused on selecting presets for the creation of new instrument tracks, or for changing the setup of an existing track. However, you can also use presets to change the settings of the VST instrument itself.

WARNING: Note that the following refers to the selection of VST 3 presets (.vstpreset). If you want to apply .FXP/.FXB presets to your VST 2 instruments in this way, see “About earlier VST instrument presets” on page 215.

To select a VST instrument preset, proceed as follows:

1. Load a VST instrument (either in the VST Instruments window or via an instrument track).

2. If you use the VST Instruments window, select a MIDI track routed to the instrument. If you use an instrument track, select this track.

3. Make sure that the Inspector section with the basic track settings is visible.

If this is not the case, click on the track name at the top of the Inspector.

4. In the Inspector, click in the Programs field.

The Presets browser opens.

5. In the Results section, select a preset from the list.

6. Activate playback to audition the selected preset.

Simply step through the presets until you find the right sound. It may be helpful to set up cycle playback of a section to make comparisons between different preset settings easier.

7. When you have found the preset that you want, double-click on it (or click outside the Presets browser).

The preset is applied.

To return to the preset that was selected when you opened the Presets browser, click the “Revert to Last Setting” button.

You can also open the Presets browser via the Presets pop-up menu in the control panel of the VST instrument.
Saving VST instrument presets

You can save your settings as presets for further use (e.g. in other projects):

1. In the VST instrument panel, click the button to the right of the preset name and select “Save Preset…”. This opens a dialog where you can save the current settings as a preset.
2. In the New Preset section, enter a name for the preset.
   • If you want to save attributes for the preset, click the button below the “New Preset” section at the bottom left. The Attribute Inspector section opens, allowing you to define attributes for the preset. For further information about attributes, see “The Attribute Inspector” on page 323.
3. Click OK to save the preset and exit the dialog.

Presets are saved into a default folder named VST3 Presets. Within this folder, there is a folder called “Steinberg Media Technologies” where the included presets are arranged in subfolders named after each instrument.

You cannot change the default folder, but you can add further subfolders inside the instrument’s preset folder.
   • Under Windows, the default preset folder is in the following location: %USERPROFILE%\AppData\Roaming\VST3 Presets.
   • Under Mac OS, the default preset folder is in the following location: /Users/<user name>/Library/Audio/Presets/<company>/<plug-in name>.

About earlier VST instrument presets

You can use any VST 2.x instrument plug-ins in Cubase. Installing VST instrument plug-ins works the same way as for audio effects — see “Installing additional VST plug-ins” on page 203.

When you install a VST 2 instrument, any previously stored presets for it will be of the old FX program/bank (.fxp/.fxb) standard. You can import such files, but the preset handling will be slightly different. You will not be able to use the new features like the Preview function or the Attribute Inspector until you have converted the old “.FXP/.FXB” presets to VST 3 presets. If you save new presets for a VST 2 plug-in these will automatically be saved in the new “.vstpreset” format in the default location.

Importing and converting FXB/FXP files

To import FXP/FXB files, proceed as follows:

1. Load any VST 2 instrument you may have installed, and click the VST Sound button to open the Preset Management pop-up menu.
2. Select the “Import FXB/FXP” option. This menu item is only available for VST 2 instrument plug-ins.
3. In the file dialog that opens, locate the FXP file and click “Open”.

If you load a bank (.fxb), it will replace the current set of all effect programs. If you load a single program, it will replace the currently selected effect program only. Note that such files exist only if you created your own .fxp/fxb presets with a previous program version (or any other VST 2 application).

• After importing, you can convert the current program list to VST presets by selecting “Convert Program List to VST Presets” from the Preset Management pop-up menu.

When the presets are converted, they are available in the Presets browser, and you can use the Attribute Inspector to add attributes and audition the presets. The presets will be stored in the VST3 Preset folder.

About latency

Depending on your audio hardware and its ASIO driver, the latency (the time it takes for the instrument to produce a sound when you press a key on your MIDI controller) may simply be too high to allow comfortable realtime VST instrument playback from a keyboard.

If this is the case, a workaround is to play and record your parts with another MIDI sound source selected, and then switch to the VST instrument for playback.

• You can check the latency for your audio hardware in the Device Setup dialog (VST Audio System page). The input and output latency values are shown below the ASIO Driver pop-up menu. For live VST instrument playing, these values should ideally be a few milliseconds (although the limit for “comfortable” live playing is a matter of personal taste).
Constrain Delay Compensation

Cubase features full delay compensation throughout the entire audio path. This means that any delay inherent in the VST plug-ins you use will automatically be compensated for during playback, so that all channels are kept in perfect sync (see “About plug-in delay compensation” on page 189).

However, when you play a VST instrument in realtime or record live audio (with monitoring through Cubase activated), this delay compensation may sometimes result in added latency. To avoid this, you can activate the Constrain Delay Compensation button on the Project window toolbar. This function tries to minimize the latency effects of the delay compensation, while maintaining the sound of the mix as far as possible.

- In the Preferences dialog (VST page) you will find a setting called Delay Compensation Threshold. Only plug-ins with a delay higher than this setting will be affected by the Constrain Delay Compensation function.
- VST plug-ins (with higher delay than the threshold value) which are activated for VST instrument channels, audio track channels that are record enabled, group channels and output channels will be turned off when you activate Constrain Delay Compensation.
- VST plug-ins activated for FX channels are not turned off but their delay is disregarded by the program (delay compensation is turned off).

After recording or using a VST instrument with Constrain Delay Compensation, turn off the function in order to restore full delay compensation.

External instruments (Cubase only)

An external instrument bus is an input (return) to your audio hardware, along with a MIDI connection via Cubase and few additional settings. External instrument busses are created in the VST Connections window. All external instrument busses you have created will appear on the VST Instrument pop-up menus and can be selected in the same way as any VST instrument plug-in. If you select an external instrument, you play it via MIDI as usual (you have to create a MIDI device to play it) and the sound (synth audio output) will come in to the VST environment where you can apply processing, etc. For more information on external instruments, see “Setting up external instruments” on page 32.
Surround sound (Cubase only)
Introduction

Cubase has integrated surround sound features with support for several formats. This support goes all the way through the audio path: all audio-related channels (i.e. audio and instrument tracks as well as group channels) and busses can handle multi-channel speaker configurations. A channel in the Mixer can either carry complete surround mixes, or an individual speaker channel which is part of a surround setup.

Cubase offers the following surround-related features:

- Audio-related tracks can be routed freely to surround channels.
- The SurroundPanner V5 plug-in is automatically applied to audio-related tracks with a mono or stereo configuration that are routed to output channels with a multi-channel configuration (other than stereo). It is available in the Inspector and Mixer and can be used to graphically position channels in the surround field. The plug-in is described in detail in the section “Using the SurroundPanner V5” on page 220.
- Cubase supports surround-specific plug-ins, that is plug-ins with multi-channel support specifically designed for surround sound mixing tasks (the included “Mx6to2” plug-in is an example of this). Furthermore, any VST3 plug-in features multi-channel support and can therefore be used in a surround configuration, even if it was not specifically designed for surround. This is described in detail in the section “Using effects in multi-channel configurations (Cubase only)” on page 191. All plug-ins are described in the separate PDF document “Plug-in Reference”.
- You configure Cubase for surround sound by defining input and output busses in the desired surround format and specifying which audio inputs and outputs are used for the different channels in the busses, see “Preparations” on page 219.

Deliverables

The result of a surround mix in Cubase is either the multi-channel audio sent from the surround output bus to your dubber, or (if you use the Export Audio Mixdown feature) audio file(s) on your hard disk. Exported surround mixes can either be split (one mono file per speaker channel) or interleaved (a single file containing all the surround channels).

Available surround configurations

The following surround configurations are supported in Cubase:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LRCS</td>
<td>LRCS refers to Left Right Center Surround, where the surround speaker is center-rear positioned. This is the original surround format that first appeared as Dolby Stereo in cinema and later as the home cinema format Dolby ProLogic.</td>
</tr>
<tr>
<td>5.0</td>
<td>This is the same as 5.1 (see below) but without the LFE channel. The LFE channel is optional in 5.1 and if you do not plan to use it, you might find this option more convenient.</td>
</tr>
<tr>
<td>5.1</td>
<td>This format is one of the most popular in cinema and DVD. In its various cinema and DVD encoding implementations (established by different manufacturers) it is referred to as Dolby Digital, AC-3, DTS and MPEG 2 Multichannel. 5.1 has one center speaker (mainly used for speech) and four surround speakers (for music and sound effects). Additionally a subchannel (LFE – Low Frequency Effects) with lower bandwidth is used for special low frequency effects.</td>
</tr>
<tr>
<td>LRC</td>
<td>Same as LRCS, but without the surround speaker channel.</td>
</tr>
<tr>
<td>LRS</td>
<td>Left-Right-Surround, with the surround speaker positioned at center-rear.</td>
</tr>
<tr>
<td>LRC+Lfe</td>
<td>Same as LRC but with an Lfe subchannel added.</td>
</tr>
<tr>
<td>LRS+Lfe</td>
<td>Same as LRS but with an Lfe subchannel added.</td>
</tr>
<tr>
<td>Quadro</td>
<td>The original Quadraphonic format for music, with one speaker in each corner. This format was intended for vinyl record players.</td>
</tr>
<tr>
<td>LRCS+Lfe</td>
<td>Same as LRCS but with an Lfe subchannel added.</td>
</tr>
<tr>
<td>Quadro+Lfe</td>
<td>Same as Quadro but with an Lfe subchannel added.</td>
</tr>
<tr>
<td>6.0 Cine</td>
<td>A Left-Right-Center front speaker arrangement with 3 (Left-Right-Center) surround channels.</td>
</tr>
<tr>
<td>6.0 Music</td>
<td>This uses 2 (Left/Right) front channels with Left and Right surround channels and Left and Right Side channels.</td>
</tr>
</tbody>
</table>
Preparations

Output bus configuration
Before you can start working with surround sound, you have to configure a surround output bus, through which all the speaker channels of the selected surround format are routed. How to add and set up busses in the VST Connections window is described in detail in the section “Setting up busses” on page 26.

Child busses
A child bus is a bus within a (wider) bus. The most obvious application of a child bus is to create stereo busses within your surround bus – this allows you to route stereo tracks directly to a stereo speaker pair within the surround bus. You may also want to add child busses in other surround formats (with fewer channels than the “parent bus”).

Once you have created a surround bus, you can add one or several child busses to it by right-clicking the bus and selecting “Add Child Bus”. This is described in detail in the section “Adding child busses (Cubase only)” on page 29.

Routing
In the Routing panel of the Mixer, you can use the Output Routing pop-up menu to route audio-related tracks to output busses or group channels with a surround configuration. For details on routing, see “Routing” on page 164.

Routing channels to individual surround channels
If you want to place an audio source in one separate speaker channel, you can route it directly to that speaker channel. This is useful for premixed material or multi-channel recordings that do not require panning.

- To do this, simply select an individual speaker channel in the Output Routing pop-up menu.
- If a stereo audio channel is routed directly to a speaker channel, the left/right channels are mixed to mono. The pan control for the audio channel governs the balance between the left and right channel in the resulting mono mix. Center pan will produce a mix of equal proportion.

Routing channels to child busses
If you have added a child bus within a surround bus (see above), it appears as a subentry of the surround bus on the Output Routing pop-up menu. Select this option to route a stereo audio channel directly to that stereo speaker pair of the surround bus (e.g. to route a music track directly to the left and right front speakers in a surround channel).

Input bus configuration
To work with surround sound in Cubase, it is often not necessary to configure a surround format input bus. You can record audio files via standard inputs, and easily route the resulting audio channels to surround outputs at any stage. You can also directly import multi-channel files of a specific surround format onto audio tracks of the same format.

You should add a surround input bus in the following circumstances:

- You have existing audio material in a specific surround format, and you wish to transfer this material into Cubase as a single, multi-channel file.
- You wish to record a surround setup “live”.
- You have prepared surround premixes (e.g. stems) that you want to record on a new audio track with a surround configuration.
Using the SurroundPanner V5

Cubase has a special feature for graphically positioning a sound source in the surround field or modifying existing premixes: the SurroundPanner V5. This plug-in distributes the audio from the input channels in various proportions to the output surround channels.

Whether the SurroundPanner V5 can be used for a specific input/output configuration, depends on whether this configuration can be mapped by the panner. The plug-in supports mapping of mono or stereo inputs to any surround configuration.

While you need to open the plug-in panel to access all of the panner features, you can perform basic panning operations also in the following places:

- In the Mixer, a miniature view of the surround plug-in appears at the top of the fader section in the channel strip. You can click and drag directly in the miniature image to move the signal source in the surround field. The volume slider to the right controls the LFE level (if available for the selected surround format).

- To view a slightly larger version of the miniature surround control in the extended Mixer panel, select the Panner option on the View Options pop-up menu. This panner view offers click and drag panning, speaker channel icons reflecting the solo/mute and deactivation states, as well as numerical values for left/right balance, front/rear balance, and LFE amount. You can enter values directly or using the mouse wheel.

- In the Inspector, a miniature surround pan control can be displayed on the Surround Pan tab. This panner view offers click and drag panning as well as speaker channel icons reflecting the solo/mute and deactivation states.

- In all miniature panner views you can scale down your movements by holding the [Shift] key while moving the sound source. This allows you to make fine adjustments.
The plug-in panel

Double-click on any of the miniature panner controls to open the plug-in panel in a separate window.

The SurroundPanner V5 plug-in offers numerous possibilities to position a mono or stereo sound source. If you work visually oriented, you can simply drag the sound source around in the pan area. To help you execute very exact movements you can use modifier keys to limit the movement direction (e.g. for straight front/rear panning).

To perform rotating movements that you cannot achieve by dragging the mouse, you can use the powerful rotation and orbit controls below the pan area. Here you will also find parameters for controlling the signal distribution to the different speaker channels and the advanced scaling controls with which you can influence the size of the sound source itself.

To the left and right of the surround field there are volume meters, showing the input and output levels of all speaker channels. For a detailed description of all the panning options available in the SurroundPanner V5, see below.

The SurroundPanner V5 plug-in offers numerous possibilities to position a mono or stereo sound source. If you work visually oriented, you can simply drag the sound source around in the pan area. To help you execute very exact movements you can use modifier keys to limit the movement direction (e.g. for straight front/rear panning).

To perform rotating movements that you cannot achieve by dragging the mouse, you can use the powerful rotation and orbit controls below the pan area. Here you will also find parameters for controlling the signal distribution to the different speaker channels and the advanced scaling controls with which you can influence the size of the sound source itself.

To the left and right of the surround field there are volume meters, showing the input and output levels of all speaker channels. For a detailed description of all the panning options available in the SurroundPanner V5, see below.
**Speaker channels – Solo and Mute vs. Disabling**

The speakers that are distributed around the surround field represent the output configuration. You can disable speakers or solo/mute them.

![Speaker symbols](image)

- [Alt]/[Option]-click on a speaker symbol to disable that speaker (the speaker symbol is grayed out) so that no audio will be routed to this surround channel. The signal that would otherwise be sent to this speaker is distributed to the other speakers instead. Note that the signal is distributed in such a way that the power level stays constant all the time (see “Constant power” on page 226).

- Click on a speaker symbol to solo that speaker (the speaker symbol turns red). That way you will only hear the signal sent to this speaker. All other speakers are muted (yellow speaker symbol). This can be used for testing purposes, e.g. to make sure that a signal is sent to a specific speaker as intended. Note that you can solo several speakers at the same time by clicking on them one after the other. By [Ctrl]/[Command]-clicking on a speaker symbol, this speaker is soloed exclusively, and all other speakers are muted.

⚠ Solo and Mute cannot be automated!

### Restricting movement

By default, you can click anywhere in the pan area and drag the mouse to move the sound source. If you want the positioning handle to jump to a specific position, you can click once at that position.

However, you can also limit movement to a specific direction, using the corresponding modifier keys (or the arrow icons above the pan area). That way you can scale down your movements, or have the sound source move along a certain axis (e.g. from bottom left to top right).

- When you press a modifier key (e.g. [Ctrl]/[Command]), the corresponding icon above the pan area is highlighted with a lighter border, indicating that this mode is active. As soon as you release the modifier key, you return to standard mode.

- By clicking on one of the icons above the pan area, the corresponding positioning mode is activated persistently. That way you do not have to keep the corresponding modifier key pressed all the time.

To deactivate the selected positioning mode, switch back to standard mode.

### The following modes are available:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Modifier key(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Standard" /></td>
<td>-</td>
<td>Standard mode, no restrictions apply.</td>
</tr>
<tr>
<td><img src="image" alt="Shift" /></td>
<td>[Shift]</td>
<td>Mouse movements are scaled to allow very fine movements. This is useful when panning in the miniature display in the channel strip, for example.</td>
</tr>
<tr>
<td>![Ctrl]/<a href="image">Command</a></td>
<td>[Ctrl]/[Command]</td>
<td>Horizontal movements only.</td>
</tr>
<tr>
<td>![Ctrl]/[Command]-<a href="image">Shift</a></td>
<td>[Ctrl]/[Command]-[Shift]</td>
<td>Vertical movements only.</td>
</tr>
<tr>
<td>![Alt]/<a href="image">Option</a></td>
<td>[Alt]/[Option]</td>
<td>Diagonal movements only (bottom left to top right).</td>
</tr>
<tr>
<td>![Alt]/[Option]-<a href="image">Shift</a></td>
<td>[Alt]/[Option]-[Shift]</td>
<td>Diagonal movements only (bottom right to top left).</td>
</tr>
<tr>
<td>![Shift]-[Ctrl]/[Command]-[Alt]/<a href="image">Option</a></td>
<td>[Shift]-[Ctrl]/[Command]-[Alt]/[Option]</td>
<td>In this mode the mouse pointer immediately jumps to the positioning handle even if it is located outside the pan area (only visible in Overview Mode).</td>
</tr>
</tbody>
</table>

### Panning the left and right channels independently with the mouse

At the top right of the plug-in window you will find the button for the independent positioning mode. If this is activated, you can adjust the left and right input channels (yellow and red balls) independently by clicking and dragging. This is similar to using the two surround pan joysticks found on some hardware consoles.
To move one of the panning balls in this mode, you do not have to click directly on them. You will always move the panning ball that is nearer to the position of the mouse pointer.

When panning in independent positioning mode, automation data is written for several parameters. Due to this, special automation rules apply, see “Automation” on page 225.

Automation data for the independent positioning mode is always written for the complete sound source, not for individual channels. This means it is not possible to record automation for one stereo channel and then add automation for the other stereo channel in a second go, for example.

Overview Mode

When moving the sound source in the pan area, you will notice that the positioning handle can leave the visible pan area (although the channel panning balls cannot). It can be moved so far outside that all channels end up on the perimeter where the positioning handle left the area. If you now use one of the rotation controls, for example, it can be quite hard to understand what is happening, i.e. why the panning balls are moving the way they are.

To get a better understanding of this behavior, you can switch to Overview Mode. Here you can see where the positioning handle is actually located and where the panning balls would be (if they could leave the pan area). These virtual or “ghost” positions are connected to the actual panning balls inside the surround field by a thin line to help you understand complex movements.

• To switch to Overview Mode, click on the eye icon above and to the left of the pan area.

• The Overview Mode is only used for visualizing the complex scenarios that you can create with the Surround-Panner V5. The actual panning is done in the standard view. Therefore, the speakers are visible in this mode, but cannot be soloed/muted or disabled.

Left-right and front-rear panning

These two controls are used to pan the sound source from left to right and front to rear, and vice versa.

This is the same as restricting the movement direction using the [Ctrl]/[Command] and [Ctrl]/[Command]-[Shift] modifiers.

Rotating signals

The Rotate Signal control is used to rotate the source channels around the positioning handle. All input channels circle around the handle (but they cannot move beyond the borders of the surround field).

Orbit controls

The Orbit controls are used to rotate the sound source (including all input channels and the positioning handle) around the center of the surround field.

Orbit Center

This is the main control that allows you to perform the rotation.
**Radius**

When using the Orbit Center control, the Radius encoder allows you to control the distance of the sound source from the center of the surround field (without changing the angle).

An example:

![Radius Examples](image)

The gray circle shows the theoretical path of the sound source when orbiting the center. Since the sound source cannot leave the pan area, it moves along the perimeter instead. At the maximum radius setting (a) the theoretical path lies outside the pan area so that the sound source stays on the perimeter all the time; at a smaller setting (b) the circle is smaller and the sound source moves inside the pan area in the corners.

⚠️ The Rotate Signal, Orbit Center, and Radius controls are endless rotary encoders so that there is no limit as to how far left or right you can rotate the sound source.

⚠️ In terms of automation, the Orbit Center, and Radius controls are not independent parameters as such. Instead, a combination of different automation parameters is used. For more information, see “Automation” on page 225.

**The LFE encoder**

Use the LFE encoder in the plug-in panel to set the signal amount sent to the LFE (Low Frequency Effects) channel. You can also set this using the LFE level slider to the right of the panner in the Mixer channel strip, or by typing in a number in the LFE value field in the panner shown in the extended Mixer view.

⚠️ The LFE channel is used as a full range channel, no low-pass filtering is applied.

**Center Distribution**

The Center Distribution control is used to distribute part or all of the center signal to the left and right front speakers.

For example, this can be useful in the following situation: The center signal is panned directly to the center speaker and the Center Distribution is set to 0%. However, the signal is too discrete for your liking, and you want to add part of the signal to the left and right front speakers to widen it. You can do this by raising the Center Distribution value. At 100%, the center source is provided entirely by the phantom image created by the left and right speakers and using a value in between you can distribute the signal to the three speakers.

A blue line at the top of the surround field indicates the distance up to which a phantom signal is added. If you position the source signal inside this range, the signal is sent to all three channels.

⚠️ Note that for this to work, the front speaker configuration needs to be symmetrical and there can never be more than 3 speakers involved.

**Divergence controls**

The three divergence controls (Front, F/R, and Rear) determine the attenuation curves used when positioning sound sources for X-axis front, Y-axis (front/rear), and X-axis back. If all three controls are set to 0%, positioning a sound source on a speaker sets all other speakers to zero level. With higher values, the other speakers receive a percentage of the sound source.

Blue horizontal and vertical lines visualize the effects when changing the divergence settings.
Surround sound (Cubase only)

For example, by using the front divergence, you can acoustically intensify the distance from the action on screen as perceived by the audience.

- At 0% the perception is very focused (concentrated in one spot).
- At 100% the perception is very diffuse (hard to locate).

The Center Distribution value and the front divergence are combined. If the front divergence is set to 100%, the Center Distribution has no effect.

**Scaling**

The Scale controls allow you to control the horizontal (Width) and vertical (Depth) expansion of the sound source. 100% corresponds to the complete width or depth of the surround field. If you reduce both values to 0%, the distance is reduced to zero and all source channels are centered in one spot.

These controls influence the perception of spatiality and ambience, as well as the traceability of signals.

- At 100% you get a very transparent, clear sound that conveys much spatiality.
- At 0% the signal is less transparent and movements cannot be traced easily.

The Depth parameter is only available for configurations with front and rear channels.

**Input and output level meters**

The meters to the left and right of the pan area show the volume of all input and output speaker channels, respectively. The numeric values below the meters indicate the peak level that has been measured for any of the channels.

**General plug-in controls**

**The Bypass Effect button**

At the top left of the plug-in panel you will find a button to bypass the SurroundPanner V5. If this is activated, the panner attempts to route the input signals to the appropriate output channels (e.g. the left and right front speakers if panning a stereo signal to a 5.1 configuration).

**Mute/Solo buttons**

At the top of the plug-in panel you will find a Mute and a Solo button that are identical with the channel’s Mute/Solo controls (see “Using Solo and Mute” on page 153).

**Read/Write buttons**

Like any other effect plug-in, the SurroundPanner V5 has Read and Write buttons at the top of the window to apply and record automation data (see below).

**Automation**

Most of the parameters in the SurroundPanner V5 plug-in can be automated just like any other channel or insert parameter (see “Enabling and disabling the writing of automation data” on page 228).

Recording automation for the Orbit controls and the independent positioning mode is handled differently, however. Automation data for these parameters is written as a combination of the front-rear panning, left-right panning and the Rotate Signal parameters. For the independent positioning mode, Scaling is added. Due to this you cannot easily modify existing automation data since this would involve too many different parameters. If an automation pass did not yield the desired result, simply try again.
Resetting all parameters

[Alt]/[Option]-click the Reset button in the lower right corner of the plug-in panel to reset all controls to their default values.

Constant power

“What goes in, must come out again.” This principle can be taken literally with regard to the SurroundPanner V5. It means that the power of a source channel is identical to the power of the corresponding output signal.

The advantage of this is that the overall volume as perceived by the listener (= the power) is always the same, regardless of the signal panning, e.g. when you move the sound source in the pan area, disable specific speaker channels, or use the divergence controls.

Exporting a surround mix

When you have set up a surround mix, you can choose to export it using the Export Audio Mixdown function.

You have the following export options when working with a surround configuration:

• Export to “split” format, resulting in one mono audio file for each surround channel.

• Export to interleaved format, resulting in a single multi-channel audio file (e.g. a 5.1 file, containing all six surround channels).

• Under Windows you can also export a 5.1 surround mix to a file in Windows Media Audio Pro format. This is an encoding format tailored for 5.1 surround – see “Windows Media Audio Pro files (Windows only)” on page 491.

For details about exporting to files, see the chapter “Export Audio Mixdown” on page 484.
Automation
Introduction

In essence, automation means recording the values for a particular Mixer or effect parameter. When you create your final mix, you will not have to worry about having to adjust this particular parameter control yourself – Cubase will do it for you.

Working with automation curves

Within a Cubase project, the changes in a parameter value over time are reflected as curves on automation tracks.

About automation curves

There are two kinds of automation curves: "ramp" and "jump":

- Jump curves are created for on/off parameters such as Mute.
- Ramp curves are created for any parameter that generates continuous multiple values, such as fader or encoder movements, etc.

![Examples of jump and ramp automation curves](image)

About the static value line

When you open an automation track for the first time, it does not contain any automation events (unless you have previously adjusted the corresponding parameter with Write automation activated). This is reflected in the event display as a straight horizontal black line, the "static value" line. This line represents the current parameter setting.

- If you have manually added any automation events or used write automation for the corresponding parameter and then disable the reading of automation data, the automation curve will be grayed-out in the event display and the static value line will be used instead.

As soon as Read is enabled, the automation curve will become available.

Enabling and disabling the writing of automation data

You can automation enable tracks and Mixer channels in Cubase by activating their automation Write buttons. Write (W) and Read (R) buttons for all plug-in effects and VST instruments can be found on the corresponding control panels.

- If you activate Write for a channel, virtually all Mixer parameters you adjust during playback for that specific channel are recorded as automation events.
- If Read is activated for a channel, all your recorded Mixer actions for that channel are performed during playback.

The Read and Write buttons for a track in the track list are the same as the Read and Write buttons in the corresponding channel strip in the Mixer.

Note that the Read button is automatically enabled when you enable the Write button. This allows Cubase to read existing automation data at any time. You can separately deactivate Write if you want to only read existing data. It is not possible to activate Write and deactivate Read at the same time.

There are also global Read and Write indicator buttons ("Toggle Read/Write for all tracks") in the common panel of the Mixer and at the top of the track list:

These buttons light up as soon as there is an enabled Read or Write button on any channel/track within your project. Furthermore, they can be clicked to activate or deactivate the Read/Write buttons of all tracks simultaneously.
Writing automation data

There are two approaches you can use to create automation curves: manually (see “Manual writing of automation data” on page 229) and automatically (see “Automatic writing of automation data” on page 229). While manual writing makes it easy to quickly change parameter values at specific points without having to activate playback, automatic writing lets you work much like you would using a “real” mixer.

With both methods, any applied automation data will be reflected in both the Mixer (a fader will move for example) and in the corresponding automation track curve.

Automatic writing of automation data

Every action you perform is automatically recorded on automation tracks which you can later open for viewing and editing.

To enable the recording of automation events, proceed as follows:

1. Open an automation track by clicking on the “Show/Hide Automation” button of a track in the track list.

2. Enable the Write button for the track and adjust the desired parameters in the Mixer, in the Channel Settings window, or in the effect control panel while rolling through the project.

The value settings are recorded and displayed as a curve on the automation tracks. When automation data is being written, the color of the automation track changes to red and the delta indicator in the automation track shows the relative amount by which the new parameter setting deviates from any previously automated value.

3. When you are finished, stop playback and return to the position where you started playback.

4. Disable Write. The Read button remains enabled.

5. Start playback. All actions you recorded will be reproduced exactly.

When dragging a plug-in to a different insert slot on the same channel, any existing automation data will move with the plug-in. When you drag it to an insert slot on a different channel, any existing automation data will not be transferred to the new channel.

Manual writing of automation data

You can add automation events manually by drawing automation curves on an automation track. Proceed as follows:

1. Open an automation track by clicking on the “Show/Hide Automation” button of a track in the track list.

2. In the track list, click on the automation parameter name and select the desired parameter from the pop-up menu.

3. Select the Pencil tool. You can also use various modes of the Line tool for drawing curves, see below.

4. Click on the static value line. An automation event is added, read automation mode is automatically activated, and the static value line changes to a colored automation curve.

5. If you click and hold, you can draw a curve by adding many automation events.

Note that the track color in the track list changes to red to indicate that automation data is being written.
6. When you release the mouse button, the number of automation events is reduced, but the basic shape of the curve remains the same. This "thinning out" of events is governed by the Reduction Level setting in the Automation Settings section of the Automation Preferences, see “Automation Settings” on page 241.

7. If you now activate playback, the automated parameter will change with the automation curve. In the Mixer, the corresponding fader moves accordingly.

8. Repeat the procedure if you are not happy with the result. If you draw over existing events, a new curve is created.

Apart from the Pencil tool, you can use the following tools to draw automation events:

- **Arrow tool**
  If Read is activated and you click on an automation track with the Arrow tool, you can add automation events. Note that events introduced between two existing events that do not deviate from the existing curve are removed as soon as you release the mouse button.

- **Line tool – Line mode**
  To activate the Line tool in Line mode, click on the Line tool and click again to open a pop-up menu where you can select the Line option. If you click on the automation track and drag with the Line tool in Line mode, you can create automation events in a line. This is a quick way to create linear fades, etc.

- **Line tool – Parabola mode**
  To activate the Line tool in Parabola mode, click on the Line tool and click again to open a pop-up menu where you can select the Parabola option. If you click and drag on the automation track with the Line tool in Parabola mode, you can create more “natural” curves and fades. Note that the result depends on the direction from which you draw the parabolic curve.

- **Line tool – Sine, Triangle, or Square mode**
  To activate the Line tool in these modes, click on the Line tool and click again to open a pop-up menu where you can select the desired option. If you click and drag on the automation track with the Line tool in Sine, Triangle, or Square mode and snap to grid is activated, the period of the curve (the length of one curve “cycle”) is determined by the grid setting. If you press [Shift] and drag, you can set the period length manually, in multiples of the grid value.

The Line tool can only be used for ramp type automation curves.

**Editing automation events**

Automation events can be edited much like other events. You can cut, copy, paste, and nudge events, etc.

**Selecting automation events**

- To select a single automation event, click on it with the Arrow tool. The event turns red, and you can drag it in any direction between two events.
- To select multiple events, you can either [Shift]-click on the events or drag a selection rectangle with the Arrow tool. All events inside the selection rectangle will be selected and the automation track editor becomes available, see below.

- To select all automation events on an automation track, right-click the automation track in the track list and choose “Select All Events” from the context menu.
Editing in the automation track editor

The automation track editor allows you to perform additional scaling operations for selection ranges on existing controller curves. The editor is automatically displayed when you drag a selection rectangle (with the Arrow tool) on a ramp type automation track.

In the automation track editor, controls (so called “smart spots”) appear on the borders of the editor. These smart spots allow you to activate a specific editing mode:

<table>
<thead>
<tr>
<th>Editing mode</th>
<th>To activate this mode…</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Vertically</td>
<td>Click in an empty area on the upper border of the editor.</td>
<td>This mode allows you to move the entire curve up or down, which is useful to boost or attenuate an otherwise perfect curve.</td>
</tr>
<tr>
<td>Scale Vertically</td>
<td>Click the smart spot in the middle of the upper border of the editor.</td>
<td>Use this mode to relatively scale the curve, i.e. to raise or lower the values in percent (not by absolute amounts).</td>
</tr>
<tr>
<td>Tilt the left/right part of the curve</td>
<td>Click the smart spot in the upper left/right corner of the editor.</td>
<td>These modes allow you to tilt the left or the right part of the curve, respectively. This is useful if the curve form is exactly the way you want it, but the start or end needs to be boosted or attenuated a bit.</td>
</tr>
<tr>
<td>Compress the left/right part of the curve</td>
<td>[Alt]/[Option]-click the smart spot in the upper left/right corner of the editor.</td>
<td>These modes allow you to compress the left or the right part of the curve.</td>
</tr>
<tr>
<td>Scale Around Absolute Center</td>
<td>Click the smart spot in the middle of the right border of the editor.</td>
<td>This mode allows you to scale the curve around the absolute center, i.e. horizontally around the center of the editor.</td>
</tr>
<tr>
<td>Scale Around Relative Center</td>
<td>[Alt]/[Option]-click the smart spot in the middle of the right border of the editor.</td>
<td>This mode allows you to scale the curve relative to its center.</td>
</tr>
</tbody>
</table>

Stretch Click and drag in the lower part of the editor. This allows you to stretch the selected curve.

To hold down [Shift] while clicking on any of the smart spots, you get the vertical scaling mode.

- To scale the automation curves on several tracks at the same time, drag a selection rectangle across the corresponding automation tracks, hold down [Ctrl]/[Command] and use the scaling smart spots.
- To move the whole selection up/down or left/right, click on an automation event inside the editor and drag the curve.

By pressing [Ctrl]/[Command] when clicking and dragging, you can restrict the direction to horizontal or vertical movement, depending on the direction in which you start dragging.

Snap is taken into account when moving automation curves horizontally.

Removing automation events

There are several ways to remove events:

- By selecting events and pressing [Backspace] or [Delete] or selecting Delete from the Edit menu, or by clicking on an event with the Erase tool. This will remove the events. The curve is redrawn to connect the remaining events.
- By selecting a range (with the Range Selection tool), and pressing [Backspace] or [Delete] or selecting Delete from the Edit menu.
- By clicking on the automation parameter name in the track list and selecting “Remove Parameter” from the pop-up menu. This will remove all automation events from the automation track, and the automation track will be closed.
Automation track operations

Most of the tracks in your project have automation tracks, one for each automated parameter. Automation tracks are hidden by default.

Opening automation tracks

To open an automation track for a channel, proceed as follows:

- Position the mouse pointer over the lower left corner of the track and click the arrow icon (“Show/Hide Automation”) that appears.
- Right-click the track in the track list and select “Show Automation” from the context menu.

By default, the Volume parameter is assigned to the first automation track.

- To open another automation track, position the mouse pointer over the lower left corner of an automation track, and click the “+” sign (“Append Automation Track”) that appears.

By default, the new automation track shows the next parameter in the Add Parameter list (see below).

You can click the “Append Automation Track” button (the “+” sign) for the automation track several times to open additional automation tracks.

If you activate the option “Show Automation Track in Project on Writing Parameter” in the Preferences dialog (Editing page), the corresponding automation track is revealed on writing automation parameters.

Assigning a parameter to an automation track

Default parameters are already assigned to automation tracks when you open them, according to their order in the Add Parameter list.

To select which parameter an open automation track displays, proceed as follows:

1. Open an automation track and click on the automation parameter name.

A parameter list is shown. The contents depend on the track type.

- If the parameter you wish to automate is available on the pop-up menu, you can select it directly.
- If you wish to add a parameter not available on the pop-up menu or if you want to view all parameters that can be automated, proceed with the next step.
2. Select “More…”.
The Add Parameter dialog opens. This dialog shows a list with all parameters that can be automated for the selected channel (sorted into different categories), including the parameters for any assigned insert effects. To view the parameters in a category, click the “+” sign for the corresponding category folder.

3. Select a parameter from the list and click OK.
The parameter will replace the current parameter in the automation track.

Note that the “replacing” of the parameter displayed in the automation track is completely non-destructive. If the automation track contains any automation data for the parameter you just replaced, this data is there, although it is not visible. By clicking on the automation parameter name in the track list, you can switch back to the replaced parameter. On the pop-up menu, all automated parameters are indicated by an asterisk (*) after the parameter name.

Repeat the above procedure to assign all the parameters you want to automate to separate automation tracks.

Tempo changes cannot be automated on automation tracks. This is done using the tempo recording function in the Tempo Track Editor, see “Recording tempo changes (Cubase only)” on page 466.

Removing automation tracks
- To remove an automation track together with all automation events, click the parameter name and select “Remove Parameter” from the pop-up menu.
- To remove all automation tracks from a track that do not contain automation events, select “Remove Unused Parameters” from any of its automation parameter name pop-up menus.
- To remove automation tracks, you can also use the Delete options on the Functions pop-up menu of the Automation panel, see “The Functions pop-up menu” on page 237.

Showing/hiding automation tracks
- To hide a single automation track, position the pointer over the top left border of the automation track in the track list and click the “Hide Automation Track” button (the “-” sign).
- To hide all automation tracks for a track, right-click the corresponding track, and select “Hide Automation” from the context menu.
- To hide all automation tracks for all tracks in the track list, right-click any track and select “Hide All Automation” from the context menu. This option is also available on the Track Folding submenu of the Project menu.
- To show or hide automation tracks, you can also use the options in the Show section of the Automation panel, see “The Show options” on page 240.
Showing only used automation tracks

If a lot of automation tracks are used, it may be impractical to have them all open in the track list. If you want to view only the automation tracks that are used (i.e. those that actually contain automation events), do one of the following:

- To close all automation tracks not containing automation events, right-click any track in the track list and select the “Show All Used Automation” option from the pop-up menu.
  This option is also available on the Track Folding submenu of the Project menu.

- To close all automation tracks for the selected track that do not contain any automation events, right-click a specific track and select the “Show Used Automation (Selected Tracks)” option from the context menu.
  Used automation tracks will be left open.

Muting automation tracks

You can mute individual automation tracks by clicking their Mute buttons in the track list. This allows you to turn off automation for a single parameter.

The “Automation follows Events” setting

If you activate the “Automation follows Events” option on the Edit menu (or in the Preferences dialog, on the Editing page), automation events will automatically follow when you move an event or part on the track.

This makes it easy to set up automation related to a specific event or part, rather than to a specific position in the project. For example, you can automate the panning of a sound effect event (having the sound pan from left to right, etc.) – if you need to move the event, the automation will automatically follow!

The rules are:

- All automation events for the track between the start and end of the event or part are moved.
  If there are automation events at the new position (to which you move the part or event), these are overwritten.

- If you copy an event or part, the automation events are duplicated as well.
The Automation panel (Cubase only)

The Automation panel is a floating window, similar to the Mixer and Transport panel, and can be left open while you work. The Project window will always have the focus.

To show the Automation panel, open the Project menu and select the Automation Panel option or click the “Open Automation Panel” button on the Project window toolbar.

The Read/Write buttons

In the upper part of the Automation panel, you will find Read and Write buttons. These are used to globally enable or disable the Read and Write buttons on all tracks.

- Click “Activate Read for all tracks” to enable all Read buttons on all tracks/channels of your project.
  Clicking “Deactivate Read for all tracks” will disable all Read buttons.
- Click “Activate Write for all tracks” to enable all Write buttons (and, at the same time, all Read buttons) on all tracks/channels of your project.
  Clicking “Deactivate Write for all tracks” will disable all Write buttons. The Read buttons will remain enabled.

Automation modes

Cubase provides three different punch out modes for automation, available on the upper part of the Automation panel and on the Automation Mode pop-up menu on the Project window toolbar.

The three modes available are “Touch”, “Auto-Latch”, and “Cross-Over”. In all three modes, automation data will be written as soon as a parameter control is touched in play mode. They differ in the way the writing of automation data is ended, i.e. in their “punch out” behavior.

Note that you can change the automation mode at any time, i.e. in play or stop mode or during an automation pass. You can also assign key commands to the automation modes, see “Automation key commands” on page 241.

The current automation pass will always punch out as soon as one of the following conditions is met, independent of which automation mode is selected:

- If you disable Write.
- If you stop playback.
- If you activate Fast Forward/Rewind.
- If the project cursor reaches the right locator in Cycle mode.
- If you click in the ruler to move the project cursor (this is user-definable and can be controlled via the Automation panel, see “Automation Preferences” on page 241).
Touch

Typically, you use Touch mode in situations where you want to make a change lasting only a few seconds to an already set up parameter.

As the name implies, Touch will write automation data only for as long as you actually touch a parameter control – punch out occurs as soon as you release the control.

After punch out, the control will return to the previously set value. The Return Time setting (see “Automation Preferences” on page 241) determines how long it takes for the parameter to reach the previously set value.

Auto-Latch

In Auto-Latch mode, there is no specific punch out condition other than those valid in all modes, see above.

Auto-Latch is useful in situations where you want to keep a value over a longer period of time – for example when making EQ settings for a particular scene.

Once your pass has started, the writing of automation data continues for as long as playback lasts or Write is enabled. When you release the control, the last value is kept until you punch out.

Cross-Over

The Cross-Over mode is a kind of “manual return time” option (see “Automation Preferences” on page 241). The Cross-Over mode can be used in situations where you are not satisfied with an automation curve or with the automatically applied return settings. Cross-Over mode allows you to perform a “manual return” to ensure smooth transitions between new and existing automation settings.

For Cross-Over, the punch out condition is crossing over an already existing automation curve after touching the parameter for a second time.

Like in Auto-Latch mode, once the automation pass begins with the first touching of the parameter control, automation data is written for as long as playback lasts.

When you have found the correct value setting, you can release the fader – the automation pass continues, with the value setting remaining the same.

Now, re-touch the fader and move it towards the original value. As soon as you cross the original curve, punch out occurs automatically.

Trim

Trim allows you to update data from a previous pass by adding or removing automation data.

Trim works for channel volume and aux send level adjustments.
When enabling Trim on the Automation panel, a trim curve is positioned in the exact middle position of your automation track. You can use the trim curve to modify the original automation curve. Just drag the trim curve up or down and add automation events to it. These increase or decrease the values of the original automation curve, but allow you to preserve the original data.

Trim data is edited like any other automation data and it is stored with the project. When Trim is activated, all editing and recording affects the trim curve. When you deactivate Trim, the original automation curve will be reset and gets active so that you can edit it.

You can use Trim either in Stop or in Play mode:
- In Stop mode, you can edit the trim curve manually by clicking on it and moving it up or down. The original automation curve is displayed in a lighter color and its values are merged with the trim curve. The resulting automation curve is displayed in a darker color.
- In Play mode, the events of the original automation curve are trimmed as the project cursor passes over them.

**Freeze Trim**

You can freeze your trim curve automatically or manually and render all trim data into a single automation curve.

To freeze your trim curve automatically, open the Freeze Trim pop-up menu in the Automation Settings. Select “On Pass End” to perform a freeze whenever a write operation is finished. Select “On Leaving Trim Mode” to freeze the trim data when Trim mode is switched off (globally or individually for a track).

To freeze your trim curve manually, select the corresponding option on the Freeze Trim pop-up menu in the Automation Settings (see “Automation Preferences” on page 241).

You have the following possibilities to freeze your trim data manually:
- On the automation track, click on the parameter name and select “Freeze Trim” from the pop-up menu to freeze this specific parameter for the track.
- On the Automation panel, open the Functions pop-up menu and select “Freeze All Trim Automation in Project” to freeze the trim automation for all tracks in the project.
- On the Automation panel, open the Functions pop-up menu and select “Freeze Trim Automation of Selected Tracks” to freeze the trim automation of all selected tracks.

**The Functions pop-up menu**

At the top right of the Automation panel, you will find the Functions pop-up menu, which contains a number of global automation commands.
The following functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete All Automation in Project</td>
<td>This removes all automation data from your project.</td>
</tr>
<tr>
<td>Delete Automation of Selected Tracks</td>
<td>This removes all automation data for the selected track(s).</td>
</tr>
<tr>
<td>Delete Automation in Range</td>
<td>This deletes all automation data between the left and right locators on all tracks.</td>
</tr>
<tr>
<td>Freeze All Trim Automation in Project</td>
<td>This freezes all trim automation for all tracks in the project. see “Freeze Trim” on page 237.</td>
</tr>
<tr>
<td>Freeze Trim Automation of Selected Tracks</td>
<td>This freezes all trim automation for the selected tracks, see “Freeze Trim” on page 237.</td>
</tr>
</tbody>
</table>

**The Fill options**

The Fill options define what happens in a specific section of your project when you punch out of a running automation pass.

The Fill options write one particular value across a defined section of your automation track – any previously created data within this section is overwritten.

The following Fill options are available:

**To Punch**

Let’s say you are automating the volume for a pop-song in realtime. The volume must be softer in the chorus section than for the verse. You do not yet know how much softer, but the change in volume from verse to chorus must be abrupt.

Proceed as follows:

1. Select “Touch” as automation mode and click the “To Punch” button once to activate it as Fill option. The “To Punch” button is highlighted.
2. Start playback somewhere during the verse and touch the fader at the moment of change from verse to chorus. The automation pass is punched in.
3. Move the fader until you have found the volume setting you need in the chorus and release the fader to punch out. The volume curve is set from the point of punch out back to where you punched in. The values written while moving the fader to find the right value are deleted, and the volume jumps at exactly the right moment from the value set in the verse to the value found for the chorus.

**To Start**

“To Start” is similar to the “To Punch” option, but with the following difference: When “To Start” is selected, punching out of automation will fill the automation track from where you punched out to the start of the project.

**To End**

Let’s assume you are automating volume for the background tracks of a two-minute part in your project. Rather than holding the fader for two minutes, you can proceed as follows:

1. Select “Touch” as automation mode and click the “To End” button once to activate it as Fill option. The “To End” button is highlighted.
2. Start playback and touch the parameter control to punch in the automation pass.
3. Move the fader until you have found the setting you want and release the fader. This will punch out the writing of automation data. As you let go of the fader, the automation curve will take the found value setting, from where you punched out to the end of the project.
**Loop**

To use the Loop option, you must first set up a loop range with the left and right locators. When you then select Loop, punching out will set the found value within the range defined by the left and right locator.

**Fill combinations**

You can also combine the various Fill options.

- Combining “To Punch” and “To End” will fill the automation track from the punch in position to the end of the project.

Feel free to experiment!

**One shot vs. continuous fill**

The Fill options can be used in two different ways:

- One shot: When you click one of the Fill buttons, it is highlighted, and will be enabled during the next automation pass. Afterwards, the option is disabled again.

- Continuous fill: If you click a Fill button a second time, a lock symbol is displayed on the highlighted button, indicating that you are permanently in “Fill to X” mode and that the operation can be repeated as many times as you wish. Clicking the button a third time disables the corresponding Fill option.

**Drawing curves with Fill enabled**

You can use the Fill options on the Automation panel in combination with the Pencil tool. This provides you with an extremely powerful method for writing automation data manually:

1. Open an automation track and select the Pencil tool.
2. On the Automation panel in the Fill column select “To End”.
3. Click and draw to create an automation curve.
4. Release the mouse button.

At the moment of release, a final automation event is created. The automation curve is written from this last event through to the end of the project. This procedure can be used with all the Fill options.
The Suspend options

<table>
<thead>
<tr>
<th>Suspend Read</th>
<th>Suspend Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume</td>
<td>Volume</td>
</tr>
<tr>
<td>Pan</td>
<td>Pan</td>
</tr>
<tr>
<td>EQ</td>
<td>EQ</td>
</tr>
<tr>
<td>Sends</td>
<td>Sends</td>
</tr>
<tr>
<td>Inserts</td>
<td>Inserts</td>
</tr>
<tr>
<td>Mute</td>
<td>Mute</td>
</tr>
<tr>
<td>Others</td>
<td>Others</td>
</tr>
<tr>
<td>All</td>
<td>All</td>
</tr>
</tbody>
</table>

The parameters or parameter groups selected here are excluded from the reading or writing of automation data – giving you full manual control of these parameters.

- The “Others” options refer to all parameters not covered by Volume, Pan, Mute, EQ, Sends, or Inserts.

Suspend Read

Imagine you have already automated several tracks. While working on the current track, you want one of the other tracks to be louder, to better identify a particular position in your audio material. By suspending Read for the Volume parameter, you regain full manual control and can set the volume to the required level.

- To suspend the reading of automation data for all parameters/parameter groups, click the All button at the bottom of the section.
- When any of the options in the Suspend Read category are enabled, clicking All will disable these buttons.

Suspend Write

Imagine the following situation: To help you concentrate while working on a particular track, you mute several other tracks. However, because write automations are active on these tracks, this mute state is also automated during the next automation pass – a classic situation in mixing.

To avoid inadvertently excluding whole tracks from your mix in this way, you can exclude Mute from all automation writing. Simply click Mute in the Suspend Write category on the Automation panel.

- To suspend the writing of automation data for all parameters/parameter groups, click the All button at the bottom of the Suspend Write category.
- When any of the options in the Suspend Write category are enabled, clicking All will disable these buttons.

• When an automation pass is in progress for a particular parameter and you write-suspend this parameter, it will punch out of the automation pass.

The Show options

The Show options on the Automation panel always affect all tracks. Clicking these buttons opens the automation tracks for the corresponding parameters, e.g. Volume or Pan. This makes it easy to look at your EQ settings on several tracks, for example.

- When you click either Volume, Pan, EQ, Sends, or Inserts, this will open the corresponding automation track(s) for all tracks.
- The automation tracks will be opened even if no automation data was recorded on these tracks.
- For parameter groups (i.e. Pan, EQ, Sends, and Inserts) you can step through the individual parameter sets by repeatedly clicking the respective button.
- When the Used Only button is enabled, clicking one of the options will show you only the corresponding automation tracks for which automation data has already been written.
- When you click Show Used, all automation tracks that contain automation data will be displayed.
- Hide All will hide all open automation tracks.
Automation Preferences

If you click the button in the bottom left of the Automation panel, you open the Automation Preferences. These are divided into General and Automation Settings.

The following options are available:

### Automation Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Data on Tracks</td>
<td>Activate this to show audio waveforms or MIDI events on automation tracks. The events are displayed only if the “Show waveforms” option is enabled in the Preferences dialog (Event Display—Audio) and if “Part Data Mode” (Event Display—MIDI) is set to an option other than “No data.”</td>
</tr>
<tr>
<td>Continue Writing</td>
<td>If you activate this option, the recording of automation will not be blocked when locating to a new position. For example, this can be used to perform multiple automation passes in Cycle mode or if you are using the arranger functions. If this option is deactivated and you write automation data and locate to another position in the project, the writing will be stopped until the mouse button is released or until a Stop command is received.</td>
</tr>
<tr>
<td>Reveal Parameter on Write</td>
<td>If you activate this option, the corresponding automation track is revealed on writing automation parameters. This is useful if you want to have a visual control of all parameters changed on writing.</td>
</tr>
<tr>
<td>Return Time</td>
<td>This determines how fast the automated parameter returns to any previously automated value when you release the mouse button. Set this to a value higher than 0 to prevent sudden jumps in your parameter settings (which may lead to crackles).</td>
</tr>
<tr>
<td>Reduction Level</td>
<td>When punching out, this function will remove all superfluous automation events so that the automation curve contains only the events necessary to reproduce your actions.</td>
</tr>
<tr>
<td>Freeze Trim</td>
<td>In this pop-up menu you can specify how to freeze your trim curve. Select “Manually” if you want to freeze your trim curve manually. Select “On Pass End” if you want a freeze to be performed whenever a write operation is finished. Select “On Leaving Trim Mode” if you want the trim data to freeze automatically when the trim mode is switched off (globally or individually for a track).</td>
</tr>
</tbody>
</table>

### Hints and further options

#### Automation key commands

In the Key Commands dialog (opened from the File menu in Cubase), in the Commands section on the left, you will find an Automation category which lists all automation commands to which you can assign key commands. How to assign key commands is described in detail in the chapter “Key commands” on page 541.

#### About linking and automation

- Cubase allows you to link, in the Mixer window, various parameters between different channels (see “Link/Unlink channels” on page 167). When automating the settings of a channel that is linked to another channel in the Mixer, the parameters of the linked channel will NOT be automated.
- Cubase only: Also, in the Channel Settings window, you can make the send’s panorama settings follow the panorama settings displayed in the channel strip (by enabling the “Send Routing Panners follow Channel Panner” option in the Control Strip section, see “Setting pan for the sends (Cubase only)” on page 197). For linked panners of sends and channels, automating the channel panner will automate the send routing panner as well.

### MIDI controller automation

#### Merging automation data

When working with Cubase, it is possible to record automation data for MIDI controllers in two places: as MIDI part data and as data on an automation track. If you have such “conflicting” automation data, you can specify separately for every parameter how these will be combined during playback. This is done by selecting an Automation Merge Mode in the track list for the automation track.
The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Global Settings</td>
<td>When this is selected, the automation track uses the &quot;global&quot; Automation Merge Mode specified in the MIDI Controller Automation Setup dialog, see below.</td>
</tr>
<tr>
<td>Replace 1 - Part Range</td>
<td>When this is selected, the part data has playback priority over the automation track data, i.e. at the left and right part borders, the automation mode switches abruptly from part to track automation, and vice versa.</td>
</tr>
<tr>
<td>Replace 2 - Last Value Continues</td>
<td>Similar to the above, but part automation only begins when the first controller event within the part is reached. At the end of the part, the last controller value will be kept until an automation event is reached on the automation track.</td>
</tr>
<tr>
<td>Average</td>
<td>When this is selected, the average values between part and track automation will be used.</td>
</tr>
<tr>
<td>Modulation</td>
<td>In this mode, the automation track curve modulates the existing part automation, with higher curve points emphasizing the automation values and lower curve points reducing the automation values even further.</td>
</tr>
</tbody>
</table>

This pop-up menu is only available for controllers that can be recorded both for a part and a track. When the pop-up menu is not available in the track list, the current parameter will not cause any playback conflicts.

For a full list of all the parameters with potential automation data conflicts, open the MIDI Controller Automation Setup dialog, see below.

The settings you make for a controller are applied to all MIDI tracks that use this controller.

**MIDI Controller Automation Setup settings**

In the MIDI Controller Automation Setup dialog, you can specify how existing MIDI automation is handled on playback and where new automation data is recorded, in a MIDI part or as track automation.

Proceed as follows:
1. On the MIDI menu, select “CC Automation Setup…”.
A dialog opens.

   ![MIDI Controller Automation Setup dialog](image)

   Define individual settings for a controller in this table.

2. On the “Record Destination on conflict (global)” pop-up menu, specify the record destination for MIDI controller data.
   This determines which destination will be used if there is a conflict, i.e. if MIDI controller data is received by Cubase and both the Record and the Automation Write buttons are enabled.

   The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI Part</td>
<td>Select this to record MIDI part automation.</td>
</tr>
<tr>
<td>Automation Track</td>
<td>Select this to record the controller data on an automation track in the Project window.</td>
</tr>
</tbody>
</table>

3. On the “Automation Merge Mode (global)” pop-up menu, specify the global Automation Merge Mode, i.e. the mode that will be used for all automation tracks with the “Use Global Settings” setting, see above.
• In the table in the lower section of the dialog, you can specify the record destination and the Automation Merge Mode separately for all the available MIDI controllers. This gives you full control over the MIDI automation (destination as well as merge mode) in your project.

4. Click in the Record Destination column for a MIDI controller to open the pop-up menu where you can choose where you want recorded data of this particular MIDI Controller to end up.

5. Click in the Automation Merge Mode column for a MIDI controller to specify what will happen with data for this specific controller on playback.

All settings you make in this dialog are saved with the project.

• When you create a new project, the default settings will be used. To save the current settings as default settings, click the “Save as Default” button. To return to the default settings, click the Load Default button.
Audio processing and functions
**Background**

Audio processing in Cubase can be called “non-destructive”, in the sense that you can always undo changes or revert to the original versions. This is possible because processing affects audio clips rather than the actual audio files, and because audio clips can refer to more than one audio file. This is how it works:

1. If you process an event or a selection range, a new audio file is created in the Edits folder, within your project folder. This new file contains the processed audio, while the original file is unaffected.

2. The processed section of the audio clip (the section corresponding to the event or selection range) then refers to the new, processed audio file. The other sections of the clip will still refer to the original file.

   - Since all edits are available as separate files, it is possible to undo any processing, at any point and in any order! This is done in the Offline Process History dialog, see “The Offline Process History dialog” on page 254.

   - The original, unprocessed audio file can still be used by other clips in the project, by other projects or by other applications.

**Audio processing**

You apply processing by making a selection and selecting a function from the Process submenu of the Audio menu. Processing is applied according to the following rules:

   - When events are selected in the Project window or the Audio Part Editor, the processing will be applied to these events only. Processing will only affect the clip sections that are referenced by the events.

   - When an audio clip is selected in the Pool, the processing will be applied to the whole clip.

   - When you have made a selection range, the processing will be applied to this range only. Other sections of the clip are not affected.

If you attempt to process an event that is a shared copy (i.e. the event refers to a clip that is used by other events in the project), you are asked whether you want to create a new version of the clip.

If you activate "Please, don't ask again", any further processing you do will conform to the selected method ("Continue" or "New Version"). You can change this setting at any time by using the “On Processing Shared Clips” popup menu in the Preferences dialog (Editing–Audio page). Also, “Create New Version” will now be displayed as an option in the dialog for the processing function.

**Common settings and features**

If there are any settings for the selected Audio processing function, these will appear when you select the function from the Process submenu. While most settings are specific for the function, some features and settings work in the same way for several functions.

**The “More…” button**

If the dialog has a lot of settings, some options may be hidden when the dialog opens. To reveal these, click the “More…” button.

To hide the settings, click the button again (now labeled “Less…”).
**The Preview, Process, and Cancel buttons**

These buttons have the following functionality:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Allows you to listen to the result of the processing with the current settings. Playback will continue repeatedly until you click the button again (the button is labeled “Stop” during Preview playback). You can make adjustments during Preview playback, but the changes are not applied until the start of the next “lap”. Some changes may automatically restart the Preview playback from the beginning.</td>
</tr>
<tr>
<td>Process</td>
<td>Performs the processing and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog without processing.</td>
</tr>
</tbody>
</table>

**Pre/Post-Crossfade**

Some processing functions allow you to gradually mix the effect in or out. This is done with the Pre/Post-Crossfade parameters. For example, if you activate Pre-Crossfade and specify a value of 1000ms, the processing is applied gradually from the start of selection, reaching full effect 1000ms after the start. Similarly, if you activate Post-Crossfade, the processing is gradually removed, starting at the specified interval before the end of the selection.

⚠️ The sum of the Pre-Crossfade and Post-Crossfade times cannot be larger than the length of the selection.

**Envelope**

The Envelope function allows you to apply a volume envelope to the selected audio. The dialog contains the following settings:

### Curve Kind buttons

These determine whether the envelope curve consists of spline curve segments (left button), damped spline segments (middle button) or linear segments (right button).

### Envelope display

Shows the shape of the envelope curve. The resulting waveform shape is shown in dark gray, with the current waveform shape in light gray. You can click on the curve to add points, and click and drag existing points to change the shape. To remove a point from the curve, drag it outside the display.

### Presets

If you have set up an envelope curve that you may want to apply to other events or clips, you can store it as a preset by clicking the Store button.

- To apply a stored preset, select it from the pop-up menu.
- To rename the selected preset, double-click on the name and enter a new one in the dialog that opens.
- To remove a stored preset, select it from the pop-up menu and click Remove.
Fade In and Fade Out

For a description of these functions, see the chapter “Fades, crossfades and envelopes” on page 117.

Gain

Allows you to change the gain (level) of the selected audio. The dialog contains the following settings:

Gain

This is where you set the desired gain, between -50 and +20dB. The setting is also indicated below the Gain display as a percentage.

Clipping detection text

If you use the Preview function before applying the processing, the text below the slider indicates whether the current settings result in clipping (audio levels above 0dB). If that is the case, lower the Gain value and use the Preview function again.

- If you want to increase the level of the audio as much as possible without causing clipping, use the Normalize function instead (see “Normalize” on page 248).

Pre-Crossfade and Post-Crossfade

See “Pre/Post-Crossfade” on page 246.

Merge Clipboard

This function mixes the audio from the clipboard into the audio selected for processing, starting at the beginning of the selection.

⚠️ For this function to be available, you need to have cut or copied a range of audio in the Sample Editor first.

The dialog contains the following settings:

Sources mix

Allows you to specify a mix ratio between the original (the audio selected for processing) and the copy (the audio on the clipboard).

Pre-Crossfade and Post-Crossfade

See “Pre/Post-Crossfade” on page 246.

Noise Gate

Scans the audio for sections weaker than a specified threshold level and replaces them with silence. The dialog contains the following settings:

Threshold

The level below which you want audio to be silenced. Levels below this value will close the gate.
**Attack Time**

The time it takes for the gate to open fully after the audio level has exceeded the threshold level.

**Min. Opening Time**

This is the shortest time the gate will remain open. If you find that the gate opens and closes too often when processing material that varies rapidly in level, try raising this value.

**Release Time**

The time it takes for the gate to close fully after the audio level has dropped below the threshold level.

**Linked Channels**

This is available for stereo audio only. When it is activated, the Noise Gate is opened for both channels as soon as one or both channels exceed the Threshold level. When Linked Channels is deactivated, the Noise Gate works independently for the left and right channel.

**Dry/Wet mix**

Allows you to specify a mix ratio between “dry” and processed sound.

**Pre-Crossfade and Post-Crossfade**

See “Pre/Post-Crossfade” on page 246.

---

**Normalize**

The Normalize function allows you to specify the desired maximum level of the audio. It then analyzes the selected audio and finds the current maximum level. Finally it subtracts the current maximum level from the specified level and raises the gain of the audio by the resulting amount (if the specified maximum level is lower than the current maximum, the gain will be lowered instead). A common use for Normalizing is to raise the level of audio that was recorded at too low an input level. The dialog contains the following settings:

**Maximum**

The desired maximum level for the audio, between -50 and 0 dB. The setting is also indicated below the Gain display as a percentage.

**Pre-Crossfade and Post-Crossfade**

See “Pre/Post-Crossfade” on page 246.

**Phase Reverse**

Reverses the phase of the selected audio, turning the waveform “upside down”.

The dialog contains the following settings:

**Phase Reverse on**

When processing stereo audio, this pop-up menu allows you to specify which channel(s) are phase-reversed.

**Pre-Crossfade and Post-Crossfade**

See “Pre/Post-Crossfade” on page 246.
Pitch Shift

This function allows you to change the pitch of the audio with or without affecting its length. You can also create “harmonies” by specifying several pitches or apply pitch shift based on a user specified envelope curve.

When the Transpose tab is selected, the dialog contains the following parameters:

Keyboard display
This is a graphic overview of the transposition setting. Here, you can specify the transpose interval in semitones.

- The root note is indicated in red. This has nothing to do with the actual key or pitch of the original audio, it just provides a way to display transpose intervals. You can change the root note by using the settings in the Pitch Shift Base section, or by pressing [Alt]/[Option] and clicking in the keyboard display.
- To specify a transpose interval, click on one of the keys. The key is indicated in blue, and the program plays test tones in the base pitch and transpose pitch to give you an audible confirmation.
- If “Multi Shift” is activated (see below), you can click on several keys to create “chords”. Clicking on a blue (activated) key removes it.

Pitch Shift settings
The “Semitones” and “Fine-Tune” settings allow you to specify the amount of pitch shift. You can transpose the audio ±16 semitones, and fine-tune it by ±200 cents (hundredths of semitones).

Volume/Amplitude
Allows you to lower the volume of the pitch-shifted sound.

Multi Shift
When this is activated, you can add several transpose values, creating multi-part harmonies. This is done by adding intervals in the keyboard display (see above). Note that you cannot use the Preview function in Multi Shift mode.

- If the intervals you add make up a standard chord, this chord is displayed to the right.
  Note, however, that to include the base pitch (the original, untransposed sound) in the processed result, you need to click the base key in the keyboard display as well, so that it is displayed in blue.

Listen Key/Chord button
Clicking this button plays a test tone pitched according to the activated interval key on the keyboard display. If “Multi Shift” is activated, this button is called “Listen Chord” and plays all activated intervals as a chord.

Pitch Shift Base
This allows you to set the root note (the red key in the keyboard display). It has nothing to do with the actual pitch, but is an aid for setting up intervals and chords.

Algorithm Settings
This is where you can make settings for the MPEX 4 algorithm. For a description of the available presets, see “About time stretch and pitch shift algorithms” on page 259.

For each quality setting you can choose between the regular setting and a setting where the formants are preserved. If you are processing vocal material, select the Preserve Formant setting in order to preserve the vocal characteristics of the pitch-shifted audio and to avoid a “chipmunk voice” effect.

Time Correction
When this is activated, the pitch shift process will not affect the length of the audio. When this is deactivated, raising the pitch will shorten the audio section and vice versa, much like changing the playback speed on a tape recorder.
Using envelope based Pitch Shift

When the “Envelope” tab is selected, you can specify an envelope curve on which the pitch shift will be based. This allows you to create pitchbend effects, pitch-shift different sections of the audio by different amounts, etc.

Envelope display

Shows the shape of the envelope curve over the waveform image of the audio selected for processing. Envelope curve points above the center line indicate positive pitch shift, while curve points below the center line indicate negative pitch shift. Initially, the envelope curve will be a horizontal, centered line, indicating zero pitch shift.

- You can click on the curve to add points, and click and drag existing points to change the shape. To remove a point from the curve, drag it outside the display.

Curve Kind

These buttons determine whether the envelope curve consists of spline curve segments (left button), damped spline segments (middle button) or linear segments (right button).

Range

This parameter determines the vertical pitch range of the envelope. If set to “4”, moving a curve point to the top of the display corresponds to pitch shifting by +4 semitones. The maximum range is +/-16 semitones.

Transpose and Fine-Tune

These parameters allow you to adjust the value of a curve point numerically:

1. Click on a curve point to select it. The selected point is shown in red.
2. Adjust the Transpose and Fine-Tune parameters to change the pitch of the curve point in semitones and cents, respectively.
Pitch Shift Mode
These are the same parameters as on the Transpose tab, see "Algorithm Settings" on page 249.

Example
Let’s say that you wish to create a pitchbend effect, so that the pitch is raised linearly by exactly 2 semitones in a specific part of the selected audio.

1. Remove all curve points by clicking the Reset button.
2. Select a linear curve by clicking the Curve Kind button to the right.
3. Make sure that the Range parameter is set to 2 semitones or higher.
4. Create a point where you want the pitchbend to start by clicking on the envelope line. Since this is the starting point for the pitchbend, you want its pitch to be zero (the envelope line should still be straight). If necessary, use the Fine-Tune parameter to set the curve point to 0 cents, because this point governs the start point, where you want the pitch transition to begin.
5. Create a new curve point at the horizontal position where you want the pitchbend to reach the full value. This curve point determines the rise time of the pitchbend effect, i.e. the further away from the starting point the new point is positioned, the longer it will take for the pitchbend to reach the full value, and vice versa.
6. With the second point still selected, use the Transpose and Fine-Tune parameters to set the pitch to exactly 2 semitones.
7. Create a new curve point to set the duration of the pitchbend, i.e. the time the pitch will remain transposed by 2 semitones.
8. Finally, create a point where you want the pitchbend to end. You do not have to create a new point if you are at the end of the audio file, since there is always an end point at the right side of the waveform display.
9. If necessary, make additional settings in the Pitch Shift Mode section, see "Algorithm Settings" on page 249.
10. Click Process. The pitchbend is applied according to the specified settings.

Remove DC Offset
This function will remove any DC offset in the audio selection. A DC offset is when there is too large a DC (direct current) component in the signal, sometimes visible as the signal not being visually centered around the “zero level axis”. DC offsets do not affect what you actually hear, but they affect zero crossing detection and certain processing, and it is recommended that you remove them.

⚠️ It is recommended that this function is applied to complete audio clips, since the DC offset (if any) is normally present throughout the entire recording.

There are no parameters for this function. Note that you can check for DC Offset in an audio clip using the Statistics function (see "Statistics" on page 259).

Resample
The Resample function can be used for changing the length, tempo and pitch of an event.

The original sample rate of the event is listed in the dialog. Resample the event to a higher or lower sample rate by either specifying a sample rate or by specifying the difference (as a percentage value) between the original sample rate and the desired new one.

- Resampling to a higher sample rate will make the event longer and cause the audio to play back at a slower speed with a lower pitch.
- Resampling to a lower sample rate will make the event shorter and cause the audio to play back at a faster speed with a higher pitch.
- You can audition the result of the resampling by entering the desired value and clicking “Preview”. The event will then be played back as it will sound after the resampling.
- When you are satisfied with the preview result, click “Process” to close the dialog and apply the processing.

It is recommended that this function is applied to complete audio clips, since the DC offset (if any) is normally present throughout the entire recording.
Reverse
Reverses the audio selection, as when playing a tape backwards. There are no parameters for this function.

Silence
Replaces the selection with silence. There are no parameters for this function.

Stereo Flip
This function works with stereo audio selections only. It allows you to manipulate the left and right channel in various ways.

The dialog contains the following parameters:

Mode
This pop-up menu determines what the function does:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip Left-Right</td>
<td>Swaps the left and right channel.</td>
</tr>
<tr>
<td>Left to Stereo</td>
<td>Copies the left channel sound to the right channel.</td>
</tr>
<tr>
<td>Right to Stereo</td>
<td>Copies the right channel sound to the left channel.</td>
</tr>
<tr>
<td>Merge</td>
<td>Merges both channels on each side for mono sound.</td>
</tr>
<tr>
<td>Subtract</td>
<td>Subtracts the left channel information from the right. This is typically used as a &quot;Karaoke effect&quot;, for removing centered mono material from a stereo signal.</td>
</tr>
</tbody>
</table>

Time Stretch
This function allows you to change the length and "tempo" of the selected audio without affecting the pitch. The dialog contains the following parameters:

Define Bars section
In this section, you set the length of the selected audio and the time signature:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bars</td>
<td>If you use the tempo setting (see below), specify the length of the selected audio here, in bars.</td>
</tr>
<tr>
<td>Beats</td>
<td>If you use the tempo setting, specify the length of the selected audio here, in beats.</td>
</tr>
<tr>
<td>Sign.</td>
<td>If you use the tempo setting, specify the time signature here.</td>
</tr>
</tbody>
</table>

Original Length section
This section contains information and settings regarding the audio selected for processing:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length in Samples</td>
<td>The length of the selected audio, in samples.</td>
</tr>
<tr>
<td>Length in Seconds</td>
<td>The length of the selected audio, in seconds.</td>
</tr>
<tr>
<td>Tempo in BPM</td>
<td>If you are processing music, and know the actual tempo of the audio, you can enter it here as beats per minute. This makes it possible to time-stretch the audio to another tempo, without having to compute the actual time stretch amount.</td>
</tr>
</tbody>
</table>

Audio processing and functions
Resulting Length section

These settings are used if you want to stretch the audio to fit within a specific time span or tempo. The values will change automatically if you adjust the Time Stretch Ratio (see below).

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Samples</td>
<td>The desired length in samples.</td>
</tr>
<tr>
<td>Seconds</td>
<td>The desired length in seconds.</td>
</tr>
<tr>
<td>BPM</td>
<td>The desired tempo (beats per minute). For this to work, you have to know the actual tempo of the audio, and specify this (along with time signature and length in bars) in the Original Length section to the left.</td>
</tr>
</tbody>
</table>

Seconds Range section

These settings allow you to set the desired range for the time stretch.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>Allows you to specify the desired length as a range between two time positions.</td>
</tr>
<tr>
<td>Use Locators</td>
<td>Clicking the diamond-shaped button below the Range fields sets the Range values to the left and right Locator positions, respectively.</td>
</tr>
</tbody>
</table>

Time Stretch Ratio section

The Time Stretch Ratio determines the amount of time stretch as a percentage of the original length. If you use the settings in the Resulting Length section to specify the amount of time stretch, this value will change automatically.

Algorithm section

In this section you can select a time stretch algorithm. The pop-up menu contains various presets sorted into category submenus based on the underlying technology: elastique, MPEX, and Standard. For a description of the available presets, see “About time stretch and pitch shift algorithms” on page 259.

Applying plug-ins (Cubase only)

You can add plug-in effects in realtime during playback (see the chapter “Audio effects” on page 187). However, sometimes it is useful to “permanently” apply effects to one or several selected events. In Cubase, this is done in the following way:

1. Make a selection in the Project window, the Pool or an editor.
2. Effects are applied according to the same rules as Processing (see “Common settings and features” on page 245).
3. Select “Plug-ins” from the Audio menu.
4. Select the desired effect from the submenu. The Process Plug-in dialog opens.

About stereo and mono

If you are applying an effect to mono audio material, only the left side of the effect’s stereo output will be applied.

The process plug-in dialog
If the lower section is hidden, click the “More…” button to display it. Clicking the button again (now labeled “Less…”) will hide the lower section.

The following settings and functions are available in the common, lower section of the dialog:

Wet mix/Dry mix
These two sliders allow you to specify the balance between wet (processed) and dry (original) signal in the resulting clip. Normally the two sliders are “reverse-ganged”, so that raising the Wet mix slider lowers the Dry mix slider by the same amount. However, if you press [Alt]/[Option] and drag a slider, you can move it independently. This allows you to set 80% dry and 80% wet signal, for example. Be careful to avoid distortion.

Tail
This parameter is useful if you are applying an effect that adds material after the end of original audio (such as reverb and delay effects). When the checkbox is activated, you can specify a tail length using the slider. The tail time is included when playing back with the Preview function, allowing you to find the appropriate tail length.

Pre/Post-Crossfade
These settings allow you to gradually mix the effect in or out. For example, if you activate Pre-Crossfade and specify a value of 1000ms, the effect is applied gradually from the start of selection, reaching full effect 1000ms after the start. Similarly, if you activate Post-Crossfade, the processing is gradually removed, starting at the specified interval before the end of the selection.

The sum of the Pre-Crossfade and Post-Crossfade times cannot be larger than the length of the selection.

Preview button
Allows you to listen to the result of the processing with the current settings. Playback will continue repeatedly until you click the button again (the button is labeled “Stop” during Preview playback). You can change the effect settings during Preview playback if needed.

Process button
Applies the effect and closes the dialog.

Cancel button
Closes the dialog without applying the effect.

The Offline Process History dialog
If you want to remove or modify some or all processing from a clip, this can be done in the Offline Process History dialog. Processing that can be modified in the Offline Process History dialog includes the functions on the Process menu, any applied plug-in effects (Cubase only), and Sample Editor operations such as Cut, Paste, Delete and drawing with the Pencil tool.

Due to the clip-file relationship (see “Background” on page 245), it is even possible to modify or remove some processing “in the middle” of the Process History, while keeping later processing! This feature depends on the type of processing performed (see “Restrictions” on page 255).

Proceed as follows:
1. Select the clip in the Pool or one of its events in the Project window.
2. Select “Offline Process History…” from the Audio menu.

The Offline Process History dialog opens.
The left part of the dialog contains a list of all processing you have added to the clip, with the most recent operations at the bottom of the list. The “Start” and “Length” columns indicate which section of the clip was affected by each operation. The “Status” column indicates if the operation can be modified or undone.

3. Locate the operation you want to edit and select it by clicking on it in the list.
   • To modify the settings of the selected processing, click the “Modify” button. This opens the dialog for the processing function or applied effect, allowing you to change the settings. This works just as when you applied the processing or effect the first time.
   • To replace the selected operation with another processing function or effect, select the desired function from the pop-up menu and click the “Replace By” button. If the selected function has settings, a dialog will appear as usual. The original operation will then be removed and the new processing will be inserted in the Offline Process History.
   • To remove the selected operation, click the “Remove” button. The processing is removed from the clip.
   • To undo the selected operation and remove the processing from the clip click the “Deactivate” button. The processing is removed from the clip, but the operation remains in the list. To redo the operation and apply the processing again, click the button, now renamed to “Activate”, again.
4. Click “Close” to close the dialog.

Restrictions
• If there are no settings for the processing function, you cannot modify it.
• If you have applied processing that changes the length of the clip (such as Cut, Insert or Time Stretch), you can only remove this if it is the most recent processing in the Offline Process History (at the bottom of the list in the dialog). If an operation cannot be removed or modified, this is indicated by an icon in the “Status” column. Also, the corresponding buttons will be grayed out.

Freeze Edits
The Freeze Edits function on the Audio menu allows you to make all processing and applied effects permanent for a clip:
1. Select the clip in the Pool or one of its events in the Project window.
2. Select “Freeze Edits...” from the Audio menu.
   • If there is only one edit version of the clip (no other clips refer to the same audio file), the following dialog will appear:

   ![Replace or create new file dialog]

   If you select “Replace”, all edits will be applied to the original audio file (the one listed in the clip’s Path column in the Pool). If you select “New File”, the Freeze Edits operation will create a new file in the Audio folder within the project folder (leaving the original audio file unaffected).
   • If the selected clip (or the clip played by the selected event) has several edit versions (i.e. there are other clips referring to the same audio file), the following alert will appear:

   ![Alert for multiple edit versions]

   As you can see, you do not have the option to Replace the original audio file in this case. This is because that audio file is used by other clips. Select “New File” to have a new file created in the Audio folder within the project folder.

   △ After a Freeze Edits, the clip refers to a new, single audio file. If you open the Offline Process History dialog for the clip, the list will be empty.
Detect Silence

The Detect Silence function searches for silent sections in an event and either splits the event, removing the silent parts from the project, or creates regions corresponding to the non-silent sections.

- To open the Detect Silence dialog, select one or several audio events in the Project window or the Audio Part Editor. On the Audio menu, open the Advanced submenu and select “Detect Silence”.

If you select more than one event, the Detect Silence dialog allows you to process the selected events successively with individual settings or to apply the same settings to all selected events at once.

Adjustments in the waveform display

The upper part of the dialog displays a waveform image of the selected audio event. In case you have selected several audio events, the waveform of the event that you have selected first is shown. You can make the following adjustments:

- With the zoom slider below the waveform to the right, zoom in and out on the waveform.
  
  You can also click in the waveform, keep the mouse button pressed, and move the mouse for zooming. Move the mouse down to zoom in and move it up to zoom out.

- If you have zoomed in on the waveform, it may not be completely visible anymore. In this case, the scroll bar to the left of the zoom slider allows you to scroll through the waveform.
  
  You can also use the mouse wheel for scrolling through the waveform.

- If the Linked option in the Detection section is deactivated, you can use the green square at the beginning and the red square at the end of the audio file to graphically adjust the Open and Close Threshold values (respectively). When “Linked” is activated, you can use either square to adjust both values.
  
  The Open and Close Threshold values in the Detection section reflect these changes.

Making settings and processing

The lower part of the Detect Silence dialog provides settings for the detection and processing of “silent” sections. Proceed as follows:

1. Adjust the settings in the Detection section to the left. The settings have the following functionality:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Threshold</td>
<td>When the audio level exceeds this value, the function &quot;opens&quot;, i.e. lets the sound pass. Audio material below the set level is detected as &quot;silence&quot;. Set this value low enough to open when a sound starts, but high enough to remove unwanted noise during &quot;silent&quot; sections.</td>
</tr>
<tr>
<td>Close Threshold</td>
<td>When the audio level drops below this value, the function &quot;closes&quot;, i.e. sounds below this level are detected as &quot;silence&quot;. This value cannot be higher than the Open Threshold value. Set this value high enough to remove unwanted noise during &quot;silent&quot; sections.</td>
</tr>
<tr>
<td>Linked</td>
<td>If this checkbox is activated, the Open and Close Threshold values are always set to the same value.</td>
</tr>
</tbody>
</table>
257

Audio processing and functions

2. Click the Compute button.
The audio event is analyzed, and the waveform display is redrawn to indicate which sections are considered “silent” according to your settings.

Above the Compute button, the number of detected regions is displayed.

If you activate the Auto checkbox next to the Compute button, the audio event is analyzed (and the display is updated) automatically every time you change the settings in the Detection section of the dialog. Deactivate this option when you are working with very long files, as this process might take some time.

3. Click “Preview” to listen to the result.
The event is played back repeatedly in its entire length, but with the “closed” sections silenced.

4. Adjust the settings in the Detection section until you are satisfied with the result.

5. In the Output section, activate the “Add as Regions” or the “Strip Silence” option, or both.
   “Add as Regions” will create regions according to the non-silent sections. “Strip Silence” will split the event at the beginning and end of each non-silent section, and remove the silent sections in between.

If you activate the “Add as Regions” option, you can specify a name for the regions in the Region Name field. In addition to the name, the regions will be numbered, starting with the number specified in the “Auto Number Start” field.

If you have selected more than one event, you can activate the “Process all selected Events” checkbox to apply the same settings to all selected events.

6. Click the Process button.
The event is split and/or regions are added.

The Spectrum Analyzer

This function analyzes the selected audio, computes the average “spectrum” (level distribution over the frequency range) and displays this as a two-dimensional graph, with frequency on the x-axis and level on the y-axis.

1. Make an audio selection (a clip, an event or a range selection).

2. Select “Spectrum Analyzer” from the Audio menu. A dialog with settings for the analysis appears.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min. time open</td>
<td>Determines the minimum time that the function will remain “open” after the audio level has exceeded the Open Threshold value. If the audio contains repeated short sounds, and you find that this results in too many short “open” sections, try raising this value.</td>
</tr>
<tr>
<td>Min. time closed</td>
<td>Determines the minimum time that the function will remain “closed” after the audio level has dropped below the Close Threshold value. Set this to a low value to avoid removing sounds.</td>
</tr>
<tr>
<td>Pre-roll</td>
<td>Allows you to cause the function to “open” slightly before the audio level exceeds the Open Threshold value. In other words, the start of each “open” section is moved to the left according to the time you set here. This is useful to avoid removing the attack of sounds.</td>
</tr>
<tr>
<td>Post-roll</td>
<td>Allows you to cause the function to “close” slightly after the audio level drops below the Close Threshold value. This is useful to avoid removing the natural decay of sounds.</td>
</tr>
</tbody>
</table>

If you have selected more than one event and did not activate the “Process all selected Events” option in the Output section, the dialog opens again after processing, allowing you to make separate settings for the next event.
Audio processing and functions

The default values give good results in most situations, but you can adjust the settings if you like:

3. Click the Process button.
The spectrum is computed and displayed as a graph.

4. You can adjust the display with the settings in the display window:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dB</td>
<td>When this is activated, the vertical axis shows dB values. When it is deactivated, values between 0 and 1 are shown.</td>
</tr>
<tr>
<td>Freq. log</td>
<td>When this is activated, frequencies (on the horizontal axis) are displayed on a logarithmic scale. When it is deactivated, the frequency axis is linear.</td>
</tr>
<tr>
<td>Precision</td>
<td>Indicates the frequency resolution of the graph. This value cannot be changed here, but is governed by the Size in Samples setting in the previous dialog.</td>
</tr>
<tr>
<td>Frequency/Note</td>
<td>Allows you to select whether you want the frequencies to be displayed in Hertz or with note names.</td>
</tr>
</tbody>
</table>

5. If you move the mouse pointer over the graph, a cross-hair cursor follows the graph curve and the display in the upper right corner shows the frequency/note and level at the current position.

To compare the level between two frequencies, move the pointer to one of the frequencies, right-click once and move the pointer to the second frequency. The delta value (the difference in level between the current position and the right-click position) is displayed in the upper right corner (labeled “D”).

- If you analyze stereo audio and selected the “Stereo” option in the first dialog, the graphs for the left and right channel are superimposed in the display, with the left channel graph in white and the right channel graph in yellow.

The display in the upper right corner shows the values for the left channel – to see the right channel values, hold down [Shift]. An “L” or “R” is displayed to indicate which channel values are shown.

6. You can leave the window open or close it by clicking the “Close” button.
If you leave it open and the “Active” checkbox is ticked, the result of the next Spectrum Analysis will be displayed in the same window.
Statistics

The Statistics function on the Audio menu analyzes the selected audio (events, clips or range selections) and displays a window with the following information:

### About time stretch and pitch shift algorithms

In Cubase, time stretching and pitch shifting algorithms are used for numerous operations (e.g. the Time Stretch and Pitch Shift offline processes, in the Sample Editor, or by the Flatten function). Depending on the feature, some or all of the following algorithm presets are available.

### élastique

The élastique algorithm is suited for both polyphonic and monophonic material. The algorithm has three modes, and there are three presets for each mode. The following modes are available:

- **élastique Pro** – This mode offers the best audio quality, without formant preservation.
- **élastique Pro Formant** – This is the same as the Pro mode, but including formant preservation.
- **élastique efficient** – This mode requires less computing power, but has a lower audio quality than the Pro modes.

These modes are available with the following variants:

- **Time** – Timing accuracy is favored over pitch accuracy.
- **Pitch** – Pitch accuracy is favored over timing accuracy.
- **Tape** – The pitch shift is locked to the time stretch (as when playing back a tape with varying speed). Stretching the audio material to a longer duration automatically decreases its pitch. This variant has no effect when used in combination with event transpose or the transpose track.

### MPEX

MPEX is an alternative high-quality algorithm. You can choose between the following quality settings:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPEX – Preview Quality</td>
<td>Use this mode only for preview purposes.</td>
</tr>
<tr>
<td>MPEX – Mix Fast</td>
<td>This mode is a very fast mode for preview. This works best with composite music signals (mono or stereo material).</td>
</tr>
<tr>
<td>MPEX – Solo Fast</td>
<td>Use this mode for single instruments (monophonic material) and voice.</td>
</tr>
<tr>
<td>MPEX – Solo Musical</td>
<td>Same as above but higher quality.</td>
</tr>
<tr>
<td>MPEX – Poly Fast</td>
<td>Use this for processing monophonic and polyphonic material. This is the fastest setting that gives still very good results. You can use this for drum loops, mixes, chords.</td>
</tr>
</tbody>
</table>
Audio processing and functions

When applying the Pitch Shift process, you can choose between the regular setting and a setting where the formants are preserved for each quality setting.

### Standard

The Standard algorithm is optimized for CPU efficient realtime processing. The following presets are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPEX – Poly Musical</td>
<td>Use this for processing monophonic and polyphonic material. This is the recommended MPEX default quality setting. You can use this for drum loops, mixes, chords.</td>
</tr>
<tr>
<td>MPEX – Poly Complex</td>
<td>This high quality setting is quite CPU-intensive and should be used only when processing difficult material or for stretch factors above 1.3.</td>
</tr>
</tbody>
</table>

When applying the Pitch Shift process, you can choose between the regular setting and a setting where the formants are preserved for each quality setting.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overlap</td>
<td>Overlap is the percentage of the whole grain that will overlap with other grains. Use higher values for material with a stable sound character.</td>
</tr>
<tr>
<td>Variance</td>
<td>Variance is also a percentage of the whole length of the grains, and sets a variation in positioning so that the overlapping area sounds smooth. A Variance setting of 0 will produce a sound akin to time stretching used in early samplers, whereas higher settings produce more (rhythmic) “smearing” effects but less audio artifacts.</td>
</tr>
</tbody>
</table>

### Limitations

Applying time stretching or pitch shifting to audio material can lead to a degradation in audio quality and to audible artifacts. The result depends on many factors, such as the source material, the particular stretch and pitch operations applied, and the selected audio algorithm preset.

As a rule of thumb, smaller changes in pitch or duration cause less degradation. However, there are additional issues one should be aware of when working with time stretching and pitch shifting algorithms.

- In rare cases, editing warped audio events may cause discontinuities at the edit points. You can then try to move the edit point to a different position or bounce the audio event prior to editing.

### Reverse playback and scrubbing

Most of the algorithms used for time stretching and pitch shifting only support forward playback. Reverse playback or scrubbing of warped audio events can lead to recurring artifacts in the playback.

### Pitch and stretch factor limitations

Some algorithms may put limitations on the maximum degree of time stretching or pitch shifting supported. For the élastique presets, the maximum pitch shift factor is 4, and the stretch factor is limited to 10. In case your settings cause a higher factor, Cubase displays a warning message and deactivates the algorithm for the affected events until the settings are changed to stay within the valid bounds.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard – Drums</td>
<td>This mode is best for percussive sounds, because it does not change the timing of your audio. Using this option with certain tuned percussion instruments may lead to audible artifacts. In this case, try the Mix mode as an alternative.</td>
</tr>
<tr>
<td>Standard – Plucked</td>
<td>Use this mode for audio with transients and a relatively stable spectral sound character (e.g. plucked instruments).</td>
</tr>
<tr>
<td>Standard – Pads</td>
<td>Use this mode for pitched audio with slower rhythm and a stable spectral sound character. This minimizes sound artifacts, but the rhythmic accuracy is not preserved.</td>
</tr>
<tr>
<td>Standard – Vocals</td>
<td>This mode is suitable for slower signals with transients and a prominent tonal character (e.g. vocals).</td>
</tr>
<tr>
<td>Standard – Mix</td>
<td>This mode preserves the rhythm and minimizes the artifacts for pitched material that does not meet the above criteria (i.e. with a less homogenous sound character). This preset is selected by default for audio that is not categorized.</td>
</tr>
<tr>
<td>Standard – Custom</td>
<td>This preset allows you to manually tweak the time stretching parameters (see below). By default, the settings that are shown when you open the dialog are those of the last preset used (except if the Solo preset has been selected, see below).</td>
</tr>
<tr>
<td>Standard – Solo</td>
<td>This mode preserves the timbre of the audio. Only use it for monophonic material (solo woodwind/brass instruments or solo vocals, monophonic synths or string instruments that do not play harmonies).</td>
</tr>
</tbody>
</table>

If you select the “Standard – Custom” option, a dialog opens where you can manually adjust the three parameters that govern the sound quality of the time stretching:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grain size</td>
<td>The standard time-stretching algorithm splits the audio into small pieces called “grains”. This parameter determines the size of the grains. For material with many transients, use low grain size values for best results.</td>
</tr>
</tbody>
</table>
The Sample Editor
Window overview

The Sample Editor allows you to view and manipulate audio by cutting and pasting, removing, or drawing audio data, and by processing audio (see the chapter “Audio processing and functions” on page 244). This editing is “non-destructive”: The actual file will remain untouched so that you can undo modifications or revert to the original settings at any time.

The Sample Editor also contains most of the realtime time stretching functions in Cubase. These can be used to match the tempo of audio to the project tempo (see “Warping audio” on page 272).

Another special feature of the Sample Editor is hitpoint detection. Hitpoints allow you to create audio slices, which can be useful in many situations, for example, if you want to change the tempo without introducing artifacts (see “Working with hitpoints and slices” on page 276).

The VariAudio features allow you to edit monophonic vocal recordings in pitch and time, as easily as editing MIDI in the Key Editor. In these realtime pitch modifications the transitions are kept so that the sound remains natural. The pitch detection and correction is “non-destructive”, i.e. you can always undo modifications or revert to the original versions, see “VariAudio (Cubase only)” on page 281 for details.

⇒ The term “loop” is used throughout this chapter and in this context usually means an audio file with a musical time base. That means that the length of the loop represents a certain number of bars and beats at a certain tempo. Playing the loop back at the right tempo in a cycle set to the correct length will produce a continuous loop without gaps.

Opening the Sample Editor

To open the Sample Editor, double-click an audio event in the Project window or the Audio Part Editor, or double-click an audio clip in the Pool. You can have more than one Sample Editor window open at the same time.

⇒ Double-clicking an audio part in the Project window opens the Audio Part Editor, even if the part contains a single audio event only. The Audio Part Editor is described in a separate chapter, see “The Audio Part Editor” on page 294.
The toolbar

The toolbar contains various tools for selecting, manipulating and playing back audio, as well as options that affect the appearance and behavior of the Sample Editor.

In the Musical Information section at the right of the toolbar, the estimated length of your audio file is displayed in bars and beats (PPQ) together with the estimated tempo and the time signature. These values are important for using Musical Mode, see “Musical Mode” on page 272.

The Algorithm pop-up menu allows you to select an algorithm for the realtime time stretching. For more information about the time stretch algorithm, see “Selecting an algorithm for realtime playback” on page 271.

• You can customize the toolbar by right-clicking it and using the context menu to hide or show items. For further information about configuring the toolbar, see “Using the Setup options” on page 534.

Show Audio Event

When the “Show Audio Event” button is activated on the toolbar, the section corresponding to the edited event is highlighted in the waveform display and the Overview. The sections of the audio clip not belonging to the event are shown with a gray background.

• You can adjust the start and end of the event in the clip by dragging the event handles in the waveform display.

⚠️ This button is only available if you have opened the Sample Editor by double-clicking an audio event in the Project window or the Audio Part Editor. It is not available if you have opened the audio event from the Pool.

Snap

The Snap function helps you to find exact positions when editing in the Sample Editor by restricting horizontal movement and positioning to certain grid positions. You turn Snap on or off by clicking the Snap button in the Sample Editor toolbar.

⚠️ The Sample Editor Snap function is independent of the Snap setting in the Project window toolbar or other editors. It has no effect outside the Sample Editor.

Snap to Zero Crossing

When this option is activated, editing is done at zero crossings (positions in the audio where the amplitude is zero). This helps you to avoid pops and clicks, which might otherwise be caused by sudden amplitude changes.

⚠️ The Sample Editor function “Snap to Zero Crossing” is independent of the same setting in the Project window toolbar or other editors. It has no effect outside the Sample Editor.

Auto-Scroll

When the Auto-Scroll option is activated on the Sample Editor toolbar, the waveform display will scroll during playback, keeping the project cursor visible in the editor.

⚠️ This setting is independent of the Auto-Scroll setting in the Project window toolbar or other editors.
The info line

The info line is displayed below the toolbar. It shows information about the audio clip, such as the audio format and the selection range.

Initially, length and position values are displayed in the format specified in the Project Setup dialog. For information about configuring the info line, see “Using the Setup options” on page 534.

- To show or hide the info line, click the “Set up Window Layout” button on the toolbar and activate or deactivate the Info Line option.

The Sample Editor Inspector

On the left in the Sample Editor, you will find the Sample Editor Inspector. It contains tools and functions for working in the Sample Editor.

For more information on the handling of the various Inspector tabs, see the section “Inspector handling” on page 39.

The Definition tab

The Definition tab helps you to adjust the audio grid and define the musical context of your audio. This is useful if you have an audio loop or audio file that you want to match to the project tempo, see “Warping audio” on page 272. If the Definition tab is open, a second ruler is displayed, showing the musical structure of your audio.

The AudioWarp tab

The AudioWarp tab lets you perform timing settings for your audio. This includes applying swing and manually changing the rhythm of the audio by dragging beats to time positions in the grid (see “Applying swing” on page 275 and “Free Warp” on page 275).

- If you click the “Disable Warp Changes” button, any warp modifications you have made are disabled, allowing you to compare the modified sound with the original sound of your audio.

However, the display does not change. The time stretch applied by the Musical Mode is not disabled by this. “Disable Warp Changes” is deactivated when you reset your warp operations or when you close the Sample Editor. It will not be recalled when reopening the Sample Editor.

The VariAudio tab (Cubase only)

On this tab you can edit single notes of your audio file and change their pitch and/or timing, in a way that is similar to the editing of MIDI notes (see “Understanding the waveform display in VariAudio” on page 281). Furthermore, you can extract MIDI from your audio (see “Extracting MIDI” on page 291).

- If you click the “Disable Pitch Changes” button, any pitch modifications you have made are disabled, allowing you to compare the modified sound with the original sound of your audio.

However, the display does not change. “Disable Pitch Changes” is deactivated when you reset your pitch or warp operations or when you close the Sample Editor. It will not be recalled when reopening the Sample Editor.
The Hitpoints tab

On this tab, hitpoints can be marked and edited (see “Working with hitpoints and slices” on page 276). Hitpoints allow you to slice your audio and to create groove quantize maps from your audio. You can also create markers, regions, events, and warp tabs based on hitpoints.

The Range tab

On this tab you will find functions for working with ranges and selections (see “Making selections” on page 268).

The Process tab

This tab regroups the most important audio editing commands from the Audio and Edit menus. For further information on the options contained in the Select Process and Select Plug-in pop-up menus, see the chapter “Audio processing and functions” on page 244.

The overview line

The overview line displays the whole clip. The section currently shown in the main waveform display of the Sample Editor (the viewing area) is indicated by a rectangle in the overview line, and the current selection range is also shown. If the “Show Audio Event” button is activated on the toolbar, event start/end and snap point are shown in the overview line.

• To view other sections of the clip, move the viewing area in the overview line. Click in the lower half of the viewing area and drag to the left or right to move it.

• To zoom in or out, horizontally, resize the viewing area by dragging its left or right edge.

• To define a new viewing area, click in the upper half of the Overview and drag a rectangle.

The ruler

The Sample Editor ruler is located between the overview line and the waveform display. The ruler is explained in detail in the section “The ruler” on page 44. When the Definition tab is open, an additional ruler displays the musical structure of the audio file.
The waveform display and the level scale

The waveform display shows the waveform image of the edited audio clip according to the wave image style set in the Preferences dialog (Event Display–Audio page), see “Adjusting how parts and events are shown” on page 57. To the left of the waveform display a level scale is shown, indicating the amplitude of the audio.

- You can select whether the level is shown as a percentage or in dB. This is done by opening the level scale pop-up menu at the top of the level scale and selecting an option.

- Select the “Show Half Level Axis” option on the context menu of the waveform display, if you want the half level axes to be shown.

General functions

Zooming
Zooming in the Sample Editor is done according to the standard zoom procedures, with the following special notes to keep in mind:

- The vertical zoom slider changes the vertical scale relative to the height of the editor window, in a way similar to the waveform zooming in the Project window (see “Zoom and view options” on page 56). The vertical zoom will also be affected if the ‘Zoom Tool Standard Mode: Horizontal Zooming Only’ preference (Editing–Tools page) is deactivated and you drag a rectangle with the Zoom tool.

The following options relevant to the Sample Editor are available on the Zoom submenu of the Edit menu or the context menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Zooms in one step, centering on the position cursor.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zooms out one step, centering on the position cursor.</td>
</tr>
<tr>
<td>Zoom Full</td>
<td>Zooms out so that the whole clip is visible in the editor.</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>Zooms in so that the current selection fills the editor display.</td>
</tr>
<tr>
<td>Zoom to Selection (Horiz.)</td>
<td>Zooms horizontally so that the current selection fills the editor display.</td>
</tr>
</tbody>
</table>
• When the VariAudio tab is active (see “VariAudio (Cubase only)” on page 281), you can also zoom by holding down [Alt]/[Option] while drawing a selection rectangle around the segments that you want to zoom in on. You can zoom out by holding down [Alt]/[Option] and clicking in an empty area of the waveform.

• The current zoom setting is shown in the info line, as a “samples per screen pixel” value.

  You can zoom in horizontally to a scale of less than one sample per pixel! This is required for drawing with the Pencil tool (see “Drawing in the Sample Editor” on page 268).

• If you have zoomed in to one sample per pixel or less, the appearance of the samples depends on the “Interpolate Audio Images” option in the Preferences dialog (Event Display–Audio page).

  If the option is deactivated, single sample values are drawn as “steps”. If the option is activated, they are interpolated to a “curve” form.

**Auditioning**

While you can use the regular play commands to play back audio when the Sample Editor is open, it is often useful to listen to the edited material only.

  When auditioning, audio is routed to the Control Room (if activated) or to the Main Mix (the default output bus). In Cubase Artist, the Main Mix bus is always used for all auditioning. For information about routing, see “Routing” on page 164.

Clicking the Audition icon on the toolbar plays back the edited audio, according to the following rules:

• If you have made a selection, this selection will be played back.

• If there is no selection and “Show Event” is deactivated, playback will start at the cursor position.

  If the Audition Loop icon is activated, playback will continue repeatedly until you deactivate the Audition Loop icon. Otherwise, the section will be played back once.

  There is a separate Play button for auditioning regions, see “Auditioning regions” on page 271.

**Using the Speaker tool**

If you click somewhere in the waveform display with the Speaker (“Play”) tool and keep the mouse button pressed, the clip is played back from the position where you click. Playback will continue until you release the mouse button.

**Using Acoustic Feedback**

If you activate the “Acoustic Pitch Feedback” button on the toolbar, the audio will be played back when you edit it vertically, i.e. when you change the pitch. This way you can easily audition your modifications.

**Using key commands**

If you activate the “Playback Toggle triggers Local Preview” option in the Preferences dialog (Transport page), you can start/stop auditioning by pressing [Space]. This is the same as clicking the Audition icon on the toolbar.

The Sample Editor also supports the “Preview start” and “Preview stop” key commands in the Media category of the Key Commands dialog. These key commands stop the current playback, whether you are in normal playback or in audition mode.

**Scrubbing**

The Scrub tool allows you to locate positions in the audio by playing back, forwards, or backwards, at any speed:

1. Select the Scrub tool.

2. Click in the waveform display and keep the mouse button pressed.

The project cursor is moved to the position where you clicked.
3. Drag to the left or right.
The audio is played back. The speed and pitch of the playback depend on how fast you drag.

Adjusting the snap point
The snap point is a marker within an audio event. It is used as a reference position when you move events with snap activated, so that the snap point is "magnetic" to whatever snap positions you have selected.

By default, the snap point is set at the beginning of the audio event, but often it is useful to move the snap point to a "relevant" position in the event, such as a downbeat.

To adjust the snap point, proceed as follows:

1. Activate the "Show Audio Event" option on the toolbar, so that the event is displayed in the editor.
2. If needed, scroll until the event is visible, and locate the “S" flag in the event. If you have not adjusted this previously, it is located at the beginning of the event.
3. Click on the “S" flag and drag it to the desired position.

You can also adjust the snap point by setting the project cursor at the desired position and selecting “Snap Point To Cursor” on the Audio menu. The snap point will be set to the position of the cursor. This method can also be used in the Project window and the Audio Part Editor.

It is also possible to define a snap point for a clip (for which there is no event yet).

When you set the grid start on the Definition tab, the snap point is moved to the grid start (see "Correcting the local definition grid" on page 274).

To open a clip in the Sample Editor, double-click it in the Pool. After having set the snap point, you can insert the clip into the project from the Pool or the Sample Editor with the set snap point position.

Events and clips can have different snap points. If you open a clip from the Pool, you can edit the clip snap point. If you open a clip from within the project window, you can edit the event snap point. The clip snap point serves as a template for the event snap point. However, it is the event snap point that is taken into account when snapping.

Drawing in the Sample Editor
It is possible to edit the audio clip at sample level by drawing with the Pencil tool. This can be useful if you need to manually edit out a spike or click, etc.

Proceed as follows:

1. Zoom in to a zoom value lower than 1. This means that there is more than one screen pixel per sample.
2. Select the Pencil tool.
3. Click at the beginning of the section that you want to correct and draw in the new curve. A range selection covering the edited section is automatically applied.

The Pencil tool cannot be used when the VariAudio tab is open.

Making selections
To select an audio section in the Sample Editor, click and drag with the Range Selection tool.

A selected range

• If “Snap to Zero Crossing” is activated on the toolbar, the selection’s start and end are always at zero crossings.
• You can resize the selection by dragging its left and right edge or by [Shift]-clicking.
The current selection is indicated in the corresponding fields on the Range tab of the Sample Editor Inspector. You can fine-tune the selection by changing these values. Note that the values are relative to the start of the clip, rather than to the project timeline.

Using the Select menu

On the Select menu on the Range tab and on the Select submenu of the Edit menu you find the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects the whole clip.</td>
</tr>
<tr>
<td>None</td>
<td>Selects no audio (the selection length is set to “0”).</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all audio between the left and right locator.</td>
</tr>
<tr>
<td>Select Event</td>
<td>Selects only the audio that is included in the edited event. This is grayed out if you have opened the Sample Editor from the Pool (in which case the whole clip is opened for editing, not an event). Cubase only: If the VarAudio tab is open and your audio file is split into separate segments (see “Segments mode” on page 283), all segments are selected.</td>
</tr>
<tr>
<td>Locators to Selection</td>
<td>Sets the locators to encompass the current selection. This is available if you have selected one or several events or made a selection range.</td>
</tr>
<tr>
<td>Locate Selection (Range tab only)</td>
<td>Moves the project cursor to the beginning or end of the current selection. For this to be available, you must have selected one or more events or parts, or made a selection range.</td>
</tr>
<tr>
<td>Loop Selection (Range tab only)</td>
<td>This activates playback from the start of the current selection and keeps starting over again when reaching the selection end.</td>
</tr>
<tr>
<td>From Start to Cursor (Edit menu only)</td>
<td>Selects all audio between the clip start and the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End (Edit menu only)</td>
<td>Selects all audio between the project cursor and the end of the clip. For this to work, the project cursor must be within the clip boundaries.</td>
</tr>
<tr>
<td>Equal Pitch - all Octaves/ same Octave (Cubase only)</td>
<td>This function requires that the audio event has been analyzed using the VariAudio features and that one or several notes are selected. These options select all notes of this event that have the same pitch as the currently selected note(s) (in any octave or in the current octave).</td>
</tr>
<tr>
<td>Left Selection Side to Cursor (Edit menu only)</td>
<td>Moves the left side of the current selection range to the project cursor position. For this to work, the cursor must be within the clip boundaries. This function is not available for VarAudio segments.</td>
</tr>
<tr>
<td>Right Selection Side to Cursor (Edit menu only)</td>
<td>Moves the right side of the current selection range to the project cursor position (or the end of the clip, if the cursor is to the right of the clip). This function is not available for VarAudio segments.</td>
</tr>
</tbody>
</table>

Several of these options are also available on the Sample Editor context menu.

Editing selection ranges

Selections in the Sample Editor can be processed in several ways.

If you attempt to edit an event that is a shared copy (i.e., the event refers to a clip that is used by other events in the project), you are asked whether you want to create a new version of the clip.

- Select “New Version” if you want the editing to affect the selected event only. Select “Continue” if you want the editing to affect all shared copies.

- If you activate the “Please, don’t ask again” option in the dialog, any further editing will conform to the selected method (“Continue” or “New Version”). You can change this setting at any time with the “On Processing Shared Clips” pop-up menu in the Preferences dialog (Editing–Audio page).

- Any changes to the clip are shown in the Offline Process History, making it possible to undo them later (see “The Offline Process History dialog” on page 254).

Cut, Copy, and Paste

The Cut, Copy, and Paste commands (on the Edit menu, on the Process tab of the Sample Editor Inspector, or on the main Edit menu) work according to the following rules:

- Selecting Copy copies the selection to the clipboard.
- Selecting Cut removes the selection from the clip and moves it to the clipboard. The section to the right of the selection is moved to the left to fill the gap.
- Selecting Paste copies the data from the clipboard into the clip. If there is a selection in the editor, this is replaced by the pasted data. If there is no selection, the pasted data is inserted starting at the project cursor. The section to the right of the line is moved to make room for the pasted material.

Delete

Selecting Delete (on the Edit menu, on the Process tab of the Sample Editor Inspector, or on the main Edit menu) removes the selection from the clip. The section to the right of the selection is moved to the left to fill the gap.
Insert Silence

Selecting “Insert Silence” (on the Edit menu, on the Process tab of the Sample Editor Inspector, or on the Range submenu of the main Edit menu) inserts a silent section with the same length as the current selection, at the selection start.

- The selection is not replaced, but moved to the right to make room.
  If you want to replace the selection, use the “Silence” function instead (see “Silence” on page 252).

Processing

The Processing features (on the Select Process menu, on the Process tab of the Sample Editor Inspector, or on the Process submenu of the Audio menu) can be applied to selections in the Sample Editor, as well as the effects (on the Select Plug-in menu on the Process tab of the Sample Editor Inspector or on the Plug-ins submenu of the Audio menu). For more information, see the chapter “Audio processing and functions” on page 244.

Creating a new event from the selection using drag & drop

To create a new event that plays only the selected range, proceed as follows:
1. Make a selection range.
2. Drag the selection range to an audio track in the Project window.

Creating a new clip or audio file from the selection

To extract a selection from an event and either create a new clip or a new audio file, proceed as follows:
1. Make a selection range.
2. Open the context menu and select “Bounce Selection” from the Audio submenu.

A new clip is created and added to the Pool, and another Sample Editor window opens with the new clip. This clip refers to the same audio file as the original clip, but contains the audio corresponding to the selection range only.

Working with regions

Regions are sections within a clip. One of the main uses for regions is Cycle recording, in which the different “takes” are stored as regions (see “Recording audio” on page 97). You can also use this feature for marking important sections in the audio clip. Regions can be dragged into the Project window from the Sample Editor or the Pool to create new audio events.

Regions are best created, edited, and managed in the Sample Editor.

Creating and removing regions

1. Select the range that you want to convert into a region.
2. Click the “Set up Window Layout” button and activate the Regions option.
   The regions list is displayed on the right.
3. Click the Add Region button above the regions list (or select “Event or Range as Region” from the Advanced submenu of the Audio menu).
   A region is created, corresponding to the selected range.
4. To name the region, double-click on it in the list and enter a new name.
   Using this procedure, regions can be renamed at any time.
   - When you click on a region in the regions list, it is instantly displayed in the Sample Editor.
   - To remove a region from a clip, select it in the list and click the Remove Region button above the list.

Creating regions from hitpoints

If your audio event contains calculated hitpoints, you can choose to automatically create regions from hitpoints. This can be useful to isolate recorded sounds. For further information on hitpoints, see “Working with hitpoints and slices” on page 276.
Editing regions
The region selected in the list is displayed in gray in the waveform display and the overview line.

There are two ways to edit the start and end positions of a region:
• Click and drag the region start and end handles in the waveform display (with any tool). When you move the pointer over the handles, it automatically changes to indicate that you can drag the handles.
• Edit the Start and End positions in the corresponding fields in the regions list. The positions are shown in the display format selected for the ruler and info line, but are relative to the start of the audio clip rather than the project timeline.

Auditioning regions
You can listen to a region by selecting it in the list and clicking the Play Region button above the list. The region will play back once or repeatedly, depending on whether the Loop icon on the toolbar is activated or not.

You can also listen to a region by selecting it in the list and clicking the Audition icon on the toolbar. This way you can preview separate regions by clicking on them in the list or by selecting them with the up/down arrow keys on your computer keyboard.

Making selections from regions
If you select a region in the list and click the Select Region button above, the corresponding section of the audio clip is selected (as if you had selected it with the Range Selection tool) and zoomed. This is useful if you want to apply processing to the region only.

You can also double-click a region in the Pool to have its audio clip opened in the Sample Editor with the area of the region automatically selected.

Creating audio events from regions
To create new audio events from regions using drag & drop, proceed as follows:
1. In the list, click on the region and keep the mouse button pressed.
2. Drag the region to the desired position in the project and release the mouse button.
A new event is created.
• You can also use the “Events from Regions” function from the Advanced submenu of the Audio menu (see “Region operations” on page 68).

Exporting regions as audio files
If you create a region in the Sample Editor, the region can be exported to disk as a new audio file. This is done from the Pool, see “Exporting regions as audio files” on page 307.

Selecting an algorithm for realtime playback
On the Algorithm pop-up menu on the toolbar you can select the algorithm preset to be applied during realtime playback. This setting affects warp changes in Musical Mode, FreeWarp, and Swing. For the VariAudio warping and pitching features, the “Standard – Solo” preset must be used and is applied automatically.

The pop-up menu contains various options that govern the audio quality of the realtime time stretching. There are presets for common uses and a Custom option that allows you to manually set warp parameters. The presets are sorted into categories, according to the technology used (élastique or Standard). For a detailed description of the available presets, see “About time stretch and pitch shift algorithms” on page 259.
Musical Mode

Musical Mode allows you to lock audio clips to the project tempo by using realtime time stretching. This is very useful if you want to use audio in your project without worrying too much about timing.

If you want to use Musical Mode, verify that the length in bars corresponds to the audio file you imported. If necessary, listen to your audio and enter the correct length in bars and beats.

When Musical Mode is activated, audio events will adapt to any tempo changes in Cubase, just like MIDI events.

You can activate Musical Mode on the AudioWarp tab, the Definition tab, and the toolbar.

→ It is also possible to activate/deactivate Musical Mode from within the Pool by clicking the corresponding checkbox in the Musical Mode column.

Cubase supports ACID® loops. These loops are standard audio files but with embedded tempo/length information. When ACID® files are imported into Cubase, Musical Mode is automatically activated and the loops will adapt to the project tempo.

Warping audio

Warping is a term used to describe the realtime time stretching of a selected section of audio. Warping is generally used to correct the tempo or timing of audio.

Adjusting loops to the project tempo using Musical Mode

Audio loops are normally short audio files containing a defined number of bars with straight beats. These loops can be adjusted to the project tempo by using the Musical Mode function. Proceed as follows:

1. Import an audio loop into a project and double-click it to open the Sample Editor.
2. From the Algorithm pop-up menu on the toolbar, select the algorithm preset to be applied during realtime playback.
   For details about the available options on the submenus, see “About time stretch and pitch shift algorithms” on page 259.
3. Listen to the loop and, if necessary, correct the Bars and Beats values on the toolbar.
4. Activate the Musical Mode button.
Your loop is warped and stretched automatically to adapt it to the project tempo. The rulers reflect the change.

3. Select a range that is covering one or several bars.
This selection should cover the section that you want to use in your project. The definition grid will be calculated for this section only.

4. Click the Auto Adjust button.
The snap point is moved to the start of the selected range, which is now also the start position of the local definition grid. The lower ruler changes to reflect your edits. The transients, i.e. the bars and beats positions, are marked with vertical lines.

In the Project window, the audio event is now shown with a note symbol and a warp symbol in the upper right corner to indicate that time stretching has been applied.

Adjusting complex audio material to the project tempo using Musical Mode

If you want to use an audio file with unknown tempo or if the beat of your audio file is not straight, you have to change the “definition” of this audio file first. This is done with the Auto Adjust function on the Definition tab of the Sample Editor Inspector.

The Auto Adjust function extracts a “local” definition grid that you can then match with the project tempo using Musical Mode.

⚠️ The Auto Adjust function needs to be applied on a section containing complete bars. Therefore you first need to define a range in your audio material that starts and ends at a bar line.

To extract the definition from an audio file, proceed as follows:

1. Open an audio clip or audio event in the Sample Editor.
2. Open the Definition tab and select a suitable value from the Grid pop-up menu.
   This determines the grid resolution for your audio.

5. Activate the Musical Mode button.
Your clip is warped and stretched automatically to adapt it to the project tempo. The rulers reflect the change.

⚠️ You can also apply Auto Adjust directly on an audio event or a clip. If no range selection is defined, the grid is calculated for the audio event. If no range selection and no audio event are defined, the grid is calculated for the entire clip. In both cases you need to make sure that the event or clip starts and ends on a bar line.
Correcting the local definition grid

In some situations, you might not be able to get satisfying results with the “Auto Adjust” function. In this case you can manually modify the grid and tempo of your audio file. Proceed as follows:


2. If the grid start does not correspond with the first main beat, move the mouse pointer to the beginning of the audio clip until the tooltip “Set Grid Start” is displayed. The mouse pointer turns into a double arrow.

3. Click and drag the mouse to the right until you reach the first downbeat. Release the mouse button to move the grid start (and snap point). The lower ruler (for the local grid) changes to reflect your edits.

4. Audition the file to determine where the second bar in the sample begins.

5. In the upper part of the waveform, move the mouse pointer to the vertical line nearest to the second bar so that the tooltip “Stretch Grid” and a blue vertical line are shown. “Stretch Grid” allows you to correct the tempo by stretching or compressing the whole grid.

6. Click and drag the blue vertical line to the left or right to the position of the first downbeat in the second bar and release the mouse button. The beginning of the next bar is set, and all bar positions in the grid are adjusted so that the bars have the same length.

7. Check the positions of the following bars. If you find an incorrect bar position, move the mouse pointer over the grid lines in the lower part of the waveform so that the tooltip “Set Bar Position (Move Following Bars)” and a green vertical line are shown. “Set Bar Position” allows you to adjust a single bar line, thereby changing the tempo of one bar only. The bars to the right are moved accordingly, but the area to the left remains unaffected.

8. Click and drag the green vertical line to the left or right to the position of the first downbeat of the following bar and release the mouse button. Repeat the last two steps for all bar lines that need to be corrected.

9. Now have a look at the single beats in between the bars. If you find an incorrect beat position, move the mouse pointer over the corresponding grid line so that the tooltip “Set Beat Position” and a blue vertical line are shown.
10. Click and drag the grid line to align the single beat position with the waveform, and release the mouse button.

- To remove a misplaced beat edit, press any modifier key so that the Eraser tool is shown and click on the adjusted grid line.

- If you want to hear your changes immediately, you can activate Musical Mode for this procedure. The warping will be recalculated after each edit.

Applying swing

If you find that your audio sounds too straight, e.g. after having used the Auto Adjust function, you can add swing. Proceed as follows:

1. Activate Musical Mode.

2. On the AudioWarp tab, select a suitable grid resolution from the Resolution pop-up menu.

   This defines the positions that the swing is applied to. If you select 1/2, the swing is applied in steps of half notes, if you select 1/4, it is applied in steps of quarter notes, etc.

3. On the Algorithm pop-up menu on the toolbar select the algorithm preset that fits the audio material best. For details about the available options, see “Standard” on page 260.

4. Move the Swing fader to the right to offset every second position in the grid.

   This creates a swing or shuffle feel.

Depending on how far you move the fader to the right and what grid resolution you chose, this function offers everything from half-note swing to 64th-note swing.

Free Warp

The Free Warp tool allows you to change the timing of individual positions in the audio material.

The Free Warp tool creates warp tabs. Warp tabs are a kind of marker or anchor that can be attached to musically relevant time positions in an audio event, for example the first beat of every bar. Warp tabs can be dragged to the corresponding time positions in the project, and the audio will be stretched accordingly. Because the Free Warp tool allows you to freely stretch any part of the audio, you can use warp tabs for many operations, such as creative editing.

Warp tabs are typically used for creative tempo editing or further tweaking after having activated Musical Mode.

- When you activate or deactivate Musical Mode or select another Resolution value, all your warp modifications will be lost.

- Warp tabs can also be created from hitpoints (see “Create Warp Tabs” on page 280).
To correct the timing using the Free Warp tool, proceed as follows:

1. Open the audio file that you wish to process in the Sample Editor.

2. Activate the “Snap to Zero Crossing” button on the Sample Editor toolbar.
   When this button is activated, warp tabs will snap to zero crossings.

3. If you want to use the Free Warp tool for selective timing corrections, you can define the local definition grid and activate the Musical Mode function.

The next step is to find out where a warp tab needs to be added.

4. On the Transport panel, use the Click button to activate the metronome click, and play back your audio clip to determine positions where the beat is not on time with the click.
   If you find it difficult to pinpoint an exact position in the audio event, you can use the Scrub tool and/or zoom in the view.

5. On the AudioWarp tab, select the Free Warp tool, place the pointer at the position of the beat that you want to adjust, click, and hold.
   The mouse pointer changes to a clock with arrows on either side and a vertical line in the middle. A new warp tab is inserted.

6. With the mouse button still pressed, drag the warp tab to the desired position and release the mouse button.
   The beat should now be perfectly aligned with the corresponding position in the project. You can also first add warp tabs at the relevant musical positions and change their positions later, see “Editing Warp tabs” on page 289.

Next to the warp tab handle in the ruler, a number is shown. This number indicates the warp factor, i.e. the amount of stretch. Warp factors higher than 1.0 indicate that the audio region preceding the warp tab is expanded and will play back slower. Warp factors lower than 1.0 indicate that the audio region preceding the warp tab is compressed and will play back faster.

**Editing warp tabs**

- To move the destination position of a warp tab (and thus stretch or compress the audio), select the Free Warp tool and position the pointer on the warp line in the waveform, click and drag.

- To change the insert position of a warp tab in the audio, click and drag the warp tab handle in the ruler.

- To disable all warp modifications, click the “Disable Warp Changes” button on the AudioWarp tab. Alternatively you can use the “VariAudio - Disable Warp Changes” key command from the Sample Editor category (see “Key commands” on page 541).

- To delete a warp tab, hold down [Alt]/[Option] so that the pointer becomes an eraser and click on the warp tab. To delete several warp tabs, hold down [Alt]/[Option] while drawing a selection rectangle.

**Resetting warp modifications**

- To reset your Free Warp edits, click the Reset button on the AudioWarp tab.
  This also resets the “Disable Warp Changes” button on the same tab.

- If Musical Mode is activated, only Free Warp edits are reset.

**Working with hitpoints and slices**

Cubase can detect hitpoints, i.e. musically relevant positions, by analyzing onsets and melodic changes. At these positions a type of marker is added. Hitpoints allow you to create slices, where each slice ideally represents each individual sound or “beat” (drum or other rhythmic recordings or loops work best with this feature).

**Purpose and preparation**

The main functions of using hitpoints are to slice up audio to make it fit the project tempo or to create a situation that allows the song tempo to be changed while retaining the timing of a rhythmic audio loop.
When you have successfully detected the hitpoints for an audio file, you can do a number of useful things:

• Change the tempo of the audio material without affecting the pitch and audio quality.
• Extract the timing (a groove map) from a drum loop. The groove map can then be used to quantize other events, see “Create Groove Quantize Preset” on page 111.
• Use slices to replace individual sounds in a drum loop.
• Extract sounds from loops.

You can further edit these slices in the Audio Part Editor. You can, for example:

• Remove or mute slices.
• Change the loop by reordering, replacing, or quantizing slices.
• Apply processing or effects to individual slices.
• Create new files from individual slices using the "Bounce Selection" function on the Audio menu.
• Transpose in realtime and stretch slices.
• Edit slice envelopes.

Hitpoints can also be used to quantize audio material without creating slices. For details about the quantizing functions, see the chapter “Quantizing MIDI and audio” on page 108.

Which audio files can be used?

Here are some guidelines as to what type of audio files are suited for slicing using hitpoints:

• Each individual sound should have a noticeable attack. Slow attacks, legato playing, etc. may not produce the desired result.
• Poorly recorded audio might be difficult to slice correctly. In these cases, try to normalize the files or to remove DC Offset.
• The recorded audio should contain as little crosstalk signals as possible. Crosstalk refers to the “bleeding” of a sound into a microphone placed before another instrument during recording.
• There may be problems with sounds drowned in smearing effects, like short delays.

Adjusting the tempo: warping vs. hitpoints and slices

Both the warping features and the hitpoint detection can be used to alter the tempo and timing of audio material. Warping is very useful for continuous audio material without noticeable gaps between the individual sounds, e.g. piano or vocal recordings.

Using hitpoints has the advantage that the quality of the sound is not affected and no artifacts are being introduced. The audio is cut up into slices that are then moved on the timeline, making this method especially suited for drums, which contain silence between the individual sounds. Furthermore, hitpoint detection is useful for multi-track drum recordings, because the phase alignment is kept stable. Using hitpoints and slices for continuous audio material is not recommended, as it is difficult to fill the gaps caused by moving the slices.

Detecting and filtering hitpoints

Hitpoints are calculated when you activate the “Edit Hitpoints” option on the Hitpoints tab. The audio event is analyzed and the hitpoints are shown as vertical lines.

Depending on the quality and type of the analyzed audio material, you may have to fine-tune the hitpoint detection using the Threshold slider and the Beats pop-up menu. Furthermore you can manually add, edit, or remove hitpoints.

• To filter out hitpoints based on their peaks in dB, use the Threshold slider. The threshold is indicated by a horizontal line. This can be used to eliminate found hitpoints in crosstalk signals, e.g. by keeping the louder bass drum hits and ignoring the quieter crosstalk signals of the snare drum.
• To filter out hitpoints by their musical position, use the Beats pop-up menu. Only hitpoints within a certain range of a defined beat value are allowed. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>All hitpoints are shown (taking the Threshold slider into account).</td>
</tr>
<tr>
<td>1/4, 1/8, 1/16, 1/32</td>
<td>Only hitpoints that are close to the selected note value positions within the loop are shown (e.g. close to exact sixteenth note positions). A second ruler displaying the local definition of the audio file is shown below the ordinary ruler.</td>
</tr>
</tbody>
</table>

When hitpoints have been calculated, they are also visible in the Project window for selected events (provided that the zoom factor is high enough). In the Sample Editor, hitpoints are only displayed in the waveform when the Hitpoints tab is open.
Auditioning and hitpoints

- You can audition the hitpoint slices (i.e. the area between two hitpoints) by pointing and clicking in any slice area. The pointer changes to a speaker icon and the corresponding slice is played back from the beginning to the end.

Navigating between hitpoints

- You can navigate between the slices using the arrow keys or by pressing the [Tab] key.
- You can select the next or previous hitpoint marker using the Locate Next/Previous Hitpoint commands. The default key commands for this are [Alt]/[Option]-[N] and [Alt]/[Option]-[B].

Editing hitpoints

You can change the state of a hitpoint, insert new hitpoints manually, and move existing hitpoints.

Hitpoints can have three different states: enabled, locked, and disabled. “Enabled” is the normal state a hitpoint has immediately after the detection. Hitpoints can be “disabled” so that they are still visible as gray triangles on the timeline, but will not be taken into account for further operations. “Locking” hitpoints is an easy way to make sure that hitpoints are not accidentally filtered out. Locked hitpoints are not affected by the Threshold slider and Beats pop-up menu.

Disabling and locking hitpoints

After applying the different hitpoint filters, you may find that you want to keep individual hitpoints that were filtered out or disable hitpoints that you do not need. Furthermore, you may want to lock certain hitpoints.

- To lock a disabled hitpoint, you can also press [Alt]/[Option] and move the mouse over the waveform. At positions where a disabled hitpoint can be locked, a gray hitpoint line and the tooltip “Lock Hitpoint” are shown. Click to lock the hitpoint.
- To lock multiple hitpoints, press [Shift]-[Alt]/[Option] so that the tooltip “Lock multiple hitpoints” is shown and drag a rectangle over the hitpoints. All enabled and disabled hitpoints within the area defined by the rectangle become locked.
- To disable hitpoints, press [Shift] so that the tooltip “Disable Hitpoints” is shown and click on the line of a single hitpoint or drag a rectangle over all the hitpoints that you want to disable. This way, enabled and locked hitpoints can be disabled.
- To disable a locked hitpoint, you can also point the mouse at the blue hitpoint triangle on the timeline so that the tooltip “Disable Hitpoint” is shown. Click on the triangle.

Resetting hitpoints

Sometimes it can be useful to reset hitpoints to their original state, e.g. because you still want them to be affected by the Threshold slider.

- To reset hitpoints to their original state, press [Ctrl]/[Command]-[Alt]/[Option] so that the tooltip “Enable/Unlock Hitpoints” is shown and drag a rectangle over the hitpoints. All disabled and locked hitpoints within the area defined by the rectangle are reset. Note that some of the hitpoints may still appear as disabled due to the Threshold slider and Beats pop-up menu settings.

Inserting hitpoints

If you get too few hitpoints using the filter options, you can insert hitpoints manually.

- To insert a new hitpoint, press [Alt]/[Option] and click at the position where you want to enter the new hitpoint (i.e. at the start of the sound). Manually added hitpoints are locked by default.

Moving hitpoints

If a hitpoint was either placed too far away from the start of the sound or too far into the sound, you can move it.
To move a hitpoint, press [Alt]/[Option] and point the mouse at the vertical line of the hitpoint. The mouse pointer changes to a double arrow and the tooltip “Move Hitpoint” is shown. You can now drag the hitpoint to its new position.

Moved hitpoints are locked by default.

**Slicing audio**

Once you have set up the hitpoints as needed, you can slice the audio by clicking the Create Slices button on the Hitpoints tab. Alternatively, you can select the “Create Audio Slices from Hitpoints” command from the Hitpoints submenu of the Audio menu.

The following happens:

- The Sample Editor closes.
- The audio event is “sliced” so that the sections between the hitpoints become separate events, all referring to the same original file.
- The audio event is replaced by an audio part, containing the slices (double-click the part to view the slices in the Audio Part Editor).

⚠️ When you create slices, all events referring to the edited clip are also replaced.

- The audio is automatically adapted to the project tempo, taking the specified tempo or bars and beats values into account: if the event was one bar long, the part is resized to fit exactly one bar in the Cubase tempo, and the slices are moved accordingly, keeping their relative positions within the part.
- In the Pool, the sliced clip is shown with a different icon. Dragging the sliced clip from the Pool to an audio track creates an audio part with the slices adapted to the project tempo, just as above.

The audio should now play back seamlessly at the tempo set in the project!

**Slices and the project tempo**

The musical time base setting and the project tempo affect how the sliced audio is played back. Make sure that the “Toggle Time Base” button in the track list or Inspector is set to a musical time base (the button shows a note symbol – see “Defining the track time base” on page 74). This way the loop will follow any further tempo changes.

If the project tempo is slower than the tempo of the original audio event, there may be audible gaps between the slice events in the part. To remedy this, you can apply the “Close Gaps (Timestretch)” function from the Advanced submenu of the Audio menu on the parts containing the slice events. Time stretch is applied to each slice to close the gaps. Depending on the length of the part and the algorithm set in the Preferences dialog (Editing–Audio page), this can take a while.

⚠️ If you open the Pool, you will see that new clips were created, one for each slice.

If you decide to change the tempo again after using the “Close Gaps (Timestretch)” function, undo the Close Gaps operation or start over again, using the original, unstretched file.

Also consider activating auto fades for the corresponding audio track – fade-outs set to about 10ms will help eliminate any clicks between the slices when you play back the part. See “Making Auto Fade settings for individual tracks” on page 123 for details.

If the project tempo is higher than the tempo of the original audio event, the slice events are overlapping. Activate auto crossfades for the track to smooth out the sound (see “Making global Auto Fade settings” on page 122). Furthermore, you can select the overlapping events inside the part and apply the “Delete Overlaps” function from the Advanced submenu of the Audio menu.

The slices in the Audio Part Editor. Here, the project tempo was higher than the clip’s original tempo – the slice events overlap.
Slicing multi-track drum recordings

If you have a multi-track drum recording that you want to quantize using hitpoints, you can put all the tracks belonging to the recording in an edit group, calculate the hitpoints for the relevant tracks (e.g. Kick, Snare, and HiHats), and use the “Divide Audio Events at Hitpoints” command on the Audio menu (Hitpoints submenu) to slice all tracks of the recording at once. This is described in detail in the section “Quantizing multiple audio tracks (Cubase only)” on page 114.

Other hitpoint functions

On the Hitpoints tab of the Sample Editor Inspector, you will also find the following functions. Many of these functions are also available on the Hitpoints submenu of the Audio menu. If selected on the Audio menu, they can be applied on several events and even range selections at the same time.

Create Groove

This function is described in detail in the section “Create Groove Quantize Preset” on page 111.

Create Markers

If an audio event contains calculated hitpoints, you can click the Create Markers button on the Hitpoints tab to add a marker for each hitpoint. If your project has no marker track, it will be added and activated automatically (see “Using markers” on page 138). Markers can be useful to snap to hitpoints, e.g. for locating hitpoints and for using the Time Warp tool (see “The Time Warp tool (Cubase only)” on page 469).

Create Regions

If your audio event contains calculated hitpoints, you can click the Create Regions button on the Hitpoints tab to automatically create regions from hitpoints. This can be useful to isolate recorded sounds.

Create Events

If your audio event contains calculated hitpoints, you can click the Create Events button on the Hitpoints tab to automatically create separate events based on the hitpoints.

Create Warp Tabs

If you want to quantize audio based on hitpoints, you can use this option to create warp tabs from the calculated hitpoints. This option is identical with using the “Create Warp Tabs from Hitpoints” option on the Realtime Processing submenu of the Audio menu.

Create MIDI Notes

You can export your hitpoints to a MIDI part containing a MIDI note for each hitpoint. For example, you can use this function to double, replace, or enrich drum hits by triggering sounds of a VST instrument at the positions of the hitpoints.

- To convert the hitpoints into MIDI notes, click the “Create MIDI Notes” button. Make the desired settings in the Convert Hitpoints to MIDI Notes dialog and click OK.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Velocity Mode / Velocity| Dynamic Velocity Value – The velocity values of the created MIDI notes vary, according to the peak levels of the corresponding hitpoints.  
Fixed Velocity Value – The created MIDI notes get the same velocity value. You can set this value using the Velocity field. |
| Pitch / Length          | Hitpoints do not contain any information about pitch or duration. Therefore, all created MIDI notes get the same pitch and note length. Use these fields to specify the desired values. |
| Destination             | First Selected Track – The MIDI part is placed on the first selected MIDI or instrument track. Note that any MIDI parts from previous conversions that are on this track will be deleted.  
New MIDI Track – A new MIDI track is created for the MIDI part.  
Project Clipboard – The MIDI part is copied into the clipboard so that you can insert it at the desired position on a MIDI or instrument track. |
VariAudio (Cubase only)

With the AudioWarp features, editing audio in the time domain has become significantly easier. However, editing pitch was limited to having just one single numeric “transpose” value per event or part.

VariAudio offers completely integrated vocal editing and pitch alteration of individual notes in monophonic vocal recordings and can solve intonation and timing problems with only a few mouse clicks. It was developed and optimized specifically to be used with monophonic vocal recordings. Though the detection and stretching of notes of other monophonic audio recordings, such as those of a saxophone, may work well, the quality of the end result depends greatly on the generic condition and structure of the recording’s texture.

And how does it work? First, the vocal line is analyzed and split into segments shown as graphic representation of the notes sung. After the detection process is complete, the recognized notes can be modified entirely “non-destructively” so that any modifications to the audio material can be undone.

VariAudio allows you to change your audio on the vertical axis (see “Changing the pitch” on page 285) and on the horizontal axis (see “Warping segments” on page 288).

If you load projects with VariAudio files in Cubase Artist, the original files will be played back and your VariAudio modifications will be ignored. If you want to hear your modifications in Cubase Artist, you will have to bounce the audio files that have been edited with the Cubase VariAudio features.

Understanding the waveform display in VariAudio

When you open monophonic vocal recordings in the Sample Editor and activate the Segments or the Pitch & Warp tool on the VariAudio tab, your audio is analyzed and segmented to display the tonal portions, i.e. the notes sung or played. This process is called segmentation. The segmentation allows you to easily associate the audio with your lyrics and to introduce pitch and timing changes.

In between the different segments you may find gaps where non-tonal portions have been detected, e.g. caused by breath sounds.

At the beginning of the waveform, you can see a gap where no segment is shown.

The audio waveform displayed on the VariAudio tab is always shown as mono, even if you have opened a stereo or multi-channel file.
The vertical position of a segment indicates its average pitch. If the Pitch & Warp tool is active and you move the mouse pointer over a segment, a piano keyboard is displayed, showing the found pitches.

Furthermore, if you move the mouse pointer over a segment and the zoom factor is high enough, the average pitch – note name and fine tuning in cent steps (100ths of a semitone) – is shown on top of the segment. When you select a segment, this is also shown in the info line.

Note pitches represent the perceived fundamental frequency of a sound. The note A4 is perceived to be of the same pitch as a sine wave of 440 Hz. The notation of pitches is a logarithmic frequency scale. The table below shows the relation between pitch (note name) and frequency in Hz:

<table>
<thead>
<tr>
<th>Note</th>
<th>Frequency (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>C4</td>
<td>261.63</td>
</tr>
<tr>
<td>C#4/Db4</td>
<td>277.18</td>
</tr>
<tr>
<td>D4</td>
<td>293.66</td>
</tr>
<tr>
<td>D#4/Eb4</td>
<td>311.13</td>
</tr>
<tr>
<td>E4</td>
<td>329.63</td>
</tr>
<tr>
<td>F4</td>
<td>349.23</td>
</tr>
<tr>
<td>F#4/Gb4</td>
<td>369.99</td>
</tr>
<tr>
<td>G4</td>
<td>392.00</td>
</tr>
<tr>
<td>G#4/Ab4</td>
<td>415.30</td>
</tr>
<tr>
<td>A4</td>
<td>440.00</td>
</tr>
<tr>
<td>A#4/Bb4</td>
<td>466.16</td>
</tr>
<tr>
<td>B4</td>
<td>493.88</td>
</tr>
<tr>
<td>C5</td>
<td>523.25</td>
</tr>
</tbody>
</table>

The average pitch of a segment is calculated from its micro-pitch curve. Micro-pitch curves represent the progression of the pitch for the tonal portion of the audio.

The horizontal position of a segment indicates the time position and the length.

You can navigate through the segments by using the left/right arrow keys on your computer keyboard.

You can zoom in on the segments that you want to edit by holding down [Alt]/[Option] while drawing a selection rectangle. To zoom out, hold down [Alt]/[Option] and click in an empty area of the waveform. If you hold down [Alt]/[Option] and double click in an empty area, the display will be zoomed out to show all segments.

**Applying editing, offline processes, and VariAudio**

The following offline processes and edits that affect the length of the audio file may lead to the reanalysis of the audio material:

- Options on the Select Process menu, on the Process tab of the Sample Editor Inspector, or in the Process submenu of the Audio menu that can be applied to selections.
- Effect processing using the options on the Select Plugin menu on the Process tab of the Sample Editor Inspector or in the Plug-ins submenu of the Audio menu (see the chapter “Audio processing and functions” on page 244).
• Cut, paste, and delete (see "Editing selection ranges" on page 269), or drawing notes (see "Drawing in the Sample Editor" on page 268).

⚠️ Because of the reanalysis any existing VariAudio data becomes invalid. Therefore, you should always apply offline processing or edits before using the VariAudio features.

If you apply editing that affects the audio itself (like cutting portions, etc.) to a file containing VariAudio data, the following warning message is displayed:

• If you click "Proceed", your edits are applied and you will lose your VariAudio data. Click "Cancel" to return to your audio file without applying any changes.

If you apply offline processing to a file containing VariAudio data, the following warning message is displayed:

• If you click "Proceed", your edits are applied, and you will lose your VariAudio data. Click "Cancel" to return to your audio file without applying any changes.

• If you activate the "Please don’t display this warning again" option in one of these warning dialogs before proceeding, Cubase will always proceed with the selected option. You can reactivate the warning messages by deactivating the "Inhibit warning when changing the Sample Data" or "Inhibit warning when applying Offline Processes" options in the Preferences dialog (VariAudio page).

Segments mode

If you activate Segments mode on the VariAudio tab, your audio file is analyzed and split into separate segments.

⚠️ Due to the data gained during this process, the audio and thus the size of your project can increase. Furthermore, the analysis of long audio files might take some time.

When you want to change the pitch of audio that includes non-tonal portions, e.g. consonants or effect sounds like reverb, you may have to edit the segmentation in order to include the non-tonal portions in the segments. Otherwise, pitch modifications will only affect the tonal portions.

Editing the segmentation includes changing the start and end position of a segment, cutting or gluing segments, and moving or deleting them. Just select the section of the file that you want to change, activate Segments mode, and edit the segmentation for the desired section. If you are not satisfied with your changes, you can go back to the original segmentation (see "Reset" on page 290).

⚠️ Editing the segmentation always leads to a recalculation of the segment’s pitch. Therefore, it is recommended that you edit the segmentation before changing the pitch.

In Segments mode, the segments are shown with a hatched background. You can toggle between “Pitch & Warp” and “Segments” mode (see “Pitch & Warp tool” on page 285) by pressing the [Tab] key.

The following paragraphs list the corrections that can be performed when Segments mode is activated.
Changing the note start or end point
If you find that a note starts or ends too early or too late, e.g. when the reverb of a note or a consonant is not included in the segment, proceed as follows:
1. On the VariAudio tab activate Segments mode.
2. To change the length of a segment, move the mouse pointer over the start/end of the segment. The mouse pointer becomes a double arrow.
3. Click and drag the segment start/end to the left or right. The segment length changes accordingly. As the average pitch is recalculated, the segment may jump upwards or downwards. Snap will not be taken into account.
⚠️ If the resulting segment pitch cannot be calculated because of an increase in non-tonal data, the segment will be deleted.
⚠️ You can drag the segment start/end only until it reaches the start/end of the next segment. Segments cannot overlap each other.

Cutting a segment
If you notice that a segment includes more than one note, proceed as follows:
1. On the VariAudio tab activate Segments mode.
2. Move the mouse pointer over the lower border of the segment that you would like to cut. The mouse pointer becomes a scissor.
3. Click at the desired position to cut the segment. The segment is cut accordingly taking Snap into account.
⚠️ When the resulting segment pitch cannot be calculated because of an increase in non-tonal data, the segment will be deleted.
⚠️ There is a minimum size for a segment. Very short segments cannot be cut.

Gluing segments
⚠️ We recommend to correct the segmentation before pitching. If you glue together segments after changing the pitch (this includes manual pitch modifications, Quantize Pitch, and Straighten Pitch), your modifications are reset and the original pitch will be heard.
If you notice that a single note is spread over two segments, proceed as follows:
1. On the VariAudio tab activate Segments mode.
2. Hold down [Alt]/[Option] and move the mouse pointer over the segment that you want to glue to the next. The mouse pointer becomes a glue tube.
3. Click to glue the active segment to the next segment. If several segments are selected, they are all glued together. Snap is not taken into account.
⚠️ If the resulting segment pitch cannot be calculated because of an increase in non-tonal data, the segment will be deleted.
Moving segments horizontally
After cutting a segment it may be necessary to move segments horizontally, for example, if you notice that a note is at the wrong position. Proceed as follows:

1. On the VariAudio tab activate Segments mode.
2. Move the mouse pointer over the upper border of the segment.
The mouse pointer becomes a double arrow.
3. Click and drag the whole segment to the left or right.
The segment is moved accordingly. If several segments are selected, they are all moved together. Snap is not taken into account.

⚠️ If the resulting segment pitch cannot be calculated because of an increase in non-tonal data, the segment will be deleted.

⚠️ You can only drag the segment start/end until it reaches the start/end of the next segment. Segments cannot overlap each other.

Deleting segments
Sometimes it might be useful to delete segments. This is the case in situations where you want the original audio to be played back, e.g. for non-tonal portions or consonants.

- You can delete segments by selecting them in Segments mode and pressing [Backspace].

Saving the segmentation
The corrected segmentation is saved with the project, no additional saving is required.

Pitch & Warp tool
If you activate the Pitch & Warp tool on the VariAudio tab, you can change the pitch and the timing of your audio.

⚠️ Before changing the pitch or timing of your segments, make sure that the segments you want to change are correct (see “Segments mode” on page 283).

You can edit the pitch and timing of audio segments for corrective purposes but also creatively. VariAudio allows you to experiment freely with note pitches in order to change the melody with or without preserving a natural sound. Furthermore, you can change the timing of the audio.

⚠️ In Pitch & Warp mode, the segments are shown with a plain background. You can toggle between “Pitch & Warp” and “Segments” mode by pressing the [Tab] key.

⚠️ There are some restrictions concerning the highest and lowest possible note pitch. You cannot choose note pitches above C5 and below E0.

Changing the pitch
If you want to edit the pitch of a segment, proceed as follows:

1. On the VariAudio tab activate the Pitch & Warp tool.
2. Move the mouse pointer over the segment.
The mouse pointer becomes a hand symbol to indicate that you can change the pitch of the segment. If the zoom factor is high enough, a tooltip indicates the found note pitch and the segment’s deviation from this pitch in percent.
There are three different modes that affect the way in which a note will snap to a certain pitch that can be accessed using the following modifier keys:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default modifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute Pitch Snapping</td>
<td>Pitches the segment to the next semitone.</td>
<td>None</td>
</tr>
<tr>
<td>Relative Pitch Snapping</td>
<td>Snaps the segment in relation to its current deviation in cents, i.e. if the segment has a pitch of C3 and a deviation of 22%, and you move it up by one semitone, it will be pitched to C#3 while keeping the deviation of 22%.</td>
<td>[Ctrl]/[Command]</td>
</tr>
<tr>
<td>No Pitch Snapping</td>
<td>Lets you edit the pitch freely.</td>
<td>[Shift]</td>
</tr>
</tbody>
</table>

The default modifier key can be changed in the Preferences dialog (Editing–Tool Modifier page).

3. Drag the segment up or down to the desired pitch and release the mouse. However, be careful: The more the pitch deviates from the original pitch, the less likely it is that your audio sounds natural.

If the Solo algorithm preset is not turned on already, a warning appears informing you that Cubase has selected it automatically. The segment is pitched accordingly. While dragging, the original micro-pitch curve of the segment is shown in orange. If several segments are selected, they are all pitched.

You can also use the up/down arrow keys on your computer keyboard to edit the note pitches.

Proceed as follows:

- Use the up/down arrow keys to change the pitch in semitone steps.
- Hold down [Shift] while using the up/down arrow keys to change the pitch in cent steps.

⚠️ If you pitch-shift audio events with the Transpose options (see “The transpose functions” on page 131) the transposition is added to the pitch modifications that you introduced with the Pitch & Warp tool, even if this is not reflected in the segmentation display.

Quantize Pitch

You can also quantize the audio pitch upwards or downwards to iteratively reduce the deviation from the nearest semitone position.

Proceed as follows:

1. Select the segments that you want to quantize.
2. Move the Quantize Pitch slider to the right. The selected segments are quantized iteratively.

You can set up a key command for Quantize Pitch in the Sample Editor category of the Key Commands dialog (see “Key commands” on page 541). When using the key command, the segments are directly quantized to the next semitone position.

Tilting the micro-pitch curve

Sometimes changing the pitch of the whole note segment is not enough. In these cases you will have to modify how the pitch changes inside the segment. This is indicated by the micro-pitch curve (see “Understanding the waveform display in VariAudio” on page 281).

⚠️ The micro-pitch curve displays the progression of the pitch for the tonal portion of the segment. For non-tonal portions of the audio, micro-pitch curves cannot be shown.

Proceed as follows:

1. On the VariAudio tab, activate the Pitch & Warp tool.
2. To change the micro-pitch of a segment, move the mouse pointer over the top left/right corner of the segment. The mouse pointer becomes an up/down arrow.
3. Drag upwards/downwards with the mouse to change the micro-pitch curve.
If you want to change the pitch modulation only for the segment start or end, you can set an "anchor point" to specify which part of the segment is affected. Proceed as follows:

1. Move the mouse pointer over the top border of the segment. The mouse pointer becomes an I-beam symbol.
2. Click at the position where you want to set an anchor. A vertical line appears at the position where you clicked. A segment can only have one anchor.
3. Move the mouse pointer over the top left/right corner of the segment and drag upwards or downwards to tilt the micro-pitch curve. The modulation curve is only changed from the segment border to the anchor.

- If you press [Alt]/[Option] while dragging up/down, the tilt anchor is used as an axis around which the micro-pitch curve can be rotated.

4. Repeat the steps above to set anchors and tilt the micro-pitch curve until you are satisfied with the result.

- If you want to remove a tilt anchor from a segment, hold down [Alt]/[Option], position the mouse pointer at the top border of the segment until it turns to a glue tube, and click. The tilt anchor is deleted.

**Straighten Pitch**
If you want to compensate for the rise and fall of notes, i.e. the deviation of the micro-pitch curve from the representative pitch, you can use the Straighten Pitch slider. This correction comes in handy when a note is played flat (pitch rises) or sharp (the pitch falls) at the end. Proceed as follows:

1. Select the segments whose pitch you want to straighten.
2. Move the Straighten Pitch slider to the right. The pitch of the selected segments is straightened.

This micro-pitch looks a bit off. By moving the Straighten Pitch slider to the right...

...the micro-pitch curve is straightened.
MIDI Input

You can change the pitch on the fly by selecting the segment you want to change and pressing a key on your MIDI keyboard or using the Virtual Keyboard (see “The Virtual Keyboard” on page 88).

Proceed as follows:

1. After having corrected the segmentation, select the segment for which you would like to change the pitch.
2. Activate the Pitch & Warp tool and click the MIDI Input button.
3. Press a key on your MIDI keyboard or use the Virtual Keyboard to change the pitch of the segment.
   The pitch of the segment changes according to the note you play.
   The MIDI Input function has two modes: Still mode and Step mode. You can switch between them by [Alt]/[Option]-clicking on the MIDI Input button:
   • In Still mode you can select individual segments by clicking on them and change their pitch by pressing a MIDI key.
     You can also select several segments and press a MIDI key to change the pitch of several segments simultaneously.
     The pitch of the first selected segment is changed to the pitch of the MIDI note you play. The pitches of the other selected segment are changed by the same amount.
   • In Step mode you can step through the segments by selecting the first segment that you would like to change and pressing a MIDI key. The next segment will automatically be selected afterwards. This allows you to work in a more creative way, for example, to develop completely new melody lines via MIDI.
4. When you are done, deactivate the MIDI Input button.
   MIDI controller data like pitchbend or modulation are ignored.

Warping segments

Any correction of the segmentation must be applied before warping segments.

Time correction, i.e. warping at segment level, is useful if you want to align a musical accent to a certain position, or change or quantize the timing of single segments in monophonic vocal recordings. When warping audio segments, warp tabs will be created. These are shown on the VariAudio and the AudioWarp tabs of the Sample Editor Inspector. (For information on warping complete audio files, see “Free Warp” on page 275.)

To warp a segment, proceed as follows:

1. On the VariAudio tab activate the Pitch & Warp tool.
2. To change the timing of a segment, move the mouse pointer over the start/end of the segment.
   The mouse pointer becomes a double arrow and the warp tabs are displayed in the ruler.
3. Drag the start/end of the segment to the desired position.
If the Snap button is activated, the segment border will snap to the grid.
When you drag the segment border, warp tabs are shown not only at the border but also at the adjacent segment borders to indicate which portions of the audio are stretched/affected.

Warping a segment will also change the timing of the adjacent segments.

Timing modifications introduced this way will not adapt to the project tempo. If this is what you want, use Musical Mode (see “Musical Mode” on page 272).

- You can change the insert position of a warp tab in the audio by clicking and dragging the warp tab handle in the ruler. This will change the warping (see “Editing Warp tabs” on page 289).
- Hold down [Shift] (by default) to delete warp tabs. To delete a warp tab, hold down the tool modifier so that the pointer becomes an eraser and click on the warp handle.
- If you are not satisfied with your changes, you can revert the timing of the selected segments by choosing the “Warp Changes” option from the Reset pop-up menu (see “Reset” on page 290).

Editing Warp tabs
In some cases the beginning of the waveform does not correspond to the beginning of a segment, e.g. when the audio starts with non-tonal portions like breath sounds (see “Understanding the waveform display in VariAudio” on page 281). But when it comes to warping, any changes you wish to make must affect the waveform as a whole.

You can of course change the segmentation to achieve this, but if you want to pitch your audio afterwards, this would affect also any non-tonal portions of the audio. If this is not what you want, proceed as follows:

1. Activate the Pitch & Warp tool and activate the Snap button.

In this example the beginning of the segment does not correspond to the beginning of the waveform.

2. Move the mouse pointer over the start of the segment so that it becomes a double arrow and drag the segment start to the beginning of the bar.

The segment border snaps to the grid at the exact bar position.
Now the beginning of the segment matches the beginning of the bar, but we want the beginning of the waveform to match the beginning of the bar:

3. Point at the warp handle displayed in the ruler so that it turns into a double arrow and drag it to the beginning of the waveform.

The background is displayed in orange to indicate which part of the waveform is affected by the change.

Now the beginning of the waveform matches the desired bar position.

Editing warp tabs can also be useful if you change the length of a segment that you have already warped. In this case, editing warp tabs can help you synchronize your audio again.

**Reset**

This pop-up menu at the bottom of the VariAudio tab allows you to reset the modifications you performed with the Pitch & Warp tool. It also lets you reset the changes you made in Segments mode by reanalyzing the audio and returning to the original segmentation. The following options are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch Changes</td>
<td>If you select this option, pitch changes including micro-pitch modifications are reset either for the selected segments (if available) or for the whole file.</td>
</tr>
<tr>
<td>Warp Changes</td>
<td>If you select this option, warp changes are reset.</td>
</tr>
<tr>
<td>Pitch + Warp Changes</td>
<td>If you select this option, pitch, micro-pitch, and warp changes are reset either for the selected segments (if available) or for the whole file.</td>
</tr>
<tr>
<td>Reanalyze Audio</td>
<td>If you select this option, the audio is reanalyzed and all your segmentation changes are reset.</td>
</tr>
</tbody>
</table>

You can set up key commands for the reset and the reanalyze function in the Sample Editor category of the Key commands dialog (see “Key commands” on page 541).

**Listening to your modifications**

You can listen to the results of your modifications using the following methods:

- By activating Acoustic Feedback on the toolbar.
- The segments are played back so that you can easily audition your pitch modifications while editing.
- By using the Play tool on the toolbar.
- By using the Audition and the Audition Loop tool on the toolbar.
- By using cycle playback in the Project window.

If you want to compare the original to the modified audio (i.e. hear the audio without pitch or warp modifications), you have the following possibilities:

- You can disable your pitch modifications by clicking the Disable Pitch Changes button on the VariAudio tab or by setting up and using the “VariAudio - Disable Pitch Changes” key command in the Key Commands dialog, Sample Editor category (see “Key commands” on page 541).
You can disable your warp modifications by clicking the Disable Warp Changes button on the AudioWarp tab or by setting up and using the “VariAudio – Disable Warp Changes” key command in the Key Commands dialog, Sample Editor category (see “Key commands” on page 541).

Extracting MIDI

You can extract a MIDI part from your audio. This is useful if you have an audio event with a certain tune and sound and you want to create an identical second tune with a MIDI instrument or VST instrument. The extracted MIDI part can also be used to print out notes from within the Score Editor or it can be exported as a MIDI file (see “Exporting and importing standard MIDI files” on page 527). Furthermore, you can convert the audio to MIDI notes containing Note Expression data which allows you to adopt the modulation data for individual notes (for information about Note Expression, see the chapter “Note Expression (Cubase only)” on page 428).

Before extracting MIDI from your audio you should correct the segmentation. Otherwise, you will have to correct segmentation errors later in the MIDI part. Transition changes, tilting of the micro-pitch curve, Quantize Pitch settings, and pitch corrections will also be taken into account.

If your audio event references only a section of the audio clip, only this section will be extracted.

The quality of the resulting MIDI data depends on the quality and the characteristics of your audio.

To extract a MIDI part from your audio, proceed as follows:

1. Open the audio file that you want to extract a MIDI part from in the Sample Editor.
2. Open the VariAudio tab.
3. Activate Segments mode (see “Segments mode” on page 283).
4. Click the “Extract MIDI...” button. The “Extract MIDI” dialog opens.
5. On the Pitch Mode pop-up menu, specify which data should be included when extracting the MIDI part.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Just Notes and No Pitchbend Data</td>
<td>Only notes are included in the MIDI part.</td>
</tr>
<tr>
<td>Notes and Static Pitchbend Data</td>
<td>A pitchbend event is created for each segment. Select a pitchbend value from 1 to 24 in the Pitchbend Range field. When you are working with an external MIDI device, it might be necessary to set it to the same value.</td>
</tr>
<tr>
<td>Notes and Continuous Pitchbend Data</td>
<td>Pitchbend events that correspond to the micro-pitch curve are created within the resulting MIDI part. Select a pitchbend value from 1 to 24 in the Pitchbend Range field. The setting should correspond to the value set on your MIDI device or the controlled VST instrument. Note that although the graphic representation of the pitchbend curve is smoothed, all pitchbend data is included.</td>
</tr>
<tr>
<td>Notes and NoteExp Pitchbend Curve</td>
<td>MIDI pitchbend events that correspond to the micro-pitch curve are created as Note Expression data for the resulting MIDI notes (Cubase only).</td>
</tr>
<tr>
<td>Notes and NoteExp VST3 Tuning Curve</td>
<td>VST 3 events for the “Tuning” parameter are created as Note Expression data for the resulting MIDI notes. Note that this works only with a connected VST instrument that is compatible with Note Expression (Cubase only).</td>
</tr>
</tbody>
</table>

6. On the Volume Mode pop-up menu, specify how volume information from the audio is extracted to MIDI.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Velocity</td>
<td>All created MIDI notes get the same velocity. Select a velocity value in the Velocity field.</td>
</tr>
<tr>
<td>Dynamic Velocity</td>
<td>Each created MIDI note gets an individual velocity value according to the amplitude of the audio signal.</td>
</tr>
<tr>
<td>Volume Controller Curve</td>
<td>A continuous volume controller curve is created within the MIDI part. You can select the MIDI controller to be used for the curve in the MIDI Controller field.</td>
</tr>
<tr>
<td>NoteExp Volume Controller Curve</td>
<td>MIDI volume controller events are created as Note Expression data for the resulting MIDI notes (Cubase only).</td>
</tr>
<tr>
<td>NoteExp VST3 Volume Curve</td>
<td>A VST 3 volume curve is created as Note Expression data for the resulting MIDI notes. Note that this works only with a connected VST instrument that is compatible with Note Expression (Cubase only).</td>
</tr>
</tbody>
</table>

7. On the Destination pop-up menu, specify where the MIDI part will be placed.
The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Selected</td>
<td>The MIDI part will be placed on the first selected MIDI or instrument track. Note that any MIDI parts from previous extractions that are on this track will be deleted.</td>
</tr>
<tr>
<td>Track</td>
<td></td>
</tr>
<tr>
<td>New MIDI Track</td>
<td>A new MIDI track will be created for the MIDI part.</td>
</tr>
<tr>
<td>Project Clipboard</td>
<td>The MIDI part is copied into the clipboard so that you can insert it at the desired position on a MIDI or instrument track in the Project window.</td>
</tr>
</tbody>
</table>

If you have opened the Sample Editor from the Pool and the audio file is not part of your project, the MIDI part will be inserted at the beginning of the project.

8. Click OK.
A MIDI part is created according to the specified settings.

You can also use a key command to extract a MIDI part from your audio. In this case no dialog opens and the settings that were used for the previous extraction are used. For further information on how to set up key commands, please refer to the chapter "Key commands" on page 541.

Flattening realtime processing

You can "flatten" realtime processing at any time. This can be done to serve two purposes: to reduce the CPU load and to optimize the sound quality of the processing. Also use this function before applying any offline processing. When the flatten processing is applied, a copy of the original file is automatically created in the Pool so that the original audio clip remains intact.

The flatten function takes the following into account:

- Warp modifications (see "Free Warp" on page 276 and "Warping segments" on page 288), even when Bypass is activated. After the flattening, your Warp tabs will be lost. However, you can undo this function as usual.
- VariAudio pitch modifications (see "Changing the pitch" on page 285), even when Bypass is activated. After the flattening, your VariAudio data will be lost. However, you can undo this operation.
- Event transpose (see "Transposing individual parts or events using the info line" on page 135).

Proceed as follows:

1. Select the audio events that you want to process.
2. On the Audio menu, open the Realtime Processing submenu and select the Flatten command.
A dialog opens where you can select an algorithm for the processing.

⚠️ This dialog will not open when the time stretching factor is outside the range of 0.5 and 2.

- If the audio has been transposed, the dialog also contains the "Formant Correction" option. You can activate this, for example, if you want to avoid a "chipmunk voice" effect.

3. Select an algorithm preset and click OK.
After the processing, any loop that was previously stretched in realtime or had been pitch shifted will play back exactly the same, but Musical Mode will be deactivated and the realtime pitch shifting will be set to 0.

⚠️ Instead of the Flatten menu command, you can click the Flatten button on the Process tab of the Sample Editor.
The audio clip is now like any standard audio clip before applying realtime processing, i.e. it does not follow tempo changes. The flattening processing function is best used when you have determined the tempo or key of a project. If you want to adapt the audio to a new key or tempo after flattening, it is better to revert to the original audio clip rather than to process the already processed file again.

This dialog will not open when the time stretching factor is outside the range of 0.5 and 2.

- If the audio has been transposed, the dialog also contains the "Formant Correction" option. You can activate this, for example, if you want to avoid a "chipmunk voice" effect.

3. Select an algorithm preset and click OK.
After the processing, any loop that was previously stretched in realtime or had been pitch shifted will play back exactly the same, but Musical Mode will be deactivated and the realtime pitch shifting will be set to 0.

⚠️ Instead of the Flatten menu command, you can click the Flatten button on the Process tab of the Sample Editor.
The audio clip is now like any standard audio clip before applying realtime processing, i.e. it does not follow tempo changes. The flattening processing function is best used when you have determined the tempo or key of a project. If you want to adapt the audio to a new key or tempo after flattening, it is better to revert to the original audio clip rather than to process the already processed file again.
Selecting an algorithm for the flattening

When you flatten the realtime processing, you can use the MPEX 4 algorithm or the Realtime algorithm to process the audio. The MPEX 4 algorithm may produce better sound quality than the realtime processing. The Realtime algorithm corresponds to the algorithm preset selected on the Sample Editor toolbar. For a detailed description of the available presets, see “About time stretch and pitch shift algorithms” on page 259.

If you introduced VariAudio pitch modifications, the MPEX presets will not be available and the algorithm preset “Standard – Solo” is used automatically.

The Realtime presets can be selected from the Algorithm pop-up menu on the Sample Editor toolbar, see “Selecting an algorithm for realtime playback” on page 271.

In the Pool, you can select an algorithm for several selected clips at a time.

Unstretching audio files

By selecting “Unstretch Audio” from the Realtime Processing submenu of the Audio menu, all realtime time stretching (by sizing or by warp tabs) is removed.

Note that realtime transpose (in the info line) and Musical Mode will not be removed by this.

Whether the “Unstretch Audio” menu item is available depends on whether the time stretching has been applied at event or clip level:

- If you have sized an audio event in the Project window using “Sizing Applies Time Stretch” (see “Resizing events using time stretch” on page 64), you can undo the time stretching by selecting the event in the Project window and then applying “Unstretch Audio”. This removes all time stretching and warp tabs.

- When you have entered a tempo and/or length on the toolbar, this information is saved for the source clip. These changes cannot be undone using “Unstretch Audio”.


The Audio Part Editor
Background
The Audio Part Editor allows you to view and edit the events inside audio parts. Essentially, this is the same type of editing that you do in the Project window, which means that this chapter contains a lot of references to the chapter "Working with projects" on page 48.

Audio parts are created in the Project window in one of the following ways:
• By selecting one or several audio events on the same track, and selecting "Events to Part" from the Audio menu.
• By gluing together two or more audio events on the same track with the Glue Tube tool.
• By drawing an empty part with the Pencil tool.
• By double-clicking between the left and right locators on an audio track.
With the last two methods, an empty part is created. You can then add events to the part by pasting, or by using drag and drop from the Pool.

Opening the Audio Part Editor
You open the Audio Part Editor by selecting one or more audio part(s) in the Project window and double-clicking on any one of them (or using the Edit-Open key command, by default [Ctrl]/[Command]-[E]). The Audio Part Editor can display several parts at once, and you can also have more than one Audio Part Editor open at the same time.
• Double-clicking on an audio event in the Project window will open the Sample Editor (see "Opening the Sample Editor" on page 262).

Window overview
The toolbar
The tools, settings, and icons on the toolbar have the same functionality as in the Project window, with the following differences:
• A Solo button (see “Auditioning” on page 296).
• Separate tools for auditioning (Speaker) and scrubbing (see “Scrubbing” on page 297).
• No Line, Glue Tube or Color tools.
• Play and Loop icons and an Audition Volume control (see “Auditioning” on page 296).
• Independent Track Loop settings (see “The independent track loop function” on page 297).
• Part List controls for handling several parts: activating parts for editing, restricting editing to active parts only and showing part borders (see “Handling several parts” on page 297).
• You can customize the toolbar by hiding or reordering its items, see “Using the Setup options” on page 534.

The ruler and info line
These have the same functionality and appearance as their counterparts in the Project window.
• You can select a separate display format for the Audio Part Editor ruler by clicking on the arrow button on the right and selecting an option from the pop-up menu.
For a list of the available formats, see “The ruler” on page 44.
About lanes

If you make the editor window larger, this will reveal additional space below the edited events. This is because an audio part is divided vertically in lanes.

Lanes can make it easier to work with several audio events in a part. Moving some of the events to another lane can make selection and editing much easier.

- To move an event to another lane without accidentally moving it horizontally, press [Ctrl]/[Command] and drag it up or down.

For further information about lanes and overlapping events, see the chapter "Working with tracks and lanes" on page 71.

Auditioning

There are several ways to listen to the events in the Audio Part Editor:

By using the Speaker tool

If you click somewhere in the editor’s event display with the Speaker tool and keep the mouse button pressed, the part will be played back from the position where you clicked. Playback will continue until you release the mouse button.

By using the Audition icon

Clicking the Audition icon on the toolbar plays back the edited audio, according to the following rules:

- If you have selected events in the part, only the section between the first and last selected event will be played back.
- If you have made a range selection, only this section will be played back.
- If there is no selection, the whole part will be played back. If the project cursor is within the part, playback starts from the current cursor position. If the cursor is outside the part, playback starts from the beginning of the part.
- If the Audition Loop icon is activated, playback will continue until you deactivate the Audition icon. Otherwise, the section will be played back once.

- When auditioning with the Speaker tool or Audition icon, audio will be routed directly to the Control Room (Cubase only) or to the Main Mix (the default output bus) if the Control Room is disabled. In Cubase Artist, the Main Mix bus is always used for auditioning.

By using regular playback

You can of course use the regular playback controls while in the Audio Part Editor. Furthermore, if you activate the Solo Editor button on the toolbar, only the events in the edited part will be played back.

Using key commands

If you activate the "Playback Toggle triggers Local Preview" option in the Preferences dialog (Transport page), you can start/stop auditioning by pressing [Space]. This is the same as clicking the Audition icon on the toolbar.
The Audio Part Editor also supports the key commands “Preview start” and “Preview stop” in the Media category of the Key Commands dialog. These key commands stop the current playback, no matter if you are in normal playback or in audition mode.

The independent track loop function
The independent track loop is a sort of “mini-cycle”, affecting only the edited part. When the loop is activated, the events in the parts that are within the loop will be repeated continuously and completely independent – other events (on other tracks) are played back as usual. The only “interaction” between the loop and the “regular playback” is that the loop starts every time the cycle starts over again.

To set up the independent track loop, proceed as follows:

1. Turn on the loop by clicking the Independent Track Loop button on the toolbar.
   If it is not visible, right-click the toolbar and add the Independent Track Loop Settings section – see “Using the Setup options” on page 534.

When the loop is activated, the cycle is not shown in the editor’s ruler. Now you need to specify the length of the loop:

2. [Ctrl]/[Command]-click in the ruler to set the start and [Alt]/[Option]-click to set the end of the loop.
   You can also edit the loop start and end positions numerically in the fields next to the Loop button.

The loop is indicated in purple in the ruler.

The events will be looped as long as the Loop button is activated and the Audio Part Editor window is open.

Scrubbing
In the Audio Part Editor, the Scrub tool has a separate icon on the toolbar. Apart from that, scrubbing works exactly as in the Project window (see “Scrubbing audio” on page 59).

Handling several parts
When you open the Audio Part Editor with several parts selected – all on the same track or on different tracks – they might not all “fit” in the editor window, which can make it hard to get an overview of the different parts when editing.

Therefore, the toolbar features a few functions to make working with multiple parts easier and more comprehensive:

• The “Currently Edited Part” pop-up menu lists all parts that were selected when you opened the editor, and lets you select which part is active for editing.

When you select a part from the list, it is automatically made active and centered in the display.

Note that it is also possible to activate a part by clicking on it with the Arrow tool.

• The button “Edit Active Part Only” lets you restrict editing operations to the active part only.

If you for example select “All” from the Select submenu of the Edit menu with this option activated, all events in the active part will be selected but not the events in other parts.

• You can zoom in on an active part so that it fills the screen by selecting “Zoom to Event” from the Zoom submenu of the Edit menu.

• The button “Show Part Borders” can be used if you want to see clearly defined borders for the active part.

When this is activated, all parts except the active one are grayed out, making the borders easily discernible. There are also two “markers” in the ruler with the name of the active part, marking its beginning and end. These can be moved freely to change the part borders.
• It is possible to cycle between parts, making them active using key commands.
In the Key Commands dialog – Edit category, there are two functions: “Activate Next Part” and “Activate Previous Part”. If you assign key commands to these, you can use them to cycle between parts. See “Setting up key commands” on page 542 for instructions on how to set up key commands.

Options and Settings
The following options and settings are available in the Audio Part Editor:

• Snap
The Snap functionality in the Audio Part Editor is exactly the same as in the Project window, see “The Snap function” on page 45.

• Auto-Scroll
When Auto-Scroll is activated on the toolbar, the window will scroll during playback, keeping the project cursor visible in the editor. This setting can be activated or deactivated individually for each window.

• Snap to Zero Crossing
When this option is activated, all audio edits are done at zero crossings (positions in the audio where the amplitude is zero). This helps you avoid pops and clicks which might otherwise be caused by sudden amplitude changes.
The Pool
Background

Every time you record on an audio track, a file is created on your hard disk. A reference to this file – a clip – is also added to the Pool. Two general rules apply to the Pool:

• All audio and video clips that belong to a project are listed in the Pool.
• There is a separate Pool for every project.

The way the Pool displays folders and their contents is similar to the way the Mac OS X Finder and the Windows Explorer display folders and lists of files.

In the Pool you can, among other things, perform the following operations:

Operations that affect files on disk

• Importing clips (audio files can automatically be copied and/or converted)
• Converting file formats
• Renaming clips (this will also rename the referenced files on disk) and regions
• Deleting clips
• Preparing file archives for backup
• Minimizing files

Operations that only affect clips

• Copying clips
• Auditioning clips
• Organizing clips
• Applying audio processing to clips
• Saving or importing complete Pool files

By using a key command – by default [Ctrl]/[Command]-[P].

The content of the Pool is divided into the following main folders:

• The Audio folder
  This contains all audio clips and regions currently in the project.
• The Video folder
  This contains all video clips currently in the project.
• The Trash folder
  Unused clips can be moved into the Trash folder for later permanent removal from the hard disk.

These folders cannot be renamed or deleted from the Pool, but any number of subfolders can be added (see “Organizing clips and folders” on page 308).

Opening the Pool

You can open the Pool in any of the following ways:

• By clicking the “Open Pool Window” button on the Project window toolbar.
  If this icon is not visible, you need to activate the “Media & Mixer Windows” option on the toolbar context menu first.

• By selecting “Pool” on the Project menu or “Open Pool Window” on the Media menu.

Window overview

Audio folder: contains clips and regions
Trash folder
Video folder
Waveform image

Toolbar overview

Show Info button
View/Attributes pop-up menu
Import and Search buttons
Project Folder path

Audition, Audition Loop, and Volume
Open/Close all folders
Pool Record Folder path

The info line

Click the “Show Info” button on the toolbar to show or hide the info line at the bottom of the Pool window. It shows the following information:

• Audio Files – the number of audio files in the Pool
• Used – the number of audio files in use
• Total size – the total size of all audio files in the Pool
• External Files – the number of files in the Pool that do not reside in the project folder (e.g. video files)

The Pool window columns

Various information about the clips and regions can be viewed in the Pool window columns. The columns contain the following information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media</td>
<td>This column contains the Audio, Video and Trash folders.</td>
</tr>
<tr>
<td>Used</td>
<td>This column displays the number of times a clip is used in the project.</td>
</tr>
<tr>
<td>Status</td>
<td>This column displays various icons that relate to the current Pool and clip status.</td>
</tr>
<tr>
<td>Musical Mode</td>
<td>The checkbox in this column allows you to activate or deactivate Musical Mode.</td>
</tr>
<tr>
<td>Tempo</td>
<td>This shows the tempo of audio files, if available.</td>
</tr>
<tr>
<td>Sign.</td>
<td>This is the time signature, e.g. &quot;4/4&quot;.</td>
</tr>
<tr>
<td>Key</td>
<td>This is the root key, if one was specified for the file.</td>
</tr>
<tr>
<td>Info</td>
<td>This column shows the following information for audio clips:</td>
</tr>
<tr>
<td></td>
<td>The sample rate, bit resolution, number of channels and the length in seconds. For regions, it displays start and end times in frames, and for video clips the frame rate, number of frames, and length in seconds.</td>
</tr>
<tr>
<td>Type</td>
<td>This column shows the file format of the clip.</td>
</tr>
<tr>
<td>Date</td>
<td>This column shows the date when the audio file was last changed.</td>
</tr>
<tr>
<td>Origin Time</td>
<td>This column shows the original start position where a clip was recorded in the project. As this value can be used as a basis for the &quot;Insert into Project&quot; option in the Media or context menu (and other functions), you can change it if the Origin Time value is independent (i.e. not for regions). This can either be done by editing the value in the column, or by selecting the corresponding clip in the Pool, moving the project cursor to the new desired position and selecting &quot;Update Origin&quot; from the Audio menu.</td>
</tr>
<tr>
<td>Image</td>
<td>This column displays waveform images of audio clips or regions.</td>
</tr>
<tr>
<td>Path</td>
<td>This column shows the path to the location of a clip on the hard disk.</td>
</tr>
<tr>
<td>Reel Name</td>
<td>If you have imported an OMF file (see &quot;Exporting and importing OMF files (Cubase only)&quot; on page 535), it may include this attribute, which is then shown in this column. The Reel Name describes the &quot;physical&quot; reel or tape from which the media was originally captured.</td>
</tr>
</tbody>
</table>

About the Status column symbols

The Status column can display various symbols that relate to the clips status. The following symbols can be shown:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>This indicates the current Pool Record folder (see &quot;Changing the Pool Record folder&quot; on page 308).</td>
</tr>
<tr>
<td>?</td>
<td>This symbol is shown if a clip has been processed.</td>
</tr>
<tr>
<td></td>
<td>The question mark indicates that a clip is referenced in the project but missing from the Pool (see &quot;About missing files&quot; on page 305).</td>
</tr>
<tr>
<td></td>
<td>This indicates that the clip file is external, i.e. located outside the current Audio folder for the project.</td>
</tr>
<tr>
<td></td>
<td>This indicates that the clip has been recorded in the currently open version of the project. This is useful for finding recently recorded clips quickly.</td>
</tr>
</tbody>
</table>

Sorting the Pool contents

You can sort the clips in the Pool by name, date, etc. This is done by clicking on the corresponding column heading. Clicking again on the same heading switches between ascending and descending sort order.

Customizing the view

• You can specify which of the columns are shown or hidden by opening the View/Attributes pop-up menu on the toolbar and selecting/deselecting items.
• You can rearrange the order of the columns by clicking on a column heading and dragging the column to the left or right. The mouse pointer changes to a hand when you place it on the column heading.
• The width of a column can also be adjusted by placing the pointer between two column headers and dragging left or right. The pointer changes to a divider when you place it between two column headers.

Operations

Most of the Pool-related main menu functions are also available on the Pool context menu (opened by right-clicking in the Pool window).

Renaming clips or regions in the Pool

To rename a clip or a region in the Pool, select it and click on the existing name, type in a new name and press [Return].

This will also rename the referenced files on disk!

Renaming a clip in the Pool is much preferred to renaming it outside Cubase (for example on the computer desktop). This way, Cubase already "knows" about the change, and will not lose track of the clip the next time you open the project. See "About missing files" on page 305 for details about lost files.

Duplicating clips in the Pool

To duplicate a clip, proceed as follows:
1. Select the clip you wish to copy.
2. Select "New Version" on the Media menu.

A new version of the clip appears in the same Pool folder, with the same name but with a "version number" after it, to indicate that the new clip is a duplicate. The first copy made of a clip will get the version number "2" and so on. Regions within a clip are copied too, but keep their name.

Duplicating a clip does not create a new file on disk, but a new edit version of the clip (referring to the same audio file).

Inserting clips into a project

To insert a clip into a project, you can either use the Insert commands on the Media menu or use drag and drop.

Using menu commands

Proceed as follows:
1. Select the clip(s) you want to insert into the project.
2. Pull down the Media menu and select an "Insert into Project" option.
   "At Cursor" will insert the clip(s) at the current project cursor position.
   "At Origin" will insert the clip(s) at their Origin Time position(s).
3. The clip is inserted on the selected track or on a new audio track.
   If several tracks are selected, the clip will be inserted on the first selected track.

Using drag and drop

When using drag and drop to insert clips into the Project window, please note the following:

• Snap is taken into account if activated.
• While you drag the clip in the Project window, its position is indicated by a marker line and a numerical position box.
   Note that these indicate the position of the snap point in the clip. For example, if you drop the clip at the position 10.00, this will be where the snap point ends up. See "Adjusting the snap point" on page 268 for information on how to set the snap point.
• If you position the clip in an empty area in the event display (i.e. below existing tracks), a new track is created for the inserted event.
Deleting clips

Removing clips from the Pool
To remove a clip from the Pool without deleting it from the hard disk, proceed as follows:

1. Select the clip(s) and select “Delete” from the Edit menu (or press [Backspace] or [Delete]).
   A prompt asks whether you want to move the clip to the Trash or remove it from the Pool.

   - If you try to delete a clip that is used by one or more events, the program will ask you whether to remove these events from the project.
   If you cancel, neither the clip nor the associated events are deleted.

2. In the window that opens, select “Remove from Pool”. The clip is no longer associated with the project, but still exists on the hard disk and can be used in other projects, etc. This operation can be undone.

Deleting from the hard disk
To delete a file permanently from the hard disk, it must first be moved to the Trash folder:

1. Follow the instructions for deleting clips above, but click the Trash button instead of the Remove from Pool button.
   Alternatively, you can drag and drop clips into the Trash folder.

2. On the Media menu, select “Empty Trash”. A warning message is displayed.

3. Click “Erase” to delete the file on the hard disk permanently.
   This operation cannot be undone!

⚠️ Before you permanently delete audio files from the hard disk, make sure that they are not used by another project!

⚠️ To retrieve a clip or region from the Trash folder, drag it back into an Audio or Video folder.

Removing unused clips
This function finds all clips in the Pool that are not used in the project. You can then decide whether to move them to the Trash folder (from where they can be permanently deleted) or to remove them from the Pool:

1. Select “Remove Unused Media” on the Media or context menu.
   A message appears asking you whether you want to move the file to the Trash or to remove it from the Pool.

2. Make your selection.

Removing regions
To remove a region from the Pool, select it and select “Delete” from the Edit menu (or press [Backspace] or [Delete]).

⚠️ For regions there is no alert if the region is used in the project!

Locating events and clips

Locating events via clips in the Pool
If you want to find out which events in the project refer to a particular clip in the Pool, proceed as follows:

1. Select one or more clips in the Pool.

2. Select “Select in Project” on the Media menu.
   All events that refer to the selected clip(s) are now selected in the Project window.

Locating clips via events in the Project window
If you want to find out which clip belongs to a particular event in the Project window, proceed as follows:

1. Select one or more events in the Project window.

2. Pull down the Audio menu and select “Find Selected in Pool”.
   The corresponding clip(s) are located and highlighted in the Pool.
Searching for audio files

The search functions can help you locate audio files in the Pool, on your hard disk or on other media. This works much like the regular file search, but with a couple of extra features:

1. Click the Search button on the toolbar.
A search pane appears at the bottom of the window, displaying the search functions.

By default, the search parameters available in the search pane are “Name” and “Location”. For using other filter criteria, see “Extended Search functionality” on page 304.

2. Specify the name of the file(s) to search for in the Name field.
You can use partial names or wildcards (*). Note that only audio files of the supported formats will be found.

3. Use the Location pop-up menu to specify where to search.
The pop-up menu will list all your local drives and removable media.
   - If you want to limit the search to certain folders, choose “Select Search Path” and select the desired folder in the dialog that opens.
   The search will include the selected folder and all subfolders. Note also that folders you have recently selected using the “Select Search Path” function will appear on the pop-up menu, allowing you to quickly select them again.

4. Click the Search button.
The search is started and the Search button is labeled Stop – click this to cancel the search if needed.
When the search is finished, the files found are listed to the right.
   - To audition a file, select it in the list and use the playback controls to the left (Play, Stop, Pause, and Loop). If Auto Play is activated, selected files are automatically played back.
   - To import a file into the Pool, double-click on it in the list or select it and click the Import button.
5. To close the search pane, click the Search button on the toolbar again.

Extended Search functionality

Apart from the search criterion Name, additional search filters are available. The Extended Search options allows for a very detailed search, helping you to master even the largest sound database.

To use them, proceed as follows:

1. Click the Search button on the toolbar.
The Search pane is displayed in the lower part of the Pool window.

2. Move the mouse pointer over the “Name” text to the right of the name field and click on the arrow that appears.

   Move the mouse pointer over the “Name” text to the right of the name field and click...

3. The extended search pop-up menu opens.
   It contains six options determining which search criterion is displayed above the Location field (Name, Size, Bitsize, Channels, Sample Rate, or Date), as well as the Add Filter and Presets submenus.

   The search criteria have the following parameters:
   - Name: partial names or wildcards (*)
   - Size: Less than, More than, Equal, Between (two values), in seconds, minutes, hours and bytes
   - Bitsize (resolution): 8, 16, 24, 32
   - Channels: Mono, Stereo and from 3 to 16
   - Sample Rate: various values, choose “Other” for free setting
   - Date: various search ranges

4. Select one of the search criteria in the pop-up menu to change the search option above the Location pop-up menu.
5. If you want to display more search options, select the desired element from the “Add filter” submenu. This allows you, for example, to add the Size or the Sample Rate parameters to the already displayed Name and Location parameters.

- You can save presets of your search filter settings. To do this, click Save Preset on the Presets submenu and enter a name for the preset.

```
Existing presets can be found at the bottom of the list. To remove a preset, click on the preset to activate it, then select Remove Preset.
```

**The Find Media window**

Alternatively to the search pane in the Pool, you can open a stand-alone Find Media window by selecting the “Search Media…” option from the Media or context menu (also available from the Project window). This offers the same functionality as the search pane.

- To insert a clip or region directly into the project from the Find Media window, select it in the list and choose one of the “Insert into Project” options from the Media menu. The options are described in the section “Inserting clips into a project” on page 302.

**About missing files**

When you open a project, the Resolve Missing Files dialog (see below) may open, warning you that one or more files are “missing”. If you click Close, the project will open anyway, without the missing files. In the Pool, you can check which files are considered missing. This is indicated by a question mark in the Status column.

A file is considered missing under one of the following conditions:

- The file has been moved or renamed outside the program since the last time you worked with the project, and you ignored the Resolve Missing Files dialog when you opened the project for the current session.
- You have moved or renamed the file outside the program during the current session.
- You have moved or renamed the folder in which the missing files are located.

**Locate missing files**

1. Select “Find Missing Files…” from the Media or context menu. The Resolve Missing Files dialog opens.

```
2. Decide if you want the program to try to find the file for you (Search), if you want to do it yourself (Locate) or if you want to specify in which directory the program will search for the file (Folder).

- If you select Locate, a file dialog opens, allowing you to locate the file manually. Select the file and click “Open”.
- If you select Folder, a dialog opens to let you specify the directory in which the missing file can be found. This might be the preferred method if you have renamed or moved the folder containing the missing file, but the file still has the same name. Once you select the correct folder, the program finds the file and you can close the dialog.
- If you select Search, a dialog opens to let you specify which folder or disk will be scanned by the program. Click the Search Folder button, select a directory or a disk and click the Start button. If found, select the file from the list and click “Accept”. Afterwards Cubase tries to map all other missing files automatically.

**Reconstructing missing edit files**

If a missing file cannot be found (e.g. if you have accidentally deleted it from the hard disk), it will normally be indicated with a question mark in the Status column in the Pool. However, if the missing file is an edit file (a file created when you process audio, stored in the Edits folder within the project folder), it may be possible for the program to reconstruct it by recreating the editing to the original audio file.
Proceed as follows:

1. Open the Pool and locate the clip(s) for which files are missing.
2. Check the Status column – if it says “Reconstructible”, the file can be reconstructed by Cubase.
3. Select the reconstructible clips and select “Reconstruct” from the Media menu.
   The editing is performed and the edit files are recreated.

Removing missing files from the Pool
If the Pool contains audio files that cannot be found or re-constructed, you may want to remove these. For this, select “Remove Missing Files” from the Media or context menu.
This will remove all missing files from the Pool as well as the corresponding events from the Project window.

Auditioning clips in the Pool
There are three ways to audition clips in the Pool:

- By using key commands.
  If you activate the “Playback Toggle triggers Local Preview” option in the Preferences dialog (Transport page), you can use [Space] to audition. This is the same as clicking the Audition icon on the toolbar.
- By selecting a clip and activating the Audition button.
  The whole clip will play back, unless you stop playback by clicking the Audition button again.
- By clicking somewhere in the waveform image for a clip.
  The clip will play from the position in the waveform you click until the end of the clip, unless you stop playback by clicking the Audition button, or by clicking anywhere else in the Pool window.

The audio is routed directly to the Control Room, if activated (Cubase only). When the Control Room is deactivated, the audio is routed to the Main Mix (the default output) bus, bypassing the audio channel’s settings, effects, and EQs. In Cubase Artist, the Main Mix bus is always used for auditioning.

You can adjust the auditioning level with the miniature level fader on the toolbar. This does not affect the regular playback level.

If you have activated the Audition Loop button before you audition, the following will happen:

- When you click the Audition button to audition a clip, the clip is repeated indefinitely until you stop playback by clicking the Audition or Audition Loop button again.
- When you click in the waveform image to audition, the section from the point you clicked to the end of the clip is repeated indefinitely until you stop playback.

Opening clips in the Sample Editor
The Sample Editor allows you to perform detailed editing on the clip (see “The Sample Editor” on page 261). You can open clips in the Sample Editor directly from the Pool in the following ways:

- If you double-click a clip waveform icon or a clip name in the Media column, the clip opens in the Sample Editor.
- If you double-click a region in the Pool, its clip opens in the Sample Editor with the region selected.

One practical use for this is to set a snap point for a clip (see “Adjusting the snap point” on page 268). When you later insert the clip from the Pool into the project, you can have it be properly aligned according to the set snap point.

About the Import Medium dialog
The Import Medium dialog lets you import files directly into the Pool. It is opened from the Media or context menu or using the Import button in the Pool window.

This is a standard file dialog, where you can navigate to other folders, audition files, etc. The following audio file formats can be imported:

- Wave (Normal or Broadcast, see “Broadcast Wave files” on page 490)
- AIFF and AIFC (Compressed AIFF)
- REX or REX 2 (see “Importing ReCycle files” on page 524)
- Dolby Digital AC3 file (ac3 – if you have the Steinberg Dolby Digital Encoder installed in your system) – Cubase only
- DTS file (dts – if you have the Steinberg DTS Encoder installed in your system) – Cubase only
- SD2 (Sound Designer II)
- MPEG Layer 2 and Layer 3 (MP2 and MP3 files – see “Importing compressed audio files” on page 525)
- Ogg Vorbis (OGG files – see “Importing compressed audio files” on page 525)
- Windows Media Audio (Windows – see “Importing compressed audio files” on page 525)
- Wave 64 (W64 files)
They may have the following characteristics:

- Stereo or mono
- Any sample rate (although files with another sample rate than the one used in the project will play back at the wrong speed and pitch — see below).
- 8, 16, 24 bit or 32 bit float resolution.

Various video formats can be imported. For information about the supported video formats, see “Video file compatibility” on page 510.

It is also possible to use the commands on the Import submenu of the File menu to import audio or video files into the Pool.

When you select a file in the Import Medium dialog and click Open, the Import Options dialog opens.

It contains the following options:

- **Copy File to Working Directory**
  Activate this if you want a copy of the file to be made in the Audio folder of the project, and have the clip refer to this copy. If the option is off, the clip will refer to the original file in the original location (and will thus be marked as “external” in the Pool — see “About the Status column symbols” on page 301).

- **Convert to Project section**
  Here you can choose to convert the sample rate (if the sample rate is different than the one set for the project) or the sample size, i.e. resolution (if the sample size is lower than the record format used in the project). The options are only available if necessary. Note that if you are importing several audio files at once, the Import Options dialog will instead contain a “Convert and Copy to Project if needed” checkbox. When this is activated, the imported files will be converted only if the sample rate is different or the sample size is lower than the project’s.

- **Split channels/Split multi-channel files**
  If this is activated, stereo and multi-channel files are split into a corresponding number of mono files — one for each channel — and these will be imported into the Pool. Note that if you use this option, the imported files will always be copied to the Audio folder of the project, as described above. Use the “Use numbers for split file names” option to give the created files the same name as the source file, appended by a number. This avoids confusion if the source file does not contain stereo or surround material, but poly-mono audio.

- **Please, don’t ask again**
  If this is activated, files will always be imported according to the settings you have made, without this dialog appearing. This can be reset in the Preferences dialog (Editing–Audio page).

You can always convert files later by using the Convert Files (see “Convert Files” on page 309) or Conform Files (see “Conform Files” on page 310) options.

### About the Import Audio CD dialog

You can import tracks (or sections of tracks) from an audio CD directly into the Pool by using the “Import Audio CD…” function on the Media menu. This opens a dialog in which you can specify which tracks are copied from the CD, converted to audio files and added to the Pool.

For details about the Import from Audio CD dialog, see “Importing audio CD tracks” on page 522.

### Exporting regions as audio files

If you have created regions within an audio clip (see “Working with regions” on page 270), these can be exported as separate audio files. To create a new audio file from a region, proceed as follows:

1. In the Pool, select the region you wish to export.
3. Select the folder in which you want the new file to be created.

A new audio file is created in the specified folder. The file will have the name of the region and will automatically be added to the Pool.

If you have two clips that refer to the same audio file (different “versions” of clips, e.g. created with the “Convert to Real Copy” function), you can use the Bounce Selection function to create a new, separate file for the copied clip. Select the clip, select Bounce Selection, and enter a location and name for the new file.
Changing the Pool Record folder

All audio clips that you record in the project will end up in the Pool Record folder. The Pool Record folder is indicated by the text “Record” in the Status column and by a red dot on the folder itself.

By default, this is the main Audio folder. However, you can create a new Audio subfolder at any time and designate this as your Pool Record folder:
1. Select the Audio folder or any audio clip. You cannot designate the Video folder (or any of its subfolders) as the Pool Record folder.
2. Select “Create Folder” on the Media or context menu. A new empty subfolder named “New Folder” appears in the Pool.
3. Select the new folder and rename it as desired.
4. Select “Set Pool Record Folder” on the Media or context menu, or click in the Status column of the new folder. The new folder now becomes the Pool Record folder, and any audio recorded in the project will be saved in this folder.

Applying processing to clips in the Pool

You can apply audio processing to clips from within the Pool in the same way as to events in the Project window. Simply select the clip(s) and choose a processing method from the Audio menu. To find out more about audio processing, see the chapter “Audio processing and functions” on page 244.

Undoing processing

If you have applied processing to a clip, in the Project window, the Sample Editor, or in the Pool, this is indicated by the red and gray waveform symbol in the Status column. This processing can always be undone using the Offline Process History, see “The Offline Process History dialog” on page 254.

Freeze Edits

You can use the Freeze Edits function to create a new file with processing applied or to replace the original with a processed version, see “Freeze Edits” on page 255.

Minimize File

The “Minimize File” option on the Media or context menu allows you shrink the audio files according to the size of the audio clips referenced in a project. The files produced using this option only contain the audio file portions actually used in the project. This can significantly reduce the size of the project, if large portions of the audio files are unused. Therefore, the option is useful for archiving purposes after you have completed a project.

This operation will permanently alter the selected audio files in the Pool. This cannot be undone! If this is not what you want, you can use the “Back up Project” option on the File menu instead, see “Back up Project” on page 52. This function also has the option of minimizing files, but copies all files into a new folder, leaving the original project untouched.

Proceed as follows:
1. Select the file(s) you wish to minimize.
2. Select “Minimize File” on the Media menu.
An alert appears, informing you that the entire Edit History will be cleared. Click Minimize to proceed or Cancel to stop the process.
3. After the minimizing is finished, another alert appears, because the file references in the stored project have become invalid. Click Save Now to save the updated project or click Later to proceed with the unsaved project.

Only the audio portions actually used in the project remain in the corresponding audio file(s) in the Pool Record folder.

**Prepare Archive**

The “Prepare Archive” option on the Media menu is useful if you want to archive a project. For detailed information about the Prepare Archive feature, see “Prepare Archive” on page 52.

**Importing and exporting Pool files (Cubase only)**

You can import or export a Pool as a separate file (file extension “.npl”), by using the “Import Pool” and “Export Pool” options on the Media or context menu.

When you import a Pool file, the file references in it are “added” to the current Pool.

⚠️ Since the audio and video files are only referenced but not saved in the Pool file, the Pool import is only useful if you have access to all referenced files (which preferably have the same file paths as when the Pool was saved).

You can also save and open libraries. These are stand-alone Pool files that are not associated with a project.

**Working with libraries (Cubase only)**

You can use libraries to store sound effects, loops, video clips, etc., and transfer media from a library into a project by using drag and drop. The following library functions are available on the File menu:

- **New Library**
  Creates a new library. Just as when creating new projects, you will be asked to specify a project folder for the new library (in which media files will be stored). The library appears as a separate Pool window in Cubase.

- **Open Library**
  Opens a file dialog for opening a saved library file.

**Save Library**

Opens a file dialog for saving the library file (file extension “.npl”).

**Convert Files**

Selecting the “Convert Files” option on the Media or context menu opens the Convert Options dialog which operates on selected files. Use the pop-up menus to specify which audio file attributes you want to keep and which you want to convert. The available settings are:

- **Sample Rate**
  Keep as is, or convert to a sample rate between 8,000 and 96,000 kHz.

- **Sample Width**
  Keep the sample width (resolution) as is, or convert to 16 Bit, 24 Bit or 32 Bit Float.

- **Channels**
  Keep as is, or convert the file to Mono or Stereo Interleaved.

- **File Format**
  Keep as is, or convert to Wave, AIFF, Wave 64, or Broadcast Wave format.

**Options**

When you convert a file, you can use the Options pop-up menu to set one of the following options regarding what to do with the new file:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Files</td>
<td>Creates a copy of the file in the audio folder and converts this new file according to the chosen attributes. The new file is added to the Pool, but all clip references will still point to the original, unconverted file.</td>
</tr>
</tbody>
</table>
**Conform Files**

By using this command, you will change all selected files that have different file attributes than what is specified for the project, to conform to this standard.

Proceed as follows:

1. Select the clips in the Pool.
2. Select “Conform Files…” on the Media menu.

A dialog opens allowing you to choose between keeping or replacing the original unconverted files in the Pool.

The following applies:

- Clip/event references in the Pool are always redirected to the conformed files.
- If any “keep” option is selected, original files remain in the Project’s Audio folder and new files are created.
- If you select the “Replace” option, files in the Pool and in the Project’s Audio folder are replaced.

**Extract Audio from Video File**

This Media menu item allows you to extract the audio from a video file on disk. It automatically generates a new audio clip that will appear in the Pool Record folder. The resulting clip will have the following properties:

- It will get the same file format and sample rate/width as in the current project.
- It will get the same name as the video file.

⚠️ This function is not available for MPEG-1 and MPEG-2 video files.

---

**Option** | **Description**
---|---
Replace Files | Converts the original file without changing clip references. The references are however saved with the next save action.
New + Replace in Pool | Creates a new copy with the chosen attributes, replaces the original file with the new one in the Pool and redirects the current clip references from the original file to the new file. This is the option to select if you want your audio clips to refer to the converted file, but still want to keep the original file on disk (e.g. if the file is used in other projects).
Introduction

One of the biggest challenges in typical computer-based music production environments is how to manage the ever-growing number of plug-ins, instruments, presets, etc. from multiple sources. Cubase features an efficient database for media file management that allows you to handle all your media files from within your sequencer program.

The MediaBay is divided into several sections:

- Define Locations – Here, you can create "presets" for locations on your system that you want to scan for media files, see “Defining Locations” on page 315.
- Locations – Here, you can switch between the previously defined Locations.
- Filters – Here, you can filter the Results list using a logical or an attribute filter, see “The Filters section” on page 321.
- Results – Here, all found media files are displayed. You can also filter the list and perform text searches, see “The Results list” on page 316.
- Previewer – This section allows you to preview the files shown in the Results list, see “Previewing files” on page 318.
- Attribute Inspector – In this section, you can view, edit and add media file attributes (or tags), see “The Attribute Inspector” on page 323.

Accessing the MediaBay

To open the MediaBay, select the MediaBay command on the Media menu. You can also use the corresponding key command (by default F5).

By default, the Define Locations section, the Locations section, the Filters section, the Results list and the Previewer section are shown.

Setting up the MediaBay window

You can show and hide the different sections of the MediaBay (except for the Results list). This is handy, as it allows you to save screen space and enables you to display only the information you need for your work.
Proceed as follows:

1. Click the “Set up Window Layout” button in the lower left corner of the MediaBay window.

A transparent pane appears, covering the window. In the center of it is a gray area containing checkboxes for the different sections.

2. Deactivate the checkboxes for the sections you want to hide from view.

Any changes you make here are directly reflected in the MediaBay window. Note that the Results list cannot be hidden.

   You can also use key commands for this: use the up/down and left/right arrow keys to step through the checkboxes and press [Space] to activate/deactivate the desired checkbox.

3. When you are done, click outside the gray area to exit the Setup mode.

Alternatively, you can wait a few seconds for the pane to disappear automatically.

   You can change the size of the individual MediaBay sections by dragging the divider line between two sections.

Working with the MediaBay

When working with many music files, the most important thing is to find the content you need quickly and easily. The MediaBay helps you find and organize your content in an effective and efficient way. After the first scan of the folders you have activated for scanning (which will take a certain time), all the files that were found are there for you to browse, tag or modify.

At the beginning, all media files of the supported formats are listed in the Results section: far too many to get a good overview. However, by using the search and filter techniques, you get the desired results very quickly.

The first thing to do is to set up “Locations”, that is folders or directories on your system that contain media files. Usually, files are organized in a specific way on your computer. For example, you might have folders reserved for audio content, folders for special effects, folders for combinations of sounds making up the ambience noise you need for a certain film take, etc. These can all be set as different Locations in the MediaBay, allowing you to limit the files available in the Results list according to context.

Whenever you expand your computer system (for example, by adding new hard disks or an external volume containing media files you want to work with), you should make it a habit to save the new volumes as Locations or add them to your existing Locations. Afterwards, you can hide the Define Locations section from view. That way, the MediaBay occupies less screen space and you can concentrate on the important thing: the Results list.

For this list, you can specify which file types are displayed, see “Filtering according to media type” on page 316. If there are still too many files to choose from, you can narrow down the results using a text search function, see “Performing a text search” on page 317. This is often all it needs to display what you want, allowing you to proceed by previewing the files before inserting them into your project (see “Previewing files” on page 318). However, if you need very complex and detailed filtering, this is also possible using either attribute or logical filtering, see “The Filters section” on page 321. For filtering or searches, the use of attributes is recommended: By specifying specific attribute values for your files (categorizing them as production sound, Foley, special effects, etc.), you can considerably speed up the browsing process, see “The Attribute Inspector” on page 323.

Finally, the files can be easily inserted into the project, by using drag & drop, by double-clicking or using the context menu options, see “Inserting the files into the project” on page 318.
The Define Locations section

When you open the MediaBay for the first time, a scan for media files is performed on your system. You specify which folders or directories you want to be included in the scan by activating/deactivating the checkboxes for the folders in the Define Locations section. Depending on the amount of media files on your computer, the scan may take a while. All files that are found in the specified folders are shown in the Results list.

- To include a folder in the scan, activate its checkbox.
- To exclude a folder from the scan, deactivate its checkbox.
- To restrict the search to individual subfolders, activate/deactivate their checkboxes.

The color of the checkmark helps you to identify which folders and subfolders are scanned:

- A white checkmark indicates that all subfolders are scanned.
- An orange checkmark indicates that at least one subfolder is excluded from the scan.

Some subfolders of this folder are excluded from the scan.

All subfolders of this folder are included in the scan.

- To revert to scanning a complete folder (including all subfolders), click on an orange checkmark. The checkmark becomes white, to indicate that all folders are scanned.

The scanning status for the individual folders themselves is indicated by the color of the folder icons:

- A red icon means that the folder is currently being scanned.
- A light blue icon means the folder has been scanned.
- A dark blue icon is displayed for folders which are excluded from the scan.
- An orange icon is displayed when the scanning process for the folder was interrupted.
- A yellow icon is displayed for folders that have not yet been scanned.

The scan result is saved in a database file. When you deactivate the checkbox for a folder that has already been scanned, a message appears, allowing you to keep the gathered scan data in this database file or to completely remove the data for this folder from the database file. Select Keep if you want to keep the database entries, but want to exclude the folder from being scanned (when you trigger a re-scan for example). Select Remove if you do not want to use the contents of this folder in your projects.

- When you activate the “Please, don’t ask again” option, no further warning messages will be shown when you deactivate other checkboxes, for as long as the program is running.

When you quit and re-launch Cubase, these warning messages will be displayed again.

The VST Sound node

The Define Locations section provides a shortcut to user content and factory content files, including the preset folders: the VST Sound node.

- The folders below the VST Sound node represent the directories in which content files and track presets, VST presets, etc. are stored by default.

To find out the “true” location of a file, right-click on it in the Results list and select “Open in Explorer” (Win)/“Reveal in Finder” (Mac). This will open an Explorer/Finder window in which the corresponding file is highlighted. Please note that this function is not available for files which are part of a VST Sound archive.
Updating the display

You can update the display in two ways: by rescanning or by refreshing.

Rescanning

When you click the Rescan button, the selected folder is rescanned. If a folder contains a large number of media files, the scanning process may take some time. Use this function if you have made changes to the content of specific media folders and want to scan these folders again.

You can also rescans the selected folder by right-clicking on it and selecting Rescan Disk from the context menu.

Refreshing

In addition to the Rescan Disk option, the context menu for the selected node or folder in the Define Locations section also contains a Refresh Views option. This refreshes the display for this location without rescanning the corresponding media files.

This is useful in the following situations:

- When you have modified attribute values (see “Editing attributes (tagging)” on page 324) and want to update the Results list so that these values are displayed for the corresponding files.
- When you have mapped a new network drive, for example, and want this to appear as a node in the Define Locations section. Simply select the Refresh Views option for the parent node and the new drive will appear in the Define Locations section (ready to be scanned for media files).

Defining Locations

When you have set up the Define Locations section according to your preferences, and the content is scanned, it is time to make it available in a meaningful way. For this, you can define locations, i.e. shortcuts to the folders you want to work with, that will be available from the Locations section for convenient access.

To define a location, proceed as follows:

1. In the list to the left, select the desired folder.
2. Click the Add button. A naming dialog for the new location is displayed.
3. Accept the default name or enter a new name.
4. Click OK. The new location is added to the Locations pop-up menu in the Locations section (see below).
5. Repeat these steps to add as many locations as you need.

Once you have set up your locations, you can hide the Define Locations section from view (see “Setting up the MediaBay window” on page 312), to save screen space.

- Some Location presets are available by default. These are: “All Media” (the topmost node in the Define Locations section), “Local Harddisks” (the local harddisks in your computer system) and “VST Sound” (the folder in which Steinberg sound files, loops and presets are stored by default).

The Locations section

When you open the Locations pop-up menu and select a location, the media files found in that location are shown in the Results list. By switching between the locations you defined, you can quickly browse to the files you are looking for.

To change the browse location, simply select another location from the pop-up menu. If the available Locations don’t yield the desired results or if the folder you want to scan for files is not part of any of the locations, define a new Location in the Define Locations section.

- To select the previous or next folder in a sequence of selected folders, use the "Previous/Next Browse Location" buttons.
These paths will be deleted when you close the MediaBay.
• To select the parent folder of the selected folder, click the “Browse Containing Folder” button.

• To remove a location from the pop-up menu, select it and click the “Remove Browse Location Definition” button.

• To show the files contained in the selected folder and any subfolders (without showing these subfolders), activate the Deep Results button. When this button is deactivated, only the folders and files contained in the selected folder are shown.

The Results list

The Results list is at the heart of the MediaBay. Here, you will find all the files found in the selected location.

As the number of files displayed can be huge (the info field in the top right corner of the Results section shows the number of files found with the current filter settings), you might want to use any of the filter and search options in the MediaBay to narrow down the list. The available options are described below.

⇒ The maximum number of files that are displayed in the Results list can be set by specifying a new value for “Maximum Items in Results list” in the Preferences (see “Preferences” on page 327).

Filtering according to media type

The Results list can be set to display only a particular media type or a combination of media types.

• Click in the field where the currently displayed media types are shown (by default “All Media Types”) to open the Show Media Types dialog.

Here, you can activate the media types you want to be displayed in the Results list.

When you have filtered the list to show a particular media type, this is indicated by the corresponding icon to the left of media type field. When you have selected several media types, the Mixed Media Type icon is used.

The media types

In the “Show Media Types” dialog, you can activate the media types you want to be displayed in the Results list. The following types are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Files</td>
<td>When this is activated, the list shows all audio files. The supported formats are .wav, .w64, .aiff, .aifc, .rex, .rx2, .mp3, .mp2, .ogg, .sd2, .wma (Windows only).</td>
</tr>
<tr>
<td>MIDI Files</td>
<td>When this is activated, the list shows all MIDI files (file name extension .mid).</td>
</tr>
<tr>
<td>MIDI Loops</td>
<td>When this is activated, the list shows all MIDI loops (file name extension .midloop).</td>
</tr>
</tbody>
</table>
Setting up the Results list columns

For each media type, or for combinations of media types, you can specify the attribute columns that are displayed in the Results list. In most cases, you will probably only want to display a few main attributes in the Results list and use the Attribute Inspector to view the complete list of attribute values for the files.

Proceed as follows:

1. Select the media type (or combination of media types) that you want to make settings for.
2. Click the “Set up Result Columns” button and activate or deactivate the options on the submenus.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pattern Banks</td>
<td>When this is activated, the list shows all pattern banks (file name extension .patternbank). Pattern banks are generated by the MIDI plug-in Beat Designer. For more information, see “Previewing pattern banks” on page 320 and the separate PDF document “Plug-in Reference”.</td>
</tr>
<tr>
<td>Track Presets</td>
<td>When this is activated, the list shows all track presets for audio, MIDI, and instrument tracks (file name extension .trackpreset). Track presets are a combination of track settings, effects and mixer settings that can be applied to new tracks of various types. For more information, see the chapter “Working with track presets” on page 331.</td>
</tr>
<tr>
<td>Plug-in Presets</td>
<td>When this is activated, the list shows all VST presets for instrument and effect plug-ins. These presets contain all parameter settings for a particular plug-in. They can be used to apply sounds to instrument tracks and effects to audio tracks. For more information, see the chapter “Working with track presets” on page 331.</td>
</tr>
<tr>
<td>Video Files</td>
<td>When this is activated, the list shows all video files. For information about the supported video formats, see “Video file compatibility” on page 510.</td>
</tr>
<tr>
<td>Projects</td>
<td>When this is activated, the list shows all project files (from Cubase, Nuendo, Sequel): .cpr, .npr, .steinberg-project.</td>
</tr>
</tbody>
</table>

You can limit the number of results in the Results list using the text search function. When you enter text in the Text Search field, only media files whose attributes match the entered text will be displayed.

For example, if you are looking for all audio loops relating to drum sounds, simply enter “drum” in the search field. The search results will contain loops with names such as “Drums 01”, “Drumloop”, “Snare Drum”, etc. Also, all media files with the Category attribute Drum&Percussion, or any other attribute that contains “drum” will be found.

When you enter text in the field, its background becomes red, to indicate that a text filter is active for the list. To reset the text filter, delete the text.
The rating slider

Using the rating slider above the Results list, you can specify rating settings for your files, ranging from 1 to 5. This makes it possible to exclude certain files from the search according to their quality.

When you move the rating slider, the active rating filter is indicated in red. All files of this rating are displayed in the list.

The search in progress indicator

At the top right in the Results list you will find an indicator which shows whether the MediaBay is currently searching for files.

Resetting the list

When you have set up filters for the Results list, you can set everything back to default by clicking the Reset Results Filter button to the right of the Rating slider.

This will delete any text in the text search field, set the rating slider to display all files and deactivate all the media type filters.

Inserting the files into the project

You can insert files into the project by right-clicking on them and selecting one of the “Insert into project” options from the context menu, or you can double-click them. What happens next depends on the track type:

Audio files, MIDI loops, and MIDI files can be inserted into the project by double-clicking them in the Results list. They will be inserted on the active track, if this matches the file type or onto a new track if no corresponding track is active. The files will be inserted at the current project cursor position.

Similarly, if you double-click on a track preset, it will be applied to the active track, if the track type matches the track preset. Otherwise, a new track will be inserted, containing the settings of the track preset.

If you double-click a VST preset, an instrument track is added to the project, containing an instance of the corresponding instrument. For some VST presets, this will load the entire instrument settings, programs, etc. For others, only one program will be loaded, see “Applying instrument presets” on page 329.

When you double-click on a pattern bank, a new MIDI track is created in the Project window, with an instance of the Beat Designer plug-in as insert effect which is using this pattern.

Managing files in the Results list

- You can move/copy a file from the Results list to another location by clicking on it and dragging it to another folder in the Define Locations section. You will be asked whether you want to copy or move the file to the new location.
- You can change the display order in the Results list by clicking on a column heading, and dragging that heading to another position in the display.
- To delete a file, right-click it in the list and select Delete from the context menu. A warning message is displayed, asking you to confirm that you really want to move this file to the operating system’s trash folder. The data you delete here will be permanently deleted from your computer, therefore be sure to delete only the files you do not want to use any more.

⚠️ When a file was deleted in the Explorer/Finder, it will still be displayed in the Results list, although it is no longer available to the program. To remedy this, you have to re-scan the corresponding folder.

Previewing files

When you have sufficiently narrowed down the list of files, you will want to preview individual files to find out which one to use in your project. This is done in the Previewer section.

Note that some MediaBay-specific Preferences affect the playback of media files, see “Preferences” on page 327.
The elements visible in this section and their functions depend on the type of media file.

⚠️ The Previewer section is not available for video files, project files, and audio track presets.

**Previewing audio files**

To preview an audio file, click the Play button. What happens next depends on the following settings:

- When “Auto Play New Results Selection” is activated, any file you select in the Results list is automatically played back.
- When “Align Beats to Project” is activated, the file you selected for preview in the Results list is played back in sync with the project, starting at the project cursor position. Note that this may apply realtime time stretching to your audio file.
- When you import an audio file into your project for which “Align Beats to Project” is activated in the Previewer, Musical Mode is automatically activated for the corresponding track.
- When “Wait for Project Play” is activated, the Play and Stop functions from the Transport panel are synchronized with the Play and Stop buttons in the Previewer section. This option is very useful for previewing audio loops. To use it to its full extent, set the left locator at the beginning of a bar, then start playing back the project using the Transport panel. The loops that you now select in the Results list will start together with the project in perfect sync. Play and Stop of the Previewer transport can still be used if needed.

**Previewing audio track presets**

Track presets for audio tracks can only be previewed in the Presets browser (see “Loading track or VST presets in the Inspector or the context menu of the track” on page 334).

**Previewing MIDI files**

To preview a MIDI file (.mid), you first have to select an output device from the Output pop-up menu.

- “Auto Play New Results Selection” and “Align Beats to Project” work as for audio files, see above.

**Previewing MIDI loops**

To preview a MIDI loop file, click the Play button.

- “Auto Play New Results Selection” works as for audio files, see above.

**MIDI loops are always played back in sync to the project.**

**Previewing VST presets and track presets for MIDI and instrument tracks**

Track presets for MIDI or instrument tracks and VST presets require MIDI notes for previewing. These notes can be sent to the track preset in the following way:

- Via MIDI Input
- Using a MIDI file
- Using the Memo Recorder
- Via the computer keyboard

These methods will be described in the following sections.

**Previewing presets via MIDI input**

MIDI input is always active, i.e. when a MIDI keyboard is connected to your computer (and set up properly), you can directly start playing the notes to preview the selected preset.
**Previewing presets using a MIDI file**

Proceed as follows:

1. On the Sequence Mode pop-up menu, select “Load MIDI File”.
2. In the file dialog that opens, navigate to the desired MIDI file, and click Open. The name of the MIDI file is displayed on the pop-up menu.
3. Click the Play button to the left of the pop-up menu. The notes received from the MIDI file are now played back with the settings of the track preset applied.
   - The recently used MIDI files are kept on the menu, for quick access. To remove an entry from this list, select it on the menu and then select “Remove MIDI File”.

**Previewing presets using the Memo Recorder**

The Memo Recorder function continually repeats a given sequence of notes as a loop.

To use the Memo Recorder, proceed as follows:

1. On the Sequence Mode pop-up menu, select Memo Recorder.
2. Enter the notes via the MIDI or computer keyboard. The Play button is automatically activated and you will instantly hear the notes you play with the preset settings applied.
   - When you stop playing notes and wait for 2 seconds, the note sequence you played until this moment will be played back in a continuous loop. To use another sequence, simply start entering notes again.
   - You cannot use the Memo Recorder when previewing presets using a MIDI file.

**Previewing presets via the computer keyboard**

Proceed as follows:

1. Activate the “Computer Keyboard Input” button. The keyboard display in the Previewer section works in the same way as the Virtual Keyboard, see “The Virtual Keyboard” on page 88.

   > When you activate the “Computer Keyboard Input” button, the computer keyboard is used exclusively for the Previewer sections, i.e. the usual key commands are blocked. The only exceptions are: [Ctrl]/[Command]-[S] (Save), Num [*] (Start/Stop Record), [Space] (Start/Stop Playback), Num [1] (Jump to left locator), [Delete] or [Backspace] (Delete), Num [/] (Cycle on/off), and [F2] (Show/Hide Transport panel).

2. Enter the notes via the corresponding keys on the computer keyboard.

**Previewing pattern banks**

Pattern banks containing drum patterns can be created with the MIDI plug-in Beat Designer. Detailed information on the Beat Designer and its functions can be found in the chapter “MIDI effects” in the separate PDF document “Plug-in Reference”. One pattern bank contains 4 sub-banks which in turn contain 12 patterns each. In the Previewer section for a pattern bank file, a keyboard-style display allows you to select a subbank (click on a number at the top) and a pattern (click on a key).

- To preview a pattern, select the pattern bank in the Results list. In the Previewer section, choose a subbank and pattern. Then click the Play button.

  Note that subbanks can contain empty patterns. Selecting an empty pattern in the Previewer section will have no effect. Patterns containing data are indicated by a circle in the upper part of the key in the display.
The Filters section

With the MediaBay, you can perform very refined file searches. You have two possibilities: Logical or Attribute Filtering.

Applying a logical filter

Logical filtering is similar to working with the Logical Editor (Cubase only), see the chapter "The Logical Editor, Transformer, and Input Transformer" on page 440.

If you click the Logical button in the Filters section, you can set up complex conditions that must be met for files to be found. Here, you can search for a specific file attribute value, for example.

Proceed as follows:

1. In the Locations section, select the Location in which you want to search for files.
2. Activate the Logical search mode by clicking on the Logical button in the Filters section. A condition line appears.
3. Click in the leftmost field, to open the Select Filter Attributes dialog. The dialog shows an alphabetical list of file attributes you can choose from. At the top of the list, the MediaBay maintains an automatically generated list of the last 5 attributes selected during previous searches.
4. Select the attribute(s) you want to use, and click OK.
5. Note that you can select more than one attribute. This creates an OR condition: the files found will match either one or the other attribute.
6. Click OK to set the attribute(s) to search for.
7. On the Condition pop-up menu next to the Attribute pop-up menu, select the desired option.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>contains</td>
<td>The search result must contain the text or number specified in the text field to the right.</td>
</tr>
<tr>
<td>omits</td>
<td>The search result must not contain the text or number specified in the text field to the right.</td>
</tr>
<tr>
<td>equals</td>
<td>The search result must correspond exactly to the text or number specified in the text field to the right, including any file extension. Text searches are not case-sensitive.</td>
</tr>
<tr>
<td>&gt;=</td>
<td>The search result must be higher than or equal to the number specified in the field to the right.</td>
</tr>
<tr>
<td>&lt;=</td>
<td>The search result must be lower than or equal to the number specified in the field to the right.</td>
</tr>
<tr>
<td>is empty</td>
<td>Use this option to find files for which certain attributes have not been specified yet.</td>
</tr>
<tr>
<td>matches</td>
<td>The search result must include the text or number entered in the text field to the right. You can also use boolean operators. This allows for a very advanced text search, see &quot;Performing a text search&quot; on page 317.</td>
</tr>
<tr>
<td>range</td>
<td>When &quot;range&quot; is selected, you can specify a lower and an upper limit for the search result in the fields to the right.</td>
</tr>
</tbody>
</table>

7. Enter the text or number you are looking for in the field to the right.

The Results list is automatically updated, showing only the files that correspond to your search conditions.

- For all conditions except "range", you can enter more than one string in the text field (separate the different search strings with a space). These strings form an AND condition, i.e. the files that are found will match all the strings entered in the field.
- To add another filter line, click the "+" button to the right of the text field.

This way, you can add up to five filter lines in which you can define further search conditions. Note that two or more filter lines form an AND condition, i.e. the files searched for must match the conditions defined in all filter lines. Click the "-" button for a filter line to remove it.

- To reset all search fields to their default settings, click the Reset Filter button in the top right corner of the Filters section.

The MediaBay
Advanced text search
You can also perform very advanced text searches using boolean operators. Proceed as follows:
1. Select the desired location.
2. Activate Logical filtering by clicking on the Logical button at the top of the Filters section.
   A condition line appears.
3. Select the desired attribute on the Attributes pop-up menu, or leave the setting on “Any Attribute”.
4. Make sure that the condition is set to “matches”.
5. Specify the desired text in the field to the right using boolean operators.
The available options are described in the section “Performing a text search” on page 317.

Performing a context menu search
If you have selected a file in the Results list or the Attribute Inspector which contains an attribute you are interested, there is a very fast way to look for other files with the same attribute.

Right-click the selected file to open the context menu and select the attribute value from the “Search for…” sub-menu. This way you can easily find all the files that have this value in common, for example if you want to view all files that were created on the same day.

⚠️ This is the same as specifying a logical search string, see above. When you select any of the “Search for…” options, the Filters section automatically switches to Logical filtering and the corresponding filter condition line is displayed. To return to the previous settings, click the Go Back button in the Filters section.

Applying an attribute filter

The MediaBay allows you not only to view and edit some of the standard file attributes found in all computer files, but it also provides preconfigured attributes, or “tags”, that you can use to organize your media files, see “The Attribute Inspector” on page 323.

If you click the Attribute button, the Filters section displays all values found for a specific attribute. Selecting one of these values will result in a list of files all showing this particular attribute value. For example, you could look for sample rates and pick 44.1 kHz to give you a list of all files with that particular sample rate.

The advantages of the use of attributes become obvious when having to find a specific file in a large database, without knowing the name of that file.

⚠️ In Cubase Artist, the Attribute search is the only search mode available.

When you activate Attribute filtering, the Filters section shows attribute columns, each with its own list of attribute values. If the columns are wide enough, the number of files that match this criteria is displayed to the right of the filter name.

You define an Attribute filter by clicking on the values in an attribute column: only the files that match the selected attribute values are then shown in the Results list. Select more attribute values from other columns to further refine your filter.

⚠️ Some attributes are directly linked to each other (e.g. for each Category value, there are certain Sub Category values available). Changing the value in one of these attribute column will give you different values in the other column!

⚠️ Each attribute column displays only the attribute values found in the currently selected location! This means that selecting another location may lead to the display of different attributes.
Selected attribute values in the same column form an OR condition. This means that files must be tagged according to either one or the other attribute value to be displayed in the Results list.

Note that this is not true for the Character attribute, which always forms an AND condition, see below.

Attribute values in different columns form an AND condition. This means that files must be tagged according to all these attribute values to be shown in the Results list.

Assigning attribute values to your files makes it easy to organize the media files. This is described in detail in the section “The Attribute Inspector” on page 323.

You can also create user attributes (see “Defining user attributes” on page 326) to create your own categories.

Further options for attribute searches

- You can change which attribute type is displayed in each column by clicking on the column title and selecting another attribute from the context menu.
- You can select an attribute value, by clicking on it. To deselect it, click the value again. Note that you can select more than one value in each attribute column.
- You can clear all settings in the attribute columns by clicking the Reset Filter button at the top right of the Filters section. Clicking this button also resets the Results list.

The Attribute Inspector

Attributes (or “tags”) for media files are sets of metadata providing additional information on the file.

When you have selected one or more files in the Results list, the Attribute Inspector shows a two-column list of attributes and their values. This is very handy to get a quick overview of a selected file (for example when you are stepping through the files in the Results list).

The different types of media files have different attributes: For example, for .wav audio files you will find attributes like name, length, size, sample rate, etc., while for .mp3 files, additional attributes such as artist or genre are available. In this section, you can also edit the attribute values of files or enter new attribute values, see below.

The available attributes are divided into several groups (Media, Audio, Staff, etc.), so as to keep the list manageable and make it easy to find the desired element quickly. You have access to the standard attributes and the pre-configured attributes provided by Cubase. Additionally you can define your own attributes and add these to your files.

Attributes can be shown in the Attribute Inspector in two different ways:

- Click the Dynamic button to show all available attribute values.

This list is automatically generated by Cubase. Use this view if you want to see the attributes the selected files have already been tagged with.
• Click the Defined button to show a configured set of attributes for the selected media type.
In this mode, you can choose which attributes are displayed (regardless of whether corresponding values are available for the selected files). For more information on how to set up the list of displayed attributes, see “Managing the attribute lists” on page 326.

Editing attributes (tagging)
The search functions, especially the attribute filter, become a truly powerful media management tool when making extensive use of tagging, i.e. when adding and editing attributes.

Media files are usually organized in complex folder structures to provide a logical way of guiding the user to the desired files, with the folder and/or file names indicating the instrument, style, tempo, etc.

To find a particular sound or loop in such a folder structure can be very time consuming – tagging is the answer!

Editing attributes in the Attribute Inspector
In the Attribute Inspector, you can edit attribute values of the various media files. Attribute values can be chosen from pop-up lists, entered as text or numbers, or set to Yes or No.

Note that changing an attribute value in the Attribute Inspector will permanently change the corresponding file (unless the file is write-protected or part of a VST Sound archive).

You can edit attributes in the following way:

1. Select the file that you want to make settings for in the Results list.
The corresponding attribute values are displayed in the Attribute Inspector.

2. Click in the Value column for the attribute.

Depending on the selected attribute, the following happens:

• For most of the attributes, a pop-up menu opens from which you can choose a value. This can be a name, a number and an on/off state. For example, this is the case for the attributes Name, Family Name, or Author.

Some of the pop-up menus also have a “more…” entry to open a window with more attribute values. These attribute selection windows also feature a Text Search button that you can use to find specific values more quickly.

• For the Rating attribute, you can click in the Value column and drag left or right to modify the setting.

• For the Character attribute (Musical group), the Edit Character dialog opens.
Click a radio button on the left or the right side and then click OK to define values for the Character attribute.

3. Set the attribute to the desired value.

• Many attribute values can also be edited by double-clicking in the Value column of the Attribute Inspector. Simply enter/change the text or number setting in the field displayed for a value.

• To remove the attribute value from the selected files, right-click in the corresponding Value column and select “Remove Attribute” from the context menu.

• “Display only” attributes cannot be edited.
If this is the case, the file format probably does not permit changing this value, or changing a particular value makes no sense (e.g. you cannot change the file size in the MediaBay).

You can also select several files and make settings for them simultaneously (except for the name, which must be unique for every file).
About the color scheme used in the Attribute Inspector

The colors used for the displayed values in the Attribute Inspector have the following meaning:

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>White</td>
<td>This represents a “normal” attribute: One or more files are selected in the Results list, and they have the same values.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Yellow color stands for an “ambiguous” attribute: Multiple files are selected in the Results list, and their values differ.</td>
</tr>
<tr>
<td>Orange</td>
<td>This stands for an “ambiguous static attribute”: Multiple files are selected in the Results list, with differing values, and which cannot be edited.</td>
</tr>
<tr>
<td>Red</td>
<td>Red values are displayed for a “static attribute”: One or more files are selected in the Results list, whose values cannot be edited.</td>
</tr>
</tbody>
</table>

Information on the meaning of the colors used in the Attribute Inspector are also displayed in a tooltip when you move the mouse pointer over one of the color icons below the Attribute Inspector.

Editing attributes in the Results list

You can also edit attributes directly in the Results list. This allows you for example to assign tags to a number of loop files.

⚠️ This is only possible if “Allow Editing in Results List” is activated, see “Preferences” on page 327.

Proceed as follows:

1. In the Results list, select the file(s) for which you want to change an attribute value.
2. Click in the column for the value you want to change and make the desired settings.
   As in the Attribute Inspector, you can choose a value from a pop-up menu, enter the new value directly, etc.

Editing the attributes of multiple files simultaneously

There is no limit as to how many files can be tagged at the same time, but you need to be aware that the tagging of a large amount of files in one go may take quite a while. This operation is executed in the background, so that you can continue with your work as usual. By looking at the Attribute Counter above the Results list, you can see how many files still have to be updated.

• If you close Cubase before the Attribute Counter has gone down to zero, a dialog with a progress bar is displayed, indicating how long the updating process will take. You can choose to abort this process.
   In this case only the files that were updated before you clicked “Abort” will have the new attribute values.

Editing the attributes of write-protected files

Media files may be write-protected due to a number of reasons: They may belong to content that was provided by someone else who write-protected the files, you may have write-protected them yourself in order not to overwrite them accidentally, or the file format could restrict write operations by the MediaBay.

In the MediaBay, the write protection status of files is shown as an attribute in the Attribute Inspector and in the Write Protection column in the Results list.

However, there may be cases when you want to define attributes for write-protected files. For example, you might want to apply attributes to the content files that came with Cubase or you are working on the same files with several people and cannot modify these files. In these scenarios, you still want to be able to find files quickly and improve your workflow.

Therefore, it is possible to change the attribute values of write-protected files in the MediaBay. These changes are not written to disk though and occur in the MediaBay only.

• When you specify attribute values for a file that is write-protected, this is reflected in the Pending Tags column next to the Write Protection column in the Results list.
   Note that if you rescan the MediaBay content and a media file on your hard disk has changed since the last scan, all pending tags for this file will be lost.

• If a file has pending tags, and you want to write the corresponding attributes to the file, you need to remove the write protection first, and then select the “Write Tags to File” command from the context menu.
  ⚠️ If the Write Protection and/or the Pending Tags column are not visible, you may have to enable the corresponding attributes for the file type in question in the Attribute Inspector.
• You can change the write-protection status of your media files, provided that the file type allows write operations and you have the necessary operation system permissions: To set or remove the write protection attribute for a file, simply select the file in the Results list and select “Set/Remove Write Protection” from the context menu.

☞ If you use other programs than Cubase to change the write-protection status of a file, this will not be reflected in the MediaBay until you rescan the files!

Managing the attribute lists

In the Attribute Inspector, you can define which attributes are shown in the Results list and in the Attribute Inspector itself. For different media types, individual “attribute sets” can be configured.

Proceed as follows:

1. In the Attribute Inspector, click the Defined button.
2. Click the “Configure Defined Attributes” button to the right of the Defined button.
   A number of controls are displayed.
3. Click the leftmost button below the Defined/Dynamic buttons to open the “Select Media Types” dialog, activate one or more of the media types, and click OK.
   The Attribute Inspector now shows a list of all attributes available for these media types.
   • If you have activated more than one media type, your settings affect all selected types.
   An orange checkmark indicates that the current display settings for an attribute differ for the selected media types.
   • The display settings made for the Mixed Media Type option are applied whenever you select files of different media types (for example audio and MIDI files) in the Results list or the Attribute Inspector.
4. To select a certain attribute, activate the corresponding checkbox.

• You can also select several attributes and activate/de-activate their checkboxes in one go.

The Type column shows whether the value for an attribute is a number, text, or a Yes/No switch.

The Precision column shows the number of decimals displayed for number attributes.

• You can reset the display settings you made by clicking the “Reset to Default” button in the top right corner. This will reset the display settings for all media types to their default settings.

☞ To make settings for another media type, make sure to only select this type in the list in the dialog.

5. When you have set up the attributes for all the media types you are working with, exit the Configuration mode by clicking the “Configure Defined Attributes” button again.

Defining user attributes

If you find that the available attributes are not suitable for your work, you can define your own attributes and save these in the MediaBay database and the corresponding media files.

Proceed as follows:

1. In the Attribute Inspector, activate the Defined button and click the “Configure Defined Attributes” button to enter configuration mode.
   A number of controls are displayed.
2. Click the “Add User Attribute” button (the “+” sign).
   A dialog opens.
3. Specify the type of the attribute.
   Attributes can be of the types “Text”, “Number” or “Yes/No” switch. For “Number” attributes, you can specify how many decimals are displayed, by entering the corresponding value in the Precision field.
4. In the text field below, enter the name for the new attribute.
   Note that this is the name as it will be displayed in the program. Below the text field, you will see the name as it will be used internally (e.g. in the MediaBay database). This way, you will see immediately if a certain name is invalid and cannot be used.
5. Click OK.
The new attribute is added to the list of available attributes and will be displayed in the Attribute Inspector and the Results list.
• To remove a user attribute, select it in the attribute list and click the “Remove User Attribute” button (the “-” sign). The attribute is removed from any attribute list.
• Cubase recognizes all user attributes that are included in media files. For example, if you load content from another user, who has assigned his own user tags to the files, these tags are also shown in the MediaBay.

The Loop Browser, Sound Browser, and Mini Browser windows

The Loop Browser, Sound Browser, and Mini Browser items on the Media menu open different “views” of the MediaBay. The Loop Browser is preconfigured for quickly browsing your “loops”, i.e. audio files, MIDI loops, and pattern banks. Similarly, the Sound Browser is set up for you to be able to quickly search the desired sound, without having to configure the window. By default, it is set to display track presets and plug-in presets. The Mini Browser is very small, which makes it perfect to be placed along instruments like LoopMash or Groove Agent One.

These Browser windows offer the same functions as the MediaBay, i.e. you can specify different browse locations, define searches, set up the available panes, etc., as described previously in this chapter.

Preferences

In the Preferences dialog in Cubase, you can find options and settings that control the global behavior of the program. The Preferences dialog contains a special MediaBay page. These settings are also available from within the MediaBay.

To open the Preferences pane for the MediaBay, proceed as follows:
1. Click the MediaBay Preferences button in the lower left corner of the window.

   - A transparent pane appears, covering the window. In the center of it is a gray area where the available preferences for the Locations section and the Results list are displayed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Managed Locations Only</td>
<td>Activate this to hide all folders that are not scanned for files. This will keep the tree view in the Define Locations section less cluttered.</td>
</tr>
<tr>
<td>Use Current Selection as Base Location</td>
<td>Activate this to show only the selected folder and its subfolders. To switch back to the display of all folders, deactivate this option.</td>
</tr>
<tr>
<td>Scan Folders Only when MediaBay is Open</td>
<td>When this is activated, Cubase only scans for media files when the MediaBay window is open. When this is deactivated, the folders are scanned in the background even when the MediaBay window is closed. However, Cubase will never scan folders while playing back or recording.</td>
</tr>
</tbody>
</table>

The following options are available in the Results section:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Items in Results List</td>
<td>Use this parameter to specify the maximum number of files that are displayed in the Results list. This avoids unmanageably long lists of files. Note that the MediaBay does not warn you if the maximum number of files has been reached and there might be situations where a certain file you were looking for could not be found, because the maximum number of files was reached.</td>
</tr>
<tr>
<td>Allow Editing in Results List</td>
<td>When this is activated, you can also edit attributes in the Results list. When this option is deactivated, editing can only be done in the Attribute Inspector.</td>
</tr>
</tbody>
</table>
Key commands

You can display the available MediaBay key commands from within the MediaBay window. This is useful if you want to get a quick overview over the assigned and the available MediaBay key commands.

To open the Key Commands pane, proceed as follows:

- Click the Key Commands button in the lower left corner of the window.

A transparent pane appears, covering the window. In the center of it is a gray area where the available key commands are displayed.

- If you only want to get an overview over the key commands, you can exit the pane by clicking on its background (not in the gray area).
- If you want to assign or modify key commands, click in the gray area.

The Key Commands dialog opens, in which you can set up and edit key commands, see the chapter “Key commands” on page 541.

Working with MediaBay-related windows

The MediaBay concept can be found throughout the program, for example when adding new tracks or when choosing presets for VST instruments or effects. The workflow in all MediaBay-related windows is the same as in the MediaBay. Below follow a few examples.

Adding tracks

When you select one of the Add Track options on the Project menu, the following dialog opens:

Click the Browse button to expand the dialog to show the Results list (as you can find it in the MediaBay). However, only file types that can be used in this context are shown.

You can also apply track presets to existing tracks. The dialog that opens in this case is the same as above.

Applying effect presets

When you have added an insert effect, you can choose from a variety of presets via the Presets pop-up menu for the effect slot.
The Presets browser opens:

Applying instrument presets
When working with VST instruments, you can choose from a variety of presets via the Presets pop-up menu.

VST presets for instruments can be divided into two groups: “presets” containing the settings of the whole plug-in (for multi-timbral instruments, this means the settings for all sound slots as well as the global settings) and “programs” containing only the settings for one program (for multi-timbral instruments, this means only the settings for one sound slot). In the MediaBay, they can be recognized by their icons. This way, you can see directly whether a VST preset contains a single sound or more.

Presets and programs have the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>This preset contains settings for all loaded programs.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>This program only contains settings for the first or the selected instrument slot.</td>
</tr>
</tbody>
</table>

Working with Volume databases

Cubase stores all media file information used in the MediaBay, such as paths and attributes, in a local database file on your computer. However, in some cases, it might be necessary to browse and manage this kind of metadata on an external volume. For example, a sound editor might have to work both at home and in a studio, on two different computers. Therefore, he has stored his sound effects on an external storage medium. When he is working on a different computer, he wants to connect the external device and directly browse its contents in the MediaBay, without having to scan the device again. This can be achieved by creating a volume database for the external device.

Volume databases are files that can be created for drives of your computer or for external storage media. They contain the same kind of information about the media files on these drives as the regular MediaBay database.
Creating a volume database

To create a separate volume database file for a drive, proceed as follows:

1. In the Define Locations section of the MediaBay, select the external storage medium, drive or partition of your computer system that you want to create a database for.

⚠️ You must select the topmost level (root) for this. You cannot create a database file for a lower-level folder.

2. Right-click on it and select “Create Volume Database” on the context menu.

The file information for this drive is now written into a new database file.

If the drive contains a large amount of data, this process may take a while.

When the new database file is available, this is reflected by the symbol to the left of the drive name.

For this volume a volume database has been created.

Volume databases are automatically mounted when Cubase is launched. They are shown in the Define Locations section and their data can be viewed and edited in the Results list, as for the other media files in the MediaBay.

Rescanning and refreshing

Use the Rescan and Refresh MediaBay functions for a volume database if you have modified the scan settings on a different system, for example, by activating additional folders for scanning.

Removing volume databases

When you have worked on another computer using an external hard disk and return to your own computer and connect the external device again as part of your system setup, you do not need a separate volume database for it any more. Any data on this drive can then be included in the local database file again, by removing the extra database file.

- To remove a database, right-click on it and select “Remove Volume Database” from the context menu.

This integrates the metadata in the local MediaBay database file and subsequently deletes the volume database file.

Depending on the size of the volume database, this might take a while.

Mounting and unmounting volume databases

When you launch Cubase, all available volume databases are automatically mounted. Databases that are made available while the program is running have to be mounted manually via the command “Mount Volume Database” on the context menu. To unmount a volume database, select “Unmount Volume Database” from the context menu.
Working with track presets
**Introduction**

Track presets are templates from audio, MIDI or instrument tracks that can be applied to newly created or existing tracks of the same type. They contain sound and channel settings, and allow you to quickly browse, preview, select and change sounds, or reuse channel settings across projects.

Track presets are organized in the MediaBay (see the chapter “The MediaBay” on page 311), where you can categorize them with attributes.

**Types of track presets**

There are four kinds of track presets (audio, instrument, MIDI and Multi) and two kinds of VST presets (VST instrument presets and VST effect plug-in presets). These are described in the following sections.

- Track preset settings for volume, pan, input gain and input phase will be applied only when creating a new track from a track preset.

**Audio track presets**

Track presets for audio tracks include all settings that define the sound. You can use the factory presets as a starting point for your own editing and save the audio settings that you optimized for an artist you often work with as a preset for future recordings.

The following data is saved in audio track presets:

- Insert effects settings (including VST effect presets)
- EQ settings
- Volume + pan
- Input gain + phase

**Instrument track presets**

Instrument track presets offer both MIDI and audio features and are the best choice when handling sounds of simple, mono-timbral VST instruments. Use instrument track presets for auditioning your tracks, or saving your preferred sound settings, for example. You can also extract sounds from instrument track presets for use in instrument tracks, “Extracting sound from an instrument track or VST preset” on page 335.

The following data is saved in instrument track presets:

- Audio insert effects
- Audio EQ
- Audio volume + pan
- Audio input gain + phase
- MIDI insert effects
- MIDI track parameters
- Input Transformer settings
- The VST instrument used for the track
- Staff settings
- Color settings
- Drum map settings

**MIDI track presets**

MIDI tracks should be used for multi-timbral VST instruments and external instruments. When creating MIDI track presets you can either include the currently set channel, or the currently set patch. See “Creating a track preset” on page 335 for details.

To ensure that saved MIDI track presets for external instruments will work again with the same instrument, install the instrument as a MIDI device, see the separate PDF document “MIDI Devices”.

The following data is saved in MIDI track presets:

- MIDI modifiers (Transpose, etc.)
- MIDI insert effects
- Output + Channel or Program Change
- Input Transformer settings
- Volume + pan
- Staff settings
- Color settings
- Drum map settings
Multi-track presets
You can use multi-track presets, for example, when recording setups that require several microphones (a drum set or a choir, where you always record under the same conditions) and you have to edit the resulting tracks in a similar way. Furthermore, they can be used when working with layered tracks, where you use several tracks to generate a certain sound instead of manipulating only one track.

If you select more than one track when creating a track preset, the settings of all selected tracks will be saved as one multi-track preset. Multi-track presets can only be applied if the target tracks are of the same type, number and sequence as the tracks in the track preset, therefore, they should be used in recurring situations with very similar tracks and settings.

VST (instrument) presets
VST instrument presets (extension ".vstpreset") behave like instrument track presets and contain a VST instrument and its settings but no modifiers, MIDI inserts, inserts, or EQ settings. You can extract sounds from VST presets for use in instrument tracks, see "Extracting sound from an instrument track or VST preset" on page 335.

The following data is saved in VST instrument presets:
• VST instrument
• VST instrument settings

VST effect plug-ins are available in VST3 and VST2 format. Presets for these effects are also saved as VST presets. These can be part of audio track presets (see "Audio track presets" on page 332).

⚠️ In this manual, “VST presets” stands for VST3 instrument presets, unless stated otherwise.

Pattern banks
Pattern banks are presets created for the Beat Designer MIDI effect. They behave much like track presets. For detailed information, see “Previewing pattern banks” on page 320 and the chapter “MIDI effects” in the separate PDF document “Plug-in Reference”.

Applying track or VST presets via drag and drop
1. Open the MediaBay from the Media menu.
2. Select a MIDI or instrument track preset, or a VST preset.
3. Preview the preset using the functions in the Previewer section (for further information, see “Previewing files” on page 318).
4. Drag and drop it onto a track of the same type.
You can also drag and drop track presets from the Windows Explorer or the Mac OS Finder, but in this case, no preview for track presets is possible.

Loading track or VST presets in the Inspector or the context menu of the track

1. In the Project window, select a track.
2. Click in the Load Track Preset field at the top of the Inspector (above the track name) or right-click the track in the track list and select “Load Track Preset”.

The Presets browser opens.

3. Select a track or VST preset from the Results list. If needed, filter the list by activating the attributes you are looking for in the Filters section. This section is similar to the Filters section in the MediaBay, see “The Filters section” on page 321.
4. Start playback to preview the selected audio, MIDI, instrument track, or VST preset. All settings from the track preset are applied in realtime to the selected track. If you set up your target track to a cycle and play back in loop, previewing will be very comfortable. Note that you cannot preview multi-track presets.
5. When you have found the preset that you want, double-click on it (or click outside the Presets browser). The preset is applied.
   • To return to the preset that was selected when you opened the Presets browser, click the “Revert to Last Setting” button.

Applying a multi-track preset

1. Select several tracks in your project. Multi-track presets can only be applied if track type, number, and sequence are identical for the selected tracks and the track preset.
2. Right-click the track to open the context menu and select “Load Track Preset”. The Presets browser opens. Only multi-track presets corresponding to the selection of tracks in the project are shown.
3. Select a multi-track preset from the Results list.
4. When you have found the preset that you want, double-click on it (or click outside the Presets browser). The preset is applied.
   • To return to the preset that was selected when you opened the Presets browser, click the “Revert to Last Setting” button.

Reloading track or VST presets

When you have modified the settings of a track or VST preset and are not satisfied with the results, you can revert to the default settings of the preset by clicking the “Reload Track Preset” button.

Applying inserts and EQ settings from track presets

Instead of handling complete track presets, it is also possible to apply insert or equalizer settings from track presets. Proceed as follows:

1. Select the desired track, open the Inspector or the Channel Settings window and click the VST Sound button on the Inserts or Equalizers tab/section. The Preset Management pop-up menu opens.
2. On the pop-up menu, select “From Track Preset...”. The Presets browser opens, showing all available track presets that contain inserts or EQ settings.
3. Select a track preset and click outside the browser.

For information on the general handling of inserts presets, see “Effect presets” on page 200. The general handling of EQ presets is described in the section “Using EQ presets” on page 161.

334
Working with track presets
Extracting sound from an instrument track or VST preset

For instrument tracks, you can extract the “sound” of an instrument track preset or VST preset, that means the VST instrument and its settings. Proceed as follows:

1. Select the instrument track to which you want to apply a sound.
2. Click the VST Sound button below the Output Routing field in the Inspector.

The Presets browser opens, showing a list of all available presets.

3. Select an instrument track preset or VST preset by double-clicking on it.

The VST instrument and its settings (but no inserts, EQs, or modifiers) on the existing track are overwritten with the data of the track preset. The previous VST instrument for this instrument track is removed and the new VST instrument with its settings is set up for the instrument track.

Creating a track preset

A track preset can be created from an existing audio, MIDI, or instrument track – or a combination of these. Proceed as follows:

1. In the Project window, select one or more tracks. If several tracks are selected, all of them are stored in one combined multi-track preset, see “Multi-track presets” on page 333.
2. Right-click one of the selected tracks in the track list and select “Save Track Preset” from the context menu. The Save Track Preset dialog opens.

3. In the New Preset section, enter a name for the new preset. The track preset file name extension .trackpreset is assigned automatically.

- If you want to save attributes for the preset, click the button below the “New Preset” section at the bottom left. The Attribute Inspector section opens, allowing you to define attributes for the preset. For further information about attributes, see “The Attribute Inspector” on page 323.
- If you create a track preset for a MIDI track, you can decide whether you want to include the MIDI channel or the MIDI patch.
  Select “Include MIDI channel” when working with a pre-configured multi-timbral external instrument (for example, a sampler). That way the correct channel will be called up.
  Select “Include MIDI Patch” when working with a multi-timbral external instrument (e.g. a MIDI expander), where all sounds are available on all channels so that the sounds (patches) can be changed on the fly.

4. Click OK to save the preset and exit the dialog.

Track presets are saved within the application folder in the “Track Presets” folder (in default subfolders named according to their track type: audio, MIDI, instrument, and multi).

- You cannot change the default folders, but you can add further subfolders (by clicking the New Folder button).
In the MediaBay, all presets are available under the (virtual) VST Sound node, see “The VST Sound node” on page 314.

If you want to use a MIDI track preset for a pre-configured VST instrument setup, load the VST instrument(s) in the VST Instruments window, select a VST instrument patch, save the track preset, and do not change the patch afterwards. To ensure this, use a template project with the VSTi setup included and save the sounds (track presets) of this template project in specific subfolders, as they only work within this setup.

Creating tracks from track presets or VST presets

Using drag and drop
1. Open the MediaBay from the Media menu.
2. Select a track or VST preset from the list of all presets.
3. Start playback to preview the selected VST preset. All settings are applied in realtime to the selected track. If you set up your target track to a cycle and play back in loop, previewing will be very comfortable. Note that you cannot preview multi-track presets.
4. Drag and drop the preset onto the track list in the Project window. One or more (in case of multi-track presets) tracks are created. If you drag and drop a VST instrument preset, an instrument track is created.

You can also drag and drop from the Windows Explorer or the Mac OS Finder, but in this case, no preview for MIDI and instrument track presets is possible.

Using the Choose Track Preset dialog
1. Right-click the track list to open the context menu and on the Add Track submenu select “Add Track Using Track Preset…”.

The Choose Track Preset dialog opens, showing a list of the available presets.
2. Select a preset from the Results list. The Results section of the Choose Track Preset dialog displays all preset sounds for all track types and VST instruments.

Using the Filters section, you can narrow down the list by selecting the attributes that you are looking for. This section is similar to the Filters section in the MediaBay, see “The Filters section” on page 321.

• Open the Location Tree section to select the folder in which you want to look for presets.

To show the Location Tree section, click the “Set Up Window Layout” button and activate the Location Tree option.

3. To preview MIDI and instrument track presets or VST presets, you have to play MIDI notes on a MIDI keyboard or load a MIDI file because there is no track connected. The previewing options are described in detail in the section “Previewing VST presets and track presets for MIDI and instrument tracks” on page 319.

The Preview functions work in the same way in the MediaBay and its related dialogs. Note however that not all Preview functions available in the MediaBay are also available in the dialogs.

4. When you have found the right preset, click the Add Track button to close the dialog. One or more tracks (in case of multi-track presets) are created.

Using the Add Track function
1. Right-click the track list and select one of the Add Track options on the context menu.
2. Click the Browse button to expand the Add Track dialog. The Presets Browser opens. The options are the same as when applying a preset to an existing track, see “Loading track or VST presets in the Inspector or the context menu of the track” on page 334. The view is filtered to show only the corresponding track presets.
3. Select a track or VST preset.
4. Click the Add Track button to create the track.

This method is not available for multi-track presets.
Track Quick Controls
Introduction

Cubase can give you instant access to up to eight different parameters (e.g. track, effect, or instrument controls). This is done with the aid of the so-called quick controls, set up on the Quick Controls Inspector tab for the corresponding track.

The Quick Controls tab can be used as a kind of track control center, an area in which your most important parameters are assembled in one place. This saves you from having to click your way through the various windows and sections pertaining to your track.

Also, Cubase allows you to assign these quick controls very quickly to an external remote control device. This does not only give you manual control of your most important track parameters, but also allows you to conveniently use an external MIDI device such as a foot controller to control effect parameters.

- Quick control assignments are saved with the current project.
- Since quick control settings are part of the track setup, you can save them as track presets, allowing you to re-use your settings across different projects. Track presets are described in the chapter “Working with track presets” on page 331.
- You can automate the parameter settings on the Quick Controls tab using the Read/Write buttons (R and W). The automation features of Cubase are described in detail in the chapter “Automation” on page 227.

Assigning parameters to quick controls

The Quick Controls tab shows eight slots, one for each quick control. To start with, these slots are empty. Parameters can be assigned manually or retrieved automatically, see below.

Assignment via the Learn function

Using the “QC Learn Mode” button on the Quick Controls tab in the Inspector, you can assign a parameter by moving the corresponding control:

- Activate the “QC Learn Mode” button, select the slot to which you want to assign a parameter and use the desired control.

Assignment via a plug-in panel

You can assign effect parameters to quick control slots directly from within the plug-in panel:

- To assign an effect parameter to the topmost quick control slot, right-click the parameter and select the “Add x to Quick Controls” option (where “x” is the name of the parameter).
- To assign an effect parameter to a specific quick control slot, right-click the parameter, select the “Add x to Quick Controls Slot” option (where “x” is the name of the parameter), and select the desired slot from the submenu.

These options are only available for VST 3 plug-ins that support this function.
Manual assignment via the Inspector tab

Proceed as follows to manually assign track parameters:

1. On the Quick Controls tab, click on the first quick control slot.
   A pop-up menu opens. It lists all parameters currently accessible for this particular track.

2. Double-click the parameter that you want to assign to the first quick control slot.
   The parameter name and its value are displayed in the slot. You can change the value by dragging the slider.

3. Repeat these steps for each quick control slot until all eight slots are associated with track parameters.

You can now control the 8 functions most important to you via one single Inspector section.

- To rename a quick control, double-click on the name in the slot to select it, enter a new name and press [Enter].
- To replace a parameter assignment with a different parameter, click on the corresponding quick control slot and double-click a different parameter.

Automatic assignment of VST instrument parameters

When you create an instrument track or load a VST instrument via the VST Instruments window (including creating an associated MIDI track), the main parameters of the instrument are automatically assigned to the slots on the Quick Controls tab in the Inspector (if the VST instrument supports this feature).

- To retrieve the default assignments for the main parameters of the VST instrument, click the “Get Default QCs from Plug-in” button on the Inspector tab.

This is useful if you have changed the parameter assignment or if you manually route a MIDI track to a VST instrument.

Removing parameter assignments

- To remove a parameter from a slot, double-click the parameter name to select it and press the [Delete] or [Backspace] key. Confirm by pressing [Return].
- Alternatively, you can click in the corresponding slot and select “No parameter” from the pop-up menu.
- To remove the quick control assignments for all slots, press [Alt]/[Option] and click the “Remove All QC Assignments” button.

Connecting quick controls with remote controllers

Quick controls become really powerful when used in combination with a remote controller. Setting up the connection between the slots on the Quick Controls Inspector tab and a remote control device is easy.

Proceed as follows:

1. In Cubase, open the Device Setup dialog from the Devices menu.
2. In the Devices list on the left, select the Quick Controls option.
This will open the Quick Controls section on the right of the dialog:

3. With your remote control device connected to Cubase via MIDI, select the corresponding MIDI port on your computer in the MIDI Input pop-up menu (or select “All MIDI Inputs”). If your remote controller has its own MIDI input and supports MIDI feedback, you can connect your computer to the device input. Then, select the corresponding MIDI port in the MIDI Output pop-up menu.

4. Click “Apply” to use the new MIDI port assignment.

5. Activate the Learn option.

6. In the “Control Name” column, select “QuickControl1”.

7. Move the control (knob, fader or other) on your remote control device that you want to use for the first quick control.

8. To assign further controls, select different slots in the “Control Name” column and repeat the last steps.

   In addition to using the Learn function to set up the table in the Quick Controls section, you can modify the values manually. The available options are identical to the ones available for the Generic Control device, see “The Generic Remote device” on page 345.

You have now associated the slots on the Quick Control tab with control elements on your external remote controller. Moving a control element will automatically change the value of the parameter assigned to the corresponding quick control.

The remote controller setup for quick controls is saved globally, i.e. independent of any projects. If you have various remote controllers, you can store and load several quick control setups using the Export and Import buttons.

Quick controls and automatable parameters

The quick controls feature has one special extension: you can use quick controls not only to access certain parameters of the current track, but also to control all automatable parameters. This makes it possible to use the Quick Controls tab of a dedicated track as a kind of “mini mixer”, controlling parameters on other tracks. Use this function with caution, however, as you might accidentally modify parameters on other tracks.

Proceed as follows:

1. Create a new, empty audio track and open its Quick Controls tab. This track has no events or parts.

2. Hold down the [Ctrl]/[Command] key and click on the slot for quick control 1. The parameter selection context menu opens, but it lists not the parameters of the current track, but all automatable parameters.

3. Open the VST Mixer folder.

The pop-up menu lists all channels available in the Mixer of your current project.
4. Now assign a parameter of one particular channel to quick control 1, and another parameter of another channel to quick control 2.

The Quick Controls tab has become a “secondary” mixer, dedicated to quick-controlling parameters on other tracks.

⚠️ Quick controls that are assigned that way cannot work when saved as track presets.
Remote controlling Cubase
Introduction

It is possible to control Cubase via MIDI. A large number of MIDI control devices is supported. This chapter describes how to set up Cubase for remote control. The supported devices are described in the separate PDF document “Remote Control Devices”.

• There is also a Generic Remote Device option, allowing you to use any MIDI controller to remote control Cubase. How to set this up is described in the section “The Generic Remote device” on page 345.

Setting Up

Connecting the remote device
Connect the MIDI output on the remote unit to a MIDI input on your MIDI interface. Depending on the remote unit model, you may also need to connect a MIDI Out on the interface to a MIDI In on the remote unit (this is necessary if the remote unit features “feedback devices” such as indicators, motorized faders, etc.).

If you are recording MIDI tracks, you do not want any MIDI data from the remote unit to be accidentally recorded as well. To avoid this, you should make the following setting:

1. Open the Device Setup dialog from the Devices menu.
2. Select “MIDI Port Setup” in the list on the left.
3. Check the table on the right and locate the MIDI input to which you have connected the MIDI remote unit.
4. Deactivate the checkbox in the “In ‘All MIDI Inputs’” column for that input, so that the State column reads “Inactive”.
5. Click OK to close the Device Setup dialog.

Now you have removed the remote unit input from the “All MIDI Inputs” group. This means that you can record MIDI tracks with the “All MIDI Inputs” port selected without risking to record the data from the remote unit at the same time.

Selecting a remote device

1. Open the Device Setup dialog from the Devices menu.
2. If you cannot find the remote device you are looking for, click on the plus sign in the top left corner and select the device from the pop-up menu.

The selected device is added to the Devices list.

• Note that it is possible to select more than one remote device of the same type.

If you have more than one remote device of the same type, these will be numbered in the Devices list. For example, to be able to use a Mackie Control Extender, you must install a second Mackie control device.

3. Select your MIDI control device model from the Devices list.

Depending on the selected device, either a list of programmable function commands or a blank panel is shown in the right half of the dialog window.

4. Select the correct MIDI input from the pop-up menu.
If necessary, select the correct MIDI output from the pop-up menu.

5. Click OK to close the dialog.

You can now use the MIDI control device to move faders and knobs, activate Mute and Solo, etc. The exact parameter configuration depends on which external MIDI control device you are using.
• In the Project window (track list) and the Mixer (bottom of channel strips) you will now see white stripes indicating which channels are currently linked to the remote control device.

Audio 10 can be remote controlled, while Audio 11 is not linked to the remote control device.

⚠️ Sometimes communication between Cubase and a remote device is interrupted or the handshaking protocol fails to create a connection. To re-establish communication with any device in the Devices list, select it and click the Reset button in the lower part of the Device Setup dialog. The “Send Reset Message to all Devices” button at the top left of the dialog next to the “+” and “-” buttons will reset every device in the Devices list.

### Operations

#### Global options for remote controllers

In the Device Setup dialog, on the page for your remote device, some (or all) of the following global functions may be available (depending on your remote device):

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank pop-up menu</td>
<td>If your remote device contains several banks, you can select the bank you want to use. The bank you select here is used by default when Cubase is launched.</td>
</tr>
<tr>
<td>Smart Switch Delay</td>
<td>Some of the Cubase functions (e.g. Solo and Mute) support the so called “smart switch” behavior: In addition to regular activation/deactivation of a function by clicking a button, you can also activate the function for as long as the button is pressed. Upon releasing the mouse button, the function is deactivated. This pop-up menu allows you to specify how long a button must be pressed before it goes into “smart switch” mode. When “Off” is selected, the “smart switch” function is deactivated in Cubase.</td>
</tr>
<tr>
<td>Enable Auto Select</td>
<td>If this option is activated, touching a fader on a touch-sensitive remote control device automatically selects the corresponding channel. On devices without touch-sensitive faders, the channel gets selected as soon as you move the fader.</td>
</tr>
</tbody>
</table>

#### Writing automation using remote controls

Automating the Mixer in Touch mode using a remote control device is done in the same way as when you operate on-screen controls in Write mode. In order to replace existing automation data for a control in Touch mode, the computer needs to know how long the user actually “grabbed” or used the control. When doing this “on screen”, the program simply detects when the mouse button is pressed and released. When you are using an external remote control device without touch-sensitive controls, Cubase cannot tell whether you “grab and hold” a fader or simply move it and release it.

Therefore, when you are using a device without touch-sensitive controls and want to replace existing automation data, pay attention to the following:

• If you activate Write mode and move a control on the remote control device, all data for the corresponding parameter is replaced from the position where you moved the control, up to the position where playback is stopped. In other words, as soon as you move a control in Write mode, it remains “active” until you stop playback.

• Make sure that you move only the controller you want to replace.

#### Assigning remote key commands

For some remote devices, you can assign any Cubase function (to which a key command can be assigned) to generic buttons, wheels, or other controls.

Proceed as follows:

1. Open the Device Setup dialog and select your remote device. On the right side of the window you will find a three column table. This is where you assign commands.
2. Use the Button column to locate a remote device control or button to which you wish to assign a Cubase function.
3. Click in the Category column for the control and select one of the Cubase function categories from the pop-up menu.
4. Click in the Command column and select the desired Cubase function from the pop-up menu. The available items on the pop-up menu depend on the selected category.
5. Click “Apply” when you are done.
• Click “Reset” to revert to the default settings.
The selected function is now assigned to the button or control on the remote device.

A note about remote controlling MIDI tracks
While most remote control devices will be able to control both MIDI and audio channels in Cubase, the parameter setup may be different. For example, audio-specific controls (such as EQ) will be disregarded when controlling MIDI channels.

Accessing user panel parameters via remote control devices (Cubase only)
Cubase allows you to control external MIDI devices through user device panels. When you have assigned project parameters to a device panel to be displayed in the Mixer (i.e. when creating the panel, you must select the Channel Strip Size option in the Add Panel dialog), you can access these parameters through some of the remote control devices supported by Cubase.

This feature is supported for the following devices:
• Steinberg Houston
• Mackie Control
• Mackie HUI
• Yamaha DM 2000
• CM Motormix
• SAC2K

These remote control devices provide an extra display page in the Inserts section for the selected channel.

The Generic Remote device
If you have a generic MIDI controller, you can use this for remote control of Cubase by setting up the Generic Remote device:
1. Open the Device Setup dialog on the Devices menu. If the Generic Remote device is not on the Devices list, you need to add it.
2. Click the “+” sign in the top left corner and select the “Generic Remote” device from the pop-up menu.
3. Select the Generic Remote device in the Devices list to the left. The settings for the Generic Remote device are displayed, allowing you to specify which control on your device should control which parameter in Cubase.
4. Use the MIDI Input and Output pop-up menus to select the MIDI port(s) to which your remote device is connected.
5. Use the pop-up menu to the right to select a bank. Banks are combinations of a certain number of channels, and are used because most MIDI devices can control only a limited number of channels at a time (often 8 or 16). For example, if your MIDI control device has 16 volume faders, and you are using 32 Mixer channels in Cubase, you would need two banks of 16 channels each. When the first bank is selected you can control channel 1 to 16; when the second Bank is selected you can control channel 17 to 32.

6. Set up the table at the top according to the controls on your MIDI control device. The columns have the following functionality:

- Column Description
  - Control Name: Double-clicking this field allows you to enter a descriptive name for the control (typically a name written on the console). This name is automatically reflected in the Control Name column in the lower table.
  - MIDI Status: Clicking in this column opens a pop-up menu, allowing you to specify the type of MIDI message sent by the control (e.g., Controller, Prog. Change Trigger). The NRPN and RPN controllers are part of the MIDI specification and present a way to extend the available control messages. The “Ctrl JLCooper” option is a special version of a Continuous Controller where the 3rd byte of a MIDI message is used as address instead of the 2nd byte (a method supported by various JL-Cooper remote devices). For a description of the Ctrl-Houston status value, see the Steinberg Houston hardware manual.
  - MIDI Channel: Clicking in this column opens a pop-up menu, allowing you to select the MIDI channel on which the controller is transmitted.
  - Address: The Continuous Controller number, the pitch of a note, or the address of a NRPN/RPN Continuous Controller.
  - Max. Value: The maximum value the control will transmit. This value is used by the program to “scale” the value range of the MIDI controller to the value range of the program parameter.
  - Flags: Clicking in this column pulls down a pop-up menu, allowing you to activate or deactivate three flags: Receive – activate this if the MIDI message should be processed on reception. Transmit – activate this if a MIDI message should be transmitted when the corresponding value in the program changes. Relative – activate this if the control is an “endless” rotary encoder, which reports the number of turns instead of an absolute value.

- If you find that the table at the top holds too many or too few controls, you can add or remove controls with the Add and Delete buttons to the right of the table.

7. Use the table at the bottom to specify which Cubase parameters you want to control. Each row in the table is associated to the controller in the corresponding row in the first table (as indicated by the Control Name column). The other columns have the following functionality:

- Column Description
  - Device: Clicking in this column opens a pop-up menu, used for determining which device in Cubase is controlled. The special “Command” option allows you to perform certain command actions by remote control. One example of this is the selection of remote banks.
  - Channel/Category: This is where you select the channel to be controlled or, if the “Command” Device option is selected, the Command category.
  - Value/Action: Clicking in this column pulls down a pop-up menu, allowing you to select the parameter of the channel to be controlled (typically, if the “VST Mixer” Device option is selected, you can choose between volume, pan, send levels, EQ, etc.). If the “Command” Device option is selected, this is where you specify the “Action” of the category.
  - Flags: Clicking in this column pulls down a pop-up menu, allowing you to activate or deactivate three flags: Push Button – When activated, the parameter is only changed if the received MIDI message shows a value unequal to 0. Toggle – When activated, the parameter value is switched between minimum and maximum value each time a MIDI message is received. The combination of Push Button and Toggle is useful for remote controls which do not latch the state of a button. One example is controlling mute status with a device on which pressing the Mute button turns it off, and releasing the Mute button turns it on. If Push Button and Toggle are activated, the Mute status will change between on and off whenever the button is pressed on the console. Not Automated – When activated, the parameter will not be automated.

If this does not give you the result you want, try using the “Prog. Change” value instead.

Remote controlling Cubase
8. If necessary, make settings for another bank. Note that you only need to make settings in the bottom table for this bank. The table at the top is already set up according to the MIDI remote device.

- If necessary, you can add banks by clicking the Add button below the Bank pop-up menu. Clicking the Rename button allows you to assign a new name to the currently selected bank, and you can remove an unneeded bank by selecting it and clicking the Delete button.

9. When you are finished, close the Device Setup window. Now, you can control the specified Cubase parameters from the MIDI remote device. To select another bank, use the pop-up menu in the Generic Remote window (or use a control on the MIDI remote device, if you have assigned one for this).

Importing and exporting remote setups

The Export button in the top right corner of the Generic Remote Setup window allows you to export the current setup, including the Control configuration (the table at the top) and all banks. The setup is saved as a file (with the file extension "*.xml"). Clicking the Import button allows you to import saved remote setup files.

- The last imported or exported remote setup will automatically be loaded when the program starts or the Generic Remote control is added in the Device Setup dialog.

Track Quick Controls

If you have an external remote control device, you can set it up to control up to eight parameters of each audio track, MIDI track or instrument track, using the Track Quick Controls feature in Cubase. How to set up your device and how to assign parameters to it is described in the chapter “Track Quick Controls” on page 337.

Apple Remote (Macintosh only)

Many Apple computers come with an Apple Remote Control, a small hand-held device akin to TV remote controls. It allows you to remotely control certain features in Cubase.

Proceed as follows:
1. Open the Device Setup dialog and select Apple Remote Control from the Add Device pop-up menu.
2. In the list on the right, the Apple Remote’s buttons are listed. For each button you can open a pop-up menu from which you can select a Cubase parameter. The parameter you select is assigned to the corresponding button on the Apple Remote.

By default, the Apple Remote always controls the application that currently has the focus on your Macintosh computer (provided that this application supports the Apple Remote).

- When the “Disable when application is not in front” option is not selected, the Apple Remote will control Cubase even if it does not have the focus.
MIDI realtime parameters and effects
Introduction

For each MIDI track, you can set up a number of track parameters, or modifiers, and MIDI effects. These affect how the MIDI data is played back, “transforming” MIDI events in realtime before they are sent to the MIDI outputs.

On the following pages, the available parameters and effects are described. Keep in mind:

• The actual MIDI events will not be affected – the changes happen “on the fly”.
• Since the modifier settings do not change the actual MIDI data on the track, they will not be reflected in the MIDI editors.

To convert the track settings into “real” MIDI events, use the Freeze MIDI Modifiers function or the Merge MIDI in Loop function (see “Making your settings permanent” on page 368).

The Inspector – general handling

The MIDI modifiers and effects are set up in the Inspector (although some settings are available in the Mixer as well).

• To show the Inspector, click the “Set up Window Layout” button on the toolbar and activate the Inspector option.

The Inspector is displayed to the left of the track list.

The Inspector sections

Basic track settings

The topmost Inspector section contains the basic track settings. These settings either affect the basic functionality for the track (mute, solo, enable record, etc.) or send out additional MIDI data to the connected devices (program change, volume, etc.). The section contains all settings that are available in the track list (see “The track list” on page 39), with a few additional parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track name field</td>
<td>Click once to show/hide the topmost Inspector section. Double-click to rename the track.</td>
</tr>
<tr>
<td>Edit button</td>
<td>This opens the Channel Settings window for the track (a window showing a channel strip with volume fader and other controls, along with effect settings – see “Using Channel Settings” on page 158).</td>
</tr>
<tr>
<td>Mute/Solo buttons</td>
<td>Mutes or solos the MIDI track.</td>
</tr>
<tr>
<td>Read/Write buttons</td>
<td>Used for automating the track settings – see “Enabling and disabling the writing of automation data” on page 228.</td>
</tr>
<tr>
<td>Open Device Panels button</td>
<td>Cubase only: If the MIDI track is routed to a device with a panel, clicking this button opens the respective panel. For more information, see the separate PDF document “MIDI Devices”.</td>
</tr>
<tr>
<td>Input transformer button</td>
<td>Opens the Input Transformer dialog, allowing you to transform incoming MIDI events in realtime, see “The Input Transformer” on page 450.</td>
</tr>
<tr>
<td>Record enable button</td>
<td>Activate this to make the track ready for recording.</td>
</tr>
</tbody>
</table>

• For MIDI tracks, several sections are available in the Inspector. Which of these are displayed is determined in the setup context menu or the Setup dialog of the Inspector. For information about setting up the Inspector, see “Using the Setup options” on page 534.

• You can fold or unfold the sections individually by clicking on the section name.

Clicking the name for a hidden section brings it to view and hides the other sections. [Ctrl]/[Command]-clicking the tab allows you to hide or show a section without affecting other sections. [Alt]/[Option]-clicking a tab shows or hides all sections in the Inspector.

Folding or hiding (via the Setup dialog) a section does not affect the functionality but merely hides the section from view. This means your settings will still be active even if you fold or hide the Inspector settings.
MIDI realtime parameters and effects

**Expression Map section (Cubase only)**

This section is used when working with the Expression Map features, see the chapter “Expression maps (Cubase only)” on page 419.

**Note Expression section (Cubase only)**

This section is used when working with the Note Expression features, see the chapter “Note Expression (Cubase only)” on page 428.

**MIDI Modifiers**

The settings on this tab affect the MIDI events on the track in realtime during playback. They will also be in effect if you play “live” with the track selected and record enabled (provided that “MIDI Thru Active” is activated in the Preferences dialog, MIDI page). This makes it possible, for example, to transpose or adjust the velocity of your live playing.

- If you want to compare the result of your modifier settings with the “unprocessed” MIDI, you can use the Bypass button in the MIDI Modifiers section. When this is activated, the MIDI Modifiers settings will be temporarily disabled. A bypassed section is indicated by a yellow Bypass button.

**Transpose**

This allows you to transpose all notes on the track in semitones. The available range is -127 to +127 semitones, but remember that the total range of MIDI note numbers is 0 to 127. Furthermore, not all instruments can play back notes over the whole range. Therefore, extreme transpositions can give rather strange and unwanted results.
• You can also transpose individual MIDI parts using the Transpose field in the info line. The transposition in the info line (for the individual part) is added to the transpose value you have set up for the whole track in the Inspector.

³ This setting is also affected by the global Transpose settings. For detailed information, see the chapter “The transpose functions” on page 131.

**Velocity Shift**

This setting lets you change the dynamics of all notes on the track. The value in this field is added to the velocity of each note message that is sent out (use negative values to lower the velocities). The range is -127 to +127 with 0 representing no change in velocity.

Note that the effect of changing the velocity depends on the sound and instrument.

³ You can also adjust the velocity of events in individual MIDI parts using the Velocity field in the info line. The velocity shift in the info line (for the individual part) is added to the velocity shift you have set up for the whole track in the Inspector.

**Velocity Compression**

This function multiplies the velocity values with the factor you specify. This factor is set using a numerator (left value) and a denominator (right value), resulting in a fractional number (1/2, 3/4, 3/2 etc.). For example, if you set the factor to 3/4, the velocities will be three quarters of their original values. This will also affect the difference in velocity between the notes, thus compressing or expanding the velocity scale. Typically, you would combine this setting with the Velocity Shift parameter.

An example:

Let’s say you have three notes with the velocity values 60, 90 and 120, and wish to “even out” the velocity differences somewhat. If you set the Velocity Compression value to 1/2, the notes will play back with the velocities 30, 45 and 60. By adding 60 in the Velocity Shift field, the notes will play back with the velocities 90, 105 and 120, meaning you have compressed the velocity range.

In a similar way, you can use Velocity Compression values greater than 1/1 together with negative values in the Velocity Shift field, to expand the velocity range.

³ Remember that the maximum velocity is always 127 no matter how much you try to expand.

**Length Compression**

This value adjusts the lengths of all notes on the track. As with Velocity Compression, the value is set with a numerator and denominator. For example, the value 2/1 means that all note lengths will be doubled, while 1/4 means all note lengths will be a quarter of the actual lengths.

**Random**

The Random settings let you introduce random variations to various properties of MIDI notes. Anything from very subtle variations to dramatic changes can be applied. There are two separate "random generators", set up in the following way:

1. Pull down the Random pop-up menu and select which note property is randomized.

The options are position, pitch, velocity and length.

³ Keep in mind that depending on the content of the track, certain parameter changes might not be immediately noticeable or have any effect at all (as would be the case if applying random length to a percussion track playing "one-shot" samples for example). To best audition the random changes, choose a track with clearly defined rhythm and note content (as opposed to a string pad).

2. Set the desired range of random deviation by entering values in the two number fields.

The two values govern the limits of the randomization, so that the values will vary between the left value and the right value (you cannot set the left value higher than the right value). The maximum random range for each property is listed in the table below:

<table>
<thead>
<tr>
<th>Property</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>-500 to +500 ticks</td>
</tr>
<tr>
<td>Pitch</td>
<td>-120 to +120 semitones</td>
</tr>
<tr>
<td>Velocity</td>
<td>-120 to +120</td>
</tr>
<tr>
<td>Length</td>
<td>-500 to +500 ticks</td>
</tr>
</tbody>
</table>

³ You can make independent settings for the two random generators.
• To deactivate the Random function, pull down the Random pop-up menu(s) and select “OFF”.

Range

The Range function lets you specify a note (pitch) or velocity range and either force all notes to fit within this range, or exclude all notes outside this range from playback. As with the Random function, there are two separate Range settings. Set them up as follows:

1. Pull down the Range pop-up menu and select one of the following four modes:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vel. Limit</td>
<td>This function affects all velocity values outside the specified range. Velocity values below the Min setting (the lower limit of the range) are set to the Min value, and velocity values above the Max setting are set to the Max value. Notes with velocity values within the set range are not affected. Use this if you want to force all velocity values to fit within a certain range.</td>
</tr>
<tr>
<td>Vel. Filter</td>
<td>Velocity Filter works by excluding all notes with velocity values outside the specified range. Notes with velocity values below the Min setting or above the Max setting will not be played back. Use this to “isolate” notes with certain velocity values.</td>
</tr>
<tr>
<td>Note Limit</td>
<td>This function allows you to specify a pitch range, and forces all notes to fit within this range. Notes outside the specified range are transposed up or down in octave steps until they fit within the range. Note: If the range is too “narrow”, so that some notes cannot be fit within the range by octave-transposing, these notes will get a pitch in the middle of the range. For example, if you have a note with a pitch of F3, and the range is C4-E4, that note will be transposed to D4.</td>
</tr>
<tr>
<td>Note Filter</td>
<td>Note Filter works by excluding all notes with pitches outside the specified range. Notes lower than the Min setting or higher than the Max setting will not be played back. Use this to “isolate” notes with certain pitches.</td>
</tr>
</tbody>
</table>

2. Use the two fields to the right to set the minimum and maximum values. These values will be shown as numbers (0–127) for the velocity modes and as note numbers (C-2 to G8) for the pitch modes.

Note that you can make independent settings for the two Range functions.

• To deactivate the Range function, pull down the Range pop-up menu(s) and select “OFF”.

MIDI Fader section

This contains a single channel strip, allowing you to set volume, pan, mute/solo and other parameters for the track, and a panel view of the active sends/inserts. This is a “mirror” of the track’s channel strip in the Cubase Mixer – see “MIDI channel strips” on page 166.

Notepad section

This is a standard notepad, allowing you to enter notes and comments about the track. Each track has its own notepad in the Inspector.

VST Instrument section

If the MIDI track is routed to a VST instrument, a new subpanel will appear at the bottom of the Inspector, labeled with the name of the VST instrument. Clicking this section shows a duplicate of the Inspector settings for the VST instrument channel. This makes it easy to adjust the channel settings for the VST instrument while you are editing the MIDI track.

• If the VST instrument has multiple outputs (and thus several Mixer channels), there will be a setting called “Output” at the top of the VST Instrument section.

New subpanels will also be added in the following cases:

• When a MIDI track is routed to an external instrument or effect that has an associated MIDI Device. In this case, the new subpanel will get the name of the device.

• When a MIDI track is routed to an effect plug-in that also receives audio data, i.e. that is used as an insert effect for an audio track (e.g. MIDI Gate), a subpanel for this audio track appears in the MIDI track inspector.

• If a MIDI track is routed to a plug-in assigned to a FX Channel track, a corresponding FX subpanel is added to the Inspector.

For an easy way to combine MIDI and VST instruments, check out instrument tracks (see “VST instruments and instrument tracks” on page 206).

User Panel section (Cubase only)

This allows you to display MIDI device panels, which are control panels for external hardware. This is described in the separate PDF document “MIDI Devices”.

352
MIDI realtime parameters and effects
Quick Controls section
This allows you to configure quick controls, e.g. to use remote devices. See the chapter "Track Quick Controls" on page 337 for details.

MIDI effects
Cubase comes with a number of MIDI effect plug-ins, capable of transforming the MIDI output from a track in various ways.

Just like the MIDI modifiers, MIDI effects are applied in realtime to the MIDI data played back from the track (or to MIDI you play live “thru” the track).

What are MIDI effects?
Although a MIDI effect can be similar to an audio effect, it is important to remember that you are not processing the sound resulting from MIDI playback, but the MIDI data (the “instructions” for how the music is played back).

A MIDI effect will change properties of the MIDI events (e.g. change the pitch of notes) and/or generate new MIDI events (for example, a MIDI delay may add new MIDI notes, “echoing” the original notes).

The included MIDI effect plug-ins are described in the separate PDF document “Plug-in Reference”.

Insert and send effects
As with audio effects, there are two ways to route the MIDI events on a track to an effect:

If you add an insert effect, the MIDI events will be sent to the effect, which will process the data and pass it on to the track’s MIDI output (or to another insert effect). In other words, the MIDI events will be routed “through” the insert effect.

If you use a send effect, the MIDI events will be sent both to the track’s MIDI output and to the effect. That is, you will get both the unprocessed MIDI events and the output of the MIDI effect. Note that the effect can send its processed MIDI data to any MIDI output – not necessarily to the one used by the track.

There are separate sections in the Inspector for MIDI inserts and MIDI sends.

MIDI Inserts section
This allows you to add up to four MIDI insert effects. The section contains the following items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inserts State indicator and Bypass button</td>
<td>The symbol on the right of the title bar is blue when an insert effect is activated. You can click the symbol to bypass all insert effects for the track.</td>
</tr>
<tr>
<td>Effect selection pop-up menu (x 4)</td>
<td>Selecting an effect from this pop-up menu automatically activates it and brings up its control panel (which can be a separate window or a number of settings below the insert slot in the Inspector). To remove an insert effect completely, select “No Effect”.</td>
</tr>
<tr>
<td>On button (x 4)</td>
<td>Allows you to turn the selected effect on or off.</td>
</tr>
<tr>
<td>Edit button (x4)</td>
<td>Click this to bring up the control panel for the selected effect. Depending on the effect, this may appear in a separate window or below the insert slot in the Inspector. Clicking the button again hides the control panel.</td>
</tr>
</tbody>
</table>

Effects that display their controls in the Inspector can be opened in a separate control panel window by pressing [Alt]/[Option] and clicking the Edit button.
This allows you to add up to four MIDI send effects. Unlike audio send effects, you can select and activate send effects individually for each track. The section contains the following items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sends State indicator and Bypass button</td>
<td>The symbol on the right of the title bar is blue when a send effect is activated. You can click the symbol to bypass all send effects for the track.</td>
</tr>
<tr>
<td>Effect selection pop-up menu (x 4)</td>
<td>Selecting an effect from this pop-up menu automatically activates it and brings up its control panel (which can be a separate window or a number of settings below the send slot in the Inspector). To remove a send effect completely, select “No Effect”.</td>
</tr>
<tr>
<td>On button (x 4)</td>
<td>Allows you to turn the selected effect on or off.</td>
</tr>
<tr>
<td>Pre/Post button (x 4)</td>
<td>If this is activated, the MIDI signals will be sent to the send effects before the MIDI modifiers and insert effects.</td>
</tr>
<tr>
<td>Edit button (x 4)</td>
<td>Click this to bring up the control panel for the selected effect. Depending on the effect, this may appear in a separate window or below the sends slot in the Inspector. Clicking the button again hides the control panel.</td>
</tr>
<tr>
<td>Output pop-up menu (x 4)</td>
<td>This determines to which MIDI output the effect will send the processed MIDI events.</td>
</tr>
<tr>
<td>Channel setting (x 4)</td>
<td>This determines on which MIDI channel the effect will send the processed MIDI events.</td>
</tr>
</tbody>
</table>

Effects that display their controls in the Inspector can be opened in a separate control panel window by pressing [Alt]/[Option] and clicking the Edit button.

About presets
Several of the MIDI plug-ins come with a number of presets for instant use.

- To load a preset, select it from the Presets pop-up menu.
- To store your current settings as a preset, click on the “+” button (“Save Preset...”) to the right of the Presets menu. You will be asked to specify a name for the preset. The saved preset will then be available for selection from the pop-up menu for all instances of that MIDI plug-in, in all projects.
- To remove a preset, select it and click on the “−” button (“Remove Preset”).

At the left and right borders of the Presets pop-up menu you will also find MIDI In and Out activity indicators. Whenever the plug-in receives or transmits MIDI data, the left or the right indicator will light up, respectively.

Applying a MIDI insert effect – an example
Here is a step-by-step example of how to add a MIDI insert effect to a MIDI track:

1. Select the MIDI track and open the Inspector.
2. Open the MIDI Inserts tab in the Inspector.
3. Alternatively you can use the Mixer: bring up the extended Mixer panel and select “Inserts” on the view options pop-up menu for the track’s channel strip.
3. Click in one of the insert slots to open the MIDI effect pop-up menu.

4. Select the desired MIDI effect from the pop-up menu. The effect is automatically activated (the power button for the insert slot lights up) and its control panel appears, either in a separate window or in the MIDI Inserts section below the slot (depending on the effect).

Now all MIDI from the track will be routed through the effect.

5. Use the control panel to make settings for the effect. All included MIDI effects are described in the separate PDF document “Plug-in Reference”.
   - You can bypass the insert effect by clicking its power button (above the insert slot).
   - To bypass all insert effects for the MIDI track, use the bypass button in the MIDI Inserts section in the Inspector, in the Mixer channel strip or in the track list.
   - To remove an insert effect, click in its slot and select “No Effect”.

Managing plug-ins

Selecting Plug-in Information from the Devices menu opens a window in which all loaded plug-ins, audio and MIDI, are listed.
   - To view the MIDI effect plug-ins, click the MIDI Plug-ins tab.

   - The leftmost column allows you to deactivate plug-ins. This is useful if you have plug-ins installed that you do not want to use in Cubase. Only plug-ins that are activated (ticked checkbox) will appear on the MIDI effect pop-up menus.
   - The second column shows how many instances of each plug-in are currently used in the project.
   - The remaining columns show various information about each plug-in and cannot be edited.
Using MIDI devices
Background

The MIDI Device Manager allows you to specify and set up your MIDI devices, making global control and patch selection easy.

But the MIDI Device Manager also features powerful editing functions that can be used to create MIDI device panels (Cubase only). MIDI device panels are internal representations of external MIDI hardware, complete with graphics. The MIDI device panel editor provides all the tools you need to create device maps where every parameter of an external device (and even an internal device like a VST instrument) can be controlled and automated from inside Cubase.

For descriptions of how to create device maps and the powerful device panel editing features, see “About Device panels (Cubase only)” on page 362. For additional information on how to create panels for VST instruments, see the separate PDF document “MIDI Devices”.

MIDI devices – general settings and patch handling

On the following pages, we will describe how to install and set up preset MIDI devices, and how to select patches by name from within Cubase. For a description on how to create a MIDI device from scratch, please refer to the separate PDF document “MIDI Devices”.

About Program Change and Bank Select

To instruct a MIDI instrument to select a certain patch (sound), you send a MIDI Program Change message to the instrument. Program Change messages can be recorded or entered in a MIDI part like other events, but you can also enter a value in the Program Selector field in the Inspector for a MIDI track. This way, you can quickly set each MIDI track to play a different sound.

With Program Change messages, you are able to select between 128 different patches in your MIDI device. However, many MIDI instruments contain a larger number of patch locations. To make these available from within Cubase, you need to use Bank Select messages, a system in which the programs in a MIDI instrument are divided into banks, each bank containing 128 programs. If your instruments support MIDI Bank Select, you can use the Bank Selector field in the Inspector to select a bank, and then the Program Selector field to select a program in this bank.

Unfortunately, different instrument manufacturers use different schemes for how Bank Select messages are constructed, which can lead to some confusion and make it hard to select the correct sound. Also, selecting patches by numbers this way seems unnecessarily cumbersome, when most instruments use names for their patches nowadays.

To help with this, you can use the MIDI Device Manager to specify which MIDI instruments you have connected by selecting from a vast list of existing devices or by specifying the details yourself. Once you have specified which MIDI devices you are using, you can select to which particular device each MIDI track is routed. It is then possible to select patches by name in the track list or Inspector.

Opening the MIDI Device Manager

Select MIDI Device Manager from the Devices menu to bring up the following window:
Using MIDI devices

Cubase Artist:

When you open the MIDI Device Manager for the first time, it will be empty (because you have not installed any devices yet). On the following pages we describe how to add a pre-configured MIDI device to the list, how to edit the settings and how to define a device from scratch.

Note that there is an important difference between installing a preset MIDI device (“Install Device”) and importing a MIDI device setup (“Import Setup”):

- The presets do not include any device mapping of parameters and controls and no graphic panels. They are simply patch name scripts. When you install a preset MIDI device, it is added to the Installed Devices list. For more information about patch name scripts, see the separate PDF document “MIDI Devices”.
- A device setup can include device mapping, panels and/or patch information.

Device setups are also added to the list of installed devices when imported. For more information about setups and device panels, see “About Device panels (Cubase only)” on page 362.

Defining a new MIDI device

If your MIDI device is not included in the list of pre-configured devices (and is not a “plain” GM or XG device), you need to define it manually to make it possible to select patches by name. This is handled slightly differently for Cubase and Cubase Artist.

Cubase:

1. In the MIDI Device Manager, click the Install Device button. The Add MIDI Device dialog opens.
2. Select “Define New…” and click OK. The “Create New MIDI Device” dialog opens. For a description of the options in this dialog, see the separate PDF document “MIDI Devices”.
3. In the Identical Channels list, activate the MIDI channels you would like the device to use. This means that the device will receive Program Change over any MIDI channel. For a description of Identical and Individual Channels, see the separate PDF document “MIDI Devices”.
4. Enter a name for the device at the top of the dialog, and click OK. The device appears in the Installed Devices list, and the device node structure for the device is automatically shown in a new window.
5. Select Patch Banks from the pop-up menu at the top of the window.
As you can see, the list is currently empty.
6. Make sure that the Enable Edit checkbox is activated. Now you can use the functions on the Commands pop-up menu on the left to organize the patch structure of the new device.

Cubase Artist:

1. In the MIDI Device Manager, click the Install Device button. The Add MIDI Device dialog appears.
2. Select “Define New…” and click OK. A dialog appears.
3. Enter the name of the device and the MIDI channels you would like the device to use and click OK. The device appears in the Installed Devices list.
4. Select the device in the list. As you can see, it currently contains only an Empty Bank item.
5. Make sure that the Enable Edit checkbox is activated. Now you can use the functions on the Commands pop-up menu on the left to organize the patch structure of the new device.

This pop-up menu lets you edit the selected device (provided that “Enable Edit” is ticked).

Here, the patch structure for the selected device is shown.

This area shows exactly which MIDI messages are sent out to select the patch highlighted in the list to the left.

Here you specify to which MIDI output the selected device is connected.

This list of connected MIDI devices. The first time you open the MIDI Device Manager, this list will be empty.

Use these buttons to install/remove devices.

358

Using MIDI devices
Installing a preset MIDI device

To install a preset MIDI device, proceed as follows:

1. Click the Install Device button. A dialog opens listing all pre-configured MIDI devices. For now we assume that your MIDI device is included in this list.

2. Locate and select the device in the list and click OK.
   - If your MIDI device is not included in the list but is compatible with the GM (General MIDI) or XG standards, you can select the generic GM or XG Device options at the top of the list. When you select one of these options, a name dialog will appear. Enter a name for the instrument and click OK.

The device now appears in the Installed Devices list to the left.

3. Make sure that the new device is selected in the list and open the Output pop-up menu.

4. Select the MIDI output that the device is connected to.

5. If you are using Cubase, click the Open Device button. A separate window opens for the selected device, showing a node structure in the left half of the window. At the top of this structure is the device itself, and below it the MIDI channels used by the device. For more information about the Device window, see the separate PDF document “MIDI Devices”.

6. Select Patch Banks from the pop-up menu at the top of the window.

   The Patch Banks list in the left half of the window shows the patch structure of the device. This could simply be a list of patches, but it is usually one or several layers of banks or groups containing the patches (much like a folder structure on a hard disk for example).

   - You can rename a device in the Installed Devices list by double-clicking and typing – this is useful if you have several devices of the same model, and want to separate them by name instead of by number.

   - To remove a device from the Installed Devices list, select it and click Remove Device.

   - Note that if there already exists a panel for the device (Cubase only), opening the device might open this panel first. In this case, click on the Edit (“e”) button to open the Device window.

About Patch Banks

Depending on the selected device, you may find that the Patch Banks list is divided in two or more main banks. Typically, these are called Patches, Performances, Drums, etc. The reason for having several patch banks is that different “types” of patches are handled differently in the instruments. For example, while “patches” typically are “regular” programs that you play one at the time, “performances” may be combinations of programs, which could be split across the keyboard, layered, or used for multi-timbral playback, and so on.

For devices with several banks, you will find an additional item labeled “Bank Assignment” in the pop-up menu at the top of the window. Selecting this opens a window in which you can specify for each MIDI channel which bank it should use.

   The selection here will affect which bank is displayed when you select programs by name for the device in the track list or Inspector. For example, many instruments use MIDI channel 10 as an exclusive drum channel, in which case you would want to select the “Drums” (or “Rhythm Set”, “Percussion”, etc.) bank for channel 10 in this list. This would then let you choose between different drum kits in the track list or Inspector.
Limitations

There is no easy way to import a patch name script into an existing MIDI device. For a complex workaround based on XML editing, see the separate PDF document “MIDI Devices”.

Selecting a patch for an installed device

If you return to the Project window at this point, you will find that the installed device has been added to the MIDI Output menus (in the track list and the Inspector). Now you can select patches by name, in the following way:

1. Pull down the Output menu (in the track list or Inspector) for the track you want to associate the installed device with, and select the device. This directs the track to the MIDI output specified for the device in the MIDI Device Manager. The Bank and Program Selector fields in the track list and Inspector are replaced by a single Program Selector field that currently reads “Off”.

2. Click the Program Selector field to display a pop-up menu, hierarchically listing all the patches in the device. The list is similar to the one displayed in the MIDI Device Manager. You can scroll the list up and down (if required), click the plus/minus signs to show or hide subgroups, etc.

3. Click a patch in the list to select it. This sends the appropriate MIDI message to the device. You can also scroll the program selection up or down, as with any value.

You can also use a filter function here. For this, enter the search term in the Filter field, e.g. “drum”, and press [Return] to display all sounds with “drum” in the name.

Renaming patches in a device

The pre-configured devices list is based on the factory-preset patches, i.e. the patches included in the device when you first bought it. If you have replaced some of the factory presets with your own patches, you need to modify the device so that the patch name list matches the actual device:

1. In the MIDI Device Manager, select the device in the Installed Devices list.

2. If you are using Cubase, click Open Device. Make sure that Patch Banks is selected on the pop-up menu at the top of the window.

3. Activate the Enable Edit checkbox. When this is turned off (default), you cannot edit the pre-configured devices.

4. Use the Patch Banks display to locate and select the patch you want to rename. In many instruments, the user-editable patches are located in a separate group or bank.

5. Click on the selected patch in the Patch Banks list to edit its name.

6. Type in the new name and click OK.

7. Rename the desired patches in this way, and finish by deactivating Enable Edit again (to avoid modifying the device by accident).

You can also make more radical changes to the patch structure in a device (adding or deleting patches, groups or banks), see below. For example, this is useful if you expand your MIDI device by adding extra storage media such as RAM cards.

Patch Structure

Patches are structured as follows:

- Banks are the main categories of sounds – typically patches, performances and drums, as described above.
- Each bank can contain any number of groups, represented by folders in the list.
- The individual patches, performances or drum kits are represented by presets in the list.
The Commands pop-up menu contains the following items:

**Create Bank**

Creates a new bank at the highest hierarchical level of the Patch Banks list. You can rename this by clicking on it and typing a new name.

**New Folder**

 Creates a new subfolder in the selected bank or folder. This could correspond to a group of patches in the MIDI device, or just be a way for you to categorize sounds, etc. When you select this item, a name dialog opens, allowing you to name the folder. You can also rename the folder afterwards by clicking it and typing in the list.

**New Preset**

This adds a new preset in the selected bank or folder. You can rename the preset by clicking it and typing a new name.

When the preset is selected, the corresponding MIDI events (Program Change, Bank Select, etc.) are shown in the event display to the right. The default setting for a new preset is Program Change 0 – to change this, proceed as follows:

- To change which Program Change value is sent out to select the patch, adjust the number in the Value column for the Program Change event.
- To add another MIDI event (e.g. Bank Select) click directly below the last event in the list and select a new event from the pop-up menu.
- After adding a new event, you need to set its value in the Value column, as with Program Change.
- To replace an event, click on it and select another event from the pop-up menu.
- For example, a MIDI device may require that a Bank Select message is sent first, followed by a Program Change message, in which case you would need to replace the default Program Change message with a Bank Select message and add a new Program Change after that.

- To remove an event, select it and press [Delete] or [Backspace].

⚠️ Different devices use different schemes for Bank Select. When you insert a Bank Select event, you should check the device's documentation to find out whether to choose "CC: BankSelect MSB", "Bank Select 14 Bit", "Bank Select 14 Bit MSB-LSB Swapped" or some other option.

**Add Multiple Presets**

This opens a dialog, allowing you to set up a range of presets to be added to the selected bank or folder.

Proceed as follows:

1. Add the event types required for selecting a patch in the MIDI device. This is done just as when editing the settings for a single event: clicking in the event display brings up a pop-up menu from which you can select an event type.

2. Use the Range column to set up either a fixed value or a range of values for each event type in the list. This requires some explanation:
   - If you specify a single value in the Range column (e.g. 3, 15 or 127), all added presets will have an event of this type set to the same value.
   - If you instead specify a value range (a start value and an end value, separated by a dash, e.g. 0–63), the first added preset will have an event set to the start value, the next value will be incrementally raised by one and so on, up to and including the end value.

   ! The number of added presets depends on the Range setting.
3. Specify a Default Name below the event display. The added events will get this name, followed by a number. You can rename presets manually in the Patch Banks list later.

4. Click OK.
A number of new presets have now been added to the selected bank or folder, according to your settings.

Other editing functions
- You can move presets between banks and folders by dragging them to the Patch Banks list.
- You can remove a bank, folder or preset by selecting it in the Patch Banks list and pressing [Backspace].
- If you specify more than one bank, a Bank Assignment item is added to the pop-up menu at the top of the window. Use this to assign banks to the different MIDI channels (see "About Patch Banks" on page 359).

About Device panels (Cubase only)
On the following pages we will describe how to use MIDI Device panels and the powerful MIDI device panel editing features of the MIDI Device Manager.

We recommend that you first configure the patch banks, then export the device setup before editing the panels. This way, most of your settings will be saved in case of panel configuration problems.

The panels are saved in XML format. For more information, see the separate PDF document "MIDI Devices".

Basic concept
The panel editing features in the MIDI Device Manager can be seen as a separate application or entity within Cubase. It allows you to build device maps complete with control panels, including all parameters controllable from within Cubase. Building more complex device maps requires that you are familiar with SysEx programming (see the separate PDF document "MIDI Devices"). But you can also create simpler panels by assigning MIDI Control Change messages to control objects, which does not require any programming skills.

Although these powerful editing features are there if you need them, you do not have to use them to use MIDI devices.

Device panels in the program
In this section we will take a look at a pre-configured MIDI device panel to illustrate how it can be used in Cubase. Several device maps can be found in the Knowledge Base on the Steinberg web site (http://knowledgebase.steinberg.net). You can select one or several devices for import. A device setup file can contain one or several MIDI devices.

Opening a device setup
Proceed as follows to open a MIDI device setup:
1. Open the MIDI Device Manager from the Devices menu.
2. Click the “Import Setup” button.
A file dialog opens.
3. Select a device setup file for import by navigating to the Device Maps folder (see above).
The Device setup files are saved in XML format, for more information see the separate PDF document “MIDI Devices”.
4. Click Open. The Import MIDI Devices dialog opens where you can select one or several devices for import. A device setup file can contain one or several MIDI devices.
5. Select a device and click OK.
The device is added to the list of installed devices in the MIDI Device Manager.
6. Select the correct MIDI output from the Output pop-up menu, select the device in the list and click the Open Device button.
   The device control panel opens in a separate window. The Edit ("e") button at the top opens the Edit Panel window, see the separate PDF document “MIDI Devices”.

7. Close the Device panel and return to the Project window.

8. Select the device from the “Output Routing” pop-up menu for a MIDI track.
   Note that for some devices, you may have to set the MIDI channel to “Any”.

   Now the Device panel can be opened by clicking the Open Device Panels button in the Inspector or in the channel strip for the corresponding track in the Mixer.

   ➤ Note that [Ctrl]/[Command]-clicking the Open Device Panels button allows you to open a subpanel via the panel browser pop-up menu.

Showing panels in the Inspector
1. In the Inspector, open the User Panel tab and click on the arrow on the right.
   A “Panels” folder is shown with the selected device in a node structure below it. If you open all the folders, you can select any individual panel from the device that “fits” into the User Panel space.

2. Select a panel by double-clicking it in the list.
   The panel opens in the Inspector.

   ➤ If you cannot see any panels in the “Panels” folder, although you have successfully set up a MIDI device with several panels, make sure that you selected the correct channel from the Channel pop-up menu, preferably “Any” to see all device panels. Also make sure that the panels fit into the space, otherwise they will not be available in the “Panels” folder.
Showing panels in the Mixer

1. Open the Mixer and make sure that the extended channel view is shown.
2. Open the View options pop-up menu for the MIDI channel connected to the device and select "User Panel".
3. Click the arrow next to the label "user" at the top of the extended section of the channel strip.
   The Panels folder is displayed like in the Inspector, but with different available panels. Just like in the Inspector, the panel has to "fit" into the available space to be selectable.
4. Double-click to select a panel.
   The panel is shown in the extended section of the channel strip.

Automating device parameters

Automation works just like for normal audio and MIDI tracks:
1. Open the device control panel by clicking the Open Device Panels button in the Inspector.
2. Activate Write automation on the device panel.
   You can automate the device by either moving knobs and sliders on the control panel or by drawing curves on the automation track for a selected parameter.
3. If you now go back to the Project window, there will be a MIDI Device Automation track in the track list.
   If the track is hidden, select "Show All Used Automation" on the Track Folding submenu of the Project menu.

   If you click in the name field, all parameters in the device are shown and can be selected for automation.

   To open another automation track for the next parameter on the pop-up menu, click the + button ("Append automation track") at the bottom left of the automation track.
   ⚠ If you wrote automation but your MIDI device is not yet connected, the panel will not display any parameter changes when playing back the track with the Read button activated.

About Studio Connections

Studio Connections is the name of an initiative led by Steinberg and Yamaha. The initiative intends to create industry standards for totally integrated system environments using software and hardware products.

First implementation stage of the Studio Connections open standard is the integration and support of Yamaha's Studio Manager 2 (SM2) and Total Recall for compatible hardware devices.

For further information about Studio Connections, please visit the web site http://www.studioconnections.org.
If you have an SM2 component installed, there is an additional menu item on the Devices menu.

Total Recall
Total Recall means that you can save and recall all settings of your hardware and software products by opening one integrated file in a DAW such as Cubase or Nuendo. Also you will have instant and organized access to hardware editors.

When you load a project or switch to another active project that contains SM2 data, the Total Recall Synchronization dialog opens:

This dialog can also be opened any time from the Studio Manager’s Synchronize menu. Click OK for the Dump to start.

Virtual MIDI Devices
If you have a new OPT component (e.g. the DM2000) which uses a new special interface, you can access these components as virtual MIDI Devices in the MIDI track’s output routing (if the output of the OPT is configured).

When a MIDI track is routed to such a device, the “Open Device Panels” button becomes available.

• Click the Open Device Panels button, to open the editor window for the device.

Please also refer to the separate documentation for the Studio Manager 2 and the OPT components.
MIDI processing
Introduction

This chapter describes the various MIDI processing functions available on the MIDI menu. They offer various ways to edit MIDI notes and other events, either in the Project window or from within a MIDI editor.

MIDI functions vs. MIDI modifiers

In some cases, the result of a MIDI function can also be obtained by using MIDI modifiers and effects, see “MIDI realtime parameters and effects” on page 348). For example, the operations “Transpose” and “Quantize” are available both as MIDI modifiers and as MIDI functions.

The main difference is that MIDI modifiers and effects do not affect the actual MIDI events on the track in any way, while MIDI functions change the events “permanently” (although recent changes can be undone).

Use the following guidelines to decide which path to choose for operations that are available both as modifiers or effects and as functions:

- If you want to adjust a few parts or events only, use MIDI functions. The MIDI modifiers and effects affect the output of the whole track (although they can be made permanent in a specific area with the Merge MIDI in Loop function).
- If you want to experiment with different settings, use MIDI modifiers and effects.
- MIDI modifiers and effects settings are not reflected in the MIDI editors, since the actual MIDI events are not affected. This can be potentially confusing; if you have transposed notes using modifiers for example, the MIDI editors will still show the notes with their original pitch (but they will play back at their transposed pitch). Therefore, MIDI functions are a better solution if you want to see the effects of your editing in the MIDI editors.

What is affected by the MIDI functions?

Which events are affected when you use a MIDI function depends on the function, the active window and the current selection:

- Some MIDI functions only apply to MIDI events of a certain type.
  For example, quantization only affects notes, while the Delete Controllers function only applies to MIDI controller events.
- In the Project window, the MIDI functions apply to all selected parts, affecting all events (of the relevant types) in them.
- In the MIDI editors, the MIDI functions apply to all selected events. If no events are selected, all events in the edited part(s) will be affected.

Transpose

The Transpose item on the MIDI menu opens a dialog with settings for transposing the selected notes.

Semitones

This is where you set the amount of transposition.

Scale Correction

Scale Correction transposes the selected notes by forcing them to the closest note of the selected scale type. This can be used for creating interesting key and tonal changes, either by itself or in conjunction with the other settings in the Transpose dialog.

- To activate Scale Correction, click the checkbox.
- Select a root note and scale type for the current scale from the upper pop-up menus.
- Select a root note and scale type for the new scale from the lower pop-up menus.

Make sure to select the correct root note if you want to keep the result in the same key as the original notes, or select an entirely different key if you want to experiment.
Use Range
When this is activated, transposed notes will remain within the limit that you specify with the Low and High values. If a note would end up outside this limit after transposition, it is shifted to another octave, keeping the correct transposed pitch if possible. If the range between the upper and lower limit is very narrow, the note will be transposed “as far as possible”, i.e. to notes specified with the Low and High values. If you set Low and High to the same value, all notes will be transposed to this pitch!

OK and Cancel
Clicking OK performs the transposition. Clicking Cancel closes the dialog without transposing.

Making your settings permanent
The settings described in the chapter “MIDI realtime parameters and effects” on page 348 do not change the MIDI events themselves, but work like a “filter”, affecting the music on playback. Therefore, you may want to make them permanent, i.e. convert them to “real” MIDI events, for example to transpose a track and then edit the transposed notes in a MIDI editor. For this, you can use two commands from the MIDI menu: “Freeze MIDI Modifiers” and “Merge MIDI in Loop”.

Freeze MIDI Modifiers
“Freeze MIDI Modifiers” applies all filter settings permanently to the selected track. The settings are “added” to the events on the track, and all modifiers are set to zero. The “Freeze MIDI Modifiers” function affects the following settings for MIDI tracks:

- Several settings on the main tab of the Inspector (program and bank selection and the Delay parameter).
- The settings on the MIDI Modifiers tab (i.e. Transpose, Velocity Shift, Velocity Compression, and Length Compression).
- The settings on the MIDI Inserts tab (for example, if you are using an arpeggiator and want to convert the added notes to real events).

The following settings for MIDI parts are taken into account as well:

- The Transpose and Velocity settings for parts displayed on the info line – the Volume setting is not taken into account.

Merge MIDI in Loop
The “Merge MIDI in Loop” function combines all unmuted MIDI events on all unmuted tracks, applies MIDI modifiers and effects, and generates a new MIDI part, containing all the events as you would hear them during playback. Proceed as follows:

1. Mute all the tracks that you do not want to include in the merge. Instead of muting whole tracks, you can also mute individual parts.
2. Set up the left and right locators to encompass the area that you want to merge. Only events starting within this area will be included.
3. Select the track on which you want the new part to be created. If you do not select a track, a new MIDI track is created. If several MIDI tracks are selected, the new part is inserted on the first selected track. Existing data on the selected track can be kept or overwritten (see below).
4. On the MIDI menu, select “Merge MIDI in Loop…”. The MIDI Merge Options dialog opens.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Inserts</td>
<td>If this is activated, any MIDI insert effects and MIDI modifiers currently activated for the tracks will be applied.</td>
</tr>
<tr>
<td>Include Sends</td>
<td>If this is activated, any MIDI send effects currently activated for the track(s) will be applied.</td>
</tr>
<tr>
<td>Erase Destination</td>
<td>If this is activated, any existing MIDI data between the left and right locators on the destination track will be deleted.</td>
</tr>
<tr>
<td>Include Chase</td>
<td>If this is activated, events placed outside the selected part but relating to it will be included in the processing, e.g. a Program Change right before the left locator. For details about chase events, see “About Chase” on page 87.</td>
</tr>
<tr>
<td>Convert VST3 (Cubase only)</td>
<td>If this is activated, all VST 3 data within the selected area is converted to MIDI data.</td>
</tr>
</tbody>
</table>

5. Activate the desired options and click OK. A new part is created between the locators on the destination track, containing the processed MIDI events.

If you only want to include events from a single track in the merge operation, you may want to solo the track.
Applying effects to a single part

Normally, the MIDI modifiers and effects affect a whole MIDI track. This may not always be what you want. For example, you may want to apply some MIDI effects to a single part (without having to create a separate track for that part only). The “Merge MIDI in Loop” function can help:

1. Set up your MIDI modifiers and MIDI effects the way you want them for the part. This will of course affect the whole track, but focus on the part for now.
2. Set the locators to encompass the part. An easy way to do this is to select the part and choose Locators to Selection from the Transport menu (or use the corresponding key command, by default [P]).
3. Make sure that the track holding the part is selected in the track list.
4. On the MIDI menu, select “Merge MIDI in Loop…” The MIDI Merge Options dialog opens.
5. Activate the desired options, making sure that “Erase Destination” is activated, and click OK. A new part is created on the same track, containing the processed events. The original part is deleted.
6. Turn off or reset all MIDI modifiers and effects, so that the track plays back as before.

Dissolving parts into separate channels

Setting a track to MIDI channel “Any” will cause each MIDI event to play back on its original MIDI channel, rather than a channel set for the whole track. There are two main situations when “Any” channel tracks are useful:

- When you record several MIDI channels at the same time.
  You may for example have a MIDI keyboard with several keyboard zones, where each zone sends MIDI on a separate channel. Recording on an “Any” channel track allows you to play back the recording with different sounds for each zone (since the different MIDI notes play back on separate MIDI channels).
- When you have imported a MIDI file of Type 0.
  MIDI files of Type 0 contain only one track, with notes on up to 16 different MIDI channels. If you were to set this track to a specific MIDI channel, all notes in the MIDI file would be played back with the same sound; setting the track to “Any” will cause the imported file to play back as intended.

The Dissolve Part function scans MIDI parts for events on different MIDI channels and distributes the events into new parts on new tracks, one for each MIDI channel found. This allows you to work with each musical part individually. Proceed as follows:

1. Select the parts containing MIDI data on different channels.
2. Select “Dissolve Part” from the MIDI menu.
3. In the dialog that opens, select the “Separate Channels” option.

Now, for each MIDI channel used in the selected parts, a new MIDI track is created and set to the corresponding MIDI channel. Each event is then copied into the part on the track with the corresponding MIDI channel. Finally, the original parts are muted.

Dissolve Part

The Dissolve Part function on the MIDI menu allows you to separate MIDI events according to channels or pitches:

- When you work with MIDI parts (on MIDI channel “Any”) containing events on different MIDI channels, activate the “Separate Channels” option.
- To separate MIDI events according to pitch, activate the “Separate Pitches” option.

Typical examples are drum and percussion tracks, where different pitches usually correspond to separate drum sounds.

⚠️ When dissolving a part into either separate channels or separate pitches, you can automatically remove the silent (empty) areas of the resulting parts by activating the “Optimized Display” checkbox in the Dissolve Part dialog. This option is not available when “Dissolve to Lanes” is activated, see “Dissolving to lanes” on page 370.
An example:

![Image of MIDI part]

This part contains events on MIDI channels 1, 2, and 3.

Selecting "Dissolve Part" creates new parts on new tracks, set to channels 1, 2, and 3. Each new part contains only the events on the respective MIDI channel. The original MIDI part is muted.

Dissolving parts into separate pitches

The Dissolve Part function can also scan MIDI parts for events of different pitches, and distribute the events into new parts on new tracks, one for each pitch. This is useful when the different pitches are not used in a melodic context, but rather for separating different sounds (e.g. MIDI drum tracks or sampler sound FX tracks). By dissolving such parts, you can work with each sound individually, on a separate track.

Proceed as follows:

1. Select the parts containing MIDI data.
2. Select "Dissolve Part" from the MIDI menu.
3. In the dialog that opens, select the "Separate Pitches" option.

A new MIDI track is created for each used pitch in the selected parts. The events are then copied into the parts on the track for the corresponding pitch. Finally, the original parts are muted.

Dissolving to lanes

In the lower right section of the Dissolve Part dialog, you will find the "Dissolve to Lanes" option. When this is activated, the part will not be dissolved onto different tracks but onto different lanes of the original track, allowing for a better management of MIDI material that “belongs together”.

This is useful when working with drums for example, as it allows you to split up a part into different drum sounds and edit these independently. When you have made the desired modifications, you can reassemble all your drums into one part using the Bounce MIDI command, see below.

This option is especially handy when working with instrument parts on instrument tracks. “Normal” dissolving would lead to a number of different tracks each routed to a separate instance of the connected VST instrument. When dissolving parts to lanes, the parts will still reside on the same track, with all parts using the same VST instrument instance.

Bounce MIDI

With this function, you can combine MIDI parts on several lanes to a single MIDI part. This can be used to reassemble a drum part that you dissolved onto several lanes for editing, see above. Simply select the MIDI parts on the different lanes that you want to combine and select "Bounce MIDI" on the MIDI menu.

During the bounce process, any muted parts will be removed. If transpose and velocity values were specified for the parts, these are taken into account as well.

Repeat Loop

With this function, the events inside the independent track loops will be repeated until the end of the part, i.e. the notes that were previously only played repeatedly are now actual notes on the MIDI track. Events to the right of the independent track loop (within the same part) will be replaced by this function. For more information about independent track loops, see “The independent track loop” on page 381.
Other MIDI functions

The following items can be found on the Functions submenu of the MIDI menu:

Legato

Extends each selected note so that it reaches the next note.

You can specify a gap or overlap for this function with the “Legato Overlap” setting in the Preferences dialog (Editing–MIDI page).

When using Legato with this setting, each note will be extended to end 5 ticks before the next note.

When you activate “Legato Mode: Between Selected Notes Only”, the length of the note will be adjusted so that it reaches the next selected note, allowing you to apply Legato only to your bass line, for example.

You can also apply a legato using the “Scale Length/Legato” slider in the MIDI editors, see “The Length section” on page 379.

Fixed Lengths

⚠️ This function is only available from within the MIDI editors.

This function resizes all selected notes to the length set with the Length Quantize pop-up menu on the MIDI editor toolbar.

Delete Doubles

This function removes double notes, i.e. notes of the same pitch on the exact same position from the selected MIDI parts. Double notes can occur when recording in Cycle mode, after Quantizing, etc.

Delete Controllers

This function removes all MIDI controllers from the selected MIDI parts.

Delete Continuous Controllers

This function removes all “continuous” MIDI controller events from the selected MIDI parts. Therefore, “on/off” events such as sustain pedal events are not removed.

Delete Notes

Allows you to delete very short or weak notes. This is useful for automatically removing unwanted “ghost notes” after recording. Selecting “Delete Notes…” opens a dialog in which you set up the criteria for the function.

The parameters have the following functionality:

Minimum Length

When the Minimum Length checkbox is activated, the note length is taken into account, allowing you to remove short notes. You can either specify the minimum length (for notes to be kept) in the value field or by dragging the blue line in the graphical length display below.
The graphical length display can correspond to 1/4 bar, one bar, two bars or four bars. You change this setting by clicking in the field to the right of the display.

In this case, the whole length display corresponds to two bars, and the Minimum Length is set to 32nd notes (60 ticks).

**Minimum Velocity**
When the Minimum Velocity checkbox is activated, the velocity of notes is taken into account, allowing you to remove weak notes. You specify the minimum velocity (for notes to be kept) in the value display.

**Remove when under**
This setting is only available when both Minimum Length and Minimum Velocity is activated. By clicking in this field, you select whether both the length and the velocity criteria must be met for notes to be deleted, or whether one of the criteria will suffice.

**OK and Cancel**
Clicking OK performs the automatic delete according to the rules set up. Clicking Cancel closes the dialog without deleting notes.

**Restrict Polyphony**
Selecting this item opens a dialog in which you can specify how many “voices” are used (for the selected notes or parts). Restricting the polyphony this way is useful when you have an instrument with limited polyphony and want to make sure all notes will be played. The effect is achieved by shortening notes as required, so that they end before the next note starts.

**Pedals to Note Length**
This function scans for Sustain pedal on/off events, lengthens the affected notes to match the Sustain pedal off position, and then removes the Sustain Controller on/off events.

**Delete Overlaps (mono)**
This function allows you to make sure that no notes of the same pitch overlap (i.e. that one starts before the other ends). Overlapping notes of the same pitch can confuse some MIDI instruments (a new Note On is transmitted before the Note Off is transmitted). This command can then be used to automatically solve the problem.

**Delete Overlaps (poly)**
This function shortens notes when required, so that no note begins before another ends. This happens regardless of which pitch the notes have.

**Velocity**
This function opens a dialog that allows you to manipulate the velocity of notes in various ways.

The following types of velocity processing are available:

**Add/Subtract**
This simply adds a fixed number to the existing velocity values. You set the value (positive or negative) with the Amount parameter.

**Compress/Expand**
Compresses or expands the “dynamic range” of MIDI notes by scaling the velocity values according to the Ratio setting (0–300%). The principle behind this is that multiplying different velocity values with a factor higher than 1 (over 100%) will also make the differences between velocity values greater, while using a factor lower than 1 (under 100%) will make the differences smaller. In short:
- To compress (“even out” velocity differences), use ratio values below 100%.
- After compression, you would probably want to add a velocity amount (with the Add/Subtract function) to maintain the average velocity level.
• To expand (create greater difference in velocity), use ratio values above 100%.
Before you expand, you may want to adjust the velocity with the Add/Subtract function, so that the average velocity is somewhere in the middle of the range. If the average velocity is high (near 127) or low (near 0), expansion will not work properly, simply because velocity values can only be between 0 and 127!

**Limit**
This function allows you to make sure that no velocity values fall outside a given range (the Lower and Upper values). Any velocity values outside this range are raised/lowered to exactly the Lower/Upper values.

**Fixed Velocity**
This function sets the velocity of all selected notes to the Insert Velocity value on the toolbar in the MIDI editors.

**Thin Out Data**
Thins out MIDI data. Use this to ease the load on your external MIDI devices if you have recorded very dense controller curves, etc.

่าย Cubase only: This also thins out MIDI controller and VST 3 events that form part of Note Expression data.

You can also manually thin out the controller data by using the quantize function in the Key Editor.

**Extract MIDI Automation**
This is an extremely useful function as it allows you to quickly and easily convert the continuous controllers of your recorded MIDI parts into MIDI track automation data, making them available for editing in the Project window. Proceed as follows:

1. Select the desired MIDI part containing the continuous controller data.
2. On the MIDI menu, open the Functions submenu and select "Extract MIDI Automation".
3. In the Project window, open the automation tracks for the respective MIDI track. You will find that an automation track has been created for each of the continuous controllers in the part.

่าย In the MIDI editors, the controller data will automatically be removed from the controller lane.

This function can only be used for continuous controllers. Data such as Aftertouch, Pitchbend, or SysEx cannot be converted to MIDI track automation data.

่าย MIDI controller automation is also affected by the Automation Merge Mode, see “MIDI controller automation” on page 241.

**Reverse**
This function inverts the order of the selected events (or of all events in the selected parts), causing the MIDI music to play backwards. Note that the effect is different from reversing an audio recording. With MIDI, the individual notes will still play as usual in the MIDI instrument – it is only the order of playback that is changed.

**Merge Tempo from Tapping (Cubase only)**
This function allows you to create a complete tempo track based on your tapping, see the section “Merge Tempo From Tapping (Cubase only)” on page 469.
31
The MIDI editors
Introduction

There are several ways to edit MIDI in Cubase. You can use the tools and functions in the Project window for large-scale editing, or the functions on the MIDI menu to process MIDI parts in various ways (see “What is affected by the MIDI functions?” on page 367). For hands-on graphical editing of the contents of MIDI parts, you use the MIDI editors:

• The Key Editor is the default MIDI editor, presenting notes graphically in an intuitive piano roll-style grid. The Key Editor also allows for detailed editing of non-note events such as MIDI controllers. For more information, see “The Key Editor – Overview” on page 377.

• The Score Editor shows MIDI notes as a musical score and comes with advanced tools and functions for notation, layout and printing. The Score Editor in Cubase is described in detail in “Part II: Score layout and printing (Cubase only)” on page 550. Cubase Artist features a basic version of the Score Editor, see “The basic Score Editor – Overview” on page 411.

• The Drum Editor is similar to the Key Editor, but takes advantage of the fact that with drum parts, each key corresponds to a separate drum sound. This is the editor to use when you are editing drum or percussion parts. For more information, see “The Drum Editor – Overview” on page 397.

• The List Editor shows all events in the selected MIDI parts as a list, allowing you to view and edit their properties numerically. It also allows you to edit SysEx messages. For more information, see “The List Editor – Overview” on page 404 and “Working with SysEx messages” on page 407.

• The Edit In-Place function allows you to edit MIDI parts directly in the Project window. This is similar to working in the Key Editor, but makes it easier to edit MIDI in context with other track types, see “The In-Place Editor” on page 396.

• Cubase only: You can also edit MIDI in the Project Browser. The Project Browser is described in the chapter “The Project Browser (Cubase only)” on page 477.

You can define each of the editors mentioned above as your default MIDI editor, see below.

This chapter describes how to use the MIDI editors. Features that are identical in these editors are described in the Key Editor section. The sections about the Drum Editor, the In-Place Editor, the List Editor, and the basic Score Editor only describe the features that are specific to these editors. The Score Editor for Cubase is described in detail in “Part II: Score layout and printing (Cubase only)” on page 550.

Opening a MIDI editor

There are two ways to open a MIDI editor:

• Select one or several parts (or a MIDI track, with no parts selected), open the MIDI menu and select Open Key Editor, Open Score Editor, Open Drum Editor, Open List Editor, or Open In-Place Editor (or use the corresponding key command).

In Cubase Artist, the Score Editor is opened via the Scores submenu of the MIDI menu. The selected parts (or all parts on the track, if no part was selected) will open in the selected editor.

• Double-click a part. The default editor opens. Which editor this is, depends on the Default Edit Action setting in the Preferences dialog (Event Display–MIDI page).

If the “Edit as Drums when Drum Map is assigned” option is activated and a drum map is selected for the edited track (see “Selecting a drum map for a track” on page 401), the Drum Editor will open.

If the part you open for editing is a shared copy, any editing you perform will affect all shared copies of this part. Shared copies are created by pressing [Alt]/[Option]-[Shift] and dragging, or by using the Repeat function with the “Shared copies” option activated. In the Project window, shared copies are indicated by an equal sign (=) in the top right corner of the part.
Handling several parts

When you open a MIDI editor with several parts (or a MIDI track containing several parts) selected, the editor contains a few functions that make working with multiple parts easier and more comprehensive:

• The “Currently Edited Part” pop-up menu on the toolbar lists all parts that are opened in the editor (or all parts on the track if no parts were selected). Here you can select which part is active for editing. When you select a part from the list, it is automatically active and centered in the note display.

• The “Edit Active Part Only” button on the toolbar lets you restrict editing operations to the active part. For example, if you select “All” from the Select submenu of the Edit menu with this option activated, only events in the active part will be selected. Similarly, if you select notes by dragging with the Arrow tool (making a selection rectangle), only the notes in the active part will be selected.

• The “Zoom to Event” function on the Zoom submenu of the Edit menu lets you zoom in on the active part so that it fills the screen.

• The “Show Part Borders” button on the toolbar lets you see clearly defined borders for the active part. When this is activated, all parts except the active one are grayed out, making the borders easily discernible. In the Key Editor, there are also two “markers” in the ruler with the name of the active part, marking its beginning and end. These can be moved freely to change the size of the part.

• Note that it is also possible to activate a part by selecting an event within this part with the Arrow tool.

• Key commands allow you to cycle between parts (making them active). In the Key Commands dialog – Edit category, you will find two functions for this: “Activate Next Part” and “Activate Previous Part”. If you assign key commands to these, you can use them to cycle between parts in the editors. For further information, see “Setting up key commands” on page 542.

* “Show Part Borders” is activated on the toolbar.

* “Edit Active Part Only” is activated on the toolbar.

* The “Zoom to Event” function on the Zoom submenu of the Edit menu lets you zoom in on the active part so that it fills the screen.
The Key Editor – Overview

The toolbar contains tools and various settings for the Key Editor. The following toolbar elements are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up Window Layout</td>
<td>Clicking this button allows you to show/hide the status line and info line for the editor.</td>
</tr>
<tr>
<td>Solo Editor</td>
<td>This function is described in the section “The Solo Editor button” on page 380.</td>
</tr>
<tr>
<td>Acoustic Feedback</td>
<td>This function is described in the section “Acoustic Feedback” on page 381.</td>
</tr>
<tr>
<td>Auto-Scroll</td>
<td>This button activates/deactivates Auto-Scroll for the Key Editor, see “Auto-Scroll” on page 380.</td>
</tr>
<tr>
<td>Tool buttons</td>
<td>These are the tools used for editing in the Key Editor.</td>
</tr>
<tr>
<td>Independent Track Loop</td>
<td>This button activates/deactivates the independent track loop, see “The independent track loop” on page 381.</td>
</tr>
<tr>
<td>Auto Select Controllers</td>
<td>Use this button to also select all available controller data for a note when selecting the note in the editor.</td>
</tr>
<tr>
<td>Show Note Expression Data</td>
<td>When this button is activated, Note Expression data is shown in the Key Editor (Cubase only), see “Note Expression (Cubase only)” on page 428.</td>
</tr>
<tr>
<td>Multiple Part Controls</td>
<td>These controls allow you to show/hide the part borders and switch between several selected parts, see “Handling several parts” on page 576.</td>
</tr>
<tr>
<td>Indicate Transpositions</td>
<td>When this button is activated, MIDI notes are displayed according to their transposition settings, see “Indicate Transpositions” on page 135.</td>
</tr>
<tr>
<td>Insert Velocity</td>
<td>Use this field to specify a velocity value for any notes that are entered in the editor.</td>
</tr>
</tbody>
</table>

You can show/hide most of the toolbar elements by activating/deactivating the corresponding options on the context menu. Furthermore, you can store/recall different toolbar configurations, see “Using the Setup options” on page 534.
The status line

The status line is displayed below the toolbar in the Key Editor.

It displays the following information:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mouse Time Position</td>
<td>This displays the exact time position of the mouse pointer, in the format selected for the ruler, allowing you to perform editing or to insert notes at exact positions.</td>
</tr>
<tr>
<td>Mouse Note Position</td>
<td>This displays the exact pitch of the mouse pointer position, making it easier to find the right pitch when entering or transposing notes.</td>
</tr>
<tr>
<td>Current Chord Display</td>
<td>When the project cursor is positioned over notes making up a chord, this chord is displayed here.</td>
</tr>
</tbody>
</table>

- To show or hide the status line, click the “Set up Window Layout” button on the toolbar and activate or deactivate the “Status Line” option.

The info line

The info line shows information about the selected MIDI note. If several notes are selected, the values for the first note are displayed (in color). You can edit all values on the info line using regular value editing (see “Editing on the info line” on page 386 for details). Length and position values are displayed in the format currently selected for the ruler. Cubase only: If the Note Expression editor is open, the info line shows information about the selected Note Expression events (see “Editing Note Expression data” on page 434).

- To show or hide the info line, click the “Set up Window Layout” button on the toolbar and activate or deactivate the “Info Line” option.

The ruler

The ruler shows the timeline, by default in the display format selected on the Transport panel. You can select a separate format for a MIDI editor ruler on the Ruler pop-up menu, opened by clicking the arrow button to the right of it. For a list of the available formats, see “The ruler” on page 44.

At the bottom of the pop-up menu, there are two additional items:

- If “Time Linear” is selected, the ruler, note display, and controller display will be linear in relation to time. This means that if the ruler shows bars and beats, the distance between the bar lines will vary depending on the tempo.
- If “Bars+Beats Linear” is selected, the ruler, note display, and controller display will be linear in relation to tempo. This means that if the ruler shows bars and beats, the distance between beats will be constant.

In most cases, you would set the display format to “Bars+Beats” and “Bars+Beats Linear” mode when editing MIDI.

The Key Editor Inspector

On the left in the Key Editor, you will find the Inspector. It contains tools and functions for working with MIDI data.

The Expression Map section (Cubase only)

In the Expression Map section you can load an expression map. This is useful if you are working with articulations, see “Expression maps (Cubase only)” on page 419.

The Note Expression section (Cubase only)

The Note Expression section contains functions and settings related to Note Expression, see “Setting up the Note Expression Inspector tab” on page 430.

The Quantize section

The Quantize section allows you to access the main quantize parameters. These are identical with the functions on the Quantize panel (see “The Quantize Panel” on page 111) and the Advanced Quantize submenu of the Edit menu (see “Advanced Quantize functions” on page 110).
The Transpose section

The Transpose section allows you to access the main parameters for transposing MIDI events. These can also be found in the Transpose dialog, see “Transpose” on page 367.

The Length section

The Length section contains the length-related options from the Functions submenu of the MIDI menu (see “Other MIDI functions” on page 371) as well as a Length/Legato slider.

• Use the “Scale Length/Legato” slider to change the length of the selected MIDI events (or all events of the active part if no events are selected).
  At the maximum value the notes reach the beginning of the next note.

• Use the “Freeze MIDI Lengths” button to the right of the “Scale Length/Legato” slider to make the new length settings permanent.

• Use the Overlap slider to finetune the distance between consecutive notes.
  At “0 Ticks”, the “Scale Legato” slider extends each note so that it reaches the next note exactly. Positive values cause the notes to overlap and negative values allow you to define a small gap between the notes.

• Activate the “Between Selected” option if you want to use the Legato function or slider to extend a note until the next selected note (instead of the following note in the part).
  This is identical with activating the “Legato Mode: Between Selected Notes Only” option in the Preferences dialog.

The note display

The note display is the main area in the Key Editor. It contains a grid in which MIDI notes are shown as boxes. The width of a box corresponds to the note length, and the vertical position of a box corresponds to the note number (pitch), with higher notes higher up in the grid. The piano keyboard helps you to find the right note number.

For a description of how to display colors in the note display, see “Coloring notes and events” on page 382.

The controller display

The area at the bottom of the Key Editor window is the controller display. It consists of one or several controller lanes, each showing one of the following properties or event types:

• Velocity values of the notes
• Pitchbend events
• Aftertouch events
• Poly Pressure events
• Program Change events
• SysEx events
• Articulations and Dynamics (see “Expression maps (Cubase only)” on page 419 and “Working with mapped dynamics” on page 685).
• Any type of continuous controller event (see “Editing continuous controllers on the controller lane” on page 392)

To change the size of the controller display, drag the divider between the controller display and the note display.

Velocity values are shown as vertical bars in the controller display, with higher bars corresponding to higher velocity values.

Each velocity bar corresponds to a note in the note display.

Events other than velocity values are shown as blocks, the heights of which correspond to the values of the events. The beginning of an event is marked by a curve point. To select an event, click on the curve point, so that it turns red.

Unlike notes, events in the controller display have no length. The value of an event in the display is “valid” until the start of the next event.
For a description of editing in the controller display, see “Using the controller display” on page 388.

Key Editor operations

Zooming
Zooming in the Key Editor is done according to the standard zoom procedures, using the zoom sliders, the Zoom tool or the Zoom submenu of the Edit menu.

- When you drag a rectangle with the Zoom tool, the result depends on the "Zoom Tool Standard Mode: Horizontal Zooming Only" option in the Preferences dialog (Editing–Tools page).
  If this is activated, the window will only be zoomed horizontally; if not, the window will be zoomed both horizontally and vertically.

Using the Trim tool
The Trim tool allows you to change the length of note events by cutting off the end or the beginning of notes.

Using the Trim tool means moving the note-on or the note-off event for one or several notes to a position defined with the mouse. Proceed as follows:

1. Select the Trim tool on the toolbar.
   The mouse pointer changes to a knife symbol.

2. To edit a single note, click on it with the Trim tool. The range between the mouse pointer and the end of the note will be removed.
   You can use the mouse note info on the status line to find the exact position for the trim operation.

3. To edit several notes, click and drag with the mouse across the notes.
   A line is displayed. The notes will be trimmed along this line.

   By default, the Trim tool will cut off the end of notes. To trim the beginning of the note(s), press [Alt]/[Option] while dragging.

   If you press [Ctrl]/[Command] while dragging, you will get a vertical trim line, allowing you to set the same start or end time for all edited notes.

   Note that the trimmed note ends or starts do not snap to the grid.

Playing back
You can play back your music as usual when working in a MIDI editor. There are several features designed to make editing easier during playback.

The Solo Editor button

If you activate the Solo Editor button, only the edited MIDI parts will be heard during regular playback.

Auto-Scroll

As described in the section “Auto-Scroll” on page 47, the Auto-Scroll function makes the window "follow" the project cursor during playback, so that the current play position is visible at all times. However, when you are working in a MIDI editor, you may want to deactivate Auto-Scroll – this way, the events you are working with will stay visible.

The Auto-Scroll buttons in each MIDI editor are independent of the Project window Auto-Scroll setting, which means that Auto-Scroll can be activated in the Project window and deactivated in the MIDI editor you are working in.
The independent track loop

The independent track loop is a sort of “mini-cycle”, affecting only the MIDI part being edited. When the loop is activated, the MIDI events within the loop will be repeated continuously and completely independent – other events (on other tracks) will be played back as usual. The only “interaction” between the loop and the “regular playback” is that every time the cycle starts over again, so does the loop.

To set up the independent track loop, proceed as follows:

1. Activate the “Independent Track Loop” button on the toolbar.
2. Specify the length of the independent track loop by [Ctrl]/[Command]-clicking and [Alt]/[Option]-clicking in the ruler to set the start and end of the loop, respectively.

The independent track loop is indicated in purple in the ruler. When the corresponding options are activated on the context menu, the track loop start and end are also displayed on the status line.

The MIDI events will be looped as long as the “Independent Track Loop” button is activated and the MIDI editor is open.

• To turn the loop into actual MIDI notes, use the Repeat Loop function on the MIDI menu, see “Repeat Loop” on page 370.

Acoustic Feedback

If the Acoustic Feedback icon (speaker symbol) on the toolbar is activated, individual notes will automatically be played back (auditioned) when you move or transpose them, or when you create new notes by drawing. This makes it easier to hear what you are doing.

In the Preferences dialog (MIDI page), you can specify whether the Acoustic Feedback function takes into account any MIDI sends or inserts used for the track. Activate the “Audition through MIDI Inserts/Sends” option if you want the layering of MIDI instruments (by MIDI sends) to be active within the MIDI editors as well. This way, the acoustic feedback of the editors sends the MIDI data not only to the output selected for the track, but additionally through any MIDI inserts and MIDI sends assigned to it. Note, however, that this also means that the MIDI events will be sent through any MIDI plug-ins assigned to this track.

Snap

The Snap function helps you find exact positions when editing in a MIDI editor. It does this by restricting horizontal movement and positioning to certain positions. Operations affected by snap include moving, duplicating, drawing, sizing, etc. The Snap function is described in detail in the section “The Snap function” on page 45.

• When the “Bars+Beats” display format is selected in the ruler, the snap grid is set by the quantize value on the toolbar.

When any of the other display formats is selected in the ruler, positioning is restricted to the displayed grid, i.e. you can snap in finer increments by zooming in, and in coarser increments by zooming out.
Coloring notes and events

By using the Event Colors pop-up menu on the toolbar, you can select a color scheme for the events in the editor. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity</td>
<td>The notes get different colors depending on their velocity values.</td>
</tr>
<tr>
<td>Pitch</td>
<td>The notes get different colors depending on their pitch.</td>
</tr>
<tr>
<td>Channel</td>
<td>The notes get different colors depending on their MIDI channel value.</td>
</tr>
<tr>
<td>Part</td>
<td>The notes get the same color as their respective part in the Project window. Use this option when you are working with two or more tracks in an editor, to make it easier to see which notes belong to which track.</td>
</tr>
<tr>
<td>Grid Match</td>
<td>The notes get different colors depending on their time position. For example, this mode makes it easy to see if the notes in a chord start at the exact same beat.</td>
</tr>
<tr>
<td>Sound Slot (Cubase only)</td>
<td>The notes get different colors depending on the articulation that has been assigned to the note in the Expression Map Setup dialog. For more information, see the chapter “Expression maps (Cubase only)” on page 418.</td>
</tr>
</tbody>
</table>

For all of the options except “Part” the pop-up menu also contains a “Setup…” option. This option opens a dialog in which you can specify the colors that are associated with which velocities, pitches, or channels, respectively.

Creating and editing notes

To draw in new notes in the Key Editor, use the Pencil tool or the Line tool.

Drawing notes with the Pencil tool

With the Pencil tool, you can insert single notes by clicking at the desired time (horizontal) and pitch position (vertical).
- When you move the pointer in the note display, its bar position is indicated on the status line, and its pitch is indicated both on the status line and on the piano keyboard to the left. This makes it easy to find the right note and insert position. For a description of how to show the status line, see “The status line” on page 378.

• If Snap is activated, this determines the start position of the created note.
• If you click once, the created note will have the length set on the Length Quantize pop-up menu on the toolbar. You can create a longer note by clicking and dragging. The length of the created note will be a multiple of the Length Quantize value. If “Length Quantize” is set to “Quantize Link” the note value is determined by the quantize grid.

Drawing notes with the Line tool

The Line tool can be used for creating series of contiguous notes. To do so, click and drag to draw a line and then release the mouse button.
To determine another mode for the Line tool you can click on the Line tool and click again to open a pop-up menu where you can select the desired option.

The button will change appearance according to the selected mode.

### Setting velocity values

When you draw notes in the Key Editor, the notes will get the velocity value set in the Insert Velocity field on the tool bar.

You can use different methods to set the velocity:

- When a tool modifier is assigned for the Select tool–Edit Velocity action (in the Preferences dialog, Editing–Tool Modifiers page), you can select one or more notes, press the modifier and click on one of the selected notes to change the velocity.

  The cursor changes into a speaker and, next to the note, a field with the velocity value appears – the Note Velocity slider. Move the mouse pointer up or down to change the value. Value changes will be applied to all selected notes, as you can see in the controller lane.

- Selecting a predefined velocity value from the Insert Velocity pop-up menu.

  The menu contains five different predefined velocity values. The “Setup...” item opens a dialog that allows you to specify which five velocity values are available on the pop-up menu. (This dialog can also be opened by selecting “Insert Velocities...” from the MIDI menu.)

- Manually entering the desired velocity value by double-clicking in the Insert Velocity field and typing in the desired value.

- Using a key command.

  You can assign a key command to each of the five available velocity values in the Key Commands dialog (MIDI category – the items Insert Velocity 1–5). This allows for quick switching between different velocity values when entering notes. See “Setting up key commands” on page 542 for instructions on how to set up key commands.

### Selecting notes

Selecting notes is done using any of the following methods:

- Using the Arrow tool.

  The standard selection techniques apply.

- Using the Select submenu of the Edit menu or context menu.

  The Select menu options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects all notes in the edited part.</td>
</tr>
<tr>
<td>None</td>
<td>Deselects all events.</td>
</tr>
<tr>
<td>Invert</td>
<td>Inverts the selection – all selected events are deselected and all notes that were not selected are selected instead.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all notes that are partially or completely inside the boundaries of the left and right locators (only visible if locators are set).</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all notes that begin to the left of the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all notes that end to the right of the project cursor.</td>
</tr>
<tr>
<td>Equal Pitch – all Octaves</td>
<td>This function requires that a single note is selected. It selects all notes of this part that have the same pitch (in any octave) as the currently selected note.</td>
</tr>
</tbody>
</table>
The MIDI editors

To step from one note to another, use the left and right arrow keys on the computer keyboard.
If you press [Shift] and use the arrow keys, the current selection will be kept, allowing you to select several notes.

To select all notes of a certain pitch, press [Ctrl]/[Command] and click on the desired key in the keyboard display to the left.

To select all the following notes of the same pitch, you can press [Shift] and double-click on a note.

If the “Auto Select Events under Cursor” option is activated in the Preferences dialog (Editing page), all notes “touched” by the project cursor are automatically selected.

Toggle selections

If you want to toggle the selected elements within a selection rectangle, press [Ctrl]/[Command] and enclose the same elements within a new selection rectangle. Once you release the mouse button, the previous selection is deselected and vice versa.

Selecting controllers within the note range

You can select the controllers within the range of the selected notes. The following applies:

- When the Auto Select Controllers button is activated on the toolbar, the controllers will always be selected when the respective notes are selected.

- When you select “Select Controllers in Note Range” on the Select submenu of the Edit menu, the controllers within the note range (i.e. between the first/leftmost and last/rightmost note) will be selected.

- A note range lasts until the start of the next note or the end of the part.

- Selected controllers for notes are moved when the corresponding notes are moved.

Moving and transposing notes

To move notes in the editor, use any of the following methods:

- Select the notes and use the buttons on the Transpose Palette on the toolbar.
- Click and drag to a new position.

All selected notes will be moved, maintaining their relative positions. If Snap is activated, this determines to which positions you can move the notes, see “Snap” on page 381.

You can restrict movement to horizontal or vertical by holding down [Ctrl]/[Command] while dragging.

- Use the up and down arrow keys on the computer keyboard.

This method allows you to transpose the selected notes, without risking to move them horizontally. Note that pressing [Shift] and using the up and down arrow keys will transpose notes in steps of one octave. Transpose is also affected by the global transpose setting, see “The transpose functions” on page 131.

- You can also use the Transpose function on the MIDI menu (see “Transpose” on page 367).

- Use the Move to Cursor function on the Edit menu.

This moves the selected notes to the project cursor position.

- Select a note and adjust its position or pitch on the info line, see “Editing on the info line” on page 386.

- Use the Move buttons in the Nudge palette on the toolbar.

This moves the selected note(s) by the amount set on the Quantize pop-up menu. By default, the Nudge palette is not shown on the toolbar. How to show/hide toolbar items is described in the section “Using the Setup options” on page 534.
When you move selected notes to a different position, any selected controllers for these notes will move accordingly. For further information, see also “Moving events” on page 392.

You can also adjust the position of notes by quantizing (see “Quantizing MIDI and audio” on page 108).

Duplicating and repeating notes

Notes are duplicated much in the same way as events in the Project window:

- Hold down [Alt]/[Option] and drag the note(s) to a new position.
  If Snap is activated, this determines to which positions you can copy notes (see “Snap” on page 381).

- Selecting Duplicate from the Functions submenu on the Edit menu creates a copy of the selected note and places it directly after the original.
  If several notes are selected, all of these are copied “as one unit”, maintaining the relative distance between the notes.

- Selecting “Repeat…” from the Functions submenu on the Edit menu opens a dialog, allowing you to create a number of copies of the selected note(s).
  This works like the Duplicate function, but you can specify the number of copies.

- You can also perform the Repeat function by dragging: Select the note(s) to repeat, press [Alt]/[Option], click the right edge of the last selected note and drag to the right. The longer to the right you drag, the more copies are created (as indicated by the tooltip).

Using cut and paste

You can use the Cut, Copy and Paste options on the Edit menu to move or copy material within a part or between different parts. When you paste copied notes, you can either use the regular Paste function or the function “Paste Time” from the Range submenu of the Edit menu.

- “Paste” inserts the copied notes at the project cursor position without affecting existing notes.

- “Paste Time” inserts at the project cursor position, but moves (and if necessary, splits) existing notes to make room for the pasted notes.

Selecting “Paste Time” with this data on the clipboard and the project cursor here…

…will give you this.

Resizing notes

To resize a note, use one of the following methods:

- Position the Arrow tool at the start or end of the note, so that the pointer takes on the shape of a small double arrow. Click and drag to the left or right to resize the note. This method allows you to resize the note from either direction.

- If you want to apply time-stretching to the controller (and Note Expression data, Cubase only) associated with the note that you resize, you can select the “Sizing Applies Time Stretch” mode for the Arrow tool before resizing the note.
  This resizing mode works exactly as in the Project window, see “Resizing events using time stretch” on page 64.

- Click with the Pencil tool within the note box and drag to the left or the right (to make the note shorter or longer, respectively).

With these methods, the resulting length will be a multiple of the Length Quantize value on the toolbar.

- Use the Trim Start/End buttons on the Nudge palette on the toolbar.
  This resizes the selected note(s) by moving their start or end positions, in steps according to the Length Quantize value on the toolbar. By default, the Nudge palette is not shown on the toolbar – see “Using the Setup options” on page 534 for more information.

- Select the note and adjust its length on the info line.
  See “Editing on the info line” on page 386 for details on info line editing.

- Use the Trim tool, see “Using the Trim tool” on page 380.
### Splitting notes

There are three ways to split notes:

- Clicking on a note with the Scissors tool splits the note at the position you pointed (taking the Snap setting into account if activated).
- If you select “Split at Cursor” from the Functions submenu on the Edit menu, all notes that are intersected by the project cursor are split at the cursor position.
- If you select “Split Loop” from the Functions submenu on the Edit menu, all notes that are intersected by the left or right locator are split at the locator positions.

### Gluing notes

Clicking on a note with the Glue Tube tool will “glue it together” with the next note of the same pitch. The result will be one long note spanning from the start of the first note to the end of the second note and with the properties (velocity, etc.) of the first note.

### Muting notes

Individual notes can be muted in the Key Editor, as opposed to muting an entire MIDI part in the Project window. This allows you to exclude notes from playback, but keep the option to bring them back again at any time. To mute a note, use one of the following methods:

- Click on it with the Mute tool.
- Drag a rectangle with the Mute tool, enclosing all notes you want to mute.
- Select the note(s) and choose Mute from the Edit menu. The default key command for this is [Shift]-[M].

To unmute a note, either click it or enclose it with the Mute tool, or select it and choose Unmute from the Edit menu. The default key command for this is [Shift]-[U].

### Deleting notes

To delete notes, either click on them with the Erase tool or select them and press [Backspace].

### Editing on the info line

The info line shows the values and properties of the selected events. If a single event is selected, its values are displayed on the info line. If several events are selected, the info line shows the values of the first of these events (in color).

You can edit the values on the info line using regular value editing. This allows you to move, resize, transpose or change velocity of events in a very precise manner. It is also possible to click in the Pitch or Velocity field in the info line and play a note on your MIDI keyboard – the pitch or velocity will be adjusted accordingly.

- If you have several events selected and change a value, all selected events will be changed by the set amount.
- If you have several events selected and change a value holding down [Ctrl]/[Command], the change will be absolute. In other words, the value setting will be the same for all selected events.

Cubase only: If the Note Expression editor is open and you have selected values on a curve, the info line shows values belonging to the corresponding Note Expression parameter.
How the Key Editor handles drum maps
When a drum map is assigned to a MIDI or instrument track (see “Working with drum maps” on page 400), the Key Editor will display the drum sound names as defined by the drum map.

In Cubase, the name of the drum sound is displayed in the following locations:

On the status line, in the Mouse Note Position field
On the info line, in the Pitch field
In the event itself (provided that the zoom factor is high enough)
When dragging a note

This allows you to use the Key Editor for drum editing, e.g. when editing drum note lengths (which may be necessary for some external instruments) or when editing several parts, to identify drum events.

How the Key Editor handles expression maps (Cubase only)
When an expression map is assigned to a MIDI track, the musical articulations defined for that map are displayed in the following locations of the Key Editor:

On the info line
On the controller lane
In the event itself if the vertical zoom factor is high enough

For more information, see the chapter “Expression maps (Cubase only)” on page 419.

Note Expression data in the Key Editor (Cubase only)
The Key Editor is the main editor for working with Note Expression. This functionality is described in detail in the chapter “Note Expression (Cubase only)” on page 428.

Editing notes via MIDI
You can change the properties of notes via MIDI. For example, this can be a fast way to get the right velocity value, since you will hear the result even as you edit:

1. Select the note you want to edit.
2. Click the MIDI Input button on the toolbar to enable editing via MIDI.
3. Use the note buttons on the toolbar to decide which properties are changed by the MIDI input. You can enable editing of pitch, note-on and/or note-off velocity.

With this setting, the edited notes will get the pitch and velocity values of the notes input via MIDI, but the note-off velocities will be kept as they are.

4. Play a note on your MIDI instrument. The note selected in the editor will get the pitch, velocity and/or note-off velocity of the played note.

The next note in the edited part is automatically selected, making it easy to quickly edit a series of notes.

- If you want another try, select the note again (e.g. by pressing the left arrow key on the computer keyboard) and again play a note on your MIDI instrument.

**Step input**

Step input, or step recording, is when you enter notes one at a time (or one chord at a time) without worrying about the exact timing. This is useful, for example, when you know the part you want to record but are not able to play it exactly as you want it.

Proceed as follows:

1. Click the Step Input button on the toolbar to activate Step Input mode.

2. Use the note buttons to the right to decide which properties are included when you input the notes. For example, you may not want to include the velocity and/or note-off velocity of the played notes. It is also possible to turn off the pitch property, in which case all notes will get the pitch C3, no matter what you play.

3. Click anywhere in the note display to set the start position (the desired position of the first note or chord). The step input position is shown as a blue line in the note display.

4. Specify the desired note spacing and length with the Quantize and Length Quantize pop-up menus. The notes you input will be positioned according to the Quantize value and have the length set with the Length Quantize value. For instance, if you set Quantize to 1/8 notes and Length Quantize to 1/16 notes, the notes will be sixteenth notes, appearing on each eighth note position.

- If “Length Quantize” is set to “Quantize Link” the note length is also determined by the Quantize value.

5. Play the first note or chord on your MIDI instrument. The note or chord appears in the editor and the step input position advances one quantize value step.

- If Move Insert Mode is activated, all notes to the right of the step input position will be moved to “make room” for the inserted note or chord.

6. Continue in the same way with the rest of the notes or chords. You can adjust the Quantize or Length Quantize value as you go along, to change the timing or note lengths. You can also move the step input position manually by clicking anywhere in the note display.

- To insert a “rest”, press the right arrow key on the computer keyboard. This advances the step input position one step.

7. When you are done, click the Step Input button again to deactivate step input.

**Using the controller display**

By default, the controller display has a single lane, showing one event type at a time. However, you can add as many lanes as you need. The use of several controller lanes allows you to view and edit different controllers at the same time.
Each MIDI track has its own controller lane setup (number of lanes and selected event types). When you create new tracks, they get the controller lane setup used last.

The controller display with three lanes

- To add a lane, click the “+” button or open the “Controller Selection and Functions” pop-up menu and select “Create Controller Lane”.

- To remove a lane, open the “Controller Selection and Functions” pop-up menu and select “Remove this Lane”. This hides the lane from view – it does not affect the events in any way.

  If you remove all lanes, the controller display will be completely hidden. You can bring it back by clicking the “Create Controller Lane” button.

Instead of adding and removing single lanes, you can also show/hide multiple lanes using the “Controller Lane Setup” pop-up menu:

- “Show/Hide Controller Lanes” allows you to hide all controller lanes from view, giving you more space for viewing and editing the MIDI notes. When you select this option again, your previous lanes setup is restored.

- “Velocity Only” resets the controller display to show only the Velocity lane.

- “Show Used Controllers” allows you to automatically show all controller lanes with controller data.

Selecting the event type

Each controller lane shows one event type at a time. To select which type is displayed, use the “Controller Selection and Functions” pop-up menu to the left of the lane.

Setting up the available continuous controllers

In the MIDI Controller Setup dialog you can specify which continuous controllers are available for selection. Proceed as follows:

1. Open the “Controller Selection and Functions” pop-up menu and select “Setup…”.

   The MIDI Controller Setup dialog opens.

2. Move all the controllers that you need to the list on the left and move the controllers that you do not need to the list on the right.
3. Click OK.

⚠️ The MIDI Controller Setup dialog can be opened from different areas in the program. The settings are global, i.e. the setup you choose here affects all areas of the program where MIDI controllers can be selected.

Controller lane presets

Once you have added the required number of controller lanes and selected the event types you need, you can store this combination as a controller lane preset. For example, you can have a preset with one velocity lane only, another with a combination of velocity, pitchbend and modulation, and so on. This can make working with controllers much quicker.

Controller lane presets are organized via the “Controller Lane Setup” pop-up menu.

The following options are available:

• To add the current controller lane setup as a preset, select “Add Preset…” on the pop-up menu. A dialog opens, where you can enter a name for the preset.

• To apply a stored preset, select it from the pop-up menu. This immediately brings up the controller lanes and event types in the preset.

• To remove or rename presets, select “Organize…” from the pop-up menu.

Entering and editing controller events

Editing the events in the controller display is much like editing automation data on an automation track in the Project window (except for velocity values and articulations, see “Editing velocity values” on page 393 and “Editing articulations (Cubase only)” on page 394). All controller values can be edited with the Pencil or the Line tool. If you have selected more than one controller event on a controller lane, the controller lane editor is displayed, see “Working with selection ranges” on page 395.

• To select all events on a controller lane, open the “Controller Lane Setup” pop-up menu and choose the “Select all Controller Events” option.

Adding and editing events in the controller display

When any option other than “Velocity” is selected for a controller lane, you can create new events or edit the values of existing events using the Pencil tool or the Line tool in its various modes:

• To create a new event, click with the Pencil tool or the Line tool.

• To modify the values of existing events, press [Alt]/[Option] and use the Pencil tool or the Line tool. No new controller events are added in this mode.

You can click and drag to change or add multiple events, draw controller curves, etc:

When you move the pointer in the controller lane, the corresponding value is displayed in this field.

⚠️ With the Pencil tool and the Line tool in Paint mode, the quantize value determines the “density” of created controller curves (if Snap is activated, see “Snap” on page 381). For very smooth curves, use a small quantize value or turn off Snap. However, this will create a very large number of MIDI events, which can cause MIDI playback to “stutter” in some situations. A medium-low density is often sufficient.
• Clicking and dragging with the Line tool in Line mode allows you to create events in a straight line. This is the best way to draw linear controller ramps.

![Converting a controller curve to a ramp using the Line tool.](image)

• The Parabola mode works in the same way, but arranges the values on a parabola curve instead, giving more “natural” curves and fades. Note that the result depends on the direction from which you draw the parabola.

![Parabola mode curve](image)

- In Parabola mode, you can use modifier keys to determine the shape of the parabola curve. If you press [Ctrl]/[Command], the parabola curve will be reversed. If you press [Alt]/[Option]-[Ctrl]/[Command] while Snap is activated, you can change the position of the whole curve (in both cases the snap value for the positioning will be a quarter of the quantize value). If you press [Shift], the exponent will be increased or decreased.

- In Line and Parabola modes, the Length Quantize value determines the “density” of created controller curves. If Snap is activated. For very smooth curves, use a small Length Quantize value or turn off Snap. To avoid over-dense controller curves (which may cause MIDI playback to “stutter”), use a medium-low density.

- If Length Quantize is set to “Quantize Link” and you enter data in Sine, Triangle or Square mode, the density of the events depends on the Zoom factor.

• The Sine, Triangle and Square modes create events with values aligned to continuous curves. In these modes, the quantize value determines the period of the curve (the length of one curve “cycle”) and the Length Quantize value determines the density of the events (the lower the Length Quantize note value, the smoother the curve).

- In Sine, Triangle and Square mode you can also use modifier keys to determine the shape of the curve. If you press [Ctrl]/[Command] you can change the phase of the beginning of the curve, if you press [Alt]/[Option]-[Ctrl]/[Command] while Snap is activated you can change the position of the whole curve (in both cases the snap value for the positioning will be a quarter of the quantize value).

- You can also set the curve period freely by holding down [Shift] when you insert events in Sine, Triangle or Square mode. Activate Snap, [Shift]-click and drag to set the length of one period. The period length will be a multiple of the quantize value.

- In Triangle and Square mode, you can press [Shift]-[Ctrl]/[Command] to change the maximum position of the triangle curve (to create sawtooth curves) or the pulse of the square curve.
Moving events

You can move events in a controller lane, much like you can with notes:

1. Click with the Arrow tool to select the events that you want move or copy.
   You can also click and drag to create a selection rectangle encompassing the desired events.
2. Click on a curve point inside the selection and drag the events.
   The events inside the selection are moved to the new position. If Snap is activated, this determines to which positions you can move the events (see “Snap” on page 381).

Deleting events in the controller display

You delete events by clicking on them with the Erase tool or by selecting them and pressing [Backspace]. Deleting a controller event makes the last event before this valid up until the next event. It does not “zero” any controller changes.

- You can delete notes by deleting their velocity bars in the controller display.
  Please be aware that if there is more than one note at the same position, there may still only be one velocity bar visible – make sure that you delete only the desired notes!

Editing continuous controllers on the controller lane

When a continuous controller is selected for a controller lane, additional data is displayed on the controller lane. This is due to the fact that MIDI controller data can be recorded (or entered) either for an automation track or for a MIDI part (see “MIDI controller automation” on page 241).

The following applies:

- On the “Controller Selection and Functions” pop-up menu, an asterisk is displayed next to the controller name if automation data already exists for this controller.
  This can be either controller data you entered in a MIDI editor (the data will then be displayed on the controller lane), or controller data recorded on an automation track in the Project window (in which case no events are displayed on the controller lane).

Using cut, copy and paste

You can use the standard Cut, Copy and Paste options on the Edit menu to copy and paste events in the controller display:

1. Select the events you want to cut or copy.
2. Select Cut or Copy from the Edit menu.
3. If you want to paste the events into another MIDI part, open that part in another Key Editor window.
4. Position the project cursor where you want to paste the events.
5. Select Paste from the Edit menu.
   The events on the clipboard are added, starting at the project cursor position, maintaining their relative distances. If a pasted event ends up at the same position as an existing event of the same type, the old event is replaced.

⚠️ Remember that a non-note event does not have a length – it is “valid” until the next event (see “The controller display” on page 379).

⚠️ When the Auto Select Controllers button is activated in the Key Editor toolbar, selecting notes will also select the corresponding controller events. Moving events (either using cut/copy/paste or drag & drop) in the note display will also move the corresponding controller events (see also “Selecting controllers within the note range” on page 384).
• If conflicting controller data exists in two different places, you can specify what will happen on playback by making settings for the Automation Merge Mode (see “Merging automation data” on page 241). The resulting curve is displayed in addition to the curve you entered on the controller lane.

- You can use the Pencil tool or the Line tool in Paint mode to change the velocity values of several notes by painting a “freehand curve”. When editing velocity, these two methods have the same functionality.

- Use the Line tool in Line mode for creating linear velocity ramps. Click where you want the ramp to start and drag the cursor to where you want the ramp to end. When you release the mouse button, the velocity values are aligned with the line between the two points.

- Parabola mode works in the same way, but aligns the velocity values to a Parabola curve instead. Use this for smooth, “natural” velocity fades, etc.

• On the controller lane, you can also see the controller curve that is applied before the part starts. That way, you know which controller value (if any) is currently being used at the starting point of the part so that you can choose the start value accordingly. Note that this value also depends on the Automation Merge Mode.

**Editing velocity values**

When “Velocity” is selected, the lane shows the velocity of each note as a vertical bar.

Velocity values are edited with the Pencil or the Line tool. The Arrow tool automatically switches to the Pencil tool when you move the pointer into the controller display. If you want to use the Arrow tool to select events in the controller display, press [Alt]/[Option]. The different tools and Line tool modes offer several possibilities:

- You can use the Pencil tool to change the velocity of a single note: click on its velocity bar and drag the bar up or down. While you drag, the current velocity value is shown in the display to the left.

- On the controller lane, you can also see the controller curve that is applied before the part starts. That way, you know which controller value (if any) is currently being used at the starting point of the part so that you can choose the start value accordingly. Note that this value also depends on the Automation Merge Mode.

**Controller curve**

entered on the controller lane

The controller curve before the part starts. This curve depends on the existing controller data (if any) and on the selected Merge Mode.

**Resulting controller curve**

(if controller automation was also recorded on a track). These values depend on the selected Automation Merge Mode.
• The remaining three Line tool modes (Sine, Triangle and Square) align the velocity values to continuous curve shapes.

If there is more than one note at the same position (e.g. a chord), their velocity bars will overlap on the controller lane. If none of the notes are selected, all notes at the same position will be set to the same velocity value when you draw. To edit the velocity of only one of the notes at the same position, first select the note in the note display. Now, editing will only affect the velocity of the selected note.

If the Speaker icon (Acoustic Feedback) is activated on the toolbar, the notes will be played back when you adjust the velocity, allowing you to audition your changes.

You can also adjust the velocity of a single note by selecting it and changing its velocity value on the info line.

Editing articulations (Cubase only)
It is also possible to add and edit musical expressions or articulations in the controller lane. This is described in detail in the chapter “Expression maps (Cubase only)” on page 419.

Editing dynamics (Cubase only)
Provided that the Dynamics mapping is set up and activated for the track, you can insert 12 dynamics symbols in the lower part of the Articulations/Dynamics lane. Dynamics are described in detail in the section “Working with mapped dynamics” on page 685.

• To insert a dynamics symbol, click in the controller lane with the pencil tool.
A mezzo forte symbol is inserted.

• To select another dynamics symbol for an event, click on the triangle in the upper left corner of the event and select a symbol from the pop-up menu. If several events are selected, the same symbol will be applied to all the events.

• To step through the available dynamics symbols, use the mouse wheel or the key commands “One down” and “One up” (in the Key Commands dialog, Score Functions category). If several events are selected, they will all change in increments, i.e. relative to the original values.

Moving and copying dynamics events works as with other events on the controller lane.

You can modify the settings for the Dynamics symbols in the Dynamics Mapping Setup dialog. You can open this dialog via the pop-up menu for a dynamics event or by selecting “Dynamics Mapping...” on the “Controller Selection and Functions” pop-up menu.

Adding and editing Poly Pressure events
Poly Pressure events are special, in that they “belong to” a specific note number (key). That is, each Poly Pressure event has two editable values: the note number and the amount of pressure. Therefore, when Poly Pressure is selected on the “Controller Selection and Functions” pop-up menu, there are two value fields to the left of the controller display, one for the note number and one for the amount.
To add a new Poly Pressure event, proceed as follows:

1. Select Poly Pressure on the “Controller Selection and Functions” pop-up menu.
2. Set the note number by clicking on the keyboard display. The selected note number is displayed in the upper value field to the left of the controller display. Note that this only works for the topmost lane. If you have selected “Poly Pressure” for several controller lanes, you have to type in the desired note number directly in the lower value field to the left of each lane.
3. Use the Pencil tool to add a new event, just as when adding regular controller events.

To view and edit existing Poly Pressure events, proceed as follows:

1. Select Poly Pressure on the “Controller Selection and Functions” pop-up menu.
2. Click on the arrow button next to the note number field to the left of the controller lane. A pop-up menu appears, listing all note numbers for which there already are Poly Pressure events.
3. Select a note number from the pop-up menu. The Poly Pressure events for the selected note number are shown in the controller lane.
4. Use the Pencil tool to edit the events as usual. Press [Alt]/[Option] to edit existing events without adding any new ones.

Poly Pressure events can also be added and edited in the List Editor.

Working with selection ranges

The controller lane editor allows you to perform additional scaling operations for selection ranges on existing controller curves.

- To open the controller lane editor, use the Arrow tool to create a selection rectangle on the controller lane, encompassing the desired controller events.
- For Velocity lanes, press [Alt]/[Option] to get the Arrow tool.
- The controller lane editor is not available for Articulation or Dynamics lanes.
- For Velocity lanes, the editor also opens if you select multiple MIDI notes in the note display.

In the controller lane editor, controls (so called “smart spots”) appear on the borders of the editor. These smart spots allow you to activate a specific editing mode:

<table>
<thead>
<tr>
<th>Editing mode</th>
<th>To activate this mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Vertically</td>
<td>Click in an empty area on the upper border of the editor.</td>
<td>This mode allows you to move the entire curve up or down, which is useful to boost or attenuate an otherwise perfect curve.</td>
</tr>
<tr>
<td>Scale Vertically</td>
<td>Click the smart spot in the middle of the upper border of the editor.</td>
<td>Use this mode to relatively scale the curve, i.e. to raise or lower the values in percent (not by absolute amounts).</td>
</tr>
<tr>
<td>Tilt the left/right part of the curve</td>
<td>Click the smart spot in the upper left/right corner of the editor.</td>
<td>These modes allow you to tilt the left or the right part of the curve, respectively. This is useful if the curve form is exactly the way you want it, but the start or end needs to be boosted or attenuated a bit.</td>
</tr>
<tr>
<td>Compress the left/right part of the curve</td>
<td>[Alt]/[Option]-click the smart spot in the upper left/right corner of the editor.</td>
<td>These modes allow you to compress the left or the right part of the curve.</td>
</tr>
<tr>
<td>Scale Around Absolute Center</td>
<td>Click the smart spot in the middle of the right border of the editor.</td>
<td>This mode allows you to scale the curve around the absolute center, i.e. horizontally around the center of the editor.</td>
</tr>
<tr>
<td>Scale Around Relative Center</td>
<td>[Alt]/[Option]-click the smart spot in the middle of the right border of the editor.</td>
<td>This mode allows you to scale the curve relative to its center.</td>
</tr>
<tr>
<td>Stretch</td>
<td>Click and drag in the lower part of the editor (not available for Velocity lanes).</td>
<td>This allows you to stretch the selected controller events.</td>
</tr>
</tbody>
</table>
If you hold down [Shift] while clicking on any of the smart spots, you get the vertical scaling mode.

- To move the whole selection up/down or left/right, click on a controller event inside the editor and drag the curve. By pressing [Ctrl]/[Command] when clicking and dragging, you can restrict the direction to horizontal or vertical movement, depending on the direction in which you start dragging.

Snap is taken into account when moving controller curves horizontally.

The In-Place Editor

The In-Place Editor makes it possible to edit MIDI parts directly in the Project window, for quick and efficient editing in context with other tracks.

To open the In-Place Editor for one or more selected tracks, you have the following possibilities:

- Select “Open In-Place Editor” on the MIDI menu.
- Use the Edit In-Place key command, by default [Ctrl]/[Command]-[Shift]-[I].
- To open the In-Place Editor for a single MIDI track, click the corresponding Edit In-Place button in the track list (if necessary, expand the track list to display the button).

This expands the MIDI track to show something like a miniature Key Editor, allowing you to edit MIDI notes and controllers.

- Clicking on the gray triangle in the upper right corner of the track list for the edited track brings up a local toolbar with some settings specific to the In-Place Editor.

For descriptions of these settings, see “The toolbar” on page 377.

Just like in the Key Editor, you can edit controller data and articulations at the bottom of the In-Place Editor.

- To add or remove controller lanes, right-click below the controller name field and select an option from the context menu.

When you select a MIDI note, the Project window info line shows information about that note, just like the info line in the Key Editor. You can perform the same editing here as on the Key Editor info line, see “Editing on the info line” on page 386.

- The Snap button and Snap Type pop-up menu on the Project window toolbar govern snapping in the In-Place Editor, but the snap grid is set using the Quantize pop-up menu.

- To close the In-Place Editor for one or several selected tracks, you can use the Edit In-Place key command, by default [Ctrl]/[Command]-[Shift]-[I].

- To close the In-Place Editor for one track, you can click the Edit In-Place button in the track list or double-click below the controller display in the In-Place Editor.

If you have opened the In-Place Editor for multiple parts, you can drag and drop notes between the parts.

- To zoom or scroll the In-Place Editor, point at the left part of the piano keyboard display so that the pointer changes to a hand. Now you can click and drag to the right or left to zoom in or out vertically, and drag up or down to scroll the editor.
The Drum Editor – Overview

The toolbar, status line, info line, and Inspector

These are much the same as the toolbar, status line, info line, and Inspector in the Key Editor (see “The Key Editor – Overview” on page 377), with the following differences:

• The toolbar has a Solo Instrument button that allows you to mute all sounds except the selected one, see “Muting notes and drum sounds” on page 399.

• The Drum Editor has a Drumstick tool (for entering and removing notes) and a Line tool with various line and curve modes (for drawing several notes in one go or editing controller events).

    These tools replace the Pencil tool.

• The pitch in the Mouse Note Position display on the status line shows is shown as a drum sound name rather than a note number.

• The Use Global Quantize button allows you to select which value is used when Snap is activated — the global quantize value on the toolbar or the individual quantize values for the drum sounds.

• There is an Insert Length pop-up menu instead of the Length Quantize pop-up menu.

    It is used in much the same way, as described on the following pages.

• There are no Scissors and Glue Tube tools in the Drum Editor.

• The status line does not contain a chord display.

The drum sound list

The drum sound list lists all drum sounds by name (according to the selected drum map or name list – see below), and lets you adjust and manipulate the drum sound setup in various ways.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch</td>
<td>The actual note number of the drum sound. This is what links notes on a MIDI track to drum sounds. For example, with the GM Map, all MIDI notes with the pitch C1 are mapped to the Bass Drum sound.</td>
</tr>
<tr>
<td>Instrument</td>
<td>The name of the drum sound.</td>
</tr>
<tr>
<td>Quantize</td>
<td>This value is used when entering and editing notes as described in the sections “Creating and editing notes” on page 398 and “Moving, duplicating, or repeating notes” on page 399.</td>
</tr>
</tbody>
</table>
Please note the following:

- The number of columns in the list depends on whether a drum map is selected for the track or not. See “Working with drum maps” on page 400.
- You can reorder the columns by dragging the column headings, and resize them by dragging the dividers between the column headings.

**The note display**

The note display of the Drum Editor displays notes as diamond symbols. The vertical position of the notes corresponds to the drum sound list to the left, while the horizontal position corresponds to the note’s position in time, just as in the Key Editor. Note, however, that the diamond symbols do not indicate the length of the notes. This makes sense, since drum sounds most often are "one-shot" samples that play to their end regardless of the note lengths.

**Drum map and names pop-up menus**

Below the drum sound list there are two pop-up menus, used for selecting a drum map for the edited track or (if no drum map is selected) a list of drum sound names. For an explanation of drum maps, see “Working with drum maps” on page 400.

**Controller display**

The controller display in the Drum Editor is the same as in the Key Editor, see “Using the controller display” on page 388. When you select a line in the drum sound list (to the left of the event display), only the velocity controller events belonging to the note events on this line are displayed in the controller display.

- If you select more than one line in the drum sound list, the controller lane shows all velocity controller events for all notes on the selected lines. This helps you when having to adjust the controller values between different drum sounds.

**Drum Editor operations**

The basic handling (zooming, playback, auditioning, etc.) is the same as in the Key Editor (see “Key Editor operations” on page 380). The following sections describe the procedures and features specific to the Drum Editor.

**Creating and editing notes**

The standard way of entering notes in the Drum Editor is to click with the Drumstick tool.
The position of the created note depends on the following factors:

- If Snap is deactivated on the toolbar, the note appears exactly where you clicked.
  In this mode, notes can be positioned freely.
- If Snap is activated and Use Global Quantize is deactivated on the toolbar, the note snaps to positions according to the quantize value set for the sound in the drum sound list.
  You can set up different quantize values for different drum sounds. You may for example want hi-hat notes snap to sixteenth notes, but snare and bass drum snap to eighth notes.
- If Snap and Use Global Quantize are activated, the note snaps to positions according to the Quantize setting on the toolbar.

The length of the inserted note is determined by the Insert Length setting on the toolbar. However, if this is set to “Drum-Map Link”, the note gets the length of the quantize value for the sound.

- You can quickly audition the drum sounds by clicking in the leftmost column in the drum sound list.
  This plays the corresponding note.
- Clicking with the Drumstick tool on an existing note removes it.
  This makes drum pattern editing very quick and intuitive.

### Selecting notes

Selecting notes is done by any of the following methods:

- Use the Arrow tool.
  The standard selection techniques apply.
- Use the Select submenu on the context menu (see “Selecting notes” on page 383).
- Use the left and right arrow keys on the computer keyboard to step from one note to the next or previous note.
  If you press [Shift] and use the arrow keys, the current selection is kept, allowing you to select several notes.
- You can also press [Shift] and double-click on a note to select all the following notes for the same drum sound.

### Moving, duplicating, or repeating notes

To move or copy notes in the editor (to other positions or other drum sounds), you use the same methods as in the Key Editor: click and drag, use the arrow keys or Edit menu functions, etc. (see “Moving and transposing notes” on page 384). To help you identify the right notes, the drum sound names as defined in the drum map are displayed in the Pitch field in the Drum Editor info line and, when dragging notes in the event display, in the text fields displayed next to the mouse pointer.

There is one other thing to note:

If the moved/copied notes have different quantize values and Snap is activated but Use Global Quantize is deactivated, the largest value determines snapping. For example, if you are moving two notes, with the quantize values 1/16 and 1/4 respectively, the notes snap to quarter notes (1/4).

You can also adjust the position of notes by quantizing (see “Quantizing MIDI and audio” on page 108).

### Muting notes and drum sounds

You can mute individual notes by clicking or enclosing them with the Mute tool or by using the Mute function on the Edit menu (see “Muting notes” on page 386).

Furthermore, if a drum map is selected (see “Selecting a drum map for a track” on page 401), the drum sound list has a Mute column. Click in the Mute column for a drum sound to mute that sound. Clicking the Solo Instrument button mutes all drum sounds other than the selected one.

### Deleting notes

To delete notes, click on them with the Drumstick or Erase tool, or select them and press [Backspace].

⚠️ Please note that the mute state for drum sounds is part of the drum map. Therefore, any other tracks using the same map are also affected.
Working with drum maps

Background
A drum kit in a MIDI instrument is most often a set of different drum sounds with each sound placed on a separate key (i.e. the different sounds are assigned to different MIDI note numbers). One key plays a bass drum sound, another a snare, and so on.

Unfortunately, different MIDI instruments often use different key assignments. This can be troublesome if you have made a drum pattern using one MIDI device, and then want to try it on another. When you switch devices, it is very likely that your snare drum becomes a ride cymbal or your hi-hat becomes a tom, etc. – just because the drum sounds are distributed differently in the two instruments.

To solve this problem and simplify several aspects of MIDI drum kits (like using drum sounds from different instruments in the same “drum kit”), Cubase features so-called drum maps. A drum map is a list of drum sounds, with a number of settings for each sound. When you play back a MIDI track for which you have selected a drum map, the MIDI notes are “filtered” through the drum map before being sent to the MIDI instrument. Among other things, the map determines which MIDI note number is sent out for each drum sound, and so which sound is played in the receiving MIDI device.

A solution to the problem above therefore is to set up drum maps for all your instruments. When you want to try your drum pattern on another instrument, you simply switch to the corresponding drum map and your snare drum sound remains a snare drum sound.

Drum map settings
A drum map consists of settings for 128 drum sounds (one for each MIDI note number). To get an overview of these settings, open the Drum Editor and use the Map pop-up menu below the drum sound list to select the “GM Map” drum map.

This drum map is set up according to the General MIDI standard. For information on how to load, create and select other drum maps, see “Managing drum maps” on page 401.

All settings in a drum map (except the pitch) can be changed directly in the drum sound list (see “The drum sound list” on page 397) or in the Drum Map Setup dialog (see “The Drum Map Setup dialog” on page 402). These changes affect all tracks that use the drum map.

About pitch, I-note, and O-note
This can be a somewhat confusing area, but once you have grasped how it all works it is not very complicated. Going through the following “theory” helps you make the most out of the drum map concept – especially if you want to create your own drum maps.

As mentioned earlier, a drum map is a kind of “filter”, transforming notes according to the settings in the map. It does this transformation twice; once when it receives an incoming note (i.e. when you play a note on your MIDI controller) and once when a note is sent from the program to the MIDI sound device.

In the following example, we have modified the drum map so that the Bass Drum sound has different pitch, I-note, and O-note values.

I-notes (input notes)
When you play a note on your MIDI instrument, the program looks for this note number among the I-notes in the drum map. If you play the note A1, the program finds that this is the I-note of the Bass Drum sound.

This is where the first transformation happens: the note gets a new note number according to the Pitch setting for the drum sound. In our case, the note is transformed to a C1 note, because that is the pitch of the Bass Drum sound. If you record the note, it is recorded as a C1 note.
For example, you may want to place some drum sounds near each other on the keyboard so that they can be easily played together, move sounds so that the most important sounds can be played from a short keyboard, play a sound from a black key instead of a white, and so on. If you never play your drum parts from a MIDI controller (but draw them in the editor) you need not care about the I-note setting.

O-notes (output notes)

The next step is the output. This is what happens when you play back the recorded note, or when the note you play is sent back out to a MIDI instrument in realtime (MIDI Thru):

The program checks the drum map and finds the drum sound with the pitch of the note. In our case, this is a C1 note and the drum sound is the Bass Drum. Before the note is sent to the MIDI output, the second transformation takes place: the note number is changed to that of the O-note for the sound. In our example, the note sent to the MIDI instrument is a B0 note.

The O-note settings let you set things up so that the “Bass Drum” sound really plays a bass drum. If you are using a MIDI instrument in which the bass drum sound is on the C2 key, you set the O-note for the Bass Drum sound to C2. When you switch to another instrument (in which the bass drum is on C1) you want the Bass Drum O-note set to C1. Once you have set up drum maps for all your MIDI instruments, you do not need to care about this anymore – you just select another drum map when you want to use another MIDI instrument for drum sounds.

The Channel and Output settings

You can set separate MIDI channels and/or MIDI outputs for each sound in a drum map. The following rules apply:

• When a drum map is selected for a track, the MIDI channel settings in the drum map override the MIDI channel setting for the track.

In other words, the MIDI channel setting you make in the track list or Inspector for the track is normally disregarded. If you want a drum sound to use the channel of the track, set it to channel “Any” in the drum map.

• If the MIDI output is set to “default” for a sound in a drum map, the sound uses the MIDI output selected for the track.

Selecting any other option allows you to direct the sound to a specific MIDI output.

By making specific MIDI channel and output settings for all sounds in a drum map, you can direct your drum tracks directly to another MIDI instrument simply by selecting another drum map – you do not need to make any channel or output changes for the actual track.

To select the same MIDI channel for all sounds in a drum map, click in the Channel column, press [Ctrl]/[Command] and select the desired channel. All drum sounds are set to this MIDI channel. The same procedure can be used for selecting the same MIDI output for all sounds as well.

It can also be useful to select different channels and/or outputs for different sounds. This allows you to construct drum kits with sounds from several different MIDI devices, etc.

Managing drum maps

Selecting a drum map for a track

To select a drum map for a MIDI track, use the Map pop-up menu in the Inspector or in the Drum Editor.

Selecting “No Drum Map” turns off the drum map functionality in the Drum Editor. Even if you do not use a drum map, you can still separate sounds by name using a name list (see “Using drum name lists” on page 403).

Initially, the Map pop-up menu only contains one map: “GM Map”. However, a number of drum maps are included on the program DVD – how to load these is described below.
**The Drum Map Setup dialog**

To set up and manage your drum maps, select Drum Map Setup from the Map pop-up menu or the MIDI menu. This opens the following dialog:

This is where you load, create, modify, and save drum maps. The list on the left shows the currently loaded drum maps; selecting a drum map in the list displays its sounds and settings on the right.

- The settings for the drum sounds are exactly the same as in the Drum Editor (see “Drum map settings” on page 400). As in the Drum Editor, you can click the leftmost column to audition a drum sound.

- If you audition a sound in the Drum Map Setup dialog and the sound is set to MIDI output “Default”, the output selected on the Output pop-up menu in the lower left corner is used. When auditioning a default output sound in the Drum Editor, the MIDI output selected for the track is used, as described in section “The Channel and Output settings” on page 401.

Open the Functions pop-up menu in the top left corner to open a list of available functionalities:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Map</td>
<td>Click this to add a new drum map to the project. The drum sounds are named “Sound 1, Sound 2”, and so on, and have all parameters set to default values. The map is named “Empty Map”, but you can rename it by clicking and typing in the list.</td>
</tr>
<tr>
<td>New Copy</td>
<td>Adds a copy of the currently selected drum map. This is probably the quickest way to create a new drum map: select the map that is similar to what you want, create a copy, change the desired drum sound settings, and rename the map in the list.</td>
</tr>
<tr>
<td>Load…</td>
<td>Opens a file dialog, allowing you to load drum maps from disk. The Cubase DVD contains a number of drum maps for different MIDI instruments – use this function to load the desired maps into your project.</td>
</tr>
<tr>
<td>Save…</td>
<td>Opens a file dialog for saving the drum map selected in the list. If you have created or modified a drum map, you can use this function to save it as a file on disk – this allows you to load it into other projects. Drum map files have the extension “.drm”.</td>
</tr>
<tr>
<td>Edit head pairs…</td>
<td>Allows you to customize the note pairs, see “Customizing note head pairs” on page 678.</td>
</tr>
<tr>
<td>Init Display Notes</td>
<td>Allows you to reset the Display Notes entry to the original setting, i.e. the Pitch entry.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the dialog.</td>
</tr>
</tbody>
</table>

- Drum maps are saved with the project files. If you have created or modified a drum map, use the Save function to store it as a separate XML file, available for loading into other projects.

- If you always want to have the same drum map(s) included in your projects, you may want to load these into the template – see “Save as Template” on page 51.

**O-Note Conversion**

This function on the MIDI menu goes through the selected MIDI part(s) and sets the actual pitch of each note according to its O-note setting. This is useful if you want to convert a track to a “regular” MIDI track (with no drum map) and still have the notes play back the correct drum sound. A typical application is if you want to export your MIDI recording as a standard MIDI file (see “Exporting and importing standard MIDI files” on page 527) – by first performing an O-Note Conversion you make sure that your drum tracks play back as intended when they are exported.

**Use Head Pairs and Edit in Scores (Cubase only)**

These options are explained in detail in the section “Setting up the drum map” on page 677.
Using drum name lists

Even if no drum map is selected for the edited MIDI track, you can still use the Drum Editor. As previously mentioned, the drum sound list then only has four columns: Audition, Pitch, Instrument (drum sound name), and Quantize. There is no I-note and O-note functionality.

In this mode, the names shown in the Instrument column depend on the selection on the Names pop-up menu, just below the Map pop-up menu in the Drum Editor.

The options on this pop-up menu are the currently loaded drum maps plus a “GM Default” item, which is always available. This means you can use the drum sound names in any loaded drum map without using I-notes and O-notes if you want to.
The List Editor – Overview

The toolbar
The toolbar contains several items that are the same as in the Key Editor. The following toolbar items are unique to the List Editor:

- The Insert Event Type pop-up menu is used when creating new events. This is where you determine what type of event to add (see “Inserting events” on page 405).
- The List Editor contains an additional value display.
- The List Editor has no info line (numerical editing is available in the list instead).

If you see an empty or incomplete list of items although the items are visible in the Key Editor, check if you have activated any filters (see “Filtering” on page 406).

The Filters bar
Similar to the info line and the status line, the Filters bar can be shown/hidden via the “Set up Window Layout” button (see “The status line” on page 378). The Filters bar allows you to hide events from view, based on their type and other properties (see “Filtering” on page 406).

The status line
This is the same as in the Key Editor (see “The status line” on page 378), except for the Current Note Position option, which is not available in the List Editor.

The event list
This lists all events in the selected MIDI part(s), in the order (from top to bottom) in which they are played back. You can edit the event properties by using regular value editing, see “Editing in the list” on page 405.

The event display
This shows the events graphically. The vertical position of an event in the display corresponds to its entry in the list (i.e. to the playback order), while the horizontal position corresponds to its actual position in the project. This is where you add new parts or events, drag to move them, etc.

The value display
This display shows the “value” of each event, allowing for easy viewing and graphical editing. Typically, the value shown is the “Data 2” or “Value 2” property (amounts to MIDI controller events, velocity for notes, etc.).
- To show or hide the value display, click the “Set up Window Layout” button on the toolbar and activate or deactivate the “Value Display” option.
List Editor operations

Customizing the view

You can click and drag the divider between the list and the event display to make one area wider and the other narrower. Furthermore, the list can be customized in the following ways:

- You can change the order of the columns by dragging the column headings.
- You can resize columns by dragging the dividers between the column headings.

Setting the display format

Just like in the Project window, you set the display format (bars+beats, seconds, etc.) by right-clicking in the ruler and selecting an option from the pop-up menu. This setting affects both the ruler and all start, end and length values shown in the list.

Zooming

You can change the horizontal magnification in the event display by using the zoom slider below the display or the Zoom tool (the magnification glass).

Inserting events

To add a new event to the edited part, proceed as follows:

1. Use the Insert Event Type pop-up menu on the toolbar to select the event type.

2. Select the Pencil tool and click in the event display at the desired position (relative to the ruler). If you are creating note events, you can click and drag to set the length of the note.

   The new event appears in the list and in the display. Its properties will be set to default values, but can be adjusted in the list.

- Notes will get the insert velocity value set in the Insert Velocity field on the toolbar, see “Setting velocity values” on page 383.

Editing in the list

The list allows you to perform detailed numerical editing of the events properties. The columns have the following functionality:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>An arrow in this column indicates the event that starts closest before the project cursor position. If you click in this column for an event, the project cursor is moved to the start of that event. Double-clicking moves the cursor position and starts/stops playback – useful for auditioning when editing in the list.</td>
</tr>
<tr>
<td>Type</td>
<td>The event type. This cannot be changed.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the event, shown in the format selected for the ruler. Changing this is the same as moving the event. Note that moving the event past any other event in the list will re-sort the list (the list always shows the events in the order they are played back).</td>
</tr>
<tr>
<td>End</td>
<td>This is only used for note events, allowing you to view and edit the end position of a note (thereby resizing it).</td>
</tr>
<tr>
<td>Length</td>
<td>This is only used for note events. It shows the length of the note – changing this resizes the note and automatically changes the End value as well.</td>
</tr>
<tr>
<td>Data 1</td>
<td>This is the “data 1” or “value 1” property of the event. The content of this depends on the event type – for notes, this is the pitch, for example. Where applicable, the values are shown in the most relevant form. For instance, the Data 1 value for notes is shown as a note number in the format selected in the Preferences dialog (Event Display–MIDI page). For further information, see the table in the section “Editing in the value display” on page 407.</td>
</tr>
<tr>
<td>Data 2</td>
<td>This is the “data 2” or “value 2” property of the event. The content of this depends on the event type – for notes, this is the note-on velocity value, for example. For further information, see the table in the section “Editing in the value display” on page 407.</td>
</tr>
<tr>
<td>Data 3</td>
<td>This is the “data 3” or “value 3” property of the event. This value is only used for note events, where it corresponds with the note-off velocity.</td>
</tr>
<tr>
<td>Channel</td>
<td>The MIDI channel of the event. Note that this setting is normally overridden by the channel setting for the track. To make a MIDI event play back on “its own” channel, set its track to channel “Any” in the Project window.</td>
</tr>
<tr>
<td>Comment</td>
<td>This column is used for some event types only, providing an additional comment about the event.</td>
</tr>
</tbody>
</table>
You can edit several events at once. If several events are selected and you edit a value for one event, the other selected events’ values will be changed as well. Normally, any initial value differences between the events will be maintained – i.e. the values will change by the same amount. If you press [Ctrl]/[Command] when you edit, however, all events will get the same value.

For SysEx (system exclusive) events, you can only edit the position (Start) in the list. However, when you click the Comment column, the MIDI SysEx Editor opens, in which you can perform detailed editing of system exclusive events (see “Working with SysEx messages” on page 407).

When you trim the beginning of a note in the List Editor, the note may move to a different position in the list (since other events may now begin before the edited event).

Editing in the event display
The event display allows you to edit the events graphically using the tools on the toolbar. You can edit single events as well as several selected events simultaneously.

- To move an event, click and drag it to a new position. Note that moving the event past any other event in the display will re-sort the list (the list always shows the events in the order they are played back). As a result, the vertical position of the event in the display will change as well.
- To make a copy of an event, press [Alt]/[Option] and drag it to a new position.
- To resize a note, select it and drag its end point with the Arrow tool as in the Project window. This only works with notes.
- To mute or unmute an event, click on it with the Mute tool. You can mute or unmute several events in one go by enclosing them in a selection rectangle with the Mute tool.
- You can select a color scheme for the events with the Event Colors pop-up menu on the toolbar. This affects how all MIDI events are shown in the MIDI editors, see “Coloring notes and events” on page 382.
- To delete an event, select it and press [Backspace] or [Delete], or click on it with the Erase tool in the event display.

Filtering
The Filters bar is displayed below the toolbar in the List Editor. It contains two sections. On the left, you can find controls for setting up complex filters, and on the right, you can exclude certain event types from being displayed.

- To show or hide the Filters bar, click the “Set up Window Layout” button on the toolbar and activate or deactivate the Filters option.

The Show section (complex filtering)
On the left of the Filters bar, you find the Show pop-up menu. This can be used to filter the event display based on complex criteria. Proceed as follows:

1. Select one or more events that have the desired properties.
2. Pull down the Show pop-up menu and select one of the options.

In the top section, the following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Focus</td>
<td>Select this to deactivate this filtering function.</td>
</tr>
<tr>
<td>Event Types</td>
<td>Only events of the same type as the selected events will be shown. This is the same as activating event types in the Hide section.</td>
</tr>
<tr>
<td>Event Types  and Data 1</td>
<td>Only events of the same type and with the same “Data 1” value will be shown. For example, if a note event is selected, only notes with the same pitch are shown. If a controller event is selected, only controllers of the same type are shown.</td>
</tr>
<tr>
<td>Channels</td>
<td>Only events with the same MIDI channel value as the selected event will be shown.</td>
</tr>
</tbody>
</table>

- Cubase only: In addition to these options, the menu also gives you access to the presets available in the Logical Editor. Using the “Setup...” item, you can directly open the Logical Editor. In this editor, you can create very complex filter settings (see the chapter “The Logical Editor, Transformer, and Input Transformer” on page 440).

When you apply any of the Logical presets or use the Logical Editor to create filter settings yourself, only the events that meet the specified criteria will be visible.
The Hide section (filtering out event types)
The Hide section on the Filters bar allows you to hide specific event types from view. For example, it may be hard to find note events if the part contains a lot of controller data. By hiding the controllers, the list becomes more manageable.

- To hide an event type, activate the corresponding checkbox on the Filters bar.
- To hide all event types except one, press [Ctrl]/[Command] and click the checkbox of the event type you want to view.
  - If you [Ctrl]/[Command]-click again, all checkboxes are cleared.
  - The event types remain hidden even if you hide the Filters bar. To make sure that you see all events, show the Filters bar and verify that all checkboxes are deactivated and that the Show pop-up menu is set to “No Focus”.
  - Filtering events out does not remove, mute, or change the events in any way.

Editing in the value display
The value display to the right of the event display is a tool for quick viewing and editing of multiple values, e.g. velocities or controller amounts. The values are shown as horizontal bars, with the bar length corresponding to the value.

A velocity ramp in the value display
You edit the values by clicking and dragging. Note that the pointer automatically takes on the shape of the Pencil tool when you move it over the value display – you do not have to select the Pencil tool for this.

Exactly which value is shown for an event depends on the event type. The following table shows what is displayed and edited in the Data columns and the value display:

<table>
<thead>
<tr>
<th>Event type</th>
<th>Data 1</th>
<th>Data 2</th>
<th>Value display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>Pitch</td>
<td>Note-on</td>
<td>Velocity</td>
</tr>
<tr>
<td></td>
<td>(note number)</td>
<td>velocity</td>
<td></td>
</tr>
<tr>
<td>Controller</td>
<td>Controller type</td>
<td>Controller amount</td>
<td>Controller amount</td>
</tr>
<tr>
<td>Program Change</td>
<td>Program number</td>
<td>Not used</td>
<td>Program number</td>
</tr>
<tr>
<td>Aftertouch</td>
<td>Aftertouch amount</td>
<td>Not used</td>
<td>Aftertouch amount</td>
</tr>
<tr>
<td>Pitchbend</td>
<td>Bend amount</td>
<td>Not used</td>
<td>Bend amount</td>
</tr>
<tr>
<td>SysEx</td>
<td>Not used</td>
<td>Not used</td>
<td>Not used</td>
</tr>
</tbody>
</table>

- For note events there will also be a value in the Data 3 column, which is used for note-off velocity.
- Note that for SMF and text events no values are displayed.

Working with SysEx messages
SysEx (System Exclusive) messages are model-specific messages for setting various parameters of a MIDI device. This makes it possible to address device parameters that would not be available via normal MIDI syntax.

Every major MIDI manufacturer has its own SysEx identity code. SysEx messages are typically used for transmitting patch data, i.e. the numbers that make up the settings of one or more sounds in a MIDI instrument.

Cubase allows you to record and manipulate SysEx data in various ways. The following sections point to various features that help you manage and create SysEx data.

To learn about the possibilities of the MIDI Device Manager for controlling your device, see the chapter “Using MIDI devices” on page 356.

Bulk dumps
Recording a bulk dump in Cubase
In any programmable device, the settings are stored as numbers in computer memory. Change those numbers, and you will change the settings.
Normally, MIDI devices allow you to dump (transmit) all or some settings in the device’s memory in the form of MIDI SysEx messages. A dump is therefore (among other things) a way of making backup copies of the settings of your instrument: sending such a dump back to the MIDI device will restore the settings.

If your instrument allows the dumping of a few or all of its settings via MIDI by activating some function on the front panel, this dump will probably be recordable in Cubase.

1. Open the Preferences dialog from the File menu (on the Mac, this is located on the Cubase menu) and select the MIDI–MIDI Filter page. This allows you to govern which MIDI event types are recorded and/or thru-put.

2. Make sure that recording of SysEx data is not filtered, by deactivating the SysEx checkbox in the Record section. The SysEx checkbox in the Thru section can be left as it is (by default activated).

3. This way, SysEx messages will be recorded but not echoed back out to the instrument (which might lead to unpredictable results).

4. Activate recording on a MIDI track and initiate the dump from the front panel of the instrument.

5. When done recording, select the new part and open the List Editor from the MIDI menu. This allows you to check that the SysEx dump was recorded – there should be one or several SysEx events in the part/event list.

6. If your MIDI instrument does not offer a way to initiate a dump “by itself”, you have to send a Dump Request message from Cubase to start the dump. In that case, use the MIDI SysEx Editor (see “Editing SysEx messages” on page 409) to insert the specific Dump Request message (see the instrument’s documentation) at the beginning of a MIDI track. When you activate recording, the Dump Request message will be played back (sent to the instrument), the dump will start and be recorded as above.

Transmitting a bulk dump back to a device

1. Make sure that the MIDI track with the System Exclusive data is routed to the device. You may want to check your device’s documentation to find details about which MIDI channel should be used, etc.

2. Solo the track. This might not be necessary, but it is a good safety measure.

3. Make sure that the device is set up to receive SysEx messages (often, receiving SysEx is turned off by default).

4. If necessary, put the device in “Standby to Receive System Exclusive” mode.

5. Play back the data.

Some advice

• Do not transmit more data than you need. If all you want is a single program, do not send them all, it will only make it harder to find the one you want. Usually, you can specify exactly what you want to send.

• If you want the sequencer to dump the pertinent sounds to your instrument each time you load a project, put the SysEx data in a silent “count-in” before the project itself starts.
The MIDI editors

• If the dump is very short (for instance, a single sound) you can put it in the middle of the project to re-program a device on the fly. However, you can achieve the same effect by using Program Change. This is definitely preferable, since less MIDI data is sent and recorded. Some devices may be set up to dump the settings for a sound as soon as you select it on the front panel.

• If you create parts with useful SysEx dumps, you can put these on a special muted track. When you want to use one of them, drag it to an empty unmuted track and play it back from there.

• Do not transmit several SysEx dumps to several instruments at the same time.

• Make a note of the current device ID setting of the instrument. If you change this, the instrument may refuse to load the dump later.

Recording SysEx parameter changes

Often you can use SysEx to remotely change individual settings in a device, e.g. open a filter, select a waveform, change the decay of the reverb, etc. Many devices are also capable of transmitting changes made on the front panel as SysEx messages. These can be recorded in Cubase, and thus incorporated into a regular MIDI recording.

Here’s how it works: let’s say you open up a filter while playing some notes. In that case, you will record both the notes and the SysEx messages generated when you opened the filter. When you play it back, the sound changes exactly like it did when you recorded it.

1. Open the Preferences dialog from the File menu, select the MIDI–MIDI Filter page and make sure that SysEx is recorded, i.e. the SysEx checkbox in the Record section is deactivated.

2. Make sure that the instrument is actually set to transmit changes of front panel controls as SysEx messages.

3. Record normally.

When you are done, you can check in the List Editor that the events were recorded properly.

Editing SysEx messages

While SysEx events are shown in the List Editor/Project Browser (Cubase only), their entire content is not (only the beginning of the message is displayed in the Comment column for the event). Also, you cannot edit the event (other than moving it) as you can with other event types in the List Editor.

Instead, you have to use the MIDI SysEx Editor for this.

• To open the MIDI SysEx Editor for an event, click in the Comments column for the event in the List Editor/Project Browser.

The display shows the entire message on one or several lines. SysEx messages always begin with F0 and end with F7 with a number of arbitrary bytes in between. If the message contains more bytes than fit on one line, it continues on the next. The Address indication to the left helps you find out on which position in the message a certain value resides.

You can edit all values except for the first (F0) and last one (F7).

Selecting and viewing values

To select a value, either click on it or use the cursor keys. The selected byte is displayed in various formats:

• In the main display, values are shown in hexadecimal format.

• To the right of this, values are shown in ASCII format.

• At the bottom of the dialog, the selected value is shown in ASCII, binary, and decimal formats.
Editing a value
The selected value can be edited directly in the main display or in the ASCII, decimal, and binary displays. Just click on it and type in the desired value as usual.

Adding and deleting bytes
Using the Insert and Delete buttons or their corresponding computer keyboard keys, you can add and delete bytes from the message. Inserted data will appear before the selection.

- To delete the complete SysEx message, select it in the List Editor and press [Delete] or [Backspace].

Importing and exporting data
The Import and Export buttons allow you to get SysEx data from disk and to export the edited data to a file. The file has to be in “MIDI SysEx” (.SYX) binary format. Only the first dump in a SYX file will be loaded.

☞ Do not confuse this format with MIDI files, which have the extension .mid.
The basic Score Editor – Overview

This section describes the basic Score Editor, which is available in Cubase Artist. The full-featured version of the Score Editor that is available in Cubase is described in detail in “Part II: Score layout and printing (Cubase only)” on page 550.

The Score Editor shows MIDI notes as a musical score.

The toolbar

The Score Editor toolbar is similar to the toolbar in the Key Editor, but tailored to working with scores:

- There are an Insert Note tool and an Insert Text tool instead of the Pencil, Trim, Mute, Zoom, and Line tools.
- Parts on different tracks are shown on different staves. Therefore there are no part controls.
- There are only two Snap types: Grid and Grid Relative.
- The Independent Track Loop, Auto-Select Controllers, and Indicate Transpositions buttons, as well as the Nudge palette and Event Colors pop-up menu are not available.

The status line

The status line features the Mouse Time Position, the Mouse Note Position, and the Current Chord displays. Unlike in the Key Editor, you need to select the notes making up the chord to make it appear in the Current Chord Display.

- To show or hide the status line, click the “Set up Window Layout” button and activate or deactivate the “Status Line” option.

The info line

The info line shows information about selected MIDI notes, just like in the Key and Drum Editors. You can edit all values on the info line using regular value editing (see “Editing on the info line” on page 386 for details).

- To configure which items are available on the info line, right-click the info line and select “Setup…” from the context menu.
- In the dialog that appears you can configure where the separate items will be placed and save/recall different setup configurations.
- To show or hide the info line, click the “Set up Window Layout” button and activate or deactivate the “Info Line” option.
The extended toolbar

- To show or hide the extended toolbar, click the “Set up Window Layout” button and activate or deactivate the Tools option.

Note value buttons

Click one of these to select a note value for input. The “T” and “.” options are for triplet and dotted note values. You can also press [Ctrl]/[Command] and click one of the note value buttons – this will resize all selected notes to the note value you choose.

Enharmonic Shift

Allows you to manually select whether a note is shown with flat or sharp accidentals, see “Enharmonic Shift” on page 417.

The score display

The main area of the Score Editor window shows the notes in the edited parts on one or several staves.

- If you are editing one or several parts on the same track, as much of them as possible is shown on several staves – one above the other – just as with a score on paper.
- If you are editing parts on several tracks, they are put on a grand staff (multiple staves, tied together by bar lines).
- The number of bars across the screen depends on the size of the window and the number of notes in each bar. The maximum number of bars across the page is four.
- The end of the last part is indicated by a double bar line.
- Unlike the other MIDI editors, the Score Editor does not have a ruler.

A conventional ruler would not make sense, since there is no exact relationship between a note’s horizontal position in the score and its musical position in the project.

Score Editor operations

Opening the Score Editor

To open one or several parts in the Score Editor, select one or several tracks or any number of parts (on the same or different tracks), and select “Open Score Editor” from the Scores submenu of the MIDI menu. The default key command for this is [Ctrl]/[Command]-[R].

- You can also select the Score Editor as your default editor, allowing you to open it by double-clicking parts. This is done with the Default Edit Action pop-up menu in the Preferences dialog (Event Display–MIDI page).

About editing parts on different tracks

If you have selected parts on two or more tracks and open the Score Editor, you will get one staff for each track (although you can split a staff in two, e.g. when scoring for piano). The staves are tied together by bar lines and placed in the order of the tracks in the Project window.

- If you need to rearrange the staves: close the editor, go back into the Project window, drag the tracks to the order you want them, and open the Score Editor again.

The active staff

Just as in the other editors, all MIDI input (as when recording from your instrument) is directed to one of the tracks, here called the active staff. The active staff is indicated by a blue rectangle to the left of the clef symbol.

- To change the active staff, click on the staff you want to activate.
Getting the score displayed correctly
When you open the Score Editor for a part recorded in real time, the score may not look as legible as you expect. The Score Editor can ignore the minor time variances in performance and make a neater score almost instantly. To achieve this, there are a number of Staff Settings that determine how the program displays the music.

Note that the time signature follows the time signature(s) set in the Tempo Track Editor, and that these settings are common to all tracks/staves in the score.

There are two ways to open the Staff Settings dialog:
• Double-click in the area to the left of the staff.
• Activate a staff by clicking in it, and select “Staff Settings…” from the Scores submenu of the MIDI menu. The Staff Settings dialog appears.

Staff Mode
This pop-up menu determines how the staff is shown:
• When set to “Single”, all notes in the part are shown in the same staff.
• When set to “Split”, the part is split on the screen into a bass and treble clef, as in a piano score.

You use the Split-Point value field to set the note where you want the split to occur. Notes above and including the split note will appear on the upper staff, and notes below the split note will appear on the lower staff.

Before and after setting a split at C3.

Display Quantize
Notes are not an absolute language, and you must give the program a few hints on how you want the score to be displayed. This is done using the Display Quantize section of the Staff Settings dialog.

These are only display values used for the graphics in the Score Editor. They do not affect the actual playback in any way.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>Determines the smallest note value to be displayed and the “smallest position” to be recognized and properly displayed. Set this to the smallest significant note position used in your music. For example, if you have notes on odd sixteenth note positions, set this value to 16. The “T” values are for triplet note values. This setting is partly overridden by Auto Quantize (see below).</td>
</tr>
<tr>
<td>Rests</td>
<td>This value is used as a “recommendation” – the program will not display rests smaller than this value, except where necessary. In effect, this setting also determines how the length of notes is displayed. Set this value according to the smallest note value (length) you want to be displayed for a single note, positioned on a beat.</td>
</tr>
</tbody>
</table>
The correct Clef and Key are set using the two scroll bars in the Clef/Key section.

If you activate the “Auto Clef” checkbox, the program attempts to guess the correct clef, judging from the pitch of the music.

- To set the clef and key for the lower staff, activate the “Lower Staff” checkbox in the Clef/Key section.

Display Transpose

Some instruments, for example a lot of brass instruments, are scored transposed. For this purpose, the Staff Settings dialog allows you to specify a separate Display Transpose setting for each staff (track). This transposes the notes in the score (i.e. how they are displayed) without affecting how the notes play back. This allows you to record and play back a multi staff arrangement, and still score each instrument according to its own transposition.

- Use the pop-up menu to select the instrument for which you are scoring.
You can also manually set a display transpose value with the Semitones box above.

Interpretation Options

These provide additional options for how the score is displayed:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean Lengths</td>
<td>When this is activated, notes that are considered to be chords will be shown with identical lengths. This is done by showing the longer notes as shorter than they are. When Clean Lengths is turned on, notes with very short overlaps are also cut off; a bit as with No Overlap (see below), but with a more subtle effect.</td>
</tr>
<tr>
<td>No Overlap</td>
<td>When this is activated one note will never be shown as overlapping another, lengthwise. This allows long and short notes starting at the same point to be displayed without ties; the long notes are cut off in the display. This will make the music more legible. An example measure with No Overlap deactivated… and with No Overlap activated.</td>
</tr>
<tr>
<td>Syncopation</td>
<td>When this function is activated, syncopated notes are shown in a more legible way. This is a dotted quarter at the end of a bar when Syncopation is Off… and when it is On.</td>
</tr>
<tr>
<td>Shuffle</td>
<td>Activate this function when you have played a shuffle beat and want it displayed as straight notes (not triplets). This is very common in jazz notation.</td>
</tr>
</tbody>
</table>
Applying your settings

After you have made your settings, click Apply to apply them to the active staff. You can select another staff in the score and make settings for that, without having to close the Staff Settings dialog first – just remember to click Apply before you change staff, otherwise your changes will be lost.

Entering notes with the mouse

To enter notes into a part in the Score Editor, you use the Note tool. However, first you need to set the note value (length) and spacing:

Selecting a note value for input

This can be done in two ways:
• By clicking the note symbols on the extended toolbar. You can select any note value from 1/1 to 1/64th and turn on and off the dotted and triplet options by clicking the two buttons to the right. The selected note value is displayed in the Length value field on the toolbar and in the Note tool cursor shape.
• By selecting an option from the Length Quantize pop-up menu on the toolbar.

Selecting a Quantize value

When you move the mouse pointer over the score, you will see that the Mouse Time Position field on the status line tracks your movement and shows the current position in bars, beats, sixteenth notes, and ticks.

Positioning on screen is controlled by the current Quantize value. If you set this to 1/8, you can only insert and move notes to eighth note positions, at quarter notes, at half bars or at bar positions. It is a good strategy to set the Quantize value to the smallest note value in the piece. This does not stop you from inputting notes at “coarser” positions. However, if you set the Quantize value to too small a note value, it is easier to make mistakes.

With the Quantize value set to 1/8, you can only input notes at eighth note positions.

The Quantize value is set with the Quantize pop-up menu on the toolbar.

• You can also assign key commands to the different Quantize values. This is done in the Key Commands dialog, in the “MIDI Quantize” category.
• Just like in the other MIDI editors, you can use the Quantize Panel to create other quantize values, irregular grids, etc. However, this is not often used when entering score notes.

Entering a note

To add a note to the score, proceed as follows:
1. Make the staff active. Notes are always put in on the active staff.
2. Select the type of note by selecting a note value. This is described in detail above.
3. On the toolbar, select the Note tool. If you selected the note value by clicking on a symbol on the extended toolbar, the Note tool gets automatically selected.
4. Select a Quantize value.
5. Move the mouse over the staff to find the correct position. Check the Mouse Time Position display on the status line — the position is “magnetically” attracted to the grid defined by the current Quantize value. This allows you to easily find the correct position.
6. Move the mouse vertically to find the correct pitch. The Mouse Note Position display on the status line shows the pitch at the pointer position, making it easy to find the right pitch.
7. Click in the staff. The note appears in the score.

The notes you enter will get the insert velocity value set in the Insert Velocity field on the toolbar, see “Setting velocity values” on page 383.

If the notes you enter, appear to have the wrong note value (e.g. you enter a 1/32 note that is displayed as a 1/16 note), you may have to adjust the Display Quantize settings, see “Display Quantize” on page 413.

Selecting notes

There are several ways to select notes in the Score Editor:

By clicking
To select a note, click on its note head with the Arrow tool. The note head gets red to indicate that it is selected.
- To select more notes, hold down [Shift] and click on them.
- To deselect notes, hold [Shift] down and click on them again.
- If you hold down [Shift] and double-click on a note, this note and all the following notes in the same staff are selected.

**Using a selection rectangle**

1. Press the mouse button with the Arrow tool in some free (white) space in the score.
2. Drag the mouse pointer to create a selection rectangle. You can drag to select notes on several voices or staves if you wish.
3. Release the mouse button. All notes with their note heads inside the rectangle get selected.
- If you want to deselect one or more of the notes, hold down [Shift] and click as described above.

**Using the keyboard**

By default, you can step through the notes in the staff using the left and right arrow keys. If you press [Shift], you will select the notes as you step through them.
- If you want to use other keys for selecting notes, you can customize the settings in the Key Commands dialog (in the Navigate category).

**Deselecting everything**

- To deselect everything, simply click with the Arrow tool in some “free” (white) space in the score.

**Deleting notes**

Notes can be deleted in two ways:

**Using the Erase tool**

1. Select the Erase tool from the toolbar or context menu.
2. One at a time, click on the note(s) you want to erase, or drag over them with the mouse button pressed.

**Using the keyboard or delete menu item**

1. Select the note(s) you want to delete.
2. Select Delete from the Edit menu, or press [Delete] or [Backspace] on the computer keyboard.

**Moving notes**

To move or transpose notes, proceed as follows:

1. Set the Quantize value.
2. If you want to hear the pitch of the note while moving, activate the Acoustic Feedback button (speaker icon) on the toolbar. When it is on, you will hear the current pitch of the “dragged” note.
3. Select the notes that you want to move.
4. Click one of the selected notes and drag it to a new position and/or pitch. The horizontal movement of the note is “magnetically attracted” to the current Quantize value. The position boxes on the toolbar show what the new position and pitch for the dragged note will be.
5. Release the mouse. The notes appear at their new position.
- If you hold [Ctrl]/[Command] and drag, movement is restricted to vertical or horizontal (depending on the direction in which you drag).
- You can also move selected notes by using key commands, as assigned in the Nudge category in the Key Commands dialog. When moving notes to the left or right using key commands, the notes will be moved in steps according to the current Quantize value. The keys assigned for up/down nudging will transpose notes in semitone steps.

**Duplicating notes**

1. Set the Quantize value and select the notes, as for moving.
2. Hold down [Alt]/[Option] and drag the notes to their new position.
- If you want to restrict movements to one direction, press [Ctrl]/[Command]. This works just as for moving, as described above.
- [Alt]/[Option] is the default modifier key for copying/duplicating. If you like, you can change this in the Preferences dialog (Editing–Tool Modifiers page). The entry for this is found in the Drag & Drop category ("Copy").
Changing the length of notes

As described earlier (see "Getting the score displayed correctly" on page 413), the displayed length of a note is not necessarily the actual note length, but also depends on the Notes and Rests values for Display Quantize in the Staff Settings dialog. This is important to remember when you change the length of a note, since it can lead to confusing results.

There are several ways to change the length of a note in the Score Editor:

By using the note value icons on the extended toolbar

Using the extended toolbar is another quick way to set a number of notes to the same length:

1. Select the notes you want to change.
2. Hold down [Ctrl]/[Command] and click on one of the note icons on the extended toolbar.
   All the selected notes are now given the length of the clicked note.

By using the info line

You can also edit length values numerically on the info line, just like in the Key and Drum Editors (see "Editing on the info line" on page 386).

Splitting and gluing notes

- If you have two notes strung together by a tie and click on the “tied” note head with the Scissors tool, the note will be divided into two, with the respective length of the “main” and the tied note.
- Conversely, if you click on a note with the Glue Tube tool it will be joined to the next note with the same pitch.

Enharmonic Shift

The buttons to the right on the extended toolbar allow you to shift the display of selected notes so that for example an F# (F sharp) is instead shown as a Gb (G flat) and vice versa:

1. Select the note(s) you want to affect.
2. Click on one of the buttons to display the selected note(s) a certain way.

The “off” button resets the notes to original display. The other five options are double flats, flats, No (no accidentals shown, regardless of pitch), sharps and double sharps.

Flip Stems

Normally the direction of the note stems is automatically selected according to the note pitches, but you can change this manually if you like:

1. Select the notes for which you want to change (flip) the stem direction.
2. Pull down the MIDI menu and select Flip Stems from the Scores submenu.

Working with text

You can use the Text tool to add comments, articulation or instrumentation advice and other text strings anywhere in the score:

Adding a text string

1. On the toolbar, select the Text tool.
2. Click anywhere in the score.
   A blinking cursor appears, indicating that you can enter text.
3. Enter the text and press [Return].

Editing text

To edit an already added text string, double-click it with the Arrow tool. This opens the text for editing, and you can use the arrow keys to move the cursor, delete characters with the [Delete] or [Backspace] keys and type new text as usual. Finish by pressing [Return].
• To delete a text block, select it with the Arrow tool and press [Backspace] or [Delete].

• You can move or duplicate text blocks by dragging (or [Alt]/[Option]-dragging) them, just as with notes.

Changing the text font, size and style

To change the font settings for the text you have added, proceed as follows:

1. Select the text by clicking it with the Arrow tool.

2. Pull down the MIDI menu and select “Set Font…” from the Scores submenu.

The Font Settings dialog appears, containing the following settings:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>This is where you specify the font for the text. Which fonts are available on the pop-up menu depends on the fonts you have installed on your computer. You probably do not want to use the “Steinberg” fonts – these are special fonts used by the program (e.g. for score symbols) and not suited for common text.</td>
</tr>
<tr>
<td>Size</td>
<td>Sets the size of the text.</td>
</tr>
<tr>
<td>Frame</td>
<td>Allows you to encase the text in a rectangular (box) or oval frame.</td>
</tr>
<tr>
<td>Font options</td>
<td>These checkboxes determine whether the text is formatted bold, italic, and/or underlined.</td>
</tr>
</tbody>
</table>

3. When you have made your settings, click Apply.

If you like, you can leave the Font Settings dialog open, select another text block and adjust the settings for that – just remember to click Apply before you select a new text block.

• If you make settings in the Font Settings dialog with no text selected, the settings will be used as default for all new text.

In other words, all text you enter from then on will get the settings you have specified (although you can of course change this manually for each text as usual).

Printing

To print your score, proceed as follows:

1. Open the parts you want to print in the Score Editor. Printing is only available from within the Score Editor.

2. Select “Page Setup…” from the File menu and make sure all your printer settings are correct. Close the dialog.

⚠️ If you change your setting for paper size, scale and margins now, the score may change its look.
Expression maps (Cubase only)
Introduction

About articulations
Musical articulations, or expressions, define how certain notes “sound”, i.e. how they are sung or performed on a given instrument. They allow you to specify that a string instrument is bowed (not plucked), a trumpet muted (not played open), and so on. Articulations also define the relative volume of notes (to play some notes louder or softer than the others) or changes in pitch (create a tremolo).

Articulations can be divided into “Directions” and “Attributes”.

• Directions are valid for all notes from the insert position on, until another direction is scored. This means, they are applied not to single notes, but to a continuous range of notes, or even an entire piece of music.

An example for a direction is pizzicato, which means that the string instrument is plucked.

• Attributes belong to single notes. They are only applied to the notes for which they are scored.

Examples for this are accents, where a note is played with an emphasis, and staccato, where a note is played shorter.

Articulations and MIDI

When working with MIDI, i.e. when you are entering notes via a MIDI keyboard, editing notes in the MIDI editors or using VST instruments, articulations need to be realized as different sounds. To trigger the necessary sound changes, use the following command and data types:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Channel</td>
<td>Program Change messages can be used to instruct a connected VST instrument to switch from one program to another. Depending on the instrument, this can be used to play a different articulation.</td>
</tr>
</tbody>
</table>

Expression maps

When working on a project, you might want to audition a composition including articulations. In Cubase, this can be achieved using expression maps, which can be selected via the Expression Map section in the Inspector for MIDI or instrument tracks. Within these maps, you can specify the sound mapping and characteristics for all your musical expressions, using the methods described in the table above.

When you select an expression map for a MIDI or instrument track, the articulations (sounds) defined in the map are automatically applied during playback. Cubase recognizes the expressions scored for the MIDI part and searches the sound slots in the expression map for a sound that matches the defined criteria.

When a matching sound slot is found, the current note is either modified (e.g. reduced in length or played louder), or the MIDI channel, program change or key switch information is sent to the connected instrument (the instrument selected on the Output Routing pop-up menu for the track), so that a different sound is played. When no sound slot is found that matches the articulations used in the part, the “closest match” is used, see “Groups” on page 426.

When you enter articulations in a MIDI part, you need to set up an expression map in a way that the right sounds in the connected VST or MIDI instrument are triggered (see “Creating and editing expression maps” on page 424).

Expression maps also allow you to link your articulations with remote keys on a MIDI input device and map these to sounds that can be played by a MIDI device or VST instrument. This way, you can enter notes and articulations using a remote MIDI device and have these automatically be recorded and played back correctly by Cubase.

Expression maps are useful in the following situations:

• When you want to enter musical articulations directly in one of the MIDI editors, especially the Score Editor, without having to record MIDI data first.

Expression maps (Cubase only)
• When you want to play/record music in realtime and control articulation changes while playing.
• When you open and edit projects from other users. By using expression maps, you can map the articulation information to a different instrument set or content library quickly and easily.

⇒ You can also use the Note Expression functions to add articulations directly on your MIDI notes in the Key Editor. This is described in detail in the chapter “Note Expression (Cubase only)” on page 428.

Using expression maps in Cubase
Expression maps and their related functions can be found in different locations in Cubase. To be able to use these functions, an expression map or a track preset containing such a map has to be loaded.

Loading expression maps
Expression maps can either be part of track or VST presets, or be saved separately. Depending on this, the way to make them available in Cubase is slightly different.

Loading expression maps that are part of presets
Cubase comes with a set of predefined expression maps which are part of the default presets. They are loaded automatically with the presets. Track presets are described in detail in the chapter “Working with track presets” on page 331.

The following applies:
• Included with Cubase are several track presets which are pre-configured for use with expression maps. They contain sounds that make use of key switches and have different articulations. To indicate that these presets can be used in this context, they have the suffix "VX".
• Track presets for HALion Symphonic Orchestra can also be used with expression maps. The presets are installed automatically with Cubase. However, for them to be available, you have to separately install the VST instrument. These Track Presets begin with "HSO" and end with "VX".

Expression maps that were saved separately
You can also define your own expression maps, see “Creating and editing expression maps” on page 424. To load these, proceed as follows:

1. In the Inspector for the selected track, select the Expression Map section, open the pop-up menu and select “Expression Map Setup….”.
   The Expression Map Setup window opens.
⇒ If the Expression Map section is not shown in the Inspector, right-click on another Inspector section and select “Expression Map” from the context menu.
2. In the Expression Maps section on the left, click the Load button.
   A file dialog appears.
3. Locate and select an expression map and click Open.
   The expression map is added to the Maps list.
4. Repeat the steps for all the maps that you want to make available, and close the dialog.

All loaded maps are available on the Expression Map pop-up menu in the Inspector.
Expression maps in the Project window

In the Inspector for MIDI and instrument tracks, the Expression Map section is available. This indicates whether an expression map is used for a track. It also shows the sound slots that are active for playback and for realtime input.

The possibility to monitor the active slots is especially useful when recording articulations with an external device, such as a MIDI keyboard. This way, you can see whether the correct sound slot, i.e. the right articulation, is used.

Expression maps in the Score Editor

In the Score Editor, the articulations that are part of an expression map can be inserted like other symbols. There is a special tab in the Symbols Inspector, containing all articulation symbols of the current expression map.

• To insert a symbol, click on it in the Expression Map tab, and click at the desired position in the note display.
• To delete an articulation symbol from the score, select it and press [Delete] or [Backspace].

In the Preferences dialog (Score–Colors for Additional Meanings page), you can specify a color for Expression Map symbols. This way, you can easily distinguish them from other Score symbols.

Articulation editing in the Score Editor is the same as regular symbol editing, see the chapter “Working with symbols” on page 618.

⚠️ In the Score Editor, it is possible to insert symbols for a single note that in fact cannot be combined in a musically meaningful way. So when entering articulations, make sure that they do not conflict with other articulations.

Expression maps in the Key, Drum, and In-Place Editors

If an expression map is used for a MIDI or instrument track, its articulations are shown in the note events in the Key Editor display, provided that the vertical zoom factor is high enough. If the horizontal zoom factor is high enough, the attribute description (the text in the Description column, see “Editing Articulations” on page 425) is also shown.

You can insert and edit articulations in the Key, Drum, and In-Place Editors using the controller lane. This is much like regular controller lane editing (see “Using the controller display” on page 388).

• To display the articulations set up in the selected expression map, open the pop-up menu to the left of the lane and select “Articulations/Dynamics”.

Dynamics are described in detail in the section “Editing dynamics (Cubase only)” on page 394.

• When “Articulations/Dynamics” is selected for a controller lane, the note beginnings are displayed as thin vertical lines in the controller display.
• All articulations that are specified for the selected expression map are available on the controller lane. They appear on different rows one above the other. The order in which they are listed is the same as in the expression map. The different groups (1 to 4) are also reflected here, see “Groups” on page 426. They are separated by black lines. Articulations belonging to the same group are shown in the same color.

• Directions are displayed as bars in the controller lane. They begin at the insertion point of a direction and end at the insertion point of the next articulation from the same group (or at the end of the part if no more directions follow). Attributes are inserted at the note beginning. You can assign a maximum of one attribute per group to each note.

Editing on the controller lane

• To insert new directions on the controller lane, select the Pencil tool and click at the desired position in the respective row, i.e. where you want the direction to start. Note that you have to click at the exact position of the first note that you want to apply this articulation to or to the left of it.

• To insert new attributes on the controller lane, select the Pencil tool and click at the respective note line in the corresponding row of the controller lane. Instead of selecting the Pencil tool, you can also hold down [Alt]/[Option] and click at the desired position.

• To remove a direction, click on it with the Eraser tool or select it and press [Delete] or [Backspace].

• To remove an attribute, click on it with the Pencil tool. Note that you cannot select attributes in the controller lane without automatically selecting the corresponding note, too. Therefore, you cannot delete an attribute by selecting it and pressing [Delete] or [Backspace] without deleting the note as well.

If several notes are selected, you can use the Pencil tool to insert or delete attributes for all of them in one go.

Editing on the info line

When a MIDI note is selected in the note display, the info line contains the “Articulations” option. This displays the note attributes (symbols) specified for the selected note. Click in this section to open the Articulations pop-up menu. The following applies:

• All note attributes available in the expression map are shown on the pop-up menu, sorted by group (see “Groups” on page 426).

• To add an attribute to a note, simply select it on the pop-up menu. Attributes that are active for a note are indicated on the menu.

• If you click on an active attribute again on the menu, it is deleted.

• If you select another attribute from the same group for a note, the attribute replaces the previous attribute.

Expression maps in the List Editor

In the List Editor, the Articulations can be viewed and edited in the Comment column. The options are the same as on the Key Editor info line, see above.

Directions can be shown either as Text or as Graphic Symbols (like in the Score Editor). Either way, they are followed by the text “VST Expression” in brackets, so as to be easily recognizable and distinguishable from ordinary Score symbols.
Creating and editing expression maps

Creating expression maps based on the key switches used in an instrument

You can automatically extract mapping information from your connected VST instruments and convert it into a new expression map. This makes it very easy to set up expression maps for the instruments you often work with.

Proceed as follows:

1. Load the VST instrument you want to use and assign it to a MIDI or instrument track.
2. Select the track, open the Expression Map section in the Inspector, and select “Import Key Switches” on the pop-up menu. Note that this menu option will only be available when the loaded program contains key switches. The Expression Map Setup window opens.
3. Make the desired settings for the created map (see “Creating an expression map from scratch” on page 424) and click the Save button.

The expression map is saved and can now be loaded via the pop-up menu on the Expression Map section of the Inspector.

Creating an expression map from scratch

Proceed as follows:

1. In the Inspector for a MIDI or instrument track, open the Expression Map section, open the pop-up menu and select “Expression Map Setup…”.

The Expression Map Setup window opens, allowing you to load and create expression maps.

- You can also open the Expression Map Setup window by selecting the “Expression Map Setup…” option on the MIDI menu.

2. To create a new map from scratch, click the “+” button at the top of the Maps list in the Expression Maps section of the dialog.

A new map named “Untitled” is shown in the Expression Maps section.

3. Click on the map name and enter a meaningful name (e.g. “Cello” to set up an expression map for a cello).

Adding sound slots

Now, you create one sound slot for each articulation that you want to add. Proceed as follows:

1. In the Sound Slots section to the right of the Maps list, a sound slot is added automatically when a new map is created.

This is the default slot that is used. You can specify an articulation for it or leave it empty, depending on your preferred default setting.

2. Click in the first Articulation column (Art. 1) for the sound slot and select an articulation from the menu.

A new entry is added in the Articulations section in the lower right corner of the window.

3. When adding articulations, the name of the sound slot is automatically set to the articulation. To change the name, click in the name field and enter a new name.

The names of the sound slots are displayed in the Inspector for the track, see “Expression maps in the Project window” on page 422.
4. To create a complex articulation, made of several different single articulations, click in the other Articulation columns (Art. 2-4) for the sound slot and add the corresponding articulations.

For each new articulation, an additional entry is added in the Articulations section.

• Apart from creating combined articulations, the Articulation columns also allow you to prioritize articulations, by sorting them into different groups.

When the program is looking for sounds and no exact match is found, the group setting defines the “closest match”, i.e. the sound which matches most criteria when searching from left to right is used. For example, if two sounds are found which have the same articulation in group 1, the sound that also matches group 2 is preferred and so on. For more information on groups, see below.

• If you cannot find the articulation that you want to add on the pop-up menu, you can define your own articulations by selecting “Add Custom Articulation”.

This adds a default articulation which you can define in the Articulations section, see below.

• Click in the “Col” column to assign a color to the current sound slot.

When working in the MIDI editors, you can color your events according to the color of the sound slots.

5. When you have made the desired settings, click the “+” button again to add another sound slot.

Add as many sound slots as you need.

• In the Remote column, you can specify the key on your external device that triggers this sound slot.

For more information, see “Remote Key Settings” on page 426.

Output Mapping

When you have added sound slots, you can map them to certain sound characters or expressions of an instrument, e.g. a bowed violin or a pizzicato violin. The available sounds depend on the instrument that is selected for the MIDI or instrument track. Some of the more complex virtual instruments require multiple key switches or combinations of key switches and controllers to select a particular articulation. This can be accomplished by stacking multiple output events to a single sound slot. You can add a new slot by clicking the “+” button above the list.

You can make the following settings for the slots: In the Status column, you can specify a note-on, program change, or controller message. Additionally, you can make settings in the Data 1 and 2 columns (if applicable). If you have an instrument that uses key switches (for example Steinberg’s HALion Symphonic Orchestra), you can specify these key switches here. This allows you to switch between a bowed and a pizzicato violin, or to switch to another program containing a different articulation.

You can also create expressions by editing the incoming MIDI data, for example by changing the note length or velocity. For this, you can make the following settings in the lower part of the Output Mapping section:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>Here you can specify the MIDI channel. When using HALion Symphonic Orchestra for example, this allows you to switch to a different program.</td>
</tr>
<tr>
<td>Length</td>
<td>Here you can specify the note length. This way, you can create staccato or tenuto sounds.</td>
</tr>
<tr>
<td>Velocity</td>
<td>Here you can specify the desired velocity. This allows you to create accents, for example.</td>
</tr>
<tr>
<td>Min. Velocity</td>
<td>If you are using an instrument that has different velocity ranges on the same key, you can specify a minimum velocity here, to make sure that the sample mapped to a particular range is used.</td>
</tr>
<tr>
<td>Transpose</td>
<td>This allows you to specify a transpose value. This can be used to select different articulations in some sample libraries, in which different articulations are located on different octaves, for example.</td>
</tr>
<tr>
<td>Controller 1/2</td>
<td>These allow you to set MIDI Control Change messages and their values for each sound slot.</td>
</tr>
</tbody>
</table>

Editing Articulations

In the Articulations section, the articulations you added for the sound slots are displayed. The following settings can be made here:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Art.</td>
<td>Clicking in this column opens a context menu, where you can choose whether you want to insert a symbol or a text string. If you select Symbol, the dialog with the available symbols opens. If you select Text, you can directly enter the desired text.</td>
</tr>
<tr>
<td>Type</td>
<td>In this column you specify whether you want to add an “Attribute” (which only influences a single note, e.g. an accent) or a “Direction” (which is valid from the insertion position until it is replaced by another articulation, e.g. arco and pizzicato).</td>
</tr>
</tbody>
</table>
Groups

You can sort the different articulations you define for an expression map into one to four groups. Groups can be used to combine directions and attributes in more complex musical expressions by choosing articulations from the different groups, for example to play a note arco AND staccato AND with an accent.

The groups themselves are exclusive. This means articulations residing within the same group cannot be used together. Since some of the articulations cannot be combined – for example, a violin cannot be played arco (bowed) and pizzicato (plucked) at the same time – these articulations should be placed in the same group.

Furthermore, the groups represent the musical importance, with group 1 having the highest priority (expressions in group 1 are more important than those in group 2, 3, and 4). This setting is required when the expression map does not find an exact match for your data and tries to identify the closest possible sound. Let’s say you have added a staccato symbol and an accent to a note in an editor. In the expression map, you have specified that staccato is in group 2 and the accent is in group 3. The connected instrument, however, does not have a sample that corresponds to these settings. In this case, the program looks for a staccato sound, disregarding the accent.

Remote Key Settings

The remote keys specify which key on an external device is used to play a certain sound slot, i.e. these keys are then used to insert articulations instead of notes.

The active remote keys (if any) are indicated in the Inspector for the track, see “Expression maps in the Project window” on page 422.

If you do not plan to record or trigger articulations via a MIDI input device, you do not need to specify remote keys.

Latch Mode

This setting determines whether the remote key function reacts to note-off messages.

- When Latch Mode is deactivated, the key you press on your MIDI input device is valid for as long as the key is held, i.e. the sound slot plays until the key is released. On release, the default (first) sound slot is played again.
- When Latch Mode is activated, the key you press is valid until the next key is pressed.

⚠️ Note that Latch Mode can only be generally activated/deactivated in Cubase, not for single expression maps.

Root Note

Here, you can specify the first key on your external device that you want to use as a remote key. This is useful, since it allows you to automatically adjust existing remote key assignments to suit your needs, for example when you are using a MIDI keyboard with a very wide or very narrow key range.

Set Remote Keys

Remote keys can be specified manually for each slot in the Sound Slots section of the window. However, you can also automatically assign a range of keys on your external device to the sound slots in the expression map. Proceed as follows:

1. Click the Set Remote Keys button. A dialog opens.

2. Use the Start Key field to specify the first key on the MIDI input device that you want to trigger a sound slot.
3. On the Key Mapping pop-up menu, you can specify with which keys on your device you want to trigger the sound slots. You can choose whether you want to use all keys on the keyboard as remote keys, or whether only the white or black keys are used.

4. Click OK to close the dialog.

**Saving your settings**

When you have made the desired settings, you need to save the expression map. To do so, click the Save button in the Expression Maps section of the window, specify a file name and a location for the expression map, and click Save.
Note Expression (Cubase only)
Introduction

Note Expression offers a very intuitive way of controller editing in Cubase. As an alternative to working with controller lanes in the Key Editor, controller data can be viewed and edited directly on the associated MIDI note events in the event display.

With Note Expression, a note and its associated controller data are treated as a unit. When you quantize, move, copy, duplicate, or delete notes, all their associated controller information will follow. This allows for a very intuitive and accurate editing of note-related data. The Note Expression values can be edited in various ways, see “Editing Note Expression data” on page 434. Furthermore, by superimposing the corresponding data curves in the event display, you can view all the Note Expression data for a note simultaneously, which gives you a good overview.

![Note Expression curves in the Key Editor](image)

When working with Note Expression, it is important to distinguish between VST 3 controllers and MIDI controllers:

**VST 3 controllers**

VST 3 controllers are provided by the VST instrument. Therefore, different controllers can be available, depending on the instrument.

VST 3 controllers provide articulation information for each individual note. Unlike MIDI controllers (which are channel-specific), VST 3 controllers are note-specific and are suitable for polyphonic contexts. Articulating each note in a chord individually creates a much more natural feel. Furthermore, VST 3 controllers allow for a value range that exceeds the MIDI range of 0 to 127, which offers a more comfortable value editing and fine-tuning.

To be able to work with VST controllers, you need a VST instrument that offers this kind of controller parameters and is capable of playing back these controller messages. Included with Cubase is HALion Sonic SE, which is compatible with Note Expression, see “HALion Sonic SE” on page 439.

**MIDI controllers**

A major limitation of MIDI is the nature of controller information. With the exception of poly pressure, controller messages are channel-specific messages, i.e., they affect the entire instrument, regardless of whether they are inserted for a part or a note. Therefore, when using Note Expression with MIDI instruments (hardware or VSTi), it is important to understand that articulation data on one note usually also affects all other notes of the same voice, i.e. any other note playing on the same channel at the same time. This limits the potential of Note Expression for MIDI controller events to monophonic (solo) performances. When using MIDI controllers in polyphonic performances, we recommend using controller lanes in the Key Editor, see “Using the controller display” on page 388.

However, Note Expression can be useful in the context of standard VST instruments and MIDI hardware instruments, see “Recording MIDI controllers as Note Expression data” on page 438 and “Converting MIDI Controllers into Note Expression data” on page 438.

**Working with Note Expression**

When working with Note Expression, start by activating the “Show Note Expression Data” button on the Key Editor toolbar. This will give you a visual feedback of your actions. Use the slider to the right of the button to modify the display size of the Note Expression data in the event display.
If you want to listen to your editing, activate the Acoustic Feedback button on the Key Editor toolbar. Playback is triggered when you enter or change Note Expression data. All controllers that are present at the mouse position will be used during playback.

Note Expression can be used in the following ways:

• You can record notes live into Cubase while attaching some or all of the used controllers as Note Expression events to the notes, see “Recording” on page 432.
• You can replace the existing Note Expression data of a MIDI part by recording Note Expression events for the MIDI notes during playback, see “Overdubbing” on page 432.
• You can add Note Expression data to one MIDI note after another using the “Note Expression MIDI Input” button, see “Recording Note Expression data via MIDI input” on page 433.
• You can draw in Note Expression events for MIDI notes in the Note Expression editor, see “Editing Note Expression data” on page 434.

Setting up the Note Expression Inspector tab

To be able to work with Note Expression, you have to set up the parameters first. This is done on the Note Expression tab in the Inspector of the Project window or the Key Editor.

The top area of the Note Expression tab shows a list of parameters. The VST 3 controllers are shown first, followed by the MIDI controllers. Which VST 3 controllers are available depends on the instrument that is used. The MIDI controllers can be set up in the MIDI Controller Setup dialog, see “Selecting the event type” on page 389.

If many controllers are available, you may have to navigate through the list using the scrollbar.

If an asterisk (*) is displayed in front of a parameter name, data for this controller exists. The number to the right of a parameter determines the MIDI controller mapped to the parameter for recording, see “Mapping controllers” on page 431.

In the middle section of the tab, you can make settings for the parameter that is selected in the list. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter name and color selector</td>
<td>By clicking on the colored square to the right of the parameter name, you can specify which color is used for the parameter in the Inspector and in the note display. You can also define a Note Expression color set. For further information on setting up colors, see “The Project Colors dialog” on page 539.</td>
</tr>
<tr>
<td>MIDI assignment field and pop-up menu</td>
<td>Here, you can specify the MIDI controller assignment for recording for the selected parameter by either selecting it from the pop-up menu or using the MIDI Learn button, see “Mapping controllers” on page 431.</td>
</tr>
<tr>
<td>MIDI Learn button</td>
<td>You can assign any control of your external MIDI controller to the selected parameter. Click the MIDI Learn button and move the fader or knobs on the external device, see “Mapping controllers” on page 431.</td>
</tr>
<tr>
<td>Parameter range controls (Min/Max)</td>
<td>If you want to use only a certain value range of the parameter, you can specify it here. Set the range by changing the minimum and maximum values or use the slider below the fields. Using a parameter range allows you to make finer settings for certain parameters. This is especially useful for the VST 3 parameter “Tuning”. Specify the range you want to use and enter or record the corresponding data.</td>
</tr>
</tbody>
</table>
In the lower part of the Note Expression tab, the following global settings and parameters are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI Expression</td>
<td>If this button is activated, incoming MIDI controllers will be recorded as Note Expression data, see “Recording MIDI controllers as Note Expression data” on page 438.</td>
</tr>
<tr>
<td>Overdub</td>
<td>When this is activated, you can overdub existing Note Expression data. See “Overdubbing” on page 432.</td>
</tr>
<tr>
<td>Latch Buffer</td>
<td>With this button, you can activate/deactivate the latch buffer used for overdub recording, see “Latch mode” on page 433.</td>
</tr>
</tbody>
</table>

### Showing/hiding controllers

You can specify which parameters are displayed in the Note Expression editor and in the event display by activating/deactivating them in the leftmost column in the list. When you want to edit a single parameter, it might be best to hide the data for the other parameters. Activating several parameters allows you to view them in context, giving you a better overview. In the Inspector, visible controllers are shown with a filled rectangle in front of their name. Hidden controllers are shown with an empty rectangle. To show or hide a parameter, click on its rectangle.

### Filtering the list

If you click on the Parameter column header, a pop-up menu opens, containing the following filter commands:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show only used Parameters</td>
<td>Select this command to only display the parameters in the list for which data exists.</td>
</tr>
<tr>
<td>Make all Parameters visible</td>
<td>Select this command to display all available parameters in the event display.</td>
</tr>
<tr>
<td>Make only edited Parameter visible</td>
<td>Select this command to display only the currently edited parameter in the event display.</td>
</tr>
</tbody>
</table>

### Bypassing Note Expression

Like for most other Inspector tabs, you can bypass the Note Expression settings by clicking on the button at the top right of the Inspector tab, so that it lights up yellow. If Bypass is activated, all Note Expression data will be bypassed for the track.

Bypass is active for the Note Expression Inspector tab.

### Mapping controllers

External keyboards have no controls or faders for VST 3 parameters, which can therefore not be recorded directly. To remedy this, you have the possibility to assign a certain MIDI controller (or Pitchbend and Aftertouch) to any of the Note Expression parameters in the list. The MIDI assignment is shown in the CC column in the Inspector.

The same MIDI controller can be used for several parameters, but only one of these controllers can be active at a time. If the mapping is active, the number for the assigned MIDI controller is displayed (or PB and AT for Pitchbend and Aftertouch, respectively). If a MIDI controller is assigned but inactive, e.g., because the selected parameter uses the same assignment as another parameter, a dot is shown in the CC column.

The VST 3 parameter Tuning is automatically assigned to the pitchbend wheel of your MIDI controller. All other parameters are assigned by default to the first MIDI controller (CC1: Modulation).

You can manually specify the record mapping for the parameters, use the MIDI Learn function, or load a mapping preset, see below.

### Manual mapping

To manually map a MIDI controller to the selected Note Expression parameter, you can select the MIDI controller from the MIDI assignment pop-up menu. If the MIDI controller you are looking for is not on the list, select “MIDI Controller Setup…” and activate it in the dialog. This is the same as selecting which controllers are available for the controller lanes in the Key Editor, see “Selecting the event type” on page 389.
MIDI Learn

Another way to assign the knobs and faders of your MIDI instrument to Note Expression parameters is using the MIDI Learn function. Proceed as follows:

1. Select the parameter to which you want to assign a MIDI controller.
2. Below the list, click the MIDI Learn button to the right of the MIDI assignment pop-up menu.
3. Use the knob or fader on your MIDI device that you want to assign to the selected Note Expression parameter. This control is now automatically assigned.
4. Repeat this step for all the parameters you want to control with your MIDI device.

Now, you can record Note Expression data using the controls on your MIDI device.

Recording

Recording notes and Note Expression data

To record MIDI notes together with Note Expression data using an external MIDI device, proceed as follows:

1. Create an instrument track, e.g. using HALion Sonic SE as VST instrument. The Note Expression Inspector tab shows which parameters are available for recording.
   - You can also load one of the available presets. Some presets were created especially for the use with Note Expression. These have the suffix ".NoteExp".
2. Select a parameter from the list.
3. Set up the record mapping for the parameters, see “Mapping controllers” on page 431.
   You can use the data range controls to use only a subrange of the full parameter range. This allows for finer recording and editing.
4. Record some MIDI notes and use the mapped controls on your MIDI device to record the corresponding Note Expression data.
5. Open the Key Editor and activate the “Show Note Expression Data” button on the toolbar. The Note Expression data is shown on the notes for which it was recorded.

Overdubbing

You can also record or replace Note Expression data for existing notes. This is achieved by overdubbing. To activate this mode, click the Overdub button on the Note Expression Inspector tab. When this is activated, no notes are recorded when you click the Record button. Instead, you can use the controls on your MIDI device to record Note Expression data for the note that is playing.

⚠️ To be able to record MIDI notes again, you have to deactivate the Overdub button when you have finished recording the Note Expression data.

⚠️ If notes are selected when you start overdubbing, controllers will be recorded for these notes only. To record controllers for all notes touched by the position cursor, make sure to deselect all notes in the event display before you start overdubbing.
Latch mode

When Cubase receives controller data from an external MIDI device, this information, i.e. the setting of the faders and knobs on the device, is automatically written to the Latch buffer. By activating Latch mode when overdubbing Note Expression data, you can add the data in the Latch buffer to the notes while these are played back. This can be useful when you want to overdub Note Expression data starting at specific controller values (i.e. at predefined initial knob or fader settings), for example.

To use Latch mode, start by mapping each control to one of the available VST 3 parameters (see “Mapping controllers” on page 431). Then activate the Latch buffer button and set the knobs and faders on the MIDI controller to the desired values. When you now start overdubbing, the values for all these controls are attached to the notes that are passed during overdub recording, replacing any existing controller data of the same type.

- To record Note Expression data via MIDI input, select a note and move the active control on your MIDI device. The note is played in real time and any manipulation of the controls, i.e. all incoming controller data, is recorded for this note. Recording stops when the end of the note or the end of the release phase (see “Editing the release phase of a note” on page 436) is reached, or when you deselect the note.

Recording the sustain pedal

When the sustain pedal (MIDI CC 64) of the connected MIDI device is held during recording, the following applies for VST 3 parameters (not for continuous MIDI controllers):
- When a note-off event is received (when the key on the connected keyboard is released), this message is not sent to the VST 3 instrument but is instead created by the program when the sustain pedal is released. This makes it possible for the VST 3 instrument to play back controllers that are sent after a key was released.
- The release phase of the recorded notes ends when the sustain pedal is released.

Resetting the Latch buffer

Whenever data is present in the Latch buffer, the “Reset Latch buffer” button becomes available. If you click this button, all the memorized values are removed from the Latch buffer.

- When you are using Latch mode in combination with cycle recording, the Latch Buffer is automatically reset at the end of the cycle.

Recording Note Expression data via MIDI input

An alternative way to enter Note Expression data for existing notes is using Note Expression MIDI input. When you activate the “MIDI Input” and “Note Expression MIDI Input” buttons on the Key Editor toolbar, you can replace the controllers for the selected note.
Editing Note Expression data

In the Key Editor, you can view and edit the Note Expression data for notes in the Note Expression editor. This is opened by double-clicking a note in the event display. In the editor, you can add Note Expression data from scratch. All parameters that are marked as visible in the Inspector are displayed as curves in the editor.

- When several notes are selected in the Key Editor and you double-click any of them, the Note Expression editor opens for all these notes. This is useful if you want to edit all notes in a chord in the same way, for example.

- To adjust the editor size, click and drag the Resize handle (in the center of the lower border of the editor). This allows you to switch between three different window sizes.
- To navigate from note to note while the editor is open, use the left and right arrow keys. You can also use the key commands [Tab] and [Shift]-[Tab] to step through the notes.

To make settings in the editor, first select the parameter that you want to make settings for. How to do this depends on whether you want to modify existing data or enter new data from scratch:

- If you want to enter new data from scratch, i.e. create events for a parameter that has not been used yet, you have to select this parameter in the Inspector to make it available in the editor.
- If you want to edit existing data, you specify which parameter to edit in one of the following ways: by clicking on the curve, by selecting the corresponding controller on the Parameter pop-up menu, or by selecting the parameter on the Note Expression Inspector tab.

The parameter pop-up menu in the lower left corner of the editor lists all parameters that are used for the edited note. If the editor size is big enough, the name of the edited parameter is displayed to the right of the pop-up menu.

- You can close the editor by clicking outside of it in the event display.
You can also specify a key command for opening and closing the Note Expression editor.

The value display

The value display in the lower right corner of the editor shows the current value at the (vertical) mouse pointer position. The value range differs depending on the parameter type, e.g. 0 to 127 for MIDI controllers or semitones and cents for Tuning.

Selection ranges

You can select a range of controller values by clicking and dragging in the editor with the Object Selection tool.

- If you hold down [Shift] and drag, any previous selection will be kept.
- You can move selections by dragging them in the editor.
- To copy a selection in the editor, click on it, keep the mouse button pressed, then press [Alt]/[Option] and drag.

Editing functions

Drawing in data

You can enter or modify curves using the pencil tool or the line tool. The editing is the same as in the controller lanes, see “Adding and editing events in the controller display” on page 390. If the arrow tool is selected and the editor is open, you can press [Alt]/[Option] to get the pencil tool.

You can enter lines and curves using the line tool in its various modes. This works just as when editing in the controller lane, see “Adding and editing events in the controller display” on page 390.

Using Cut, Copy, and Paste

- To cut, copy, and paste Note Expression data for a single parameter in the editor, use the corresponding commands on the Edit menu.
It is also possible to copy and paste data between different parameters.

- Pasting Note Expression data in the editor is restricted to the note (or notes, if they are located at the same time position) for which the editor is open. However, you can copy all Note Expression data from one note to another using a key command.
To paste all the Note Expression data from one note to other notes, set up the key command “Paste Note Expression” in the Key commands dialog (Note Expression category).

This pastes all the Note Expression information of one or several notes for which you have used the Copy command into the currently selected notes.

Using the “Paste Note Expression” command, you can copy the settings you made for one note into several other notes, or copy the settings for several selected notes into a number of other notes (which makes it easy to recreate specific drum patterns, for example).

If Note Expression data is copied from several source notes to a number of destination notes, the following applies:

- If the number of the source and destination notes matches, the data of the first “source” note is pasted into the first “destination” note, the data of the second source note into the second destination note, etc.
- If the number of source notes is smaller than the number of destination notes, the source note data will be pasted repeatedly into the destination notes in the order in which they appear.

When you copy the data from two source notes into four destination notes, for example, the first destination note gets the Note Expression data from the first source note, the second destination note the data of the second source note, the third destination note the data of the first source note and the fourth destination note the data of the second source note.

Deleting Note Expression data

- To delete all or the selected Note Expression data, use the Delete command on the Edit menu or press [Backspace].

Moving Note Expression data

- To move all or the selected data of the active parameter, click with the Object Selection tool in the editor (not in the stretch area at the bottom of the window) and drag. You can restrict the direction to vertical or horizontal by pressing [Ctrl]/[Command] while dragging. When you hold down [Alt]/[Option] while dragging, the data is copied instead.

Fixed values

- To enter or edit a fixed value (i.e. a straight line), activate “One-Shot Mode” mode by clicking the button in the upper left corner of the window and click with the pencil tool anywhere in the editor to set the value. Note that some VST 3 parameters are one-shot only. For these, this mode is automatically activated.

The snap controls

The horizontal snap button in the upper right corner of the editor corresponds to the Snap button in the Project window (see “The Snap function” on page 45).

The Vertical Snap button in the middle of the left border of the editor is especially useful for the Tuning parameter. It allows you to enter the pitch in semitone steps instead of as a continuous curve. This way, it is much easier to create fast pitch modulations.

- To temporarily switch to vertical snapping while editing, hold down [Shift].
Modifying the data using the smart spots

The editor offers various modes for editing the Note Expression data. Most editing modes are activated by clicking the various so-called “smart spots”, situated on the editor frame.

Which editing is performed is reflected by the shape of the mouse pointer. The following modes are available:

<table>
<thead>
<tr>
<th>Editing mode</th>
<th>To activate this mode…</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Vertically</td>
<td>Click in an empty area on the upper border of the editor.</td>
<td>This mode allows you to move the entire curve up or down, which is useful to boost or attenuate a curve.</td>
</tr>
<tr>
<td>Scale Vertically</td>
<td>Click the smart spot in the middle of the upper border of the editor.</td>
<td>Use this mode to relatively scale the curve, i.e. to raise or lower the values in percent (not by absolute amounts).</td>
</tr>
<tr>
<td>Tilt the left/right part of the curve</td>
<td>Click the smart spot in the upper left/right corner of the editor.</td>
<td>These modes allow you to tilt the left or the right part of the curve, respectively. This is useful if the curve form is exactly the way you want it, but the start or end needs to be boosted or attenuated a bit.</td>
</tr>
<tr>
<td>Compress the left/right part of the curve</td>
<td>[Alt]/[Option]-click the smart spot in the upper left/right corner of the editor.</td>
<td>These modes allow you to compress the left or the right part of the curve. You can create a vibrato using the line tool in sinus mode, for example, and then compress its start and end to get a more natural effect.</td>
</tr>
<tr>
<td>Scale Around Absolute Center</td>
<td>Click the smart spot in the middle of the right border of the editor.</td>
<td>This mode allows you to scale the curve around the absolute center, i.e. horizontally around the center of the editor. This is useful for parameters which contain a center value or position, such as Pitch bend or panorama.</td>
</tr>
</tbody>
</table>

Editing the release phase of a note

Sometimes it can be necessary to edit the release phase of a note, e.g. to work on the tail of a note which is still sounding after the note-off message was sent. These settings are made in the release section of the editor. To add a release phase, click and drag the release length handle in the lower right corner of the editor.

When Note Expression data are displayed in the Key Editor, the release phase of a note is also shown.
Setting the length of the release phase

To determine the length of the release phase, drag the release length handle or enter the value manually on the info line. You can also modify the release length after having edited or recorded controller data. Only the controllers within the specified length will be heard during playback.

→ When you have opened the editor for several notes and hold down [Alt]/[Option] while setting the release length for one note, the release phase of all the notes will be changed accordingly, i.e. they will all end at the same time position.

Adding controllers in the release phase

You can add controllers in the release phase by overdubbing or by manually entering Note Expression data in the editor. When you are overdubbing Note Expression data, the length of the existing release phase will be used to associate newly recorded data to the notes. When the sustain pedal of your external device is held during recording, the notes automatically get a corresponding release phase.

Editing multiple notes simultaneously

When you have opened the editor for several notes, any editing (e.g. entering Note Expression data, applying time stretch or modifying the length of the release phase) affects all the notes that are present at the time position where you perform the editing.

Note Expression and MIDI

Making global settings

In the Note Expression MIDI Setup dialog, you can make some global settings for the use of the Note Expression functionality with MIDI. In this dialog, you can specify exactly which MIDI controllers will be used when recording Note Expression data, for example.

Proceed as follows:

1. On the MIDI menu, open the Note Expression submenu and select “Note Expression MIDI Setup...”. The Note Expression MIDI Setup dialog opens.

The dialog contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller</td>
<td>Activate this option if you want to use MIDI controllers when working with Note Expression. In the table below, activate the MIDI controllers you want to use and deactivate the MIDI controllers that should be disregarded in the Note Expression context. If MIDI controller data for a deactivated controller is received in Cubase, it will end up on the controller lane.</td>
</tr>
<tr>
<td>Pitchbend</td>
<td>Activate this option if you want incoming Pitchbend data to be used when working with Note Expression.</td>
</tr>
<tr>
<td>Aftertouch</td>
<td>Activate this option if you want incoming Aftertouch data to be used when working with Note Expression.</td>
</tr>
<tr>
<td>Poly Pressure</td>
<td>Activate this option if you want Poly Pressure data to be used when working with Note Expression.</td>
</tr>
<tr>
<td>Controller Catch Range</td>
<td>This allows you to associate controllers with a note, although they were sent slightly before the note-on message. Specify the number of ticks in the value field. For example, this might be necessary when working with some electronic drums for which the drum head position message is sent before the note.</td>
</tr>
</tbody>
</table>

2. When you have made the desired settings, click OK to close the dialog. The settings you made in the Note Expression MIDI Setup dialog will be used every time that you use the “Convert to Note Expression” function or record MIDI controllers as Note Expression data.
Recording MIDI controllers as Note Expression data

To record Note Expression data using standard MIDI controller messages, activate the “MIDI as Note Expression” button on the Note Expression Inspector tab and enter the notes and controllers using your MIDI device. Afterwards, you can copy, paste and move the notes and the associated controller data will follow.

However, you should not shift individual notes from a chord, because this leads to conflicting controller messages. One way to avoid such conflicts is to record MIDI controllers as Note Expression data for monophonic performances only. Another option is to use a MIDI track set to “Any” channel and to split polyphony to separate channels. This is useful when working with guitar-to-MIDI controllers, where each string sends on a separate MIDI channel.

When recording MIDI controllers as Note Expression data, keep in mind that this only works within the limits of standard MIDI controllers. With the exception of Poly Pressure, all MIDI controllers are channel-specific messages and therefore not available for notes.

Converting MIDI Controllers into Note Expression data

You can also convert the MIDI controller data on the controller lanes into Note Expression data.

Proceed as follows:
1. Open the MIDI part in the Key Editor.
2. Make sure that the MIDI controllers to be recorded are activated in the “Note Expression MIDI Setup” dialog.
3. On the MIDI menu, open the Note Expression submenu and select “Convert to Note Expression”.

The MIDI data of the types you specified in the Note Expression MIDI Setup dialog is converted from controller lane data into Note Expression data, leaving the corresponding controller lanes empty.

During this process, the program searches for notes that are sounding at the same time as the controllers and if several notes are playing at the same time, the same Note Expression parameters will be attributed to them, with the same values.

When converting MIDI controllers into Note Expression data, release phases (see “Editing the release phase of a note” on page 436) are automatically created where necessary, so that no controller data is lost during this process.

When you are editing the MIDI notes after the conversion, it might be necessary to consolidate the controller data.

Consolidating MIDI overlaps

It can be problematic to convert regular MIDI controllers into Note Expression data or to edit MIDI controllers which have been recorded as Note Expression data. For example, when you move notes so that they overlap other notes containing the same controllers (e.g. by moving or quantizing), these controllers are conflicting. This might cause trouble, especially for connected MIDI devices.

You can eliminate such controller conflicts using the “Consolidate Note Expression Overlaps” command on the Note Expression submenu of the MIDI menu. When you select this command, the following happens:

• If notes overlap that contain data for the same controller, the controller values of the second note are used from the beginning of the overlap.

• If a note is moved so that it is positioned entirely within a longer note and if these notes contain controller data for the same controller, the controller values of the longer note are used until the encompassed note starts. The controllers for the “embedded” shorter note are used for the entire length of that note. At the end of the shorter note, the controllers of the longer note are used again.

⚠️ When you are editing the MIDI notes after recording them, it might be necessary to consolidate the controller data.
Distributing notes to different channels

If you do not have a VST 3 instrument, but still want to use the Note Expression functions, proceed as follows:

1. Add a multi-timbral instrument, open its control panel, and assign the same sound to different channels.
2. In the Inspector for the corresponding MIDI track, make sure the MIDI output pop-up menu is set to "Any".
3. Enable the “MIDI as Note Expression” button and record or enter MIDI notes with expression as needed.
4. On the MIDI menu, open the Note Expression submenu and select “Distribute Notes to MIDI Channels”. This will distribute the MIDI notes to different channels (starting at channel 1).
5. Edit Note Expression for each note independently without controller conflicts.

Dissolving Note Expression data

- To convert Note Expression data into MIDI controller data on controller lanes, select the “Dissolve Note Expression” option from the Note Expression submenu on the MIDI menu.
  Note that this applies only to Note Expression data that consists only of MIDI controllers (i.e. not the VST 3 controller data).

Removing all Note Expression data

- To delete all the Note Expression data for the current selection, open the MIDI menu and, on the Note Expression submenu, select “Remove Note Expression”.

Trimming Note Expression data

When you reduce the release length of a note after entering Note Expression data for the release phase, some of the data ends up behind the release phase, thereby becoming unused.

- To keep only those Note Expression events that are actually used, select the notes and select “Trim Note Expression to Note Length” from the Note Expression submenu on the MIDI menu.
  This will delete any Note Expression data present after the end of the release phase for the notes.

HALion Sonic SE

HALion Sonic SE is a VST 3-compatible VST instrument. For use with Note Expression, it offers the VST 3 parameters “Tuning” (Pitch), “Volume”, and “Pan”. HALion Sonic SE comes with several presets (with the file name extension “*.NoteExp”) that can be used with Note Expression. Use them to get a quick overview of the possibilities HALion Sonic SE offers when working with Note Expression.

For detailed information about HALion Sonic SE and its parameters, refer to the separate PDF document “HALion Sonic SE”.

You can also open the Project Browser to have all the Note Expression data shown in a list. This is described in detail in the chapter “The Project Browser (Cubase only)” on page 477.
The Logical Editor, Transformer, and Input Transformer
Introduction

Most of the time you will perform your MIDI editing graphically in one of the MIDI editors. But there are times when you want more of a “search and replace” function on MIDI data, and that’s where the Logical Editor comes in.

⚠️ The Logical Editor is only available in Cubase! However, the Transformer MIDI effect and the Input Transformer that share many of the functions with the Logical Editor are also available in Cubase Artist.

The principle of the Logical Editor is this:

• You set up filter conditions to find certain elements. This can be elements of a certain type, with certain attributes or values or on certain positions, in any combination. You can combine any number of filter conditions and make composite conditions using AND/OR operators.

• You select the basic function to be performed. The options include Transform (changing properties of the found elements), Delete (removing the elements), Insert (adding new elements based on the found positions of other elements) and more.

• You set up a list of actions, which specify exactly what is done. This is not necessary for all functions. For example, the Delete function does not require any additional action specifications – it simply removes all found elements. The Transform function on the other hand requires that you specify which properties are changed and in which way (transpose notes by a certain amount, adjust velocity values, etc.).

By combining filter conditions, functions and the specific actions, you can perform very powerful processing.

To master the Logical Editor, you need some knowledge about how MIDI messages are structured. However, the Logical Editor also comes with a rich selection of presets, allowing you to access its processing powers without delving into its more complicated aspects, see “Working with presets” on page 450.

⚠️ Studying the included presets is an excellent way to learn the workings of the Logical Editor! Many of them can also be used as starting points when you set up your own editing operations using the Logical Editor.

About the Transformer MIDI effect

The Transformer effect is a realtime version of the Logical Editor, allowing you to apply editing to the events played back from a track “on the fly”. The Transformer contains virtually the same settings and functions as the Logical Editor – where there are differences between the two, this is clearly stated on the following pages.

⚠️ For details on how to open the Transformer (and other MIDI effects), see “MIDI realtime parameters and effects” on page 348.

About the Input Transformer

This too is very similar to the Logical Editor. Just like the Transformer effect, the Input Transformer works in realtime. However, the Input Transformer filters out and transforms MIDI data as it is recorded. In other words, the settings you make in the Input Transformer will affect the actual MIDI events you record.

The Input Transformer is described in the section “The Input Transformer” on page 450. However, we recommend that you make yourself familiar with the Logical Editor first, since they share many features and principles.

About the Project Logical Editor

There is also a “Project Logical Editor” available via the Edit menu. This is described in the chapter “The Project Logical Editor (Cubase only)” on page 452.

Opening the Logical Editor

1. Select the desired parts or events. What will be affected by the operation depends on the current selection.

• In the Project window, edits using the Logical Editor are applied to all selected parts, affecting all events (of the relevant types) in them.

• In the MIDI editors, edits using the Logical Editor are applied to all selected events. If no events are selected, all events in the edited part(s) will be affected.

You can change the selection while the Logical Editor window is open.

2. Select “Logical Editor…” from the MIDI menu.
Window overview

Filter conditions list  Presets pop-up menu

Action List  Function pop-up menu  Apply button (not available in the Transformer)

Setting up filter conditions

General procedure

The upper list is where you set up the filter conditions, determining which elements to find. The list can contain one or several conditions, each on a separate line.

- To add a new condition, click the “+” button below the list. A new line is added at the bottom of the list. If there are many lines, you may need to use the scrollbar to the right to view them.

- To remove a condition, select it and click the “-” button below the list.

If you have already defined filter conditions and/or applied a preset, but want to start again from scratch, you can initialize the settings by selecting the Init option from the Presets pop-up menu.

You set up a filter condition line by clicking in the columns and selecting options from the pop-up menus that appear. Here is a brief description of the columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>This determines how the Logical Editor compares the property in the Filter Target column to the values in the Parameter columns (see below). The available options depend on the Filter Target setting.</td>
</tr>
<tr>
<td>Parameter 1</td>
<td>Here you set which value the element properties are compared to (depending on the Filter Target). For example, if the Filter Target is “Position” and Condition is “Equal”, the Logical Editor will look for all elements starting at the position you specify in the Parameter 1 column.</td>
</tr>
<tr>
<td>Parameter 2</td>
<td>This column is used if you have selected one of the “Range” options in the Condition column. This allows you to find all elements with values inside (or outside) the range between Parameter 1 and Parameter 2. Furthermore, if you want to find certain VST 3 events (Filter Target set to “Type is” and Parameter 1 set to “VST3 Event”), you can use the Parameter 2 column to specify the VST 3 parameter that you are searching for, e.g. Tuning.</td>
</tr>
<tr>
<td>Bar Range/Time Base (Logical Editor only)</td>
<td>This column is only used if the Filter Target is set to “Position”. If one of the “Bar Range” options is selected in the Condition column, you use the Bar Range/Time Base column to specify “zones” within each bar (for example, allowing you to find all elements on or around the first beat of every bar). If any of the other Condition options is selected, you can use the Bar Range/Time Base column to specify the time base (PPQ, Seconds, etc.). See “Searching for elements at certain positions (Logical Editor only)” on page 443 for details.</td>
</tr>
<tr>
<td>Right bracket</td>
<td>This is used for “bracketing” several lines together, see “Combining multiple condition lines” on page 446.</td>
</tr>
<tr>
<td>bool</td>
<td>This allows you to insert the boolean operators And/Or, when creating conditions with multiple lines, see “Combining multiple condition lines” on page 446.</td>
</tr>
</tbody>
</table>

You can also set up filter conditions by dragging MIDI events directly into the upper list. If the list contains no entries, a MIDI event dragged into this section will form conditions including the state and type of the event. If it contains entries, the dragged event will initialize the matching parameters. For example, if a length condition is used, the length will be set according to the length of the event.

Conditions

Depending on the Filter Target setting, the following options can be selected in the Condition column:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal</td>
<td>… has the exact same value as set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Unequal</td>
<td>… has any value other than the one set up in the Parameter 1 column.</td>
</tr>
</tbody>
</table>
The Conditions for the “Property” filter target are different, see “Searching for properties” on page 445.

Below, the different Filter Targets (and their corresponding Condition and Parameter options) are described in more detail.

### Searching for elements at certain positions
(Logical Editor only)

Selecting “Position” in the Filter Target column lets you find elements starting at certain positions, either relative to the start of the song or within each bar.

- **If you select any condition other than the Range or Bar Range options, you set up a specific position (in PPQ, seconds, samples, or frames) in the Parameter 1 column. Use the Bar Range/Time Base column to specify the time base.**

Here, the Logical Editor will find all elements at 1.1.1.0 in the project.

- **If you select Inside Range or Outside Range in the Condition column, you set the start position of the range in the Parameter 1 column and the end position in the Parameter 2 column. You can also change the time base using the Bar Range/Time Base column.**

The Logical Editor will then find all elements inside or outside this position range.

- **If you select one of the Bar Range options in the Condition column, the Bar Range/Time Base column will show a graphic bar display. You specify the range within the bar by clicking and dragging in the bar display (the specified Bar Range is indicated in blue).**

The Logical Editor will then find all elements starting inside or outside this Bar Range, in all bars (within the current selection).

<table>
<thead>
<tr>
<th>Condition</th>
<th>Elements will be found if their Filter Target property…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bigger</td>
<td>…has a value higher than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Bigger or Equal</td>
<td>…has a value that is the same as or higher than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Less</td>
<td>…has a value lower than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Less or Equal</td>
<td>…has a value that is the same as or lower than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Inside Range</td>
<td>…has a value that is between the values set up in the Parameter 1 and Parameter 2 columns. Note that Parameter 1 should be the lower value and Parameter 2 the higher.</td>
</tr>
<tr>
<td>Outside Range</td>
<td>…has a value that is not between the values set up in the Parameter 1 and Parameter 2 columns.</td>
</tr>
<tr>
<td>Inside Bar Range (Logical Editor only)</td>
<td>…is within the “zone” set up in the Bar Range/Time Base column (Position only), in each bar within the current selection.</td>
</tr>
<tr>
<td>Outside Bar Range (Logical Editor only)</td>
<td>…is outside the “zone” set up in the Bar Range/Time Base column (Position only), in each bar within the current selection.</td>
</tr>
<tr>
<td>Before Cursor (Logical Editor only)</td>
<td>…is before the song cursor position (Position only).</td>
</tr>
<tr>
<td>Beyond Cursor (Logical Editor only)</td>
<td>…is after the song cursor position (Position only).</td>
</tr>
<tr>
<td>Inside Track Loop (Logical Editor only)</td>
<td>…is inside the set track loop (Position only).</td>
</tr>
<tr>
<td>Inside Cycle (Logical Editor only)</td>
<td>…is inside the set cycle (Position only).</td>
</tr>
<tr>
<td>Exactly matching Cycle (Logical Editor only)</td>
<td>…exactly matches the set cycle (Position only).</td>
</tr>
<tr>
<td>Note is equal to</td>
<td>…is the note specified in the Parameter 1 column, regardless of octave (Pitch only). For example, lets you find all C notes, in all octaves.</td>
</tr>
</tbody>
</table>

### Searching for notes of certain lengths
(Logical Editor only)

Only note events have lengths (actually, a note is made up of separate note-on and note-off events but in Cubase it is considered as a single event with a length). Therefore, the “Length” Filter Target is only valid if you are specifically searching for notes – there has to be another condition line with the Filter Target “Type”, Condition “Equal” and Parameter 1 set to “Note”. See “Combining multiple condition lines” on page 446 for details about using multiple filter conditions.
Searching for Value 1 or Value 2

A MIDI event is composed of several values. What is displayed for Value 1 and 2 depends on the type of event:

<table>
<thead>
<tr>
<th>Event type</th>
<th>Value 1</th>
<th>Value 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>The Note Number/Pitch.</td>
<td>The velocity of the note.</td>
</tr>
<tr>
<td>PolyPressure</td>
<td>The key that was pressed.</td>
<td>The amount of pressure for the key.</td>
</tr>
<tr>
<td>Controller</td>
<td>The type of Controller, displayed as a number.</td>
<td>The amount of Control Change.</td>
</tr>
<tr>
<td>Program Change</td>
<td>The Program Change number.</td>
<td>Not used.</td>
</tr>
<tr>
<td>Aftertouch</td>
<td>The amount of pressure.</td>
<td>Not used.</td>
</tr>
<tr>
<td>Pitchbend</td>
<td>The “fine-tune” of the bend.</td>
<td>The coarse amount of bend.</td>
</tr>
<tr>
<td>VST3 Event</td>
<td>Not used.</td>
<td>The value of the VST3 event parameter.</td>
</tr>
</tbody>
</table>

Note: This table is not exhaustive; System Exclusive events are not included in the table above, because they do not use value 1 and 2.

Because value 1 and 2 have different meanings for different events, searching for value 2 = 64 would both find notes with the velocity 64 and controllers with the amount 64, etc. If this is not what you want, you can add an additional filter condition line with the Filter Target “Type”, specifying which type of events to find (see below).

⚠️ This is particularly useful when searching for note pitch or velocity values, as described below.

The general procedures when searching for value 1 or 2 are:

- If you select any Condition other than the Range options, you set up a specific value in the Parameter 1 column.

Here, the Logical Editor will find all events with a value 2 less than 80.

- If you select Inside Range or Outside Range in the Condition column, the range consists of the values between Parameter 1 and Parameter 2.

Note that Parameter 1 should have the lower value.

Searching for note pitch or velocity

If you add another condition line with the Filter Target “Type”, Condition “Equal” and Parameter 1 set to “Note”, the Logical Editor will “know” you are searching for pitch or velocity. This has the following benefits:

- The Filter Targets Value 1 and Value 2 will be displayed as “Pitch” and “Velocity” respectively, making it easier to grasp the function of the filter condition.
- Pitch values in the Parameter columns will be displayed as note names (C3, D#4, etc.). When entering pitch values you can either type a note name or a MIDI note number (0–127). When Value 1 (pitch) is selected as Filter Target, an additional option appears in the Condition column: “Note is equal to”. When this is selected, you specify a note name in the Parameter 1 column but without any octave number (C, C#, D, D#, etc.). The Logical Editor can then find all notes of a certain key, in all octaves.

See “Combining multiple condition lines” on page 446 for more info on working with multiple filter condition lines.

Searching for controllers

There is similar extended functionality when searching for controllers: If you have added an additional “Type = Controller” condition line, the Logical Editor will “know” you are searching for controllers. The Parameter 1 column will then show the names of the MIDI controllers (Modulation, Volume, etc.) when Value 1 is selected as Filter Target.
Searching for MIDI channels

Each MIDI event contains a MIDI channel setting (1–16). Normally, these settings are not used, since the MIDI event plays back on the MIDI channel set for its track. However, you can come across MIDI parts with events set to different channels, for example in the following scenarios:

- If you have recorded MIDI from an instrument sending on several different channels (e.g. a master keyboard with different key zones).
- If you have imported a MIDI file of type 0 (with a single track, containing MIDI events with different channel settings).

Searching for MIDI channel values is straightforward; you select a Condition and enter a MIDI channel (1–16) in the Parameter 1 column (and, if you have selected one of the Range Conditions, a higher channel in the Parameter 2 column, creating a value range).

Searching for element types

Selecting Type as the Filter Target allows you to find elements of a certain type only.

- The Condition column contains only three options: Equal, Unequal and All Types.
- Clicking the Parameter 1 column displays a pop-up menu, listing the available types (Note, Poly Pressure, Controller, etc.).

The Logical Editor will find all elements matching or not matching the selected type (depending on the Condition).

⚠️ As mentioned above, selecting Type = Note or Type = Controller adds some additional functionality to the Logical Editor. You should make it a habit to add a Type condition when applicable.

Searching for properties

On the Filter Target pop-up menu, you will find an option called Property. This allows you to search for properties that are not part of the MIDI standard but rather Cubase-specific settings.

When the Property option is selected, the Condition column has two options: "Property is set" and "Property is not set". Which property to look for is selected in the Parameter 1 column. The options are "muted", "selected", "empty", "inside NoteExp", and "valid VST3". Some examples:

- Here, the Logical Editor will find all muted events.
- Here, the Logical Editor will find all events that are selected and muted.
- Cubase only: Here, the Logical Editor will find all Note Expression data.
- Cubase only: Here, the Logical Editor will find all MIDI controller events that form part of Note Expression data.
- Cubase only: Here, the Logical Editor will find all VST 3 events that cannot be played back, because there is no Note Expression compatible VST instrument on the related track.

Searching for event contexts

On the Filter Target pop-up menu, you will find an option called "Last Event". This can be used to perform context-dependent searches (especially useful in the Input Transformer).

"Last Event" indicates the state of an event which has already passed the Input Transformer/Logical Editor. The condition has to be combined with Parameter 1 and Parameter 2.

Below, you will find a few examples on how the Last Event filter target can be used.
Here, the action will only be performed when the sustain pedal is down:

<table>
<thead>
<tr>
<th>Filter Target</th>
<th>Condition</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Event</td>
<td>Equal</td>
<td>MIDI Status</td>
<td>176/Controller</td>
</tr>
<tr>
<td>Last Event</td>
<td>Equal</td>
<td>Value 1</td>
<td>64</td>
</tr>
<tr>
<td>Last Event</td>
<td>Bigger</td>
<td>Value 2</td>
<td>64</td>
</tr>
</tbody>
</table>

In this example, the action will be performed when the note C1 is pressed (the “Note is playing” condition is only available in the Input Transformer and in the Transformer effect):

<table>
<thead>
<tr>
<th>Filter Target</th>
<th>Condition</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type is</td>
<td>Equal</td>
<td>Note</td>
<td></td>
</tr>
<tr>
<td>Last Event</td>
<td>Equal</td>
<td>Note is playing</td>
<td>36/C1</td>
</tr>
</tbody>
</table>

In this example, the action will be performed after playing the C1 note:

<table>
<thead>
<tr>
<th>Filter Target</th>
<th>Condition</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Event</td>
<td>Equal</td>
<td>Value 1</td>
<td>36/C1</td>
</tr>
</tbody>
</table>

Cubase only: In this example, the action will be performed for Note Expression VST 3 Tuning events that are attached to a C1 note when C1 is pressed:

<table>
<thead>
<tr>
<th>Filter Target</th>
<th>Condition</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type is</td>
<td>Equal</td>
<td>VST3 Event</td>
<td>Tuning</td>
</tr>
<tr>
<td>Last Event</td>
<td>Equal</td>
<td>MIDI Status</td>
<td>144/Note On</td>
</tr>
<tr>
<td>Last Event</td>
<td>Equal</td>
<td>Value 1</td>
<td>36/C1</td>
</tr>
</tbody>
</table>

**Combining multiple condition lines**

As described above, you can add condition lines by clicking the "+" button below the list. The result of combining condition lines depends on the boolean And/Or operators and the brackets.

**The bool column**

By clicking in the “bool” column to the right in the list, you can select a boolean operator: “And” or “Or”. A boolean operator combines two condition lines and determines the result in the following way:

- If two condition lines are combined with a boolean And, both conditions must be fulfilled for an element to be found.
- If two condition lines are combined with a boolean Or, one of the conditions (or both) must be fulfilled for an element to be found.

The Logical Editor will only find elements that are notes and start at the beginning of the third bar.

When you add a new condition line, the boolean setting defaults to And. Therefore, if all you want to do is set up two or more conditions that all must be met for an element to be found, you do not have to think about the boolean column – just add the required lines and make the usual filter settings.

**Using brackets**

The bracket (parenthesis) columns let you enclose two or more condition lines, dividing the conditional expression into smaller units. This is only relevant when you have three or more condition lines and want to use the boolean Or operator. This is how it works:

- Without brackets, the conditional expressions are evaluated according to their order in the list.

In this case the Logical Editor will find all MIDI notes with the pitch C3, as well as all events (regardless of their type) set to MIDI channel 1.

Maybe you wanted to find all notes that either had the pitch C3 or the MIDI channel 1 (but no non-note events)? Then you need to add some brackets:
Expressions within brackets are evaluated first. If there are several layers of brackets, these are evaluated “from the inside out”, starting with the innermost brackets.

You add brackets by clicking in the bracket columns and selecting an option. Up to triple brackets can be selected.

Selecting a function

The pop-up menu at the bottom of the Logical Editor is where you select the function – the basic type of editing to be performed.

Below, the available options are listed. Note that some options are not available in the Transformer effect.

Delete

Deletes all elements found by the Logical Editor. In the case of the Transformer, this function will remove (or “mute”) all found elements from the “output stream” – the actual elements on the track are not affected.

Transform

Changes one or several aspects of the found elements. You set up exactly what is changed in the action list, see “Specifying actions” on page 447.

Insert

This will create new elements and insert these into the part(s) (Logical Editor) or the output stream (Transformer). The new elements will be based on the elements found by the Logical Editor’s filter conditions, but with any changes you have set up in the action list applied.

Another way of expressing this is that the Insert function copies the found elements, transforms them according to the action list and inserts the transformed copies among the existing elements.

Insert Exclusive

This will transform the found elements according to the action list. Then, all elements that were not found (that did not meet the filter conditions) are deleted (Logical Editor) or removed from the output stream (Transformer).

Copy (Logical Editor only)

This will copy all found elements, transform them according to the action list and paste them into a new part on a new MIDI track. The original events are not affected.

Extract (Logical Editor only)

This works like Copy, but will cut the found events instead. Or in other words, Extract will transform all found events and move them to a new part on a new MIDI track.

Select (Logical Editor only)

This will simply select all found events, highlighting them for further work in the regular MIDI editors.

Specifying actions

The lower list in the Logical Editor window is the action list. This is where you specify any changes that are made to the found events (relevant for all function types except Delete and Select).

The handling of the action list is similar to the filter condition list, but without the brackets and booleans. You simply add lines by clicking the “+” button below the list, and fill out the columns as required. To remove a superfluous action line, select it and click the “−” button.

Action Target

This is where you select the property that is changed in the events:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Adjusting this value will move the events.</td>
</tr>
<tr>
<td>(Logical Editor only)</td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>Lets you resize the events (notes only).</td>
</tr>
<tr>
<td>(Logical Editor only)</td>
<td></td>
</tr>
</tbody>
</table>
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value 1</td>
<td>This adjusts value 1 in the events. As described in the section “Searching for Value 1 or Value 2” on page 444, what is displayed for value 1 depends on the event type. For notes, value 1 is the pitch.</td>
</tr>
<tr>
<td>Value 2</td>
<td>This adjusts value 2 in the events. As described in the section “Searching for Value 1 or Value 2” on page 444, what is displayed for value 2 depends on the event type. For notes, value 2 is the velocity value.</td>
</tr>
<tr>
<td>Channel</td>
<td>Allows you to change the MIDI channel setting, see “Searching for MIDI channels” on page 445.</td>
</tr>
<tr>
<td>Type</td>
<td>Allows you to change the event type, e.g. transform after-touch events to modulation events, or pitchbend events to VST 3 Tuning events.</td>
</tr>
<tr>
<td>Value 3</td>
<td>This adjusts value 3 in the events, which is used for handling of Note-off velocity when searching for properties, see “Searching for properties” on page 445.</td>
</tr>
<tr>
<td>NoteExp Operation (Logical Editor only)</td>
<td>Cubase only: Allows you to specify a Note Expression operation in the Operation column.</td>
</tr>
<tr>
<td>VST3 Value Operation (Logical Editor only)</td>
<td>Allows you to perform common operations within the VST3 value range (0.0 to 1.0) instead of the standard MIDI value range (0-127), for finer adjustments.</td>
</tr>
</tbody>
</table>

- The Position and Length parameters are interpreted via the time base setting in the Bar Range/Time Base column, with the exception of the Random setting, which uses the time base of the affected events.

### Operation

This setting determines what to do with the Action Target. The options on this pop-up menu are different depending on the selected Action Target. Below, all available operations are listed:

**Add**

Adds the value specified in the Parameter 1 column to the Action Target.

**Subtract**

Subtracts the value specified in the Parameter 1 column from the Action Target.

**Multiply by**

Multiplies the Action Target value with the value specified in the Parameter 1 column.

**Divide by**

Divides the Action Target value by the value specified in the Parameter 1 column.

**Cubase only: VST3 Value Operation – Invert (Logical Editor only)**

Inverts Note Expression data containing the specified VST 3 event parameter.

**Round by**

This “rounds” the Action Target value using the value specified in the Parameter 1 column. In other words, the Action Target value is changed to the closest value that can be divided by the Parameter 1 value.

For example, if the Action Target value is 17 and Parameter 1 is 5, the result of rounding will be 15 (the closest value that can be divided by 5). Another word for this type of operation would be “quantizing”, and it is actually possible to use it for this, by setting the Action Target to “Position” and specifying a quantize value with Parameter 1 (in ticks, with 480 ticks per quarter note).

**Set Random Values between**

This will set the Action Target value to a random value within the range specified with Parameter 1 and 2.

**Set Relative Random Values between**

This will add a random value to the current Action Target value. The added random value will be within the range specified with Parameter 1 and 2. Note that these can be set to negative values.

For example, if you set Parameter 1 to -20 and Parameter 2 to +20, the original Action Target value will get a random variation, never exceeding ±20.

**Set to fixed value**

This sets the Action Target to the value specified in the Parameter 1 column.
Add Length (Logical Editor only)
This is only available when Action Target is set to Position. Furthermore, it is only valid if the found events are notes (and thus have a length). When Add Length is selected, the length of each note event will be added to the Position value. This can be used for creating new events (using the Insert function) positioned relative to the end positions of the original notes.

Transpose to Scale
This is only available when Action Target is set to Value 1, and when the filter conditions are specifically set up to find notes (a “Type = Note” filter condition line has been added). When “Transpose to Scale” is selected, you can specify a musical scale using the Parameter 1 and 2 columns. Parameter 1 is the key (C, C#, D, etc.) while Parameter 2 is the type of scale (major, melodic or harmonic minor, etc.).
Each note will be transposed to the closest note in the selected scale.

Use Value 2
This is only available when Action Target is set to Value 1. If this option is selected, the Value 2 setting in each event will be copied to the Value 1 setting.
This is useful, for example, if you are transforming all Modulation controllers to Aftertouch events (since controllers use Value 2 for their amount, while Aftertouch uses Value 1 — see “Searching for Value 1 or Value 2” on page 444).

Use Value 1
This is only available when Action Target is set to Value 2. If this option is selected, the Value 1 setting in each event will be copied to the Value 2 setting.

Mirror
This is only available when Action Target is set to Value 1 or Value 2. When this option is selected, the values will be “mirrored” around the value set in the Parameter 1 column.
In the case of notes, this will invert the scale, with the key set in the Parameter 1 column as “center point”.

Cubase only: NoteExp Operation – Remove Note Expression (Logical Editor only)
This option is only available for notes. It allows you to remove all Note Expression data from a note.

Cubase only: NoteExp Operation – Create One-Shot (Logical Editor only)
This option is only available for notes. It allows you to add Note Expression data for notes in “One Shot” mode, meaning that you add a parameter as Note Expression data. After having added the one-shot parameter, you have to set it to the desired value in a second go.

Cubase only: NoteExp Operation – Reverse (Logical Editor only)
Reverses the Note Expression data.

Linear Change in Loop Range (Logical Editor only)
This will affect events within the loop range (between the left and right locators) only. It will create a linear “ramp” of values (replacing the original values) starting at the value in the Parameter 1 column and ending at the Parameter 2 value.
This can be used for creating linear controller sweeps, velocity ramps, etc.

Relative Change in Loop Range (Logical Editor only)
As with the previous option, this will create a ramp of values, affecting events in the loop range only (i.e. between the locators). However, here the changes are “relative”, meaning that values will be added to the existing values.
In other words, you set up a value ramp starting at Parameter 1 and ending at Parameter 2 (note that the Parameter values can be negative). The resulting value ramp is then added to the existing values for the events within the loop range.
For example, if you apply this to note velocities with Parameter 1 set to 0 and Parameter 2 set to -100, you create a velocity fade-out, keeping the original velocity relations:
Applying the defined actions

Once you have set up filter conditions, selected a function and set the required actions (or loaded a preset), you apply the actions defined with the Logical Editor by clicking the Apply button.

⚠️ In the Logical Editor, processing is not performed until you click the Apply button. When using the Transformer MIDI effect, there is no Apply button – the current settings are automatically applied in realtime during playback or live playing.

Logical Editor operations can be undone just like any other editing.

Working with presets

The Presets pop-up menu at the top of the window allows you to load, store, and manage Logical Editor presets.

- To load a preset, select it from the Presets pop-up menu. If available, an explanatory text appears to the right of the menu. When setting up your own presets, you can click in this area and enter a description.
- You can also select Logical Presets directly from the MIDI menu. This allows you to apply a preset to the selected MIDI part, without having to open the Logical Editor.
- It is also possible to select and apply Logical Presets from within the List Editor (from the Mask menu).
- It is also possible to set up a key command for a preset. That way you can conveniently apply the same operation to several selected events in one go (for further information about setting up key commands, see the chapter “Key commands” on page 541).

Storing your own settings as a preset

If you have made Logical Editor settings that you want to use again, you can store them as a preset:

1. Click on the Store Preset button on the right of the Preset menu. A dialog for specifying a name for the new preset is displayed.
2. Enter a name for the preset and click OK. The preset is stored.

- To remove a preset, load it and click on the Remove Preset button.

Organizing and sharing presets

The Logical Editor presets are stored within the application folder in the Presets/Logical Edit subfolder. While these files cannot be edited “manually”, you can reorganize them (e.g. putting them in subfolders) like any files.

This also makes it easy to share presets with other Cubase users, by transferring the individual preset files.

- The list of presets is read each time the Logical Editor is opened.

The Input Transformer

This function allows you to filter out and change MIDI data coming to a MIDI track before it is recorded. The Input Transformer is very similar to the Transformer MIDI effect, but contains four independent “modules”, for which you can set up different filtering and actions. You can activate any or all of these four modules.

Here are some of the things the Input Transformer allows you to do:

- Set up split keyboard combinations for recording left and right hands separately.
- Turn a controller like a foot pedal into MIDI notes (for playing bass drum the right way).
- Filter out one specific type of MIDI data on one MIDI channel only.
- Turn aftertouch into any controller (and vice versa).
- Invert velocity or pitch.

Again: four of these things can be done at the same time.
Opening the Input Transformer
To open the Input Transformer for a MIDI track, select the track and click the Input Transformer button in the Inspector to open the pop-up menu.

• Select Global to make Input Transformer settings that affect all MIDI inputs (and thereby all MIDI tracks).
• Select Local to make Input Transformer settings for this track only.

In both cases, the button lights up and the Input Transformer opens.

Handling the four modules
The Input Transformer is really four separate transformers, or modules.
• You select which module to view and make settings for by clicking the corresponding Module tab.

Module 1 selected for viewing and editing.
• The On/Off buttons next to the Module names determine which module(s) are active.

The Function pop-up menu
The Function pop-up menu contains two options: Filter and Transform.
• In Filter mode, only the filter conditions (the upper list) are taken into account. All events matching the conditions set up will be filtered out (excluded from the recording).
• In Transform mode, events matching the filter conditions will be transformed according to the settings in the action list (the lower list).

Setting up filtering and actions
This is done just like in the Logical Editor. Here is a brief rundown:
• Click the “+” button to add lines to the filter condition list or action list. To remove a line, click it to select it and click the “−” button below the lists.
• Clicking the columns in the filter condition list opens pop-up menus allowing you to specify the conditions to match.
• Clicking the columns in the action list opens pop-up menus allowing you to specify how the found events are transformed (when Transform mode is selected).

For detailed descriptions of the filter conditions and action columns, see “General procedure” on page 442.
• The Input Transformer has no Apply button – the settings are active as soon as you activate the On/Off button of a module. The settings made in the active modules will affect all MIDI data you record on the track.

Closing the Input Transformer window does not turn it off – you need to deactivate the On/Off buttons of all modules for this! A lit Input Transformer button in the Inspector indicates that one or more modules are active.
The Project Logical Editor (Cubase only)
Introduction

On the Edit menu you will find the function “Project Logical Editor…”. This opens a Project Logical Editor for the entire project. It works similar to the Logical Editor on the MIDI menu, see the chapter “The Logical Editor, Transformer, and Input Transformer” on page 440. The most important difference is that the Logical Editor for MIDI works at the event level, whereas the Project Logical Editor works at the project level and is therefore a very powerful tool for “search and replace” functions in your entire project.

The MIDI events in the MIDI parts will not be affected by the Project Logical Editor operations. If you want to change MIDI notes or controller data, you have to use the Logical Editor.

With the Project Logical Editor, you can combine filter conditions with actions to create complex procedures, e.g. for special track type operations on tracks that are named identically. You can use its functions to delete all muted MIDI parts or to toggle the open state of all folder tracks in your project, etc.

Included with the Project Logical Editor are a number of presets that give you an impression of the great possibilities that this feature offers, see “Working with presets” on page 460. Many of them can also be used as starting points when you set up your own editing operations.

The principle for the Project Logical Editor is this:

• You set up filter conditions to find certain elements. This can be elements of a certain type, with certain attributes or values or on certain positions, in any combination. You can combine any number of filter conditions and make composite conditions using AND/OR operators.

• You select the basic function to be performed. The options are Transform (changing properties of the found elements), Delete (removing the elements) and Select (selecting the found elements).

• You set up a list of actions, which specify exactly what is done. This is not necessary for all functions. For example, the Delete function does not require any additional action specifications – it simply removes all found elements.

• In the Macro pop-up menu you can choose an additional macro that will be executed after the actions you defined. Use this to extend the possibilities offered by combining the filter conditions and actions specified in the Project Logical Editor even further.

By combining filter conditions, functions, the specific actions, and additional macros, you can perform very powerful processing.

⚠️ The Project Logical Editor allows all kinds of settings that may not always make sense. Experiment a bit before applying your edits to important projects. You can undo the operations by using the Undo command on the Edit menu.

Opening the Project Logical Editor

1. Open the desired project. All elements in the project will be affected, you do not have to make any selection.

2. Select “Project Logical Editor…” from the Edit menu.

Window overview

To understand the Project Logical Editor, it might be a good idea to start by exploring the included presets. These are found on the Presets pop-up menu at the top of the window. For information on how to create and handle your own presets, see “Working with presets” on page 460.
Setting up filter conditions

General procedure

The upper list is where you set up the filter conditions, determining which elements to find. The list contains one or several conditions, each on a separate line.

- To add a new condition, click the “+” button below the list. The new line is added at the bottom of the list. If there are many lines, you may need to use the scrollbar to the right to view them.
- To remove a condition, select it and click the Delete button (-) below the list.

If you have already defined filter conditions and/or applied a preset, but want to start again from scratch, you can initialize the settings by selecting the Init option from the Presets pop-up menu.

You set up a filter condition line by clicking in the columns and selecting options from the pop-up menus that appear. Here is a brief description of the columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left bracket</td>
<td>This is used for “bracketing” several lines together when creating conditions with multiple lines and the boolean operators And/Or, see “Combining multiple condition lines” on page 457.</td>
</tr>
<tr>
<td>Filter Target</td>
<td>Here you select which property to look for when finding elements. Your choice here affects the available options in the other columns as well, see below!</td>
</tr>
<tr>
<td>Condition</td>
<td>This determines how the Project Logical Editor compares the property in the Filter Target column to the values in the Parameter columns. The available options depend on the Filter Target setting.</td>
</tr>
<tr>
<td>Parameter 1</td>
<td>Here you set which value the element properties are compared to (depending on the Filter Target). For example, if the Filter Target is “Position” and Condition is “Equal”, the Project Logical Editor will look for all elements starting at the position you specify in the Parameter 1 column.</td>
</tr>
<tr>
<td>Parameter 2</td>
<td>This column is only used if you have selected one of the “Range” options in the Condition column. Typically, this allows you to find all elements with values inside (or outside) the range between Parameter 1 and Parameter 2.</td>
</tr>
</tbody>
</table>

Below, the different Filter Targets (and their corresponding Condition and Parameter options) are described in more detail.

Searching for Media types

1. Select “Media Type” in the Filter Target pop-up menu. This allows you to find elements of certain types of media only.
2. Open the pop-up menu in the Parameter 1 column and select the desired option.

When the Filter Target is set to Media Type, the pop-up menu lists the available media types. The following table lists what will be found:

<table>
<thead>
<tr>
<th>Media Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>If no container type is specified, this finds audio events, audio parts and audio tracks.</td>
</tr>
<tr>
<td>MIDI</td>
<td>If no container type is specified, this finds MIDI parts and MIDI tracks.</td>
</tr>
<tr>
<td>Automation</td>
<td>If no container type is specified, this finds automation events and automation tracks.</td>
</tr>
<tr>
<td>Marker</td>
<td>If no container type is specified, this finds marker events and marker tracks.</td>
</tr>
<tr>
<td>Transpose</td>
<td>If no container type is specified, this finds transpose events and transpose tracks.</td>
</tr>
<tr>
<td>Arranger</td>
<td>If no container type is specified, this finds arranger events and arranger tracks.</td>
</tr>
<tr>
<td>Tempo (Cubase only)</td>
<td>If no container type is specified, this finds tempo events and tempo tracks.</td>
</tr>
<tr>
<td>Signature</td>
<td>If no container type is specified, this finds signature events and signature tracks.</td>
</tr>
</tbody>
</table>
3. Open the pop-up menu in the Condition column and select the desired condition.
For media types, the following options are available:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal</td>
<td>This finds the Media Type set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>All Types</td>
<td>This finds all Media Types.</td>
</tr>
</tbody>
</table>

For example, if you have set up the Project Logical Editor like this...

For media types, the following options are available:

…it will find all marker events and tracks in the project.

**Searching for Container types**

1. Select Container Type in the Filter Target pop-up menu. This allows you to find parts, events or tracks.

2. Open the pop-up menu in the Parameter 1 column and select the desired option.
When the Filter Target is set to Container Type, the pop-up menu lists the available container types. The following table lists what will be found:

<table>
<thead>
<tr>
<th>Container Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder Track</td>
<td>This finds all folder tracks, included FX Channel and Group Channel folders.</td>
</tr>
<tr>
<td>Track</td>
<td>This finds all track types.</td>
</tr>
<tr>
<td>Part</td>
<td>This finds audio, MIDI, and instrument parts. Folder parts will not be found.</td>
</tr>
<tr>
<td>Event</td>
<td>This finds automation points, markers, as well as audio, arranger, transpose, tempo and time signature events.</td>
</tr>
</tbody>
</table>

3. Open the pop-up menu in the Condition column and select the desired condition.
For container types, the following options are available:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal</td>
<td>This finds the Container Type set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>All Types</td>
<td>This finds all Container Types.</td>
</tr>
</tbody>
</table>

For example, if you have set up the Project Logical Editor like this...

…it will find all Folder tracks in the project.

**Combining Media Type and Container Type**
The combination of the filter targets Media Type and Container Type represents a versatile tool for logical operations:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal</td>
<td>This finds the Media Type set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>All Types</td>
<td>This finds all Media Types.</td>
</tr>
</tbody>
</table>

Here, the Project Logical Editor will find all MIDI and instrument parts in the project.

Here, the Project Logical Editor will find all automation tracks (not events) in the project whose name contains "vol".

Here, the Project Logical Editor will find all MIDI and instrument parts (not tracks) in the project that are muted.

Here, the Project Logical Editor will find all MIDI and instrument parts (not tracks) or all audio events (not parts or tracks) in the project that are muted.

**Searching for Names**

1. Select Name on the Filter Target pop-up menu.

2. Enter the desired name, or a part of a name in the Parameter 1 column.

3. Open the pop-up menu in the Condition column and select the desired condition.
For names, the following options are available:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal</td>
<td>This is the exact same text string as set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Contains</td>
<td>This contains the text specified in the Parameter 1 column.</td>
</tr>
</tbody>
</table>

For example, if you have set up the Project Logical Editor like this...

…it will find all tracks in the project whose name contains "voc".
To take maximum advantage of this feature, we recommend using a standard nomenclature in your projects (Drums, Perc, Voc, etc.).

**Searching for elements at certain positions**

1. Select “Position” in the Filter Target pop-up menu. This allows you to find elements starting at certain positions, either relative to the start of the project or within each bar.

2. Open the pop-up menu in the Condition column and select the desired condition.

For positions, the following options are available:

<table>
<thead>
<tr>
<th>Condition</th>
<th>An element will be found if it…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal</td>
<td>…has the exact same value as set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Unequal</td>
<td>…has any value other than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Bigger</td>
<td>…has a value higher than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Bigger or Equal</td>
<td>…has a value that is the same as or higher than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Less</td>
<td>…has a value lower than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Less or Equal</td>
<td>…has a value that is the same as or lower than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Inside Range</td>
<td>…has a value that is between the values set up in the Parameter 1 and Parameter 2 columns.</td>
</tr>
<tr>
<td>Outside Range</td>
<td>…has a value that is not between the values set up in the Parameter 1 and Parameter 2 columns.</td>
</tr>
<tr>
<td>Inside Bar Range</td>
<td>…is within the “zone” set up in the Bar Range/Time Base column, in each bar within the current selection.</td>
</tr>
<tr>
<td>Outside Bar Range</td>
<td>…is outside the “zone” set up in the Bar Range/Time Base column, in each bar within the current selection.</td>
</tr>
<tr>
<td>Before Cursor</td>
<td>…is before the song Project position.</td>
</tr>
<tr>
<td>Beyond Cursor</td>
<td>…is after the song Project position.</td>
</tr>
<tr>
<td>Inside Track Loop</td>
<td>…is inside the set track loop (see “The independent track loop function” on page 297).</td>
</tr>
<tr>
<td>Inside Cycle</td>
<td>…is inside the set cycle.</td>
</tr>
<tr>
<td>Cycle</td>
<td>…exactly matches the set cycle.</td>
</tr>
</tbody>
</table>

- If you select any condition other than the Range, Bar Range, Cursor, Loop or Cycle options, you set up a specific position (in PPQ, seconds, samples, or frames) in the Parameter 1 column. Use the Bar Range/Time Base column to specify the time base. Note that the position for Bar Range is measured in ticks related to the start of the bar. Here, the Project Logical Editor will find all elements at the PPQ position 5.1.1. in the project.

- If you select Inside Range or Outside Range in the Condition column, you set the start position of the range in the Parameter 1 column and the end position in the Parameter 2 column. You can also change the time base using the Bar Range/Time Base column. The Project Logical Editor will then find all elements inside or outside this position range.

- If you select one of the Bar Range options in the Condition column, the Bar Range/Time Base column will show a graphic bar display. You specify the range within the bar by clicking and dragging in the bar display (the specified Bar Range is indicated in blue). The Project Logical Editor will then find all elements starting inside or outside this Bar Range, in all bars (within the current selection).

Here, the Project Logical Editor will find elements starting around the second beat in each bar.

**Searching for elements of certain lengths**

1. Select Length in the Filter Target pop-up menu. This allows you to find elements of a certain length only. The Length parameter is interpreted via the time base setting in the Bar Range/Time Base column, i.e. in PPQ, seconds, samples, or frames.

2. Open the pop-up menu in the Condition column and select the desired condition.

For lengths, the following options are available:

<table>
<thead>
<tr>
<th>Condition</th>
<th>An element will be found, if it…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal</td>
<td>…has the exact same value as set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Unequal</td>
<td>…has any value other than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Bigger</td>
<td>…has a value higher than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Bigger or Equal</td>
<td>…has a value that is the same as or higher than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Less</td>
<td>…has a value lower than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Less or Equal</td>
<td>…has a value that is the same as or lower than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Inside Range</td>
<td>…has a value that is between the values set up in the Parameter 1 and Parameter 2 columns.</td>
</tr>
<tr>
<td>Inside Bar Range</td>
<td>…is within the “zone” set up in the Bar Range/Time Base column, in each bar within the current selection.</td>
</tr>
<tr>
<td>Inside Track Loop</td>
<td>…is inside the set track loop (see “The independent track loop function” on page 297).</td>
</tr>
<tr>
<td>Inside Cycle</td>
<td>…is inside the set cycle.</td>
</tr>
</tbody>
</table>

The Project Logical Editor (Cubase only)
The Project Logical Editor (Cubase only)

If you select any condition other than the Range options, you set up a specific position in the Parameter 1 column.

<table>
<thead>
<tr>
<th>Condition</th>
<th>An element will be found, if it…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Less</td>
<td>…has a value lower than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Less or Equal</td>
<td>…has a value that is the same as or lower than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Inside Range</td>
<td>…has a value that is between the values set up in the Parameter 1 and Parameter 2 columns. Note that Parameter 1 should be the lower value and Parameter 2 the higher.</td>
</tr>
<tr>
<td>Outside Range</td>
<td>…has a value that is not between the values set up in the Parameter 1 and Parameter 2 columns.</td>
</tr>
</tbody>
</table>

Note that “event” in this context refers to all the Project window elements that can be modified, e.g. MIDI parts, audio events and parts, or transpose, arranger, and automation events.

Three examples:

Here, the Project Logical Editor will find all audio parts and events in the project with a length smaller than 200 samples.

Searching for properties

1. Select “Property” on the Filter Target pop-up menu.
2. Open the pop-up menu in the Condition column and select the desired condition.
   - When the Property option is selected, the Condition column has two options: “Property is set”, and “Property is not set”.
3. Open the pop-up menu in the Parameter 1 column and select the desired option.
   - This sets which property will be searched. The options are “Event is muted”, “Event is selected”, and “Event is Empty”.
   - Note that “event” in this context refers to all the Project window elements that can be modified, e.g. MIDI parts, audio events and parts, or transpose, arranger, and automation events.

Combining multiple condition lines

As described above, you can add condition lines by clicking the “+” button below the list. The result of combining condition lines depends on the boolean And/Or operators and the brackets.

The bool column

By clicking in the “bool” column to the right in the list, you can select a boolean operator: “And” or “Or”. A boolean operator combines two condition lines and determines the result in the following way:

- If two condition lines are combined with a boolean And, both conditions must be fulfilled for an element to be found.

Here, the Project Logical Editor will find all selected but not muted.

Here, the Project Logical Editor will find all muted MIDI and instrument parts.

Here, the Project Logical Editor will find all selected audio parts that are empty.

Less

…has a value lower than the one set up in the Parameter 1 column.

Less or Equal

…has a value that is the same as or lower than the one set up in the Parameter 1 column.

Inside Range

…has a value that is between the values set up in the Parameter 1 and Parameter 2 columns. Note that Parameter 1 should be the lower value and Parameter 2 the higher.

Outside Range

…has a value that is not between the values set up in the Parameter 1 and Parameter 2 columns.

The Project Logical Editor will only find MIDI tracks.
If two condition lines are combined with a boolean Or, one of the conditions (or both) must be fulfilled for an element to be found.

The Project Logical Editor will find all parts or events that match exactly the cycle.

⚠️ When you add a new condition line, the boolean setting defaults to And. Therefore, if all you want to do is set up two or more conditions that all must be met for an element to be found, you do not have to think about the boolean column – just add the required lines and make the usual filter settings.

**Using brackets**

The bracket (parenthesis) columns let you enclose two or more condition lines, dividing the conditional expression into smaller units. This is only relevant when you have three or more condition lines and want to use the boolean Or operator.

You add brackets by clicking in the bracket columns and selecting an option. Up to triple brackets can be selected.

⚠️ Without brackets, the conditional expressions are evaluated according to their order in the list.

Here, the Project Logical Editor will find all audio parts and events whose name contains perc as well as other parts and events (e.g. MIDI parts) whose name contains drums.

Maybe you want to find all audio parts and events that either had the name perc or the name drums (but no other parts or events named drums)? Then you need to add some brackets:

Here, all audio parts or events will be found whose name contains perc or drums.

⚠️ Expressions within brackets are evaluated first.

If there are several layers of brackets, these are evaluated “from the inside out”, starting with the innermost brackets.

---

**Specifying actions**

The lower list in the Project Logical Editor window is the action list. This is where you specify any changes that are made to the found elements, relevant for the function type Transform.

You can perform two different kinds of actions: track-based actions (such as Track Operation, Name) and event-based actions (such as Position, Length, Name). There are also actions that only take effect on automation data (Trim).

The handling of the action list is similar to the filter condition list, but without the brackets and booleans. You simply add lines by clicking the “+” button, and fill out the columns as required. To remove a superfluous action line, select it and click the “-” button.

**Action Target**

This is where you select the property that is changed. The Operations determine what to do with the Action Target. Below, all available operations are listed:

**Position**

Adjusting this value will move the elements. This parameter is interpreted via the time base setting in the Bar Range/ Time Base column, with the exception of the Random setting, which uses the time base of the affected events:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Adds the value specified in the Parameter 1 column to the Position.</td>
</tr>
<tr>
<td>Subtract</td>
<td>Subtracts the value specified in the Parameter 1 column from the Position.</td>
</tr>
<tr>
<td>Multiply by</td>
<td>Multiplies the Position value with the value specified in the Parameter 1 column.</td>
</tr>
<tr>
<td>Divide by</td>
<td>Divides the Position value by the value specified in the Parameter 1 column.</td>
</tr>
<tr>
<td>Round by</td>
<td>This &quot;rounds&quot; the Position value using the value specified in the Parameter 1 column. In other words, the Position value is changed to the closest value that can be divided by the Parameter 1 value. For example, if the Position value is 17 and Parameter 1 is 5, the result of rounding will be 15 (the closest value that can be divided by 5). Another word for this type of operation would be “quantizing”, and it is actually possible to use it for this, by specifying a quantize value with Parameter 1 (in ticks, with 480 ticks per quarter note).</td>
</tr>
</tbody>
</table>
### Length

Lets you resize the elements. This parameter is interpreted via the time base setting in the Bar Range/Time Base column, with the exception of the Random setting, which uses the time base of the affected events:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Relative</td>
<td>This will add a random value to the current Position value. The added random value will be within the range specified with Parameter 1 and 2. Note that these can be set to negative values. For example, if you set Parameter 1 to -20 and Parameter 2 to +20, the original Position value will get a random variation, never exceeding ±20.</td>
</tr>
<tr>
<td>Random Values</td>
<td></td>
</tr>
<tr>
<td>Subtract</td>
<td>Subtracts the value specified in the Parameter 1 column from the Length.</td>
</tr>
<tr>
<td>Multiply by</td>
<td>Multiplies the Length value with the value specified in the Parameter 1 column.</td>
</tr>
<tr>
<td>Divide by</td>
<td>Divides the Length value by the value specified in the Parameter 1 column.</td>
</tr>
<tr>
<td>Round by</td>
<td>This “rounds” the Length value using the value specified in the Parameter 1 column. In other words, the Length value is changed to the closest value that can be divided by the Parameter 1 value.</td>
</tr>
<tr>
<td>Set to fixed</td>
<td>This sets the Position to the value specified in the Parameter 1 column.</td>
</tr>
<tr>
<td>Value</td>
<td></td>
</tr>
<tr>
<td>Set Random</td>
<td>This will add a random value to the current length. The added random value will be within the range specified with Parameter 1 and 2.</td>
</tr>
<tr>
<td>Values between</td>
<td></td>
</tr>
</tbody>
</table>

### Track Operation

This lets you change the track status.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Opens, closes or toggles folders.</td>
</tr>
<tr>
<td>Record</td>
<td>Enables, disables or toggles the record enable status.</td>
</tr>
<tr>
<td>Monitor</td>
<td>Enables, disables or toggles the monitor status.</td>
</tr>
<tr>
<td>Solo</td>
<td>Enables, disables or toggles the solo status.</td>
</tr>
<tr>
<td>Mute</td>
<td>Enables, disables or toggles the mute status.</td>
</tr>
<tr>
<td>Read</td>
<td>Enables, disables or toggles the read enable status.</td>
</tr>
<tr>
<td>Write</td>
<td>Enables, disables or toggles the write enable status.</td>
</tr>
<tr>
<td>EQ Bypass</td>
<td>Enables, disables or toggles the EQ bypass status.</td>
</tr>
<tr>
<td>Inserts Bypass</td>
<td>Enables, disables or toggles the inserts bypass status.</td>
</tr>
</tbody>
</table>

### Name

This lets you rename the found elements.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace</td>
<td>Replaces names with the text specified in the Parameter 1 column.</td>
</tr>
<tr>
<td>Append</td>
<td>Names will be appended with the string specified in the Parameter 1 column.</td>
</tr>
<tr>
<td>Prepend</td>
<td>The name will be prepended with the string specified in the Parameter 1 column.</td>
</tr>
<tr>
<td>Generate Name</td>
<td>The name will be replaced by the text specified in the Parameter 1 column, followed by the number set with Parameter 2. The number will be increased by 1 for every found element.</td>
</tr>
<tr>
<td>Replace Search</td>
<td>You can specify a search string under Parameter 1 that is replaced by the text specified in the Parameter 2 column.</td>
</tr>
</tbody>
</table>

### Trim

This Action Target is used for automation only and lets you trim the found elements.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiply by</td>
<td>Multiplies the Trim value with the value specified in the Parameter 1 column.</td>
</tr>
<tr>
<td>Divide by</td>
<td>Divides the Trim value by the value specified in the Parameter 1 column.</td>
</tr>
</tbody>
</table>

### Set Color

This lets you set the color for an element. For this Action Target the only Operation available is “Set to fixed value”. To use this, insert the name of a track color in the Parameter 1 column, e.g. “Color 7” to use dark green as track color.
Selecting a function

The left pop-up menu at the bottom of the Project Logical Editor is where you select the function – the basic type of editing to be performed.

The available options are:

**Delete**
Deletes all elements found by the Project Logical Editor.

- When you delete automation tracks and undo this operation by selecting Undo from the Edit menu, the automation tracks will be restored, but the tracks will be closed.

**Transform**
Changes one or several aspects of the found elements. You set up exactly what is changed in the action list.

**Select**
This will simply select all found elements, highlighting them for further work in the Project window.

Applying Macros

In the Macro pop-up menu you can select a macro that will be executed automatically after completing the actions defined using the Filter and Action lists. This is useful if you would like to extend the already powerful Project Logical Editor features even further.

To use this, you set up the macro that you need in the Key Commands dialog (see “Setting up key commands” on page 542) and then select it in the Project Logical Editor from the Macro pop-up menu.

For example, you can use the filter conditions to select all tracks that contain automation data for a certain automation parameter (such as “volume”) and use the macro “Select all on Track + Delete” to remove the automation events from these tracks (without deleting the tracks themselves).

Applying the defined actions

Once you have set up filter conditions, selected a function and set the required actions (or loaded a preset), you apply the actions defined with the Project Logical Editor by clicking the Apply button.

Project Logical Editor operations can be undone just like any other editing.

Working with presets

The Presets section in the upper left section of the window allows you to load, store and manage Project Logical Editor presets. A preset contains all settings in the window, which means you can simply load a preset, edit the settings (if necessary) and click Apply.

- To load a preset, select it from the Presets pop-up menu. If available, an explanatory text appears to the right of the menu. When setting up your own presets, you can click in this area to enter a description.
- You can also open the Edit menu and select Presets directly from the “Process Project Logical Editor” submenu. This allows you to apply a preset directly, without having to open the Project Logical Editor.

Storing your own settings as a preset

If you have made Project Logical Editor settings that you want to use again, you can store them as a preset:

1. Click the Store Preset button to the right of the Presets pop-up menu.
   A dialog for specifying a name for the new preset is displayed.
2. Enter a name for the preset and click OK.
   The preset is stored.

- To remove a preset, load it and click the Remove Preset button.

Organizing and sharing presets

The Project Logical Editor presets are stored within the application folder in the Presets\Logical Edit Project subfolder. While these files cannot be edited manually, you can reorganize them (e.g. putting them in subfolders) like any files.
The Project Logical Editor (Cubase only)

This also makes it easy to share presets with other Cubase users, by transferring the individual preset files.

The list of presets is read each time the Project Logical Editor is opened.

Setting up key commands for your presets

If you have stored Project Logical Editor presets, you can set up key commands for them:

1. Pull down the File menu and select “Key Commands…”.
   The Key Commands dialog opens.

2. Use the list in the Commands column to navigate to the category “Process Project Logical Editor” and click the “+” sign to display the items in the folder.

3. In the list, select the item to which you wish to assign a key command, click in the “Type in Key” field and enter a new key command.

4. Click the Assign button above the field.
   The new key command appears in the Keys List.

5. Click OK to exit the dialog.

For more information on Key Commands, see the chapter “Key commands” on page 541.
Editing tempo and signature
Background
Whenever you create a new project, Cubase will automatically set the tempo and time signature for this project. The tempo and signature settings can be displayed in two ways: either on dedicated tracks in the Project window or in the Tempo Track Editor.

Tempo modes
Before we go into detail about tempo and signature settings, you should understand the different tempo modes.

For each track in Cubase that can make use of this function, you can specify whether it is time-based or tempo-based (see “Defining the track time base” on page 74). For tempo-based tracks, the tempo can either be fixed throughout the entire project (this is called “fixed tempo mode”) or follow the tempo track (this is called “tempo track mode”), which may contain tempo changes.

• To switch between fixed tempo mode and tempo track mode, use the Tempo button on the Transport panel:

When the Tempo button is lit (and the text “Track” is shown), the tempo follows the tempo track; when it is deactivated (and the text “Fixed” is shown), a fixed tempo is used (see “Setting the fixed tempo” on page 466). You can also switch the tempo mode with the Activate Tempo Track button on the Tempo Track Editor toolbar.

In tempo track mode, the tempo cannot be changed on the Transport panel, i.e. the tempo information here is for display purposes only.

Signature events are always active, regardless of whether fixed tempo mode or tempo track mode is selected.

A note about tempo-based audio tracks
For tempo-based tracks, the start position of audio events on the timeline depends on the current tempo setting. However, it is important to realize that the actual audio (“within” the events) will play back as recorded, regardless of any tempo changes you make. Therefore, it is good practice to make the proper tempo and time signature settings before you start recording tempo-based audio.

• To make an already recorded audio track follow the tempo changes, you can use the Tempo Detection Panel (see “Tempo Detection (Cubase only)” on page 473) or the Sample Editor, see the chapter “The Sample Editor” on page 261.

• To adapt the tempo track to time-based material, you can use the Time Warp tool, see “The Time Warp tool (Cubase only)” on page 469. This allows you to adjust the tempo track so that tempo-based material (e.g. positions in music) coincides with time-based material (positions in narration, video, etc.).

Tempo and signature display
You can view the current tempo and signature settings of your project in a number of ways:

• On the Transport panel.
  See above, and the section “The Transport panel” on page 83.

• By displaying the tempo track and the signature track in the Project window.
  Open the Project menu, select Add Track and the Signature and/or Tempo options.

• In the Tempo Track Editor.
  Open the Project menu and select Tempo Track Editor, or [Ctrl]/[Command]-click the Tempo button on the Transport panel.

About the tempo and signature tracks
The tempo track and the signature track allow you to view and edit tempo and signature data in the project context.

• The Inspectors for these tracks show the positions and values of individual tempo curve points or signature events.
• The signature track’s background always shows bars. This is independent of the ruler display format setting.

• In the track list for the tempo track, on the far right, you can specify the display range by clicking on the numbers at the top or bottom and dragging up or down. Note that this does not change the tempo setting, but changes the display scale of the tempo track.

• You can lock the tempo track and the signature track to prevent unintentional editing. Simply click the lock symbols in the track list to lock/unlock the tracks.

About the Tempo Track Editor

If you do not want to display two extra tracks in the Project window, you can also open the Tempo Track Editor to view and edit tempo and signature information.

The Tempo Track Editor has a toolbar, info line, and ruler just like other editors in Cubase, plus an area for the display of time signature events and a tempo curve display.

The toolbar

The toolbar contains various tools and settings:

- The tools for Object Selection, Erase, Zoom and Draw are used in the same way as in other editors. The Snap and Auto-Scroll functions also work exactly like in the Project window. Note that in the Tempo Track Editor, the Snap function affects tempo events only. Time signature events always snap to the beginning of bars.

- The info line in the Tempo Track Editor allows you to change settings for selected time signature events, and the type and tempo of selected tempo curve points.

- The ruler in the Tempo Track Editor shows the timeline, and is similar to the ruler in the Project window. See “The ruler” on page 44 for details.

- The area below the ruler shows time signature events.

- The main display shows the tempo curve (or, if fixed tempo mode is selected, the fixed tempo – see “Setting the fixed tempo” on page 466). To the left of the display you will find a tempo scale to help you quickly locate the desired tempo. Note that the vertical “grid lines” in the tempo curve display correspond to the display format selected for the ruler.
Editing tempo and signature

You can use the options of the Tempo Track Editor or the tempo and signature tracks to edit tempo and signature settings. The descriptions given below are valid in both cases. The only exception is the tempo recording slider, which is available only in the Tempo Track Editor (see "Recording tempo changes (Cubase only)" on page 466).

Editing the tempo curve

⚠️ This section assumes that you are working in tempo track mode, i.e. the Tempo button must be activated on the Transport panel.

Adding tempo curve points

1. Use the “Insert curve” pop-up menu (on the toolbar of the Tempo Track Editor) or the “Type of New Tempo points” pop-up menu in the track list for the tempo track to select whether you want the tempo to change gradually from the previous curve point to the new one (“Ramp”) or change instantly to the new value (“Jump”).
You can also set this to Automatic. In this case, the types of existing tempo curve points will be used when inserting new points at the same position.

2. Select the Pencil tool.

3. Click and drag in the tempo curve display to draw a tempo curve.
When you click, the tempo display on the toolbar shows the tempo value.
If Snap is activated on the toolbar, this determines at which time positions you can insert tempo curve points, see "The Snap function" on page 45.

- You can also click on the tempo curve with the Arrow tool.
This adds a single point with each click.

➤ Tempo values can also be automatically inserted by the Beat Calculator, see "The Beat Calculator" on page 468.

Selecting tempo curve points

Curves points can be selected as follows:

- Using the Arrow tool.
The standard selection techniques apply.
- Using the Select submenu of the Edit menu.
The options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects all curve points on the tempo track.</td>
</tr>
<tr>
<td>None</td>
<td>Deselects all curve points.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all curve points between the left and right locator.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all points to the left of the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all points to the right of the project cursor.</td>
</tr>
</tbody>
</table>

- You can also use the left and right arrow keys on the computer keyboard to go from one curve point to the next.
If you press [Shift] and use the arrow keys, you can select several points at the same time.

Editing tempo curve points

Curves points can be edited in the following ways:

- By clicking and dragging horizontally and/or vertically with the Arrow tool.
If several points are selected, all of them are moved. If Snap is activated on the toolbar, this determines to which time positions you can move curve points, see "The Snap function" on page 45.

- By adjusting the tempo value in the tempo display on the Tempo Track Editor toolbar, in the Inspector, or on the info line.

➤ Selecting several points and changing the tempo value in the info line leads to a relative adjustment of the tempo values.

⚠️ We recommend using the Bars+Beats display format when editing tempo curves. Otherwise, you may get confusing results. This is because moving a point will change the relationship between tempo and time. If you move a tempo point to the right and drop it at a certain time position, the mapping between tempo and time will be adjusted. Since you have changed the tempo curve, the moved point will appear at another position.
Adjusting the curve type

You can change the curve type of a tempo curve segment at any time, using the following method:

1. With the Arrow tool, select all curve points within the segment you want to edit.

2. In the info line, click below the word “Type” to switch the curve type between “Jump” and “Ramp”. The curve sections between the selected points are adjusted.

Removing tempo curve points

To remove a curve point, either click on it with the Erase tool or select it and press [Backspace]. The first tempo curve point cannot be removed.

Recording tempo changes (Cubase only)

The Tempo Recording slider on the toolbar of the Tempo Track Editor allows you to record tempo changes “on the fly”: simply start playback and use the slider to raise or lower the tempo at the desired positions. This is useful for creating natural sounding ritardandos, etc.

Setting the fixed tempo

When the tempo track is deactivated, the tempo track curve is grayed out (but still visible). Since the tempo is fixed throughout the whole project, there are no tempo curve points. Instead, the fixed tempo is displayed as a horizontal black line in the tempo curve display.

To set the tempo in fixed mode:

• Adjust the value numerically in the tempo display on the Tempo Track Editor toolbar or in the track list.

• On the Transport panel, click on the tempo value to select it, enter a new value and press [Enter].

Adding and editing time signature events

• To add a time signature event, click with the Pencil tool in the time signature area or time signature track. This adds a default 4/4 time signature event at the closest bar position.

• To edit the value of a time signature event, select it and adjust the value on the info line, or double-click the event and enter a new value. Note that there are two controls for the signature display; the left one adjusts the numerator and the right one adjusts the denominator.

• To move a time signature event, click and drag it with the Arrow tool. Note that you can [Shift]-click to select multiple events. Also note that time signature events can only be positioned at the start of bars. This is also true if Snap is deactivated.

• To remove a time signature, either click on it with the Erase tool or select it and press [Backspace] or [Delete]. The first time signature event cannot be removed.
Exporting and importing tempo tracks (Cubase only)

You can export the current tempo track for use in other projects by selecting “Tempo Track” from the “Export” submenu of the File menu. This allows you to save the tempo track information (including time signature events) as a special XML file (file extension “.smt”).

To import a tempo track, select “Tempo Track” from the Import submenu of the File menu. Note that this replaces all tempo track data in the current project (although the operation can be undone if needed).

Process Tempo (Cubase only)

Process Tempo allows you to define a specific length or end time for a set range, and the tempo track will automatically set a tempo that will fit the range in the specified time.

Proceed as follows:

1. Specify a region or range that you wish to process by setting the left and right locators, either in the Tempo Track Editor or in the Project window.

2. Click on the Process Tempo button (either in the Tempo Track Editor or on the tempo track). The Process Tempo dialog opens.

3. In the Process Range fields, the specified range is shown, in Bars and Beats (PPQ) and in a time format, which can be selected from the Time Display Format pop-up menu.

   The range defined in step 1 will already be set, but you can edit the range by adjusting the values in the Process Range fields if you wish.

Now you can either specify a new range length or a new range end time. What to choose depends on whether the range should have a specific length or whether it should end at a specific time position.

4. Enter the desired End or Length in the corresponding fields of the New Range section. You can select a time format for the new range in the Time Display Format pop-up menu.

5. Click Process. Now the tempo track is automatically adjusted, and the range will have the specified duration.

The Process Bars dialog (Cubase only)

The Process Bars dialog (opened from the Tempo Track Editor or the signature track) uses the global “Insert Silence” and “Delete Time” functions from the Range submenu of the Edit menu. However, the necessary ranges (or parameters) are calculated using a musical “bars+beats-based” environment. The function also ensures that the time signatures stay “in sync” after these operations. This allows for a much more intuitive approach when inserting, deleting or replacing “time” while working with a project set to the Bars+Beats time type.

The dialog contains the following elements:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar Range</td>
<td>The Bar Range display shows the bar range within the project as well as its length. Click on the right edge of the green indicator and drag it to the right to enlarge the range. You can also use the Start and Length value fields (see below). The arrow pair in this section marks the length of the current project. The area to the right marks the bar range that can be added (500 bars max.).</td>
</tr>
<tr>
<td>Bar Range – Start</td>
<td>This is where you specify the start position for the bar range. Click on the arrows to raise/lower the value or click directly in the value field to enter the value manually.</td>
</tr>
<tr>
<td>Bar Range – Length</td>
<td>This is where you specify the length of the bar range. Click on the arrows to raise/lower the value or click directly in the value field to enter the value manually.</td>
</tr>
</tbody>
</table>
The Beat Calculator

The Beat Calculator is a tool for calculating the tempo of freely recorded audio or MIDI material. It also allows you to set the tempo by tapping.

Calculating the tempo of a recording

1. In the Project window, make a selection that covers an exact number of beats of the recording.
2. Select “Beat Calculator…” from the Project menu.
   The Beat Calculator window appears.
3. In the Beats field, enter the number of beats that the selection encompasses.
   The corresponding tempo is calculated and displayed in the BPM field.
   - If you need to adjust the selection, you can go back to the Project window, leaving the Beat Calculator open.
   To re-calculate the tempo after adjusting the selection, click Refresh.
4. You can also insert the calculated tempo into the tempo track by clicking one of the buttons in the lower left corner of the Beat Calculator window.
   Clicking “At Tempo Track Start” will adjust the first tempo curve point, while “At Selection Start” will add a new tempo curve point at the selection’s start position, using the “Jump” curve type (see “Adding tempo curve points” on page 465).

Using Tap Tempo

The Tap Tempo function allows you to specify a tempo by tapping:

1. Open the Beat Calculator.
2. If you want to tap the tempo to some recorded material, activate playback.
3. Click the Tap Tempo button.
   The Tap Tempo window appears.
4. Tap the tempo on the Spacebar of the computer keyboard or with the mouse button.
   The tempo display will update the calculated tempo between each tap.
5. Click OK to close the Tap Tempo dialog.
   The tapped tempo is now shown in the Beat Calculator’s BPM display.
   You can insert it into the tempo track as described above.
**Merge Tempo From Tapping (Cubase only)**

This function allows you to create a complete tempo track based on your tapping. Typically, you would use this if you have an audio file with no tempo mapping and want to be able to add other material afterwards, etc.

1. Create an empty time-based MIDI track and, while playing back your audio material, tap the new tempo on your MIDI keyboard and record the created notes onto the new MIDI track.
   Note that you must create note events – pedal events cannot be used for this function.

2. Play back the audio and check that the timing of the MIDI notes corresponds to that of the audio.
   If necessary, edit the MIDI notes in an editor.

3. Select the MIDI part (or the individual notes in an editor) that you want to use for the calculation.

4. Select “Merge Tempo From Tapping” from the Functions submenu of the MIDI menu.
   A dialog opens.

5. In the dialog, specify what type of note (1/2, 1/4, etc.) you tapped during the recording.
   If you activate the “Begin at Bar Start” option, the first note will automatically start at the beginning of a bar when calculating the new tempo curve.

6. Click OK.
   The project’s tempo is adjusted to the tapped notes.

7. Open the Project menu and select “Tempo Track” to check that the new tempo information is reflected in the tempo curve.

Another way of creating a tempo map for freely recorded audio would be to use the Time Warp tool, see below.

**The Time Warp tool (Cubase only)**

The Time Warp tool lets you adjust the tempo track so that “musical time-based” material (positions related to the tempo) matches “linear time-based” material (positions in time). Some typical applications:

- When you have recorded music (audio or MIDI) without tempo reference or metronome click, the Time Warp tool can be used for creating a tempo map that fits the recording (allowing you to rearrange or add other material).

- When you are creating music for a movie and want to match certain positions in the video with certain positions in the music.

The Time Warp tool makes use of the fact that tracks can be based on time positions (linear time base) or positions related to tempo (musical time base), see “Defining the track time base” on page 74 for a description of these modes.

**Basic procedure**

You use the Time Warp tool to drag a musical position (a position in bars+beats format) to a certain position in time. This can be done in the Project window or in an editor, as described below. Here is the general procedure:

1. Make sure tempo track mode is active.
   You cannot use the Time Warp tool in fixed tempo mode.

2. Select the Time Warp tool.

Bars+Beats format is automatically selected for the ruler in the active window, and the ruler is shown in brown.

3. Click in the window at a musical position and drag it so that it matches a position in the material you are editing — e.g. the start of an event, a certain “hit” within an audio event, a frame in a video clip, etc.
   When you click with the Time Warp tool, it snaps to the grid in the window.

Dragging the start of the bar to the start of the audio event.
Editing tempo and signature

470

While you are dragging, the track(s) you are editing are temporarily switched to linear time base. This means that the contents of the tracks remain at the same time positions regardless of the tempo (there is an exception to this in the Project window, see below).

4. When you release the mouse button, the musical position you clicked on matches the time position you dragged it to. This is because the Time Warp tool changed the last tempo event on the tempo track (and/or added new ones, depending on window and usage), thereby scaling the tempo track to fit.

Rules

• When you use the Time Warp tool, the tempo value of the last tempo event (before the click position) is adjusted.
• If later tempo events exist, a new tempo event will be created at the click position. This way, the later tempo event(s) will not be moved.
• If you press [Shift] and use the Time Warp tool, a new tempo event is created at the click position. [Shift] is the default modifier for this – you can adjust this in the Preferences dialog (Editing–Tool Modifiers page).
• If you use the Time Warp tool in an editor, a tempo event will be created at the start of the edited part or event. Only the currently edited track will be affected – but note that events to the right of the edited events or parts (on the edited track) will be affected as well.
• If you have made a selection range and use the Time Warp tool within that range, the tempo changes will be confined to that range. This means tempo events will be inserted at the start and end of the selection range, if needed – useful if you need to adjust the tempo within a certain area but want all material outside that range to stay in place.
• When you click with the Time Warp tool, it snaps to the tempo grid in the window.
• When you drag the tempo grid to a new position, it can be magnetic to events in the window. In the Project window, this requires that Snap is activated and “Events” is selected on the Snap Type pop-up menu – the grid will then snap to the start and end of events or parts, and to markers. In the Sample Editor, this requires that Snap is activated – the grid will then snap to hitpoints (if any). In the MIDI editors, this requires that Snap is activated – the grid will then snap to the start and end of notes.
• The function will create tempo values up to 300bpm.

Viewing and adjusting tempo events

When you select the Time Warp tool, the ruler of the active window is shown in brown. Existing tempo events are shown in the ruler as “flags” with the tempo values displayed.

This helps you see what’s going on, but you can also use this for editing the tempo track:

• If you press the create/erase modifier key (by default [Shift]) and click on a tempo event in the ruler, it is deleted.
• You can click on a tempo event in the ruler and drag to move it. This automatically edits the tempo value in the event so that elements to the right keep their positions.
• If you press [Alt]/[Option] and move (or delete) a tempo event in the ruler, the tempo value is not adjusted – this means elements to the right will be moved. This is the default modifier key for this – you can adjust it in the Preferences dialog (Editing–Tool Modifiers page).

Using the Time Warp tool in the Project window

In the Project window, there are two modes for the Time Warp tool. To select the desired option, click on the Time Warp tool and click again to open a context menu. The available options are:

• Warp Grid
This is the default mode. If you use it, all tracks are temporarily switched to linear time base. This means that all tracks will keep their absolute time positions when you adjust the tempo track.
• Warp Grid (musical events follow)
If you use this mode, no tracks are switched to linear time base. This means that all tracks that are not set to linear time base will follow the changes you make to the tempo track.
Matching a musical score to video

Here’s an example of how to use the Time Warp tool in "musical events follow" mode. Let’s say you are creating the music for a film. You have a video track, an audio track with a commentary and some audio and/or MIDI tracks with your music. Now you want to match the position of a musical cue to a position in a video film. The musical cue is located in bar 33. There are no tempo changes in the project (yet). Proceed as follows:

1. Make sure tempo track mode is selected on the Transport panel.
2. Now you need to locate the position in the video. If you do not need very high precision, you can simply locate it looking at the thumbnails on the video track — otherwise you can pinpoint the exact position and add a marker to the marker track (that you can snap to later on). You can also make a note of the exact position and add an extra ruler track set to show the timecode (Cubase only).
3. Make sure that the correct tracks are set to linear time base or musical time base, respectively. In our example, we want the video track and the audio track with a commentary voice-over to be linear time-based (as well as the marker track, if used). All other tracks should be set to musical time base. You change this by clicking the time base button in the track list or Inspector.
4. Set up the Grid Type pop-up menu as desired. When you click with the Time Warp tool, it snaps to the selected grid. In this case, you will find the musical cue at the start of bar 33, so we can set the grid to "Bar".
   • Note that this affects the snapping to the ruler (tempo grid) when you click! In addition, the tool can be “magnetic” to events in the Project window when you drag — for this, you need to activate the Snap function, open the Snap Type pop-up menu, and select “Events”.
   In our example, this would be useful if you created a marker at the desired position in the video — when you drag the grid (see below), it will snap to the marker.
5. Click on the Time Warp button and click again to open a pop-up menu.
6. Select the “Warp Grid (musical events follow)” mode.
7. Click in the event display at the start of bar 33 and drag to the desired position in the video. As mentioned above, this can mean dragging to a position indicated by the thumbnails on the video track, to a marker on the marker track or to a time position on an additional ruler track (Cubase only).

When you drag, the ruler is scaled — and the music tracks will follow.
8. Release the mouse button. If you look in the ruler at the beginning of the project, you will see that the first (and only) tempo event has been adjusted.
9. Try playing back. The musical cue should now happen at the correct position in the video.

Let’s say you need to match another cue to another position later on in the video. If you simply repeat this procedure, you will find that the first cue gets out of sync — since you are still changing the first (and only) tempo event on the tempo track!

You need to create a “lock point” — a tempo event at the first cue position:
10. Press [Shift] and click with the Time Warp tool in the event display at the cue position.
   In our case, this is bar 33.
   A tempo event (with the same value as the first one) is added at that position.
11. Now match the second musical cue to the correct video position by dragging the musical position to the desired time position as before. The new tempo event is edited – the first tempo event is unaffected and the original cue is still matched.

- If you know you are going to match several cues this way, make it a habit to press [Shift] each time you use the Time Warp tool to match positions. This adds a new tempo event – that way, you do not have to add tempo events afterwards as described above.

**About snapping**

If Snap is activated in the Project window and “Events” is selected on the Snap Type pop-up menu, the Time Warp tool will be magnetic to events when you drag the tempo grid. This makes it easier to snap a tempo position to a marker, the start or end of an audio event, etc.

**Using the Time Warp tool in an audio editor**

Using the Time Warp tool in the Sample Editor or Audio Part Editor is different from using it in the Project window, in the following ways:

- When you use the Time Warp tool, a tempo event is automatically inserted at the beginning of the edited event or part. This tempo event will be adjusted when you warp the tempo grid with the tool. This means that material before the edited events will not be affected.
- Only the default mode for the Time Warp tool is available. This means that when you use the tool, the edited track is temporarily switched to linear time base.

**Making a tempo map for a “free” recording**

The following example shows how to use the Time Warp tool in the Sample Editor to create a tempo map matching freely recorded music. Let’s say you have recorded a drummer, playing without a metronome – this typically means the tempo varies ever so slightly. To be able to add more material and easily rearrange the recorded audio, you want the tempo in Cubase to match the recorded drum track:

1. If necessary, move the recorded event. Move it so that the first downbeat (“one”) happens at the start of the bar – zoom in if needed.

2. Open the drum recording in the Sample Editor and make sure Hitpoint mode is not selected. The Time Warp tool cannot be used in Hitpoint mode. However, if you have calculated hitpoints already, these will be visible when the Time Warp tool is selected (see below).

3. Set the zoom so that you can see the individual drum hits clearly. To achieve this type of “visual” beat matching, it is important to have a fairly clean recording, such as the drum track in this example.

4. Select the Time Warp tool.

You have already matched the first downbeat with the start of a bar. However, if the recording starts before the first downbeat (with a fill, some silence, etc.), you want to “lock” the first downbeat so that it stays in position:

5. Press [Shift] and click in the event at the position of the first downbeat (the start of the bar). When you press [Shift], the pointer turns into a pencil. Clicking adds a tempo event at the first downbeat – when you later adjust the tempo with the Time Warp tool, the first downbeat will stay in place. Note that if the event starts exactly on the first downbeat (no audio before the “one”), you do not need to do this. This is because a tempo event is automatically added at the start of the edited event.

6. Now, locate the start of the next bar in the ruler.

7. Click at that position in the event display and drag to the downbeat of the second bar in the recording. When you click, the pointer will snap to the ruler grid. By dragging the grid, you changed the tempo value in the tempo event at the first downbeat. If the drummer held a fairly consistent tempo, the following bars should now match pretty well, too.

8. Check the following bars and locate the first position where the audio drifts from the tempo. Now, if you simply adjusted that beat in the tempo grid to match the beat in the recording, the tempo event at the first downbeat would be changed – this would ruin the match in the previous bars! We need to lock these by inserting a new tempo event.
9. Locate the last beat that is in sync. This would be the beat just before the position where the audio and tempo drift apart.

10. Press [Shift] and click at that position to insert a tempo event there. This locks this matched position. The material to the left will not be affected when you make adjustments further along.

11. Now match the tempo grid to the next (unmatched) beat by clicking and dragging with the Time Warp tool. The tempo event you inserted in step 10 will be adjusted.

12. Work your way through the recording this way – when you find that the recording drifts from the tempo, repeat steps 9 to 11 above.

Now the tempo track follows the recording and you can add more material, rearrange the recording, etc.

Matching to hitpoints

If you have calculated hitpoints for the audio event you are editing, these will be shown when the Time Warp tool is selected.

• The number of hitpoints shown depends on the Hitpoint Sensitivity slider setting you have made in Hitpoint mode.
• If you activate the Snap to Zero Crossing button on the toolbar, the Time Warp tool will snap to hitpoints when you drag the tempo grid.
• You can use the Create Markers from Hitpoints function (on the Hitpoints submenu of the Audio menu) to create markers at the hitpoint positions. This can be useful when using the Time Warp tool in the Project window, as the tool will be magnetic to markers (if the Snap Type is set to Events).

Using the Time Warp tool in a MIDI editor

This is very similar to using the tool in an audio editor:

• When you use the Time Warp tool, a tempo event is automatically inserted at the beginning of the edited part – this tempo event will be adjusted when you warp the tempo grid with the tool. Material before the edited part will not be affected.
• Only the default mode for the Time Warp tool is available. So when you use the tool, the edited MIDI track is temporarily switched to linear time base.

• The rulers in the MIDI editors can be set to “Time Linear” or “Bars+Beats Linear” mode (see “The ruler” on page 378) – the Time Warp tool requires Time Linear mode. If necessary, the ruler mode will be switched when you select the Time Warp tool.
• If Snap is activated on the toolbar in the MIDI editor, the tool will snap to the start and end of MIDI notes when you drag the tempo grid.

Typically, you would use the Time Warp tool in a MIDI editor to match the Cubase tempo to freely recorded MIDI material (much like the audio example above).

Tempo Detection (Cubase only)

Cubase offers a powerful tempo detection algorithm that can be used on any rhythmic musical content, even if it has not been recorded to a metronome click and/or contains tempo drift. This feature serves two main purposes:

• Analyzing the tempo of freely recorded audio so that other (audio or MIDI) tracks can follow this tempo.
• Adjusting freely recorded audio to the project tempo, which can be fixed or variable.

Audio requirements

• The audio event has to be at least 7 seconds long.
• Musical Mode has to be deactivated for the clip.
• The track has to be set to linear timebase (this happens automatically).
• The audio material needs to have discernible beats.
The Tempo Detection Panel

The Tempo Detection Panel contains the functions for analyzing the tempo of an audio event. It is opened via the Project menu.

In the top section of the panel, the name of the selected audio event is shown. Below the name, the Analyze button is located. Click this button to start the tempo detection for an event.

The middle section contains several functions for correcting and fine-tuning the detected tempo curve. These functions are described in the section “Correcting and fine-tuning the detected tempo curve” on page 474.

The arrow buttons at the bottom right let you change the direction in which the algorithm will analyze the audio material during a manual correction operation. To work backwards, i.e. to reanalyze the beginning of the tempo curve, activate the left arrow button (see “The beginning of the tempo curve needs to be corrected” on page 475).

With the Reset button at the bottom left you can delete the complete analysis data and start again from scratch.

Any tempo events beyond the event timeline will also be removed upon reset.

The Tempo Detection Panel has to be opened specifically for the event that you want to analyze. To analyze another event, close the panel, select the event, and reopen the panel.

Detecting the basic tempo of an audio event

1. In the Project window, select the audio event that you want to analyze.
3. Click the Analyze button.

The following happens:

- A rough tempo map based on the beat analysis is created for the selected audio clip.
- A tempo and a signature track are added to the project.
- The project will get a 1/4 signature, because the tempo detection only calculates a tempo based on beats, regardless of a musical signature. The signature can be modified later.
- The Time Warp Tool is selected for fine-tuning or adjusting the newly generated tempo map.

Depending on the rhythmic quality of the source material, the tempo analysis may directly lead to a perfect result. However, if this is not the case, you can apply the correction and fine-tuning functions. To find out whether such actions are necessary, activate the metronome click and play back the project.

Correcting and fine-tuning the detected tempo map

If the metronome click does not match the audio perfectly, perform any of the following operations, depending on the situation.

The detected tempo is too fast or too slow

- To double or halve the detected tempo, use the “Multiply by 2” and “Divide by 2” buttons.
- To adjust the detected tempo with a factor of 3/4 or 4/3, use the “Multiply by 4/3” and “Multiply by 3/4” buttons.

Examples:

- If your audio is twice as fast as the detected tempo, you can apply the “Multiply by 2” function.
- If your audio contains dotted notes or triplets and the algorithm detects 3 beats where 4 are expected, you can apply the 4/3 conversion.
- If the actual signature is 2/4 and the algorithm detected 6/8 beats or vice versa, you can apply a 3/4 conversion combined with the “Multiply by 2” function.
The detected tempo has jumps and spikes although it should be steady

If you get the message that the algorithm has detected irregular tempo changes, even though you know that the material has a more or less steady tempo, you can use the “Smooth Tempo” function.

- To retrigger the tempo analysis based on the assumption that the event has a steady tempo, click the “Smooth Tempo” button. Irregular spikes or tempo changes are removed during this analysis.

The detected tempo is off by half a beat

In some cases, the offbeat of a rhythm might be dominant enough to confuse the beat detection algorithm resulting in an offset. In that case it is necessary to shift the tempo events.

- To shift the detected tempo events by half a beat, click the “Offbeat Correction” button.

The tempo was not detected properly for the whole event

Sometimes it is impossible for the algorithm to properly detect the tempo for the whole audio event because the audio contains sections played in a different tempo or has special rhythmic characteristics. Manual adjustments are then necessary to create a perfect tempo track.

To manually correct tempo events, proceed as follows:

1. With the Tempo Detection Panel still open, play the track from the beginning and listen to the click. It is useful to zoom in on the waveform so that the transients are visible. Using the stationary cursor could be useful as well.

2. Locate the first tempo event that is off. Use the Time Warp Tool to move this tempo event to the correct position. The material to the right of the corrected event will be reanalyzed and the tempo recalculated.

3. Continue listening to the audio until you reach the next misplaced tempo event and repeat the manual correction procedure until you reach the end of the song.

The beginning of the tempo curve needs to be corrected

When you edit a tempo event, the tempo curve by default is reanalyzed from the point of editing towards the right. However, if the detection did not produce proper results at the beginning of the event, you can change the direction in which the algorithm works.

Proceed as follows:

1. At the bottom of the Tempo Detection Panel, activate the left arrow button to change the direction of reanalysis.

2. Locate the first correct tempo event at the beginning of the audio and use the Time Warp tool to move the corresponding tempo event slightly back and forth to trigger a backwards detection. The tempo at the beginning of the audio event is corrected and new events are added where necessary.

The audio material contains sections with different tempos

In some cases, a track may include multiple sections with different tempo and the tempo detection might stop at the position of a tempo change or pause in the audio. If the manual adjustment of individual tempo events does not give you the desired results for files with varying tempo, you can cut the audio event at each major tempo change and perform the tempo detection for each of the resulting sections independently.

- Remember that each cut needs to have a length of at least 7 seconds.

Finishing

Once the tempo map is correct, close the Tempo Detection Panel. You can now set up signature events with the correct time signature.
Adjusting the audio to the project tempo

If you want freely recorded audio to follow a fixed tempo or a different project tempo, you can use the Set Definition From Tempo dialog to save the tempo information from the tempo track in the corresponding audio clips.

Proceed as follows:

1. Select the audio events that you want to have follow the project tempo. For example, this could be the individual tracks in a multi-track drum session.
2. On the Audio menu, open the Advanced submenu and select the “Set Definition From Tempo…” option. The Set Definition From Tempo dialog opens.
3. Select whether you want to save the tempo information in the project file only or in the selected audio clips. Writing the definition into the audio files allows you to use these in other projects, complete with tempo information.
4. Select if you want to set all tracks to musical timebase. If you do not activate this option, only the tracks containing the selected events are set to musical timebase.
5. Click OK. The tempo information is now copied into the selected audio clips and the tracks are set to musical timebase. Furthermore, Musical Mode is activated for the audio events.

⚠️ If you have placed audio events referring to the same audio clip at different positions on the timeline and you apply the “Set Definition From Tempo” function simultaneously to these events, new audio files are written for all the events except the first.

The audio tracks will now follow any tempo changes in the project. Therefore, you can disable the tempo track and set a fixed tempo for your project or edit the tempo track for a new tempo map. Warping is applied to the events to match the tempo. By default, the “élastique Pro Time” time shifting algorithm is applied, which should lead to the best-quality results (see "About time stretch and pitch shift algorithms" on page 259).
The Project Browser (Cubase only)
Window Overview

The Project Browser window provides a list based representation of the project. This allows you to view and edit all events on all tracks by using regular value editing in a list.

Opening the Project Browser

You open the Project Browser by selecting “Browser” from the Project menu. The Browser window can be open while you are working in other windows; any changes made in the Project window or an editor are immediately reflected in the Project Browser and vice versa.

Navigating in the Browser

You use the Project Browser much like you use the Windows Explorer and Mac OS X Finder for browsing folders on your hard disk:

- Click on an item in the Project Structure list to select it for viewing. The contents of the item are shown in the event display.

- Items with hierarchical substructures can be folded out by clicking the “+” symbols or the “closed folder” symbols in the Project Structure list. When the substructure of an item is revealed, a “-” symbol or an “open folder” symbol is shown instead – click this to hide the substructure.
- To reveal or hide all substructures in the Project Structure list, use the buttons “(+) All” and “(–) All” above the list.
- The actual editing is done in the event display, using regular value editing techniques. There is one exception: You can rename items in the Project Structure list by clicking on their names and typing.

Customizing the view

You can drag the divider between the Project Structure list and the event display. Furthermore, the event display can be customized in the following ways:

- You can change the order of the columns by dragging the column headings to the left or right.
- You can resize columns by dragging the dividers between the column headings.
- To select a display format for all position and length values, use the Time Format pop-up menu.
The Project Browser (Cubase only)

You can sort events in the display by columns, by clicking the column heading. For example, if you want to sort events by their start positions, click that column heading. An arrow appears in the column heading, indicating that events are sorted by that column. The direction of the arrow indicates whether the events are sorted in ascending or descending order. To change the direction, click the column heading again.

Importing files via the MediaBay

You can also import audio, video and MIDI files into the Project Browser via the MediaBay using drag and drop. You can only import into existing tracks. This means, for example, that a video track has to exist in the Project window prior to importing a video file in the Project Browser. For more information about the MediaBay, see "The MediaBay" on page 311.

About the Sync Selection option

If the "Sync Selection" checkbox is activated (on the Project Browser toolbar), selecting an event in the Project window automatically selects it in the Project Browser, and vice versa. This makes it easy to locate events in the two windows.

Editing tracks

Editing audio tracks

Audio tracks can have two "subitems": Track Data and Automation.

- The Automation item corresponds to the automation track in the Project window, and contains the track’s automation events (see ‘Editing automation tracks’ on page 481).
- The Track Data item corresponds to the actual audio track in the Project window. It contains audio events and/or audio parts, which in turn can contain audio events.

Note that if you have not performed any automation or opened an automation track, the Browser will only contain the audio data.

The following parameters are available for the different items:

The list columns for audio events

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Allows you to change the name of the event. Double-clicking the waveform image to the left of it opens the event in the Sample Editor.</td>
</tr>
<tr>
<td>File</td>
<td>The name of the audio file referenced by the event’s audio clip.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the event. If the event belongs to an audio part, you cannot move it outside the part.</td>
</tr>
<tr>
<td>End</td>
<td>The end position of the event.</td>
</tr>
<tr>
<td>Snap</td>
<td>The absolute position of the event’s snap point. Note that adjusting this value will not change the position of the snap point within the event – instead it is another way of moving the event!</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the event.</td>
</tr>
<tr>
<td>Offset</td>
<td>This determines &quot;where in the audio clip&quot; the event starts. Adjusting this value is the same as sliding the contents of the event in the Project window (see “Sliding the contents of an event or part” on page 64). You can only specify positive Offset values, because the event cannot start before the start of the clip. Likewise, it cannot end after the end of the clip. If the event already plays the whole clip, the Offset cannot be adjusted at all.</td>
</tr>
<tr>
<td>Volume</td>
<td>The volume of the event, as set with the Volume handle or on the info line in the Project window.</td>
</tr>
<tr>
<td>Fade In</td>
<td>The length of the fade-in and fade-out areas respectively. If you use these settings to add a fade (where there previously was none), a linear fade will be created. If you adjust the length of an existing fade, the previous fade shape will be maintained.</td>
</tr>
<tr>
<td>Fade Out</td>
<td></td>
</tr>
<tr>
<td>Mute</td>
<td>Click in this column to mute or unmute the event.</td>
</tr>
<tr>
<td>Image</td>
<td>Displays a waveform image of the event inside a gray box corresponding to the clip. The image is scaled according to the width of the column.</td>
</tr>
</tbody>
</table>
The list columns for audio parts

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the part. Double-clicking on the part symbol to the left of it opens the part in the Audio Part Editor.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the part. Editing this value is the same as moving the part in the Project window.</td>
</tr>
<tr>
<td>End</td>
<td>The end position of the part. Editing this value is the same as resizing the part in the Project window.</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the part. Editing this value is the same as resizing the part in the Project window.</td>
</tr>
<tr>
<td>Offset</td>
<td>This adjusts the start position of the events within the part. Adjusting this value is the same as sliding the contents of the part in the Project window (see “Sliding the contents of an event or part” on page 64). Setting a positive Offset value is the same as sliding the contents to the left, while a negative Offset corresponds to sliding the contents to the right.</td>
</tr>
<tr>
<td>Mute</td>
<td>Click in this column to mute or unmute the part.</td>
</tr>
</tbody>
</table>

Creating audio parts

When the “Audio” item of an audio track is selected in the Project Structure list, you can create empty audio parts on the track by clicking the Add button on the toolbar. This will insert a part between the left and right locator.

Editing MIDI tracks

Just like audio tracks, MIDI tracks can have two “subitems”: Track Data and Automation.

- The Track Data item corresponds to the actual MIDI track in the Project window and can contain MIDI parts (which in turn can contain MIDI events).
- The Automation item corresponds to the automation track in the Project window, and contains the track’s automation events (see “Editing automation tracks” on page 481).

If you have not performed any automation or opened an automation track, the Browser will only contain the MIDI data.

When editing the Track Data, the following parameters are available:

The list columns for MIDI parts

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the part.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the part. Editing this value is the same as moving the part.</td>
</tr>
<tr>
<td>End</td>
<td>The end position of the part. Changing this is the same as resizing the part (and will automatically affect the Length value as well).</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the part. Changing this resizes the part and automatically changes the End value.</td>
</tr>
<tr>
<td>Offset</td>
<td>This adjusts the start position of the events within the part. Adjusting this value is the same as sliding the contents of the part in the Project window (see “Sliding the contents of an event or part” on page 64). Setting a positive Offset value is the same as sliding the contents to the left, while a negative Offset corresponds to sliding the contents to the right.</td>
</tr>
<tr>
<td>Mute</td>
<td>Click in this column to mute or unmute the part.</td>
</tr>
</tbody>
</table>

The list columns for MIDI events

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of MIDI event. This cannot be changed.</td>
</tr>
<tr>
<td>Start</td>
<td>The position of the event. Editing this value is the same as moving the event.</td>
</tr>
</tbody>
</table>

Parameter Description

End This is only used for note events, allowing you to view and edit the end position of a note (thereby resizing it).

Length This is only used for note events. It shows the length of the note – changing this resizes the note and automatically changes the End value as well.

Data 1 The property of this value depends on the type of MIDI event:
- For notes, this is the note number (pitch). It is displayed and edited as a note name and an octave number, with the values ranging between C-2 and G8.
- For controller events, this is the type of controller, displayed in words. Note that you can edit this by entering a number – the corresponding controller type is automatically displayed.
- For pitchbend events, this is the fine adjustment of the bend amount.
- For poly pressure events, this is the note number (pitch).
- For VST 3 events, this is the event parameter (e.g. Volume).
- For other event types, this is the value of the event.

Data 2 The property of this value depends on the type of MIDI event:
- For notes, this is the note-on velocity.
- For controller events, this is the value of the event.
- For pitchbend events, this is the coarse bend amount.
- For poly pressure events, this is the amount of pressure.
- For VST 3 events, this is the value of the event parameter, with a range of 0.0 to 1.0.
- For other event types, this is not used.

Channel The event’s MIDI channel, see “Notes” on page 103.

Comment This column is used for some event types only, providing an additional comment about the event.
For SysEx (system exclusive) events, you can only edit the position (Start) in the list. However, clicking the Comment column opens the SysEx Editor, in which you can perform detailed editing of system exclusive events. For a description of this, see “Working with SysEx messages” on page 407.

**Editing Note Expression data in the Project Browser**

In the Project Browser, you can view and edit the MIDI controller events or VST 3 events of a MIDI note with Note Expression data (for further information about Note Expression, see the chapter “Note Expression (Cubase only)” on page 428).

To view and edit the Note Expression data content of a MIDI note, proceed as follows:

1. In the Project Structure list, select the Note Expression subitem of the MIDI note that you want to view or edit. In the event display, all MIDI controllers or VST 3 events within the Note Expression data are listed.
2. In the event display, view and edit the parameter values. This allows you to move an event by entering a different Start value, for example. You can also delete single events to “thin out” the Note Expression data content by selecting them and pressing [Delete].

**Filtering MIDI events**

When you are editing MIDI in the Project Browser, the large number of different MIDI events displayed can make it hard to find the events you want to edit. The Filter pop-up menu allows you to select a single event type for display.

Creating MIDI parts

When a MIDI track is selected in the Project Structure list, you can create empty MIDI parts on the track by clicking the Add button. This will insert a part between the left and right locator.

Creating MIDI events

You can use the Project Browser to create new MIDI events:

1. Select a MIDI part in the Project Structure list.
2. Move the project cursor to the desired position for the new event.
3. Use the Add pop-up menu above the event display to select which type of MIDI event to add.

4. Click the Add button. An event of the selected type is added to the part, at the project cursor position. If the cursor is outside the selected part, the event is added at the beginning of the part.

- It is not possible to add MIDI controller events or VST 3 events to Note Expression data.

**Editing automation tracks**

All kinds of Cubase automation (the automation tracks for MIDI, instrument, audio, group, and FX channel tracks, or the individual automation tracks for VST instruments, ReWire channels, or input (Cubase only) and output buses) are handled in the same way in the Project Browser.
Each Automation item in the Project Structure list will have a number of subentries, one for each automated parameter. Selecting one of these parameters in the Project Structure list shows its automation events in the list:

You can use the two columns in the list to edit the position of the events and their values.

**Editing the video track**

When the video track is selected in the Project Structure list, the event display lists the video events on the track, with the following parameters:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the video clip that the event refers to.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the event. Editing this value is the same as moving the event.</td>
</tr>
<tr>
<td>End</td>
<td>The end position of the event. Editing this value is the same as resizing the event, and will automatically change the Length value as well.</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the event. Editing this value is the same as resizing the event, and will automatically change the End value as well.</td>
</tr>
<tr>
<td>Offset</td>
<td>This determines &quot;where in the video clip&quot; the event starts. Note that the event cannot start before the start of the clip, or end after the end of the clip. Thus, if the event already plays the whole video clip, the Offset cannot be adjusted at all.</td>
</tr>
</tbody>
</table>

**Editing the marker track**

Marker events have the following parameters:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>The name of the marker. This can be edited for all markers except the left and right locator.</td>
</tr>
<tr>
<td>Start</td>
<td>The position of &quot;regular&quot; markers or the start position of cycle markers.</td>
</tr>
<tr>
<td>End</td>
<td>The end positions of cycle markers. Editing this value is the same as resizing the cycle marker, and will automatically change the Length value as well.</td>
</tr>
</tbody>
</table>

You can insert markers on the marker track by selecting "Marker" or "Cycle Marker" from the Add pop-up menu and clicking the Add button. Regular markers will be added at the current project cursor position while cycle markers will be added between the current left and right locator positions.

The Project Browser only displays the default attributes. For further information on markers, refer to the chapter “Using markers” on page 138.

**Editing the tempo track**

When the tempo track is selected in the Project Structure list, the event display shows the events on the tempo track, with the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>The position of the tempo event. You cannot move the first event on the tempo track.</td>
</tr>
<tr>
<td>Tempo</td>
<td>The tempo value of the event.</td>
</tr>
<tr>
<td>Type</td>
<td>This indicates whether the tempo jumps to the value of the event (&quot;Jump&quot; type) or whether it changes gradually from the previous tempo event, creating a ramp (&quot;Ramp&quot; type), see &quot;Editing the tempo curve&quot; on page 465.</td>
</tr>
</tbody>
</table>

You can add new tempo events by clicking the Add button. This creates a jump-type event with the value 120 bpm at the project cursor position. Make sure that there is no other tempo event at the current cursor position.
**Editing time signatures**

When “Signature track” is selected in the Project Structure list, the event display shows the time signature events in the project:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>The position of the event. Note that you cannot move the first time signature event.</td>
</tr>
<tr>
<td>Signature</td>
<td>The value (time signature) of the event.</td>
</tr>
</tbody>
</table>

You can add new time signature events by clicking the Add button. This creates a 4/4 event, at the beginning of the bar closest to the project cursor position. Make sure that there is no other time signature event at the current cursor position.

**Deleting events**

The procedure for deleting events is the same for all different track types:

1. Click on an event (or a part) in the Event display to select it.
2. Select Delete from the Edit menu or press [Delete] or [Backspace].

⚠️ Note that you cannot delete the first tempo event or the first time signature event.
Export Audio Mixdown
Introduction

The Export Audio Mixdown function in Cubase allows you to mix down audio from the program to files on your hard disk in a number of formats. In the Channel Selection section, you can choose which channels (or busses) to export.

Cubase only: By activating the “Channel Batch Export” option you can choose to mix down several channels in one go. For each channel, an individual file will be created.

The following channel types are available:

- Output channels
  For example, if you have set up a stereo mix with tracks routed to a stereo output bus, mixing down that output bus will give you a mixdown file containing the whole mix. Similarly, you can mix down a complete surround bus, either to a single multi-channel file or to one file per surround channel (by activating the Split Channels option) (Cubase only).

- Audio track channels (Cubase only)
  This will mix down the channels for the tracks, complete with insert effects, EQ, etc. This can be useful for turning a number of events into a single file, or to convert tracks with insert effects into audio files (that are less CPU-intensive). Simply export the track and re-import the file into the project.

- Any kind of audio-related Mixer channel (Cubase only)
  This includes VST instrument channels, instrument tracks, effect return channels (FX channel tracks), group channels, and ReWire channels. There are many uses for this — for example, you can mix down an effect return track or turn individual ReWire channels into audio files.

Please note the following:

- The Export Audio Mixdown function mixes down the area between the left and right locators.

- When you mix down, you get what you hear – mutes, Mixer settings, record enable, and insert effects are taken into account. Note though that you will only include the sound of the channels you select for mixdown.

- MIDI tracks are not included in the mixdown!

To make a complete mixdown containing both MIDI and audio, you first need to record all your MIDI music onto audio tracks (by connecting the outputs of your MIDI instruments to your audio inputs and recording, as with any other sound source).

Mixing down to audio files

1. Set up the left and right locators to encompass the section you want to mix down.

2. Set up your tracks so that they play back the way you want. This includes muting unwanted tracks or parts, making manual Mixer settings and/or activating the R (Read) automation buttons for some or all Mixer channels.


4. In the Channel Selection section to the left, select the channels you want to mix down. The list contains all output and audio-related channels available in the project (see “About the Channel Selection section” on page 486). Cubase only: Activate the Channel Batch Export option if you want to mixdown several channels at once.

5. In the File Location section at the top, you can set up the naming scheme for the exported files and select a path for the mixdown files. For details about the naming options, see “About the File Location section” on page 486.

6. Select an entry from the File Format pop-up menu and make additional settings for the file to be created. This includes codec settings, meta data, sample rate, bit depth, etc. The available options depend on the selected file format, see “The available file formats” on page 489.
7. In the Audio Engine Output section, specify whether you want to export all subchannels of a multi-channel bus as separate mono files (Split Channels), downmix all subchannels to one mono file (Mono Downmix), or export only the left and right channels of a multi-channel bus to a stereo file (L/R Channels).

   For details about the settings relating to the audio engine, see “About the Audio Engine Output section” on page 488.

8. Activate Realtime Export if you want the export to happen in realtime (see “About the Audio Engine Output section” on page 488).

9. If you want to automatically import the resulting audio files back into Cubase, activate any of the checkboxes in the “Import into Project” section.

   For details about the available options, see “About the Import into Project section” on page 488.

10. If you activate Update Display, the meters will be updated during the export process. This allows you to check for clipping, for example.

11. Click Export.

    A dialog with a progress bar is displayed while the audio files are being created. To cancel the operation, you can click the Abort button.

    • Cubase only: During the realtime export of a single channel, the Audition Volume fader is displayed in the progress dialog (see “About the Audio Engine Output section” on page 488). It allows you to adjust the Control Room volume.

    Note that this fader is only available if the Control Room is activated.

    • If the “Close Window after Export” option is activated, the dialog will be closed automatically.

    • If you have activated any of the options in the “Import into Project” section, the mixdown files will be imported back into the same or a new project.

    When playing back the reimported file in the same Cubase project, mute the original tracks so that you only hear the mixdown.

   If you set the export range in such a way that the effects applied to a preceding event (e.g. reverb) reach into the next, these will be heard in the mixdown (even though the event itself is not included). If you do not want this, you need to mute the first event before exporting.

---

The Export Audio Mixdown dialog

Below you will find detailed descriptions of the different sections of the dialog and the corresponding functions.

---

About the Channel Selection section

The Channel Selection section shows all output and audio-related channels available in the project. These channels are organized in a hierarchical structure that allows you to easily identify and select the channels you want to export. The different channel types are listed below each other, with channels of the same type being grouped in a node (e.g. instrument tracks).

• You can activate/deactivate channels by clicking on the checkboxes in front of the channel names.

• Cubase only: If Channel Batch Export is activated, you can also activate/deactivate all channels of the same type by clicking on the checkbox in front of the channel type entry.

• Cubase only: If Channel Batch Export is activated, you can select/deselect several channels in one go using the [Shift] and/or [Ctrl]/[Command] modifiers and then clicking on any of the checkboxes for the highlighted channels.

   Note that this toggles the activation status of a channel, i.e. all selected channels that were previously activated will be deactivated and vice versa.

If your project contains a large number of channels, it might get difficult to find the desired channels in the Channel Selection section.

• To simplify the process of selecting several channels, you can filter the display. Simply type in the desired text (e.g. “voc” to show all tracks containing vocals) in the Filter field below the tree view.

---

About the File Location section

In the File Location section you can specify a name and a path for the exported files. Furthermore, you can define the naming scheme for the exported files.
At the right of the Name and the Path fields there are two pop-up menus with a number of options:

**Naming Options**
- Select “Set to Project Name” to set the Name field to the project name.
- Activate the “Auto Update Name” option to add a number to the specified file name every time you click the Export button.

**Path Options**
- Select “Choose…” to open a dialog in which you can browse for a path and enter a file name. The file name will automatically be shown in the Name field.
- Select an entry from the Recent Paths section to reuse a path specified for a previous export. This section is only shown after an export has been completed. With the “Clear Recent Paths” option you can delete all entries from the Recent Paths section.
- Activate the “Use Project Audio Folder” option to save the mixdown file in the project’s Audio folder.

**Naming Scheme**

Clicking the “Naming Scheme…” button opens a separate pop-up window. Here, you can choose a number of elements that will be combined to form the file name. Depending on the settings in the Channel Selection section, different elements are available.

The elements are defined as follows:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that you entered in the Name field (in the File Location section).</td>
</tr>
<tr>
<td>Mixer Index</td>
<td>The number of the Mixer channel.</td>
</tr>
<tr>
<td>Channel Type</td>
<td>The type of audio-related channel that is being exported.</td>
</tr>
<tr>
<td>Channel Name</td>
<td>The name of the exported channel.</td>
</tr>
</tbody>
</table>

By combining the available naming elements, you can make sure that all the files of a batch are exported with unique names. If you have set up a naming scheme that would result in identical file names, a warning message appears when you click the Export button.

- To add an element, press the “+” button on the far right, and to remove an element from the naming scheme click the corresponding “-” button. You can also remove an element by dragging it out of the Elements section.
- To rearrange the sequence, simply click on an element and drag it to a different position.
- To choose a different element for a certain position, click on the element name and select a new entry from the pop-up menu.

Below the Elements section, you will find some additional options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separator</td>
<td>Allows you to enter any character sequence to be used as a separator between the naming elements (e.g. a hyphen enclosed in spaces).</td>
</tr>
<tr>
<td>Leading Zeros</td>
<td>This controls how many leading zeros the Counter and Mixer Index components will have. For example, if you set this to “2”, the numbers from 1 to 10 will be written as 001 to 010.</td>
</tr>
<tr>
<td>Counter Start</td>
<td>Here you can enter a number that is used as the first Counter value.</td>
</tr>
</tbody>
</table>

The field below these options shows a preview of what the resulting file names will look like.

To close the Naming Scheme pop-up window, simply click anywhere outside the pop-up window. The generated name will now also be shown to the right of the “Naming Scheme…” button.
About the File Format section

In the File Format section, you can select the file format for your mixdown files and make additional settings that are different for each file type. For details, see “The available file formats” on page 489.

About the Audio Engine Output section

The Audio Engine Output section contains all the settings related to the output of the Cubase audio engine. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Rate</td>
<td>Allows you to select 8, 16, 24 bit or 32 bit (float) files. If the file is an “intermediate mixdown” that you plan to re-import and continue working on in Cubase, we recommend that you select the 32 bit (float) option. 32 bit (float) is a very high resolution (the same resolution as used internally for audio processing in Cubase), and the audio files will be twice the size of 16 bit files. If you are making a mixdown for CD burning, use the 16 bit option, as CD audio is always 16 bit. In this case, we recommend dithering, see “Dithering” on page 193. Activate the UV-22HR dithering plug-in (see the separate PDF document “Plug-in Reference” for details). This reduces the effects of quantization noise and artifacts from being introduced when converting the audio down to 16 bit. 8 bit resolution should only be used if required, since it results in limited audio quality. 8 bit audio may be suitable in some multimedia applications, etc.</td>
</tr>
<tr>
<td>Bit Depth</td>
<td>In Cubase, activate this if you want to downmix all the subchannels of a stereo or surround channel or bus to a single mono file. To avoid clipping, the following summing rules are applied: Stereo: The panning law as defined in the Project Setup dialog is applied (see “About the “Stereo Pan Law” setting” on page 157). Surround (Cubase only): The channels are summed and then divided through the number of channels used (in case of a 5.1. channel = (L+R+C+Lfe+Ls+Rs)/6).</td>
</tr>
<tr>
<td>Mono Downmix</td>
<td>In Cubase, activate this if you want to downmix all the subchannels of a single channel. The panning law as defined in the Project Setup dialog is applied (see “About the “Stereo Pan Law” setting” on page 157). Surround (Cubase only): The channels are summed and then divided through the number of channels used (in case of a 5.1. channel = (L+R+C+Lfe+Ls+Rs)/6).</td>
</tr>
<tr>
<td>Split Channels</td>
<td>Activate this if you want to export all subchannels of a multi-channel bus as separate mono files.</td>
</tr>
<tr>
<td>L/R Channels</td>
<td>Activate this if you want to export only the left and right subchannels of a multi-channel bus into a stereo file.</td>
</tr>
<tr>
<td>Realtime Export</td>
<td>Activate this if you want the export to happen in real-time, in which case the process will take at least the same time as regular playback. Some VST plug-ins, external instruments and effects require this in order to have enough time to update correctly during the mixdown – consult the plug-in manufacturers if uncertain. Cubase only: When Realtime Export is activated, the exported audio will be played back via the Control Room. Depending on the CPU and disk speed of your computer, it may not be possible to export all channels simultaneously if Realtime Export is activated. If an error occurs during the real-time export, the program will automatically stop the process, reduce the number of channels and start again. Afterwards the next batch of files is exported. This is repeated as often as needed to export all selected channels. Due to this splitting of the export process in “runs”, the realtime export might take longer than the actual playback would.</td>
</tr>
</tbody>
</table>

About the Import into Project section

In this section you will find several options for importing the resulting mixdown files back into the existing or into a new project:

- If you activate the Pool checkbox, the resulting audio file will automatically be imported back into the Pool as a clip. Use the Pool Folder option to specify in which Pool folder the clip will reside.
- If you activate the Audio Track option as well, an audio event that plays the clip will be created and placed on a new audio track, starting at the left locator. If you activate the Audio Track option, the Pool option will automatically be activated as well, and deactivating the Pool option also deactivates the Audio Track option.
- If you activate the “Create New Project” option, a new project is created that contains one audio track for each of the exported channels, as well as the signature and tempo track of the original project. Note that if this is activated, the Pool and Audio Track options are disabled. The tracks will have the corresponding mid混down file as audio event. The track names will be identical with the export channel names. Note that the new project will be the active project.
- The Create New Project option is only available if you have selected an uncompressed file format and the Use Project Audio Folder option is deactivated.
About the Import Options dialog
If you activate any of the options in the "Import into Project" section, the Import Options dialog will open for each exported channel when the export is complete. For a detailed description of the options in this dialog see “About the Import Medium dialog” on page 306.

The available file formats
The following pages describe the different export file formats, as well as their options and settings.

• AIFF files (see “AIFF files” on page 489).
• AIFC files (see “AIFC files” on page 489).
• Wave files (see “Wave files” on page 490).
• Wave 64 files (see “Wave 64 files” on page 490).  
• Broadcast Wave files (see “Broadcast Wave files” on page 490).
• MP3 files (see “MPEG 1 Layer 3 files” on page 490).
• Ogg Vorbis files (see “Ogg Vorbis files” on page 490).
• Windows Media Audio Pro files (Windows only, see “Windows Media Audio Pro files (Windows only)” on page 491).

Note that the Wave 64 file format is the only format that allows you to export files with a resulting size of more than 2 GB.

Most of the settings described below for AIFF files are available for all file types. Where this is not the case, you will find additional information in the corresponding section.

MP3 Export (Cubase Artist only)
This version of Cubase provides a function for exporting your audio mixdown as mp3 files. This function is limited to 20 trial encodings or a trial period of 30 days from the installation date (whichever ends first). After this period, the function will be disabled until you purchase the mp3 encoder for Cubase.

• When the mp3 format is selected and you click the Export button, a window opens showing you how many trial encodings you have left. You can upgrade to an unlimited mp3 export function by clicking the “Go to Online Shop” button in the dialog.

This will take you to Steinberg’s online shop where you can purchase the upgrade. Note that a working internet connection is required.

AIFF files
AIFF stands for Audio Interchange File Format, a standard defined by Apple Inc. AIFF files have the extension “.aif” and are used on most computer platforms.

For AIFF files the following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Broadcast Wave Chunk</td>
<td>This allows you to include information about the date and time of creation, a timecode position (allowing you to insert exported audio at the correct position in other projects, etc.) along with author, description and reference text strings in the exported file. Some applications may not be able to handle files with embedded info – if you get problems using the file in another application, deactivate the option and re-export.</td>
</tr>
<tr>
<td>Edit button</td>
<td>By clicking this button, the “Broadcast Wave Chunk” dialog opens, where you can enter additional information that will be embedded in the exported files. Note that in the Preferences dialog (Record–Audio–Broadcast Wave page) you can enter default text strings for author, description and reference that will automatically be displayed in the “Broadcast Wave Chunk” dialog.</td>
</tr>
<tr>
<td>Insert iXML Chunk</td>
<td>This allows you to include additional project-related metadata (e.g. project name, author and project frame rate) in the exported file. Some applications may not be able to handle files with embedded info – if you get problems using the file in another application, deactivate the option and re-export. Note: In the Project Setup dialog you will find the fields Author and Company that you can use to include the corresponding data in the iXML chunk. These fields are also available in the Preferences dialog (General–Personalization page).</td>
</tr>
<tr>
<td>Insert Tempo Definition</td>
<td>This option is only available if “Insert iXML Chunk” is activated. When “Insert Tempo Definition” is activated, tempo information from the tempo track or the Definition tab of the Sample Editor is included in the iXML chunk of exported files. This is useful if you want to use the files in other projects where they need to adapt to the project tempo.</td>
</tr>
</tbody>
</table>

AIFC files
AIFC stands for Audio Interchange File Format Compressed, a standard defined by Apple Inc. These files support compression ratios as high as 6:1 and contain tags in the header. AIFC files have the extension “.aifc” and are used on most computer platforms.

AIFC files support the same options as AIFF files.
Wave files
Wave files have the extension ".wav" and are the most common file format on the PC platform.
Wave files support the same options as AIFF files and have one additional option:

- Don't Use Wave Extensible Format
The Wave Extensible format contains additional metadata, such as the speaker configuration. It is an extension to the normal Wave format that some applications may not be able to handle.
If you get problems using the Wave file in another application, activate this option and re-export.

Wave 64 files
Wave 64 is a proprietary format developed by Sonic Foundry Inc. In terms of audio quality, Wave 64 files are identical to standard Wave files, but in the file headers Wave 64 files use 64-bit values for addressing where Wave files use 32-bit values. The consequence of this is that Wave 64 files can be considerably larger than standard Wave files. Wave 64 is therefore a good file format choice for really long recordings (file sizes over 2 GB). Wave 64 files have the extension ".w64".
Wave 64 files support the same options as AIFF files.

Broadcast Wave files
Concerning audio, Broadcast Wave files are the same as regular Wave or Wave 64 files, but with additional metadata. To create a Broadcast Wave file, select either Wave or Wave 64 as the file format and activate the Insert Broadcast Wave Chunk option. Click Edit if you wish to edit the chunk information, otherwise the defaults as specified in the Preferences dialog (Record–Audio–Broadcast Wave page) will be used. Broadcast Wave files have the extension ".wav".
Broadcast Wave files support the same options as regular Wave files.

MPEG 1 Layer 3 files
MPEG 1 Layer 3 files have the extension ".mp3". By use of advanced audio compression algorithms, MP3 files can be made very small, yet maintaining good audio quality.
In the File Format section, the following options are available for MPEG 1 Layer 3 files:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit Rate fader</td>
<td>By moving this fader, you can select a bit rate for the MP3 file. As a rule, the higher the bit rate, the better the audio quality and the larger the file. For stereo audio, 128 kBit/s is often considered to result in &quot;good&quot; audio quality.</td>
</tr>
<tr>
<td>Sample Rate pop-up menu</td>
<td>On this pop-up menu you can select a Sample Rate for the MP3 file.</td>
</tr>
<tr>
<td>High Quality Mode option</td>
<td>When this is activated, the encoder will use a different resampling mode, which can give better results depending on your settings. In this mode, you cannot specify the Sample Rate, but only the Bit Rate for the MP3 file.</td>
</tr>
<tr>
<td>Insert ID3 Tag option</td>
<td>This allows you to include ID3 Tag information in the exported file.</td>
</tr>
<tr>
<td>Edit ID3 Tag button</td>
<td>When you click this, the ID3 Tag dialog opens, in which you can enter information about the file. This additional information will be embedded as text strings in the file, and can be displayed by most mp3 playback applications.</td>
</tr>
</tbody>
</table>

Ogg Vorbis files
Ogg Vorbis is an open source, patent-free audio encoding and streaming technology, offering compressed audio files (extension ".ogg") of small size, but with comparatively high audio quality.
In the File Format section you will find only one setting: the Quality fader. The Ogg Vorbis encoder uses variable bit rate encoding, and the Quality setting determines between which limits the bit rate will vary. Generally speaking, the higher the Quality setting, the higher the sound quality but also the larger the files.
Windows Media Audio Pro files (Windows only)

This is a continuation of the Windows Media Audio format developed by Microsoft Inc. Due to the advanced audio codecs and lossless compression used, WMA Pro files can be decreased in size with no loss of audio quality. Furthermore, WMA Pro features the possibility of mixing down to 5.1 surround sound. The files have the extension ".wma".

When you select “Windows Media Audio File” as the file format, you can click the “Codec Settings…” button to open the “Windows Media Audio File Settings” window.

Note that the configuration options may vary, depending on the chosen output channels.

General tab

In the Input Stream section, you set the sample rate (44.1, 48 or 96kHz) and the bit resolution (16bit or 24bit) of the encoded file. Set these to match the sample rate and bit resolution of the source material. If no value matches that of your source material, use the closest available value that is higher than the actual value. For example, if you are using 20bit source material, set the bit resolution to 24bit rather than 16bit.

The setting in the Channels field depends on the chosen output and cannot be changed manually.

The settings in the Encoding Scheme section are used for defining the desired output from the encoder, e.g. a stereo or a 5.1 surround file. Make settings appropriate for the intended use of the file. If the file will be downloaded or streamed on the Internet, you might not want too high bit rates, for example. See below for descriptions of the options.

• Mode pop-up menu

The WMA Pro encoder can use either a constant bit rate or a variable bit rate for encoding to 5.1 surround, or it can use lossless encoding for encoding to stereo. The options on this menu are as follows:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant Bitrate</td>
<td>This will encode to a 5.1 surround file with a constant bit rate (set in the Bit Rate/Channels menu, see below). Constant bit rate is preferably used if you want to limit the size of the final file. The size of a file encoded with a constant bit rate is always the bit rate times the duration of the file.</td>
</tr>
<tr>
<td>Variable Bitrate</td>
<td>Encodes to a 5.1 surround file with a variable bit rate, according to a quality scale (the desired quality is set in the Bit Rate/Quality menu, see below). When you encode with variable bit rates, the bit rate fluctuates depending on the character and intricacy of the material being encoded. The more complex passages in the source material, the higher the bit rate – and the larger the final file.</td>
</tr>
<tr>
<td>Lossless</td>
<td>Encodes to a stereo file with lossless compression.</td>
</tr>
</tbody>
</table>

• Bit Rate/Quality pop-up menu

This menu allows you to set the desired bit rate. The available bit rate settings vary depending on the selected mode and/or output channels (see above). If the Variable Bitrate mode is used, the menu allows you to select from various levels of quality, with 10 being the lowest and 100 the highest. Generally, the higher the bitrate or quality you select, the larger the final file will be. The menu also shows the channel format (5.1 or stereo).

Advanced tab

• Dynamic Range Control

These controls allow you to define the dynamic range of the encoded file. The dynamic range is the difference in dB between the average loudness and the peak audio level (the loudest sounds) of the audio. These settings affect how the audio is reproduced if the file is played on a Windows computer with a player from the Windows Media series, and the “Quiet Mode” feature of the player is activated to control the dynamic range.

The dynamic range is automatically calculated during the encoding process, but you can specify it manually as well.
To manually specify the dynamic range, first put a check-mark in the box to the left by clicking in it, and then enter the desired dB values in the Peak and Average fields. You can enter any value between 0 and -90dB. Note, however, that it is usually not recommended to change the Average value, since this affects the overall volume level of the audio and therefore can have a negative effect on the audio quality.

The Quiet Mode in a Windows Media player can be set to one of three settings. Below, these settings are listed together with an explanation of how the Dynamic Range settings affect them:

- **Off**: If Quiet Mode is off, the dynamic range settings that were automatically calculated during the encoding will be used.
- **Little Difference**: If this is selected and you have not manually changed the dynamic range settings, the peak level will be limited to 6 dB above the average level during playback. If you have manually specified the dynamic range, the peak level will be limited to the mean value between the peak and average values you specified.
- **Medium Difference**: If this is selected and you have not manually changed the dynamic range settings, the peak level will be limited to 12 dB above the average level. If you have changed the dynamic range, the peak level will be limited to the peak value you specified.

- **Surround Reduction Coefficients**

Here you can specify which amount of volume reduction, if any, is applied to the different channels in a surround encoding. These settings affect how the audio is reproduced on a system incapable of playing back the file in surround, in which case the surround channels of the file will be combined into two channels and played back in stereo instead.

The default values should produce satisfactory results, but you can change the values manually if you wish. You can enter any value between 0 and -144 dB for the surround channels, the center channel, the left and right channels and the LFE channel, respectively.

**Media tab**

In these fields you can enter a number of text strings with information about the file – title, author, copyright information and a description of its contents. This information will then be embedded in the file header and can be displayed by some Windows Media Audio playback applications.

For more information about surround sound and encoding, see the chapter "Surround sound (Cubase only)" on page 217.
Synchronization
Background

What is synchronization?
Synchronization is the process of getting two or more devices to play back together at the same exact speed and position. These devices can range from audio and video tape machines to digital audio workstations, MIDI sequencers, synchronization controllers, and digital video devices.

Synchronization basics
There are three basic components of audio/visual synchronization: position, speed, and phase. If these parameters are known for a particular device (the master), then a second device (the slave) can have its speed and position "resolved" to the first in order to have the two devices play in perfect sync with one another.

Position
The position of a device is represented by either samples (audio word clock), video frames (timecode), or musical bars and beats (MIDI clock).

Speed
The speed of a device is measured either by the frame rate of the timecode, the sample rate (audio word clock) or by the tempo of the MIDI clock (bars and beats).

Phase
Phase is the alignment of the position and speed components to each other. In other words, each pulse of the speed component should be aligned with each measurement of the position for the most accuracy. Each frame of timecode should be perfectly lined up with the correct sample of audio. Put simply, phase is the very precise position of a synchronized device relative to the master (sample accuracy).

Machine control
When two or more devices are synchronized, the question remains: how do we control the entire system? We need to be able to locate to any position, play, record, and even jog and scrub the entire system using one set of controls.

Machine control is an integral part of any synchronization setup. In many cases, the device simply called "the master" will control the whole system. However, the term "master" can also refer to the device that is generating the position and speed references. Care must be taken to differentiate between the two.

Master and slave
Calling one device the "master" and another the "slave" can lead to a great deal of confusion. The timecode relationship and the machine control relationship must be differentiated in this regard.

In this document, the following terms are used:
- The "timecode master" is the device generating position information or timecode.
- The "timecode slave" is any device receiving the timecode and synchronizing or "locking" to it.
- The "machine control master" is the device that issues transport commands to the system.
- The "machine control slave" is the device receiving those commands and responding to them.

For example, Cubase could be the machine control master, sending transport commands to an external device which in turn sends timecode and audio clock information back to Cubase. In that case, Cubase would also be the timecode slave at the same time. So calling Cubase simply the master is misleading.

In most scenarios, the machine control slave is also the timecode master. Once it receives a play command, that device starts generating timecode for all the timecode slaves to synchronize to.

Timecode (positional references)
The position of any device is most often described using timecode. Timecode represents time using hours, minutes, seconds, and frames to provide a location for each device. Each frame represents a visual film or video frame.

Timecode can be communicated in several ways:
- LTC (Longitudinal Timecode) is an analog signal that can be recorded on tape. It should be used for positional information primarily. It can also be used for speed and phase information as a last resort if no other clock source is available.
• VITC (Vertical Interval Timecode) is contained within a composite video signal. It is recorded onto video tape and is physically tied to each video frame.
• MTC (MIDI Timecode) is identical to LTC except that it is a digital signal transmitted via MIDI.

**Timecode standards**

Timecode has several standards. The subject of the various timecode formats can be very confusing due to the use and misuse of the shorthand names for specific timecode standards and frame rates. The reasons for this confusion are described in detail below. The timecode format can be divided into two variables: frame count and frame rate.

**Frame count (frames per second)**

The frame count of timecode defines the standard with which it is labeled. There are four timecode standards:

• **24fps Film (F)**
  This frame count is the traditional count for film. It is also used for HD video formats and commonly referred to as “24p”. However, with HD video, the actual frame rate or speed of the video sync reference is slower, 23.976 frames per second, so timecode does not reflect the actual realtime on the clock for 24p HD video.

• **25fps PAL (P)**
  This is the broadcast video standard frame count for European (and other PAL countries) television broadcast.

• **30fps non-drop SMPTE (N)**
  This is the frame count of NTSC broadcast video. However, the actual frame rate or speed of the video format runs at 29.97 fps. This timecode clock does not run in realtime. It is slightly slower by 0.1%.

• **30fps drop-frame SMPTE (D)**
  The 30fps drop-frame count is an adaptation that allows a timecode display running at 29.97 fps to actually show the clock-on-the-wall-time of the timeline by “dropping” or skipping specific frame numbers in order to “catch the clock up” to realtime.

Confused? Just remember to keep the timecode standard (or frame count) and frame rate (or speed) separate.

**Frame rate (speed)**

Regardless of the frame counting system, the actual speed at which frames of video go by in realtime is the true frame rate.

In Cubase the following frame rates are available:

• **23.9fps (Cubase only)**
  This frame rate is used for film that is being transferred to NTSC video and must be slowed down for a 2-3 pull-down telecine transfer. It is also used for the type of HD video referred to as “24p”.

• **24fps**
  This is the true speed of standard film cameras.

• **24.9fps (Cubase only)**
  This frame rate is commonly used to facilitate transfers between PAL and NTSC video and film sources. It is mostly used to correct for some error.

• **25fps**
  This is the frame rate of PAL video.

• **29.97fps**
  This is the frame rate of NTSC video. The count can be either non-drop or drop-frame.

• **30fps**
  This frame rate is not a video standard anymore but has been commonly used in music recording. Many years ago it was the black and white NTSC broadcast standard. It is equal to NTSC video being pulled up to film speed after a 2-3 telecine transfer.

• **59.98fps (Cubase only)**
  This rate is also referred to as “60p”. Many professional HD cameras record at 59.98fps. While 60fps could theoretically exist as a frame rate, no current HD video camera records at a full 60fps as a standard rate.

**Frame count vs. frame rate**

Part of the confusion in timecode stems from the use of “frames per second” in both the timecode standard and the actual frame rate. When used to describe a timecode standard, frames per second defines how many frames of timecode are counted before one second on the counter increments. When describing frame rates, frames per second define how many frames are played back during the span of one second of realtime. In other words: Regardless of how many frames of video there are per second of timecode (frame count), those frames can be moving at different rates depending on the speed (frame rate) of the video format. For example, NTSC timecode (SMPTE) has a frame count of 30fps. However, NTSC video runs at a rate of 29.97fps. So the NTSC timecode standard known as SMPTE is a 30fps standard that runs at 29.97 realtime.
Synchronization

Clock sources (speed references)

Once the position is established, the next essential factor for synchronization is the playback speed. Once two devices start playing from the same position, they must run at exactly the same speed in order to remain in sync. Therefore, a single speed reference must be used and all devices in the system must follow that reference. With digital audio, the speed is determined by the audio clock rate. With video, the speed is determined by the video sync signal.

Audio clock

Audio clock signals run at the speed of the sample rate used by a digital audio device and are transmitted in several ways:

Word clock

Word clock is a dedicated signal running at the current sample rate that is fed over BNC coaxial cables between devices. It is the most reliable form of audio clock and is relatively easy to connect and use.

AES/SPDIF Digital Audio

An audio clock source is embedded within AES and SPDIF digital audio signals. This clock source can be used as a speed reference. Preferably, the signal itself does not contain any actual audio (digital black), but any digital audio source can be used if necessary.

ADAT Lightpipe

ADAT Lightpipe, the 8-channel digital audio protocol developed by Alesis, also contains audio clock and can be used as a speed reference. It is transmitted via optical cables between devices.

MIDI clock

MIDI clock is a signal that uses position and timing data based on musical bars and beats to determine location and speed (tempo). It can perform the same function as a positional reference and a speed reference for other MIDI devices. Cubase supports sending MIDI clock to external devices but cannot slave to incoming MIDI clock.

\[\text{MIDI clock cannot be used to synchronize digital audio. It is only used for MIDI devices to play in musical sync with one another. Cubase does not support being a MIDI clock slave.}\]

The Project Synchronization Setup dialog

Cubase's Project Synchronization Setup dialog provides a central place to configure a complex synchronized system. In addition to settings for timecode sources and machine control settings, project setup parameters are available along with basic transport controls for testing the system.

To open the Project Synchronization Setup dialog, proceed as follows:

- On the Transport menu, select the “Project Synchronization Setup…” option.
- On the Transport panel, [Ctrl]/[Command]-click the Sync button.

The dialog is organized into sections separating related groups of settings. The arrows shown between the various sections of the dialog indicate how settings in one section influence settings in another section. In the following, the available sections are described in detail.

The Cubase section

At the center of the Project Synchronization Setup dialog is the Cubase section. It is provided to help you visualize the role that Cubase takes in your setup. It shows which external signals enter or leave the application.
Timecode Source

The Timecode Source setting determines whether Cubase is acting as timecode master or slave.

When set to “Internal Timecode”, Cubase is the timecode master, generating all position references for any other device in the system. The other options are for external timecode sources. Selecting any of these, makes Cubase a timecode slave when the Sync button is activated.

Internal Timecode

Cubase generates timecode based on the project timeline and project setup settings. The timecode will follow the format specified in the Project Setup section.

MIDI Timecode

Cubase acts as a timecode slave to any incoming MIDI timecode (MTC) on the port(s) selected in the MIDI Timecode section, to the right of the Timecode Source section.

Selecting “All MIDI Inputs” allows Cubase to sync to MTC from any MIDI connection. You can also select a single MIDI port for receiving MTC.

ASIO Audio Device

This option is only available with audio cards that support ASIO Positioning Protocol. These audio cards have an integrated LTC reader or ADAT sync port and can perform a phase alignment of timecode and audio clock.

VST System Link

VST System Link can provide all aspects of sample-accurate synchronization between other System Link workstations. For information on configuring VST System Link, see “Working with VST System Link” on page 501.

Timecode Preferences

When MIDI Timecode is selected, additional options become available in the Cubase section, providing several options for working with external timecode.

Lock Frames

This setting determines how many full frames of timecode it takes for Cubase to try and establish sync or “lock”. If you have an external tape transport with a very short start-up time, try lowering this number to make lock-up even faster. This option can only be set to multiples of two.

Drop Out Frames

This setting determines the amount of missed timecode frames it takes for Cubase to stop. Using LTC recorded on an analog tape machine can result in some amount of drop outs. Increasing this number allows Cubase to “free-wheel” over missed frames without stopping. Lowering this number causes Cubase to stop sooner once the tape machine has stopped.

Inhibit Restart ms

Some synchronizers still transmit MTC for a short period after an external tape machine has been stopped. These extra frames of timecode sometimes cause Cubase to restart suddenly. The “Inhibit Restart ms” setting allows you to control the amount of time in milliseconds that Cubase will wait to restart (ignoring incoming MTC) once it has stopped.
Auto-Detect Frame-Rate Changes
Cubase can notify the user when the frame rate of time-code changes at any point. This is helpful in diagnosing problems with timecode and external devices. This notification will interrupt playback or recording. Deactivating this option will avoid any interruption in playback or recording.

⚠️ If there is a discrepancy between the project frame rate in Cubase and incoming timecode, Cubase might still be able to lock to the incoming timecode. If the user is unaware of these differences, problems can arise later in postproduction.

Machine Control Output Destination
When the Sync button on the Transport panel is activated, all transport commands (including movements of the cursor in the Project window) are translated into machine control commands and routed according to the settings made in the “Machine Control Output Destination” section.

MMC Device ID
The MMC device ID should be set to the same number as the receiving device. You can also set the device ID to “All” if more than one machine is receiving MMC commands or if the device ID is not known.

⚠️ Some devices can only listen to their specific IDs. Therefore, using the All option will not work with such devices.

Number of Audio Tracks (Cubase only)
The number of audio tracks should be set to match the amount of available audio tracks in the destination device. This setting determines how many record-enable buttons are shown in the MMC Master panel (see below).

MMC Master panel
The MMC Master panel can be opened from the Devices menu. In order to use the MMC Master panel, proceed as follows:

• Open the Preferences dialog, select the MIDI Filter section and make sure SysEx is activated in the Thru section. This is necessary since MMC uses two-way communication (the tape recorder “replies” to the MMC messages it receives from Cubase). By filtering out SysEx Thru, you ensure that these MMC System Exclusive replies are not echoed back to the tape recorder.

• On the MMC Master panel, activate the Online button to use the transport buttons on the panel to control the transport of the device.

It is not necessary to have this activated in order to synchronize with the MMC device. It only affects operation of the MMC Master panel.

• You can use the buttons to the left on the MMC Master panel to arm tape tracks for recording.

• The “A1, A2, TC, VD” items refer to additional tracks usually found on video tape recorders. Refer to the manual of your VTR device to see if these tracks are supported.
Machine Control Input (Cubase only)

Cubase can respond to machine control commands from external MIDI devices. Cubase can follow incoming transport commands (locate, play, record) and respond to record-enabling commands for audio tracks. This allows Cubase to easily integrate into larger studio systems with centralized machine control and synchronization such as theatrical mixing stages.

MMC Slave Active

When this option is activated, several settings become available in the Machine Control Input section:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MMC Input</td>
<td>Set this to the MIDI input that is connected to the master machine control device.</td>
</tr>
<tr>
<td>MMC Output</td>
<td>Set this to the MIDI output that is connected to the master machine control device.</td>
</tr>
<tr>
<td>MMC Device ID</td>
<td>This determines the MIDI ID number that is used to identify the machine in Cubase.</td>
</tr>
</tbody>
</table>

⚠️ The MMC protocol involves polling devices (requesting information) for their status which requires two way communication. While some functions may work with only one way communication, it is best to connect both MIDI ports (input and output) of MMC devices. Refer to “MMC Master panel” on page 498 to ensure that the MIDI filter is set up correctly.

MIDI Timecode Destinations

Cubase can send MTC to any MIDI port. Use this section to specify the MIDI ports to which MTC is routed. Devices that can lock to MTC will chase Cubase’s timecode position.

⚠️ Some MIDI interfaces send MTC over all ports by default. If this is the case, only select one port of the interface for MTC.

MIDI Clock Destinations

Some MIDI devices like drum machines can match their tempo and location to incoming MIDI clock. Select any MIDI ports that you wish to output MIDI clock.

MIDI Clock Follows Project Position

Activate this option to ensure that the MIDI clock device follows Cubase when looping, locating, or jumping while playing.

⚠️ Some older MIDI devices might not respond well to these positioning messages and could take some time synchronizing to the new location.
Always Send Start Message

MIDI clock transport commands include Start, Stop, and Continue. However, some MIDI devices do not recognize the Continue command. By activating the “Always Send Start Message” option, you can avoid this problem with specific MIDI devices.

Send MIDI Clock in Stop Mode

Activate this option if you are working with a device that needs MIDI clock to run continuously in order to operate arpeggiators and loop generators.

Synchronized operation

Once you have connected all the devices that will be synchronized, it is important to understand how Cubase operates in Sync mode. Sync mode is enabled by activating the Sync button on the Transport panel.

Sync mode

When you activate the Sync button, the following happens:

• Cubase only: Transport commands are routed to the machine control destination output as specified in the Project Synchronization Setup dialog. Locate, Play, Stop, and Record commands will now be sent to an external device.

• Cubase awaits incoming timecode from the chosen timecode source defined in the Project Synchronization Setup dialog in order to play. Cubase will detect incoming timecode, locate to its current position, and start playback in sync with the incoming timecode.

Cubase only: In a typical scenario, an external tape machine (e.g. a VTR) has its timecode output connected to Cubase. Cubase is sending machine control commands to the deck. When Sync is activated and you click Play on the Transport panel, a play command is sent to the VTR. The VTR in turn starts playback, sending timecode back to Cubase. Cubase then synchronizes to that incoming timecode.

Example scenarios (Cubase only)

To better understand how synchronization options can be utilized, an example scenario is provided.

Personal music studio

In a personal music studio, the user might have the need of synchronizing with an external recording device such as a portable hard disk recorder used for live remote recordings.

In this example, MIDI will be used for timecode and machine control while the audio clock will be handled by Lightpipe digital audio connections.

• When the Sync button is activated, Cubase sends MMC commands to the hard disk recorder. Cubase can remotely start playback of the recorder.

• The hard disk recorder is using audio clock from Cubase’s audio interface as the speed reference. It is also possible for Cubase to use the audio clock from the recorder. The audio clock is carried over the Lightpipe digital audio connection that also carries audio signals.

• The hard disk recorder sends back MTC to Cubase. When the recorder begins playing, MTC is sent back to Cubase which will sync to that timecode.

Sync settings for a personal music studio

To synchronize the devices in this example scenario, proceed as follows:

1. Make the connections as shown in the diagram above. In this simple example, any device that uses MTC can be substituted.

2. Open the Project Synchronization Setup dialog and select “MIDI Timecode” as the timecode source. When recording from the hard disk recorder into Cubase, Cubase will be the machine control master and the timecode slave, locking to incoming MTC.

3. In the “Machine Control Output Destination” section, select the “MIDI Machine Control” option. Cubase will now send MMC commands to the hard disk recorder to locate and start playback.

4. In the “Machine Control Output Settings” section, assign the MIDI input and output ports that are connected to the hard disk recorder. Since MMC uses two-way communication, both MIDI ports should be connected. Be sure the MIDI filter does not echo SysEx data.
5. On the Transport panel, activate the Sync button. This routes transport commands to the hard disk recorder via MIDI and sets Cubase as the timecode slave.

6. On the hard disk recorder, enable MMC and MTC. Follow the instructions on how to set up the unit to receive MMC commands and transmit MTC.

7. In Cubase, click the Play button. The hard disk recorder should start playback and send MTC to Cubase. Once Cubase syncs to MTC, the status on the Transport panel should read “Lock” and show the current frame rate of incoming MTC.

Working with VST System Link

VST System Link is a network system for digital audio that allows you to have several computers working together in one large system. Unlike conventional networks it does not require Ethernet cards, hubs, or CAT-5 cables; instead it uses the kind of digital audio hardware and cables you probably already possess in your studio.

VST System Link has been designed to be simple to set up and operate, yet give enormous flexibility and performance gains in use. It is capable of linking computers in a “ring” network (the System Link signal is passed from one machine to the next, and eventually returns to the first machine). VST System Link can send its networking signal over any type of digital audio cable, including S/PDIF, ADAT, TDIF, or AES, as long as each computer in the system is equipped with a suitable ASIO compatible audio interface.

Linking up two or more computers gives you vast possibilities:
• Dedicate one computer to running VST instruments while recording audio tracks on another.
• If you need lots of audio tracks, you may simply add tracks on another computer.
• You could have one computer serve as a “virtual effect rack”, running CPU-intensive send effect plug-ins only.
• Since you can use VST System Link to connect different VST System Link applications on different platforms, you can take advantage of effect plug-ins and VST instruments that are specific to certain programs or platforms.

Requirements

The following equipment is required for VST System Link operation:
• Two or more computers.
These can be of the same type or use different operating systems – it does not matter. For example, you can link an Intel-based PC to an Apple Macintosh without problems.
• Each computer must have audio hardware with specific ASIO drivers.
• The audio hardware must have digital inputs and outputs.
To be able to connect the computers, the digital connections must be compatible (i.e. the same digital formats and connection types must be available).
• At least one digital audio cable must be available for each computer in the network.
• A VST System Link host application must be installed on each computer.
Any VST System Link application can connect to another. Additionally, use of a KVM switchbox is recommended.

Using a KVM switchbox

Whether you want to set up a multi-computer network or a small network in a limited space, it is a good idea to invest in a KVM (Keyboard, Video, Mouse) switchbox. With one of these you can use the same keyboard, monitor, and mouse to control each computer in the system, and you can switch between computers very rapidly. KVM switchboxes are not too expensive, and they are very easy to set up and operate. If you decide not to go this route, the network will function just the same, but you may end up doing a lot of jumping from one machine to the other while setting up!

Making connections

Below, we assume that you are connecting two computers. Should you have more than two computers, it is still best to start with two and add the others one by one once the system is working – this makes troubleshooting easier if you run into problems. For two computers, you will need two digital audio cables, one in each direction:

1. Use the first digital audio cable to connect the digital output of computer 1 to the digital input of computer 2.
2. Use the other cable to connect the digital output of computer 2 to the digital input of computer 1.
If a card has more than one set of inputs and outputs, choose whichever one that suits you – for simplicity usually the first set is best.

**Synchronization**

Before you proceed, you need to make sure that the clock signals on your ASIO cards are synchronized correctly. This is essential when cabling any kind of digital audio system, not just VST System Link.

⚠️ All digital audio cables by definition always carry a clock signal as well as audio signals, so you do not have to use a special word clock input and output for this (although you may find that you get a slightly more stable audio system if you do, especially when using multiple computers).

The clock mode or sync mode is set up in the ASIO control panel of the audio hardware. Proceed as follows:

1. From the Devices menu, open the Device Setup dialog.
2. On the VST Audio System page, select your audio interface from the ASIO Driver pop-up menu. In the Devices list, the name of the audio interface now appears as a sub-entry to the “VST Audio System” entry.
3. In the Devices list, select your audio interface.
4. Click the Control Panel button. The ASIO control panel appears.
5. Open the ASIO control panel on the other computer as well. If you are using another VST System Link host application on that computer, check its documentation for details on how to open the ASIO control panel.
6. Now you need to make sure that one audio card is set to be the clock master and all other cards are set to be clock slaves (i.e. they listen for the clock signal coming from the clock master). The naming and procedure for this differs depending on the audio hardware – consult its documentation if required. If you are using Steinberg Nuendo ASIO hardware, all cards default to the AutoSync setting. In this case you must set one of the cards (and only one) to “Master” in the Clock Mode section of the control panel.

Typically, the ASIO control panel for an audio card contains some indication of whether or not the card receives a proper sync signal, including the sample rate of that signal. This is a good indication that you have connected the cards and set up clock sync properly. Check your audio hardware’s documentation for details.

⚠️ It is very important that only one card is the clock master, otherwise the network cannot function correctly. Once you have set this up, all the other cards in the network will take their clock signal from this card automatically.

The only exception to this procedure is if you are using an external clock – from a digital mixing desk or a special word clock synchronizer, for example. In that case you must leave all your ASIO cards in clock slave or AutoSync mode and make sure that each of them is listening for the signal coming from the synchronizer. This signal is usually passed through your ADAT cables or word clock connectors in a daisy chain fashion.

**VST System Link and latency**

The general definition of latency is the amount of time it takes any system to respond to whatever messages are sent to it. For example, if your system’s latency is high and you play VST instruments in realtime, you will get a noticeable delay between when you press a key and when you hear the sound of the VST instrument. Nowadays, most ASIO-compatible audio cards are capable of operating with very low latencies. Also, all VST applications are designed to compensate for latency during playback, making the playback timing tight.

However, the latency time of a VST System Link network is the total latency of all the ASIO cards in the system added together. Therefore it is extra important to minimize the latency times for each computer in the network.

⚠️ The latency does not affect the synchronization – it is always perfectly in time. But it can affect the time it takes to send and receive MIDI and audio signals, or make the system seem sluggish.

To adjust the latency of a system, you adjust the size of the buffers in the ASIO control panel – the lower the buffer size, the lower the latency. It is best to keep to fairly low latencies (buffer sizes) if your system can handle it – about 12ms or less is usually a good idea.
Synchronization

Setting up your software

Now it is time to set up your programs. The procedures below describe how to set things up in Cubase. If you are using another program on the other computer, please refer to its documentation.

Setting the sample rate

The projects in both programs must be set to use the same sample rate. Select “Project Setup…” from the Project menu and make sure that the sample rate is the same in both systems.

Streaming digital audio between applications

1. Create input and output busses in both applications and route these to the digital inputs and outputs. The number and configuration of the busses depend on your audio hardware and on your needs. If you have a system with eight digital i/o channels (such as an ADAT connection), you could create several stereo or mono busses, a surround bus together with a stereo bus, or any combination you need. The important thing is that you should have the same configuration in both applications – if you have four stereo output busses on computer 1, you want four stereo input busses on computer 2, etc.

2. Set things up so that computer 1 plays back some audio. For example, you could import an audio file and play it back in Cycle mode.

3. In the Inspector or Mixer, make sure that the channel containing the audio material is routed to one of the digital output busses.

4. On computer 2, open the Mixer and locate the corresponding digital input bus. The audio being played back should now “appear” in the program running on computer 2. You should see the input bus level meters moving.

5. Reverse this procedure so that computer 2 plays back and computer 1 “listens”.

Now you have verified that the digital connection works as it should.

From this point on in this chapter, we refer to the busses connected to the digital inputs and outputs as “VST System Link busses”.

Settings for the audio hardware

When you exchange VST System Link data between computers, it is important that the digital information is not changed in any way between the programs. Therefore, you should open the control panel (or additional application) for your audio hardware and make sure that the following conditions are met:

- If there are additional “format settings” for the digital ports that you use for VST System Link data, make sure that these are turned off.
  For example, if you are using an S/PDIF connection for VST System Link, make sure that “Professional format”, Emphasis, and Dithering are turned off.

- If your audio hardware has a mixer application allowing you to adjust the levels of digital inputs and outputs, make sure that this mixer is disabled or that the levels for the VST System Link channels are set to ±0 dB.

- Similarly, make sure no other forms of DSP (pan, effects, etc.) are applied to the VST System Link signal.

Notes for Hammerfall DSP users

If you are using RME Audio Hammerfall DSP audio hardware, the Totalmix function allows for extremely complex signal routing and mixing in the audio hardware. This can in some situations lead to “signal loops” in which case the VST System Link will not work. If you want to make absolutely sure this will not cause any problems, select the default or “plain” preset for the Totalmix function.

Activating VST System Link

Before you proceed, you need to make sure that VST System Link is set as the timecode source in the Project Synchronization Setup dialog and that the desired Sync options are activated, see “Timecode Preferences” on page 497.

After setting up the inputs and outputs, you now need to define which input/output will carry the actual VST System Link information.

The VST System Link networking signal is carried on only one bit of one channel. This means that if you have an ADAT-based system which normally carries eight channels of 24-bit audio, once you activate VST System Link you will have seven channels of 24-bit audio and one channel of
23-bit audio (the least significant bit of this last channel will be used for networking). In practice this makes no discernible difference to the audio quality, since you will still have around 138 dB headroom on this channel.

To set things up, open the VST System Link panel:

1. From the Devices menu, open the Device Setup dialog.
2. In the Devices list to the left, select the “VST System Link” entry.

The VST System Link settings are shown to the right of the Devices list.

3. Use the ASIO Input and ASIO Output pop-up menus to define which channel is the networking channel.
4. Activate the Active checkbox at the top left of the panel.
5. Repeat the steps above for every computer in the network.

As the computers are made active, you should see the Sending and Receiving indicators flashing on each active computer, and the name of each computer should appear in the list at the bottom of the pane. Each computer is assigned a random number – do not worry about this, it is just so the network knows internally which one is which.

• You can double-click on the name in bold (which is the name of the computer you are currently working on) and set it to whatever other name you wish.

This name will appear in the VST System Link window of every computer on the network.

⚠️ If you do not see the name of each computer appearing once you have made it active, you need to check your settings. Go through the procedure above again and make sure that all ASIO cards are listening to the digital clock signals correctly, and that each computer has the correct inputs and outputs assigned to the VST System Link network.

### Putting the network online

After each computer’s name you will see whether it is online or not. When a computer is online, it will receive transport and timecode signals, and its sequencer application can be started and stopped by remote control. If it is offline, it can only be started from its own keyboard – it is effectively an independent machine, although it is still on the network.

⚠️ Note that any computer can control any and all of the others – VST System Link is a peer-to-peer network and there is no absolute “master” computer.

To put all computers online, proceed as follows:

1. For all computers, activate the Online checkbox on the VST System Link page.
2. Start playback on one computer to check that the system is working – all computers should start almost instantly and play perfectly in time, with sample-accurate precision.

• The Offset Samples setting allows you to adjust whether one machine will play slightly ahead or behind the rest. This is normally not needed, but occasionally with some hardware you may find that the lock is a few samples out. For now, leave it set to 0 – it will most likely be what you want.

• The Transfer Bits setting allows you to specify whether you want to transfer 24 or 16 bits. This allows you to use older audio cards which do not support transfer of 24 bits.

VST System Link sends and understands all transport commands (such as play, stop, fast forward, rewind, etc.). This allows you to control the entire network from one computer without a problem – try it! If you jump to a locator point on one machine, all other machines will also instantly jump to that locator point.

⚠️ Make sure that all computers have their tempos set to the same value, otherwise your synchronization will be seriously skewed.
Scrubbing via VST System Link

You can scrub on one computer and have the video and audio on another computer scrub along. However, the playback on the linked systems may not be perfectly in sync while scrubbing and there are some further restrictions you should bear in mind when scrubbing via VST System Link:

- Use the jog/shuttle control on the Transport panel or a remote controller for scrubbing. Scrubbing with the Scrub tool does not work over a VST System Link connection.
- Always use the system where you started scrubbing to control the scrubbing, e.g. change the scrub speed or stop scrubbing. Changing the scrub speed on a remote system will only change the speed on the local system.
- You can start playback on all systems. This stops scrubbing and enters playback on all systems in sync.

Using MIDI

As well as supplying transport and sync control, VST System Link also supplies up to 16 MIDI ports, with 16 channels each. To set this up, proceed as follows:

1. Use the MIDI Inputs and MIDI Outputs value fields to specify the number of MIDI ports you need. The default value is 0 MIDI In and 0 MIDI Out ports.
2. In the Project window, create a MIDI track and open the Inspector (top section).
3. If you now pull down the Input or Output Routing pop-up menu, you will find the specified System Link ports added to the list of MIDI inputs or outputs.

This allows you to route MIDI tracks to VST instruments running on another computer, as described in the application examples (see “Using one computer for VST instruments” on page 507).

The “Use Selected ASIO Ports for Data only” setting

If you are sending huge amounts of MIDI data at once, there is a small possibility that you might run out of bandwidth on your VST System Link network. This will manifest itself by notes “choking” or timing becoming erratic.

If this happens, you can devote more bandwidth to MIDI by activating the “Use Selected ASIO Ports for Data only” option on the VST System Link page of the Device Setup dialog. When this is activated, the VST System Link information will be sent on the entire channel instead of just one bit, more than enough for all the MIDI you could ever hope to use. The downside is that you can no longer use this ASIO channel for audio transfer (do not connect it to a speaker!), thus leaving you with only 7 audio channels in our ADAT cable example. Depending on how you work, this might be a reasonable compromise.
Hearing the network audio

If you are using an external mixing desk, hearing your audio really is not an issue – just plug the outputs of each computer into the desired channels on the external mixing desk, start playback on one of the computers, and you are good to go.

However, many people prefer to mix internally inside the computer and just use a desk for monitoring (or maybe not use any external mixer at all). In this case you will need to select one computer to be your “main mix computer” and send the audio from your other computers into this.

In the following example, we assume you are using two computers, with computer 1 as your main mix computer and computer 2 running two additional stereo audio tracks, an FX channel track with a reverb plug-in and a VST instrument plug-in with stereo outputs.

Proceed as follows:

1. Set things up so that you can listen to the audio playback from computer 1. In other words, you need an unused set of outputs, e.g. an analog stereo output, connected to your monitoring equipment.
2. On computer 2, route each of the two audio tracks to a separate output bus. These should be busses connected to the digital outputs – let’s call them Bus 1 and 2.
3. Route the FX channel track to another VST System Link bus (Bus 3).
4. Route the VST instrument channel to yet another bus (Bus 4).
5. Go back to computer 1 and check the corresponding four VST System Link input busses.
   If you start playback on computer 2, the audio should “appear” on the input busses on computer 1. However, to mix these audio sources you need actual Mixer channels.
6. Add four new stereo audio tracks on computer 1 and route these to the output bus you use for listening, e.g. to the analog stereo outputs.
7. For each of the audio tracks, select one of the four input busses. Now, each computer 2 bus is routed to a separate audio channel on computer 1.
8. Activate monitoring for the four tracks.

If you now start playback, the audio from computer 2 will be sent “live” to the new tracks on computer 1, allowing you to hear them together with any tracks you play back on computer 1.

For more information about Monitoring, see “About monitoring” on page 30.

Adding more tracks

What if you have more audio tracks than you have VST System Link busses (physical outputs)? Then you just use the computer 2 mixer as a submixer: Route several audio channels to the same output bus and adjust the output bus level if needed.

If your audio cards have multiple sets of input and output connections, you can link up multiple ADAT cables and send audio via any of the busses on any of the cables.

Internal mixing and latency

One problem with mixing inside the computer is the latency issue we mentioned earlier. The VST engine always compensates for record latencies, but if you are monitoring through computer 1 you will hear a processing delay while you listen to signals coming from your other computers (not on your recording!). If your audio card in computer 1 supports ASIO Direct Monitoring you should definitely turn this on. You can find the setting on the VST Audio System device panel for your hardware (see “ASIO Direct Monitoring” on page 97). Most modern ASIO cards support this function. If yours does not, you may want to change the Offset Samples value on the VST System Link page to compensate for any latency issues.

Setting up a larger network

Setting up a larger network is not much more difficult than a two-computer network. The main thing to remember is that VST System Link is a daisy chain system. In other words, the output of computer 1 goes to the input of computer 2, the output of computer 2 goes to the input of computer 3, and so on around the chain. The output of the last computer in the chain must always go back into the input of computer 1, to complete the ring.
Once you have done this, the transmission of all the transport, sync, and MIDI information to the whole network is handled pretty much automatically. However, where you may run into confusion in a large network is in the transmission of audio signals back to a central mix computer. If you have lots of hardware inputs and outputs on your ASIO cards, you do not have to send audio via the chain at all, but can transmit it directly to the master mix computer via one or more of its other hardware inputs. For example, if you have a Nuendo Digiset interface or 9652 card on computer 1, you could use ADAT cable 1 for networking, ADAT cable 2 as a direct audio input from computer 2, and ADAT cable 3 as a direct audio input from computer 3. You can also transmit audio via the ring system if you do not have enough hardware I/Os for direct audio transmission. For example, in a four-computer scenario you could send audio from computer 2 into a channel in the Mixer in computer 3, from there to a channel in the Mixer in computer 4, and from there back to the master Mixer in computer 1. This can certainly be tricky to set up, so for complex networks it is generally recommended to use ASIO cards with at least three separate digital I/Os.

Application examples

Using one computer for VST instruments

In this example, one computer will be used as main record and playback machine, and another computer as a virtual synth rack. Proceed as follows:

1. Record a MIDI track into computer 1.
2. Once you have finished recording, route the MIDI output of that track to VST System Link MIDI port 1.
3. On computer 2, open up the VST Instrument rack and assign an instrument to the first slot in the rack.
4. Route the VST instrument channel to the desired output bus. If you are using computer 1 as your main mixing computer, this would be one of the VST System Link output busses, connected to computer 1.
5. Create a new MIDI track in the Project window of computer 2 and assign the MIDI output of the track to the VST instrument you created.
6. Assign the MIDI input of the track to be VST System Link port 1.
Now, the MIDI track on computer 1 is routed to the MIDI track on computer 2, which in turn is routed to the VST instrument.
7. Now activate monitoring for the MIDI track on computer 2, so that it will listen and respond to any MIDI commands coming in. In Cubase, click the Monitor button in the track list or Inspector.
8. Start playback on computer 1.
It will now send the MIDI information on the track to the VST instrument loaded on computer 2. Even with a slow computer you should be able to stack a whole bunch of extra VST instruments this way, expanding your sound palette considerably. Do not forget that VST System Link MIDI is also sample-accurate, and thus has much tighter timing than any hardware MIDI interface ever invented!

Creating a virtual effect rack

The effect sends for an audio channel in Cubase can either be routed to an FX channel track or to any activated group or output bus. This allows you to use a separate computer as a “virtual effect rack”, by setting the system up as follows:

1. On computer 2 (the machine you will use as effect rack), add a new stereo audio track. You cannot use an FX channel track in this case, since the track must have an audio input.
2. Add the desired effect as an insert effect for the track. Let’s say you add a high-quality reverb plug-in.
3. In the Inspector, select one of the VST System Link busses as input for the audio track. You want to use a separate VST System Link bus, which will only be used for this purpose.
4. Route the channel to the desired output bus. If you are using computer 1 as your main mixing computer, this would be one of the VST System Link output busses, connected to computer 1.
5. Activate monitoring for the track.
6. Go back to computer 1 and select a track to which you want to add some reverb.
7. Bring up the effect sends for the track in the Inspector or the Mixer.
8. Open the Send Routing pop-up menu for one of the sends and select the VST System Link bus assigned to the reverb in step 3.

9. Use the Send slider to adjust the amount of effect as usual.

The signal will be sent to the track on computer 2 and processed through its insert effect, without using any processor power on computer 1.

You can repeat the steps above to add more effects to the “virtual effect rack”. The number of effects available this way is only limited by the number of ports used in the VST System Link connection (and of course by the performance of computer 2, but given that it will not have to handle any recording or playback, you should be able to use quite a lot of effects).

**Getting extra audio tracks**

All computers on a VST System Link network are locked with sample-accuracy. Therefore, if you find that the hard drive on one computer is not fast enough to run as many audio tracks as you need, you can record new tracks on one of the other computers instead. This would create a “virtual RAID system”, with several disks all operating together. All tracks will remain locked together just as tightly as if they were all running on the same machine. This means that you effectively have an unlimited track count! Need another 100 tracks? Just add another computer.

**Dedicated Video Playback**

Playback of high-resolution video can be taxing on a system’s CPU. By dedicating one computer for video playback via System Link, you can free up resources on your main CPU for audio and MIDI processing. Since all transport commands will respond on the VST System Link computers, scrubbing video is possible even when it is coming from another computer.
Introduction

Cubase supports the integration of video files in your project. You can play back video files in various formats and via different output devices from within Cubase, edit your music to the video, extract the audio material from a video file, and replace the audio later with different audio material.

Before you start

When working on a project involving a video file, you first need to set up your system according to your equipment and your demands. The following sections provide some general information about video file formats, frame rates, and video output devices.

Video file compatibility

Because there are many types of video files, it can be difficult to determine if one will work on your system. There are two ways to figure out if Cubase can play back a certain video file:

• Open the video file with QuickTime 7.1 or higher, because Cubase uses QuickTime for playing back video files.
• Check the file information of a video file in the Pool. If the information reads "Invalid or not supported file!", the video file is either corrupt or the format is not supported by the available codecs.

⚠️ If you are not able to load a certain video file, you must use an external application to convert the file into a compatible format or install the required codec. For more information on codecs, see the section “Codecs” on page 510.

Video container formats

Video and other multi-media files come in a container format. This container holds various streams of information including video and audio, but also metadata such as synchronization information required to play back audio and video together. Data regarding creation dates, authors, chapter markings, and more can also be held within the container format.

The following container formats are supported by Cubase:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOV</td>
<td>This is a QuickTime movie.</td>
</tr>
<tr>
<td>QT</td>
<td>This is also a QuickTime movie, but it is only used in Windows.</td>
</tr>
<tr>
<td>MPEG-1</td>
<td>This is the first standard of the Moving Picture Experts Group for video and audio compression, used for making video CDs. Files of this container format can have the extensions &quot;.mpg&quot; or &quot;.mpeg&quot;.</td>
</tr>
<tr>
<td>MPEG-4</td>
<td>This format is based on the QuickTime movie standard, can contain various metadata for streaming, editing, local playback, and interchange of content. Its file extension is &quot;.mp4&quot;.</td>
</tr>
<tr>
<td>AVI</td>
<td>This format is a multimedia container format introduced by Microsoft.</td>
</tr>
<tr>
<td>DV</td>
<td>This is a video format used by camcorders.</td>
</tr>
</tbody>
</table>

Cubase supports all these container formats, but problems may arise when the computer does not have the correct software to decode compressed video and audio streams within the container file. You must also know the type of codec that was used to create the video file.

Codecs

Codecs are methods of data compression used to make video (and audio) files smaller and more manageable for computers. In order to play back a video file, your computer must have the correct codec installed in the operating system to decode the video stream.

⚠️ The names of codecs and container formats can be confusing. Because many container formats have the same names as the codecs they use within the file, make sure to differentiate the container format or file type (e.g. .mov or .dv) from the codec used within it.

If you are not able to load a certain video file, the required codec is probably not installed on your computer. In this case, you can search the Internet (e.g. the Microsoft or Apple web sites) for video codecs.
Frame rates
Cubase is capable of working with different types of video and film frame rates. For an overview about the supported frame rates, refer to the section “Frame rate (speed)” on page 495.

Video output devices
Cubase supports several ways to play back video files. Viewing video files onscreen in the Video Player window may work just fine for many applications, but often it is necessary to display video in a large format for viewing small details and so others involved in the session can also see the video. Cubase provides the ability to use several types of video output devices to accomplish this.

Multi-head video cards
One of the most common methods is the use of a multi-head video card installed in the computer. Multi-head video cards allow you to connect more than one computer monitor to the card, in some cases up to four. If you direct the video output of Cubase to one of these outputs, the video file is displayed in fullscreen mode on a computer monitor or HD television screen.

- You can also use more than one video card to achieve the same result.

Different video cards support different types of outputs including standard VGA, DVI, S-Video, HDMI, and component video. These options allow you to choose the type of monitor you use for video. HD televisions and digital projectors provide the largest viewing screens, but a normal computer monitor can function as a very high-quality video monitor as well.

Dedicated video cards
The use of a dedicated video card is also supported in Cubase. These cards are normally used in video editing systems to capture video to disk and display it while editing. They usually have a high resolution and take some strain off the host CPU by providing video compression and decompression processing on the card.

- The Decklink cards by Blackmagic Design are automatically recognized by Cubase. Video will be sent directly to its output.

FireWire DV Output
You have the option to use FireWire ports on the computer to output DV video streams to external converters such as various camcorders and standalone FireWire to DV conversion units. These units can be connected to a television or projector for large format viewing. The FireWire protocol is capable of transporting data at high speed and is the most common standard for communicating with video-related peripheral equipment.

⚠️ Under Windows, it is important that you connect your device to the FireWire port before launching Cubase. Otherwise it may not be detected properly by Cubase.

Preparing a video project in Cubase
The following sections describe the basic operations necessary for preparing a Cubase project involving video. It is advisable to store your video files on a separate hard drive from your audio files. This can help prevent data streaming problems when using high-resolution video with many audio tracks.

Importing video files
Importing a video file into your project is very straightforward once you know that you have a compatible video file. Video files are imported in the same manner as audio files:

- By using the File menu (Import–Video File). In the Import Video dialog, you can activate the “Extract Audio From Video” option. This imports any embedded audio streams to a newly created audio track positioned below the video track. The new track and the clip will get the name of the video file. The new audio event will start at the same time as the video event, so that they are in sync with each other.

- If you try to import a non-supported video file with the Import Video option, the Import Video dialog displays the text “Invalid or not supported file!”.

- By importing to the Pool first and then dragging to the Project window (see “The Pool” on page 299 for details).

- By using drag and drop from the MediaBay, the Pool, the Windows Explorer, or the Mac OS Finder.
When importing video files via the Pool or by using drag and drop, Cubase can automatically extract the audio from a video file. Whether this happens, depends on the “Extract Audio on Import Video File” setting in the Preferences dialog (Video page). For further information about extracting audio from a video file, see “Extracting audio from a video file” on page 516.

When importing video, Cubase automatically creates a thumbnail cache file. The generated file is stored in the same folder as the video file and gets the name of the file with the suffix ".vcache".

⚠️ In Cubase, you may work with multiple video files of differing frame rates and formats on the same video track. Assuming you have the proper codecs installed, all video files can be played back in one project, but note that proper synchronization of audio and video events is ensured only if the frame rate of the video file matches the project frame rate.

Adopting the video frame rate
When using video files within Cubase, it is important to adjust the project’s frame rate to that of the imported video. This ensures that the time displays of Cubase correspond to the actual frames in the video. If the frame rate of an imported video file differs from the frame rate set for the project, the video event shows a warning.

In order to match the two frame rates, you have to adjust the frame rate in the Project Setup dialog.

To adopt the video frame rate, proceed as follows:

1. Pull down the Project menu and select “Project Setup…”.
2. In the Project Setup dialog, click the “Get From Video” button.

Provided that the video file has a frame rate supported by Cubase, it is automatically detected and applied to the project. If the project contains several video files with different frame rates, the project frame rate is adjusted to the frame rate of the first video event on the upper video track.

The project frame rate setting will change to that of the video file and the project start time will be altered to reflect the change in frame rate if needed. For example, when the project frame rate is switched from 30fps to 29.97fps, the start time is changed so that all the events currently in the project remain at the same positions in relation to realtime. If you want the project start time to remain the same, you must manually change it back after clicking the “Get From Video” button. In this case, it is important that the video event is snapped to the timeline to ensure proper positioning and synchronization within the project.

⚠️ Cubase can only detect the supported frame rates (these are the frame rates listed in the Frame Rate pop-up menu in the Project Setup dialog). Video files with non-supported frame rates can be played back, but the time displays are not correct in this case and proper positioning is not guaranteed. Furthermore, audio and video may not be in sync. Therefore, we recommend that you use an external application to convert the video file to a frame rate supported by Cubase.

If you have more than one video file in a project, it is advisable that all video files have the same frame rate consistent with the project frame rate. Nevertheless, you can work with multiple video files of differing frame rates, but in this case you should always change the project frame rate to the frame rate of the video file that you are editing at the moment. This is done in the Project Setup dialog by selecting the correct frame rate from the Frame Rate pop-up menu.
Video files in the Project window

Video files are displayed as events/clips on a video track, with thumbnails representing the frames in the film.

In the track list and in the Inspector, the following buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute video</td>
<td>When this is activated, video playback is disabled, but playback of any other events in the project continues. This increases the performance of Cubase when realizing operations that do not require watching the video.</td>
</tr>
<tr>
<td>Show Frame Numbers</td>
<td>When this is activated, each thumbnail is shown with the corresponding video frame number.</td>
</tr>
<tr>
<td>Show Thumbnails</td>
<td>With this button you can activate/deactivate the thumbnails of a video track.</td>
</tr>
<tr>
<td>Lock</td>
<td>When this is activated, the video event will be locked, see the section “Locking events” on page 65.</td>
</tr>
</tbody>
</table>

Some of these buttons may not be visible in the track list. In the Track Controls Settings dialog you can determine which buttons are displayed in the track list, see the section “Customizing track controls” on page 535.

About thumbnails

The individual thumbnail images are positioned exactly at the beginning of the corresponding frame. When you zoom in and there is enough space between the frames, the thumbnail is repeated as many times as there is free space available. Thus, you can always see a thumbnail regardless of how much you zoom in.

Thumbnail Memory Cache Size

In the Preferences dialog on the Video page, you can enter a value for the “Thumbnail Memory Cache Size”. This determines how much memory is available for displaying “real” thumbnails. The currently shown image is buffered in the thumbnail memory cache. Whenever you move to another image and there is no memory capacity left, the “oldest” picture in the cache is replaced by the current one. If you have long video clips and/or work with a large zoom factor, you may have to raise the “Thumbnail Memory Cache Size” value.

About thumbnail cache files

When importing video, Cubase automatically creates a thumbnail cache file. The cache file is used in situations where the processor load is very high and the correct redrawing or realtime calculation of thumbnails might use system resources necessary for editing or processing. When you zoom in on the thumbnails, you see that they are in a lower resolution, i.e. the pictures are not as clear as when they are calculated. When the processes that rely heavily on the computer CPU are finished, the frames are automatically recalculated, i.e. the program automatically switches between realtime calculation of the pictures and using the cache file.

There are situations where no thumbnail cache file can be generated, e.g. if you import a video file from a folder that is write-protected. If you have access to the host folder at a later stage, you can generate a thumbnail cache file manually.

Manually generating thumbnail cache files

If no thumbnail cache file could be generated during import or if you have to “refresh” a thumbnail cache file of a certain video file, because the file has been edited with an external video editing application, you have the possibility to generate the thumbnail cache file manually.

To create a thumbnail cache file manually, you have the following possibilities:

- In the Pool, right-click on the video file that you want to create a thumbnail cache file for and select the “Generate Thumbnail Cache” option from the context menu. A thumbnail cache file is created, or, in case there already existed a thumbnail cache file for the video file, it is “refreshed”.
- In the Project window, open the context menu for the video event, and select “Generate Thumbnail Cache” from the Media submenu.
- Pull down the Media Menu and select “Generate Thumbnail Cache”.

“Refreshing” an already existing thumbnail cache file can be done only from within the Pool.
The thumbnail cache file is generated in the background so that you can continue working with Cubase.

**Playing back video**

⚠️ For playing back video files, you must have QuickTime 7.1 or higher installed on your computer. There is a freeware version and a “pro” version, which offers additional video conversion options. The player engine is the same in both versions, so for mere playback in Cubase there is no need to purchase the “pro” version.

⚠️ You need a video card that supports OpenGL (version 2.0 recommended) for proper video playback. A card with OpenGL 1.2 can also be used, but might put restrictions on the video functionality.

To check if your video equipment is capable of playing back a video from within Cubase, open the Video Player page in the Device Setup dialog. If your system does not meet the minimum video requirements, a corresponding message will be displayed.

Video is played back together with all other audio and MIDI material, using the Transport controls.

**Video settings in the Device Setup dialog**

In the Device Setup dialog you determine which device is used for playing back video files. You can switch between different output devices during playback.

To set up a video output device, proceed as follows:

1. Pull down the Devices Menu and select “Device Setup...” to open the Device Setup dialog, and select the Video Player page.

2. In the Active column, activate the checkbox for the device that you want to use for playing back video.

All devices in your system that are capable of playing back video are listed. The Onscreen Window device serves for playing back the video file on your computer monitor. For further information on output devices, see the section “Video output devices” on page 511.

3. From the pop-up menu in the Format column, select an output format.

For the Onscreen Window output, only a “fixed” format is available. For the other output devices, you can select different output formats for playback depending on the device.

4. Adjust the Offset setting to compensate for processing delays.

Due to delays while processing video, the video image may not match with the audio in Cubase. By using the Offset parameter, you can compensate for this effect. The Offset value indicates how many milliseconds the video will be delivered earlier in order to compensate for the processing time of the video material. Each hardware setup can have different processing delays, so you must try out different values to determine which value is appropriate.

⚠️ The Offset value can be set individually for each output device. It is saved globally for each output device and is independent of the project.

⚠️ The offset is only used during playback. It is defeated in stop and scrub mode so that you always see the correct video frame.

• If the quality of the video image is not a critical factor or if you are experiencing performance problems, try lowering the value on the Video Quality pop-up menu. Although higher quality settings make the video display sharper and smoother, they also lead to an increased processor load.

**Playing back video on the computer screen**

The Video Player window is used for playing back video on your computer screen.

• To open the Video Player window, pull down the Devices menu and select the “Video Player” option.
Setting the window size and video quality

To resize the Video Player window and/or change the playback quality of the video, select the appropriate option on the context menu of the Video Player window.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fullscreen</td>
<td>The window is enlarged to occupy the whole (computer) screen. If you are working with more than one monitor, you can move the Video Player window to an extra monitor. Thus, you can work with Cubase on one monitor and let the video play back on another monitor. You can exit fullscreen mode via the window’s context menu or by pressing [Esc] on your computer keyboard.</td>
</tr>
<tr>
<td>Quarter Size</td>
<td>The window size is reduced to a quarter of the actual size.</td>
</tr>
<tr>
<td>Half Size</td>
<td>The window size is reduced to half the actual size.</td>
</tr>
<tr>
<td>Actual Size</td>
<td>The window size corresponds to the size of the video.</td>
</tr>
<tr>
<td>Double Size</td>
<td>The window is enlarged to twice the actual size.</td>
</tr>
<tr>
<td>Video Quality</td>
<td>This submenu allows you to change the quality of the video image. Higher settings make the video display sharper and smoother, but lead to an increased processor load.</td>
</tr>
</tbody>
</table>

- To resize the Video Player window, you can also drag the borders.
- The higher the resolution, the more processing power is needed for playback. If you need to reduce the processor load, you can reduce the size of the Video Player window, or lower the value on the Video Quality submenu.

Setting the aspect ratio

Resizing the Video Player window by dragging its borders may lead to a distorted image. To prevent this, you can set an aspect ratio for video playback.

- From the Aspect Ratio submenu of the Video Player context menu, select one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>The aspect ratio of the video is not kept when resizing the window. The image is enlarged/reduced to occupy the whole Video Player window.</td>
</tr>
<tr>
<td>Internal</td>
<td>The Video Player window can be resized at will, but the aspect ratio of the video is kept and black borders are displayed around the video image to fill the window.</td>
</tr>
<tr>
<td>External</td>
<td>The resizing of the Video Player window is limited according to the aspect ratio of the video image, i.e. the video image always fills the full window and its aspect ratio is kept.</td>
</tr>
</tbody>
</table>

- When the video is played back in fullscreen mode, the aspect ratio of the video is always kept.

Scrubbing video

You can scrub video events, i.e. play them back forwards or backwards at any speed. This is done by clicking in the Video Player window and moving the mouse to the left or to the right.

You can also use the Scrub controls on the Transport panel or a jog wheel on a remote controller for scrubbing video events, see the sections “Playing back with the shuttle speed control” on page 85 and “Project scrubbing – the jog wheel” on page 86.
Editing video

Video clips are played back by events just as audio clips are. You can use all the basic editing operations on video events, just as with audio events. You can take a single event and copy it many times for the creation of mix variations. A video event may also be trimmed using the event handles to remove a countdown for instance. Furthermore, you can lock video events just like other events in the Project window, and you can edit video clips in the Pool (see the chapter “The Pool” on page 299).

It is not possible to fade or crossfade video events. Furthermore, you cannot use the Draw, Glue, and Mute tools with a video event.

Windows only: If you find that you are unable to edit a video file copied from a CD, this might be due to the fact that files copied from CD are write-protected by default. To remove the write-protection, in the Windows Explorer, open the Properties dialog and deactivate the “Read-Only” option.

Extracting audio from a video file

If a video file contains audio, the audio stream can be extracted. As always when importing audio material, a dialog is displayed allowing you to select different import options (see “Audio file import options” on page 522).

There are several ways to extract audio from a video file:

- By activating the “Extract Audio From Video” option in the Import Video dialog (see the section “Importing video files” on page 511).
- By using the “Audio from Video File” option on the Import submenu of the File menu. This will insert an audio event starting at the project cursor position on the selected audio track. If no audio track is selected, a new one will be created.
- By activating the “Extract Audio on Import Video File” option in the Preferences dialog (Video page). This will automatically extract the audio stream from any video file during import.
- By using the “Extract Audio from Video File” option on the Media menu. This creates an audio clip in the Pool, but does not add any events to the Project window.

⚠️ These functions are not available for MPEG-1 and MPEG-2 video files.

Replacing the audio in a video file

Once you have edited all audio and MIDI data to the video and created a final mix, you will need to put the new audio back with the video. You can do this by embedding the audio in another stream within the video container file.

To replace the audio stream in a video file, proceed as follows:

1. Place the left locator at the start of the video file in Cubase. This will ensure that your audio and video streams are synchronized.
2. Pull down the File menu and select the Audio Mixdown option from the Export submenu to export the audio file you wish to insert into the video container file (for detailed information on this function, see the chapter “Export Audio Mixdown” on page 484).
3. From the File menu, select “Replace Audio in Video File…”.
   A file dialog opens prompting you to locate the video file.
4. Select the video file and click Open.
5. Select the audio file and click Open.
   The audio is added to the video file, replacing its current audio stream.

Once the process is completed, open the video file in a native media player and check for proper synchronization.
Introduction

ReWire and ReWire2 are special protocols for streaming audio between two computer applications. Developed by Propellerhead Software and Steinberg, ReWire provides the following possibilities and features:

- Realtime streaming of up to 64 separate audio channels (256 with ReWire2), at full bandwidth, from the “synthesizer application” into the “mixer application”. In this case, the “mixer application” is of course Cubase. An example of a “synthesizer application” is Propellerhead Software’s Reason.
- Automatic, sample accurate synchronization between the audio in the two programs.
- The possibility to have the two programs share one audio card and take advantage of multiple outputs on that card.
- Linked transport controls that allow you to play, rewind, etc., either from Cubase or from the synthesizer application (provided it has some kind of transport functionality).
- Automatic audio mixing functions of separate channels as required.

In the case of Reason, for example, this allows you to have separate mixer channels for the different devices.

- Additionally, ReWire2 offers the possibility to route MIDI tracks in Cubase to the other application, for full MIDI control. For each ReWire2 compatible device, a number of extra MIDI outputs will be made available in Cubase. In the case of Reason, this allows you to route different MIDI tracks in Cubase to different devices in Reason, with Cubase serving as the main MIDI sequencer.
- The overall load on your system is much reduced, compared to when using the programs together in the conventional way.

Launching and quitting

When using ReWire, the order in which you launch and quit the two programs is very important:

Launching for normal use with ReWire

1. First launch Cubase.
2. Enable one or several ReWire channels in the ReWire Device dialog for the other application. This is described in detail in the section “Activating ReWire channels” on page 519.
3. Launch the other application. It may take slightly longer for the application to start when you are using ReWire.

Quitting a ReWire session

When you are finished, you also need to quit the applications in a special order:

1. First quit the synthesizer application.
2. Then quit Cubase.

Launching both programs without using ReWire

We cannot think of any scenario, in which you would need to run Cubase and the synthesizer application simultaneously on the same computer, without using ReWire, but you can:

1. First launch the synthesizer application.
2. Then launch Cubase.

Please note that the two programs now compete for system resources such as audio cards, just as when running either with other, non-ReWire audio applications.
Activating ReWire channels

ReWire supports streaming of up to 64 separate audio channels, while ReWire2 supports 256 channels. The exact number of available ReWire channels depends on the synthesizer application. Using the ReWire Device panels in Cubase, you can specify which of the available channels you want to use:

1. Pull down the Devices menu and select the menu item with the name of the ReWire application. All recognized ReWire compatible applications will be available on the menu.
   The ReWire panel appears. This consists of a number of rows, one for each available ReWire channel.

2. Click on the power buttons to the left to activate/de-activate the desired channels.
   The buttons light up to indicate activated channels. Please note that the more ReWire channels you activate, the more processing power is required.
   • For information about exactly what signal is carried on each channel, see the documentation of the synthesizer application.

3. If desired, double-click on the labels in the right column, and type in another name.
   These labels will be used in the Cubase Mixer to identify the ReWire channels.

Using the transport and tempo controls

⚠️ This is only relevant if the synthesizer application has some sort of built-in sequencer or similar.

Basic transport controls

When you run ReWire, the transports in the two programs are completely linked. It does not matter in which program you play, stop, fast forward or rewind. However, recording (if applicable) is still completely separate in the two applications.

Loop settings

If there is a loop or cycle facility in the synthesizer application, that loop will be completely linked to the cycle in Cubase. This means that you can move the start and end point for the loop or turn the loop on or off in either program, and this will be reflected in the other.

Tempo settings

As far as tempo goes, Cubase is always the master. This means that both programs will run in the tempo set in Cubase.

However, if you are not using the tempo track in Cubase, you can adjust the tempo in either program, and this will immediately be reflected in the other.

⚠️ If you are using the tempo track in Cubase (i.e. the Tempo button is activated on the Transport panel), you should not adjust the tempo in the synthesizer application, since a tempo request from ReWire will automatically deactivate the tempo track in Cubase!
How the ReWire channels are handled in Cubase

When you activate ReWire channels in the ReWire Device panels, they will become available as channel strips in the Mixer. The ReWire channel strips have the following properties:

- ReWire channels appear to the right of the other audio and MIDI channel strips in the Mixer.
- ReWire channels may be any combination of mono and stereo, depending on the synthesizer application.
- ReWire channels have the same functionality as regular audio channels. This means you can set volume and pan, add EQ, insert effects and sends, and route the channel outputs to groups or busses. However, ReWire channels have no monitor buttons.
- All ReWire channel settings can be automated using the Read/Write buttons.
- When you write automation, channel automation tracks will automatically appear in the Project window. This allows you to view and edit the automation graphically, just as with VST instrument channels, etc.
- You can mix down the audio from ReWire channels to a file on your hard disk with the Export Audio Mixdown function (see "Mixing down to audio files" on page 485). You can export the output bus to which you have routed the ReWire channels. Cubase only: You can also export individual ReWire channels directly – "rendering" each ReWire channel to a separate audio file.

Routing MIDI via ReWire2

⚠️ This feature is only available with ReWire2-compatible applications.

When using Cubase with a ReWire2-compatible application, additional MIDI outputs will automatically appear on the MIDI Output pop-up menus for MIDI tracks. This allows you to play the synthesizer application via MIDI from Cubase, using it as one or several separate MIDI sound sources.

Considerations and limitations

Sample rates

Synthesizer applications may be limited to audio playback in certain sample rates. If Cubase is set to a sample rate other than those, the synthesizer application will play back at the wrong pitch. Consult the documentation of the synthesizer application for details.

ASIO drivers

ReWire works well with ASIO drivers. By using the Cubase bus system you can route sounds from the synthesizer application to various outputs on an ASIO compatible audio card.
Importing audio

In Cubase audio can be imported in a variety of different formats. For example, you can import tracks from audio CDs, or import audio files saved in different formats (compressed and uncompressed).

For information on how to import audio files into the Pool and import options, see “About the Import Medium dialog” on page 306.

Audio file import options

When you are importing audio files, there are a number of options concerning how the files should be treated by Cubase:

• You can choose to copy the file into the audio folder of the project and have the project make reference to the copied file rather than the original file. This helps you keep your project “self-contained”.
• You can choose to split stereo and multi-channel files into a number of mono files.
• You can set all files in the project to the same sample rate and sample size (resolution).

Using the “On Import Audio Files” pop-up menu in the Preferences dialog (Editing–Audio page), you can define what Cubase does when importing audio files. The available options are described in the following.

Open Options Dialog

An Options dialog appears when you import, allowing you to select whether you want to copy the files to the audio folder and/or convert them to the project settings. Please note the following:

• When importing a single file of a format other than the project settings, you can specify which properties (sample rate and/or resolution) are changed.

• When importing multiple files at the same time, you can select to convert the imported files automatically if necessary, i.e. if the sample rate is different than the project’s or the resolution is lower than the project setting.

Use Settings

No Options dialog will appear when you import. Instead, you can select standard actions from the list below the pop-up menu that are performed automatically each time you import audio files:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Files to Working Directory</td>
<td>If files are not already in the project’s audio folder, they are copied there before being imported.</td>
</tr>
<tr>
<td>Convert and Copy to Project If Needed</td>
<td>If files are not already in the project’s audio folder, they are copied there before being imported. Furthermore, if the files have a different sample rate or a lower resolution than the project settings, they are automatically converted.</td>
</tr>
<tr>
<td>Split multi-channel files</td>
<td>If you import a multi-channel audio file (including two-channel stereo files), it will be split into a number of mono files – one for each channel – which are placed on separate, automatically created mono tracks. Use the “Use numbers for split file names” option to give the created files the same name as the source file, appended by a number. This avoids confusion if the source file does not contain stereo or surround material, but poly-mono audio.</td>
</tr>
</tbody>
</table>

Importing audio CD tracks

You can import audio from audio CDs into Cubase projects in two ways:

• To import the CD tracks directly into project tracks, choose the “Audio CD…” option from the Import submenu of the File menu.

The imported audio CD track(s) are inserted on the selected audio track(s) at the project cursor position.

• To import the CD tracks into the Pool, select “Import Audio CD…” from the Media menu.

This might be the preferred method if you want to import several CD tracks in one go.
Selecting one of the Import Audio CD menu items brings up the following dialog:

To import one or more tracks, proceed as follows:

1. If you have more than one CD drive, select the correct one from the Drives pop-up menu at the top left. On opening the CD, the program tries to retrieve the track names from CDDB (a CD database). If no connection to CDDB can be established or the CD track names are not found, you can manually change the generic track name in the Default Name field.

2. Windows only: Activate the “Secure Mode” option if you want to use a Secure Read mode. Use this if you encounter problems when trying to import an audio CD. Error checking and correction will be done during the process. Note that this mode will take more time.

3. In the Windows version, select the data transfer speed from the Speed pop-up menu. While you normally want to use the fastest possible speed, you may have to select a slower speed for flawless audio extraction.

4. Activate the Copy checkbox for every audio file you want to import. You can also select a copy section for every file, see below.

5. Click on the Copy button to create a local copy of the audio file(s) or section(s). The copied files are listed at the bottom of the dialog. By default, imported audio CD tracks will be stored as Wave files (Windows) or AIFF files (Mac) in the Audio folder of the current project. To change the folder, click Destination Folder and select a different folder from the dialog. During copying, the Copy button is labeled “Stop”; click it to stop the process.

6. Click OK to import the copied audio files into the project, or click Cancel to stop the import and discard the copied files.

   • If you import more than one audio file into project tracks, a dialog opens in which you have to choose whether to insert the tracks on one track or on different ones. The new track(s) are displayed in the Project window. New audio clips are created and added to the Pool.

The columns in the “Import from Audio CD” dialog have the following functionality:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Activate the checkbox in this column for the track you want to copy/import.</td>
</tr>
<tr>
<td></td>
<td>To activate more than one checkbox, click and drag over the checkboxes (or</td>
</tr>
<tr>
<td></td>
<td>press [Ctrl]/[Command] or [Shift] and click.</td>
</tr>
<tr>
<td>#</td>
<td>This is the track number.</td>
</tr>
<tr>
<td>CD Track as shown</td>
<td>When you import an audio CD track, the file is named according to this column. The names are pulled automatically from CDDB, if possible. You can rename a track by clicking in the CD Track column and typing a new name. You can also apply a generic name to all audio CD tracks, if no name was available in CDDB.</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the audio CD track in minutes and seconds.</td>
</tr>
<tr>
<td>Size</td>
<td>The file size of the audio CD track in MB.</td>
</tr>
<tr>
<td>Copy Start</td>
<td>You can copy a section of a track if you like. This indicates the start of the section to be copied in the track. By default, this is set to the start of the track (0.000) but you can adjust this on the copy selection ruler (see below).</td>
</tr>
<tr>
<td>Copy End</td>
<td>Indicates the end of the section to be copied in the track. By default, this is set to the end of the track but you can adjust this on the copy selection ruler (see below).</td>
</tr>
</tbody>
</table>

By default, complete tracks are selected.
• If you want to copy and import a section of an audio CD track only, select the track in the list and specify the start and end of the selection to be copied by dragging the handles in the copy selection ruler.

Note that you can import sections of several audio CD tracks by selecting them in turn and adjusting the selection. The start and end settings for each track are displayed in the list.

• You can audition the selected audio CD track by clicking the Play button. The track will be played back from selection start to selection end (or until you click the Stop button).

• The Play from left Marker (down arrow) and Play to Right Marker (up arrow) buttons allow you to audition the start and end of the selection only. The down arrow button will play a short snippet beginning at the start of the selection, while the up arrow button will play a snippet starting just before the end of the selection.

• To open the CD drive, click on the Eject button at the top of the dialog.

Importing Audio from video files

While you can automatically extract the audio when importing a video file (see “Extracting audio from a video file” on page 516), it is also possible to import the audio from a video file without importing the video itself:

1. Pull down the File menu, open the Import submenu and select “Audio from Video File…”.

2. In the file dialog that opens, locate and select the video file and click Open. The audio in the selected video file is extracted and converted to a Wave file in the project’s Audio folder.

• A new audio clip is created and added to the Pool. In the Project window, an event referencing the audio file is inserted on the selected track at the project cursor position. If no track was selected, a new track is created. This works just like importing regular audio files.

For information about importing video files, see “Importing video files” on page 511.

Importing ReCycle files

ReCycle by Propellerhead Software is a program designed especially for working with sampled loops. By “slicing” a loop and making separate samples of each beat, ReCycle makes it possible to match the tempo of a loop and edit the loop as if it was built of individual sounds. Cubase can import two file types created by ReCycle:

• REX files (export file format of the first versions of ReCycle, extension “.rex”).

• REX 2 files (file format of ReCycle 2.0 and later, extension “.rx2”).

For this to work, the REX Shared Library needs to be installed on your system. If this is not the case, you will find the corresponding installer on the installation DVD (in the “Additional Content\Installer Data” folder).

Proceed as follows:

1. Select an audio track and move the project cursor to where you want the imported file to start. You probably want to import REX files to tempo based audio tracks, since this will allow you to change the tempo later on (having the imported REX file automatically adjust).

2. Select “Audio File…” from the Import submenu of the File menu.

3. On the file type pop-up menu in the file dialog, select REX File or REX 2 File.

4. Locate and select the file you want to import, and click Open. The file is imported and automatically adjusted to the current Cubase tempo.

Unlike a regular audio file, the imported REX file will consist of several events, one for each “slice” in the loop. The events will automatically be placed in an audio part on the selected track and positioned so that the original internal timing of the loop is preserved.

5. If you now open the part in the Audio Part Editor, you can edit each slice separately by muting, moving and resizing events, adding effects and processing, etc. You can also adjust the tempo and have the REX file automatically follow (provided that its track is tempo based).
You can achieve similar results by using Cubase’s own loop slicing features, see “Working with hitpoints and slices” on page 276.

Importing compressed audio files

Cubase can import (and export, see “Mixing down to audio files” on page 485) several common audio compression formats. The procedure is the same as when importing any non-compressed audio file, with one important thing to note:

- When you import a compressed audio file, Cubase creates a copy of the file and converts this to Wave format (Windows) or AIFF format (Mac OS X) before importing it. The original compressed file will not be used in the project. The imported file is placed in the designated project Audio folder.

⚠️ The resulting Wave/AIFF file will be several times larger than the original compressed file.

The following file types are supported:

**MPEG audio files**

MPEG, which stands for Moving Picture Experts Group, is the name of a family of standards used for encoding audio-visual information (e.g. movies, video, music) in a digital compressed format.

Cubase can read two types of audio MPEG files: MPEG Layer 2 (*.mp2) and MPEG Layer 3 (*.mp3). Currently, mp3 is the most common of these formats, while the mp2 format is mostly used in broadcast applications.

**Ogg Vorbis files**

Ogg Vorbis is an open and patent-free format that offers very small audio files maintaining comparatively high audio quality. Ogg Vorbis files have the extension “.ogg”.

**Windows Media Audio files (Windows only)**

Windows Media Audio is an audio format developed by Microsoft, Inc. Due to advanced audio compression algorithms, Windows Media Audio files can be made very small, maintaining good audio quality. The files have the extension “.wma”.

⚠️ For exporting Audio, see the chapter “Export Audio Mixdown” on page 484.

Exporting and importing OMF files (Cubase only)

Open Media Framework Interchange (OMFI) is a platform independent file format intended for the transfer of digital media between different applications. Cubase can import and export OMF files (file extension “.omf”), allowing you to use Cubase in conjunction with other audio and video applications.

Exporting OMF files

When exporting tracks and files as OMF, you should consider setting up your project to use mono tracks and mono files, to allow compatibility with audio applications that provide limited support for interleaved audio files.

1. Pull down the File menu, open the Export submenu and select “OMF…”.
   The Export Options dialog opens.

   The Export Options dialog for OMF files

   2. Use the track list to the left to select the tracks that you want to include in the exported file.
   To select all tracks, click the “Select All” button. Normally, the whole project is included – to export the range between the locators only, activate “From Left to Right Locator”.

The resulting Wave/AIFF file will be several times larger than the original compressed file.
When referencing media files (see below), you can set the referenced output path by entering it in the “Media Destination Path” field or by clicking on “Browser…” and choosing it in the file dialog that opens. All file references will be set to this path. You can create references to media destinations that do not exist on the system you are currently working with, making it easy to prepare files for use in projects on another system or in a network environment.

3. If you want to create copies of all the media files, choose the “Copy Media” option. By default, the copied audio files are placed in a subdirectory in the export destination folder. To specify a different location for the copied files, use the “Media Destination Path” field.

4. If you want to copy only the portions of audio files that are used in the project, activate “Consolidate Events”. You can also define handle lengths in milliseconds to include audio outside each event boundary for later fine tuning. If you do not have any handles when consolidating audio files, you will not be able to adjust fades or edit points when the project is imported in another application.

5. Select “1.0 File” or “2.0 File”, depending on which OMF version is supported by the application in which you plan to import the file.

   Select whether you want to include all audio data in the OMF file (“Export All to One File”) or use references only (“Export Media File References”). If you choose “Export All to One File”, the OMF file will be totally “self-contained”, but possibly very large. If you choose “Export Media File References”, the file will be small, but the referenced audio files must be available for the receiving application.

6. If you selected the “2.0 File” option above, you can choose whether to include the volume settings and fades for the events (as set up with the event volume and fade handles) as well as the clip names – to include these in the OMF file, activate “Export Clip Based Volume”, “Use Fade Curves” and/or “Export Clip Names”.

7. Specify a sample size (resolution) for the exported files (or use the current project settings).

8. If you activate “Quantize Events to Frames”, the event positions in the exported file will be moved to exact frames.

9. Click OK, and specify a name and location in the file dialog that opens.

The exported OMF file will contain (or reference) all audio files that are played in the project (including fade and edit files). It will not include unused audio files referenced in the Pool, or any MIDI data. Video files are not included.

Importing OMF files

1. Pull down the File menu, open the Import submenu and select “OMF…”.

2. In the file dialog that opens, locate the OMF file and click Open.

   If there is already an open project, a dialog opens in which you can select whether a new project is created for the file. If you select “No”, the OMF file will be imported into the current project.

3. If you choose to create a new project, a file dialog opens in which you can select the project folder. Select an existing project folder or create a new one.

4. The Import Options dialog opens, allowing you to choose a track for the import.

   - Activating the “Import all media files” option allows you to import media that is not referenced by events.
   - Activating the “Import Clip Gain as Automation” option imports volume automation and envelopes of the Volume Automation Track of each track.
   - “Import at Timecode Position” will insert the elements contained in the OMF file at their original timecode positions. This is useful when you want to position every imported element at its exact timecode position, i.e. as it was saved in the OMF file. This way, the elements will end up at their correct time positions even when Cubase uses a different frame rate than the OMF file. This is usually required in a picture-related context.
   - “Import at Absolute Time” will insert the elements contained in the OMF file starting at the timecode position saved in the file and keeping the relative distances between the elements. This is required when the relative positioning of the elements inside the OMF file needs to be maintained after importing it into the Cubase timeline (even if Cubase is set to a different frame rate than the OMF file). This is usually required in music contexts, where the timing between objects has highest priority.
   - If the OMF file contains video event information, you are asked whether you want to create Markers at the start position of the video events. This allows you to manually import the video files, using the Markers as position references.

A new, untitled project is created (or tracks are added to the existing project), containing the audio events of the imported OMF file.
Exporting and importing standard MIDI files

Cubase can import and export standard MIDI files, which makes it possible to transfer MIDI material to and from virtually any MIDI application on any platform. When you import and export MIDI files, you can also specify whether certain settings associated with the tracks are included in the files (automation tracks, volume and pan settings, etc.).

Exporting MIDI files

To export your MIDI tracks as a standard MIDI file, pull down the File menu and select “MIDI File…” from the Export submenu. A regular file dialog opens, allowing you to specify a location and name for the file. When you have specified a location and a name for the file, click “Save”. The Export Options dialog opens, allowing you to specify a number of options for the file, e.g. what is included in the file, its type and its resolution (see below for a description of the options).

The Export Options dialog

You will also find most of these settings in the Preferences dialog (MIDI–MIDI File page). If you set these up in the Preferences dialog, you only need to click OK in the Export Options dialog to proceed.

The dialog contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Inspector</td>
<td>If this is activated, the MIDI patch settings in the Inspector – Bank Select and Program Select (used for selecting sounds in the connected MIDI instrument) are included as MIDI Bank Select and Program Change events in the MIDI file.</td>
</tr>
<tr>
<td>Export Inspector Volume/Pan</td>
<td>If this is activated, Volume and Pan settings made in the Inspector are included as MIDI Volume and Pan events in the MIDI file.</td>
</tr>
<tr>
<td>Export Automation</td>
<td>If this is activated, the automation data (as heard during playback) are converted to MIDI controller events and included in the MIDI file. Note that if a continuous controller (e.g. CC7) has been recorded but the Read button is deactivated for the automation track (i.e. the automation is effectively switched off for this parameter), only the part data for this controller will be exported.</td>
</tr>
<tr>
<td>Export as Type 0</td>
<td>If this is activated, any markers you have added (see “Using markers” on page 138) will be included in the MIDI file as standard MIDI file marker events.</td>
</tr>
<tr>
<td>Export Resolution</td>
<td>You can specify a MIDI resolution between 24 and 960 for the MIDI file. The resolution is the number of pulses, or ticks, per quarter note (PPQ) and determines the precision with which you will be able to view and edit the MIDI data. The higher the resolution, the higher the precision. Choose the resolution depending on the application or sequencer with which the MIDI file will be used, though, since certain applications and sequencers may not be able to handle certain resolutions.</td>
</tr>
</tbody>
</table>

In most cases it is recommended to activate this option.
The MIDI file will include the tempo information of the project (i.e. it will include the tempo and time signature events of the Tempo Track Editor or, if the tempo track is deactivated on the Transport panel, the current tempo and time signature).

Inspector settings other than those specified in the Export options are not included in the MIDI file! To include these, you need to convert the settings to "real" MIDI events and properties by using the Merge MIDI in Loop function for each track, see "Merge MIDI in Loop" on page 368.

Importing MIDI files
To import a MIDI file from disk, proceed as follows:
1. Select “MIDI File…” from the Import submenu of the File menu.
2. If there is already an open project, a dialog opens in which you can select whether a new project is created for the file.
   If you select “No”, the MIDI file will be imported into the current project.
3. Locate and select the MIDI file in the file dialog that opens and click Open.
   - If you choose to create a new project, select the project folder.
   - Select an existing project folder or create a new one.

The MIDI file is imported. The result depends on the contents of the MIDI file and the Import Options settings in the Preferences dialog (MIDI–MIDI File page). The Import Options are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Locator Range</td>
<td>If this is activated, only the range between the locators will be exported.</td>
</tr>
<tr>
<td>Export includes Delay</td>
<td>If this is activated, the delay of the MIDI track will be included in the MIDI file. For more information about the Delay option, see &quot;Basic track settings&quot; on page 349.</td>
</tr>
<tr>
<td>Song name for Type 0</td>
<td>You can use this text field to change the name of the MIDI file as displayed when loading this file in a keyboard.</td>
</tr>
<tr>
<td>Export Con-</td>
<td>If this is activated, MIDI controller events in the MIDI file will be converted to automation data for the MIDI tracks. If this is deactivated, controller data for the MIDI Parts will be imported.</td>
</tr>
<tr>
<td>troller as Automation Tracks</td>
<td>If this is activated, the imported MIDI file will be placed so that it starts at the position of the left locator – otherwise it will start at the beginning of the project. Note that if you choose to have a new project created automatically, the MIDI file will always start at the beginning of the project.</td>
</tr>
<tr>
<td>Import to Left Locator</td>
<td>If this is activated and you drag and drop a MIDI file into the project, the whole file will be placed on a single track.</td>
</tr>
<tr>
<td>Import Markers</td>
<td>If this is activated, standard MIDI file markers in the file will be imported and converted to Cubase markers.</td>
</tr>
<tr>
<td>Import dropped File as single Part</td>
<td>If this is activated and you import a MIDI file into the current project, tempo and signature track data in the MIDI file are ignored. The imported MIDI file will play according to the current tempo and signature tracks in the project. If this option is deactivated, the Tempo Track Editor will be adjusted according to the tempo information in the MIDI file.</td>
</tr>
<tr>
<td>Ignore Master Track Events on Merge</td>
<td>If this is activated and you import a MIDI file into the current project, each MIDI channel in the file, a separate track will be inserted in the Project window. If this is deactivated, only one MIDI track will be created. This track will be set to MIDI Channel “Any”, allowing all MIDI events to play back on their original channels. You can also use the &quot;Dissolve Part” function on the MIDI menu to distribute the events onto different tracks with different MIDI Channels at a later stage.</td>
</tr>
<tr>
<td>Auto Dissolve Format 0</td>
<td>If this is activated and you import a MIDI file of type 0 into the project, the file will automatically be “dissolved”: For each embedded MIDI channel in the file, a separate track will be inserted in the Project window. If this is deactivated, only one MIDI track will be created. This track will be set to MIDI Channel “Any”, allowing all MIDI events to play back on their original channels. You can also use the “Dissolve Part” function on the MIDI menu to distribute the events onto different tracks with different MIDI Channels at a later stage.</td>
</tr>
<tr>
<td>Destination</td>
<td>Here, you can specify what happens when you drag a MIDI file into the project:</td>
</tr>
<tr>
<td></td>
<td>- If you select the “MIDI Tracks” option, MIDI tracks are created for the imported file.</td>
</tr>
<tr>
<td></td>
<td>- If you select the “Instrument Tracks” option, instrument tracks are created for each MIDI channel in the MIDI file. Furthermore, the program automatically loads appropriate presets.</td>
</tr>
<tr>
<td></td>
<td>- If you select the “HALion Sonic SE multi-timbral” option, several MIDI tracks are created, each routed to a separate instance of HALion Sonic SE in the VST Instruments window and the appropriate presets are loaded.</td>
</tr>
</tbody>
</table>

- It is also possible to import a MIDI file from disk by dragging and dropping it from the Windows Explorer or the Mac OS Finder into the Project window. The Import Options apply as well.
Support for the Yamaha XF data format
Cubase supports the Yamaha XF format. XF is an extension of the standard MIDI file format that allows you to save song-specific data with a MIDI file of type 0.

When importing a MIDI file containing XF data, this data is placed in parts on separate tracks called “XF Data”, “Chord Data”, or “SysEx Data”. You can edit such a part in the List Editor (e.g. to add or change lyrics).

⚠️ Do not change the order of events within the XF data or the event data itself, unless you have a lot of experience with XF data.

Cubase can also export XF data as part of a MIDI file of type 0. If you do not want to export the XF data together with the MIDI data, mute or delete the tracks containing the XF data.

Exporting and importing MIDI loops
Cubase allows you to import MIDI loops (file extension “.midiloop“) and to save instrument parts as MIDI loops. MIDI loops are handy, as they contain not only MIDI notes and controllers, but also the associated VST instrument and instrument track preset settings.

How to import and export MIDI loops is described in detail in the chapter “VST instruments and instrument tracks“ on page 206.

Exporting and importing track archives (Cubase only)
You can export Cubase tracks (audio, FX, group, instrument, MIDI, and video) as track archives for import into other Cubase (or Nuendo) projects. All the information associated with the tracks will be exported (Mixer channel settings, automation tracks, parts and events, etc.). If you select the “Copy“ option (see below), a separate “media“ folder will be created, containing copies of all referenced audio files.

⚠️ Project-specific settings (such as tempo) are not part of the exported track archives.

⚠️ For creating track presets from tracks, see “Working with track presets“ on page 331.

Exporting tracks as track archives
1. Select the tracks you wish to export.
2. Pull down the File menu, open the Export submenu and choose “Selected Tracks…“.
3. You are prompted to choose between two options:
   - Click Copy to include copies of the media files in the export.
   - A file dialog opens in which you can choose an existing empty folder or create a new folder for saving the track archive (as XML file) and its media subfolder, which will contain any associated audio or video files.
   - Click Reference to include merely a reference to the files in the export.
   - A file dialog opens in which you can choose an existing folder for saving the track archive (as single XML file).
4. Click OK to save the track archive.

Importing tracks from a track archive
The Import Track Archive function lets you import tracks exported from another Cubase (or Nuendo) project.

⚠️ Note that the sample rates of the active project and the track archive have to match. If necessary, you have to convert the sample rate, see below.
1. Pull down the File menu, open the Import submenu and select “Track Archive…“.
2. In the file dialog that opens, select the XML file and click Open.

The Import Options dialog opens.

In the Project Settings area, you can see a comparison between the settings of the track archive and the active project.
3. Click in the Import column on the left to select the desired track(s) or click “Select all Tracks”. A checkmark is shown for all selected tracks.

4. Choose which media files to use.
   - Select “Use Media Files From Archive” if you want to import the track without copying the media files into your project folder.
   - Select “Copy Media To Project Folder” if you want to import the media files into your project folder.
     For the “Perform Sample Rate Conversion” option, see below.

5. Click OK.
The tracks are imported, complete with all contents and settings.

**Sample rate conversion on track archive import**

A track archive may contain media files with a sample rate that is different from the sample rate of your currently active project. You can see the sample rate difference in the Project Settings area.

- To convert the sample rate of a track archive to the sample rate used in the active project on import, select the “Copy Media To Project Folder” option and then “Perform Sample Rate Conversion”.

 distrust Unconverted files with another sample rate than the one used in the project will play back at the wrong speed and pitch.
Customizing
Background

The user can customize the appearance and functionality of Cubase in various ways.

User configurable items described in this chapter are:

- **Workspaces**
  By storing different window combinations as workspaces, you can quickly switch between different working modes – see “Workspaces” on page 532.

- **Setup dialogs**
  Several parts of the user interface (toolbars, Transport panel, Inspector, info lines and Channel Settings windows) provide a Setup dialog, where you can configure which items of the respective window area or panel are to be shown or hidden and where they are located – see “Using the Setup options” on page 534.

- **Track list**
  The controls shown in the track list can be set for each track type – see “Customizing track controls” on page 535.

- **Appearance**
  The general look of the program can be adjusted – see “Appearance” on page 536.

- **Track and event colors**
  You can adjust which colors are used – see “Applying colors in the Project window” on page 537.

This chapter also contains a section describing where your preferences and settings are stored (see “Where are the settings stored?” on page 539), to help you transfer your customized settings to another computer.

Workspaces

A configuration of Cubase windows is called a “workspace”. A workspace stores the size, position and content of all windows, allowing you to quickly switch between different working modes via the menu or by using key commands. For example, you may want as large a Project window as possible when you are editing, whereas you may want the Mixer and effect windows open during mix-down. Workspaces are listed and managed on the Workspaces submenu of the Window menu.

**Editing the active workspace**

There is always one workspace active, even if you have not saved any. To make changes to the active workspace, you simply set up the windows as desired – including opening, closing, moving and sizing windows, and adjusting zoom and track height. The changes are automatically stored for the active workspace.

- To keep a workspace from being accidentally changed, select “Lock Active Workspace” from the Workspaces submenu.

A locked workspace will keep its original window settings. You may change the current window layout on the screen, but the next time you select the workspace again, the originally stored layout is recalled.
Creating a new workspace
1. Pull down the Window menu and open the Workspaces submenu.
2. Select “New Workspace”.
3. In the dialog that opens, enter a name for the workspace.
4. Click OK.
The workspace is stored and will appear on the submenu. It is now the active workspace.
5. Set up the windows you want to include in the new workspace.
   This may include opening, moving and sizing windows, and adjusting zoom and track height.
   ⇒ The number of workspaces you can add is not limited.

Activating a workspace
1. Pull down the Window menu and open the Workspaces submenu.
2. Select a workspace from the list on the submenu.
The windows are closed, opened, moved and/or resized according to the stored workspace.
• You can also activate workspaces by using the corresponding key commands (see “Key commands” on page 541).

Organizing workspaces and presets
If you select “Organize…” from the Workspaces submenu, the Organize Workspaces dialog opens.

The list to the left shows the workspaces in the active project, while the list to the right shows the workspace presets. While workspaces are stored with each project, workspace presets can be stored globally, allowing you to set up a number of workspaces for use in any project. Workspace presets store the position and size of the main windows only – project-specific windows are not included.
• In the Workspaces list to the left, you can rename workspaces (by double-clicking and typing) and lock or unlock them.
• The arrow buttons between the two lists allow you to copy the selected workspace to a workspace preset, or vice versa.
• The buttons below each list let you add, remove, or activate workspaces or presets.
   You can also activate a workspace or a preset by double-clicking in its number column.
• Normally, when you use key commands to activate workspaces, they relate to the order in the workspace list, e.g. the key command for “Workspace 1” selects the first workspace on the list and so on. However, if you activate the Use IDs checkbox, you can enter a number in the ID column for each workspace.
   This number will be used as reference when you are using key commands, so that the key command for “Workspace 1” recalls the workspace with ID 1.
• Workspace presets are not only saved globally, but also included in the project. If you open a project on a different system, by default the global presets stored on this system are shown in the list to the right. To see the presets included in your project, activate the “Show Project Presets” option.
• Activate the “Auto Instantiate Presets” option to convert all global workspace presets automatically into workspaces when you create a new project or open a project.
• To close the dialog, click the OK button.
   Note that you can continue working in other windows with the Organize Workspaces dialog open.
Using the Setup options

You can customize the appearance of the following elements:

- Transport panel
- Info line
- Channel Settings window
- Toolbars
- Inspector

The setup context menus

If you right-click the Transport panel, the toolbars, the info lines, or the Inspector, the respective setup context menu opens. For Channel Settings windows, these options are found in the dialog’s context menu, on the Customize View submenu. Here, you can activate/deactivate elements as desired.

The following general options are available on the setup context menus:

- “Show All” makes all items visible.
- “Default” resets the interface to the default setting.
- “Setup…” opens the Setup dialog (see below).

If presets are available, they can be selected on the lower half of the menu.

The Setup dialogs

If you select “Setup…” from the setup context menus, the Setup dialog opens. This allows you to specify which elements are visible/hidden and to set the order of the elements. You can also save and recall setup presets in this dialog.

The dialog is divided into two sections. The left section displays the currently visible items and the right section displays the currently hidden items.

- You can change the current show/hide status by selecting items in one section and then use the arrow buttons in the middle of the dialog to move them to the other section. Changes are applied directly.
- By selecting items in the “Visible Items” list and using the Move Up and Move Down buttons, you can reorder the items list. Changes are applied directly. To undo all changes and revert to the standard layout, select “Default” on the setup context menu.
- If you click the Save button (disk icon) in the Presets section, a dialog opens, allowing you to name the current configuration and save it as a preset.
- To remove a preset, select it on the presets pop-up menu and click the trash icon.
- Saved configurations are available for selection from the Presets pop-up menu in the Setup dialog or directly from the setup context menu.
Customizing track controls

For each track type you can configure which track controls are shown in the track list. You can also specify the order of controls and group controls so that they are always shown adjacent to each other. This is done using the Track Controls Settings dialog.

Opening the Track Controls Settings dialog

There are two ways to open the dialog:

- Right-click a track in the track list and select “Track Controls Settings…” from the context menu.
- Click the arrow in the bottom right corner of the track list and select “Track Controls Settings…”.

Setting the track type

The settings made in the Track Controls Settings dialog apply to the selected track type, which is shown in the menu display in the top left corner of the dialog.

To change the track type, click the arrow to the right in the menu display and select a track type from the pop-up menu. All settings made in the dialog will apply to all tracks (current and subsequent) of the selected type.

Removing, adding, and moving track controls

The dialog is divided into two sections. The left section displays controls currently visible in the track list, and the right section displays the controls currently hidden.

- You can hide controls from the track list by selecting them in the list to the left and clicking the Remove button. To show hidden elements, select them in the list to the right and click the Add button. Click OK to apply the changes.

  All controls can be removed except the Mute and Solo buttons.

- By selecting controls in the “Visible Controls” list and using the Move Up and Move Down buttons, you can change the order of the list. Click OK to apply the changes.

Grouping track controls

If you resize the track list, the position of the controls will change dynamically to accommodate as many controls as possible in the available space (given that Wrap Controls is activated – see below). By grouping several track controls you ensure that they are always positioned side by side in the track list.

Always make sure that you have selected the desired track type when editing the track controls!
To group controls, proceed as follows:

1. Make sure that you have selected the correct track type.

2. In the “Visible Controls” section, select at least two controls.
   You can only group controls that are adjacent to each other in the list. To group controls that are currently not adjacent in the list, use the Move Up/Down buttons first.

3. Click Group.
   A number is displayed in the Group column for the grouped controls. The first group created has the number 1, the second 2, and so on.

4. Click OK.
   The controls are now grouped.
   • You can ungroup controls by using the Ungroup button. Please note that this will remove the selected element and the elements below it in the list from this group. To remove an entire group, select the first (topmost) element belonging to this group and click the Ungroup button.

About Wrap Controls

This is activated by default. Wrap Controls allows the controls to be dynamically repositioned when resizing the track list. That is, as many controls as possible will be displayed depending on the current size of the track list.

If you deactivate Wrap Controls, the positions of the controls are fixed, regardless of the size of the track list. In this mode, you may have to resize the tracks vertically (by dragging the dividers between them) to display all the controls.

About the Length column

The Length column in the Visible Controls list allows you to set the maximum length for certain text fields, e.g. Name. To change the setting, click on the number in the Length column and type in a new value.

Resetting track list settings

You have two possibilities to reset the settings:
• Click Reset to restore all default track controls settings for the selected track type.
• Click Reset All to restore all default track controls settings for all track types.

Saving presets

You can save track controls settings as presets for later recall:

1. Click on the Save button (the “+” sign) to the right of the Presets pop-up menu. A dialog opens, asking you to type in a name for the preset.
2. Click OK to save the settings as a preset. Saved presets are available for selection from the Presets pop-up menu and from the pop-up menu in the top left corner of the track list.
   • To remove a preset, select it in the Track Controls Settings dialog and click the Delete button (the “-” sign).

Cubase comes with a number of Track Controls Settings presets available.

Appearance

In the Preferences dialog, you find a page called Appearance. The following settings are available:

General

The controls on the General page affect the appearance of the windows that surround the controls and workspaces in Cubase.
• Color Intensity determines how rich the background colors are, from gray to blue.
• Color Lightness lightens or darkens the background.
• The Color Tone slider changes the background color.
• Button Brightness can be used to separately lighten or darken the buttons.


Meters

The coloring of meters in Cubase can be controlled in sophisticated ways. Multiple colors can help to visually indicate what levels are being reached, e.g. in a channel of the VST Mixer. To do this, the meter on the Appearances–Meters page has color handles that allow you to define what color the meter will have at a given signal level.

The Appearances–Meters page in the Preferences dialog

- You can click on any color handle and move its position on the meter scale. If you hold down [Shift] while moving the handle with the mouse, it will move ten times slower for more precise positioning. You may also nudge the color handle’s position with the Arrow Up/Down keys. Holding [Shift] while nudging will move the color handle ten times faster.
- You can add color handles by [Alt]/[Option]-clicking anywhere along the side of the meter scale. To remove a color handle, [Ctrl]/[Command]-click the handle. By adding more color handles to the meter scale, you can define colors for more specific signal levels. Try adding two color handles very close to one another. You can make the meter color change more rapidly at a specific signal level this way.
- To change the color of a handle, select the handle by either clicking on it or by jumping to it with the [Tab] key (hold down [Shift] and press the [Tab] key to jump backwards). Then use the hue and brightness controls on the right side to alter the handle’s color. The currently selected color handle is indicated by a black triangle on its left side.

Work Area

The work areas in Cubase are those places where the actual data are displayed such as the Project window event display. In these areas, there are items such as vertical and horizontal grid lines that can be altered in intensity by the controls found on this page.

Applying colors in the Project window

You can use color scheming for an easier overview of tracks and events in the Project window. Colors can be applied individually to tracks and events/parts. If you color a track, the corresponding events and parts are displayed in the same color. However, you can also color events and parts differently, “overriding” the applied track color.

In the following sections you will learn how to set up preferences to color tracks automatically, how to color parts or events manually, how to determine whether you want to color the events themselves or their background, and how to customize the color palette for selecting colors.

Applying track colors automatically

In the Preferences dialog (Editing–Project & Mixer page), you can find the “Auto Track Color Mode” option.
This offers you several options for automatically assigning colors to tracks that are added to the project. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Default Event Color</td>
<td>The default color (gray) is assigned.</td>
</tr>
<tr>
<td>Use Previous Track Color</td>
<td>Analyzes the color of the selected track and uses the same color for the new track.</td>
</tr>
<tr>
<td>Use Previous Track Color +1</td>
<td>Analyzes the color of the selected track and uses the color that comes next in the color palette for the new track.</td>
</tr>
<tr>
<td>Use Last Applied Color</td>
<td>Uses the color that is selected in the Select Colors pop-up menu.</td>
</tr>
<tr>
<td>Use Random Track Color</td>
<td>Uses the color palette as a basis to assign track colors randomly.</td>
</tr>
</tbody>
</table>

### Coloring tracks, parts, or events manually

You can color each track, part, or event in the Project window individually by using the Select Colors pop-up menu on the toolbar. Parts and events can also be colored using the Color tool.

#### About the Select Colors pop-up menu

1. In the Project window, select the item that you want to color.
   You can select tracks, parts, or events.

2. On the toolbar, open the “Select Colors” pop-up menu and select a color.
   If parts or events are selected, the color is applied to these parts and events. To change the color of a track, no events or parts must be selected on that track.

   ![Select Colors Pop-up Menu](image)

- To reset the color of a track, part, or event, select the corresponding item and choose the “Default Color” option from the “Select Colors” pop-up menu.

**About the Color tool**

1. Open the Select Colors pop-up menu and select a color.

2. On the toolbar, select the Color tool.

3. Click on the desired parts and events to assign the color.

   The color is applied to the parts and events and overrides the track color.

- If you press [Ctrl]/[Command] and click on a part/event with the Color tool, a color palette is displayed allowing you to select a color for the event.
- If you press [Alt]/[Option], the Color tool cursor becomes a pipette, which can be used to select the current color of a part/event in order to apply it to another part/event.

#### About the Similar Tracks options

You can use the selected color of one track to colorize other tracks of the same type (e.g. all audio tracks).

Set up the desired color for a track of a certain track type and right-click this track in the track list to open a context menu. Depending on your settings and selections you can choose one of the following options:

- **Use Color for Similar Tracks**
  When you select this, all tracks of the same type get the same color.

- **Use Color for Similar Selected Tracks**
  Use this to apply the same color to tracks within a selection. The color of the topmost track in the selection is then applied to other tracks of the same type within the selection.

« When you change the color of a track, the new color will be used for all events on the track and for the corresponding channel strip in the Mixer. However, if you have assigned a different color to individual parts or events, these will not follow color changes of the track any longer.
The Project Colors dialog

In the Project Colors dialog you can select a different set of colors for items in the Project window.

To open the Project Colors dialog, open the Select Colors pop-up menu on the toolbar and choose "Select Colors…".

Adding and editing individual colors

In the Project Colors dialog, you can fully customize the color palette. To add new colors to the color palette, proceed as follows:

1. Add a new color by clicking the Insert New Color button.

2. In the Project Colors section, click the newly created color field to activate the new color for editing.

3. Use the Standard Colors or Modify Color sections to specify a new color.
   To do this, pick a different color from the color palette, drag the cursor in the color circle, move the handle in the color meter, or enter new RGB values as well as values for hue, saturation, and luminosity manually.

4. Click the Apply button.
   The color setting is applied to the selected color field in the Project Colors section.
   Every color in the Project Colors section can be edited this way.

Setting intensity and brightness

To increase or decrease the intensity and the brightness of all colors, use the corresponding buttons in the Project Colors section.

Saving and resetting color settings

- To return to your project colors, click the “Reset To Current Project Defaults” button.
- To save the current set as default, click the “Save Current Set as Program Defaults” button.
- To apply the default set, click the “Load Program Defaults to Current Set” button.
- To return to Cubase’s standard color palette, click the “Reset Current Set to Factory Settings” button.

Where are the settings stored?

As you have seen, there are a large number of ways in which you can customize Cubase. While some of the settings you make are stored with each project, others are stored in separate preference files.

If you need to transfer your projects to another computer (e.g. in another studio), you can bring all your settings along by copying the desired preference files and installing them on the other computer.

- It is a good idea to make a backup copy of your preference files once you have set things up the way you want! This way, if another Cubase user wants to use his or her personal settings when working on your computer, you can restore your own preferences afterwards.
• Under Windows, preference files are stored in the following location: “\Users\<user name>\AppData\Roaming\Steinberg\<program name>\”. On the Start menu, you will find a shortcut to this folder for easy access.

• Under Mac OS X, preference files are stored in the following location: “/Library/Preferences/<program name>/” under your home directory.
The full path is: “/Users/<user name>/Library/Preferences/<program name>/”.

▷ The RAMpresets.xml file, which contains various presets settings (see below), is saved when exiting the program.

▷ Program functions (e.g. crossfade) or configurations (e.g. panels) not used in the project will not be stored.

Some of the preferences are not stored in the default preferences folder. A list can be found in the article “Files for the program settings and preferences” in the Steinberg Knowledge Base.

To open the Knowledge Base, browse to the Steinberg web site, click “Support” and choose “Knowledge Base” in the list on the left.
Introduction

Most of the main menus in Cubase have key command shortcuts for certain items on the menus. In addition, there are numerous other Cubase functions that can be performed via key commands. These are all default settings. You can customize existing key commands to your liking, and also add commands for many menu items and functions that currently have no key command assigned.

You can find out for which functions key commands can be assigned by looking in the Key commands dialog (see below), or by checking the tooltip for a particular interface element. If a tooltip shows [!] at the end, you can assign a key command to this function. Assigned key commands are shown in the tooltips in square brackets.

How are key commands settings saved?

Every time you edit or add any key command assignment, this is stored as a global Cubase preference – not as part of a project. If you edit or add a key command assignment, any subsequent projects that you create or open will use these modified settings. However, the default settings can be restored at any time by clicking the Reset All button in the Key Commands dialog.

In addition, you can save key commands settings as a “key commands file”, which is stored separately and can be imported into any project. This way you can quickly and easily recall customized settings, when moving projects between different computers, for example. The settings are saved in an XML file on the hard disk.

How to save key commands settings is described in the section “About key commands presets” on page 544.

Setting up key commands

Adding or modifying a key command

In the Key Commands dialog you will find all main menu items and a large number of other functions, arranged in a hierarchical way similar to the Windows Explorer and Mac OS Finder. The function categories are represented by a number of folders, each containing various menu items and functions. When you open a category folder by clicking the “+” sign beside it, the items and functions it contains are displayed with the currently assigned key commands.

To add a key command, proceed as follows:

1. Pull down the File menu and select “Key Commands…”.
   The Key Commands dialog opens.
2. In the Commands list on the left, choose a category.
3. Click the “+” sign to open the category folder and display the items it contains.

To assign a key command, click the “Assign to…” button and choose a key. Multiple key commands can be assigned to the same function, or you can assign tool modifier keys, for example.

You can also assign tool modifier keys, i.e. keys that change the behavior of various tools when pressed. This is done in the Preferences dialog – see “Setting up tool modifier keys” on page 545.

⚠️ You can also assign tool modifier keys, i.e. keys that change the behavior of various tools when pressed. This is done in the Preferences dialog – see “Setting up tool modifier keys” on page 545.
4. In the list, select the item to which you want to assign a key command. Already assigned key commands are shown in the Keys column as well as in the Keys section in the top right corner.

5. Alternatively, you can use the search function in the dialog to find the desired item. For a description of how to use the search function, see below.

6. When you have found and selected the desired item, click in the “Type in Key” field and enter a new key command. You can choose any single key or a combination of one or several modifier keys ([Alt]/[Option], [Ctrl]/[Command], [Shift]) plus any key. Just press the keys you want to use.

7. If the key command you enter is already assigned to another item or function, this is displayed below the “Type in Key” field. You can either ignore this and proceed to assign the key command to the new function instead, or you can select another key command.

8. Click the Assign button above the field. The new key command appears in the Keys List.

9. Click OK to exit the dialog. You can set up several different key commands for the same function. Adding a key command to a function that already has another key command will not replace the key command previously defined for the function. If you wish to remove a key command, see below.

Searching for key commands
If you want to know which key command is assigned to a certain function in the program, you can use the Search function in the Key Commands dialog:

1. Click in the search text field at the top left of the dialog and type in the function for which you want to know the key command. This is a standard word search function, so you should type the command as it is spelled in the program. Partial words can be used; to search for all quantize related commands, type “Quantize”, “Quant”, etc.

2. Click the Search button (the magnifying glass icon). The search is conducted and the first matching command is selected and displayed in the Commands list below. The Keys column and the Keys list show the assigned key commands, if any.

3. To search for more commands containing the word(s) you entered, click the Search button again.

4. When you are done, click OK to close the dialog.

Removing a key command
To remove a key command, proceed as follows:

1. Use the list of categories and commands to select the item or function for which you wish to remove a key command. The key command is shown in the Keys column and the Keys list.

2. Select the key command in the Keys list and click the Delete button (the trash icon). You are asked whether you really want to remove the key command.

3. Click Remove to remove the selected key command.

4. Click OK to close the dialog.

Setting up macros
A macro is a combination of several functions or commands to be performed in one go. For example, you can select all events on the selected audio track, remove DC offset, normalize the events and duplicate them, all with a single command.
Macros are set up in the Key Commands dialog as follows:

1. Click the Show Macros button.
   The macro settings are shown in the lower part of the dialog. To hide
   these from view, click the button (now renamed Hide Macros) again.

2. Click New Macro.
   A new, unnamed macro appears in the Macros list. Name it by typing the
desired name. You can rename a macro at any time by selecting it in the
list and typing in a new name.

3. Make sure that the macro is selected, and use the cat-
gories and commands in the upper half of the dialog to
select the first command you want to include in the macro.

4. Click Add Command.
   The selected command appears in the list of commands in the Macros
section.

5. Repeat the procedure to add more commands to the
   macro.
   Note that commands are added after the currently selected command in
the list. This allows you to insert commands “in the middle” of an existing
macro.

A macro with three commands

- To remove a command from the macro, select it in the
  Macros list and click Delete.
- Similarly, to remove an entire macro, select it in the
  Macros list and click Delete.

After you have closed the Key Commands dialog, all mac-
ros you have created appear at the bottom of the Edit menu
in the Macros submenu, available for instant selection.

You can also assign key commands to macros. All macros
you have created appear in the upper section of the Key
Commands dialog under the Macros category – just se-
lect a macro and assign a key command as with any other
function.

About key commands presets
As mentioned above, any changes made to the key com-
mands (and macros) are automatically stored as a Cubase
preference. However, it is also possible to store key com-
mands settings separately. This way, you can store any
number of different key command settings as presets for
instant recall.

Saving key commands presets
Proceed as follows:

1. Set up the key commands and macros to your liking.
   When setting up key commands, remember to click “Assign” to make the
changes.

2. Click the Save button next to the Presets pop-up
   menu.
   A dialog opens, allowing you to type in a name for the preset.

3. Click OK to save the preset.
   Your saved key commands settings are now available on the Presets
pop-up menu.

Loading key command presets
To load a key command preset, simply select it from the
Presets pop-up menu.

- The key command settings you load will replace the
  current key command settings for the same functions (if
any). If you have macros of the same name as those stored
in the preset you load, these will be replaced too.

If you want to be able to revert to your current settings
again, make sure to save them first, as described above!
Loading earlier key commands settings

If you have saved key commands settings with an earlier program version, it is possible to use them in this Cubase version, by using the “Import Key Command File” function, which lets you load and apply saved key commands or macros:

1. Open the Key Commands dialog.
2. Click the “Import Key Command File” button to the right of the Presets pop-up menu.
   A standard file dialog opens.

3. In the file dialog, use the “Files of type” pop-up menu to specify if you want to import a key commands file (".key") or a macro commands file (extension ".mac"). When you have imported an older file, you might want to save it as a preset (see above) to be able to access it from the Presets pop-up menu in the future.
4. Navigate to the file you want to import and click “Open”.
   The file is imported.
5. Click OK to exit the Key Commands dialog and apply the imported settings.

   The settings in the loaded key commands file or macros file now replace the current settings.

About the “Reset” and “Reset All” functions

These two buttons in the Key Commands dialog will both restore the default settings. The following rules apply:

- “Reset” will restore the default key command setting for the function selected in the Commands list.
- “Reset All” will restore the default key commands for all commands.

⚠️ Note that the “Reset All” operation will cause any changes made to the default key commands to be lost! If you want to be able to revert to these settings again, make sure to save them first!

Setting up tool modifier keys

A tool modifier key is a key you can press to get an alternate function when using a tool. For example, clicking and dragging an event with the Arrow tool normally moves it – holding down a modifier key (by default [Alt]/[Option]) while dragging will copy it instead.

The default assignments for tool modifier keys can be found in the Preferences dialog (Editing–Tool Modifiers page). Here, you can also edit them:

1. Open the Preferences dialog and select the Editing–Tool Modifiers page.
2. Select an option in the Categories list, and locate the action for which you want to edit the modifier key.
   For example, the “Copy” action mentioned above resides in the category “Drag & Drop”.
3. Select the action in the Action list.
4. Hold down the desired modifier key(s) and click the Assign button. The current modifier keys for the action are replaced. If the modifier keys you pressed are already assigned to another tool, you will be asked whether you want to overwrite them. If you do, this will leave the other tool without any modifier keys assigned.

5. When you are done, click OK to apply the changes and close the dialog.

### The default key commands

Below, the default key commands are listed according to category.

⚠️ When the Virtual Keyboard is displayed, the usual key commands are blocked because they are reserved for the Virtual Keyboard. The only exceptions are: 
- `[Ctrl]/[Command]-[S]` (Save), `Num [*]` (Start/Stop Record), `Space` (Start/Stop Playback), `Num [1]` (Jump to left locator), `Delete` or `[Backspace]` (Delete), `Num [/]` (Cycle on/off), `F2` (Show/Hide Transport panel), and `[Alt]/[Option]-[K]` (Show/Hide Virtual Keyboard).

#### Audio category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Fades to Range</td>
<td>[A]</td>
</tr>
<tr>
<td>Auto-Grid</td>
<td>[Shift]-[Q]</td>
</tr>
<tr>
<td>Crossfade</td>
<td>[X]</td>
</tr>
<tr>
<td>Find Selected in Pool</td>
<td>[Ctrl]/[Command]-[F]</td>
</tr>
</tbody>
</table>

#### Automation category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Panel</td>
<td>[F6]</td>
</tr>
<tr>
<td>Toggle Read Enable All Tracks</td>
<td>[Alt]/[Option]-[R]</td>
</tr>
<tr>
<td>Toggle Write Enable All Tracks</td>
<td>[Alt]/[Option]-[W]</td>
</tr>
</tbody>
</table>

#### Devices category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mixer</td>
<td>[F3]</td>
</tr>
<tr>
<td>Video</td>
<td>[F8]</td>
</tr>
<tr>
<td>Virtual Keyboard</td>
<td>[Alt]/[Option]-[K]</td>
</tr>
<tr>
<td>VST Connections</td>
<td>[F4]</td>
</tr>
<tr>
<td>VST Instruments</td>
<td>[F11]</td>
</tr>
<tr>
<td>VST Performance</td>
<td>[F12]</td>
</tr>
</tbody>
</table>

#### Edit category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autoscroll</td>
<td>[F]</td>
</tr>
<tr>
<td>Copy</td>
<td>[Ctrl]/[Command]-[C]</td>
</tr>
<tr>
<td>Cut</td>
<td>[Ctrl]/[Command]-[X]</td>
</tr>
<tr>
<td>Cut Time</td>
<td>[Ctrl]/[Command]-[Shift]-[X]</td>
</tr>
<tr>
<td>Delete</td>
<td>[Delete] or [Backspace]</td>
</tr>
<tr>
<td>Delete Time</td>
<td>[Shift]-[Backspace]</td>
</tr>
<tr>
<td>Duplicate</td>
<td>[Ctrl]/[Command]-[D]</td>
</tr>
<tr>
<td>Edit In-Place</td>
<td>[Ctrl]/[Command]-[Shift]-[I]</td>
</tr>
<tr>
<td>Group</td>
<td>[Ctrl]/[Command]-[G]</td>
</tr>
<tr>
<td>Insert Silence</td>
<td>[Ctrl]/[Command]-[Shift]-[E]</td>
</tr>
<tr>
<td>Left Selection Side to Cursor</td>
<td>[E]</td>
</tr>
<tr>
<td>Lock</td>
<td>[Ctrl]/[Command]-[Shift]-[L]</td>
</tr>
<tr>
<td>Move to Cursor</td>
<td>[Ctrl]/[Command]-[L]</td>
</tr>
<tr>
<td>Move to Front (Uncover)</td>
<td>[U]</td>
</tr>
<tr>
<td>Mute</td>
<td>[M]</td>
</tr>
<tr>
<td>Mute Events</td>
<td>[Shift]-[M]</td>
</tr>
<tr>
<td>Mute/Unmute Objects</td>
<td>[Alt]/[Option]-[M]</td>
</tr>
<tr>
<td>Open Default Editor</td>
<td>[Ctrl]/[Command]-[E]</td>
</tr>
<tr>
<td>Open Score Editor</td>
<td>[Ctrl]/[Command]-[R]</td>
</tr>
<tr>
<td>Open/Close Editor</td>
<td>[Return]</td>
</tr>
<tr>
<td>Paste</td>
<td>[Ctrl]/[Command]-[V]</td>
</tr>
<tr>
<td>Paste at Origin</td>
<td>[Alt]/[Option]-[V]</td>
</tr>
<tr>
<td>Paste Time</td>
<td>[Ctrl]/[Command]-[Shift]-[V]</td>
</tr>
<tr>
<td>Record Enable</td>
<td>[R]</td>
</tr>
<tr>
<td>Redo</td>
<td>[Ctrl]/[Command]-[Shift]-[Z]</td>
</tr>
<tr>
<td>Repeat</td>
<td>[Ctrl]/[Command]-[K]</td>
</tr>
<tr>
<td>Right Selection Side to Cursor</td>
<td>[D]</td>
</tr>
<tr>
<td>Select All</td>
<td>[Ctrl]/[Command]-[A]</td>
</tr>
<tr>
<td>Select None</td>
<td>[Ctrl]/[Command]-[Shift]-[A]</td>
</tr>
</tbody>
</table>

546  
Key commands
### Editors category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snap On/Off</td>
<td>[J]</td>
</tr>
<tr>
<td>Solo</td>
<td>[S]</td>
</tr>
<tr>
<td>Split At Cursor</td>
<td>[Alt]/[Option]-[X]</td>
</tr>
<tr>
<td>Split Range</td>
<td>[Shift]-[X]</td>
</tr>
<tr>
<td>Toggle Edit Group on Selected Tracks</td>
<td>[K]</td>
</tr>
<tr>
<td>Undo</td>
<td>[Ctrl]/[Command]-[Z]</td>
</tr>
<tr>
<td>Ungroup</td>
<td>[Ctrl]/[Command]-[U]</td>
</tr>
<tr>
<td>Unlock</td>
<td>[Ctrl]/[Command]-[U]/[Shift]-[U]</td>
</tr>
<tr>
<td>Unmute Events</td>
<td>[Shift]-[U]</td>
</tr>
</tbody>
</table>

### File category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>[Ctrl]/[Command]-[W]</td>
</tr>
<tr>
<td>New</td>
<td>[Ctrl]/[Command]-[N]</td>
</tr>
<tr>
<td>Open</td>
<td>[Ctrl]/[Command]-[O]</td>
</tr>
<tr>
<td>Quit</td>
<td>[Ctrl]/[Command]-[Q]</td>
</tr>
<tr>
<td>Save</td>
<td>[Ctrl]/[Command]-[S]</td>
</tr>
<tr>
<td>Save As</td>
<td>[Ctrl]/[Command]-[Shift]-[S]</td>
</tr>
<tr>
<td>Save New Version</td>
<td>[Ctrl]/[Command]-[Alt]/[Option]-[S]</td>
</tr>
</tbody>
</table>

### Media category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open MediaBay</td>
<td>[F5]</td>
</tr>
<tr>
<td>Open Mini Browser</td>
<td>[F7]</td>
</tr>
<tr>
<td>Preview Cycle On/Off</td>
<td>[Shift]-[Num] [/]</td>
</tr>
<tr>
<td>Preview Start</td>
<td>[Shift]-[Enter]</td>
</tr>
<tr>
<td>Preview Stop</td>
<td>[Shift]-[Num] [0]</td>
</tr>
<tr>
<td>Search MediaBay</td>
<td>[Shift]-[FS]</td>
</tr>
<tr>
<td>Toggle Attribute Inspector</td>
<td>[Ctrl]/[Command]-[Alt]/[Option]-[Num] [6]</td>
</tr>
<tr>
<td>Toggle Filters</td>
<td>[Ctrl]/[Command]-[Alt]/[Option]-[Num] [6]</td>
</tr>
</tbody>
</table>

### MIDI category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle Location Tree</td>
<td>[Ctrl]/[Command]-[Alt]/[Option]-[Num] [4]</td>
</tr>
<tr>
<td>Toggle Locations</td>
<td>[Ctrl]/[Command]-[Alt]/[Option]-[Num] [8]</td>
</tr>
<tr>
<td>Toggle Previewer</td>
<td>[Ctrl]/[Command]-[Alt]/[Option]-[Num] [2]</td>
</tr>
</tbody>
</table>

### Navigate category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Down:</td>
<td>[Shift]-[Down Arrow]</td>
</tr>
<tr>
<td>Add Left:</td>
<td>[Shift]-[Left Arrow]</td>
</tr>
<tr>
<td>Add Right:</td>
<td>[Shift]-[Right Arrow]</td>
</tr>
<tr>
<td>Add Up:</td>
<td>[Shift]-[Up Arrow]</td>
</tr>
<tr>
<td>Down:</td>
<td>[Down Arrow]</td>
</tr>
<tr>
<td>Left:</td>
<td>[Left Arrow]</td>
</tr>
<tr>
<td>Right:</td>
<td>[Right Arrow]</td>
</tr>
<tr>
<td>Up:</td>
<td>[Up Arrow]</td>
</tr>
<tr>
<td>Bottom:</td>
<td>[End]</td>
</tr>
<tr>
<td>Top:</td>
<td>[Home]</td>
</tr>
<tr>
<td>Toggle Selection</td>
<td>[Ctrl]/[Command]-[Space]</td>
</tr>
</tbody>
</table>

### Key commands
### Nudge category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Left</td>
<td>Alt/Option-[Shift]-[Left Arrow]</td>
</tr>
<tr>
<td>End Right</td>
<td>Alt/Option-[Shift]-[Right Arrow]</td>
</tr>
<tr>
<td>Left</td>
<td>Ctrl/Command-[Left Arrow]</td>
</tr>
<tr>
<td>Right</td>
<td>Ctrl/Command-[Right Arrow]</td>
</tr>
<tr>
<td>Start Left</td>
<td>Alt/Option-[Left Arrow]</td>
</tr>
<tr>
<td>Start Right</td>
<td>Alt/Option-[Right Arrow]</td>
</tr>
</tbody>
</table>

### Transport category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Punch In</td>
<td>[I]</td>
</tr>
<tr>
<td>Auto Punch Out</td>
<td>[O]</td>
</tr>
<tr>
<td>Cycle</td>
<td>Num [I]</td>
</tr>
<tr>
<td>Exchange time formats</td>
<td>[J]</td>
</tr>
<tr>
<td>Fast Forward</td>
<td>[Shift]-Num [+1]</td>
</tr>
<tr>
<td>Fast Rewind</td>
<td>[Shift]-Num [-1]</td>
</tr>
<tr>
<td>Forward</td>
<td>Num [+1]</td>
</tr>
<tr>
<td>Input Left Locator</td>
<td>[Shift]-[L]</td>
</tr>
<tr>
<td>Input Position</td>
<td>[Shift]-[P]</td>
</tr>
<tr>
<td>Input Right Locator</td>
<td>[Shift]-[R]</td>
</tr>
<tr>
<td>Input Tempo</td>
<td>[Shift]-[T]</td>
</tr>
<tr>
<td>Insert Marker</td>
<td>Insert (Win)</td>
</tr>
<tr>
<td>Locate Next Event</td>
<td>[N]</td>
</tr>
<tr>
<td>Locate Next Hitpoint</td>
<td>Alt/Option-[N]</td>
</tr>
<tr>
<td>Locate Next Marker</td>
<td>[Shift]-[N]</td>
</tr>
<tr>
<td>Locate Previous Event</td>
<td>[B]</td>
</tr>
<tr>
<td>Locate Previous Hitpoint</td>
<td>Alt/Option-[B]</td>
</tr>
<tr>
<td>Locate Previous Marker</td>
<td>[Shift]-[B]</td>
</tr>
<tr>
<td>Locate Selection</td>
<td>[L]</td>
</tr>
<tr>
<td>Locators to Selection</td>
<td>[P]</td>
</tr>
<tr>
<td>Loop Selection</td>
<td>[Shift]-[G]</td>
</tr>
<tr>
<td>Metronome On</td>
<td>[C]</td>
</tr>
<tr>
<td>Nudge Cursor Left</td>
<td>Ctrl/Command-[Num [-1]</td>
</tr>
<tr>
<td>Nudge Cursor Right</td>
<td>Ctrl/Command-[Num [+1]</td>
</tr>
<tr>
<td>Panel (Transport panel)</td>
<td>[F2]</td>
</tr>
<tr>
<td>Play Selection Range</td>
<td>Alt/Option-[Space]</td>
</tr>
<tr>
<td>Recall Cycle Marker 1 to 9</td>
<td>[Shift]-Num [1] to [9]</td>
</tr>
<tr>
<td>Record</td>
<td>Num [*]</td>
</tr>
<tr>
<td>Retrospective Record</td>
<td>[Shift]-Num [*]</td>
</tr>
<tr>
<td>Return to Zero</td>
<td>Num [.] or Num [.] or Num [ ]</td>
</tr>
<tr>
<td>Rewind</td>
<td>Num [-1]</td>
</tr>
<tr>
<td>Set Left Locator</td>
<td>Ctrl/Command-[Num [1]</td>
</tr>
<tr>
<td>Set Marker 1</td>
<td>Ctrl/Command-[1]</td>
</tr>
<tr>
<td>Set Marker 2</td>
<td>Ctrl/Command-[2]</td>
</tr>
<tr>
<td>Set Right Locator</td>
<td>Ctrl/Command-[Num [2]</td>
</tr>
<tr>
<td>Start</td>
<td>[Enter]</td>
</tr>
</tbody>
</table>

### Project category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Browser</td>
<td>Ctrl/Command-[B]</td>
</tr>
<tr>
<td>Open Markers</td>
<td>Ctrl/Command-[M]</td>
</tr>
<tr>
<td>Open Pool</td>
<td>Ctrl/Command-[P]</td>
</tr>
<tr>
<td>Open Tempo Track Editor</td>
<td>Ctrl/Command-[T]</td>
</tr>
<tr>
<td>Remove Track</td>
<td>Shift-[Del]</td>
</tr>
<tr>
<td>Setup</td>
<td>Shift-[S]</td>
</tr>
</tbody>
</table>

### Quantize category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantize</td>
<td>Q</td>
</tr>
</tbody>
</table>

### Tool category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete tool</td>
<td>6</td>
</tr>
<tr>
<td>Draw tool</td>
<td>8</td>
</tr>
<tr>
<td>Drumstick tool</td>
<td>0</td>
</tr>
<tr>
<td>Glue tool</td>
<td>4</td>
</tr>
<tr>
<td>Mute tool</td>
<td>7</td>
</tr>
<tr>
<td>Next Tool</td>
<td>F10</td>
</tr>
<tr>
<td>Play tool</td>
<td>9</td>
</tr>
<tr>
<td>Previous Tool</td>
<td>F9</td>
</tr>
<tr>
<td>Range tool</td>
<td>2</td>
</tr>
<tr>
<td>Select tool</td>
<td>1</td>
</tr>
<tr>
<td>Split tool</td>
<td>3</td>
</tr>
<tr>
<td>Zoom tool</td>
<td>8</td>
</tr>
</tbody>
</table>
### Option Category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/Stop</td>
<td>[Space]</td>
</tr>
<tr>
<td>Stop</td>
<td>Num [0]</td>
</tr>
<tr>
<td>To Left Locator</td>
<td>Num [1]</td>
</tr>
<tr>
<td>To Marker 1</td>
<td>[Shift]-[1]</td>
</tr>
<tr>
<td>To Marker 2</td>
<td>[Shift]-[2]</td>
</tr>
<tr>
<td>To Right Locator</td>
<td>Num [2]</td>
</tr>
<tr>
<td>Use External Sync</td>
<td>[T]</td>
</tr>
</tbody>
</table>

#### Windows Category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inline: Key Commands</td>
<td>[Shift]-[F4]</td>
</tr>
<tr>
<td>Inline: Settings</td>
<td>[Shift]-[F3]</td>
</tr>
<tr>
<td>Inline: View Layout</td>
<td>[Shift]-[F2]</td>
</tr>
</tbody>
</table>

#### Workspace Category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock/Unlock Active Workspace</td>
<td>[Alt]/[Option]-Num [0]</td>
</tr>
<tr>
<td>New</td>
<td>[Ctrl]/[Command]-Num [0]</td>
</tr>
<tr>
<td>Organize</td>
<td>[W]</td>
</tr>
<tr>
<td>Workspace 1-9</td>
<td>[Alt]/[Option]-Num [1-9]</td>
</tr>
<tr>
<td>Workspace X</td>
<td>[Ctrl]/[Command]/[Alt]/[Option]-Num [0]</td>
</tr>
</tbody>
</table>

#### Zoom Category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom Full</td>
<td>[Shift]-[F]</td>
</tr>
<tr>
<td>Zoom In</td>
<td>[H]</td>
</tr>
<tr>
<td>Zoom In Tracks</td>
<td>[Alt]/[Option]-[Down Arrow]</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>[G]</td>
</tr>
<tr>
<td>Zoom Out Tracks</td>
<td>[Alt]/[Option]-[Up Arrow] or [Ctrl]/[Command]-[Up Arrow]</td>
</tr>
<tr>
<td>Zoom to Event</td>
<td>[Shift]-[E]</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>[Alt]/[Option]-[S]</td>
</tr>
<tr>
<td>Zoom Tracks Exclusive</td>
<td>[Z] or [Ctrl]/[Command]-[Down Arrow]</td>
</tr>
</tbody>
</table>

---

549
Key commands
Part II: Score layout and printing (Cubase only)
1

How the Score Editor works
About this chapter

In this chapter you will learn:

• How the Score Editor and MIDI data relate.
• What Display Quantize is and how it works.

Welcome!

Welcome to scoring in Cubase! The Score Editor has been created to allow you to get any possible piece of music displayed as a score, complete with all the necessary symbols and formatting. It allows you to extract parts out of a full orchestra score, to add lyrics and comments, create lead sheets, score for drums, create tablature, etc. In other words: just about any type of notation you could ever desire!

There are a few basic principles to how the Score Editor works, which you have to understand to make full use of it.

How the Score Editor operates

The Score Editor does the following:

• Reads the MIDI notes in the MIDI parts.
• Looks at the settings you have made.
• Decides how the MIDI notes are displayed according to the settings.

MIDI notes vs. score notes

MIDI tracks in Cubase hold MIDI notes and other MIDI data. As you may know, a MIDI note in Cubase is only defined by its position, length, pitch and velocity. This is not nearly enough information to decide how the note is to be displayed in a score. The program needs to know more: What type of instrument are we talking about, Drums? Piano? What key is the piece in? What is the basic rhythm? How should the notes be grouped under beams? You provide this information by making settings and working with the tools available in the Score Editor.

An example of the MIDI/score relationship

When Cubase stores a MIDI note’s position, it makes the measurement in an absolute value, called ticks. There are 480 ticks to a quarter note. Have a look at the example below:

A quarter note at the end of a 4/4 measure

The note is on the fourth beat of the measure. Now, let’s say you change the time signature to 3/4. This shortens the length of a “measure” to only three quarter notes – 1440 ticks. Suddenly our quarter note is in the next measure:

The same note in 3/4

Why? Since you are not changing the MIDI data in the track/part (that would ruin your recording!) by changing the time signature, the note is still at the same absolute position. It is just that now each “measure” is shorter, which effectively moves the note in the score.

What we are trying to get across here is that the Score Editor is an “interpreter” of the MIDI data. It follows rules that you set up by making settings in dialogs, on menus, etc. And this interpretation is “dynamic”, or in other words, it is constantly updated whenever the data (the MIDI notes) or the rules (the score settings) change.
Display Quantize

Let’s say you used the Project window to record a figure with some staccato eighth notes. When you open the Score Editor, these notes are displayed like this:

This does not look anything like what you intended. Let’s start with the timing – obviously, you were off at a couple of places (the third, fourth and last note all seem to be a 32nd note late). You can solve this by quantizing the figure, but this would make the passage sound too "stiff", and not fit in the musical context. To resolve this problem the Score Editor employs something called “Display Quantize”.

Display Quantize is a setting which is used to tell the program two things:

• How precise the Score Editor is to be when displaying the note positions.
• The smallest note values (lengths) you want displayed in the score.

In the example above, the Display Quantize value seems to be set to 32nd notes (or a smaller note value).

Let’s say we change the Display Quantize value to sixteenth notes in the example:

With Display Quantize set to sixteenth notes

OK, now the timing looks right, but the notes still do not look like what you intended. Maybe you can understand that from a computer’s point of view, you did play sixteenth notes, which is why there are a lot of pauses. But that’s not how you meant it. You still want the track to play back short notes, because it is a staccato part, but you want something else “displayed”. Try setting the Display Quantize value to eighth notes instead:

With Display Quantize set to eighth notes

Now we have eighth notes, as we wanted. All we have to do now is to add staccato articulation which can be done with one simple mouse click using the Pencil tool (see the chapter “Working with symbols” on page 618) or using musical articulations (see the chapter “Expression maps (Cubase only)” on page 419).

How did this work? By setting the Display Quantize value to eighth notes, you give the program two instructions that would sound something like this in English: “Display all notes as if they were on exact eighth note positions, regardless of their actual positions” and “Don’t display any notes smaller than eighth notes, regardless of how short they are”. Please note that we used the word “display”, which leads us to one of the most important messages of this chapter:

⚠️ Setting a Display Quantize value does not alter the MIDI notes of your recording in any way, as regular quantizing does. It only affects how the notes are displayed in the Score Editor (and nowhere else)!

Choose your Display Quantize values with care

As explained above, the Display Quantize value for notes puts a restriction on the smallest note value that can be displayed. Let’s see what happens if we set it to quarter notes:

With Display Quantize set to quarter notes

Oops, this doesn’t look too good. Well of course it doesn’t! We have now instructed the program that the “smallest” note that occurs in the piece is a quarter note. We have explicitly told it that there are no eighth notes, no sixteenths, etc. So when the program draws the score on screen (and on paper) it quantizes the display of all our eighth notes to quarter note positions, which makes it look like above. But again, please note that when you hit Play, the passage still plays as it originally did. The Display Quantize setting only affects the score image of the recording.

⚠️ Even if you manually enter notes in the score using perfect note values, it is very important that you have your Display Quantize settings right! These values are not just used for MIDI recordings! If you for example set the Display Quantize value for notes to quarter notes and start clicking in eighth notes, you get eighth notes in the track (as MIDI data), but still only quarter notes in the display!
Using Rests as Display Quantize setting

Above we used Display Quantize for notes. There is a similar Display Quantize setting called “Rests” which is used to set the smallest rest to be displayed. Often, this setting is very effective.

Let’s start with the following note example:

As you see, the first note appears one sixteenth note late. If we change the Display Quantize value for notes to eighth notes, the score is displayed like this:

With Display Quantize: Notes set to eighth notes

Unfortunately, this moves the first note to the same position as the second, since sixteenth note positions are not allowed. We can solve this by inserting extra Display Quantize values within the bar with the Display Quantize tool (see “Inserting Display Quantize changes” on page 571), but there is a much easier way: Change the Display Quantize value for notes back to sixteenths, but set the value for rests to eighth notes! This tells the program not to display any rests smaller than eighth notes, except when necessary. The result looks like this:

With Display Quantize: Notes set to sixteenth notes, but Rests set to eighth notes.

How did this work? Well, you instructed the program not to display any rests smaller than eighth notes, except when “necessary”. Since the first note appeared on the second sixteenth note position, it was necessary to put a sixteenth rest at the beginning of the figure. All other rests can be hidden by displaying the notes as eighth notes, and were therefore not “necessary”.

This leads us to the following general guidelines:

- Set the Notes value according to the “smallest note position” you want to be shown in the score (e.g., if you have notes on odd sixteenth note positions, set the Notes to sixteenth notes).
- Set the Rests value according to the smallest note value (length) you want to be displayed for a single note, positioned on a beat.

Common Display Quantize settings would be to have Notes set to 16 (sixteenth notes) and Rests set to 4 (quarter notes).

Handling exceptions

Unfortunately, the guidelines above do not work perfectly in every situation. You may for example have a mix of straight notes and tuplets of different types, or you may wish to display equally long notes with different note values depending on the context. There are several methods you can try:

Automatic Display Quantize

If your score contains both straight notes and triplets, you can use Auto Quantize. When this is activated, Cubase tries to “understand” whether the notes should be display quantized to straight notes or triplets, see “If your music contains mixed straight notes and triplets” on page 589.

Using the Display Quantize tool

With the “Q” tool, you can insert new Display Quantize values anywhere in the score. Inserted Display Quantize values affect the staff from the insertion point onwards, see “Inserting Display Quantize changes” on page 571.

Permanent alteration of MIDI data

As a last resort, you can resize, quantize or move the actual note events. However, this would result in the music not playing back like it originally did. Often it is possible to get the score to look the way you want without altering any MIDI data.

Summary

This closes our discussion on the basic concept of display quantizing. There are a number of other special situations which require more advanced techniques described in the next chapters. The interpretation options which work along the same lines as Display Quantize are also explained.
Entering notes by hand vs. recording notes

Sometimes you enter and edit notes by hand (or rather using the mouse and/or the computer keyboard) and at other times you record them from a MIDI keyboard. Most of the time, you do a combination of both. In the chapter “Transcribing MIDI recordings” on page 568 you can find out how to make a recorded score as legible as possible without making any permanent changes to the MIDI data. The chapter “Entering and editing notes” on page 573 shows you how to enter and edit notes using the mouse. In real life, even if you have recorded the piece perfectly, you often have to do some permanent editing to your recording before printing.

⚠️ In order to understand how to produce legible scores we recommend to read both chapters.
2
The basics
About this chapter

In this chapter you will learn:

• How to open the Score Editor.
• How to switch between Page Mode and Edit Mode.
• How to set up the page size and margins.
• How to hide and show the Symbols Inspector, the toolbar, and the extended toolbar.
• How to set up the ruler.
• How to set a zoom factor.
• How to make initial settings for clef, key, and time signature.
• How to transpose instruments.
• How to print and export your score.

Preparations

1. In the Project window, create a MIDI track for each instrument.
   You can prepare a piano (split) staff from a single track, i.e. there is no need to create one track for the bass clef and one for the treble clef.
2. Name each track after the instrument.
   This name can later be used in the score if you like.
3. Record on the tracks or create empty parts on all tracks.
   You can make very long parts that cover the entire project, or you can start out with shorter parts to begin with. If you choose the latter option, you can always go back later and add new parts or copy existing parts.

Opening the Score Editor

Editing one or several parts
To open one or several parts in the Score Editor, select the parts (on the same or on different tracks) and select “Open Score Editor” from the MIDI menu or “Open Selection” from the Scores menu. The default key command for this is [Ctrl]/[Command]-[R].
• You can also select the Score Editor as your default editor, allowing you to open it by double-clicking parts. This is done with the Default Edit Action pop-up menu in the Preferences dialog (Event Display–MIDI page).

Editing whole tracks
When preparing a score for printing, you probably want to open whole MIDI tracks in the Score Editor. To do this, select the track(s) in the track list and make sure no parts are selected – then open the Score Editor as described above.

Editing parts on different tracks
If you have selected parts on two or more tracks (or several entire tracks – no parts) and open the Score Editor, you get one staff for each track (although you can split a staff in two, e.g. when scoring for piano). Think of the Project window as an overview of your entire score and the tracks as representing one instrument each.

Editing predefined combinations of tracks
How to open the Score Editor for a certain combination of tracks that you edited before is described in the section “Layout operations” on page 656.

Displaying single voices or the complete score
When the “Double-click on staff flips between full score/part” option is activated in the Preferences dialog (Scores–Editing page), double-clicking on the blue rectangle to the left of a staff switches between display of either the whole score or the current voice.

The project cursor
The project cursor appears as a vertical line across the staff. When you open the Score Editor, the view is automatically scrolled so that the project cursor is visible in the window. This means you do not always see the beginning of the edited part when you first open the Score Editor.
• Hold down [Alt]/[Option] and [Shift] and click anywhere in the score to move the project cursor there. This is handy when the project cursor is not visible. This is not possible if Computer Keyboard Input mode is activated, see “Entering notes using the computer keyboard” on page 576.

Playing back and recording
You can play back and record MIDI in the Score Editor using the standard transport commands, just like in the other MIDI editors. See the chapter “The MIDI editors” on page 374 for details.
Page Mode

When you are preparing a score for printout, you should set the Score Editor to Page Mode. This is done by selecting Page Mode from the Scores menu. When Page Mode is activated, a checkmark appears next to this menu option.

In Page mode, the window switches to display one page at a time, as it appears on printout.

Page Mode vs. Edit Mode

When Page Mode is not activated, the Score Editor is in Edit Mode. All you can do in Edit Mode, you can also do in Page Mode. But Page Mode offers lots of additional features which are directly related to how the score is displayed and printed.

⚠️ This section of the manual assumes you are in Page Mode. It is mentioned explicitly if something in this text specifically relates to Edit Mode.

Using the scroll bars in Page Mode

In Page Mode, the scroll bars are used to scroll the image of the page inside the window.

Moving between pages in Page Mode

If your score takes up more than one page, you use the page number indicator in the lower right corner to move to another page in your score. The number can be adjusted using the standard editing techniques.

⚠️ If you select “Fit Page”, the zoom factor is adjusted according to the window size so that the whole page becomes visible.

Changing the zoom factor

There are two ways to change the zoom in Page Mode: by setting a zoom factor on the zoom pop-up menu or by using the Zoom tool (magnifying glass).

Using the Zoom pop-up menu

Above the vertical scrollbar to the right you can find a pop-up menu allowing you to set the zoom factor.

By zooming in you can make detailed adjustments to symbols, etc. By zooming out you get a better overview.

- If you select “Fit Page”, the zoom factor is adjusted according to the window size so that the whole page becomes visible.

- If you select “Fit Width”, the zoom factor is adjusted according to the window width so that the full width of the page becomes visible.
This pop-up menu can also be opened by right-clicking in the ruler.

Using the Zoom tool
The Zoom tool in the Score Editor works much like in the Project window:

- Click once with the Zoom tool to zoom in one step.
- Hold down [Alt]/[Option] and click once with the Zoom tool to zoom out one step.
- Drag a rectangle with the Zoom tool to set a custom zoom factor.
  The section encompassed by the rectangle is zoomed to fill the window.
- Hold down a modifier key and right-click with the Zoom tool to open the Zoom context menu, and select the desired Zoom setting.

Using the Mouse wheel
You can also zoom by holding down [Ctrl]/[Command] and moving the mouse wheel. The mouse position is kept (if possible) when zooming in or out.

The active staff
One thing to note when you are working with multiple staves is the “active” staff. Only one staff at a time can be active, and it is indicated by a blue rectangle to the left of the clef symbol.

Making page setup settings
Before preparing the score for printout, you have to make some page settings for your project. This does not have to be the first thing you do, but it is a good working habit, because it also affects the on-screen display of the score.

   The Page Setup dialog appears. This is the regular operation system Page Setup dialog, described in detail in your system's documentation.
   The only things that Cubase adds to this are the margin settings.
2. Select the preferred printer, paper size, orientation, etc.
3. If you need to, change the margins by setting the left, right, top and bottom settings.
   - To make the settings permanent, save the project.
   If you want new projects to always start with certain page setup settings, you can create project templates with these, see “Setting up a default template” on page 51.

Designing your work space
You can design your work space according to your needs by showing/hiding different areas using the Window Layout function and by showing/hiding different options of these areas using the Setup options dialogs. Which areas and options to show or hide depends on what kind of project you are working on, how large your monitor is, and so on.

To configure the window layout, proceed as follows:

1. On the toolbar, click the “Set up Window Layout” button.
   A transparent pane appears.

2. Activate the desired options.
The status line

The status line features the Mouse Time and the Mouse Note Position displays as well as the Current Chord Display, which helps you identify chords in the Score Editor note display. It can be hidden/displayed using the “Status Line” option in the “Set up Window Layout” pane.

The status line has its own Setup dialog where you can specify exactly which properties you want to see.

• Right-click on the status line and select “Setup…” from the context menu.

In the dialog that appears you can configure where the separate items will be placed and save/recall different setup configurations.

The info line

The info line displays information about the selected note. It can be shown and hidden using the “Info Line” option in the “Set up Window Layout” pane.

The info line has its own setup dialog where you can specify exactly which properties are shown.

• Right-click on the info line and select “Setup…” from the context menu.

In the dialog that appears you can configure where the separate items will be placed and save/recall different setup configurations.

The extended toolbar

The extended toolbar contains additional tools for your score. It can be hidden/displayed using the Tools option in the “Set up Window Layout” pane.

The filter bar

This area contains checkboxes determining which indicators, handles, and other non-printed elements are shown in the score. It can be hidden/displayed using the Filters option in the “Set up Window Layout” pane.

Showing and hiding elements

Some of the elements in the score are not printed, but rather serve as indicators for layout changes, handles, etc. These elements can be hidden or shown in any combination by using the Filters options.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar Handles</td>
<td>Displays the bar handles, used for copying bars (see “Moving and duplicating with the bar handles” on page 631).</td>
</tr>
<tr>
<td>Hidden Notes</td>
<td>Displays any notes you might have hidden (see “Hiding/showing objects” on page 665).</td>
</tr>
<tr>
<td>Hide</td>
<td>Displays markers in the score for each hidden element (except notes, see “Hiding/showing objects” on page 665).</td>
</tr>
<tr>
<td>Quantize</td>
<td>Displays markers in the score where you have made Display Quantize “exceptions” (see “Inserting Display Quantize changes” on page 571).</td>
</tr>
<tr>
<td>Layout tool</td>
<td>Displays markers in the score where you have made adjustments with the Layout tool (see “Graphic moving of notes” on page 614).</td>
</tr>
<tr>
<td>Grouping</td>
<td>Displays markers in the score where you have made beam groupings (see “Grouping” on page 608).</td>
</tr>
<tr>
<td>Cutflag</td>
<td>Displays markers in the score where you have inserted cutflag events (see “The Cut Notes tool” on page 613).</td>
</tr>
<tr>
<td>Split Rests</td>
<td>Displays markers in the score wherever you have split multiple rests (see “Splitting multi-rests” on page 667).</td>
</tr>
<tr>
<td>Stems/Beams</td>
<td>Displays markers in the score where you have made any stem or beam adjustments (see “Setting stem direction” on page 604 and “Manual adjustment of beams” on page 612).</td>
</tr>
</tbody>
</table>

The Symbols Inspector

This area contains symbol tabs, which are used to add symbols to the score. It can be hidden/displayed using the Symbols option in the “Set up Window Layout” pane.

The symbol tabs can also be opened as free-floating palettes by opening them, right-clicking any of the buttons and selecting “Open as Palette” from the context menu. This way you can move symbol palettes around on the screen by clicking and dragging their title bars. Right-clicking on a symbol palette brings up a pop-up menu:

• Select “Toggle” to switch between a vertical or horizontal view of the palette.

• Select one of the options on the pop-up menu to bring up the corresponding palette instead of the current palette.

• Hold down [Ctrl]/[Command] and select a palette from the pop-up menu to open the selected palette in a new window (without closing the existing one).

• Click the close button to close a symbol palette.
In the Symbols Inspector setup dialog you can specify exactly which symbol tabs are shown. For a detailed description, see “The Symbols Inspector Setup dialog” on page 620.

How to work with symbols is explained in detail in the chapter “Working with symbols” on page 618.

The ruler

In the Score Editor there are no meter/time position rulers as in the other editors. Instead, there are horizontal and vertical “graphic rulers” in Page Mode. These help you to position symbols and graphical objects in the score.

• To specify which units to show on the rulers, open the Zoom pop-up menu and select one of the options. You can choose between points, inches, and centimeters.

• To hide the rulers, select “Off” from the pop-up menu.

The Position Info window

To help you when positioning objects in the score, the Page Mode has a special Position Info window, in which you can view and adjust object positions numerically, in the unit selected for the ruler. To display the Position Info window, click in the ruler.

About the Score Editor context menus

Many functions and settings of the Score Editor can be accessed via context menus, opened by right-clicking on certain elements of the score. For example, if you choose a note, the note context menu opens, listing note-related functions.

If you open the context menu on an empty area of the score, it lists all available tools (allowing you to quickly switch between tools) and it contains many functions of the main menus.

About dialogs in the Score Editor

There are two types of dialogs available in the Score Editor:

• Non-modal dialogs can remain open while you continue working in the score. In a non-modal dialog, clicking the Apply button applies the settings in the dialog to the selected objects in the score. This means you can select different elements in the score and change their settings, without having to close the dialog in between.

The dialog is closed by clicking the standard close button in the window title bar. The Score Settings dialog is an example for a non-modal dialog.

• Regular dialogs have an OK button instead of an Apply button. Clicking OK applies the settings you have made and closes the dialog. You cannot continue working in the score (or select other objects) until you close the dialog.

⇒ If the “Apply closes Property Windows” option is activated in the Preferences dialog (Scores–Editing page), clicking the Apply button in a non-modal dialog closes the dialog. In other words, this makes a non-modal dialog work a bit more like a regular dialog.
Setting clef, key, and time signature

When preparing to enter notes into a score, you probably want to start out by setting the desired clef, key, and time signature for the staff. The text below assumes you are working on one track only. If you have multiple staves, you either make this setting independently for each staff or for all staves at once, see “Staff settings” on page 570.

Normally, all these symbols appear at the beginning of each staff. However, you can control this by using the Real Book option (see “Real Book” on page 664) and by hiding objects (see “Hiding/showing objects” on page 665).

When entering or editing keys, there is one important thing to note:

⚠️ In the Score Settings dialog on the Project–Notation Style subpage (Keys category) you can find the “Key Changes for the entire Project” option. When this option is activated, all changes made to the key always affect every staff in the project, i.e. it is not possible to define different keys for different staves.

Using the Symbols Inspector to set the initial clef, key, and time signature

1. Click the “Set up Window Layout” button on the tool bar and activate the Symbols option. The Symbols Inspector is displayed.
2. Open the Clefs tab of the Inspector and click on the symbol for the clef that you want to use in your score.
3. Click anywhere in the first bar of the staff to set the clef for this track.
4. Open the Time Signature tab of the Inspector and click on the symbol for the time signature value that you want to use.
5. If you cannot find the desired time signature, you can use the Edit Time Signature dialog (see below).
6. Open the Time Signature tab of the Inspector and click on the symbol for the time signature value that you want to use.

If you want to further edit these settings, or if you need different settings for different bars of your track, proceed as described in the next section.

Editing the time signature

1. Double-click on the time signature symbol at the beginning of the staff. A dialog opens.
2. If the project is in 4/4 or 2/2, you can select common time/cut time directly by clicking one of the two symbols on the right. This sets the time signature to 4/4 or 2/2, respectively and also inserts a common/cut time symbol on the staff.
3. If the project is in any other time, set the numerator and denominator above and below the line, respectively. The numerator can consist of several numbers for composite time signatures. However, if the project is in a simple time signature you only need to fill in the first number above the line. The more advanced options are described below.
   - The “Pickup Bar” option is described in the section “By using the Pickup Bar feature” on page 668.
4. Click OK or press [Return].

⚠️ All tracks share the time signature! In other words, when you set the time signature, you do this for all tracks in the project.
If you need to enter half a bar somewhere (for example) you have to make a time signature change (e.g. from 4/4 to 2/4 and back again). See “Inserting and editing clefs, keys, or time signatures” on page 584 to find out how to enter time signature changes.

**Composite time signatures and the For Grouping Only option**

For composite signatures, the numerator can be made up of up to four groups. For example, "4+4+3+7/" on the upper line and 8 on the lower means the time signature is 11/8.

The reason for dividing the numerator into several numbers is to get beaming and tied notes displayed correctly automatically. This does not affect the metronome or anything else, only beams and ties. For more information on beaming, see “Handling beaming” on page 608.

If “For Grouping Only” is not activated, the numerator shows all the numbers entered. If it is activated, it shows the sum of the numbers entered, as for “simple” time signatures.

"For Grouping Only" off and on

Note that Cubase tries to preserve the denominator when you insert a composite signature with “For Grouping Only” activated. This means that if you have a 4/4 time signature, and change it to a composite value (3+3+2 eighths for example), the time signature still is displayed as 4/4 instead of 8/8.

**Setting the time signature on the Transport panel**

You can also set the time signature directly on the Transport panel. Please note that you cannot create composite time signatures from the Transport panel.

**Setting the time signature using the signature track/Tempo Track Editor**

You can also add, edit and delete time signatures using the signature track or the Tempo Track Editor (see the chapter “Editing tempo and signature” on page 462).

Please note the following:

- The score always shows the time signature events set in the signature track/Tempo Track Editor, regardless of whether or not the Tempo button is activated. Likewise, any time signatures you create in the Score Editor are shown in the signature track/Tempo Track Editor.

- You cannot create composite time signatures using the signature track/Tempo Track Editor.

**Editing the clef**

**On the clef context menu**

When you right-click on a clef symbol, a context menu with a list of all available clefs opens. This menu also contains the following options:

- **Display Clef Changes as Small Symbols**
  If you activate this option and insert a clef change in the score, the clef is displayed with a smaller symbol.

- **Warnings for new Clefs at Line Breaks**
  If you activate this option and insert a new clef at a line break, the Clef change symbol is inserted in the last bar before the staff break. When this is deactivated, the symbol is inserted in the first bar of the next staff line.

- **Hide**
  If you select this function, the clef is hidden.

- **Properties**
  If you select this function, the Edit Clef dialog opens.

**In the Edit Clef dialog**

1. Double-click on the current clef. A dialog appears.

2. Use the scroll bar to select a clef.

   △ This does not work if Auto Clef is activated on the Staff page of the Score Settings dialog, see below.

3. Repeat the steps above for all staves in the system.
**On the Staff page of the Score Settings dialog**

1. Click on a staff to make it the active staff.

2. On the Scores menu, select “Settings…” to open the Score Settings dialog. Select the Staff page at the top to open Main tab, showing the current settings for the active staff.

   You can also double-click to the left of a staff to make it active and bring up the Score Settings dialog in one go (if this does not work, the “Double-click on staff flips between full score/part” option in the Preferences dialog (Scores–Editing page) may be activated – see “Displaying single voices or the complete score” on page 557).

3. In the Clef/Key section, use the scroll bar on the left to select one of the available clefs.

   How to insert clef changes is described in the section “Inserting and editing clefs, keys, or time signatures” on page 584.

4. Click Apply.

   You can select another staff in the score and make settings for it without having to close the Score Settings dialog first.

**In a split system**

If you have a split system (see “Split (piano) staves” on page 583 and “Strategies: How many voices do I need?” on page 597) you can set different clefs for the upper and lower staff.

1. Open the Score Settings dialog on the Staff page.

2. Select a clef for the upper staff.

3. Activate the “Lower Staff” checkbox.

4. Set a clef for the lower staff.

**Using Auto Clef**

On the Staff page of the Score Settings dialog you also find the Auto Clef option. If this is activated, the program automatically selects a treble clef or a bass clef for the staff, depending on the range of the notes in the part.

**Editing the key**

⚠️ In the Score Settings dialog on the Project–Notation Style subpage (Keys category), you can find the “Key Changes for the entire Project” option. When this is activated, all changes made to the key always affect every staff in the project, i.e. it is impossible to define different keys for different staves (other than the relative display transpose settings for instruments made on the Staff page). Furthermore, on the Staff page, any staff (e.g. a drum staff) can be set to not show key signatures.

Therefore, when you want to edit the key, decide if you want the key change to apply to the entire project, or if you want to use different keys on different staves:

- If the key set at the beginning of the track is to be used on all staves, and if any subsequent key changes are also valid for all staves, then leave the “Key Changes for the entire Project” option activated.

- If you want to use different keys on different staves, make sure that the “Key Changes for the entire Project” option is deactivated.

**On the key context menu**

When you right-click on a key symbol, a context menu with a list of all available keys opens. This menu also contains the following options:

- Key changes for the entire Project

If this option is activated, all changes made to the key always affects the entire project, so that it is not possible to define different keys for different staves.
• Hide
  If you select this, the key is hidden.

• Properties
  If you select this, the Edit Key dialog opens.

**In the Edit Key dialog**
If the current key is anything but C major/A minor (no accidentals), you can set the key directly in the score:
1. Double-click on the accidentals at the beginning of a staff.
   The “Edit Key” dialog opens.

2. Use the scroll bar to select a key and click OK.
   ⇒ You can also enter a Display Transpose value, see “Transposing instruments” on page 565.

**On the Staff page of the Score Settings dialog**
1. Make the desired staff active, open the Score Settings dialog and select the Staff page.

2. Use the right scroll bar in the Clef/Key section to select the desired key.
3. Click Apply.
   ⇒ You can select other staves in the score and make settings for these, without having to close the Score Settings dialog.

**Setting the key for a split system**
If you have a split system with two staves (see “Split (piano) staves” on page 583 and “Strategies: How many voices do I need?” on page 597) you can set different keys for the upper and lower staff.
1. Click in the system to make one of its staves the active staff.
2. Open the Score Settings dialog on the Staff page.
3. Set a key for the upper staff.
   This automatically sets the lower staff to the same key.
4. If you need to set a different key for the lower staff, activate the “Lower Staff” checkbox and set a key for this.

**Setting a local key**
You can also set a different key for the selected staff only. This is useful for instruments like oboe and english horn that change display transpose and therefore also the key.

Proceed as follows:
1. Make the desired staff active, open the Score Settings dialog and select the Staff page.
2. Activate the “Local Keys” option on the Main subpage in the Clef/Key section.
   ⇒ This option is only available if “Key changes for entire Project” is activated in the Score Settings dialog, on the Project–Notation style subpage (Keys category).
3. Use the scroll bar to the right to set the desired key.
4. Click Apply to set the selected key for the staff.

**Transposing instruments**
Scores for some instruments, for example a lot of brass instruments, are written transposed. Therefore, the Score Editor provides a Display Transpose function. With this function notes are transposed in the score without affecting the way they are played back. This allows you to record and play back a multi-staff arrangement, and still score each instrument according to its own transposition.
**Setting Display Transpose**

1. Make the desired staff active, open the Score Settings dialog and select the Staff page.
2. In the Display Transpose section, select your instrument from the transpose pop-up menu or adjust the value directly in the Semitones field.
3. Click Apply.

⚠️ Display Transpose does not affect MIDI playback!

**Display Transpose in the Edit Key dialog**

If you want to change the Display Transpose setting in the middle of the score, you can do this by inserting a key change (see “Inserting and editing clefs, keys, or time signatures” on page 584). In the Edit Key dialog (which is opened by double-clicking a key symbol) you can find a Transpose field, in which you can enter a transposition value in semitones. This is useful if you are for example writing a saxophone part and want the player to switch from alto to tenor saxophone.

⚠️ Note that you enter an absolute Display Transpose value that is used from this point on. In other words, this setting is not relative to any Display Transpose settings you made on the Staff page of the Score Settings dialog.

**Disabling Display Transpose**

You can also disable Display Transpose by deactivating the “Display Transpose” button on the Score Editor toolbar. This can be useful if you work with transposing instruments and want to show the concert key and not the scored key.

---

**Printing from the Score Editor**

When you have made all necessary changes to the score display and are satisfied with the result, you can go ahead and print your score, e.g. to hand out note sheets.

Proceed as follows:

1. On the Scores menu, activate “Page Mode”. Printing is only possible from within Page Mode.
2. Select Page Setup from the File menu and make sure all your printer settings are correct. Close the dialog.
3. Select Print from the File menu.
4. A standard print dialog appears. Fill out the options as desired.
5. Click Print.

**Exporting pages as image files**

You can export a section of a page or a complete page in various file formats. This allows you to import your scores into desktop publishing and drawing applications.

**Selecting a section of a page for exporting**

If you only want to export a part of a certain page, proceed as follows:

1. Make sure that you are in Page Mode.
2. Select the Export tool (“Select Export Range”). The pointer turns into a crosshair.
3. Drag over the section of the score you want to include. The area is indicated by a black rectangle.
   - You can adjust the size of the rectangle by clicking and dragging its handles with the Object Selection tool.
   - You can move the rectangle to another position in the score by clicking and dragging.

To export the selected range, you have two possibilities:

   - Double-click inside the rectangle while it is selected. This opens the Export Scores dialog, where you can make settings for the file to be created (see below).
   - Use the Export Scores function, see below.
Exporting
To export the score, proceed as follows:
1. Make sure that you are in Page Mode.
2. Select the page that you want to export.
3. Pull down the File menu, open the Export submenu and select "Export Scores...".
   The Export Scores dialog appears.
4. Select a picture format.
5. Specify a resolution for the file.
   This determines the accuracy with which the image is created. 300 dpi, for example, is the resolution many laser printers use for printing. If the image file is only displayed on screen in other programs, select 72 or 96 (depending on screen resolution) and it has the same size as it had in Cubase.
6. Specify name and location for the file and click Save.
   The page of the score is exported and saved as a file. It can now be imported into any program supporting the selected file format.

Working order
When you prepare a score, we suggest you do things in the following order, since this minimizes the time needed if you make a mistake somewhere and need to redo a step.

- Preferably work on copies of recorded tracks.
  If the parts are fairly complex you might have to change them permanently, after which they do not play back as they originally did.
- If memory is an issue, break the score up into segments.
  You might for example use the Split Loop function (from the Functions submenu on the Edit menu) to split the parts across all tracks.
- Arrange the tracks in the Project window in the order you want them displayed in the score.
  You cannot rearrange the order of systems in the Score Editor. However, you can go back and change the order in the Project window at any time.
- When opening the Score Editor, begin with the adjustments described above.
  You should always begin by setting page margins, etc.
- If you have recorded music into tracks already, try adjusting the graphic display of the score as much as possible without permanently editing the notes.
  Use the Score Settings, Display Quantize, Grouping, etc.
- If the tracks are empty, make basic staff settings, enter the notes and then make detailed adjustments, add Display Quantize, etc.
- If needed, use polyphonic voicing to resolve overlapping notes, create piano systems, handle crossing voices, etc.
- When all this is done, decide if you need to perform "destructive" editing.
  You might for example have to permanently alter the length or position of some of the recorded notes.
- Hide unwanted objects and add note-dependent and note-related symbols.
  This includes accents, dynamic symbols, crescendo, slurs, lyrics, "graphic rests", etc.
- Work through the score and adjust the number of bars across the page.
- Adjust the vertical spacing between staves and grand staves.
  The last two steps can be performed automatically by the program using the Auto Layout features.
- Add layout symbols like endings, page text, etc.
- Print or export the score.
- Go back and create alternative layouts, e.g. to extract voices.

Force update
If for some reason the screen is not redrawn properly (as a result of the computer’s recalculation of the appearance of the page), you can select “Force Update” from the Functions submenu on the Scores menu or click the Force Update button on the extended toolbar. This forces a redraw of the whole page.
3

Transcribing MIDI recordings
About this chapter

In this chapter you will learn:

• How to prepare your parts for score printouts.
• How to use the Display Quantize tool to handle “exceptions” in the score.
• How to resolve parts that contain mixed notes and triplets.

About transcription

This chapter assumes you have a MIDI recording that you want to transform into a printable score. However, if the parts are fairly complicated, you probably need to perform some manual editing of the notes. This is described in the chapter “Entering and editing notes” on page 573.

⚠️ Before starting, make sure that you understand the basic principles behind the score notes/MIDI notes relationship and also what Display Quantize is, as described in the chapter “How the Score Editor works” on page 551.

Preparing parts for score printout

Below follow a few tips to note when preparing a score for printout:

• If a part is complex, you may have to do some “manual” editing of notes, like moving them or changing their lengths (see the chapter “Entering and editing notes” on page 573). This means that the recording does not play back exactly as it originally did. If this is a problem, we suggest you work on a copy of the recording. Use the Duplicate Track function on the Project menu to create a version of the track for scoring. Rename the track and mute the original track while you are preparing the score. You can of course also work on a copy of the entire project file.

• For reasons described in the previous chapter, quantizing the track might be a good idea. This reduces the amount of detailed adjustments needed in the Score Editor.

• If you need to quantize, always play back your tracks afterwards to make sure timing was not disrupted due to inappropriate quantize settings. You might have to quantize some sections with one value and others with another.

• If the project contains many repetitions, it might be quicker to record just one instance of each to start with. If you then finish the score work on each section, you can assemble the entire project by working with parts in the Project window. This might save you some time since the detailed adjustments to each section have to be performed only once.

• A similar approach can also be used when you create sections where several instruments play the same rhythm (a horn section, for example): Record the first instrument and make adjustments so that it looks like it should in the Score Editor. Then copy the part to the other tracks, and change the pitches of the notes using MIDI input. Finally, go through the copied parts and make fine adjustments, change display transpose settings, etc. This can be a very fast way to create polyphonic parts with complicated rhythms.

• There also may be situations when the quickest way to record a part for several instruments is simply to record it in one go, by playing the chords on your MIDI instrument. If you later want to split the recording into separate tracks or polyphonic voices, you can use the Explode function, see “The Explode function” on page 572.

Getting the parts ready

1. Record the music.
   You must definitely play in time with the click.

2. Play back to check that the music was recorded as intended.
   If not, you might need to re-record or perform some editing.

3. Decide how much permanent alteration to the recording you can accept to make the score look good.
   If the answer is “none”, you should prepare your score from a copy of the track. See the section below.

4. Select all parts (on all tracks) that you want to work on.

5. Open the Score Editor.

6. Activate Page Mode.
Staff settings

The first thing to do after opening the Score Editor is to make initial staff settings. This is done in the Score Settings dialog, on the Staff page. There are three ways to open the Score Settings dialog:

- Make the staff active, pull down the Scores menu and select “Settings…”.
- Double-click on the blue rectangle to the left of the staff. If this does not work, the “Double-click on staff flips between full score/part” option may be activated in the Preferences dialog (Scores–Editing page), see “Displaying single voices or the complete score” on page 557.
- Make the staff active and click the “i” button on the extended toolbar. For this to work, make sure no notes or symbols are selected – otherwise, clicking the “i” button may open a dialog with settings for the selected object instead.

Click the Staff button to open the Staff page of the Score Settings dialog. The Staff page shows the current settings for the staff on four tabs. For detailed information on the Staff Settings page, see the chapter “Staff settings” on page 586.

Situations which require additional techniques

The notes may not always appear in the score as you expect them to, initially. This is because there are a number of situations which require special techniques and settings. Below you can find a list of some of these and where to find more information about handling them:

- Notes at the same position are considered to be part of a chord. To get independent voicing (e.g. notes with different stem directions), such as for vocal material, you need to use the polyphonic voicing feature, see the chapter “Polyphonic voicing” on page 593.
- If two notes beginning at the same position have different lengths, the longer one is displayed as a number of tied notes. To avoid this, you can either use the No Overlap feature (see “No Overlap” on page 590) or polyphonic voicing (see “Polyphonic voicing” on page 593).
- One note is often displayed as two notes with a tie. Please note that this is merely the way the program displays this note; only a single note is “stored”.

This single note in the Key Editor is displayed as two tied notes in the Score Editor.

- Normally the program adds ties where necessary (if a note stretches over a beat), but not always. For a “modern” notation of syncopated notes (less ties) use the Syncopation feature, see “Syncopation” on page 589.

The same note, without and with syncopation

- If you find that you want a long note to be displayed as two or more tied notes, you can achieve this with the Cut Notes tool, see “The Cut Notes tool” on page 613.
- If two notes on the same position are too close to each other or if you want their order in the part reversed, you can do this without affecting playback, see “Graphic moving of notes” on page 614.
- If a note has the wrong accidental, this can be changed, see “Accidentals and enharmonic shift” on page 606.
- Stem direction and length are automatic, but you can change them manually if you wish, see “Background: Note stems” on page 604.
- If you need a split staff (e.g. when you are scoring for piano), there are special techniques for this – see “Split (piano) staves” on page 583 and “Polyphonic voicing” on page 593.

Without and with polyphonic voicing
Inserting Display Quantize changes

Some situations may require different staff settings on different sections of the track. The staff settings are valid for the entire track, but you can insert changes wherever you like:

1. Select the Display Quantize tool on the toolbar or the context menu.
   The Display Quantize dialog opens.

2. Activate the flags you need and set the quantize values as desired.
   For details, see “Display Quantize and Interpretation Options” on page 588. Additional hints below.

3. If you want to restore the settings to the ones used in the Score Settings dialog (Staff page), click the “Restore To Staff” button.

4. Move the mouse over the staff where you want to insert a new Display Quantize value.
   Use the Mouse Time Position display in the status line to find the exact location (see “The status line” on page 560). The vertical position is of no relevance as long as you click somewhere in the staff.

5. Click the mouse button to insert a Display Quantize event.
   The new quantize settings are now inserted into the staff at the position where you clicked. The settings are valid until a new change is inserted.

   • If you are using polyphonic voices (see “Polyphonic voicing” on page 593), you can insert a Display Quantize event for all voices by pressing [Alt]/[Option] and clicking with the tool.
   If the “Display Quantize Tool affects all Voices” option is activated in the Score Settings dialog on the Project page (Notation Style subpage, in the Miscellaneous category), Display Quantize events is always inserted for all voices.

Viewing and editing Display Quantize changes

If you activate the “Quantize” checkbox on the filter bar (see “Showing and hiding elements” on page 560), a marker is shown under the staff for each Display Quantize setting you have entered with the tool.

This allows you to edit your settings in the following ways:

• To edit a Display Quantize change event, double-click on its marker.
   This opens the Display Quantize dialog again – adjust the settings and click Apply.

• If the Display Quantize dialog is already open, you can select any Display Quantize change event, adjust its settings in the dialog and click Apply.

• To remove a Display Quantize change, either click its marker to select it and press [Backspace] or [Delete], or click on it with the Erase tool.

Adding Display Quantize changes

Very often, the score is fine except for a few bars somewhere. To remedy the problem, insert two Display Quantize changes with the tool (one at the beginning of the section, one after it to restore to the current staff settings).

If you have mixed triplets and straight notes, it can be tempting to insert many Display Quantize changes. Before you do so, try the Auto Quantize options and their additional settings. See “If your music contains mixed straight notes and triplets” on page 589 for details.
The Explode function

This function allows you to “split” the notes on a staff into separate tracks. It is also possible to use this function to convert a polyphonic staff into polyphonic voices – this is described in the section “Automatically – the Explode function” on page 598.

⚠️ Create a copy of the original track first, because it will be changed by the operation.

1. Pull down the Scores menu, open the Functions sub-menu and select “Explode”.
   The Explode dialog opens.

2. Make sure that “To New tracks” is selected at the top of the dialog.

3. Enter the desired number of new tracks.
   Note that this is the number of new tracks to be created! For example, if you have a three-part polyphonic section and want to split this into three separate tracks, you must specify 2 new tracks, since the original track holds one of the parts.

4. Use the options in the bottom section to set up the criteria for the split.
   Choose from the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split Note</td>
<td>Use this to move all notes below a certain pitch to another track. When this is selected, it is pointless to specify more than 1 new track.</td>
</tr>
<tr>
<td>Lines To tracks</td>
<td>Use this when you want all musical “lines” to be put on one track each. The notes with the highest pitch remains on the original track, the notes with the second highest pitch are put on the first new track, and so on.</td>
</tr>
<tr>
<td>Bass To Lowest Voice</td>
<td>When this is activated, the lowest notes always end up on the lowest track.</td>
</tr>
</tbody>
</table>

5. Click OK.
   A number of new tracks are now added to the score and the Project window.

Using “Scores Notes To MIDI”

For very complicated scores, there may be situations where you have tweaked the parameters for Display Quantize and Interpretation as best you can, and you still cannot get the score exactly as you want it. Perhaps one setting works fine in one section of the track and another is needed for another section.

In such a case, “Scores Notes To MIDI” helps you out. It changes the lengths and position of some or all the MIDI notes in the edited parts so that they have exactly the values currently shown on screen.

1. For safety, go back to the Project window and make a copy of the track.

2. Open the part(s) again in the Score Editor.
   If you only want some sections of your score to be “converted”, make sure to only open those parts.

3. Make sure that the notes you want to affect are not hidden (see “Hiding/showing objects” on page 665).

4. Select “Scores Notes To MIDI” from the Functions submenu on the Scores menu.
   The notes are now “converted”.

5. Make whatever adjustments are needed to make the score read as intended.
   Now that the notes have the exact lengths and positions that were previously only displayed, you can probably deactivate many of the options on the Staff page of the Score Settings dialog and delete Display Quantize settings, etc.

If you find the operation did not give you the result you were after, you can undo your settings or go back to the original track, make a copy of that, and start over.

Create a copy of the original track first, because it will be changed by the operation.
4

Entering and editing notes
About this chapter

In this chapter you will learn:

• How to make various settings for how notes are displayed.
• How to enter notes.
• How to use tools and settings to make the score as legible as possible.
• How to set up a split (piano) staff.
• How to work with multiple staves.

Score settings

Before you start entering notes, you need to make some initial staff settings in addition to those described in the chapter “The basics” on page 556. To understand why and how these settings and the note data in the score interact, please read the chapter “How the Score Editor works” on page 551.

There are three ways to open the Score Settings dialog:

• Make the staff active, pull down the Scores menu and select “Settings…”.
• Double-click on the blue rectangle to the left of the staff. If this does not work, the “Double-click on staff flips between full score/part” option may be activated in the Preferences dialog (Scores–Editing page), see “Displaying single voices or the complete score” on page 557.
• Make the staff active and click the “i” button on the extended toolbar.

For this to work, make sure no notes or symbols are selected – otherwise, clicking the “i” button may open a dialog with settings for the selected object instead.

The Score Settings dialog shows the current settings for the active staff. For detailed information on the Staff Settings dialog, see the chapter “Staff settings” on page 586.

Applying settings and selecting other staves

To make settings for another staff, simply make it active in the score (by clicking anywhere in the staff or by using the up/down arrow keys on the computer keyboard).

Always click Apply before making another staff active – otherwise your settings are lost!

Staff presets

When you want to reuse settings made for one track in other tracks, you can save some time by creating a staff preset (see “Working with staff presets” on page 587).

There are a number of staff presets available, set up to suit various instruments, etc. These are accessed via the Presets pop-up menu on the Staff page of the Score Settings dialog, or from the Staff context menu, opened by right-clicking on the blue rectangle to the left of the staff. Use them as they are, or as starting points for your own settings.

Suggested initial settings

When you start out entering notes, your staff settings should make your score display the notes as entered. We suggest the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Quantize: Notes</td>
<td>64</td>
</tr>
<tr>
<td>Display Quantize: Rests</td>
<td>64</td>
</tr>
<tr>
<td>Auto Quantize</td>
<td>Activated</td>
</tr>
<tr>
<td>Syncopation</td>
<td>Off</td>
</tr>
<tr>
<td>Consolidate Rests</td>
<td>Off</td>
</tr>
<tr>
<td>Clean Lengths</td>
<td>Off</td>
</tr>
<tr>
<td>No Overlap</td>
<td>Off</td>
</tr>
<tr>
<td>Shuffle</td>
<td>Off</td>
</tr>
<tr>
<td>Key</td>
<td>As required</td>
</tr>
<tr>
<td>Clef</td>
<td>As required</td>
</tr>
<tr>
<td>Auto Clef</td>
<td>Activate this if you want the program to select a treble or bass clef automatically.</td>
</tr>
<tr>
<td>Display Transpose value</td>
<td>0</td>
</tr>
<tr>
<td>Options tab settings</td>
<td>As is</td>
</tr>
<tr>
<td>Polyphonic tab settings</td>
<td>Staff Mode: Single (for split staves, see “Split (piano) staves” on page 583)</td>
</tr>
<tr>
<td>Tablature tab settings</td>
<td>Tablature Mode deactivated</td>
</tr>
</tbody>
</table>

It is very important that you understand how the Display Quantize values for notes and rests interact with the score. If you select too large a notes/rests value, the notes you “click in” may not appear as intended. Please read “How the Score Editor works” on page 551. If you have mixed triplets and straight notes, see “Display Quantize and Interpretation Options” on page 588.
Note values and positions

Two of the most important settings for entering notes are the length of the note (the note value) and the minimum spacing between notes (the Quantize value).

Selecting a note value for input

You can choose the length for entering notes as follows:

- By clicking the note symbols on the extended toolbar. You can select any note value from 1/1 to 1/64 and activate/deactivate the dotted and triplet options by clicking the two buttons to the right. The selected note value is displayed in the Length Quantize field on the toolbar and also reflected by the cursor shape of the Insert Note tool.

- By selecting an option from the Length Quantize pop-up menu on the toolbar.

- By assigning key commands to the different length values. This is done in the Key Commands dialog (in the category “Set Insert Length”).

About unusual note values

Not all note values can be selected directly, for example double dotted notes. Such notes are created by changing the length of the note after you have entered it (see “Changing the length of notes” on page 582), by gluing notes together (see “Lengthening a note by gluing two notes together” on page 582) or by using the Display Length feature.

Selecting a Quantize value

When you move the mouse pointer over the score the Mouse Time Position display in the status line tracks your movement and shows the current position in bars, beats, sixteenth notes, and ticks.

Positioning on screen is controlled by the current Quantize value. If you set this to 1/8, for example, you can only insert and move notes to eighth note positions, at quarter notes, at half bars or at bar positions. It is a good strategy to set the Quantize value to the smallest note value in the project. This does not stop you from inputting notes at “coarser” positions. However, if you set the Quantize value to too small a note value, it is easier to make mistakes.

The Quantize value is set on the toolbar on the “Quantize Presets” pop-up menu:

- You can also assign key commands to the different Quantize values. This is done in the Key Commands dialog (in the category “MIDI Quantize”).

- Just like in the other MIDI editors, you can use the Quantize Panel to create other Quantize values, irregular grids, etc. However, this is not often used when inputting score notes.

The mouse position info

While you often use the graphical position in the actual score to determine where the notes go, there are instances when you want to verify the position numerically using the mouse position info displayed in the status line.
The Mouse Note Position display shows the pitch according to the vertical position of the pointer in a staff. The Mouse Time Position display shows the “musical position” in bars, beats, sixteenth notes, and ticks:

- The relation between beats and bars depends on the time signature: In 4/4 there are 4 beats to a bar. In 8/8 there are eight, in 6/8 there are six, etc.

- The third number is the sixteenth note within the beat. Again, the time signature determines the number of sixteenth notes to each beat. In a quarter note based time signature (4/4, 2/4, etc.) there are four sixteenth notes to each beat, in an eighth note based time signature (3/8, 4/8, etc.), there are two sixteenth notes, etc.

- The last value is in ticks, with 480 ticks per quarter note (and thus 120 ticks per sixteenth note).

The figures below show some note positions and their corresponding position values:

### Eight note positions

<table>
<thead>
<tr>
<th>Time Signature</th>
<th>2/2</th>
<th>4/4</th>
<th>8/8</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1.1.1.0</td>
<td>1.1.1.0</td>
<td>1.1.1.0</td>
</tr>
<tr>
<td></td>
<td>1.1.3.0</td>
<td>1.1.3.0</td>
<td>1.1.3.0</td>
</tr>
<tr>
<td></td>
<td>1.1.5.0</td>
<td>1.1.5.0</td>
<td>1.1.5.0</td>
</tr>
<tr>
<td></td>
<td>1.1.7.0</td>
<td>1.1.7.0</td>
<td>1.1.7.0</td>
</tr>
</tbody>
</table>

### Eighth note triplet positions

<table>
<thead>
<tr>
<th>Time Signature</th>
<th>2/2</th>
<th>4/4</th>
<th>8/8</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1.1.1.0</td>
<td>1.1.1.0</td>
<td>1.1.1.0</td>
</tr>
<tr>
<td></td>
<td>1.1.2.40</td>
<td>1.1.2.40</td>
<td>1.1.2.40</td>
</tr>
<tr>
<td></td>
<td>1.1.3.80</td>
<td>1.1.3.80</td>
<td>1.1.3.80</td>
</tr>
<tr>
<td></td>
<td>1.2.1.80</td>
<td>1.2.1.80</td>
<td>1.2.1.80</td>
</tr>
</tbody>
</table>

### Sixteenth note positions

<table>
<thead>
<tr>
<th>Time Signature</th>
<th>2/2</th>
<th>4/4</th>
<th>8/8</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1.1.1.0</td>
<td>1.1.1.0</td>
<td>1.1.1.0</td>
</tr>
<tr>
<td></td>
<td>1.1.2.0</td>
<td>1.1.2.0</td>
<td>1.1.2.0</td>
</tr>
<tr>
<td></td>
<td>1.1.3.0</td>
<td>1.1.3.0</td>
<td>1.1.3.0</td>
</tr>
<tr>
<td></td>
<td>1.1.4.0</td>
<td>1.1.4.0</td>
<td>1.1.4.0</td>
</tr>
</tbody>
</table>

### Adding and editing notes

**Entering notes using the computer keyboard**

A quick and easy way to enter notes, without having to decide on the pitch, position and note value first is using the computer keyboard. To enter a note, proceed as follows:

1. On the toolbar, activate the “Computer Keyboard Input” button.
   
   Now you can enter notes using the computer keyboard.

2. Hold down [Alt]/[Option].
   
   A note with the note value specified in the extended toolbar appears. By default, the insert position is the first position of the bar and the pitch is C3. You can however change this using the computer keyboard.

   - You can change the pitch of the note by using the up and down arrow keys.
   - To transpose the note in octave steps, use the Page Up/Page Down keys.

   - To change the insert position of the note, use the right and left arrow keys.

   Note that for position changes, the Quantize value is taken into account.

   - To change the length of the note, hold down [Shift] and use the right and left arrow keys.

   This changes the note value step by step, passing from one Quantize value to the next.

3. To insert the note, press [Return].
   
   The note with the specified pitch and note value is inserted at the selected position and the insert position for the next note changes according to the Quantize value. If you press [Shift]-[Return], the insert position does not change, allowing you to enter chords.
Entering notes with the mouse

To add a note to the score, proceed as follows:

1. Make the staff active.
   Notes are always inserted on the active staff, see “The active staff” on page 559.

2. Select the desired note value.
   See “Selecting a note value for input” on page 575.

3. If you select the note value by clicking on a symbol on the extended toolbar, the Insert Note tool is automatically selected – otherwise select the Insert Note tool on the toolbar or context menu.

4. Select a Quantize value.
   The Quantize value determines the spacing between notes. If you set Quantize to 1/1 you only can add notes at downbeats. If you set Quantize to 1/8, you can add notes at eighth note positions, etc.

5. Click in the staff and keep the mouse button pressed.
   The Insert Note tool changes into a note symbol (showing the note exactly as it would be inserted in the score).

6. Move the mouse horizontally to find the correct position.

7. Move the mouse vertically to find the correct pitch.

   If the “Show Note Info by the Mouse” option is activated in the Preferences dialog (Scores–Editing page), the position and pitch of the note is also shown in a “tooltip” next to the pointer while you are dragging. If you find that screen redraws are too sluggish, you may want to deactivate this option.

8. Release the mouse button.
   The note appears in the score.

   If you activate the “Animate Note Cursor” option in the Preferences dialog (Scores–Editing page), you do not need to keep the mouse button pressed to see the note as it would be inserted in the score.

Adding more notes

1. If you want the next note to have a different length value, select the corresponding note symbol.

2. If you need finer positioning, or if the current value is too fine, change the Quantize value.

3. Move the mouse to the desired position, and click.
   Notes input at the same position are automatically interpreted as chords, see below.

About the interpretation

The notes may not always appear in the score as you initially expect them to. This is because there are a number of situations that require special techniques and settings. Below you can find a list of some of these and where to find more information about handling them:

• Notes at the same position are considered parts of a chord.
  To get independent voicing (for example notes with different stem directions), such as for vocal material, you need to use polyphonic voicing – see “Polyphonic voicing” on page 593.

Without and with polyphonic voicing

• If two notes beginning at the same position have different lengths, the longer is displayed as a number of tied notes. To avoid this, you can either use the “No Overlap” feature (see “No Overlap” on page 590) or polyphonic voicing (see “Polyphonic voicing” on page 593).

• One note is often displayed as two notes with a tie. This is only how the program displays the note, there is still only a single note “stored”.

The same note, without and with Syncopation

• If you want a long note to be displayed as two (or more) tied notes, you can use the Cut Notes tool for this.

• If a note has the wrong accidental, this can be changed. See “Accidentals and enharmonic shift” on page 606 for details.
• If two notes on the same position are too close to each other or if you want their “graphical order” in the score reversed, you can do this without affecting playback, see “Graphic moving of notes” on page 614.
• Stem direction and length is normally automatic, but you can set it yourself, see “Background: Note stems” on page 604.
• If you are scoring for piano and therefore (or for other reasons) need a split staff, there are special techniques for this, see “Split (piano) staves” on page 583 and “Polyphonic voicing” on page 593.

Selecting notes
In the operations described in the rest of this chapter, you often work on selected notes. The text below describes how to select notes:

By clicking
To select a note, click on the note head with the Object Selection tool. The note head turns red to indicate that it is selected.
• To select more notes, hold down [Shift] and click on them.
• If you hold down [Shift] and double-click on a note, this note and all the following notes in the same staff are selected.

Using a selection rectangle
1. Click in an empty area in the score with the Object Selection tool and keep the mouse button pressed.
2. Drag the mouse pointer to create a selection rectangle. You can drag to select notes on several voices or staves if you wish.
3. Release the mouse button.
All notes with note heads inside the rectangle are selected.

If you want to deselect one or more of the notes, hold down [Shift] and click on them.

Using the keyboard
By default, you can step through (and select) the notes in the staff using the left and right arrow keys. If you press [Shift], you can select a series of notes as you step through them.
• If you are working with polyphonic voices, you step through the notes on the current track, i.e. in a split system, you step through the staves.
• If you want to use other keys for selecting notes, you can customize the settings in the Key Commands dialog (in the Navigate category).

Selecting tied notes
Longer notes are often displayed in the score as one note with a tie. If you intend to select the entire note (e.g. for deleting), you should select the first note, not the tied note.

Deselecting everything
To deselect everything, simply click in an empty area of the score with the Object Selection tool.

Selected notes

There is a setting for this in the Preferences dialog (Scores–Editing page): If you activate “Tied notes selected as Single Units”, the whole note is selected, even if you click on one of the tied notes.
Moving notes

In the following, you can find descriptions of the various methods to move notes, as well as related features.

Moving by dragging

Proceed as follows:

1. Set the Quantize value.
   The Quantize value restricts your movement in time. You cannot place notes on positions smaller than the Quantize value (see “Selecting a Quantize value” on page 575).

2. Select the note(s) you want to move.
   You can select notes across several staves if you wish.

3. Click one of the selected notes and drag it to a new position.
   The horizontal movement of the note is “magnetically attracted” to the current Quantize value. The Mouse Time Position and Mouse Note Position displays in the status line show the new position and pitch for the dragged note.

   If the “Show Note Info by the Mouse” option is activated in the Preferences dialog (Scores–Editing page), the position and pitch of the note is also shown in a “tooltip” next to the pointer while you are dragging. If you find that screen redraws are too sluggish, you may want to deactivate this option.

4. Release the mouse button.
   The notes appear at their new position.

   - If you press [Ctrl]/[Command] and drag, movement is restricted to vertical or horizontal (depending on the direction in which you drag).

   - If you move notes vertically and the “Keep moved notes within key” option is activated in the Preferences dialog (Scores–Editing page), the notes are transposed within the current key only.

Moving by using key commands

Instead of dragging the note with the mouse, you can assign key commands for this:

- The corresponding commands can be found in the Nudge category in the Key Commands dialog. They are listed as “Left”, “Right”, “Top”, and “Bottom”.

- When moving notes to the left or right using key commands, the notes are moved in steps according to the Quantize value.
  The keys assigned for up/down nudging transpose notes in semitone steps.

Moving across staves – the Lock button

If you are editing several tracks, you may want to move notes from one staff to another. Proceed as follows:

1. Make the desired Quantize settings and select the notes.
   Make sure to only select notes on the same staff.

2. Make sure that the “L” (Lock) button on the extended toolbar is deactivated.
   When this button is activated, you cannot move notes and other objects from one staff to another, which is handy if you need to transpose a note very high or low, for example.

3. Click on one of the notes and drag them to the new system.
   The active staff rectangle indicates on which staff the dragged note(s) appears.

The Snap mode

The notes you move (or copy) snap to positions defined by the note length and Quantize values. Using the Snap Type pop-up menu on the Score Editor toolbar you can select the Snap mode used when moving or copying notes:

- When using the “Grid” mode, notes you move (or copy) always snap to exact grid positions.
- When using the “Grid Relative” mode, a note with a certain position relative to a grid line always maintains that relative position to the grid when moved (or copied).
Acoustic Feedback

To hear the pitch of the note while moving, activate the speaker icon (Acoustic Feedback) on the toolbar.

About the lock layers

When you are moving and editing notes in the score, you might accidentally move other objects nearby. To avoid this, assign different types of objects to different “lock layers” (up to three) and instruct Cubase to “lock” one or two of these layers, making them unmovable.

There are two ways to set up which type of object should belong to which lock layer:

- Open the Preferences dialog from the File menu and select the Scores–Note Layer page. This page lets you adjust the layer setting for each object type.
- Right-click one of the layer buttons (1-2-3) on the extended toolbar to bring up a pop-up menu, showing which object types are associated with that layer. A checkmark for an object type means it belongs to that layer. If no checkmark is shown, you can select the object type on the menu to move it to that layer.

To lock a layer, click the corresponding layer button, so that it is disabled (not lit). You can only select or move objects whose Layer button is activated. For more detailed information, see “Using the lock layers” on page 628.

Duplicating notes

To duplicate notes in the score, proceed as follows:

1. Set the Quantize value and select the desired notes. You can duplicate any block of notes, even on several systems at the same time. The Snap mode applies, see “The Snap mode” on page 579.
2. Press [Alt]/[Option] and drag the duplicate notes to their new position.
   - If you want to restrict movements to one direction, press [Ctrl]/[Command]. This works just as for moving, as described above.
   - If you want to restrict the pitch to inside the current key only, make sure that the “Keep moved notes within key” option is activated in the Preferences dialog (Scores–Editing page).
3. Release the mouse button to insert the notes.
   - [Alt]/[Option] is the default modifier key for copying/duplicating. If you like, you can change this in the Preferences dialog (Editing–Tool Modifiers page).
   - You can also move or copy whole bars by dragging the bar handles, see “Moving and duplicating with the bar handles” on page 631.

Cut, copy, and paste

- To cut notes, select them and choose Cut from the Edit menu (or use a key command, by default [Ctrl]/[Command]-[X]). The notes are now removed from the score and put on the clipboard.
- To copy notes, select them and choose Copy from the Edit menu (or use a key command, by default [Ctrl]/[Command]-[C]). A copy of the notes is made, and put on the clipboard. The original notes remain where they were.

⚠️ The clipboard can only hold one set of notes. If you cut or copy and then cut or copy again, the notes copied to the clipboard first are lost.
Notes that you have put on the clipboard by cutting or copying can be inserted into the score again as follows:

1. Activate the desired staff.
2. Move the project cursor to the position where you want the first note to appear. This is done by holding down [Alt]/[Option] and [Shift] and clicking at the desired position in the score.
3. Select Paste from the Edit menu (or use a key command, by default [Ctrl]/[Command]-[V]). The notes are pasted in, beginning at the project cursor. If the cut or copied notes come from different staves, they are also inserted on different staves. Otherwise, the notes are inserted on the active staff. They keep the pitch and relative positions they had when you cut or copied them.

**Editing pitches of individual notes**

**By dragging**
The simplest way to edit the pitch of a note is to drag it up or down. Remember to hold down [Ctrl]/[Command] to avoid moving the note sideways as well.

- If the “Keep moved notes within key” option is activated in the Preferences dialog (Scores–Editing page), notes are transposed within the current key only.
- To avoid accidentally moving the note into another staff, activate the Lock button (see “Moving across staves – the Lock button” on page 579).
- When you drag the mouse up and down before releasing the button, accidentals are shown beside the note to indicate the current pitch. This helps you verify the vertical position for the note.

**Using the Transpose Palette**
The Transpose Palette on the toolbar contains buttons for transposing the selected notes up or down in steps of one semitone or one octave.

- To show the Transpose Palette, right-click the toolbar and activate “Transpose Palette” on the context menu.

**Using key commands**
Instead of transposing the note with the mouse, you can assign key commands for this.

- The commands for which you can assign key commands are found in the Nudge category in the Key Commands dialog.
  The commands are listed as “Top” (transpose one semitone up) and “Bottom” (transpose one semitone down).

**Using the info line**
You can use the info line to change the pitches (and other properties) of one or several notes numerically, see “The info line” on page 43.

- If you have several notes selected and change the pitch on the info line, the changes are relative. That is, all selected notes are transposed by an equal amount.
- If you have several notes selected, hold down [Ctrl]/[Command] and change the pitch on the info line, the changes are absolute. That is, all selected notes are set to the same pitch.

**Via MIDI**
Proceed as follows:
1. On the toolbar, activate the MIDI Input button and the Record Pitch button to the right.
2. If you also want to change the note-on and/or note-off velocity of the notes via MIDI, this can be done by also activating the corresponding velocity buttons, as described in the chapter “The MIDI editors” on page 374.
3. To edit notes via MIDI (pitches only), set up the buttons like this.
4. Select the first note that you want to edit.
5. Press a key on your MIDI keyboard. The note takes on the pitch of the key you pressed. The program then selects the next note.
6. To change the pitch of the next selected note, simply press the desired key. In this manner you can change the pitches of as many notes as you wish, by simply pressing the relevant keys. You can also use key commands (by default the left and right arrow key) to pass from one note to the other. For example, if you make a mistake, you can step back to the previous note by pressing the left arrow key.
Changing the length of notes

When it comes to note lengths, the Score Editor is special in that it does not necessarily display the notes with their actual length. Depending on the situation, you may want to change the “physical length” of the notes or the “display length”.

Changing the “physical” length

This changes the actual length of the notes. The change is audible when you play back the music.

⚠️ Remember that the appearance of notes and rests in the score is determined by the Display Quantize settings on the Staff page of the Score Settings dialog. Depending on the Notes and Rests values, notes may be displayed as if they were longer than they really are (see “Display Quantize” on page 553).

By using the extended toolbar

Using the extended toolbar is another quick way to set a number of notes to the same length:

1. Select the notes that you want to change.
2. Hold down [Ctrl]/[Command] and click on one of the note icons on the extended toolbar. All the selected notes now get the note value on which you clicked.

By using the info line

You can also edit length values numerically on the info line. The same rules apply as when changing the pitch of notes (see “Using the info line” on page 581).

Lengthening a note by gluing two notes together

You can create unusual note length values by gluing notes of the same pitch together.

1. Insert the notes that you want to glue together (if they do not already exist).
2. Select the Glue tool on the toolbar or context menu.
3. Click on the first note. This note is now tied to the first following note with the same pitch.

⚠️ Make sure that you have Display Quantize values for notes and rests that allow you to display notes of the created note value.

4. If you want to glue more notes, click again.

By gluing together a quarter note, an eighth note and a sixteenth note…

…you get a double dotted quarter note.

Changing the display length

If you want to change the displayed length of notes without affecting how they play back, the first thing to try is to adjust Display Quantize, either for the whole staff or for a separate section, using the Display Quantize tool (see “Inserting Display Quantize changes” on page 571).

But you can also make display length adjustments to individual notes in the Set Note Info dialog:

1. Double-click on the note. The Set Note Info dialog opens.
2. Locate the “Length” setting. By default, this is set to “Auto”, which means that the note is displayed according to its actual length (and the Display Quantize settings).
3. Double-click in the value field and enter a new length value (displayed in bars, beats, sixteenth notes, and ticks). To set the display length to “Auto” again, scroll the value down to zero.
4. Click Apply and close the dialog. The note is now displayed according to its display length setting. However, the Display Quantize settings still apply!

Splitting a note in two

If you have two notes strung together by a tie, and click on the “tied” note head with the Split tool, the note is divided into two, with the length of the “main” and the tied note, respectively.

Before and after splitting a tied note
Working with the Display Quantize tool

There are instances when you want different staff settings for different sections of the track. The settings on the Staff page of the Score Settings dialog are valid for the entire track, but by using the Display Quantize tool you are able to insert changes and exceptions wherever you like. This is described in detail in the section “Inserting Display Quantize changes” on page 571.

Split (piano) staves

Setting up the split staff

Proceed as follows:
1. Make a staff active.
2. Open the Score Settings dialog on the Staff page and select the Polyphonic tab.
3. From the Staff Mode pop-up menu, select Split.
4. Set the Splitpoint value to a suitable note. All notes below this note value are put on the lower clef, all above are put on the upper clef.
5. Make whatever additional staff settings you need. These apply to both the upper and lower staves of the split system.
6. Click Apply.

Changing the split point

Proceed as follows:
1. Make sure that the system you are working on is active.
2. Open the Score Settings and select the Staff page.
3. Select the Polyphonic tab.
4. Change the Splitpoint value.
5. Click Apply.

Now, some notes that were previously on the lower staff are on the upper, or vice versa.

Strategies: Multiple staves

As described above, when you have parts on several tracks selected in the Project window, these are put on one staff each, when you open the Score Editor. This allows you to work on several staves in parallel.

Working with several staves is not much different from working with one. Below follow some guidelines that apply specifically to working with multiple staves.

Score settings dialog, Staff page

The settings on the Staff page of the Score Settings dialog are local to each staff. You can have the Score Settings dialog open and select each staff in turn to make settings – just remember to click Apply before selecting another staff, otherwise your changes are lost.
If several staves share settings, you can save some time by using staff presets. Set up the staff settings for the first staff, and save them as a preset. This preset can then be applied to any of the other staves, one at a time, see “Working with staff presets” on page 587 for details.

Selecting notes
You can select notes from one or several staves at the same time, using any of the selection methods, see “Selecting notes” on page 578.

Adding notes
This is done just as on a single system, see “Adding and editing notes” on page 576. Please note the following:

- When you enter a note, use the Mouse Note Position display (in the status line) to determine the pitch. Whether it ends up on the upper or lower staff has nothing to do with where you aim with the mouse. The Splitpoint setting always decides if a note goes on the upper or lower staff. If you change the splitpoint, this affects existing notes, see below.

- Sometimes a fixed splitpoint is not good enough. You might want to put two notes with the same pitch on different staves in different parts of the score. To achieve this you need to use polyphonic voicing, see “Polyphonic voicing” on page 593.

- You can add notes to any staff by clicking on it with the Insert Note tool. The active staff rectangle moves to the staff where you input the note.

- If you need to enter a note with a very high or low pitch, which makes it wind up on the wrong staff when you click, first enter a note with the wrong pitch, and then edit its pitch as described in the section “Editing pitches of individual notes” on page 581.

Inserting and editing clefs, keys, or time signatures
It is possible to insert a change of clef, key, or time signature anywhere in the score.

Inserting a symbol on one staff
Proceed as follows:

1. In the Symbols Inspector, open the “Clefs etc.” tab. This contains clef, key, and time signature symbols.

2. Select the symbol that you want to insert. When you move the mouse over the score display, the pointer takes on the form of a pencil (see also “About the Pencil tool” on page 622).

3. Move the mouse over the staff where you want to insert a new symbol. Use the Mouse Time Position display in the status line to find the exact location. The Mouse Note Position, i.e. the vertical position is of no relevance as long as you click somewhere in the staff. Time signature changes can only be inserted at the beginning of a bar.

4. Click the mouse button to insert the symbol.

⚠️ Inserting a symbol at position 1.1.1.0 is the same as changing the staff settings which are stored in the track. Inserting anywhere else adds the change to the part.

Inserting a symbol on all staves
If you hold down [Alt]/[Option] when you insert a symbol with the Pencil tool, it is inserted at this position on all staves currently being edited in the Score Editor.

- Time signature changes are always inserted on all tracks in the score. Or rather, they are inserted on the signature track, which affects all tracks.

- For key changes, Display Transpose is taken into account.

This allows you to set all staves to a new key and the staves set to Display Transpose still show the correct key after the key change.
If some of the staves are bracketed (straight brackets only, as set up in the Score Settings dialog on the Layout page, see “Adding brackets and braces” on page 672), inserting a symbol for one of these staves inserts it for all other staves within the bracket. Staves outside the bracket are not affected.

Editing clefs, keys, and time signatures

If you double-click on a symbol, a dialog appears allowing you to change the settings for it.

If you hold down [Alt]/[Option] when double-clicking, all symbols at the same position are changed accordingly. With key signatures, the Display Transpose value is taken into account as described above.

• In the Score Settings dialog on the Project page (Notation subpage), you can find several options for how clef, key, and time signature changes are displayed. You can also adjust the automatic spacing between these symbols in the Spacings subpage. See the dialog help for details.

Moving clefs

Clefs inserted into the score have an effect on how notes are displayed. If you for example insert a bass clef in the middle of a treble staff, the staff switches to show bass pitches. Therefore it is very important where you insert the clef.

If you want to move the clef graphically, without disturbing the relation between the clef and the notes, proceed as follows:

1. Select the Layout tool on the toolbar or context menu. Note that this tool is available in Page Mode only.

2. Click on the clef and drag it to the desired position. Now the clef is moved, but the score is still interpreted as if it remained in its original position.

When “Warnings for new Clefs at Line Breaks” is activated on the Clef context menu and you inserted a clef change at a line break in the score, the Clef change symbol is inserted in the last bar before the staff break. When this is deactivated, the symbol is inserted in the first bar of the next staff line.

Deleting notes

Using the Erase tool

Proceed as follows:

1. Select the Erase tool on the toolbar or context menu.

2. One at a time, click on the note(s) you want to erase, or enclose them in a selection rectangle, and click on any of the notes.

Using the Delete menu option or the keyboard

Proceed as follows:

1. Select the notes that you want to delete.

2. Select Delete from the Edit menu, or press [Delete] or [Backspace] on the computer keyboard.
5

Staff settings
About this chapter

In this chapter you will learn:

• How to make staff settings.
• How to work with staff presets.

Staff settings

Below follows a run-through of all staff settings, more detailed information about the ones already described and references to other places in the manual for some options.

Making settings

1. Open the Score Settings and select the Staff page.

2. With the dialog open, make the desired staff active. Click anywhere in a staff to make it active, or use the up and down arrow keys to step from staff to staff.

3. Select the desired tab and make all necessary settings. The settings for regular staves are found on the Main and Options tab, the Polyphonic tab contains settings for split systems and polyphonic voices while the Tablature tab lets you set up tablature scores.

4. When you have made the desired settings, click Apply.

• To make settings for another staff, simply make it active in the score (by clicking anywhere in the staff or by using the up/down arrow keys on the computer keyboard).

However, please note that you need to click Apply before making another staff active – otherwise your settings are lost!

⚠ Staff settings can be saved in the track presets. For more information, see the chapter "Working with track presets" on page 331.

Working with staff presets

Making staff settings for your scores can be time-consuming. Staff presets allow you to reuse those settings whenever you work with a staff similar to one you have worked on before. A staff preset contains all the settings from the Staff page of the Score Settings dialog, except for the key.

• To store the current settings (including the settings on the Options tab, see below) click the Store button in the Presets section of the Staff page. Enter a name for the preset in the name dialog that appears, and click OK. The preset is now available on the Presets pop-up menu (in all projects).

• There are a number of staff presets available, set up to suit various instruments, etc. The presets are accessed from the Presets pop-up menu on the Staff page of the Score Settings dialog or from the staff context menu, opened by right-clicking on the blue rectangle to the left of a staff.

Use them as they are, or as starting points for your own settings. Note that this loads the settings in the preset into the dialog – to apply these to a staff you must click the Apply button as usual. You can also apply staff presets directly in the score – see below.

• To remove a preset, select it from the pop-up menu and click the Remove button.

Applying a preset directly in the score

If you right-click on the blue rectangle to the left of a staff, a context menu appears, listing all available presets. Select one to apply it to the staff.
How staff presets are stored

The staff presets are stored as individual files in the Pre-
sets–Staff Presets folder within the Cubase program
folder. The presets are available for selection in any proj-
et you create or edit.

Staff names

These fields allow you to specify a "long" and a "short" name for the staff. The long name is shown for the very
first system for this staff in the score (at the start of the
project), while the short name is shown for the remaining
systems.

• Whether the names are shown at all is set in the Score
Settings dialog, on the Layout page (see "Staff names" on
page 653).

• If you only want the "long name" to be shown (i.e. if you
do not want a name shown for each system in the score),
simply delete the short name.

• If the "Show Long Staff Names on new Pages" option is
activated in the "Staff Names" section of the Score Set-
tings dialog (Project page), the long name is shown at the
beginning of each new page.

• You can also specify two separate subnames by dou-
ble-clicking the staff name and entering them in the upper
and lower text entry fields in the dialog that appears.
Note that this is only displayed correctly, if you are in Page Mode and if
"Show Track Names to Left of staff" is activated in the Score Settings di-
alog, on the Project–Notation Style subpage (Staff Names category).

Key and clef

The basic key and clef settings are described in detail in the
section "Setting clef, key, and time signature" on page
562. There is also a Lower Staff checkbox which is only
used in conjunction with split (piano) staves and poly-
phonic voicing (see "In a split system" on page 564).

• If you want to set a different key symbol, e.g. when scor-
ing for french horn, activate the “Local Keys” option.

Display Quantize and Interpretation
Options

These two sections of the dialog contain a number of set-
tings used to determine how the notes are interpreted.
While these settings are more critical to making MIDI re-
corded music appear as legible as possible it is still impor-
tant to have them set correctly when entering notes using
the mouse. Below you can find descriptions of the set-
tings – for further details, see "Adding Display Quantize
changes" on page 571.

There are “fixed” Display Quantize values plus an “Auto”
option which should only be used when your music con-
tains mixed straight notes and triplets. For background in-
formation about Display Quantize, see “Display Quantize”
on page 553.
Display Quantize values

Notes and Rests
• Generally, the Notes value should be set to a value equal to, or smaller than, the “smallest note position” that you want to be shown in the score.
• The Rests value should be set to a value equal to, or smaller than, the smallest note value (length) you want to be displayed for a single note, positioned on a beat.
• If the score contains only triplets, or mostly triplets, select one of the Triplet options.

Auto Quantize
• If the project contains no triplets or only triplets, deactivate this option.
• If the project contains mixed triplets and straight notes, activate this option (see below).

Deviation and Adapt
• When Deviation is activated, triplets/straight notes are detected even if they are not exactly “on the beat”. However, if you know your triplets/straight notes are perfectly recorded (quantized or entered by hand), deactivate this option.
• When Adapt is activated, the program “guesses” that when one triplet is found, there are probably more triplets surrounding it. Activate this option if not all of your triplets are detected.

If your music only contains “straight” notes or triplets
1. Specify a Notes value.
   For example, if you have notes on odd sixteenth note positions, the Notes value should be set to 16 (sixteenth notes). The “T” values on the pop-up menu are for triplets.
2. Specify a Rests value.
   For example, if you want a single short note on a beat (quarter note position) to be displayed as a quarter note, set the Rests value to 4 (quarter notes).
3. Deactivate the Auto Quantize option.
4. Set all the Interpretation Options.
   These are described in detail below.
5. Examine the score.
6. If necessary, use the Display Quantize tool to insert “exceptions” to the staff settings.
   See “Inserting Display Quantize changes” on page 571.

If your music contains mixed straight notes and triplets
1. Examine the score and decide if it mainly contains triplets or mainly “straight” notes.
2. Set the Notes value accordingly.
   If the score is mainly triplets, select the smallest triplet note position used in the score. If it is mainly straight notes, select the smallest “ordinary” note position.
3. Set the Rests value as described above.
4. Activate the Auto Quantize option.
5. Activate the Deviation and Adapt flags if you need them.

Interpretation Options

Syncopation
Activate Syncopation when the program adds more ties to notes crossing beats and bar lines than you prefer. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relax</td>
<td>When Syncopation is “relaxed”, the program applies syncopation in a number of common cases.</td>
</tr>
<tr>
<td>Full</td>
<td>Syncopation is on.</td>
</tr>
<tr>
<td>Off</td>
<td>Syncopation is off, with no exceptions.</td>
</tr>
</tbody>
</table>
For a “modern” notation of syncopated notes, activate Syncopation.

![Syncopation example](image)

Without and with Syncopation

![Syncopation example](image)

Again, without and with Syncopation

Note that you can insert “exceptions” to the Syncopation setting in the Score Settings dialog on the Staff page, by using the Display Quantize tool. You can also create tied notes in various combinations by using the Cut Notes tool.

**Consolidate Rests**

Activate this when you want small consecutive rests joined into one (an eight note rest and a sixteenth note rest joined to a dotted eighth note rest for example).

![Consolidate Rests example](image)

Consolidate Rests deactivated and activated

**Clean Lengths**

When this option is activated, the program interprets the length of your notes differently. A note’s length (in the display only) might be extended to the beginning of the next note or to the next Rests “position” for Display Quantize. An example:

- If a note is too short, you may get a rest just after it.
- When Clean Lengths is activated, the rest disappears.

![Clean Lengths example](image)

A slightly short eighth note without and with “Clean Lengths”.

If using Clean Lengths does not help in a particular situation, you can manually resize the offending note(s) or use the Display Quantize tool (see “Inserting Display Quantize changes” on page 571).

**No Overlap**

When notes starting at the same position have different lengths, the program tends to add more ties than you may want. This can be avoided by using No Overlap.

![No Overlap example](image)

This recording in the Key Editor...

![No Overlap example](image)

...is displayed like this when No Overlap is deactivated...

![No Overlap example](image)

...and like this when No Overlap is activated.

You can insert “exceptions” to the No Overlap setting on the Staff page of the Score Settings dialog, by using the Display Quantize tool.

⚠️ Please note that there may be situations when neither of these alternatives is ideal. If you run into such a situation, it can probably be resolved by using polyphonic voices, see “Polyphonic voicing” on page 593.

**Shuffle**

In jazz it is very common to score a shuffled beat as straight notes, simply to make it more legible.

When the Shuffle flag is activated, the program searches for eighth note or sixteenth note pairs where the second note is played late (with a “swing feel” or as the third note in a triplet). Such pairs are displayed as regular eighth or sixteenth notes instead of triplet-based figures.

![Shuffle example](image)

Without and with Shuffle

Please note that there may be situations when neither of these alternatives is ideal. If you run into such a situation, it can probably be resolved by using polyphonic voices, see “Polyphonic voicing” on page 593.
Display Transpose

This is used when preparing parts for instruments that are not scored at the actual concert key. For example, if you want the note C3 to be played by an alto sax, you have to score it as an A3 – nine semitones up. Luckily, the Display Transpose setting takes care of this for you:

- Use the pop-up menu to select the instrument for which you are scoring.
- If the pop-up menu does not list your instrument, you can set the desired transposition with the Semitones value field.

The Display Transpose setting does not affect playback or the actual pitch of the notes – it only changes how they are displayed and printed.

You can also insert Display Transpose changes anywhere in the score, by inserting a key change symbol and using the Transpose setting in the Edit Key/Clef dialog (see “Display Transpose in the Edit Key dialog” on page 566).

- In the Score Settings dialog, on the Project page (“Chord Symbols” subpage), deactivate the “Use Display Transpose” option if you do not want the chord symbols to be affected by the Display Transpose setting (see “Chord Symbols” on page 643).
- You can disable Display Transpose by deactivating the “Display Transpose” button on the toolbar of the Score Editor.

For more information, see “Transposing instruments” on page 565.

The Options tab

Clicking the Options tab in the dialog brings up another page with additional settings. Below follows a brief description of these, with references to more detailed explanations.

Switches

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flat Beams</td>
<td>Activate this when you want the beams over notes to be flat (as opposed to slanted), see “Beam appearance and slant settings” on page 612.</td>
</tr>
<tr>
<td>No Beams</td>
<td>Activate this when you do not want any beaming at all on the staff (for example for vocal scoring), see “Turning beaming on/off” on page 608.</td>
</tr>
<tr>
<td>Beam Subgroups</td>
<td>Use this when you want sixteen notes displayed under a beam to be divided into groups of four notes, see “Handling beam groups” on page 611.</td>
</tr>
<tr>
<td>16th Subgroups</td>
<td>Use this when you want even smaller subgroups of sixteenth notes. This setting has no effect if Beam Subgroups is deactivated.</td>
</tr>
</tbody>
</table>

As above, but with 16th Subgroups activated.
System Sizes
This section allows you to set the number of system lines and to control spacing between the lines:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Lines</td>
<td>The number of lines in a system. For regular scoring, this should be set to 5.</td>
</tr>
<tr>
<td>Add Space</td>
<td>Allows you to increase or decrease the space between the lines in a system.</td>
</tr>
<tr>
<td>Size</td>
<td>Allows you to set a size for the systems, as a percentage (with 100% being the default value). In effect, this setting scales the score vertically.</td>
</tr>
</tbody>
</table>

Score Drum Map
These settings are described in the chapter “Scoring for drums” on page 676.

Fixed Stems
Activate this if you want all note stems to end at the same vertical position. This feature is perhaps most often used when scoring for drums (see “Setting up a staff for drum scoring” on page 679).

A drum pattern with Fixed Stem length activated

The Up and Down parameters determine which position (relative to the top of the staff) is used for up and down stems, respectively. The graphical display helps you get your settings right.

Note Limits
Use the Low and High fields to specify a note range. In the active staff, any notes outside this range are displayed in a different color. When writing a score for a specific instrument, this makes it easy to find notes that are outside of this instrument’s note range.

- If the “Hide Notes beyond Limits” option is activated in the Preferences dialog (Scores–Editing page), any notes outside the Note Limits range are hidden.

The Polyphonic tab
This is where you activate and set up split (piano) systems or polyphonic voices (several independent score lines in the same staves). These settings are described in the chapter “Polyphonic voicing” on page 593.

The Tablature tab
This tab contains settings for creating tablature scores. The settings are described in the chapter “Creating tablature” on page 680.
Polyphonic voicing
About this chapter

In this chapter you will learn:
• How to decide when to use polyphonic voicing.
• How to set up voices.
• How to automatically convert your score to polyphonic voicing.
• How to enter and move notes into voices.

Background: Polyphonic voicing

Polyphonic voicing allows you to resolve a number of situations impossible to score properly otherwise:
• Notes starting at the same position, but with different lengths. Without polyphonic voicing you get unnecessary amounts of ties.

Without and with polyphonic voicing

• Vocal scoring and similar. Without polyphonic voicing, all notes starting at the same position are considered parts of a chord. With polyphonic voicing you can give each voice a stem direction, you can have individual rest handling for each voice, etc.

Without and with polyphonic voicing

• Complicated piano systems. Without polyphonic voicing, you have to resort to a fixed split note setting to decide which notes go on which clef. With polyphonic voicing, the splitpoint can be "floating". The program can even automatically put a bass line on the lower clef for you.

How voices are created

Cubase allows for up to eight voices. The first thing you do is to set them up. This includes "telling" the program which voices belong to the upper clef and which belong to the lower, how you want rests displayed for each voice, etc.

The second thing you do is to move or enter notes into the voices. If you have a recording done already, the program can do much of this work for you, automatically. You might then want to fine-tune by moving one or more notes into another voice, or you might want to add notes to a certain voice. See “Adding and editing notes” on page 576 for details.

⚠️ Each voice is polyphonic. In other words, one voice can contain chords.

Overlapping notes

Throughout this chapter you encounter the term "overlapping notes". Two notes are considered overlapping when they are on the same staff and:
• They start at the same position, but have different note values (for example whole note and a quarter note both at the beginning of a bar), or…

Without and with polyphonic voicing

• One note starts before another has ended. For example a half note at the beginning of a bar and an eighth note at the second beat.

A note that starts before another has ended, without and with polyphonic voices.
Voices and MIDI channels

Internally the program organizes the notes into voices by changing their MIDI channel values. Normally you set it up so that notes with MIDI channel 3 belong to voice 3 etc. Most of the time the link between MIDI channels and voices is totally transparent to you as a user. Sometimes you can take advantage of this relationship, as described later in this chapter.

There are also a few important things to note:

วด When you make a note part of a voice, you are in fact changing its MIDI channel value. However, when you change the voice’s MIDI channel values in the setup dialog, this does not affect the notes’ MIDI channel setting. This can lead to serious confusion, since the relationship between the notes and the voices is affected. It might even make notes disappear (the program warns if this happens). In other words, do not change the MIDI channels on the Polyphonic tab of the Staff page in the Score Settings dialog after you have put your notes into voices, unless you are absolutely sure of what you are doing.

วด When you open a part that contains notes on different MIDI channels, these notes are in fact already assigned to voices (since notes are assigned to voices using their MIDI channel setting). While this fact can be put to good use, it can also create confusion, and even disappearing notes, as described above.

Setting up the voices

To set up your score for polyphonic voicing, proceed as follows:

1. Make sure that the desired staff is active.
2. Open the Score Settings dialog and select the Staff page.
3. Select the Polyphonic tab.
4. Pull down the Staff Mode pop-up menu and select Polyphonic. This makes the voice list in the lower part of the dialog available. It consists of eight rows, one for each voice. They are numbered and therefore we refer to them as voices 1 to 8.

Do not confuse the voice numbers with the MIDI channel setting for each voice.

5. To activate a voice, click in its “On” column, so that a checkmark appears.

There are four voices on each staff, for a total of eight. If you activate one “upper” voice and one “lower” voice, you get a split (piano) staff.

6. If you have particular reasons to use specific MIDI channels, change the “Chan” settings for the voices. The program automatically sets each voice to a different MIDI channel. If you do not have good reasons to make changes, leave the settings as they are.

Do not confuse the voice numbers with the MIDI channel setting for each voice.

7. Click in the “Rests–Show” column to decide for which voices you want rests displayed.

A checkmark indicates that rests are shown for a voice. Often you only want rests to be shown for one voice per staff, see below.

8. If you have activated “Rests–Show” for a voice, but do not want rests to be shown in empty bars, click in the “Rests–Reduce” column for that voice.

This is especially useful for cue voices, see “Cue notes” on page 614.

9. Click in the “Rests–Center” column to determine at which vertical positions rests are shown (for voices with “Rests–Show” activated).

When this option is activated for a voice, the rest is put in the vertical center of the staff, when it is not, the rest gets a vertical position based on the pitch of the notes.
10. Decide on a stem direction for each voice, by selecting from the pop-up menu in the Stems column. If you select Auto, the program makes decisions about which stems go in which direction (just as when not using polyphonic voices). You can always force stem direction for individual notes by using the Flip Stem function, see “Flipping the stem of one or several notes” on page 604.

⚠️ There is a special stem feature for voice 1: If you set this to Auto, the stem direction depends on the pitch of the note as usual — except if there are voice 2 notes in the bar, because then the voice 1 stems are automatically set to Up!

11. If you want the notes in a voice to be smaller than regular notes, put a checkmark in the Cue column for the voice.

12. Click Apply.
The staff is changed to polyphonic voicing, and the program distributes the existing notes into voices according to their MIDI channel values.

• At this point you may want to use the Explode function to automatically move notes into the proper voices, see “Automatically – the Explode function” on page 598.

If the “Some Notes Do Not Belong To Voices…” dialog appears

When you click Apply, a warning may appear saying “Some notes do not belong to any voice and may be hidden. Correct these notes?”.

This warning appears when the staff contains notes with MIDI channel settings which do not match any of the active voices.

If you click the “Correct” button, these notes are moved to active voices. If you click “Ignore”, nothing is changed, and some notes are hidden. However, they are not lost, they appear in all other editors and can be made to appear again in the Score Editor if you change the channel settings for the notes or voices, activate more voices, etc.

About the polyphonic presets

The Presets pop-up menu on the Polyphonic tab (below the list of voices) contains three very useful setups. Instead of making settings by hand, you can select one of the presets, saving some time. The presets are:

Variable Split

This sets up the dialog for two voices, one on each staff, each with auto stem direction. This is a good starting point for a piano staff when the fixed split option does not suffice.

Optimize two voices

In this preset, only voices 1 and 2 are activated, and set up like this:

This way the first voice behaves as in single staff mode, but if there are notes in the second voice, the stems of the first one are set to Up.

Optimize four voices

This is like “Optimize Two Voices”, but with two staves. Voices 5 and 6 are activated as well, with the same settings as voices 1 and 2. This is the recommended way to write piano music.
Strategies: How many voices do I need?

Well, it depends…

- If you are scoring for vocals, you simply need one voice per voice, so to speak.
- If you use voices for resolving the problem of overlapping notes (see “Overlapping notes” on page 594), for example when scoring for piano, you need two voices each time two notes overlap. If three notes overlap, you need three voices. In other words you need to check for the “worst case” (largest number of overlapping notes at a certain position) and activate that many. If you do not know how many notes you need when starting out to prepare a score, do not worry, you can add more voices later.
- Voices 1 and 2 on the upper staff and 5 and 6 on the lower are special. These handle “collisions” (notes with small intervals, accidentals that otherwise would come too close, etc.) automatically which the other voices do not. Always use these voices first!

An example: in the situation below, three voices are required. The lowest note overlaps both the “melody” and the chords, so it cannot share a voice with the chords. The chords overlap the melody, so they cannot share a voice either.

![Example notation]

Entering notes into voices

When you add new notes, you need to decide which voice they go into:

1. Make sure that the extended toolbar is visible.
2. Select the Object Selection tool.
3. If you have a split system, check the voice Insert buttons.

These are displayed after the text “Insert” on the left side on the extended toolbar. Only the voices that are activated on the Polyphonic tab are shown. If the upper staff is active, the voice Insert buttons are numbered 1, 2, etc., otherwise they are numbered 5, 6, etc.

4. If you need to switch the voice icons to the right “clef”, click somewhere in the system you want to insert notes in.
5. Select one of the voices by clicking on the corresponding button. Any notes you enter from now on are inserted into that voice.

![Voice activated for insertion]

6. Insert the notes as usual, see “Adding and editing notes” on page 576.
7. To switch to another voice, click the corresponding button.
8. To insert notes into a voice on the other clef, click on that clef and then select a voice using the buttons.

Symbols and voices

Later in this manual you will learn about symbols that can be added to the score. Many of these symbols must also be put into a particular voice, see “Important! – Symbols, staves, and voices” on page 621.

Checking which voice a note belongs to

When you select one single note, the corresponding voice button on the extended toolbar is selected. This allows you to quickly find out which voice a certain note is in (after you have used the Move To Voice function, for example).

- When you step through the notes using the arrow keys, you only step through the notes in one voice at a time. This can be used as a quick way to check which notes belong to the same voice as some other note.
Moving notes between voices

Manually
To manually move notes to another voice, proceed as follows:

1. Select the note(s) you want to move to a particular voice.
2. Right-click on one of the notes and select “Move to Voice” from the context menu.
3. On the submenu, select the voice to which you want to move the notes.
   Only the activated voices are available on the menu.
   • You can also press [Ctrl]/[Command] and click a voice Insert button on the extended toolbar to move the selected notes to the corresponding voice.
   You can also assign key commands for this in the Score Functions category of the Key Commands dialog on the File menu.

Automatically – the Explode function
The Explode function distributes notes, either onto new tracks (see “The Explode function” on page 572) or into polyphonic voices:

1. Pull down the Scores menu and select “Explode” from the Functions submenu.
2. Make sure that “To Polyphonic Voices” is selected at the top of the dialog.
3. Use the options in the lower half of the dialog to set up the criteria for the split.
   Choose from the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split Note</td>
<td>Use this to move all notes below a certain pitch to another voice.</td>
</tr>
<tr>
<td>Lines To Tracks</td>
<td>Use this when you want all musical “lines” to be put in one voice each. The notes with the highest pitch goes to the first voice, the notes with the second highest pitch goes to the second, and so on.</td>
</tr>
<tr>
<td>Bass To Lowest Voice</td>
<td>When this is activated, the lowest notes always ends up in the lowest voice.</td>
</tr>
</tbody>
</table>

4. Click OK.
   The notes are distributed to different voices.
Alternative ways of handling voices

Below we suggest further “advanced” ways of putting notes into voices. This is based on the relation between voices and MIDI channels, so please make sure that you understand how this connection works.

• Cubase only: You can use the Logical Editor (see the chapter “The Logical Editor, Transformer, and Input Transformer” on page 440) to put notes into voices, based on other more complex criteria, like for example their pitch and length. This is done by setting up the Logical Editor so that the notes that meet the criteria get their MIDI channel changed to that of their voice.

• When you enter notes using step input you can change the MIDI channel on your input device and directly enter notes into separate voices.

• You can play back each voice on a different MIDI channel, simply by setting the track to Any. This can be used as a convenient way of “proof-hearing” each voice separately.

• You can use the Input Transformer to assign a certain key range to a MIDI channel, and thereby automatically put notes into voices when recording.

• For brass and vocals, you might record each voice on its own track, and use the “Merge All Staves” function to automatically copy each recording to a separate voice on a new track (see “Automatic polyphonic voicing – Merge All Staves” on page 601).

• When you have assigned parts to voices, you can use the Extract Voices function to create one track out of each voice (see “Converting voices to tracks – Extract Voices” on page 602).

Handling rests

With polyphonic voices, you often get more rest symbols than desired.

• If a voice does not need any rests at all, you can deactivate rests separately for this voice on the Polyphonic tab of the Staff page in the Score Settings dialog.

• If you only need rests from one voice on a staff, activate Rests–Center for that voice (this is done in the same dialog). If two or more voices have rests, deactivate Rests–Center. The program then automatically makes sure the rests do not “collide” in the score, by adjusting their vertical position.

• To avoid having several rests displayed in empty bars, you can activate the Rests–Reduce option for all voices (that have rests) except one. This option causes the program to hide rests in empty bars.

• You can use the Hide feature (see “Hiding/showing objects” on page 665) to totally remove individual superfluous rests from the score.

• You can use the Object Selection tool to manually move rests up/down or sideways to adjust the “picture”.

• If needed you can add “rest symbols” (rests that do not affect the playback data in any way) by using the symbols.

Voices and Display Quantize

When you insert Display Quantize changes (see “Inserting Display Quantize changes” on page 571), you can either apply the settings to all voices (by [Alt]/[Option]-clicking with the tool) or to the current voice only.

⚠️ If “Display Quantize tool affects all Voices” is activated in the Score Settings dialog on the Project–Notation Style subpage (Miscellaneous category), the Display Quantize settings always affects all voices (even if you do not press [Alt]/[Option] and click).

Making Display Quantize settings for one single voice allows you to do two things:

• Make each voice have its own Display Quantize settings by inserting a Display Quantize event for each voice, at the beginning of the staff. This is valid for the entire staff, until another Display Quantize event is inserted.

• Insert Display Quantize “exceptions” anywhere in the score, independently for each voice.

Proceed as follows:

1. Make sure that the “Display Quantize tool affects all Voices” option is deactivated.

2. Select the voice for which you want to insert a Display Quantize event.

   This is done by clicking at the corresponding voice button on the extended toolbar as described above, or by selecting a note that belongs to this voice.
3. Select the Display Quantize tool.
4. Click at the position at which you want to insert the event. The Display Quantize dialog appears.
5. Fill out the dialog as described in the section “Display Quantize and Interpretation Options” on page 588.
6. Click Apply.

Creating crossed voicings

Often, for example in vocal scoring, you have crossed voicings on one system. You can of course move notes manually into voices to get the stem direction and other note properties right, but there is a quicker way. Let’s explain how to do this by example. Without using polyphonic voicing, you have entered this:

1. Open the Score Settings dialog on the Staff page and select the Polyphonic tab.
2. From the Staff Mode pop-up menu, select Polyphonic.
3. Activate voice 1 and 2 only, and make settings for them as in the picture below.

4. Click Apply.
   The staff is in Polyphonic staff mode, but all notes are still in the same voice.
5. Pull down the Scores menu and select “Explode” from the Functions submenu.
6. In the dialog that appears, select the “To Polyphonic Voices” option and activate “Lines To Tracks”. Leave the other options off.
7. Click OK.
   The notes have now been split in two “lines”, each in a separate voice.
8. Select the two notes that you want to be moved from voice 1 to voice 2.

   Two notes in voice 1 selected.
9. Move the notes to voice 2.
   The quickest way to do this is to press [Ctrl]/[Command] and click the voice Insert [2] button on the extended toolbar.

   Two notes moved to the right voice.
10. Select the two notes that you want to be moved to voice 1 and move them, too.

All notes in the right voices.

The voicing is now correct, as you can tell from the stem directions. However, there is still some work to do on the notes graphical positions (see “Graphic moving of notes” on page 614) and the display of stems and beams for some of the notes (see “Manual adjustment of beams” on page 612). When you have made those adjustments, the score may look like this:

After making graphical adjustments.

**Automatic polyphonic voicing – Merge All Staves**

If you have already created some tracks which look and play back as they should, and you want to combine these into one track with polyphonic voices, there is a special function on the Scores menu for this:

1. Open the tracks (up to four) in the Score Editor.
2. Pull down the Scores menu and select “Merge All Staves” from the Functions submenu.

Now a new track is created and shown in the score. The track has polyphonic voices activated, and the four original tracks are assigned to one voice each (voices 1, 2, 5 and 6 are used).

Before...

…and after merging the staves

Furthermore, all non-linked symbols that belong to the staff that become the first polyphonic voice in the merged staff are copied. They have the same positions as the original symbols.

⚠️ When you later play back the music, you need to mute the four original tracks, or you get double notes.
Converting voices to tracks – Extract Voices

This function does the opposite of “Merge All Staves” – it extracts polyphonic voices from an existing track and creates new tracks, one for each voice. Proceed as follows:

1. Open a track containing 2 to 8 polyphonic voices in the Score Editor.
2. Pull down the Scores menu and select “Extract Voices” from the Functions submenu.

A number of new tracks is created and added to the display of the Score Editor. Each track contains the music from one polyphonic voice. If there were non-linked symbols in the original track, each new track gets a copy of these symbols.

⚠️ When you later play back the music, you need to mute the original track (the one with polyphonic voices), or you get double notes.
About this chapter

In this chapter you will learn:

• How to control stem direction.
• How to control beaming, and create cross-staff beaming.
• How to make detailed adjustments to note appearance.
• How to perform "graphic moving" of notes.
• How to create grace notes.
• How to create tuplets.

Background: Note stems

The direction of stems is governed by five things:

• How notes are grouped under beams.
• Any manual manipulation of beams.
• The Flip Stems function.
• How the note information is set for each note.
• How the Polyphonic tab on the Staff page of the Score Settings dialog is set up (if you use polyphonic voices).

The order of this list corresponds to the priority of the settings, i.e. on conflict, the grouping under beams has the highest priority and the settings made on the Polyphonic tab the lowest.

⚠️ If you have edited the stem length of a note and then flip it, the stem is reset to default length.

⚠️ If you have activated the “Fixed Stems” option on the Staff page of the Score Settings dialog (Options tab, see “Fixed Stems” on page 592), a lot of the automatic stem length settings are ignored. However, you can still edit the stem length and direction of individual notes.

Setting stem direction

In polyphonic voices

In the Score Settings dialog, on the Staff page (Polyphonic tab), the stem direction can be set separately for each voice.

Using Flip Stems

Flipping the stem of one or several notes

1. Select the notes.
2. Click the Flip icon on the extended toolbar.

All the stems in the selection are now flipped. Those that pointed up now point down and vice versa.

• You can also assign a key command for this.
In the Key Commands dialog on the File menu, the command is called “Flip” and is found in the Score Functions category.
• You can also right-click a note or a selection of notes and select the Flip option from the context menu.

Flipping the stems of notes grouped under a beam

1. Select any note in the group.
2. Invoke Flip as described above.

The entire group is now flipped.

⚠️ This does not work if you have adjusted the slanting of the beam by dragging. If you have, you must first reset the beam as described in the section “Stem length” on page 605.
Independent stem direction under a beam

If you need stems attached to the same beam to go in different directions, this is achieved by dragging the beam's start and end points, as described in the section “Manual adjustment of beams” on page 612. This feature is available in Page Mode only.

Stem length

Adjusting stem length (Page Mode)

1. Click on the end of the stem so that a handle appears.

The stem handle is selected.

2. If you want to change the lengths of several stems at the same time, hold down [Shift] and select these stems as well.

3. Drag the stem handle (on one of the selected stems) up or down.

All selected stems are lengthened or shortened by the same amount.

Resetting stem length and beam slants

1. Make sure that the filter bar is visible.

If the filter bar is not visible, click the “Set up Window Layout” button on the toolbar and select the Filters option.

2. Make sure that the “Stems/Beams” checkbox is activated on the filter bar.

Now, below the notes where stems have been changed or beam slant adjusted manually, the word “Stem” appears.

3. Click on the “Stem” text to select it.

4. Press [Backspace] or [Delete] to remove it.

Before and after deleting the “Stem” item.
Accidentals and enharmonic shift

Making global settings

In the Score Settings dialog, on the Project page (Accidentals subpage), you can find a number of options for how accidentals are displayed in the score. Once set, these are valid for all tracks in the project. Proceed as follows:

1. Open the Score Settings dialog on the Project page and select the Accidentals subpage from the list displayed on the left.

Now, you have the following possibilities:

- Activate the “Courtesy Acc Distance” option and enter a value in the bars field. This determines after how many measures courtesy accidentals are shown. If you set this to “0”, notes outside the scale get accidentals and no courtesy accidentals are shown.
- Activate one of the following options by clicking on the graphics:

  
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Force</td>
<td>Notes outside the scale get accidentals and accidentals are repeated even within the same bar.</td>
</tr>
<tr>
<td>Force all</td>
<td>Every single note in the score gets an accidental.</td>
</tr>
</tbody>
</table>

2. With the radio buttons to the right, you can decide how five of the most common intervals outside the scale are displayed, as sharps or as flats.

   ![Option](image)

   ![Option](image)

   ![Option](image)

3. If you want the enharmonic shift to be repeated in the whole bar, activate the “Enharmonic shift for entire bar” option in the Score Settings dialog (Project–Accidentals subpage).

Enharmonic shift

If one or several notes are not displayed with the accidentals that you want, you can perform an Enharmonic Shift operation on them.

1. Select the notes to be shifted.
2. Click the desired option on the extended toolbar.

   ![Option](image)

Changing the note head shape

1. Select the notes for which you want to change the note head shape.
2. Open the Set Note Info dialog.
3. Pull down the “Note Head” pop-up menu in the top left corner of the dialog.

   ![Option](image)
4. Select one of the note heads.
5. Click Apply.
The settings are applied to the selected notes.
6. If you like, select other notes and make settings for them.
7. When you are done, close the dialog.

**Other note details**
Each note has a number of settings in the Set Note Info dialog.

The Set Note Info dialog contains the following settings:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note Head</td>
<td>Used for selecting custom note head shapes (see &quot;Changing the note head shape&quot; on page 606).</td>
</tr>
<tr>
<td>Tablature on/off and number</td>
<td>Used for creating or editing tablature (see &quot;Creating tablature&quot; on page 880). This feature can be used for individual notes or together with the automatic tablature function.</td>
</tr>
<tr>
<td>Bows pop-up menu</td>
<td>Used for adding bow up/bow down articulation. When selecting &quot;Off&quot;, bow symbols are not displayed for the selected notes.</td>
</tr>
<tr>
<td>Display Length</td>
<td>This allows you to change the displayed length of notes, without affecting playback. Note that the display quantize settings still apply (see &quot;Display Quantize values&quot; on page 589). To reset this value to &quot;Auto&quot; (so that notes are displayed according to their actual length), scroll the value down to zero.</td>
</tr>
<tr>
<td>Accidental Distance</td>
<td>Use this to specify how far from the note, horizontally, you want the accidental. The higher the number the greater the distance.</td>
</tr>
<tr>
<td>No Ledger Lines</td>
<td>Turns off ledger lines for notes with high or low pitches.</td>
</tr>
<tr>
<td>No Stem</td>
<td>Hides the note stem completely.</td>
</tr>
<tr>
<td>No Flag/Beam</td>
<td>Activate this to hide the flags or beams of the selected notes.</td>
</tr>
<tr>
<td>Bracket Head</td>
<td>When this is activated, notes are displayed with brackets:</td>
</tr>
<tr>
<td>X Stem (Spoken)</td>
<td>When this option is activated for a note, it is displayed with an x across its stem. This is normally used to indicate spoken words.</td>
</tr>
<tr>
<td>Hide Note</td>
<td>Activating this checkbox hides the selected notes.</td>
</tr>
<tr>
<td>Stem pop-up menu</td>
<td>Determines the stem direction, see &quot;Using Flip Stems&quot; on page 604.</td>
</tr>
<tr>
<td>Tie pop-up menu</td>
<td>Determines the direction of ties. When this is set to &quot;Auto&quot;, the program chooses a tie direction depending on the stem direction of the tied notes.</td>
</tr>
<tr>
<td>Type pop-up menu</td>
<td>Determines the note type. There are four options:</td>
</tr>
<tr>
<td></td>
<td>– Normal. This is how notes usually are displayed.</td>
</tr>
<tr>
<td></td>
<td>– Grace. When this is selected, notes are displayed as grace notes. This is described in detail on &quot;Grace notes&quot; on page 615.</td>
</tr>
<tr>
<td></td>
<td>– Cue. When this is selected, notes are displayed as cue notes (smaller notes, often used as &quot;guide notes&quot; or optional lines). See &quot;Cue notes&quot; on page 614 for details.</td>
</tr>
<tr>
<td></td>
<td>– Graphic. These are special notes, useful for example for guitar notation (pull-offs) and trills (as &quot;help notes&quot;, indicating which notes to trill between). In both these cases the &quot;No Stems&quot; option could be useful. Graphic notes are not included in the &quot;automated cutting&quot; (see &quot;The Cut Notes tool&quot; on page 613). They are positioned after the notes they &quot;belong to&quot; (as opposed to grace notes).</td>
</tr>
<tr>
<td>Crossed</td>
<td>Activate this option, when you want the stem to be crossed by a slanted line (to indicate that the note is a grace note).</td>
</tr>
<tr>
<td>Grace note options</td>
<td>These options are available when Grace is selected on the Type pop-up menu, see &quot;Grace notes&quot; on page 615.</td>
</tr>
</tbody>
</table>
Coloring notes

You can assign colors to notes using the Event Colors pop-up menu on the toolbar. Proceed as follows:

1. Simply select the notes for which you want to use colors, open the Event Colors pop-up menu on the toolbar and pick a color.
   Only the note heads are colored. Note that the color is only visible once the notes have been deselected.
2. On the far right in the Score Editor toolbar you can find the Hide Colors button.
   If you assigned colors to some or all of the notes in your score, this button allows you to switch between display of colored or uncolored notes. This may help you to find selected notes among other colored notes.

If the Preferences dialog (Scores–Colors for Additional Meanings page) you can specify different colors for elements in the score in order to indicate that they are “special” in any way. You can for example choose a color for a “Moved Graphic” or a “Moved Slur”. These objects are colored accordingly when they are moved from their default positions (see “Moving note symbols” on page 632).

1. Open the Preferences dialog (Scores–Use Colors for Additional Meanings).
2. Click in the Active column to activate this function for the corresponding element.
3. Click in the Color field to the right to select a color.

When color-printing a score, you get the colors you selected for the notes. When you are using a black-and-white printer, the notes appear in black (notes that have not been assigned a color) and different shades of gray (depending on how bright/dark a color was used for the note).

Copying settings between notes

If you have made various settings in the Set Note Info dialog for a note, and want to use these settings for other notes as well, there is an easy way to do this:

1. Set up the first note as desired.
   This includes the settings in the Set Note Info dialog, but also any note-related symbols (such as accents, staccato, articulation, etc. – see “Adding note symbols” on page 622).
2. In the score, select the note and select “Copy” from the Edit menu.
3. Select the notes to which you want to copy the attributes.
4. Right-click the notes to which you want to copy the attributes, and select “Paste Note Attributes” from the context menu.
   The selected notes now get the attributes of the first, copied note, but their pitches and note values remain unchanged.

Handling beaming

**Turning beaming on/off**

Beaming is enabled/disabled independently for each staff.

1. Click the Options tab.
2. To turn off beaming, activate No Beams and click Apply.
   Even if beaming is deactivated for the staff, you can put some notes under beams, as described below.

**Grouping**

When beaming is on, the program automatically groups notes under beams. However, there are a number of ways to determine how notes are grouped.

**Using the Edit Time Signature dialog**

The time signature for the score naturally affects grouping. But you can control this yourself by creating a composite time signature used only for grouping:

1. Open the Edit Time Signature dialog by double-clicking the time signature symbol for the staff.
2. Set up the numerator with the grouping you desire.
   If you for example want eighth notes in two groups of three and one group of two, enter 3+3+2.
3. Set the denominator, if necessary.

4. Activate “For Grouping Only”.

5. Click OK.

⚠️ Note that the “For Grouping Only” setting only affects the way the numerator is divided. Any changes you make to the “sum” of the numerator number or the denominator result in a change of actual time signature in the project. If you need a grouping which cannot be entered in the current time signature, you have to group notes manually, see below.

**Regular grouping of a number of eighth notes or smaller ("Beam")**

If the grouping the program assigns is not the one you want, you can put any selection of eighth notes or smaller under a beam:

1. Select at least two notes, where you want the beam to begin and end. All notes between these two notes are grouped under a beam.

2. Click the Group Notes icon on the extended toolbar or right-click on one of the notes to be grouped and select “Beam” from the “Group/Ungroup” submenu of the context menu.

Before and after grouping

• Double-clicking on the “Grouping” text opens the Grouping dialog, allowing you to adjust the “note value” for the symbols.

**Grouping quarter notes or larger under a beam ("Brillenbass")**

It is also possible to use the grouping feature for notes that are not displayed with beams (quarter notes, half notes, etc.). The result are so called “Brillenbass” symbols, commonly used for indicating repeated accompaniment patterns, etc.

• Double-clicking on the “Grouping” text opens the Grouping dialog, allowing you to adjust the “note value” for the symbols.

**Grouping notes using Repeats**

To show Repeats for the grouped notes, proceed as follows:

1. Make sure that the filter bar is visible in the Score Editor. If the filter bar is not visible, click the “Set up Window Layouts” button on the toolbar and select the Filters option.

2. Activate the “Grouping” checkbox in the filter bar. Now, you see the text “Grouping” below all groups you have created.

3. Select the desired notes.

4. Right-click on one of the notes and from the Group/Ungroup submenu, select “Repeat…”.

5. In the dialog that appears, use the radio buttons to select the desired note value for the repeats.

In this example, the “Repeat” feature is used to display two pairs of sixteenth notes as two eighth notes with “repeat bars”. Note that the second and fourth sixteenth note have only been hidden — playback is not affected!

6. Click OK to close the dialog.

⚠️ Note that the “For Grouping Only” setting only affects the way the numerator is divided. Any changes you make to the “sum” of the numerator number or the denominator result in a change of actual time signature in the project. If you need a grouping which cannot be entered in the current time signature, you have to group notes manually, see below.
Double-clicking on the “Grouping” text opens the Grouping dialog, allowing you to adjust the “note value” for the symbols.

Creating an accelerando/ritardando
To create an accelerando/ritardando, proceed as follows:

1. Select the notes as described above and select “Accelerando” from the Group/Ungroup submenu. A dialog appears.

2. Use the radio buttons to select the desired combination (i.e. define whether you want an accelerando or a ritardando and specify the desired note values) and click OK to close the dialog.

Example for accelerando (left) and ritardando (right)

Removing groups
If you have created a group as described above and want to remove it, proceed as follows:

1. Make sure that the “Grouping” checkbox is activated in the display filter bar.
2. Select a group by clicking on its “Grouping” text.
3. Press [Backspace] or [Delete].

Removing a note from a group
There is no dedicated “ungroup” command, simply because it is not needed. A group can consist of one note if you wish. In other words…

• To remove one note at the end of a group, select it and proceed with grouping as above.
• If you select notes in the middle of a beam and then group, three groups are created.

Before and after grouping
Automatic grouping
The program can also go through the selected notes and automatically create grouping for you, where it is deemed suitable. Proceed as follows:

1. Select the notes that you want checked for auto-grouping.
   Typically, you would select all notes on the track by using the Select All command on the Edit menu.

2. Right-click on one of the notes and select “Auto Group Notes” from the context menu.
   In 4/4 you get for example two groups of eighth notes per bar, in 3/4 you get one group per bar, etc.

Cross-staff beaming
To create a beam that extends from one staff to another, proceed as follows:

1. Set up a split or polyphonic voicing system or open the Score Editor with more than one track.

2. Set up a beam of notes (using the group command) and adjust their pitches so that they are correct even though some of the notes are on the wrong staff. Use the info line to edit the pitches if they are very low or high.

3. Select the notes that should appear on the other staff.

4. Select “Display in Staff” from the context menu for a selected note and select a staff from the submenu.

5. If needed, adjust the beam appearance (see “Manual adjustment of beams” on page 612).

Handling beam groups
There are two settings for groups under a beam, Beam Subgroups and 16th Subgroups, both found on the Options tab on the Staff page of the Score Settings dialog. If “Beam Subgroups” is activated, the program displays subgroups after four sixteenths notes under a beam. If you also activate “16th Subgroups”, subgroups appear after only two sixteenths.
Beam appearance and slant settings

Global settings

In the Score Settings dialog, on the Project page (Notation Style subpage), you can find the following three options for beam appearance in the Beams category:

- **Thick Beams.**
  Activate this if you want beams to be displayed as thick lines.

- **Show Small Slants as Flat Beams.**
  When this is activated, beams that would be only slightly slanted are displayed flat.

- **Slanted Beams only Slightly Slanted.**
  Activate this if you only want a slightly slanted beam even though there might be a significant pitch difference between the notes under the beam.

![Images of beams with different settings]

Without and with “Show Small Slants as Flat Beams”

Without and with “Slanted Beams only Slightly Slanted”

⚠️ These settings are global for all staves.

Staff settings

In the Score Settings dialog, on the Options tab of the Staff page, you can find a couple of settings for beams as well:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flat Beams</td>
<td>Activate this when you do not want any slant at all, no matter the pitch difference of the notes under the beams.</td>
</tr>
<tr>
<td>No Beams</td>
<td>Activate this when you do not want any beams at all.</td>
</tr>
</tbody>
</table>

![Images of beams with different settings]

Manual adjustment of beams

For very detailed control you can manually adjust the beam slant:

1. Group and flip notes and adjust the settings described above until the beams are as close as possible to how you want them.
2. Click on the corner made up by the beam and the stem.
   A handle appears on the corner of beam and stem.

![Images of beams with different settings]

A beam handle

3. Drag the handle up or down.
   The slant of the beam changes.

![Images of beams with different settings]

Dragging a handle and the effect it has.

⚠️ You can adjust the distance between notes and their beam without changing the beam slant. Select both handles of a beam (by pressing the [Shift] key while selecting the second handle) and drag one of the handles up or down.

Mixed stem direction

By dragging the beam handles you can put the beam between the note heads:

![Images of beams with different settings]

Putting the beam between the notes.

About tied notes

Sometimes, notes are displayed as two or more notes tied together. Generally, there are three different occasions when this happens:

- When a note is of an “uneven” length that cannot be displayed without tying together two or more notes of different note values.
- When a note crosses a bar line.
- When a note crosses a “group line” within a bar.
The last case requires some explanation: Cubase uses a "cutting mechanism" that automatically creates tied notes depending on the length and position of the notes. For example, a quarter note is cut in two and tied if it crosses a half note beat, and an eighth note is cut in two and tied if it crosses a quarter note beat:

However, this is not always what you want. There are three ways to affect the cutting mechanism:

**Syncopation**

When the Syncopation option is activated on the Main tab of the Staff page in the Score Settings dialog, Cubase is less prone to cut and tie notes. For example, the second quarter note in the figure above would not have been cut if syncopation had been activated.

The Syncopation setting affects the whole track, but you can also make syncopation settings for separate sections in the score, by inserting display quantize events (see "Inserting Display Quantize changes" on page 571).

**Time signature changes**

By inserting time signature changes, you can change the way notes are cut. This is done in the same way as when you specify how beamed notes are grouped – see “Grouping” on page 608.

The **Cut Notes tool**

By using the Cut Notes tool, you can disable the automatic cutting mechanism in a bar, and insert manual cuts at any given position in the score.

---

Proceed as follows:

1. Select the Cut Notes tool.

2. Select a suitable quantize value from the “Quantize Presets” pop-up menu. As usual, this determines where you can click.

3. When you are using polyphonic voices, select the voice you want to make settings for.

4. Click in the bar containing the notes that you want to cut manually, at the position you want them cut. This inserts a cutflag event in the bar at the position you clicked. If you hold down [Alt]/[Option], a cutflag event is inserted for all voices in a polyphonic staff.

As a result, the regular cutting mechanism is disabled and the note is cut at the position you clicked instead.

The following rules apply to cutflag events:

- If a bar contains a cutflag event, the automatic cutting mechanism is disabled within that bar.
- All notes or rests that start before and end after a cutflag event are cut at the position of the event.
- To display cutflag events, make sure that “Cutflag” is activated on the filter bar.
- To remove a cutflag event, either click again with the Cut Notes tool at the same position, or select it and press [Backspace] or [Delete].
Other options for tied notes

Tie direction
As described in the section “Tie pop-up menu” on page 607, you can set the direction of the tie manually in the Set Note Info dialog.

Flat ties
If you prefer ties to be displayed as flat lines, rather than regular “curved” ties, activate the “Flat Ties” option in the Project–Notation Style sub-page (H.W. Henze Style category).

Graphic moving of notes
There might be instances where the “graphical” order of the notes is not the one you want. In this case, you can move notes without affecting the score or playback in any way. This can be done with the Layout tool or using your computer keyboard.

By using the Layout tool
1. Select the Layout tool in the Score Editor toolbar.
2. Click again on the tool button to open the Mode pop-up menu and select the desired option.

The following modes are available:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Single Object</td>
<td>In this mode, only the object you move with the Layout tool is affected (moved). Use this if you want to “correct” the position of one single note in the score, for example.</td>
</tr>
<tr>
<td>Move Notes and Context</td>
<td>In this mode, other score objects are moved accordingly when you move a note with the Layout tool. Use this mode if you want to correct the display of all score objects within a bar rather than modifying single note positions.</td>
</tr>
</tbody>
</table>

3. Click on the note and drag it to the desired position. Note that movement is restricted to horizontally only.

➔ You can also automatically select all notes making up a chord, by holding down [Alt]/[Option] and clicking on one of the notes with the Layout tool.

By using the computer keyboard
You can assign key commands for moving objects graphically. In the Key Commands dialog on the File menu, the commands are found under the Nudge category and called Graphical Left, Right, Bottom and Top (only the Graphical Left and Right commands apply to notes).

After assigning key commands, you select the notes that you want to move and press the assigned keys to adjust their graphical position.

Cue notes
You can create cue notes by using voices or by converting individual notes into cue notes.

Setting a voice to display cue notes
1. Open the Score Settings dialog on the Staff page and select the Polyphonic tab. This is described in the section “Setting up the voices” on page 595.
2. Click in the “Cue” column for the voice, so that a checkmark appears.
3. Decide how to handle rests for the voice. You might for example leave “Rests–Show” activated and activate “Reduce”. If you do, you get rests in this voice, but not as many as otherwise. Empty bars, for example, do not have any rests at all.

4. Close the dialog.
5. Move the notes into the cue voice. Polyphonic voicing is described in detail on “Polyphonic voicing” on page 593.

An example of a cue note voice
A quick example
Let’s say you have a flute part and want some cue notes for it:
1. Switch on polyphonic voices and activate voice 1 and voice 2.
2. Set voice 2 to “Auto” stem direction and centered rests.
3. Set up voice 1 to be a cue voice, with hidden rests and stems pointing up.
4. Insert the cue notes into voice 1.

Turning individual notes into cue notes
1. Select one or several notes.
2. Double-click one of the notes. The Set Note Info dialog appears. You can also click the “i” button on the extended toolbar, or right-click on a note head and select “Properties” from the context menu to open this dialog.
3. Select Cue from the Type pop-up menu.
4. Click Apply. The settings are applied to the selected notes.
5. Close the dialog.

Creating grace notes manually
1. Locate the note for which you want a grace note.
2. Insert one or more new notes just before it. The note value and exact position of the note is not important. However, the pitch of course is.

From here on there are two ways to go:
- Select the notes and open the Set Note Info dialog, either by double-clicking on one of the note heads or by clicking the “i” icon on the extended toolbar. In the dialog, select the Grace note type.
- Right-click on one of the notes and select “Convert to Grace Note” from the context menu. This turns the note into a grace note without opening any dialog.

Grace notes and beaming
If two grace notes are at exactly the same position (the same tick), they are put onto the same stem, as a chord. If multiple grace notes in front of the same note are put on different positions (even if they are only one tick apart), they are grouped under a beam.

It is possible to have beamed grace notes overlapping a beam of regular notes, as in the example below:

Grace notes in the middle of a group of regular notes

Editing a grace note
1. Select one or several grace notes and open the Set Note Info dialog.
2. Select a note value for the stem.
3. Activate Crossed, if needed. When this is activated, the stem is crossed by a slanted line, to further indicate that the note is a grace note.

Grace notes
You can turn any note into a grace note. Grace notes are considered to be notes without lengths. This means that once a note is turned into a grace note it does not affect the rest of the score display in any way.

Before and after converting to grace notes. Note that after the conversion, the grace notes no longer “interfere” with the interpretation of the other notes.

Grace notes are always positioned just before the next note on the staff. If there is no note after a grace note on the staff, the grace note are hidden!
4. Click Apply. The settings are applied to the selected notes.
5. Close the dialog.

Converting grace notes to normal notes
1. Select the notes that you want to convert.
   If you want to make sure that all notes in the score are normal notes, you can select all notes (using the Select All command on the Edit menu).
2. Double-click on one of the selected grace notes. The Set Note Info dialog appears.
3. Select “Normal” from the “Type” pop-up menu.
4. Click Apply.

Tuplets

The regular Display Quantize values do not apply to any other divisions than triplets. To create quintuplets, septuplets, etc., follow the instructions below.

There are two methods for creating tuplets:
• With permanent alteration to the MIDI data. This is the “drawing” mode to use when you want to build the tuplet from scratch. It does not put any demand on the notes’ positions before the tuplet is created.
• As display quantize. This is the method you use when the tuplet is recorded and plays back as you want it, but is not displayed correctly.

Actually, in the first case, you make permanent alterations and set display quantize settings, all in one go. In the second case you only make display quantize settings.

With permanent change to MIDI data
1. Insert as many notes as the tuplet consists of.
   This would typically be 5, 7 or 9. If the tuplet contains rests, simply leave space for those, but make sure that the current Display Quantize value allows them to be shown.
2. Select all the notes that make up the tuplet.
4. Set the type of tuplet in the Type field. “5” means a quintuplet, “7” means a septuplet, etc.
5. Set the length of the entire tuplet using the “Over” field.
6. Activate Change Length, if needed. If you do, the program alters the length of all notes so that they are exactly the note value the tuplet indicates. If you do not, the lengths of the existing notes is not affected in any way.
7. If you want any other text than the standard above the tuplet, enter it into the “Text” field.
   The standard text is simply the number in the type field. If the tuplet is put under a beam (see “Tuplet display options” on page 617) the text is put just above it. If there is no beam, the text is found in the middle of a bracket.
8. Click Build. The tuplet appears. The notes have now been moved to the tuplet positions and their length might have changed.
9. If needed, edit the lengths and pitches of the notes in the tuplet. You can also make various settings for the appearance of the tuplet – see below.
Without permanent change to MIDI data
1. Select the notes in the tuplet group.
In this case, the notes play back correctly but are not displayed as a tu-
plet (yet).
2. Select “Build N-Tuplet…” from the Scores menu to bring up the Tuplets dialog.
3. Make settings in the dialog, as described above.
4. Click Quantize.
Now the tuplet is displayed correctly. You can make additional settings for how the tuplet should appear, as described below.
5. If necessary, adjust the notes.
⚠️ Lengths and positions in a tuplet group are probably best edited using the info line.

Editing tuplet settings
1. Double-click on the text above the Tuplet group to bring up the Tuplets dialog.

2. Adjust the Text setting.
3. Click Apply.
The changes are applied to the tuplet, without affecting the tuplet type or length.

Grouping
If the Tuplet is a quarter note long or shorter, the notes are automatically grouped under a beam. If it is longer you have to perform the grouping manually, see “Grouping” on page 608 for details.

Tuplet display options
In the Score Settings dialog, on the Project–Notation Style subpage (Tuplets category), you can find the following settings for tuplets:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tuplet Brackets</td>
<td>There are three possible settings for this option:</td>
</tr>
<tr>
<td></td>
<td>– None: Tuplets never have brackets.</td>
</tr>
<tr>
<td></td>
<td>– Always: Tuplets always have brackets.</td>
</tr>
</tbody>
</table>
|                         | – …by the head: Brackets are shown only when the tup-
|                         | let is displayed on the “head side”.              |
| Display Tuplet values by the Beams | When this is activated, tuplets are displayed on the "beam             side" of the notes instead of on the note head side. |
| Suppress Recurring Tuplets | When this is activated, and you have several tuplets of     the same type in the same bar, only the first of these is displayed as a tuplet. |
| Show Tuplet Brackets as “Slurs” | When this is activated, the tuplet brackets are "slur-like" (rounded). |
8

Working with symbols
About this chapter
In this chapter you will learn:
• What the different types of symbols are.
• How to insert and edit symbols.
• Details about special symbols.

Background: The different layers
A score page is always made up of three layers – the note layer, the layout layer and the project layer. When you add symbols, these are inserted into one of these layers, depending on the type of symbol. The symbols that have a relation to notes – accents, dynamic markings, slurs, lyrics, etc. – are put in the note layer. Other symbols – such as repeats, rehearsal marks, some types of text, etc. – can be put either in the layout layer (which is individual for each layout) or in the project layer (common for all layouts).

Note layer symbols
Let’s look at the note layer symbols first. These come in three flavors:
• Note symbols. These are each tied to a single note. Examples of note symbols are accents and lyrics. When you move the note, the symbol moves with it. The same is true if you cut the note and then paste; the symbol is cut and pasted together with the note.
• Note-dependent symbols. Only a few symbols belong to this category, for example the arpeggio lines. In one way, these behave just like grace notes (see “Grace notes” on page 615). They always precede a note or chord. If there is no note “after them” on a staff, they disappear.
• All other note layer symbols (tempo, dynamics, chords, etc.). Their position is related to the bar. (Whichever way you edit the notes, these symbols remain unaffected.) However, their positions are fixed within a measure. If you for example change the spacing of the bars across the page (see “Setting the number of bars across the page” on page 669), this affects the symbols positions.

Layout layer symbols
Now let’s examine the layout layer symbols. The layout layer is not stored individually for each track, as the other symbols are. Instead it is common to a “set of tracks”. Let’s illustrate this with an example:
You have four tracks that make up a string quartet. You edit them all at the same time and add symbols to the score, both note layer symbols and layout layer symbols. Now you close the Score Editor and open only one of the tracks for editing. All your note layer symbols are there just as you left them, but the layout layer symbols have disappeared! Don’t worry, close the editor again, and open all four tracks for editing and the symbols are back.
This is due to the fact that the layout layer symbols are part of a “bigger entity” called “layout”. And a layout is something that is stored not per track, but for a group of tracks. Each time you open the same combination of tracks for editing, you get the same layout.
For a detailed description of the layout layer, see the chapter “Working with layouts” on page 655.

Project layer symbols
Project layer symbols are layout symbols that are present in all layouts. The project layer holds the symbols found in the Project tab, plus bar line types and bar number offsets.
Using project layer symbols in conjunction with the Arranger mode, you can have playback in the program follow the score – repeats, da Capos and endings are played back properly allowing you to hear your compositions as they would be played back by live players.

Why three layers?
There are several reasons for this division into layers:
• Many of the symbols that are in the layout layer can be stretched to span over several staves, or for other reasons make more sense to think of as belonging to a certain group of tracks.
• The layout layer is only one part of the bigger concept of layouts. Layouts allow you to easily extract parts from a full score and perform automatic formatting. This is described in the chapter “Working with layouts” on page 655.
• Typically, you want to display some symbols – repeat bar lines, endings, score titles, etc. – for all layouts in a score. To achieve this, insert them on the project layer.
Which symbols are part of which layer is described in the section “The available symbols” on page 621 and onwards.

The Symbols Inspector
To display the Symbols Inspector, click the “Set up Window Layout” button on the toolbar and activate the Symbols option.

Customizing the Symbols Inspector
You can customize the appearance of the Symbols Inspector by showing/hiding tabs and by specifying their order in the Inspector.

Showing/Hiding Symbols Inspector tabs
If you right-click on any tab in the Inspector, a context menu appears. On this menu, you can directly check (show) or uncheck (hide) elements of the Inspector as desired.

You can also select different preset configurations from the lower half of the menu. To display all Symbols Inspector tabs, select “Show All”.

The Symbols Inspector Setup dialog
If you right-click on any closed tab in the Symbols Inspector and select “Setup…” from the context menu, a dialog appears. In this dialog you can configure where the separate tabs are placed in the Inspector and save/recall different configurations of the Inspector.

The dialog is divided into two columns. The left column displays the currently visible tabs in the Inspector, and the right column displays the currently hidden tabs.

- You can change the current show/hide status by selecting items in one column and using the arrow buttons in the middle of the dialog to move them to the other column. The changes are reflected directly in the editor.
- You can change the order of the (visible) tabs in the Symbols Inspector with the “Move Up” and “Move Down” buttons. The changes are reflected directly in the Score Editor.

A “customized” Inspector
- If you click the Save button (disk icon) in the Presets section, you can name the current configuration and save it as a preset.
- To remove a preset, select it and click the trash icon.
- Saved configurations are available for selection from the Presets pop-up menu in the dialog or directly from the Inspector context menu.
- To revert back to the default Inspector settings, right-click on any of the tabs and select “Default” from the context menu.

Working with symbol palettes
You can open any of the Symbols Inspector sections as separate symbol palettes.

Opening tabs as palettes
1. In the Symbols Inspector, open the desired symbols tab.
2. Right-click on any of the symbols of the tab. Note that you have to right-click on a symbol. Right-clicking on a tab header opens a different context menu instead.
3. Select “Open as Palette” from the context menu. The selected tab is shown as palette.

Moving and handling palettes
Palettes are handled as any window, which means that you can:
• Move a palette to another position by dragging its title bar.
• Close a palette by clicking its close button.
In addition, you can select whether the palette is shown horizontally or vertically, by right-clicking and selecting “Toggle” from the context menu.

The available symbols
The following symbols palettes/tabs are available:
• Favourites
• Keys
• Clefs
• Time Signature
• Chord Symbols
• Guitar Symbols
• Cubase only: Expression Map, see “Expression maps (Cubase only)” on page 419.
• Dynamics Mapping, see “Working with mapped dynamics” on page 685.
• Clefs etc.
• Note Symbols
• Dynamics
• Line/Trill. Note that the arpeggios, hand indication and strum symbols are all “note-dependent”!
• Other
• Layout. All these symbols are drawn in their own “layer”.
• Project. These symbols are present in all layouts.
• Words. This is described in the section “The Words tab” on page 652.
• User Symbols. This is described in the section “User Symbols” on page 638.

When you place the mouse pointer on a symbol, a tooltip shows you information about the function. Further details about many of the symbols can be found in the section “Symbol details” on page 634.

Setting up the Favourites tab
In the Symbols Inspector, you can find a tab called Favourites. Cubase allows you to fill this tab with a selection of symbols from other tabs. This way, you have instant access to the symbols you use often:

1. Open the Favourites tab. If it is the first time you are using this tab, it is empty.
2. Open the tab from which you want to copy a symbol. Not all symbols can be placed on the Favourites tab.
3. Right-click on the symbol that you want to add to the Favourites tab and select “Add to Favourites” on the context menu. You can also add a symbol to the Favourites tab by [Alt]/[Option]-clicking on it.
4. Repeat this procedure for other symbols that you want to add to the Favourites tab.

• To remove a symbol from the Favourites tab, select “Remove from Favourites” from the context menu or hold down [Alt]/[Option] and click on it.

Important! – Symbols, staves, and voices
Most symbols belong to a staff when inserted. Only note symbols, slurs and ties are an exception. They belong to notes and therefore to voices.

It is extremely important that the correct staff is active when you insert a symbol (if you are editing multiple staves).

If you for example insert a symbol while the wrong staff is active, the symbol might later “disappear” because you edit another configuration of tracks (the track you actually inserted the symbol on might not be opened for editing).

The same is true for note symbols and their relation to voices. Make sure that the correct voice is active when inserting symbols or they might wind up at the wrong position, fermatas may be turned upside down, etc.
Layout symbols work slightly differently. Instead of belonging to a certain staff or voice, they belong to a layout. Since different track combinations use different layouts, this means that if you insert a layout symbol in the score when you are editing two tracks (for example a trumpet and a saxophone part), it is not there when you view each track by itself in the Score Editor. If you want the same symbols to appear in other layouts as well, you can copy the form of one layout to another. If you want a symbol to appear in all layouts, use the Project tab.

Adding symbols to the score

Making space and handling margins
- If you find there is not enough space between staves to add symbols (like for example text), see “Dragging staves” on page 670 for info on how to separate the staves.
- If you find the score looks crammed after adding symbols, check out the section “Auto Layout” on page 672.

⚠ Symbols you add outside the margins are not printed!

About the Pencil tool
Unlike the other MIDI editors, the Score Editor toolbar does not contain a Pencil tool. Instead, the Pencil tool is “automatically” selected when you insert symbols. The following applies:
- Normally, the Pencil tool is automatically selected when you click on a symbol in the Inspector. However, if the “Double-click Symbol to get Pencil tool” option is activated in the Preferences dialog (Scores–Editing page), you need to double-click the symbol to get the Pencil tool.
- On the same page of the Preferences dialog, you can find an option called “Display Arrow tool after Inserting Symbol”. When this is activated, the Object Selection (“Arrow”) tool is automatically selected after you have inserted a symbol.

Adding note symbols

Adding a symbol to one note
1. In the Symbols Inspector, open the Note Symbols tab.
2. Click (or double-click) on the desired symbol on the tab.

As mentioned above, the “Double-click Symbol to get Pencil tool” preference determines whether you need to double-click. In either case, the Pencil tool is selected.
3. Either click on the note or above or below it.
   If you click on the note, the symbol is put in at a predefined distance from the note. If you instead click “above or below” the note, you decide for a vertical position yourself. In either case, the symbol is aligned horizontally with the note. It can later be moved up/down.

Clicking on a note inserts the note symbol (in this case a tenuto) at a predefined distance from the note head.

There are three options in the Accents category of the Score Settings dialog (Project page–Notation Style sub-page) that affect the vertical positioning of note symbols:
- Accents above Stems
   When this is activated, accent note symbols are displayed at the stem side of notes instead of the note head.
- Accents above Staves
   When this is activated, accent note symbols are displayed above the staff, regardless of the stem direction of the notes. This setting overrides the “Accents above Stems” option.
- Center Note-Linked Symbols on Stems
   When this is activated, accents are centered on stems and not on note heads.

Adding a symbol to several notes using the Pencil tool
You might for example want to add a staccato symbol to all notes within a few measures. Proceed as follows:
1. In the Symbols Inspector, open the Note Symbols tab
2. Select the notes to which you want to apply the symbol.
3. In the Symbols Inspector, click on the desired symbol.
4. Click on one of the notes. The symbol is added to each selected note, at a predefined distance. The symbols can be moved later.

Adding a symbol without tying it to a note
Note-dependent symbols can be entered freely, too. This allows you to add a fermata to a rest symbol for example.

1. Make sure that the correct staff is active.
2. Click the symbol so that the Pencil tool is selected, as described above.
3. Hold down [Ctrl]/[Command] and click where you want to add the symbol.

Adding other symbols
1. In the Symbols Inspector, open the desired symbol tab.
2. Click on the symbol that you want to add.
3. Click once or click and drag somewhere in the score. The symbol appears. For many symbols with a length, you can drag to set the length of the symbol directly. The symbol appears with its handles selected (if it uses handles) so that you can change its size directly if you wish. This is all described in detail in the section “Changing length, size, and shape” on page 632.

Press the mouse button – drag – and release!

- You can change the size of most of the note symbols and dynamics in a score by right-click on the corresponding object and selecting the desired option from the Size submenu on the context menu.

About note-dependent symbols
Note-dependent symbols like arpeggios and strum directions must be put in front of a note or they belong to the following note instead (if there is no following note, the symbols are not inserted at all).

Adding text
There are special methods for working with text, described in their own chapter, “Working with text” on page 645.

Adding slurs and ties
Slurs can be drawn in manually or inserted automatically for a group of notes. Ties are usually added by the program but can also be drawn in as “graphic” symbols.

- There are two types of slurs – “regular” slurs and Bezier slurs (with which you have full control over thickness, curve shape, etc.).

Slurs, ties, and the Display Quantize value
Since a slur or tie “musically” always spans from one note (or chord) to another, the beginning and end of a slur/tie in Cubase is always related to two notes in the score.

When you draw in a tie or slur, the program uses the Quantize value to find the closest two notes to “attach” the symbol to. In other words, if you want to add the slur/tie to a note at a sixteenth note position, make sure Quantize is set to 1/16th notes or smaller (this is only true for manual drawing in of slurs and ties).

Please note that this does not necessarily mean that the symbol has to start or end exactly above/below two notes. Instead, what it means is that when you use the Layout tool to move the note graphically to adjust the look of the bar, the slur/tie moves with it (see “Graphic moving of notes” on page 614). The same is true if you adjust the width of the measure – the slur/tie is adjusted accordingly.

- If you want the end points of the slurs to snap to exact note positions, activate the “Snap Slurs when dragging” option on the context menu or in the Preferences dialog (Scores–Editing page).

Drawing the slur/tie
1. Set the Quantize value depending on the positions of the two notes that the slur/tie should span.
   For example, if one of them is at a quarter note position and the other at an eighth note position, set Quantize to 1/8 note or a smaller note value.
2. Click on the correct slur/tie in the Symbols Inspector, so that the Pencil tool is selected.
3. Position the mouse close to the first note and drag to a position close to the second note. The end points of the slur/tie snap to their default positions – holding down [Ctrl]/[Command] allows you to move the end points freely.

There are two special functions for inserting a slur or tie that automatically spans from one note to another.

**Adding a slur/tie between two notes**

1. Select two notes.
2. Click the correct slur/tie symbol in the Inspector, so that the Pencil tool is selected.
3. Hold down [Ctrl]/[Command] and [Shift] and click on one of the two notes. The slur/tie is added between the two selected notes.

**Inserting a slur over a selection of notes**

1. Select a span of notes.
2. Pull down the Scores menu and select “Insert Slur”. A slur is created, starting at the first selected note and ending at the last.

The default Bezier slur has four curve points – one at each end and two along the curve.

- To move the slur, click on it (but not on a curve point) and drag.
- To resize the slur, click and drag the end points.
- To change the shape of the slur, click on one of the middle curve points and drag in any direction.

Right-clicking on a curve point brings up a context menu with the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Points/Reduce Points</td>
<td>Adds another pair of curve points to the Bezier slur. This allows you to create very complex slur shapes. After adding points, there is an additional menu item “Reduce Points” – selecting it removes the additional curve points.</td>
</tr>
<tr>
<td>Add Thickness</td>
<td>Makes the Bezier slur thicker.</td>
</tr>
<tr>
<td>Reduce Thickness</td>
<td>Makes the Bezier slur thinner.</td>
</tr>
<tr>
<td>Hide</td>
<td>This hides the slur symbol, see “Hiding/showing objects” on page 665.</td>
</tr>
</tbody>
</table>

**The Bezier slur**

The Bezier slur is a special slur symbol, found on the Dynamics symbol tab. Unlike the regular slur, this symbol is made up of a bezier curve, allowing you to create more advanced curve shapes.

To add a Bezier slur, click on the symbol in the Inspector so that the Pencil tool is selected, and click or drag in the score. Clicking creates a Bezier slur of the default length and shape, while dragging creates a straight line.

Creating trills

If you have recorded or entered a trill, Cubase can help you display this properly:

1. Select the notes that make up the trill.
2. Right-click on one of the notes and select “Build Trill...” from the context menu.
3. Select an option from the dialog that appears. The radio buttons determine how the trill should look. Activate the “Help Note” option if you want an extra note to indicate between which notes the trill should be played.
4. Click OK.

Now the following happens:

- All notes except the first one (and possibly the second) are hidden.
- The first note automatically gets a display length matching the length of the whole trill.
Working with symbols

• If you choose to include a help note, the second note is converted to a “Graphic” note, with brackets but without stem. Otherwise, the second note is hidden, too.
• The trill symbols you selected in the dialog are inserted.

Inserting symbols across staves
If you hold down [Alt]/[Option] while adding a symbol to one staff in a grand staff, this symbol is put in at corresponding positions on all staves. This allows you for example to insert rehearsal marks, repeats, etc. for all instruments at the same time.

Adding a keyboard symbol

The Other tab contains a piano keyboard symbol, useful for example in educational scores. The symbol has the following properties:

• To insert the keyboard symbol, select it from the Inspector, click with the Pencil tool at the desired position and drag a box to specify the approximate size of the keyboard.
• After you have inserted the keyboard symbol, you can drag its edges to resize it vertically or horizontally.

Adding guitar chord symbols

A fretboard symbol of a guitar chord can be inserted anywhere in the score. Guitar symbols are found on the “Guitar Symbols” tab and the Other tab in the Symbols Inspector.

• The Guitar Symbols tab contains all Guitar symbols of the current guitar library, see “Using the guitar library” on page 626. If the symbol that you want to insert is among these, select it and insert it as you would any other symbol, see above.

To insert a guitar symbol not present in the guitar library, proceed as follows:
1. Open the Other tab.
2. Click on the guitar chord symbol, so that the Pencil tool is selected.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Governs the width of the keys.</td>
</tr>
<tr>
<td>Start Note</td>
<td>This is the leftmost note in the keyboard symbol.</td>
</tr>
<tr>
<td>Show Note Names</td>
<td>When this is activated, each C key is displayed with note name and octave (C1, C2, etc.).</td>
</tr>
<tr>
<td>White/Black Keys transparent</td>
<td>Activate these if you want the white and/or black keys to be transparent.</td>
</tr>
</tbody>
</table>

Option Description
Size Governs the width of the keys.
Start Note This is the leftmost note in the keyboard symbol.
Show Note Names When this is activated, each C key is displayed with note name and octave (C1, C2, etc.).
White/Black Keys transparent Activate these if you want the white and/or black keys to be transparent.
Working with symbols

3. Click in the score, at the position where you want the symbol to appear.
The Guitar Symbol dialog appears.

- To put a black dot on any fret and string, click on it.
  To remove it, click again.
- To add a symbol just above the string, outside the fretboard, click there.
  Consecutive clicks allow you to select between a ring (open string), a cross (do not play this string) and no symbol.
- To add a capodaster number, click to the left of the symbol.
  Consecutive clicks allow you to step through the possibilities.
- You can also add a capodaster symbol (a line over the strings), by setting the “Capo String” parameter to a value higher than 0.
  By adjusting the Capo End and Start values, you can create capodaster symbols that span fewer strings.
- Use the “Size” value field to adjust the size of the chord symbol.
- If you want the symbol to be horizontal, activate the “Horizontal” checkbox.
- To display more or fewer frets than the default six, change the “Frets” value.

4. Click Apply.
The guitar symbol appears in the score.

You can edit the symbol at any time by double-clicking it, changing the settings in the dialog and clicking Apply.
Note that you can also access the symbols that you defined in the guitar library by right-clicking a guitar symbol – see below.

- If you select “Make Chord Symbol” from the context menu, the corresponding chord symbol is displayed above the guitar symbol. This function is very useful when writing lead sheets, for example.

Using the guitar library
The above method is fine if you only want to add a few chord symbols to your score. If you need a lot of chord symbols, or if you are using chord symbols in a lot of different scores, you can gather all your chord symbols in a “guitar library” instead. This way you do not have to recreate the same chord symbol over and over again.

Defining chord symbols

1. In the Symbols Inspector, double-click on one of the symbols on the Guitar Symbols tab to open the guitar library.
   Alternatively, you can open the Score Settings dialog on the Project page and select the "Guitar Library" subpage.

2. To add a guitar chord symbol to the library, click the New button.
   A chord symbol appears in the list to the left.

3. To edit the chord symbol, double-click it in the list.
   This opens the Guitar Symbol dialog, as when editing a chord symbol in the score.
The symbol you create is also “interpreted” and its name is displayed to the right of the fretboard symbol. This can also be edited by double-clicking if you like.

To sort the available symbols in the library according to their root notes, click the Sort button.

To remove a symbol from the library, select it in the list and click Remove.

To save the current library as a separate file, select “Save…” from the Functions pop-up menu. A file dialog appears, allowing you to specify a name and location for the file.

To load a guitar library file, select “Load current Pane…” from the Functions pop-up menu. In the file dialog that appears, locate and open the desired guitar library file.

Loading a guitar library file replaces the current library!

There are also two additional checkboxes in the Guitar Library dialog:

- Use for Make Chords
  When this is activated, and you use the “Make Chord Symbol” function (see “Using Make Chord Symbols” on page 642), the program inserts guitar symbols as well as regular chords (if any fitting guitar symbols can be found). If there are several guitar symbols for a certain chord in the Guitar Library, the first one is used.

- Small Display
  If this is activated, the chord symbols in the list is displayed in the size they get in the score. If it is deactivated, the symbols are displayed in a larger size, for easier editing.

Adding an image file

You can insert image files as symbols into the Score. This allows you to import logos, copyright symbols, images of finger positions, etc.

Proceed as follows:

1. In the Symbols Inspector, open the Other tab, the Layout tab, or the Project tab.

Image files can be inserted on all three layers, see “Background: The different layers” on page 619.

2. Click on the Image File button to select the Pencil tool. Click in the score at the position where you want to insert the file. A file dialog opens.

3. Locate and select the image file you want to insert. The lower section of the Import dialog contains the following settings:

   - To copy the referenced file into the Project folder, activate the “Copy to Project folder” option. This is recommended as it makes it easier to manage all files used in a project.
   - If you modify your score, by adding staves for example, the position of an inserted image file changes. If this is not what you want, activate “Stick to Page” to keep it at a fixed position in your staff.
   - The Transparency parameter allows you to set the desired transparency of the image.

4. Click Open to insert the file. The image file is inserted. Its size depends on the printer resolution. However, you can scale the image by dragging its handles. To restore the printer resolution, right-click on the image to open the context menu and select “Snap to Printer Resolution”.

Inserting symbols from the library

Apart from the “Use for Make Chords” option above, there are two ways to insert symbols from the guitar library into the score:

- Use the Functions pop-up menu on the Project–Guitar Library subpage in the Score Settings dialog, when creating or editing guitar symbols.

- Right-click on a guitar symbol in the score and select a chord symbol from the Presets submenu on the context menu.
You can modify the settings you made on import by right-clicking on the image and selecting “Properties” on the context menu, to open the Image Properties dialog.

Using layout symbols
Symbols inserted from the Layout tab belong to the layout layer. When you are editing a layout containing several tracks, you can have inserted layout symbols automatically copied to any combination of tracks in the layout. You decide which staves should display layout symbols by ticking their “L” column in the Score Settings dialog, on the Layout page.

• Any editing you perform to layout symbols is automatically duplicated in the other tracks.
• The display of layout symbols for different tracks can be deactivated at any time.
• Layout symbols can be copied between layouts, by using the Get Form function on the Functions pop-up menu on the Layout page of the Score Settings dialog.

One example of how to use layout symbols:
Let’s say you are editing a full orchestra score, and want rehearsal marks inserted for more than one staff (typically, above each instrument group – brass, strings, percussion, etc.). Now all you need to do is insert the rehearsal marks from the Layout tab for one of the tracks. To do so, open the Score Settings dialog on the Layout page, tick the “L” column for the desired tracks/staves, and click Apply.

Using Project symbols
Project symbols are part of the project layer and therefore appear in all layouts. The project layer also contains changes to bar lines (e.g. repeats and double bar lines) and bar number offsets. Typically you use Project symbols when you know you want these shown for all combinations of tracks.

You can also use Project symbols in combination with the Arranger mode to have the program play back according to the score, e.g. repeats, Da Capos and endings. See “Scores and the Arranger mode” on page 685.

Selecting symbols
Almost all symbols can be selected by clicking on them. For symbols that have a length or size, one or more handles appear.

A selected crescendo

An exception to this are the slurs and ties which can be selected by clicking on the end points or by drawing a selection rectangle.

Using the lock layers
Sometimes it can be very hard to click on a symbol or other object in the score without accidentally selecting other symbols nearby. To remedy this, you can assign different types of objects to different “lock layers” (up to three) and instruct Cubase to “lock” one or two of these layers, making them “unmovable”. Furthermore, you can lock the layout and project layers separately if needed.
Setting up the lock layers

1. Open the Preferences dialog and select the Scores–Note Layer page.

2. Assign each event type to a layer (1, 2, or 3).
   It is a good idea to specify different layers for event types that might conflict "graphically". For example, you might want to assign bar numbers and note symbols to different layers, if you find that you accidentally move bar numbers when editing note symbols and vice versa.

3. Click OK to close the dialog.
   - Alternatively, you can right-click on one of the Layer buttons (1-2-3) on the extended toolbar to bring up a pop-up menu, showing which object types are associated with that layer.
   
   A checkmark for an object type means it belongs to that layer. If no checkmark is shown, you can select the object type from the pop-up menu to move it to that layer.

   ![Scores-Note Layer](image)

Locking a layer

To “lock” a layer, click on its lock layer button.

![Layer Lock](image)

In this figure, layer 2 is locked. Event types assigned to layer 2 cannot be selected, moved, or deleted.

Visual indication of the layers

Objects belonging to locked note layers are "grayed out" in the score. This makes it very easy to find out which object belongs to which layer – perhaps especially useful for the layout and project layers. For example, to quickly spot all objects in the layout layer, lock all other layers by clicking their buttons. Now, only layout layer objects are shown normally; all other objects are grayed out.

Moving and duplicating symbols

There are four ways to move and duplicate symbols:

- By dragging them with the mouse (see below).
- By using the computer keyboard (moving only – see “Moving by using the computer keyboard” on page 631).
- By using the bar handles (see “Moving and duplicating with the bar handles” on page 631).
- By using the Paste Note Attributes function (duplicating note symbols only – see “Copying settings between notes” on page 608).

Moving and duplicating by using the mouse

This is done much as with other objects in Cubase. The following rules apply:

- Note symbols and note-dependent symbols move with the notes/chords they belong to. In other words, if you move the note/chord, the symbols move with it/them.
- Note symbols (like accents and lyrics) can only be moved vertically. Other symbols (like braces and brackets) can only be moved horizontally.
- All other symbols without handles can be moved freely. If you hold down [Ctrl]/[Command], movement is restricted to one direction only.
- If the symbol has one or more handles when it is selected, do not drag it by the handles, or you change its shape instead of moving it.
• Slurs and ties are an exception, as they can only be moved by first dragging one handle and then the other. However, if you use the Layout tool (see “Graphic moving of notes” on page 614) to move the notes they belong to, or if you change the measure width, they are adjusted automatically.
• Duplicating is done by moving with [Alt]/[Option] pressed, as always in Cubase. Slurs, ties, and bar lines cannot be duplicated with this method.

There are two features to help you position symbols (and other score objects) correctly: the rulers and the Position Info window.

The rulers
Unlike other editors, the Score Editor does not have a meter/time position-based ruler. Instead, its rulers are “graphical”, i.e. they indicate the actual x-y position of objects (with “zero” at the upper left corner).

• The current pointer position is indicated by thin lines in the rulers.
• To hide the rulers, right-click on a ruler and select “Off”. This pop-up menu can also be found above the scroll bar at the far right.
• To display the ruler again, open the pop-up menu above the scroll bar at the far right and select one of the units (inches, centimeters, or points).

This setting also affects the units used in the Position Info window (see below).

The Position Info window
If you need to fine-tune the graphical positions of symbols and other objects, you should use the Position Info window. This makes positioning easier in two ways:
• You get a numerical indication of the exact position of the mouse pointer (and any object you are dragging).
• You can move objects or staves by typing in position values.

You display the Position Info window by clicking in the ruler.

The window contains the following settings and values:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure in</td>
<td>Click this label to change units for the Position Info window. You can toggle between Inch, cm, and pt. This choice also affects the units used in the rulers.</td>
</tr>
<tr>
<td>Abs. Pos./Rel. Pos</td>
<td>Click this label to select whether X-Y position values are “absolute” (referring to the upper left corner of the current page) or “relative” (referring to the upper left corner of the active staff).</td>
</tr>
<tr>
<td>X, Y</td>
<td>When a single object is selected, these values show the horizontal and vertical position of this object. When no objects or several objects are selected, these values show the current horizontal and vertical position of the pointer. When a single object is selected, you can click on these values and type in a new position for the object.</td>
</tr>
<tr>
<td>dX, dY</td>
<td>When you are moving an object, these values indicate the horizontal and vertical distance you have moved it. You can click and type in values to move the object(s) by the specified distances.</td>
</tr>
<tr>
<td>Sel. Staff</td>
<td>If “Abs. Pos.” is selected (see above), this value shows the distance from the top of the score page to the top of the active staff. You can click and type in a value to move the active staff. If “Rel. Pos.” is selected, this value is always 0, since vertical positions are related to the top of the active staff!</td>
</tr>
<tr>
<td>To Prev Staff</td>
<td>The distance between the active staff and the staff above it. Clicking and typing a value moves the active staff.</td>
</tr>
<tr>
<td>To Next Staff</td>
<td>The distance between the active staff and the staff below it. Clicking and typing a value moves the staves below the active staff.</td>
</tr>
</tbody>
</table>
Dragging symbols across staves
If you drag a symbol across the staves, you can see how the "active staff" indicator to the left follows the mouse pointer. Use this as an indication to make sure that symbols end up in the correct staff.

- If you are editing several tracks at the same time, and want to make sure that a symbol is not accidentally moved to another track when you drag it vertically, activate the Lock "L" button on the extended toolbar. When this is activated, you cannot move symbols across staves by dragging.

Moving by using the computer keyboard
In the Key Commands dialog, you can assign key commands for moving symbols, notes, or rests graphically. The commands are found in the "Nudge" category and are called "Graphical Left", "Graphical Right", "Graphical Top", and "Graphical Bottom".

Selecting an object and using one of these commands is the same as dragging them with the Layout tool, but this method offers higher precision.

Moving and duplicating with the bar handles
This function allows you to move or copy the contents of a whole bar to one or several other bars. You can select which elements in the bar will be included in the operation. Proceed as follows:

1. Make sure that the filter bar is visible.
   If the filter bar is not visible, click the "Set up Window Layout" button on the toolbar and activate the Filters option.

2. On the filter bar, make sure that the "Bar Handles" option is activated.
   Now, each bar in the score is shown with a handle in the upper left corner.

3. Double-click on the handle of the bar from which you want to copy or move symbols.
   The Bar Copy dialog appears.

4. Make sure that only the symbol types that you want to move/copy are checked.

5. If you have several subsequent bars to which you want to copy symbols, set the "Repeats" value to this number of bars.
   If you only want to copy symbols from one bar to another, make sure that "Repeats" is set to 1. This option is only available for copying, not for moving.

6. If you want this dialog to appear every time you perform the move/copy operation, activate "Show Dialog".

7. Click OK to close the dialog.

8. To copy the specified event types to another bar, hold down [Alt]/[Option], click on the bar handle of the first bar and drag it to the "target" bar.
   To move the event types instead of copying them, drag the bar handle without holding down [Alt]/[Option].

- If you activated "Show Dialog", the Bar Copy dialog appears, allowing you to confirm your settings.
  Click OK to close the dialog and perform the operation.
The following happens:

- If you activated “Note Symbols”, the note symbols are copied from the “source” bar and pasted onto notes at the same positions in the “target” bar. If there is a note symbol for a certain note in the “source” bar, but no note at the corresponding position in the “target” bar, the symbol is ignored. The actual positions of notes are used as a basis for this operation – not the displayed positions.

- If you copy the note symbols from the first bar to the second bar…

  ![Note Symbols Example](image)

  …only symbols that find corresponding note positions in the second bar are copied.

- If you activated other types of symbols, these are simply moved to the same graphical position in the “target” bar.

- If you set “Repeats” to a number larger than 1, the same symbols are pasted into that number of bars (starting from the one you drag the bar handle to).

- If you do not hold down [Alt]/[Option] when dragging the bar handle, the symbols (and other event types specified in the dialog) are removed from the “source” bar.

  ▼ If there already are symbols (or other objects) of the specified types in the “target” bars, these are removed.

Moving note symbols

Note symbols, slurs and ties all have “default positions”. This determines the vertical distance between the note head(s) and the symbol.

- You can manually adjust the vertical positions of individual symbols, but if you move or transpose their notes, the symbols are automatically reset to their default positions. This also ensures that note symbols and slurs are positioned sensibly when you change the Display Transpose settings.

- To reset the vertical positions of note symbols and slurs in a score, right-click on the corresponding object and select “Default position” from the context menu.

Changing length, size, and shape

You can change the shape of any symbol that has a length. Proceed as follows:

Changing the length of a symbol

1. Select the symbol.
   The handles appear.

   ![Symbol Handles](image)

   Symbols with a length have two handles when selected.

2. Drag one of the handles.
   You may be restricted to vertically or horizontally only, depending on the type of symbol.

   △ In the Preferences dialog (Scores–Editing page), there is a preference called “Keep Crescendo Symbols Horizontal”. When this is activated, crescendo and diminuendo symbols are never slanted.

Resizing note symbols and dynamics

1. Right-click on a dynamic or note symbol.

2. Select the desired option from the Size submenu.
   The size of the symbol changes accordingly.

   ![Dynamic Changes](image)
Altering the shape and direction of slurs and ties

This section describes how to alter the “regular” slur and tie symbols. How to add and edit Bezier slur symbols is described in the section “The Bezier slur” on page 624.

There are two types of slurs and ties in the Symbols Inspector. The up/down variation of each actually represent the same symbol but with different initial direction. You can perform the following editing to slurs and ties:

- By dragging the middle handle up/down and left/right you can change the shape of the curve.
- By selecting a slur or a tie and clicking the “Flip” symbol on the extended toolbar or by selecting “Flip Position” on the context menu, you can change the direction and positioning of the slur or tie.

Actually, there are three “modes” for a slur or tie. You step through these three modes by clicking the button.

- By dragging the end points of a slur or tie, you can change its shape without affecting its “relation” to the notes it belongs to.

In other words, the end point of the slur/tie keeps its relative distance to that note when the note is moved with the Layout tool or when the measure width is adjusted.

- By holding down [Ctrl]/[Command] and dragging the end points of a slur or tie, it can be detached from the notes it belonged to.

To restore the default shape of a symbol, right-click on it and select “Default position” from the context menu, see “Moving note symbols” on page 632.

- To change the default shape and spacing of slurs and ties, open the Score Settings dialog on the Project–Settings subpage and edit the “Slur’s Start & End Distance from Note Head” and “Slur’s Middle Distance from Note Head” settings.

These settings are used for all new slurs and ties you create, as well as for all existing slurs for which you have not manually changed the shape.

Deleting symbols

This is done as with all other objects in Cubase, either with the Erase tool or by selecting it and pressing [Delete] or [Backspace].

Copy and paste

All symbols except those in the Layout and Project tabs can be copied and pasted just as any other object in Cubase. The following applies:

- Symbols that were tied to notes (e.g. accents) become “free-floating” objects when pasted. That is, they are not tied to any note any more. If this is not what you want, consider copying with the bar handles, as described in the section “Moving and duplicating with the bar handles” on page 631.

Alignment

Symbols can be aligned as in drawing programs. Proceed as follows:

1. Select all objects that you want to align.
2. Open the Scores menu and select an option from the Align Elements submenu.
Working with symbols

Symbol details

This section further describes some of the symbol tabs.

The “Clefs etc.” tab

Clefs
You can insert a clef symbol anywhere in the score. This has an effect on the notes, just as the first clef on the staff has. And just as with the first clef, the type is selected from the Edit Clef dialog that appears when you select the Clef symbol and click in the Score. See “Inserting and editing clefs, keys, or time signatures” on page 584 and “Setting clef, key, and time signature” on page 562 for details.

When you double-click on an existing clef, the Edit Clef dialog appears again, allowing you to change the type. When you right-click on a clef, you can change the type from the context menu.

Keys

Inserting a key change is similar to inserting a new clef (see above). For further information, see “Editing the key” on page 564.

When you insert a key change, you can also insert Display Transpose changes.

Time signatures

You can insert a time signature symbol at the beginning of any bar. Inserting a new time signature inserts a change on the signature track, see “Inserting and editing clefs, keys, or time signatures” on page 584.

When you select the Time Signature symbol and click in the score, the Edit Time Signature dialog opens, allowing you to specify the time signature. When you double-click on an existing time signature symbol, the same dialog appears, allowing you to change the type. This dialog is described in detail in the section “Editing the time signature” on page 562. When you right-click on a time signature, you can change the type on the context menu.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>![Left Result]</td>
</tr>
<tr>
<td>Right</td>
<td>![Right Result]</td>
</tr>
<tr>
<td>Top</td>
<td>![Top Result]</td>
</tr>
<tr>
<td>Bottom</td>
<td>![Bottom Result]</td>
</tr>
<tr>
<td>Center Vertically</td>
<td>![Center Vertically Result]</td>
</tr>
<tr>
<td>Center Horizontally</td>
<td>![Center Horizontally Result]</td>
</tr>
</tbody>
</table>

Note symbols like staccato and accents can only be aligned horizontally.

The "Dynamics” option is a special function for aligning dynamic symbols, as described in the section “Aligning dynamics” on page 635.
You can select a font and size for time signatures in the "Text Settings" subpage of the Score Settings dialog (Project page). The default font for this is the included "Steinberg Notation" font.

The Dynamics tab

There are dynamic symbols ranging from ffff to pppp, plus "special" dynamic symbols such as sforzando, fortepiano, etc.

- By selecting a dynamic symbol and clicking the "+" and "-" buttons on the extended toolbar, you can quickly edit dynamics in the score. Use this feature to step between pppp, pp, p, mp, mf, f, ff, fff, and ffff.
- You can also right-click on a symbol and select "One up" or "One down" on the context menu. As above, these commands can be used to step between pppp, pp, p, mp, mf, f, ff, fff, and ffff.
- To change the size of a dynamic symbol, right-click on it and in the context menu, select an option from the Size submenu.
- In the Line/Trill tab you can find a line symbol which allows you to create the following type of change in dynamics:

```
PPP __________ ff
```

Crescendo and diminuendo (decrescendo)

In the Dynamics tab, there are three kinds of crescendo symbols: regular crescendo, regular diminuendo and a "double" crescendo (diminuendo–crescendo).

- To insert a crescendo (>) or diminuendo (>), select the corresponding symbol from the tab and drag from left to right.
- If you draw a crescendo symbol from right to left, the result is a diminuendo symbol, and vice versa.
- To insert a crescendo-diminuendo (<>) symbol, select the double crescendo symbol from the tab and drag from left to right.
- To insert a diminuendo-crescendo (><) symbol, select the double crescendo symbol from the tab and drag from right to left.
- When you have inserted a crescendo or diminuendo symbol, you can move it and resize it by dragging its handles.
- The "dynamic crescendo/diminuendo" symbol (p < f) is special in that it actually affects the velocity of the notes as they are played back. This is described in the section "Working with mapped dynamics" on page 685.
- If the "Keep Crescendo Symbols ‘Horizontal’" option is activated in the Preferences dialog (Scores–Editing page), crescendo/diminuendo symbols are never slanted when you draw them, but stay horizontal. Also, this option prevents you from accidentally dragging an endpoint up or down when moving the symbol.
- It is also possible to "flip" crescendo symbols, by selecting the option in the context menu or by clicking the Flip button on the extended toolbar.

Aligning dynamics

There is a special command for aligning dynamic symbols (including crescendos) horizontally. Unlike the regular align function (see "Alignment" on page 633), aligning dynamics takes the "baseline" of the dynamic letters into account, aligning them as text rather than as graphic symbols.

1. Select the dynamic symbols that you want to align, e.g. pp and a crescendo.
2. Right-click on a selected symbol and select the "Align" function on the context menu. This aligns all selected dynamics (except slurs and bezeirs) horizontally.

You can also align the dynamic objects by pulling down the Scores menu and selecting "Dynamics" from the Align Elements submenu.
The Line/Trill tab

Octave symbols

The octave symbols (8va and 15va) act as a “local display transpose” (see “Transposing instruments” on page 565) – they shift the display of the score one/two octaves down.

• By dragging the end of the dotted line, you can specify exactly which notes are affected by the octave symbol. Only notes beneath the dotted line are display transposed.

• You can also right-click on the octave symbol and select the “Extend (+)” or “Reduce (-)” command to extend it to the next chord or to reduce it.

Tuplet group symbols

These are “graphical” tuplet group symbols, as opposed to the “real” tuplets.

• After inserting a tuplet group symbol, you can double-click on its number and enter any number from 2 to 32.

• In the Score Settings dialog (Project page–Notation Style subpage) you can specify globally how tuplets are displayed.

You can also select a font and size for the tuplet numbers in the Text Settings subpage.

• You can also right-click on the tuplet group symbol and select the “Extend (+)” or “Reduce (-)” command to extend it to the next chord or to reduce it.

Vertical symbols

The vertical symbols in the Line/Trill tab are “note-dependent”. This means that they must be inserted in front of a note. For more information see “Note layer symbols” on page 619 and the text about grace notes (which behave similarly) in the section “Grace notes” on page 615.

The Other tab

Lyrics and text symbols are described in the chapter “Working with text” on page 645. Chord symbols are described in the section “Inserting Chord symbols” on page 641.

Pedal down and up symbols

When you insert a Pedal down or up symbol, you also insert an actual MIDI event (damper pedal, control change 64) at that position. Similarly, inserting or recording a damper pedal event in another editor displays a pedal down/up symbol in the score.

• If the “Hide Pedal Markers” option is activated in the Score Settings dialog, Project–Notation Style subpage (Miscellaneous category), all pedal markers are hidden. Use this if you have recorded a lot of damper pedal messages, but do not want these to show in the score (for example if you are writing for an instrument other than piano).

A pedal down/up symbol combination can be displayed as “Two Symbols”, “Ped.” + Bracket” or as “Bracket only”. Just right-click on the pedal symbol and choose an option from the context menu. You can also set this in the Score Settings dialog, on the Project–Notation Style subpage (Miscellaneous category).

Repeats

Repeat signs (one and two bars) have a special feature: if you hold down [Shift]-[Ctrl]/[Command] when entering them, notes in the bars they relate to are automatically hidden (for more info on hiding symbols, see “Hiding/showing objects” on page 665).
Box (rectangle) symbol

This is a “generic” box symbol, which may be useful for different purposes. If you double-click on a box, a dialog opens in which you can specify whether the box is transparent or not, and whether the border is visible. This dialog can also be opened by selecting “Properties” from the context menu.

The box symbol is available on the “Other” and “Layout” tabs.

The keyboard symbol

This is described in the section “Adding a keyboard symbol” on page 625.

Additional symbols

If you click the “Other Symbol” button and then into the score, the “Select Symbol” dialog opens. Here you can choose note heads, accidentals and rests that work only as drawing elements, i.e. they do not insert any note data into the track. They do not affect MIDI playback! You can set the desired symbol font size directly in the Font Size field.

The Layout tab

Rehearsal marks

These come in two flavors: as numbers and as letters. When you place the first of these in the score, it is labeled 1 or A (depending which you choose on the tab), the second is then automatically labeled 2 or B, the next 3 or C, etc. If you delete one, the labeling of the others is shifted so that they always make up a complete series of numbers/letters.

- You can select a font and size for rehearsal marks on the Project–Text Settings subpage of the Score Settings dialog.
- This dialog also allows you to add a box or an oval around the rehearsal mark.
- Rehearsal marks can be added automatically, at the start position of each Marker in the project.
  - This is done using the “Marker track to Form” function.

Da Capo and Dal Segno symbols

The “D.C.”, “D.S.”, and “Fine” symbols provide a quick way to insert some common play directions into the score. The symbols are text symbols – you can adjust which font is used on the Project page (Text Settings subpage) of the Score Settings dialog, see “Settings for other fixed text elements” on page 654.

- To have these symbols actually affect playback, insert them from the Project tab and use the Arranger mode.
  - See “Scores and the Arranger mode” on page 685.

Endings

There are two types of endings, closed (“1”) and open (“2”). Both can be stretched to any length or height by dragging the handles. You can also double-click or right-click on the existing number and enter any text you like.
Endings are available on the Layout tab (for the layout layer), the Project tab (for the project layer), and the Line/Trill tab (for the note layer). Which one to choose depends on the score; while it is handy to insert endings once and for all as Project symbols, this does not allow you to make individual adjustments for the different parts.

- You can right-click on an ending symbol and select the “Extend (+)” or “Reduce (-)” command to extend it to the next chord or to reduce it.

**Tempo Indicator symbol**

This symbol allows you to insert the current tempo according to the tempo track. In other words, to make this symbol display a certain tempo, insert the value on the tempo track.

Normally this symbol shows the number of beats (quarter notes) per minute, but if you double-click or right-click it, you can select any note value. The number then changes accordingly.

**Tempo change according to note values symbol**

This symbol allows you to specify a tempo change as a change from one note value to another. The example above would mean “lower the tempo by a third”.

To change the note value for either symbol, double-click or right-click on it and select the desired note value from the context menu.

**User Symbols**

The User Symbols tab lets you create your own graphic symbols and use these in the score.

---

**Creating a user symbol**

Initially, the User Symbols tab is empty. To create symbols you use the User Symbols editor:

1. Double-click on the empty symbol field on the tab. The User Symbols editor opens. You can also right-click on an empty symbol field and select “Edit…” to open the same dialog.

2. Pull down the Functions pop-up menu and select the desired zoom factor from the View submenu. Often you want to work at a reasonably high zoom factor when drawing and editing symbols.

3. Use the tools and functions to draw a symbol. The available tools are listed in the table below.

When you are finished, you can close the editor and insert the symbol into the score, or you can create more symbols:

4. Select “New Symbol” from the Functions pop-up menu. An empty symbol field appears in the section to the left of the drawing area – this section corresponds to the actual User Symbols tab, showing all symbols that you have created.

5. Click the new empty symbol field on the left to make sure that it is selected. The drawing area is cleared.

6. Continue creating new symbols this way.

- You can edit existing symbols at any time by selecting them to the left and using the tools and functions. Any changes you make are automatically stored in the User Symbols tab for the project. You can also export symbols for use in other projects, see below.

- To insert a user symbol into the score, click on it on the tab and then click at the desired position in the score.
The User Symbols editor – tools and functions

The toolbar contains the following tools and settings, from left to right:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow</td>
<td>Use this to select objects – press [Shift] to select more than one. Click and drag to move objects – press [Ctrl]/[Command] to drag vertically or horizontally only or press [Alt]/[Option] to copy. To delete an object, select it and press [Backspace] or [Delete].</td>
</tr>
<tr>
<td>Line</td>
<td>Draws a straight line.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Creates a rectangle. You can fill this with the Fill button if needed.</td>
</tr>
<tr>
<td>Polygon</td>
<td>Creates a polygon – click where each corner of the polygon should be and close the figure by clicking outside the drawing area.</td>
</tr>
<tr>
<td>Circle</td>
<td>Creates a circle. You can fill this with the Fill button if needed.</td>
</tr>
<tr>
<td>Ellipse</td>
<td>Creates an ellipse. You can fill this with the Fill button if needed.</td>
</tr>
<tr>
<td>Arc</td>
<td>Creates an arc.</td>
</tr>
<tr>
<td>Text</td>
<td>Allows you to insert text objects. Clicking with this tool in the drawing area opens a dialog where you enter the text, specify font, style, etc. You can double-click on a text object you have inserted to change its text or settings.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Clicking with this tool brings up a dialog where you can select any of the existing score symbols and incorporate this (at the desired font size) into your own symbol.</td>
</tr>
<tr>
<td>Set Color of Frame</td>
<td>When this is selected, the Color pop-up menu is used to select the color for the object frame.</td>
</tr>
<tr>
<td>Set Color of Fill</td>
<td>When this is selected, the Color pop-up menu is used to select the fill color for objects (if Fill is selected)</td>
</tr>
<tr>
<td>Fill</td>
<td>Click this if you want the object to be filled – you can then select a Fill Color for it from the Color pop-up menu.</td>
</tr>
<tr>
<td>Don’t Fill</td>
<td>Click this if you do not want the object to be filled.</td>
</tr>
<tr>
<td>Color pop-up menu</td>
<td>Selects Frame or Fill Color for objects. The “Select Colors…” menu item brings up a standard color dialog.</td>
</tr>
<tr>
<td>Line Width</td>
<td>Allows you to change the line width used for the selected object.</td>
</tr>
</tbody>
</table>

The Note Linked pop-up menu lets you create symbols linked to note positions. This affects the whole symbol, not a selected graphic object:

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Linked</td>
<td>The symbol is not linked to notes.</td>
</tr>
<tr>
<td>Linked/Left</td>
<td>The symbol is linked to a note, appearing to the left of the note.</td>
</tr>
<tr>
<td>Linked/Center</td>
<td>The symbol is linked and centered to a note.</td>
</tr>
<tr>
<td>Linked/Behind</td>
<td>The symbol is linked to a note, appearing to the right of the note.</td>
</tr>
</tbody>
</table>

The Functions pop-up menu contains the following items (some of these can also be accessed on the context menu for the User Symbols tab):

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Symbol</td>
<td>Adds a new empty symbol to the tab (and to the symbol list to the left in the editor).</td>
</tr>
<tr>
<td>Delete Symbol</td>
<td>Deletes the current symbol from the tab.</td>
</tr>
<tr>
<td>Export User Symbols…</td>
<td>Allows you to save the current tab with all available symbols as a separate file on disk.</td>
</tr>
<tr>
<td>Import User Symbols…</td>
<td>Loads settings for a complete tab from disk. Note that this replaces the current settings.</td>
</tr>
<tr>
<td>Export/Import Symbol…</td>
<td>Lets you save or load individual symbols to/from disk. Importing a symbol replaces the current symbol on the tab.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected object(s).</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all objects in the current symbol.</td>
</tr>
<tr>
<td>Transform – Scale Symbol</td>
<td>Lets you scale (resize) the selected object by specifying a percentage.</td>
</tr>
<tr>
<td>Transform – Mirror horizontal/vertical</td>
<td>Mirrors the selected object along the horizontal or vertical axis.</td>
</tr>
<tr>
<td>Transform – Flip ±90</td>
<td>Rotates the selected object by + or – 90 degrees.</td>
</tr>
<tr>
<td>Draw – Group</td>
<td>Groups the selected objects so that they are treated as one.</td>
</tr>
<tr>
<td>Draw – Ungroup</td>
<td>Ungroups the selected group.</td>
</tr>
<tr>
<td>Align – Left/Right/Top/Bottom/Center Vertically/Center Horizontally</td>
<td>These items let you arrange the objects by moving them to the front or the back.</td>
</tr>
<tr>
<td>Display</td>
<td>Sets the zoom factor for the drawing area.</td>
</tr>
</tbody>
</table>
9

Working with chords
About this chapter

In this chapter you will learn:

• How to enter chord symbols manually and automatically using the “Make Chord Symbols” feature.
• Which settings can be made for chord symbols.

Inserting Chord symbols

Manually

• On the Chord Symbols tab, you can find a set of pre-defined chord symbols, see “Using presets” on page 642. If the symbol that you want to add is among these, simply select it and click in the score to insert the chord symbol.

To specify and enter any other chord symbol, proceed as follows:

1. Open the Other tab and select the chord symbol button.
2. Click in the score at the position where you want to insert the chord symbol. The Edit Chord Symbol dialog opens.
3. Enter the key (root) note in the Key Note field. You can either type in a chord letter or step through the chord letters using the up/down arrows to the right.
4. In the “Chord Type” field, specify a chord type. You can either enter it directly (for example, by typing a “7”) or select an option from the pop-up menu (click the arrow button to open it).
5. If you wish, specify a tension in the Tension field. Again, this can be done by typing or by using the pop-up menu. However, there are some special display options which you can only get by typing (see the table below). You might also want to add some text here (such as “no third”). You can also select the basic tensions from the pop-up menu, and then add special options by typing.

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>()</td>
<td>The tensions are enclosed in brackets.</td>
<td>C9(5)</td>
<td>C9(5)</td>
</tr>
<tr>
<td>/</td>
<td>The tensions are separated by a slash sign.</td>
<td>C9/5</td>
<td>C9/5</td>
</tr>
<tr>
<td></td>
<td>The tensions are placed above one another.</td>
<td>C9/5</td>
<td>C9/5</td>
</tr>
<tr>
<td>You can also combine several options. This is a combination of two options, along with a space to put the “9” above the “5”. Note that only one “(“ sign is needed when the “)” option is used.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| 6. If you want to have a special bass note (e.g. a C major with a D bass note), set the Bass Note pop-up menu to this note (this cannot be the same as the key note). The program “remembers” the relation between key and bass note, so that if you change the key note, the bass note follows.
7. If you want the key note to be displayed in lower case, activate the “Key Note in Lower Case” checkbox.
8. If needed, activate the “Enharmonic Shift” option.
9. Click Apply. The chord symbol appears in the score.
To open the Edit Chord Symbol dialog for an existing chord, double-click on the symbol. You can also right-click on the symbol and select “Properties” on the context menu to open the dialog.

**Using presets**

As with many other functions in Cubase, you can create chord symbol presets for instant use. Each preset contains all settings in the dialog – i.e. the preset list is a “library” of chords. You can find the presets in the Chord Symbols tab in the Inspector and in the corresponding context menu. The preset handling is the usual:

- Click Store to store the current settings as a preset. A dialog appears, allowing you to enter a name for the preset.
- To load a stored preset, select it from the Presets pop-up menu or select it from the Presets submenu of the context menu. Note that this only loads the settings into the dialog – you need to click Apply to apply the settings to a selected chord symbol.
- To remove a preset, select it on the pop-up menu and click Remove.

**Using Make Chord Symbols**

If you already have recorded the chords for a project, Cubase can analyze them and create chord symbols:

1. Open the recording in the Score Editor. If you want the chords to be inserted on another track, you can create an empty part on that track and open it along with the recording.
2. If you like, make display settings for the chords. These settings are available in the Score Settings dialog, on the Project page (Chord Symbols and Notation Fonts subpages). You can change all these settings after you inserted the chords as well.
3. Select the notes for which you want chord symbols to be created. If you want chord symbols to be created for all chords on the track, use the Select All function on the Edit menu.
4. Use the arrow keys to make the desired staff active. This should be the staff on which you want the chord symbols to end up.
5. On the Scores menu, select “Make Chord Symbols”. The chords appear. They can be moved, duplicated and deleted as any other symbol. You can also double-click on a chord symbol to edit it in the Edit Chord Symbol dialog (in the same way as when creating chords manually – see above).

A staff after using Make Chord Symbols.

- Instead of using the “Make Chord Symbols” menu item, you can click the “Make Chord Symbols” button on the extended toolbar.
- If the “Use for Make Chords” option is activated on the Project–Guitar Library subpage of the Score Settings dialog (see “Adding guitar chord symbols” on page 625), guitar chord symbols are added as well (if the guitar library contains any guitar symbols that match the chords).

**About the analysis**

The MIDI chords are expected to be played in their most basic inversion. If not, an extra bass note is added. For example, the notes CEG are interpreted as C major, but GCE is interpreted as C major with a G bass note. If you do not want any interpretation of the inversion (i.e. no added bass notes) hold down [Ctrl]/[Command] while selecting Make Chord Symbols. All selected notes on all staves are taken into consideration. Whenever there is any change on any staff, the notes are reinterpreted and a new chord symbol is added. This means you should probably avoid having the melody track in the Score Editor when you use Make Chord Symbols, or you get a lot more chords than you expect, possibly with strange tensions.

In addition to the above, the Quantize value is used. At the most, there is a new chord at each quantize position. There must be at least three notes at a certain position for the program to interpret it as a chord. Also some combinations of notes simply do not make any sense to the program and do not produce any chords.
The analysis method is not perfect since the same set of notes can be interpreted differently depending on context. Some editing may be required. If you record the track solely to create chords automatically, play the chord as simple as possible, in the correct inversion, without added octaves, etc.

The Current Chord Display

Cubase features a handy chord recognition function that helps you identify chords in the Score Editor note display. To find out which chord is formed by simultaneously played notes, place the project cursor over the notes. All notes currently “touched” by the project cursor are analyzed and the Current Chord Display in the status line shows you which chord the notes form.

Global chord settings

In the Score Settings dialog on the Project page (Chord Symbols and Notation Fonts subpages), there are several global settings that affect how chords are displayed. These settings affect all chords in the project.

Chord Symbols

![Chord Symbols](image)

Use the four sections of radio buttons to specify how the four most common chord types are displayed:

- If you want the root (key) note to be aligned with the bass note, so that they are both displayed at the same vertical position, activate “Align Root Note”.
- If you want the tensions to be displayed at the same vertical position as the root note (rather than a bit above the root note), activate “Tension Bottom”.
- Activate “Scale Chords” to scale a staff (using the Size setting on the Options tab of the Staff page in the Score Settings dialog), and want the chords to be scaled accordingly.
- Activate “Use Display Transpose” if you want the chord symbols to be affected by the Display Transpose setting on the Staff page of the Score Settings dialog.
- To apply the settings to your score, click “Apply to Chords”.

Notation Fonts

![Notation Fonts](image)

- Use the Score Font pop-up menu to select a font for the display of note heads, clefs, etc. Available are Legacy, Classical, and Jazz.
- Use the Chord Symbols Font pop-up menu to select a font for the chords. Cubase comes with its own font for this (Steinberg Chord Symbols), but you can also pick any other available font from the pop-up menu.
- Use the four size value fields to select sizes for the four different chord “elements”. You can type in values or use the pop-up menus. Normally, you would want the “Root” size to be the largest and the “Tension” size the smallest.
- Use the radio buttons at the bottom to select a chord display mode.
This affects how the key and bass notes are displayed:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>Regular notation.</td>
</tr>
<tr>
<td>DoReMi</td>
<td>“Do-Re-Mi-…” are used instead of “C-D-E-…”</td>
</tr>
<tr>
<td>German</td>
<td>As English notation, but “B” is displayed as “F”, and “Bb” or “A♯” are displayed as “B”.</td>
</tr>
</tbody>
</table>
10

Working with text
About this chapter

In this chapter you will learn:
• Which different types of text are available.
• How to enter and edit text.
• How to set font, size, and style.
• How to enter lyrics.

Adding and editing text symbols

This section describes the general procedure for adding and editing text symbols. As described in the section “Different types of text” on page 648, there are several different types of text symbols, but the basic procedures are the same (except for block text symbols, see “Block Text” on page 650, and page text symbols, see “Page text” on page 650).

Inserting a text symbol

1. Make sure that the correct staff is active.
2. If you wish, select a font, size, and style for the text (or select a text attribute), as described in the section “Selecting font, size, and style for the text” on page 647. You can also change these settings after you inserted the text.
3. In the Symbols Inspector, open the desired symbol tab. The different text symbols are found on the Other, Layout, and Project symbol tabs.
4. Click on the text symbol on the tab and click in the score at the position where you want the text to appear. If you are adding lyrics, you should click above or below a note (lyrics are centered around each note and positioned vertically to where you clicked). See “Lyrics” on page 648 for details.
5. Enter the text in the text box that appears. You can use [Backspace] to delete letters, and move the cursor with the arrow keys.
6. When you are done, press [Return]. The text appears. You can move, duplicate or delete it as with any symbol.

About the melisma lines

When you add a text symbol, you can find a handle at the right edge of the text. By dragging this handle to the right, you can extend a “melisma line” from the text. This has several uses:
• If you are adding lyrics and want to indicate that a syllable should be sung over several notes:

![Melisma Example](image1)

• If the text is an advice about articulation or playing style, and you want it to apply to a certain musical phrase only:

![Melisma Example](image2)

In the Score Settings dialog (Text tab), you can find two settings that determine the appearance of the melisma lines for text symbols:
• The Melisma Style pop-up menu is where you specify whether the line is solid or dotted.
• The Melisma End pop-up menu allows you to choose whether the end of the line is plain, has an arrow, or forms a “bracket” up or down.

Making space

• If you find that there is not enough space between staves, e.g., to add lyrics, please see “Dragging staves” on page 670 for info on how to separate the staves.
• If you find the score looks cramped after adding text, see “Auto Layout” on page 672.
Editing the text
If you made a mistake when typing or for some other reason want to change text, double-click on a text block with the Object Selection tool, edit the text and press [Return] to close it.

- It is also possible to replace all occurrences of a certain word in the score, without having to edit the texts manually, see “Find and replace” on page 652.

Selecting font, size, and style for the text
1. Select the text that you want to make settings for. If nothing is selected, the settings you make are the “default settings”. The next time you insert text, these settings are used.
2. Open the Score Settings dialog and select the Text page.
3. Select a font from the Font pop-up menu. How many and which fonts appear depends on what typefaces you have installed on your computer.

⚠️ For regular text you should avoid the “Steinberg” fonts. These are the fonts Cubase uses for all scoring symbols, etc.

4. Select a text size from the Size pop-up menu (or enter one manually in the text field).
5. You can also add one or several font options using the checkboxes and pop-up menus.

Most of the options are common text style variations such as bold, italic, underline, etc. But there are also a few special style options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame</td>
<td>Allows you to put the text in a rectangular (“Box”) or oval frame.</td>
</tr>
<tr>
<td>Melisma options</td>
<td>These determine the appearance of the “melisma line”, see “About the melisma lines” on page 646.</td>
</tr>
<tr>
<td>Positioning</td>
<td>Allows you to select which side of the text block (left or right) is used for calculating its position. This has an effect in situations where that text block is moved automatically (as a result of an Auto Layout function, when you move bar lines manually, etc.). If, for example, the text block appears just in front of a note (to the left of it), it appears in a more sensible position after the adjustment, if the “Right” option is selected.</td>
</tr>
<tr>
<td>Alignment:</td>
<td>Allows you to specify the alignment of the text. These options are only valid for texts with more than one line.</td>
</tr>
</tbody>
</table>

6. Click Apply to apply the settings to the selected text. Note that you can select other text blocks while the dialog remains open – the dialog is updated to reflect the settings of the currently selected text.
7. When you are done, close the Score Settings dialog.

Text attribute sets
A text attribute set can be seen as a “preset” containing all font, size, and style settings. By creating text attribute sets for the settings you use most often, you can save a lot of time.

Creating a text attribute set
1. Open the Score Settings dialog on the Project page and select the Text Settings subpage.
2. Open the Attribute Sets tab.
3. On the Font Set pop-up menu, select the “Empty” set.
4. Select a font, specify a size, and add style options using the checkboxes. The options are the same as when you make text settings on the Text page in the Score Settings dialog (see above).
5. Click in the text field of the Font Set pop-up menu and enter a name for the new text attribute set.
6. Click Store to store the new text attribute set.

Using text attribute sets
To apply the settings in the text attribute set to one or several text blocks, select them, select the set from the Font Set pop-up menu on the Text page in the Score Settings dialog and click Apply. You can also apply a text attribute set to a text block directly in the score by right-clicking it and selecting the set from the context menu.

- If you select a text attribute set on the Text page when no text is selected in the score, the settings are used the next time you insert some text.

⚠️ After you have selected a set for a text block, there is a “link” between the text and the attribute set. Any changes to the attribute set affects all texts that use it (see below). You can still edit any text settings manually (on the Project–Text Settings subpage) but then the “link” to the attribute set is removed.
Editing text attribute sets

If you edit the settings in a text attribute set, all texts using this particular set are affected. This is very practical, since it allows you to use the same number of “generic” sets for all your projects (for titles, comments, lyrics, etc.), and simply change the fonts, sizes, etc. for a different project if necessary. This also makes it easier to move projects between computers (which may not have the same fonts installed).

1. In the Score Settings dialog on the Project–Text Settings subpage, select the Attribute Sets tab.
2. From the Font Set pop-up menu, select the attribute set that you want to edit.
3. Change the settings as desired. This includes the name of the set.
4. Click Apply.

Different types of text

Regular text

This type of text is inserted by selecting Text in the Other or the Layout symbol tab.

The text is tied to the bar and staff position. If you move the bar or the entire staff, it moves with it.

Pasting text

You can paste text (e.g. from another program) into a text symbol in the score. To do this, select the text symbol and right-click it. Then, select “Text from Clipboard” from the context menu. This option is also available on the Functions submenu of the Scores menu.

Similarly, you can copy selected text by using the “Text to Clipboard” option from the context menu.

Lyrics

This type of text is inserted by selecting Lyrics on the Other symbol tab.

When you insert lyrics, you should click below or above the note the syllable belongs to. The text then appears horizontally centered around the note and vertically positioned to where you clicked. You can later move it up or down, as with any symbol.

Lyrics are tied to the note position. If you move the note, the text moves with it. The spacing between notes is also adjusted to make the lyrics fit.

Inserting lyrics for a number of notes

1. With lyrics selected, click below or above the first note with the Pencil tool.
2. A text input field opens. Enter the text (the word or syllable) for that note.
3. Press the [Tab] key.
The program moves on to the next note.

4. Input text for this note and press [Tab] again.
5. Proceed until the last note and then press [Return] or click outside the text box.

When you insert lyrics this way, the positions of the notes are automatically adjusted so that no lyric “block” overlaps another. If this is not what you want, you can activate the “Don’t Sync Lyrics” option in the Score Settings dialog on the Project–Notation Style subpage (Lyrics category). If this is activated, the note positions are not affected, which may be preferable.

- When entering words with several syllables you normally separate the syllables with a dash (-). By default, the dash signs are automatically centered between the syllables – if this is not what you want, activate the “Don’t Center Hyphens” option in the Score Settings dialog, on the Project–Notation Style subpage (Lyrics category).

Lyrics and measure widths
When you first enter lyrics, the result may look cramped, since the words take up more space than the notes (the lyrics are also selected just after entering the last word, which makes them look a bit odd when overlapping). To remedy this, use the auto layout function to automatically adjust the measure widths (see “Auto Layout” on page 672).

Adding a second verse
To insert a second line of lyrics, proceed as follows:
1. Enter the new lyrics above or below the existing verse.
2. Select all the words that should be in the new verse.
3. Right-click the selected words to open the context menu.
4. Select the appropriate verse from the Move To Verse submenu (Verse 1–6).
This assigns the selected lyrics to the selected verse.

To indicate that the words belong to another verse, they are automatically displayed in another color. However, all verses are printed in black as usual.
- To select all words in one verse only, press [Shift] and double-click on the first word in that verse. This selects all following words in the verse.

Inserting lyrics into voices
Each voice can have its own lyrics. If you have a vocal arrangement with several voices, you can add lyrics to them, one by one. Proceed as follows:
1. Make sure that the correct voice is selected (on the extended toolbar), see “Entering notes into voices” on page 597.
2. In the Symbols Inspector, open the Other tab and click on the Lyrics symbol.
3. Click on the first note in the selected voice.
4. Enter the lyrics for this voice, using the [Tab] key to move from note to note, as described above.
5. Start over, by activating the next voice, clicking on the first note in that voice and proceeding as with the first voice.
6. If needed, adjust the position of the lyrics for each voice (see below).

Moving lyrics
If you want to move the lyrics up or down, for example to make room for a second verse, proceed as follows:
1. Hold down [Shift] and double-click on the first word in the lyrics. All lyric “blocks” are selected.
2. Drag one of the lyric blocks up or down. All selected lyric blocks are moved accordingly.

Adding lyrics from the clipboard
If you want to prepare your lyrics in another program, you can import them into Cubase the following way:
1. Create the lyrics in another program. Separate words with space as usual, syllables within words with dash signs (-).
2. Copy the text.
3. In Cubase, select the first note to which the lyrics will be added.
4. Pull down the Scores menu and select “Lyrics from Clipboard” from the Functions submenu. The lyrics are added, starting at the selected note.

**Layout text**

The text symbols in the Layout symbol tab are part of the layout layer, and can thus be hidden or shown for different tracks in the layout, by activating the “L” column on the Layout page of the Score Settings dialog. The text appears in all staves for which you have activated the “L” column. This means it is tied to the bar and staff position. If you move the bar or the entire staff, it moves with it.

**Block Text**

Block Text allows you to import text from a file on disk or from the clipboard. Proceed as follows:

1. Click on the Block Text symbol on the desired tab to bring up the Pencil tool.
   You can choose between project layer block text (from the Project tab – useful for text that should appear on all pages, e.g. the score title), layout layer block text (from the Layout tab – if you want to print a title only for a particular track layout, e.g. for a particular instrument), or block text used for individual parts (from the Other tab – this text only appears in the score for a particular part).

2. Click in the score where you want to insert the text. A regular file dialog appears.

3. Select a file (TXT or RTF) to import.

4. Click Open. The text in the file is inserted into the score.

   - Right-clicking on inserted Block Text brings up a pop-up menu with the following options:

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings…</td>
<td>Brings up the RTF Settings dialog. You can also open this by double-clicking the Block Text.</td>
</tr>
<tr>
<td>Import Text…</td>
<td>Imports text from a text file or RTF file. The imported text replaces any text currently inserted at the position of the Block Text.</td>
</tr>
<tr>
<td>Update Text</td>
<td>Reloads the text from the file.</td>
</tr>
<tr>
<td>Text From Clipboard</td>
<td>Pastes the text from the clipboard into the Block Text.</td>
</tr>
</tbody>
</table>

**The RTF Settings dialog**

Selecting “Settings…” from the context menu (or double-clicking the Block Text) brings up a dialog with settings for the Block Text. These are:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Lets you select the font to use for the Block Text. If “No Change” is selected, the font in the original file (if applicable) is used.</td>
</tr>
<tr>
<td>Size</td>
<td>The text size, as a percentage.</td>
</tr>
<tr>
<td>Draw Frame</td>
<td>When this is activated, a frame is shown around the Block Text.</td>
</tr>
<tr>
<td>Word wrap</td>
<td>When this is activated, line breaks are used to fit the text in the Block Text symbol.</td>
</tr>
<tr>
<td>Replace mode</td>
<td>In this mode, the Block Text box is opaque, covering what’s under it.</td>
</tr>
<tr>
<td>Trans mode</td>
<td>In this mode, the Block Text box is transparent.</td>
</tr>
</tbody>
</table>

**Page text**

The page text symbols are found on the Layout and Project tabs. They work the same way, but project page text is part of the project layout, and therefore appears in all layouts.

The position of page text is not tied to a note, bar or staff position. In other words, it does not matter if you move other objects on the page, the page text stays where you inserted it. Typically, it is used for score titles, page numbers, copyright information and other text elements that you want displayed with all parts (on all pages if you like).

To enter page text, proceed as follows:

1. Open the Layout or the Project tab of the Symbols Inspector.

2. Click on the Page Text symbol and click in the score. It does not matter where you click – the positioning is specified in the Page Text dialog that appears.

3. Enter the text that you want displayed in the field at the top of the dialog. You can use special characters to add “variables” such as page numbers – see below.
4. Adjust the positioning settings for the text:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show on all pages</td>
<td>When this is activated, the text is shown on all pages. The “Except First” checkbox allows you to exclude the very first page.</td>
</tr>
<tr>
<td>Show on first page</td>
<td>When this is selected, the text is only shown on the first page.</td>
</tr>
<tr>
<td>Line</td>
<td>This determines how the text is aligned. For example, if you place several texts on “Top/Left”, you can sort them by entering the desired number of lines.</td>
</tr>
<tr>
<td>Toggle Position</td>
<td>When the Left or Right position option is selected to the right, activating this checkbox makes the text alternate between left and right alignment on even/odd pages.</td>
</tr>
<tr>
<td>Position buttons</td>
<td>Determines where on the page you want the text, vertically (Top/Bottom) and horizontally (Left, Center, Right).</td>
</tr>
</tbody>
</table>

5. Select a text attribute set for the text, or make manual settings for font, size, and style.

6. Click OK.
   The text is inserted. You can adjust the positioning manually by dragging the text block.

**Inserting variables**

When you enter the text, you can also insert special characters or “place holders” for different attributes. When the text is displayed, these characters are replaced by their actual values (e.g. page numbers). The following variables are available:

<table>
<thead>
<tr>
<th>Text to enter</th>
<th>Text that is displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>%p</td>
<td>The current page number.</td>
</tr>
<tr>
<td>%l (lower case L)</td>
<td>The long staff name.</td>
</tr>
<tr>
<td>%s</td>
<td>The short staff name.</td>
</tr>
<tr>
<td>%r</td>
<td>The name of the project.</td>
</tr>
</tbody>
</table>

For example, if you enter the text “%l, %r, Page %p”, these variables might be shown as “1st Violin, Quartet No.2, Page 12” in the score.

**Using the Score Settings (Text page)**

In the Score Settings dialog on the Text page, you can find a number of text-related settings. The symbol buttons correspond to the symbols found on the Other, Layout, and Project tabs of the Symbols Inspector, see “Symbol details” on page 634.

- On the Layer pop-up menu, select the layer that you want to use.
  The text symbols available for this layer is displayed to the left of the pop-up menu.
- You can use the text symbols in the same way as you would use symbols from the Inspector or a symbol palette. When you select a text symbol and move the mouse pointer over the score, the pointer changes to a pencil, and you can enter text at the position you click on.

**The Notepad tab and the Selection tab**

Below the text symbols and the Layer pop-up menu, you can find two tabs with large text entry fields.

- Use the Notepad tab to enter longer text passages.
  When you are happy with the text in terms of wording and length, select all or part of the text, and select a note in the score. Now, the Insert Lyrics button below the Notepad tab becomes available.
  When you click Insert Lyrics, the selected text is entered into the score, starting from the note you selected.
- When you select text in the score and open the Selection tab, the selected words are shown in the text field. You can now change the wording of the text, and use the text format options to the left to change the appearance of the selected text. When you are done, click Apply to apply your changes to the selected text in the score.
Text functions

The Words tab
If you have certain words that you use a lot, you can “store” these as dedicated symbols on the Words tab. This saves time, since you do not have to type the same word over and over again.

Storing a word
1. Open the Words symbol tab. This tab is hidden by default. See “Showing/Hiding Symbols Inspector tabs” on page 620 for information on how to display hidden Inspector tabs.
2. Double-click on an “empty” symbol. The Custom Text Editor dialog appears.
3. Type in the desired word(s) in the text field at the top of the dialog.
4. Specify the text type (regular text or lyrics) with the Type pop-up menu.
5. Make settings for font, size, and style. You can also use a text attribute set if you like.
6. Click Exit to close the dialog. The words that you entered appear in the selected symbol field on the Words tab.

• Right-clicking one of the fields opens a context menu with a number of options:
  • Select “Edit…” to open the Custom Text Editor dialog.
  • Select “New” to add a new empty symbol to the Words tab.
  • Select “Remove” to delete any unwanted symbols from the Words tab.
  • Select “Open As Palette” to open the Words symbol palette.

Inserting a word
You insert words from the Words tab as you would insert any regular symbol, by selecting the appropriate word and clicking in the score. However, you can edit the word after inserting it, just as with text inserted by typing.

Find and replace
This function allows you to replace all occurrences of a certain word or group of words, with another word or group of words. The replacement is done once and for all, for all text symbol types, regardless of font, size, and style settings. Proceed as follows:
1. Pull down the Scores menu and select “Find and Replace” from the Functions submenu. The Find and Replace dialog opens.
2. In the Find value field, enter the words to replace.
3. If you want all instances of the words to be replaced, regardless of upper/lower case, deactivate the “Case Sensitive” option.
4. If you do not want to replace the words if they are a part of another word, activate the “Entire Word” option. For example, if you want to replace the word “string” but not the word “stringendo”, you should activate “Entire Word”.
5. In the “Replace” field, enter the words that are to be used as replacement.
6. Click OK.
Now all occurrences of the “Find” words are replaced with the “Replace” words.

**Staff names**

You can make settings for staff names in several places:

- In the Score Settings dialog on the Layout page, you specify whether the staff names are shown at all and whether to use the names of the actual edited tracks in the score.
  In a multi-track layout, you can choose for which tracks the staff names are shown by clicking in the “N” column for each track.
- You specify a long and short staff name in the Score Settings dialog, on the Staff page (Main tab). These are used if you do not use the “From Tracks” option on the Layout page of the Score Settings dialog. The long name is displayed for the first system only, and the short name for the following systems. If you want a name at the top of the page only, leave the “Short” name field empty.

⚠️ If the “Show Long Staff Names on new Pages” option is activated in the Score Settings dialog on the Project–Notation Style subpage (Staff Names category), the long name is displayed for the first system on every page.

To select a font for staff names, proceed as follows:

1. Open the Score Settings dialog on the Project page and select the Text Settings subpage.
2. Select the Project Text tab.
3. Use the “Font for” pop-up menu to select “Staff Names”.
4. Select font, size, and styles for the staff names (or use a text attribute set).
5. Click Apply and close the Score Settings dialog.

**Additional staff name settings**

- If you activate the “Show Track Names to Left of staff” option in the Score Settings dialog on the Project–Notation Style subpage (Staff Names category), the staff names are shown to the left of the staves, instead of above them.
- You can define separate subnames for the upper and the lower staff in a polyphonic or split system, see “Staff names” on page 588.

- You can fine-tune the vertical and horizontal position of staff names with some of the options on the Project–Spacing subpage of the Score Settings dialog.

**Bar Numbers**

Bar Number settings can be made in several places as well.

**General settings**

1. Open the Score Settings dialog on the Project page and select the Notation Style subpage.
2. Scroll down the list to the “Bar Numbers” category.
3. Use the “Show every” setting to specify how often bar numbers are shown.
   The options are “First Bar” (bar numbers shown for the first bar on each staff), “Off” (no bar numbers shown) and any number. Click in the Status column and use the mouse wheel to select the desired option.
4. If you like, activate the “Show Range with Multi-Rests” option.
   When this is activated, and you have a multi-rest, the bar number at the beginning of the multi-rest shows a range, indicating the length of the multi-rest.
5. If you want the bar numbers to be displayed below the bar lines, activate the “Below Bar Lines” option.
6. Click Apply and close the Score Settings dialog.

**Text settings**

As with many of the other fixed text elements, you can select a font, size, and style for bar numbers in the Score Settings dialog, on the Project–Text Settings subpage.

**Spacing**

On the Project–Spacings subpage of the Score Settings dialog, you can find four settings that relate to bar numbers:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Bar Number – Horizontal Offset</td>
<td>Sets the horizontal distance between the bar number and the bar line for the first bar on each staff.</td>
</tr>
<tr>
<td>First Bar Number – Vertical Offset</td>
<td>Sets the vertical distance between the bar number and the bar line for the first bar on each staff.</td>
</tr>
<tr>
<td>Other Bar Numbers – Horizontal Offset</td>
<td>Sets the horizontal distance between the bar number and the bar line for all other bars.</td>
</tr>
<tr>
<td>Other Bar Numbers – Vertical Offset</td>
<td>Sets the vertical distance between the bar number and the bar line for all other bars.</td>
</tr>
</tbody>
</table>
**Offsetting bar numbers**

If you double-click on a bar number, a dialog appears, allowing you to skip a number of bars in the otherwise continuous bar numbering.

This is used for example when a section repeats. Say, you have a repeat of bar 7 and 8, and want the first bar after the repeat to have the number 11, not 9. To achieve this, you double-click on the “9” and insert an offset of “2”.

It is also useful if the score starts with an upbeat, and you want the first “real” bar to be numbered 1. In that case you would specify an offset of “-1” for the second bar, and make sure that the bar number for the upbeat bar is hidden.

- Bar number offsets belong to the Project layer and are shown for all tracks and layouts.

**Settings for other fixed text elements**

You can make text settings for virtually all text and numbers that appear in the score. Proceed as follows:

1. Open the Score Settings dialog on the Project page and select the Text Settings subpage.
2. Select the Project Text tab.
3. Use the “Font For” pop-up menu to select a text type to make settings for.
4. Use the options in the dialog to change the settings.
5. Click Apply to apply the settings to all elements of the selected type.

To close the dialog, click the close button at the top right of the dialog window.

![Bar Numbers before and after changing their text settings.](image)

- You can also define text attribute sets on the Text Settings subpage, as a means to quickly change text. Note that you can select a defined attribute set from the context menu opened when right-clicking on a text element (see “Text attribute sets” on page 647).
11

Working with layouts
About this chapter

In this chapter you will learn:

• What layouts are and what they contain.
• How to create layouts.
• How to use layouts for opening combinations of tracks.
• How to apply, load, save and delete layouts.
• How to import and export layouts.
• An example of how layouts can be used.

Background: Layouts

Layouts can be viewed as “presets” containing settings for the layout layer: staff spacing, bar lines, layout symbols, etc.

When to use layouts

• You need to format the score differently when you print the entire score and when you extract parts for single instruments (or groups of instruments). Layouts allow you to keep different sets of “looks” for the same track or set of tracks. You might for example have one layout for each single instrument and one for the entire score.
• By selecting another layout on the Layout page of the Score Settings dialog, you can switch to another combination of tracks without having to leave the Score Editor.

What makes up a layout?

A layout contains the following items and properties:

• The inserted Layout symbols (see “The available symbols” on page 621).
• All settings on the Layout page of the Score Settings dialog.
• The vertical spacing of the staves.
• Bar line spacing.
• Broken bar lines.

Note that Project symbols (see “The available symbols” on page 621), bar line types and bar number offsets are part of the Project layer, and appear in all layouts.

How layouts are stored

Layouts are created automatically when you edit a single track or a combination of tracks. They are an integral part of the specific track combination, which means you do not have to store them separately.

Creating a layout

Layouts are created automatically when you open a new combination of tracks for editing.

Each track may have been edited before, individually or together with other tracks, it does not matter. What matters is that you open precisely these tracks. For example, to create a layout for a string quartet, select parts on the corresponding tracks and press [Ctrl]/[Command]-[R].

⚠️ The order of the tracks does not matter – you can reorder them in the Project window without removing the layout. However, the spacing of the staves in the layout is related to the order of the tracks.

Opening a layout

The “Open Layout” command on the Scores menu opens a dialog listing all available layouts for the Project.

• Select the desired layout in the list and click OK to open the tracks contained in the layout in the Score Editor. This is a quick way for opening several tracks in the Score Editor directly from the Project window.

Layout operations

The Score Settings dialog contains a Layout page, where you can make settings for the different layouts. To the left of the dialog, all existing layouts in the project are listed (this is the same list as in the Open Layout dialog, see above). The layout currently used is highlighted in the list.
Opening the tracks in a layout

To select another combination of tracks for editing, select the corresponding layout in the list.

- You can keep the dialog open while you are editing, and use this function for selecting which tracks to edit.

Importing layout symbols

By selecting another layout and selecting “Get Form” from the Functions pop-up menu below the list, you import all Layout symbols (inserted from the Layout section in the Symbols Inspector) from the selected layout into the current layout.

Managing layouts

- To rename a layout, select it in the list and enter the desired name in the Name field to the right in the dialog. Initially, a layout gets the name of one of the edited tracks – it may be a good idea to give each layout a more informative name.
- To remove a layout you no longer need, select it in the list and select “Remove” on the Functions pop-up menu.
- To remove all layouts for which there no longer are track combinations, select “Clean Up” on the Functions pop-up menu.

Importing and exporting layouts

By selecting a layout and selecting “Export…” or “Import…” from the Functions pop-up menu below the list, you can export or import a Layout. Note that all Staff settings are taken into account, when exporting or importing a layout.

Working with Display Transpose

You can specify for each staff in a layout whether it should use Display Transpose. In the Score Settings dialog on the Layout page, click in the D column to activate or deactivate the option. Note that this setting affects this layout only.

Using layouts – an example

The following text outlines the basic steps for extracting a musical part from a full score.

1. Prepare the entire score, including all formatting. This might include inserting project layer block text for the score title, setting the bar line type, etc.
2. Open the Score Settings dialog on the Layout page and enter the desired name in the Name field (for example “Full Score”).
3. Close the Score Editor.
4. Open a single track, for example a woodwind part. The Project layer settings automatically appear in the new single track layout.
5. Prepare a layout for the woodwind part. You might for example move bar lines, add endings, activate multiple rests, etc.
- You can also import all layout symbols from the “Full Score” layout, by opening the Score Settings dialog on the Layout page, selecting the “Full Score” layout in the list to the left, and selecting “Get Form” from the Functions pop-up menu (see “Importing layout symbols” on page 657).

⚠️ Be careful not to change any of the properties which are not part of the layout. This modifies the “Full Score”, too.

6. Enter the desired name for the new layout in the Name field on the Layout page of the Score Settings dialog and click “Apply”.

Using layouts – an example

The following text outlines the basic steps for extracting a musical part from a full score.

1. Prepare the entire score, including all formatting. This might include inserting project layer block text for the score title, setting the bar line type, etc.
2. Open the Score Settings dialog on the Layout page and enter the desired name in the Name field (for example “Full Score”).
3. Close the Score Editor.
4. Open a single track, for example a woodwind part. The Project layer settings automatically appear in the new single track layout.
5. Prepare a layout for the woodwind part. You might for example move bar lines, add endings, activate multiple rests, etc.
- You can also import all layout symbols from the “Full Score” layout, by opening the Score Settings dialog on the Layout page, selecting the “Full Score” layout in the list to the left, and selecting “Get Form” from the Functions pop-up menu (see “Importing layout symbols” on page 657).

⚠️ Be careful not to change any of the properties which are not part of the layout. This modifies the “Full Score”, too.

6. Enter the desired name for the new layout in the Name field on the Layout page of the Score Settings dialog and click “Apply”.

Using layouts – an example

The following text outlines the basic steps for extracting a musical part from a full score.

1. Prepare the entire score, including all formatting. This might include inserting project layer block text for the score title, setting the bar line type, etc.
2. Open the Score Settings dialog on the Layout page and enter the desired name in the Name field (for example “Full Score”).
3. Close the Score Editor.
4. Open a single track, for example a woodwind part. The Project layer settings automatically appear in the new single track layout.
5. Prepare a layout for the woodwind part. You might for example move bar lines, add endings, activate multiple rests, etc.
- You can also import all layout symbols from the “Full Score” layout, by opening the Score Settings dialog on the Layout page, selecting the “Full Score” layout in the list to the left, and selecting “Get Form” from the Functions pop-up menu (see “Importing layout symbols” on page 657).

⚠️ Be careful not to change any of the properties which are not part of the layout. This modifies the “Full Score”, too.

6. Enter the desired name for the new layout in the Name field on the Layout page of the Score Settings dialog and click “Apply”.

Using layouts – an example

The following text outlines the basic steps for extracting a musical part from a full score.

1. Prepare the entire score, including all formatting. This might include inserting project layer block text for the score title, setting the bar line type, etc.
2. Open the Score Settings dialog on the Layout page and enter the desired name in the Name field (for example “Full Score”).
3. Close the Score Editor.
4. Open a single track, for example a woodwind part. The Project layer settings automatically appear in the new single track layout.
5. Prepare a layout for the woodwind part. You might for example move bar lines, add endings, activate multiple rests, etc.
- You can also import all layout symbols from the “Full Score” layout, by opening the Score Settings dialog on the Layout page, selecting the “Full Score” layout in the list to the left, and selecting “Get Form” from the Functions pop-up menu (see “Importing layout symbols” on page 657).

⚠️ Be careful not to change any of the properties which are not part of the layout. This modifies the “Full Score”, too.

6. Enter the desired name for the new layout in the Name field on the Layout page of the Score Settings dialog and click “Apply”.

Using layouts – an example

The following text outlines the basic steps for extracting a musical part from a full score.

1. Prepare the entire score, including all formatting. This might include inserting project layer block text for the score title, setting the bar line type, etc.
2. Open the Score Settings dialog on the Layout page and enter the desired name in the Name field (for example “Full Score”).
3. Close the Score Editor.
4. Open a single track, for example a woodwind part. The Project layer settings automatically appear in the new single track layout.
5. Prepare a layout for the woodwind part. You might for example move bar lines, add endings, activate multiple rests, etc.
- You can also import all layout symbols from the “Full Score” layout, by opening the Score Settings dialog on the Layout page, selecting the “Full Score” layout in the list to the left, and selecting “Get Form” from the Functions pop-up menu (see “Importing layout symbols” on page 657).

⚠️ Be careful not to change any of the properties which are not part of the layout. This modifies the “Full Score”, too.

6. Enter the desired name for the new layout in the Name field on the Layout page of the Score Settings dialog and click “Apply”. 
Marker Track to Form

If you have created markers in the Project window which denote the start of each new “section” in your music (verse, bridge, chorus, etc.), you can automatically transfer these markers into the current layout:

1. Pull down the Scores menu, open the Advanced Layout submenu and select “Marker Track to Form”. Now, rehearsal marks and double bar lines are inserted in the score, at the position of each marker.

2. If you want the names of the markers shown as well, open the Advanced Layout submenu again and select “Display Markers”.

Working with layouts
12

Working with MusicXML
Introduction

MusicXML is a music notation format developed by Recordare LLC in 2000 based primarily on two academic music formats. It allows the representation of scores in the current symbolic representation of western music notation, used since the 17th century. With Cubase you can now import and export MusicXML files created with version 1.1. This makes it possible to share and exchange sheet music with people who are using score writing programs such as Finale and Sibelius.

As MusicXML is supported to various degrees by different programs, you always have to do manual adjustments.

What is MusicXML used for?

The MusicXML file format can be used for the following purposes:
- Representation and printing of sheet music
- Exchange of sheet music between various score writing programs
- Electronic distribution of musical scores
- Storage and archiving of scores in an electronic format

Notational representation vs. musical performance

MusicXML is a music notation file format, that means it deals especially with the layout of music notation and the correct graphical representation, i.e. how a piece of music should look.

However, MusicXML music data also contains elements that define how a piece of music should sound. For example, these are used when creating a MIDI file from MusicXML. This means that MusicXML has things in common with MIDI.

MIDI is a music interchange format for performance applications like Cubase or other sequencers. The MIDI file format is designed for playback, i.e. the main focus of the MIDI file format lies in the performance, not in the notation.

Is MusicXML better than MIDI?

Advantages of MusicXML

MIDI tracks hold MIDI notes and other MIDI data. A MIDI note in Cubase is only defined by its position, length, pitch and velocity. This is not enough to decide how the note will be displayed in a score. For a correct representation, Cubase also needs the following information:
- Stem direction, beaming.
- Expression marks (staccato, accent, ties and slurs).
- Information about the instrument in the score.
- Key and basic rhythm of the piece.
- Grouping of notes, etc.

MusicXML can store a great part of this information. However, you have to adjust the scores with the tools available in the Score Editor.

Advantages of MIDI

Although MusicXML has obvious advantages in the representation of musical scores, there are also restrictions in sound. This is due to the fact that MusicXML as a music notation format has a graphical background and is designed for exchanging representation, not sound.

When playing back MusicXML files in Cubase, the following parameters, among others, are not considered:
- On and Off velocities
- Dynamics
- Controller data
- SysEx
- Standard MIDI file meta events
- Audio
- All Cubase-specific data like automation, MIDI effects, Input Transformer, etc.
## Importing and exporting MusicXML files

Cubase can import and export MusicXML files, which makes it possible to transfer musical scores to and from applications that support this file format. However, there are some restrictions concerning the parameters supported by Cubase:

<table>
<thead>
<tr>
<th>Notes</th>
<th>Export</th>
<th>Import</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Length</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Staves</td>
<td>Yes</td>
<td>Up to two per part</td>
</tr>
<tr>
<td>Voices</td>
<td>Yes</td>
<td>Up to four per staff</td>
</tr>
<tr>
<td>Accidentals</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ties</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Dots</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Stem</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Beams</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Grace Notes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Rests</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Layout</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Size</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Page margins</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Page scaling</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Page breaks</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>System breaks</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Distance between staves and systems</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Left/right Inset</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Distance between measures</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Hidden staves</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>x and y positions of symbols</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Symbols</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keys</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Clefs</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Time Signature</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Dynamics</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ornaments</td>
<td>Yes / incomplete</td>
<td>Yes / incomplete</td>
</tr>
<tr>
<td>Articulations</td>
<td>Yes / incomplete</td>
<td>Yes / incomplete</td>
</tr>
<tr>
<td>Technicals</td>
<td>Yes / incomplete</td>
<td>Yes / incomplete</td>
</tr>
</tbody>
</table>

### Notes Export Import

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Lyrics</td>
<td>Yes</td>
</tr>
<tr>
<td>Chord Symbols</td>
<td>Yes</td>
</tr>
<tr>
<td>Damper Pedal</td>
<td>Yes</td>
</tr>
<tr>
<td>Dynamics</td>
<td>Yes</td>
</tr>
<tr>
<td>Rehearsals</td>
<td>Yes</td>
</tr>
<tr>
<td>Text</td>
<td>Yes</td>
</tr>
<tr>
<td>Layout Text</td>
<td>Yes</td>
</tr>
<tr>
<td>Global Text</td>
<td>Yes</td>
</tr>
<tr>
<td>Dashes</td>
<td>Yes</td>
</tr>
<tr>
<td>Endings</td>
<td>Yes</td>
</tr>
<tr>
<td>Octave Shift</td>
<td>Yes</td>
</tr>
<tr>
<td>Bar line types</td>
<td>Yes</td>
</tr>
<tr>
<td>Slurs</td>
<td>Yes</td>
</tr>
<tr>
<td>Hammer-on/pull-off</td>
<td>No</td>
</tr>
<tr>
<td>Formatting</td>
<td></td>
</tr>
<tr>
<td>Display Transpose</td>
<td>Yes</td>
</tr>
<tr>
<td>Drum notation</td>
<td>Yes</td>
</tr>
<tr>
<td>Short / long staff names</td>
<td>Yes</td>
</tr>
<tr>
<td>Program changes</td>
<td>Yes</td>
</tr>
<tr>
<td>Music font</td>
<td>Yes (if Jazz font)</td>
</tr>
<tr>
<td>Tablature (including String tunings)</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Importing MusicXML files

1. Pull down the File menu and open the Import submenu.
2. On the submenu, select “MusicXML...”.
3. In the file dialog that opens, locate and select the MusicXML file and click “Open”.
4. Another file dialog opens in which you can select the project folder for the new project. Select an existing project folder or create a new one by clicking “Create” and entering a name in the dialog.
5. A new project is created with the name of the MusicXML file.
Exporting MusicXML files

1. Set up the score the way you want it in the Score Editor of Cubase.

2. Open the File menu and open the Export submenu.

3. On the submenu, select “MusicXML…”. Note that this option is only available when the Score Editor is open.

4. A file dialog opens in which you can choose an existing empty folder or create a new folder for saving the MusicXML file (with the extension “.xml”).
Designing your score: additional techniques
About this chapter

In this chapter you will learn:

• How to change the staff size.
• How to create multi-rests.
• How to add and edit bar lines.
• How to create upbeats.
• How to set measure spacing and the number of bars across the page.
• How to control staff and grand staff spacing.
• How to use the Auto Layout dialog.
• How to use the Reset Layout function.
• How to break bar lines.

⚠️ Before you start designing the score page layout, you should open the Page Setup dialog on the File menu, and make settings for paper size, print scale and margins!

Layout settings

The Layout page of the Score Settings dialog contains a number of settings that affect the display of the current layout.

The track list

The track list lists the tracks included in the layout and allows you to make the following settings:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brackets</td>
<td>These two columns allow you to add braces or brackets, encompassing any number of staves in the layout, see “Adding brackets and braces” on page 672.</td>
</tr>
<tr>
<td>T</td>
<td>This is relevant if the “Modern Time Sign.” option is activated to the right. In that case, you use this column to specify for which tracks the time signature is shown – see below.</td>
</tr>
<tr>
<td>N</td>
<td>This option lets you specify for each staff in a layout whether the staff name is shown.</td>
</tr>
<tr>
<td>L</td>
<td>If this is activated, any layout symbols are shown; otherwise they are hidden. For example, this allows you to have rehearsal marks shown for the top staff only in a multi-staff layout.</td>
</tr>
<tr>
<td>D</td>
<td>This option lets you specify for each staff in a layout whether it should use Display Transpose.</td>
</tr>
</tbody>
</table>

Equal Spacing

Activate this option when you want a note to take up space according to its note value. When Equal Spacing is activated, two sixteenth notes take up as much space as one eighth note, for example.

Size

Changes the size of all staves, see “Staff size” on page 665.

Multi-Rests

Whenever more than one-bar rests occur, the program can replace these with a multi-rest symbol. This parameter allows you to set how many empty bars are “allowed” before Cubase collects them into a multi-rest. “Off” means “never”. See “Multiple rests” on page 667 for more information on multi-rests.

Real Book

When this option is activated, clef symbols are not set out at the beginning of each staff, only on the first staff on each page.
Staff Separators
When this option is activated, separator symbols are inserted at the beginning of each grand staff.

A staff separator between two systems

Modern Time Signature
When this is activated, time signatures are shown above the staves rather than in them. You can set the size of the modern time signature in the Time Sign section on the Project–Notation Style subpage of the Score Settings dialog. When modern time signature is selected, you use the “T” column in the track list in the Layout page to specify for which tracks time signatures are displayed.

• If you prefer to display the score in a more modern way, check out the other options on the Notation Style subpage. For descriptions of the options use the Help button in the dialog.

Staff size

For one staff
You can set the staff size as a percentage value of the normal size.

1. Make sure that the staff you want to edit is active.
2. Open the Score Settings dialog on the Staff page and select the Options tab.
3. Adjust the Size parameter in the System Sizes section. The values range from 25% up to 250% of the normal size.
4. Click Apply.

For all tracks in a layout
1. Open the Score Settings and select the Layout page.
2. Change the Size parameter. The values range from 25% up to 250% of the normal size.
3. Click Apply.

All staves now get the desired size. Staves that have individual size settings (see above) still are proportionally smaller/larger.

This setting is part of the layout and can be used when printing a full score slightly smaller than the parts for each instrument, for example.

Hiding/showing objects
Any object on a page can be hidden, including notes, rests, symbols, clefs, bar lines, even entire staves.

This can be useful in the following situations:

Printing scales
If you want to create scale examples, enter the notes and hide time signatures, bar lines and other unwanted objects.

A scale created with hidden bar lines, time signatures, etc.

Graphic notation
By hiding bar lines, you can produce graphic notation.

Hiding notes meant for playback only
If you have recorded your music, you may have added glissandos, falls, etc. that sound fine but result in a lot of unnecessary notes. You probably want to hide those notes and insert the suitable symbols instead.
**Hiding**

To hide items, proceed as follows:

1. Select all the items you want to hide.
2. Select “Hide/Show” from the Score menu or click on the “H” (Hide) button on the extended toolbar.

- Notes can also be hidden by selecting them, clicking the “i” button on the extended toolbar and ticking the Hide Note checkbox in the Set Note Info dialog (see “Other note details” on page 607).

**Hiding in the current layout only**

If you want the hiding to be “local” to the current layout, hold down [Ctrl]/[Command] when selecting “Hide/Show” as described above.

⚠️ This is not possible when hiding notes, only other symbols.

⇒ You can also move hidden objects to the layout by right-clicking the “Hide” marker and selecting “Move to Layout”.

**Viewing hidden objects**

The filter bar (shown by clicking the “Set up Window Layout” button on the toolbar and activating the Filters option) contains two options related to hidden objects:

- If you activate the “Hidden Notes” option, all hidden notes in the score are shown.
  Deactivating “Hidden Notes” hides the notes again.
- If you activate the “Hide” option, all hidden objects (except notes) are indicated by a “Hide” text marker.

**Showing one object**

1. Make sure that “Hide” is activated on the filter bar.
2. Click on the “Hide” text marker below the object you want to display again.
   The text is selected.
3. Press [Backspace] or [Delete].
   The object appears. Undo is available if you change your mind.

**Showing all objects**

If you select “Hide/Show” from the Scores menu again, all hidden objects are displayed.

- You can also use the Reset Layout function to permanently display hidden notes and objects, as described in the section “Reset Layout” on page 674.

**Showing a hidden note**

While all hidden notes can be made visible by ticking the Hidden Notes checkbox on the filter bar, you may want to make some of them “permanently” visible again:

1. Activate the Hidden Notes checkbox on the filter bar.
2. Select the notes that you want to “un-hide”.
   In the Preferences dialog (Scores–Use Colors for Additional Meanings) you can set the color for hidden notes.
3. Double-click one of the notes.
4. Deactivate the Hide Note option in the Set Note Info dialog and click Apply.

**Coloring notes**

You can use the color pop-up menu on the toolbar to colorize selected notes, e.g. for educational purposes. This is described in detail in the section “Coloring notes” on page 608.
Multiple rests

Multiple consecutive rests can be automatically displayed as multi-rests. Proceed as follows:

1. Open the Score Settings and select the Layout page.
2. Set the Multi-Rests option to the number of empty bars that are “allowed” before Cubase displays them as a multi-rest.
   For example, a value of 2 means that three or more consecutive empty bars are displayed as a multi-rest. If you set this to “Off”, multi-rests are not used.
3. Click Apply and close the dialog.
   The multi-rests now appear in the score.

A multi-rest over three bars

Splitting multi-rests

To divide one long multiple rest into several shorter ones, proceed as follows:

1. Double-click on the multi-rest symbol.
   The Split Multi-Rest dialog appears:

2. In the dialog, enter the bar number where you want the first split.
3. Click OK.
   If you need more splits, double-click on any multi-rest symbol and proceed as above.

⚠️ The program automatically splits multi-rests at time signature changes, double bar lines, repeat signs and rehearsal marks.

Multi-rest appearance

The Project page in the Score Settings dialog contains several subpages, on which you can make settings for multi-rests:

- The subpage “Notation Style” contains the following settings concerning multi-rests:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-Rests – Church Style</td>
<td>When this is activated, multi-rests are shown in “church style” (vertical bars), rather than with the regular, horizontal symbols.</td>
</tr>
<tr>
<td>Multi-Rests – Numbers above</td>
<td>Symbol When this is activated, the numbers are shown above the multi-rest symbol, instead of below it.</td>
</tr>
<tr>
<td>Multi-Rests – Snap Rests</td>
<td>moved with the Layout tool When this is activated, rests automatically snap to “intelligent” positions in the score (i.e. positions used in regular notation) when moved with the layout tool. If this is deactivated, rests can be positioned freely.</td>
</tr>
<tr>
<td>Bar numbers – Show Range</td>
<td>with Multi-Rests When this is activated, and bar numbers are displayed, the bar numbers of a multi-rest are shown as a range.</td>
</tr>
</tbody>
</table>

- On the Spacings subpage of the dialog, you can adjust the height and width of multi-rest symbols.
- On the Text Settings subpage, you can select a font for the multi-rest numbers (select “Multi-Rests” in the “Font For” pop-up menu and make the desired settings).

Editing bar lines

Editing existing bar lines

For each bar line, you can choose whether you want a regular, single bar line, a double bar line, a repeat sign, etc.:

1. Double-click on the bar line for which you want to edit the settings.
   A dialog appears with a number of bar line types.

![](image)

Designing your score: additional techniques
2. If you want the bar line to be shown with “brackets”, activate the Brackets checkbox. This is only relevant for repeat signs.

3. Click on the desired bar line type. The dialog closes and the bar line type is changed.

4. If you do not want to display bar lines at the beginning of the parts, open the Score Settings dialog on the Project–Notation Style subpage (Bar Lines category) and activate the “Hide First Bar line in Parts” option.

The bar line types are part of the Project layer – any changes you make are reflected in all layouts.

Creating upbeats

By using the Pickup Bar feature

With this method, the upbeat actually contains exactly the number of beats displayed. That is, if you have an upbeat of one beat, your project starts with one bar in 1/4 time.

1. Change the time signature of the first bar to the length of the upbeat.

2. Insert a time signature of the correct kind (the time signature used throughout the project) in the second bar. To insert a time signature, select it in the “Time Signature” section in the Symbols Inspector and click in the Score with the Pencil tool.

3. Enter the notes in the upbeat into the first bar.

4. Double-click the time signature for the upbeat bar. The Edit Time Signature dialog appears.

5. Activate the “Pickup Bar” option and click OK.

Now, the time signature of the first bar takes on the look of the second bar’s signature, while the time signature in the second bar is hidden.

6. If you use bar numbers, double-click on the first bar number and enter an offset of -1.

7. Adjust the display of bar numbers and hide the “0” in the first measure.

By hiding rests

With this method, the first bar actually gets the same time signature as the following bars – it only looks like an upbeat bar:

1. Enter the notes in the upbeat into the first bar.

The first bar before making any adjustments

2. Hide the rests that precede the notes.

3. Drag the bar line between measure one and two to adjust the width of the bar.

After hiding the rest and dragging the bar line

4. If you like, move the notes in the upbeat measure, using the Layout tool.
Designing your score: additional techniques

5. If you use bar numbers, adjust them as described in the previous example.

\[\begin{align*}
&\text{The final upbeat} \\
\end{align*}\]

Setting the number of bars across the page

Automatically

- When you open a new combination of tracks for editing, the number of bars across the page is determined by the “Default Number of Bars per Staff” setting in the Preferences dialog (Scores–Editing page).
- In the Auto Layout dialog (see “Auto Layout” on page 672), you can set the maximum number of bars across the staff.

Manually

In Page Mode, you have full control over the number of bars appearing across the page, by using the Number of Bars dialog or the tools.

If you want to use the “Max. number of Bars” option in the Auto Layout dialog (see “Auto Layout” on page 672), you should do this before you adjust the number of bars manually.

Using the Number of Bars dialog

1. Make a staff active in the system where you want to make changes. This means that if everything looks fine until for example the fifth system, activate one of the staves in this system.
2. Pull down the Scores menu and select “Number Of Bars” from the Advanced Layout submenu. The Number of Bars dialog opens.
3. Set the desired number of bars across the page.

Using the tools

- To change the number of bars for the active staff only, click “This Staff”.
- To change the number of bars for the active staff and all following staves, click “All Staves”.
  In other words, to set all systems on all pages to the same number of bars, make the very first staff active and use the All Staves option.

Before and after moving the third bar one staff down

- To make a bar “fall down” on a new staff, use the Split tool to click on its bar line.
- To bring the bar back up to the previous staff, use the Glue tool to click on the last bar line on the upper of the two staves. This in fact moves all measures in the lower staff to the upper staff.
Moving bar lines
The following operations can be made using the regular Object Selection tool or the Layout tool.

Moving a bar line
If you drag a bar line to the left or right, the surrounding bars are adjusted proportionally.

Moving bar lines on all staves
If you hold down [Alt]/[Option] when dragging a bar line, all bar lines below the one you drag are moved accordingly.

Moving a single bar line separately
If you hold down [Ctrl]/[Command] while dragging a bar line, the widths of the surrounding bars are not affected.

Making an indent on one line
• To create an indent, simply drag the first or last bar line on a staff.
  The sizes of all measures are adjusted proportionally.

Making indents on several lines
If you hold down [Alt]/[Option] and drag the first or last bar line in a system, all following systems get the same indent. If you want all lines on all pages to be modified in the same way, hold down [Alt]/[Option] and drag the appropriate bar line on the first system of the score.

The last bar line in the score
Cubase attempts to move the last bar line and space the bars on the last line in a sensible way. But you can change this manually by dragging the last bar line, if you like. To change the type of the last bar line, double-click it and select the desired type.

Resetting bar spacing
To reset the bar spacing to standard values for several lines, proceed as follows:
1. Locate the first line for which you want to reset the bar spacing, and make one staff in that system active.
2. Select “Number of Bars” from the Advanced Layout submenu on the Scores menu.
3. Specify the number of bars that you already have on the line.
4. Click on “This Staff”. Clicking “All Staves” resets the lines of all staves in the score, see “Using the Number of Bars dialog” on page 669.
5. Close the dialog. The bar spacing is reset for the currently selected staff and all following staves.

Dragging staves
For the following operations, you can use the Object Selection tool or the Layout tool.

Dragging staves can only be done in Page Mode.

Adding space between two grand staves
1. Locate the first staff in the lower of the two systems that you want to spread apart.
2. Click just to the left of the first bar line and keep the mouse button pressed. The entire staff is selected.
3. Drag downwards or upwards and release the mouse button. The new distance is set for the two staves.

Before…

…and after dragging the upper system

Setting the same distance between all grand staves
1. Hold down [Alt]/[Option] and drag the desired staff of the second system, until you have reached the desired distance between this and the first system.
2. Release the mouse button. The distances between all the systems are adjusted accordingly.

⚠️ This operation affects the system you drag and all following systems.

Setting the distance between staves within a grand staff
1. Locate the lower staff in the grand staff that you want to spread apart.
2. Click just to the left of its first bar line and keep the mouse button pressed. The entire staff gets selected.

Setting the same distance between staves in several systems
1. Hold down [Alt]/[Option] and drag the desired staff as described above.
2. Release the mouse button. The corresponding staves in all following systems are moved accordingly.

Moving one staff only
You may want to move one staff without affecting any other staff in any way:
1. Hold down [Ctrl]/[Command].
2. Drag any staff as described above.

Moving staves between pages
By using the “Move to Next/Previous Page” commands on the Staff context menu, you can quickly edit the page breaks.

Moving staves to the next page
1. Locate and activate the staff you want to move to the top of the next page. This can be any staff except the first staff on the page.
2. Right-click on the blue rectangle to the left of the staff, and select “Move to Next Page” from the context menu. The active staff (and any following staves on the page) are moved to the next page.
Moving staves to the previous page

1. Make the staff at the top of the page the active staff. If any other staff is active, the “Move to Previous Page” option cannot be used. Also, the function does not work for the first staff on the first page.

2. Right-click on the blue rectangle to the left of the staff, and select “Move to Previous Page” from the context menu. The active staff, and as many of the following staves as there are room for, are moved to the previous page. If the previous page is already “full”, nothing happens.

Adding brackets and braces

Brackets and braces are added on the Layout page of the Score Settings dialog. The settings you make are specific for the current layout, i.e. you can have different brackets or braces set up for different track configurations.

1. Open the Score Settings and select the Layout page. In the track list, you can find columns for braces ( { ) and brackets ( [ ).

2. Click in one of the columns and drag downwards in the list to encompass the desired staves. The column indicates graphically which staves are encompassed by the brace or bracket.

3. Close the dialog. The score is displayed with brackets or braces according to the settings you made.

- You can edit brackets and braces in the dialog by dragging the ends of the indicator in the list.
- To remove a bracket or brace, click on its indicator in the list.
- You can automatically get broken bar lines based on the brackets you have added – see “Breaking bar lines” on page 674.

If the “Show Braces in Edit Mode” option is activated in the Preferences dialog (Scores–Editing page), brackets and braces are shown in Edit Mode as well.

Auto Layout

This item on the Scores menu brings up a dialog with several options. Activating one of these makes the program “go through” the score and make adjustments to measure widths, staff distances, etc. Exactly which parts and properties of the score are affected depends on which option you activate/deactivate.

The automatic layout adjustments are done just as if you yourself had made them manually. This means that if there is something you do not like, you can always change it manually, as described above.

You can also open the Auto Layout dialog by clicking the Auto Layout button on the extended toolbar.
Move bars
This option looks at the currently active grand staff, and attempts to adjust the measure widths, so that all notes and symbols get as much room as possible. The number of bars on the staff is not affected.

- You can perform this function for several staves in one go, by dragging a selection rectangle over their left edges, and then selecting Move Bars.

Move Staves
This changes the measure width (as with Move Bars) but also the vertical staff distance, of the active staff and all following staves.

Spread Page
This corrects the vertical layout of the staves on the current page, so that they “fit onto the page”. In other words, this removes white space at the bottom of the page.

Hide Empty Staves
This hides all empty staves, from the active staff to the end of the score. Note that polyphonic/split staves are in this case treated as one entity, if the clef in the upper system differs from that in the lower system. That is, a piano staff is considered “empty” only if there are no notes on either staff.

- If you have activated the “Hidden” option on the filter bar, hidden staves are indicated by a marker with the text “Hide:Name” (where “Name” is the staff name). To display hidden staves, delete their “Hide” markers.

- If you activate the “Auto Layout: Don’t hide first staff” option in the Preferences dialog (Scores–Editing page), staves in the very first grand staff are not hidden, even if they are empty.

This is useful for example if you are creating an orchestra score, and want to show the complete “layout” of the orchestra on the first page of the score, without hiding anything.

All Pages
Activate this if you want to apply the options above to all pages. Please note that this setting is applied to the active staff and onwards. If you want all pages in the score to be affected, you have to make the very first staff (the first staff on the first page) the active staff.

Move Bars and Staves
This is a combination of “Move Bars”, “Move Staves”, and “All Pages”, plus automatic calculation of the number of bars across the page – the function tries to optimize the number of bars across the page for each staff (with the maximum number of bars as set in the dialog).

Optimize All
All of the above in one fell swoop. This procedure might take some time but usually yields great results.

Other functions
In the lower part of the dialog, the following options are available:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Space/Page Mode</td>
<td>The higher the value, the more space is allowed for each element in the score (and thus, the fewer the bars across the page).</td>
</tr>
<tr>
<td>Minimum Distance between Staves</td>
<td>When you use an Auto Layout function that moves staves (changes the vertical staff distance), this setting determines the minimum distance between the staves.</td>
</tr>
<tr>
<td>Minimum Distance between Grand Staves</td>
<td>This sets the minimum distance between Grand Staves in the same way.</td>
</tr>
<tr>
<td>Add to Auto Layout Distance</td>
<td>This number is added to the distance between staves that is added when you use any of the Auto Layout functions. The higher the number, the larger the distance between staves.</td>
</tr>
<tr>
<td>‘Spread Page’ Bottom Distance</td>
<td>This is added to the white space that appears on the bottom of a page when using the Spread Page functions.</td>
</tr>
<tr>
<td>Max. Number of Bars</td>
<td>This allows you to specify the maximum number of bars per staff when using the “Bars and Staves” or “Optimize All” functions.</td>
</tr>
</tbody>
</table>

◊ The functions “Move Bars” and “Move All Bars” (“Move Bars” + “All Pages”) can also be accessed via the Staff context menu (opened by right-clicking on the blue rectangle to the left of the active staff).
Reset Layout

This function allows you to delete invisible layout elements, which in effect restores the score to default settings.


The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hidden Notes</td>
<td>Makes all hidden notes permanently visible again.</td>
</tr>
<tr>
<td>Hidden</td>
<td>Makes all other hidden objects permanently visible again.</td>
</tr>
<tr>
<td>Quantize</td>
<td>Deletes all Display Quantize elements.</td>
</tr>
<tr>
<td>Layout tool</td>
<td>Resets all positions of notes, clefs, slurs and ties altered using the Layout tool.</td>
</tr>
<tr>
<td>Grouping</td>
<td>Resets the grouping under beams to standard values.</td>
</tr>
<tr>
<td>Cutflag</td>
<td>Deletes all cutflag events.</td>
</tr>
<tr>
<td>Stems/Beams</td>
<td>Resets the length of all stems and reset the slant of beams that have been manually adjusted.</td>
</tr>
<tr>
<td>Coordinates</td>
<td>Removes all manual spacing of note symbols and slurs.</td>
</tr>
</tbody>
</table>

2. Activate the items you want to delete or reset to standard settings.

3. Click on “This Staff” to clean up the active staff only, or on “All Staves” to clean up all staves in the score.

Breaking bar lines

Sometimes you may not want a bar line to stretch all the way across a grand staff. If this is the case, you have the possibility to “break it”.

Manually

**Breaking bar lines in one grand staff**

1. Select the Erase tool.

2. Click on a bar line connecting the two staves.

All bar lines between these two staves (except the first and last) are broken. To break the first or last bar line in a grand staff, you need to click directly on these.

**Breaking bar lines in several grand staves**

If you hold down [Alt]/[Option] and click on a bar line as described above, the corresponding bar lines are broken in all following grand staves.

**Re-connecting broken bar lines**

If you have broken the bar lines, you can use the Glue tool to connect them again.

1. Select the Glue tool.

2. Click on one of the bar lines in the staff above the broken bar lines.

All bar lines between these staves in this grand staff are connected.

- To re-connect bar lines in several grand staves, hold down [Alt]/[Option] and click with the Glue tool.

The bar lines between the corresponding staves are connected in all following grand staves.
Automatically

If you have added brackets for some staves on the Layout page of the Score Settings dialog (see “Adding brackets and braces” on page 672), you can have bar lines broken between each bracketed “section”, giving a clearer indication of which staves belong together:

1. Open the Score Settings dialog from the Score menu and, on the Project page, select the “Notation Style” sub-page.

2. In the Bar Lines section, locate and activate the “Break Bar Lines with Brackets” option.

• The option Break Last Brackets determines whether the breaking of bar lines should also apply to the bar line at the end of each row.
Scoring for drums
About this chapter

In this chapter you will learn:

- How to set up the drum map.
- How to set up a staff for drum notes.
- How to enter and edit drum notes.
- How to use a single line drum staff.

Background: Drum maps in the Score Editor

When scoring for drums, you can assign a unique note head to each pitch. There is even the possibility to set up different note heads for different note values!

However, to be able to fully use this function, you need to understand a bit about drum maps, and the use of these in the Score Editor.

About drum maps

Cubase handles drum editing by means of drum maps (see the chapter “The MIDI editors” on page 374). In the Score Editor, the drum map displays different note heads for different pitches.

You access the drum map by selecting “Drum Map Setup” from the MIDI menu.

Use Score Drum Map on/off

For the drum map settings to be used in the score, you need to activate the “Use Score Drum Map” option in the Score Settings dialog on the Staff page (Options tab).

Setting up the drum map

Basic settings

1. Open the Score Editor for the drums track. This should be a MIDI track to which you have assigned a drum map.
2. Open the Score Settings dialog and select the Staff page.
3. Select the Options tab and activate the “Use Score Drum Map” option.
5. Make settings for the sounds/MIDI notes you need. The dialog contains the following score-related options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch</td>
<td>This corresponds to the I-note of the sound in the drum map, and cannot be edited here.</td>
</tr>
<tr>
<td>Instrument</td>
<td>The name of the drum sound in the map.</td>
</tr>
<tr>
<td>Display Note</td>
<td>The display pitch, i.e. the pitch at which the note are shown in the score. For example, you typically want all three hi-hat sounds to be shown on the same system line in the score (but with different symbols). Therefore, you set these to the same display pitch.</td>
</tr>
<tr>
<td>Head Symbol</td>
<td>Clicking in this column opens a window in which you can select a note head symbol for the sound. If “Use Head Pairs” is activated in the dialog, you can select a note head pair instead.</td>
</tr>
<tr>
<td>Voice</td>
<td>This allows you to make all notes with this pitch belong to a certain voice, so that they get a common rest handling and stem direction, for example.</td>
</tr>
</tbody>
</table>

Basic settings

1. Open the Score Editor for the drums track.
2. Open the Score Settings dialog and select the Staff page.
3. Select the Options tab and activate the “Use Score Drum Map” option.
5. Make settings for the sounds/MIDI notes you need.

The dialog contains the following score-related options:
Please note that many different drum maps can be created for a project. Which one you get depends on which drum map is assigned to the edited track. These drum maps are totally independent of one another, i.e. each pitch can have different settings in different drum maps.

Initializing the display pitches
If you select “Init Display Notes” from the Functions pop-up menu in the top left corner of the Drum Map Setup dialog, all display pitch values are reset, so that actual pitch and display pitch are the same for each sound/note.

Using note head pairs
Not only can you have different drum sounds displayed with different note heads, you can also display different note heads for different note values:

1. Activate the “Use Head Pairs” checkbox. The “Head Symbol” column now shows two head symbols for each drum sound.

<table>
<thead>
<tr>
<th>Head Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ ○</td>
</tr>
<tr>
<td>○ □</td>
</tr>
<tr>
<td>□ □</td>
</tr>
<tr>
<td>□ ○</td>
</tr>
</tbody>
</table>

All head symbols are arranged in pairs – by default an “empty” head and a “filled” head. Just as with regular notes, the “empty” note heads are used with half notes and larger note values, and the “filled” heads are used with quarter notes and smaller note values.

2. To select a head pair for a drum sound/note, click in the Head symbol column to open the pop-up menu and choose the new head pair.

Customizing note head pairs
If you do not like the default pairs of note heads, you can edit these:

1. On the Functions pop-up menu, select “Edit head pairs”.

2. To change a symbol in a pair, click on it and select a new symbol from the pop-up menu.

3. When you are done, click Exit to close the dialog.

Editing the drum map in the score
If you activate the “Edit in Scores” option in the Drum Map Setup dialog, you can change the settings for the score drum map directly in the score:

- Transposing a note changes the display pitch of its drum sound – the actual note is not transposed.
- Double-clicking a note allows you to make note head settings for that drum sound.
- Using the “Move to Voice” function changes the voice assignment of the drum sound.

This requires that you leave the Drum Map Setup dialog open – closing the dialog automatically deactivates this option, allowing you to perform normal editing.
Setting up a staff for drum scoring

1. Open the Score Settings dialog on the Staff page and select the Options tab.
2. Make sure that “Use Score Drum Map” is activated.
3. If you want a single line drum staff, activate the corresponding option (see “Using “Single Line Drum Staff” on page 679).
4. If you want flat beams, activate the corresponding option (see “Handling beaming” on page 608).
5. If you want all stems to end at the same position, activate Fixed Stems and set a length for up/down stems.

- You may also want to use polyphonic voices to handle rest and stem separately. However, you can still activate the “Fixed Stems” option if you like. See the chapter “Polyphonic voicing” on page 593 for more information about polyphonic voices.

Using “Single Line Drum Staff”

When this option is activated on the Options tab of the Staff page in the Score Settings dialog, there is only one line in the system. Furthermore, notes can only appear below the line, on the line and above the line.

To decide which notes go where, proceed as follows:

1. Open the Score Settings dialog on the Staff page and select the Options tab.
2. Activate “Use Score Drum Map” and “Single Line Drum Staff”.
3. Set up the two pitch values to decide which pitches go on the line. Notes below this range automatically wind up below the line and notes above wind up above the line.

⚠️ When you enter and edit the pitch of notes on a single line drum staff, the best way is to drag the note up or down while watching the Mouse Note Position display in the status line.

Entering and editing notes

This is like entering notes on a normal note system. However, Notes are edited using their display pitch when the drum map is used. This means that when you move a note vertically, you move it to another display pitch. What actual pitch it gets depends on which pitch uses the display pitch you now “dropped it on”.

⚠️ If the drum map contains two notes with the same pitch (for example Open and Closed HiHat), you can get the second note by holding [Ctrl]/[Command].
15

Creating tablature
Creating tablature

About this chapter

In this chapter you will learn:

• How to create tablature, automatically and manually.
• How to control the appearance of the tablature notes.
• How to edit tablature.

Cubase is able to produce score in tablature format. This can be done automatically, by “converting” recorded MIDI information. You can also create a tablature staff from scratch and enter the notes “by hand”.

Creating tablature automatically

This assumes you have a regular score on screen already. We also suggest you perform basic editing like quantizing to make the score as legible as possible as regular notes before converting into tablature.

1. Make sure that the notes in the score are inside the range of the instrument. Notes with a pitch lower than the open tuning of the lowest string cannot be converted.

2. Open the Score Settings dialog on the Staff page and select the Tablature tab.

3. Activate “Tablature Mode”.

4. Select one of the predefined instruments from the pop-up menu.

• If you are not using one of the predefined instruments, set the open tuning of each string using the value fields. You can create tablature for up to 12 strings. To disable a string, set it to Off, the lowest value.

5. If you want to use a capodaster, e.g. on the forth fret, enter the corresponding value in the Capo field. The tablature changes accordingly.

6. Make the desired settings for “No Stems/Rests” and “MIDI Channel 1–6”.

   No Stems/Rests gives you a score where the notes have no stems and where all the rests are hidden. The “MIDI Channel 1–6” feature is described below.

7. Click Apply.

   The tablature appears. You get as many note lines as you have activated strings. All the notes now have a fret number instead of their regular note heads.

Using “MIDI Channel 1–6”

This feature makes notes automatically appear on the correct string according to their MIDI channel value.

Normally, the program automatically decides on which string to display a note, by looking at the pitch and then putting the note at the lowest possible string. You can then either manually move a note to the correct pitch, or use the “MIDI Channel 1–6” option to let the program move the notes automatically.

Even though we use the term “converting” in this chapter, please note that tablature is a mode. You can switch between regular notation and tablature at any time.
1. Many guitar synthesizers are able to transmit each string on a different MIDI channel. If you have such an instrument, set it up so that the high E string transmits on MIDI channel 1, the B string transmits on MIDI channel 2, etc.
   This feature can be used for MIDI string instruments with up to six strings.

2. Record the project. Quantize and edit it as desired.

3. Make sure that the "MIDI Channel 1–6" option is activated and convert the notes into tablature, as described above.

4. The notes are automatically placed on the right strings. For example if you played a "B" on the low E-string, it appears as a "7" on that string, not as a "2" on the A-string.

Creating tablature manually

To set up an empty system for inputting tablature, proceed as follows:

1. Double-click on the clef symbol in the score to open the Edit Clef dialog.

2. Change the clef to the tablature symbol.

3. Open the Score Settings dialog on the Staff page and select the Options tab.

4. Set the “System Lines” to as many strings as the instrument you are scoring for has.

5. Raise the Add Space value to 1 or 2.
   You need a little extra space between note lines to make room for the numbered note heads.

6. On the Tablature tab, activate “Tablature Mode”.

7. Set up whatever other parameters you need in the dialog, and click Apply.

8. Select the Insert Note tool and move the pointer over the score.

9. Press the mouse button and drag up and down until the note appears on the desired string with the correct fret number (you can also verify the pitch on the toolbar, as usual).
   When you drag up and down, the program automatically selects the lowest possible string. If you want a fret number higher than 4 on a guitar tablature, for example, you have to use “Move To String”, see below.

10. Release the mouse button.
    The note is displayed.

Tablature number appearance

In the Score Settings dialog on the Project–Text Settings subpage, you can find text settings for the tablature numbers. In the “Font For” pop-up menu, select “Tablature” and then select the desired font, size, and style for the number note heads.


**Editing**

Tablature can be edited like any other score. You can move notes, handle beaming, stem direction, etc.

**Moving notes to another string**

If you want for example a “C” to appear as a “8” on the low E-string rather than a “3” on the A-string on a guitar, proceed as follows:

1. Select one note or a number of notes that you want to move to a new string.
2. Right-click on one of the selected notes and, from the “Move to String” submenu, select the desired string. The Fret number is automatically adjusted according to the tuning of the instrument (as set up on the Tablature tab of the Staff page in the Score Settings dialog).

**Moving notes**

Moving notes in pitch in a tablature score is working the same way as entering notes manually, see above.

**Editing on the info line**

You can change the pitch of notes on the info line as usual. The string and fret number are updated automatically in the score.

**Note head shape**

If you only want to enter a fret number for your notes (Tablature mode off), you can use the Set Note Info dialog on regular notes.

1. Double-click on the head of a note. The Set Note Info dialog appears.
2. Activate the Tablature option and set a fret number in the value field to the right.
3. Click Apply.
The score and MIDI playback
About this chapter

In this chapter you will learn:

• How to use the Arranger mode to have the playback follow the structure of the score.
• How to use the “mapped” Dynamics symbols.

Cubase only: You can also play back articulations in the Score using the Expression Map and Note Expression functions, see "Expression maps (Cubase only)" on page 419 and "Note Expression (Cubase only)" on page 428.

Scores and the Arranger mode

Repeats (bar lines) appear in all layouts, as well as Project symbols like Segnos, Codas, Da Capo, endings, etc. To have the playback in Cubase follow these directions, proceed as follows:

1. Add the desired repeats and project symbols to the score.
2. Right-click the toolbar in the Score Editor and make sure that “Arranger” is ticked.
   This adds the Arranger buttons to the toolbar.
3. Click the “Activate Arranger Mode” button on the toolbar and start playback.
   Playback follows the repeats and Project symbols in the score — sections within repeat symbols are repeated, the playback position jumps to the beginning when encountering a Da Capo symbol, and so on.

Working with mapped dynamics

Apart from the dynamics symbols found on the Dynamics tab, you can also use 12 “mapped” Dynamics symbols. These make use of the Note Expression functionality in Cubase, see the chapter “Note Expression (Cubase only)” on page 419. Mapped Dynamics symbols can be played back using three different methods: by modifying the velocity values in percentages, by sending volume controller messages or by sending additional generic controllers. These methods can also be combined.

Setting up the symbols

You can make settings for the symbols in the Dynamics Mapping Setup dialog. On the left in the upper section, the available symbols are listed.

• To open the dialog, right-click on one of the symbols on the Dynamics Mapping tab in the Symbols Inspector and select “Dynamics Mapping...”.
   When mapped dynamics symbols have been added to the score, you can also double-click on a symbol to open the dialog.
In the dialog, you can make the following settings:

**Change Velocities**
You can create dynamics by defining different velocities for the different symbols. Proceed as follows:
1. Activate the “Change Velocities” checkbox in the lower section of the dialog.
2. Set up a percentage value (positive or negative) in the Velocity column to specify by how much the corresponding symbol will raise or reduce the current velocity value of a note.

**Send Volume**
You also have the possibility to define the dynamics by sending Volume controller values. Proceed as follows:
1. Activate “Send Volume” in the lower section of the dialog, and select whether you want to use the MIDI controllers 7 or 11 or the VST 3 parameter Volume (if the instrument you are using is compatible with VST 3).
2. Set up a percentage value (positive or negative) in the Volume column to specify by how much the corresponding symbol will raise or reduce the current volume of a note.

When “Send Volume” is activated and set to VST 3 Volume, the VST 3 volume events in the notes are being merged with the volume specified for the Dynamics symbols, according to the Merge Mode setting, see below. However, make sure that the edited part does not contain events for MIDI controller 7 (Main Volume) or 11 (Expression) on the controller lane.

**The Merge modes**
When you use the parameter VST 3 Volume in the notes and for the dynamics symbols, the result depends on the Merge Mode. The following modes are available:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average</td>
<td>When this is selected, the average of the two volume messages will be used for the notes.</td>
</tr>
<tr>
<td>Merge</td>
<td>When this is selected, the VST 3 Volume setting for the Dynamics symbols modulates the existing VST 3 Volume setting of the notes. Higher settings increase the volume and low settings decrease the volume set for the note.</td>
</tr>
</tbody>
</table>

**Send Controller**
You can also send an additional MIDI controller (except MIDI controllers 7 and 11, which are used for the “Send Volume” function).
If you combine this with the “Send Volume” function, you can set up a sound which gets brighter as it gets louder, which is useful when working with strings or woodwind and brass instruments.
To set up an additional controller, proceed as follows:
1. Activate “Send Controller” and specify the controller you want to use in the pop-up menu. You can select any of the available MIDI controllers, but also VST 3 parameters (except Volume, Pan, and Pitch).
2. Set up a percentage value (positive or negative) in the Controller column to specify by how much the corresponding symbol will raise or reduce the controller value of a note.

**Initializing the Dynamic Range**
You can specify the dynamic range for the work with mapped dynamics symbols using the pop-up menu in the middle section of the dialog.
If you select “pp-ff”, the extreme Dynamics symbols (pppp, ppp, ffff, and fff) do not have an effect. If you select “pppp-ffff”, the whole dynamic range will be used.

**Using dynamics symbols in the Score Editor**

**Inserting dynamics symbols**
Once you have set up the dynamics as desired, you can use the symbols in the Score Editor.
- Select the desired symbol on the Inspector tab and click at the position in the Score Editor at which you want to insert the symbol.
Note that the “mapped” dynamics symbols have a different color scheme than the regular dynamics symbols.
• Crescendi and Decrescendi are updated intelligently, i.e. when you have inserted a crescendo between two dynamics symbols and the order of these symbols is reversed, the decrescendo automatically becomes a crescendo.

• When you insert a crescendo symbol which is not preceded by a Dynamic symbol, the “assumed” start value is mezzo forte (mf).

• Likewise, if a crescendo symbol is not followed by a dynamic symbol, an end value will be calculated automatically. For a crescendo, this is one value above the start value, and for a decrescendo one value below the start value.

Modifying/Editing dynamics symbols

You can change the settings for the dynamics symbols at any time in the Dynamics Mapping Setup dialog, as described above.

• You can step between the available dynamics symbols by using the commands “One up” and “One down” on the context menu, by using the corresponding key commands, or by clicking the “+” and “−” buttons on the toolbar.

When several dynamics symbols are selected, they will all be modified accordingly.
Tips and Tricks
Overview
This chapter provides useful information about editing techniques and answers to a number of questions that might arise when you use the Score Editor. For more information about the functions referred to, please use the index and check the previous chapters.

Useful editing techniques
Use this section to find out more about some editing techniques that help you to use the score functions more efficiently.

Moving a note without transposing it
If you hold down [Ctrl]/[Command] while moving a note (or several notes), only horizontal movements are possible, so that you do not have to worry about the notes being transposed. You can also set up a key command for this. This is done in the Key Commands dialog (Nudge category).

Moving and spacing several staves
If you have a number of staves that you want displayed with an equal distance (for example, all strings of a grand staff in a full orchestra score), this can be done using the Position Info window:

1. Open the Preferences (Scores–Editing page) and deactivate the “Global staff spacing with [Alt Gr]/[Option]-[Command]” option.
2. In the score, select the staves you want to set to an equal distance.
3. Open the Position Info window by clicking on the ruler.
4. Use the To Previous Staff or To Next Staff settings to specify the desired distance between the staves.

   • If you do this when the “Global staff spacing with [Alt Gr]/[Option]-[Command]” option is activated, all staves in the score are affected.

Polyphonic voicing
If you are working on a full score with more than one instrument in one staff (2 flutes, 2 trumpets, etc.), you should use polyphonic voices. And even if both instruments play the same notes, you should insert notes for both instruments (you can mute the notes of the second voice, if playback is an issue). If you do this, it is much easier to extract single parts later by using the “Extract Voices” command.

Using the bar handles
Double-clicking a bar handle opens the Bar Copy dialog. This function is great for copying accents, but you can also use it for copying drum phrases, etc. For more information, see “Moving and duplicating with the bar handles” on page 631.

   • If you hold down [Shift] and double-click on a bar handle, this and the next bar are selected. This is handy when copying phrases of two or more bars in one go.

Copying a section with “invisibles”
If you want to copy and paste a section which contains hidden elements, adjusted beams and stems, etc., there are two ways to proceed:

   • Use the filter bar to make indicators appear in the score. Then select these indicators together with the notes before you copy. This ensures the notes are copied with their formatting, etc.

   • Double-click the bar handle of one of the bars, and make sure all relevant event types are activated in the dialog. Then select the bars you want to copy by clicking their bar handles, and copy them by [Alt]/[Option]-dragging the bar handles.

   For more information, see “Moving and duplicating with the bar handles” on page 631.

Using “Scores Notes To MIDI”
This function converts the score data, as displayed, into MIDI data. Let’s say for example that you have set up the score so that it is displayed to 99% the way you want it to be. Yet, last 1% forces you to deactivate some of the Staff Settings (like Clean Lengths, No Overlap, or Auto Quantize), which makes other parts of the score illegible.
In this case, try using the “Scores Notes To MIDI” function. Note that you should work on a copy of the track! For more information, see “Using “Scores Notes To MIDI”” on page 572.

Optimizing rests
If you have a number of consecutive empty bars, you can replace them with one multiple rest, see “Multiple rests” on page 667.

Zero system lines
Having no system lines at all might seem like a stupid idea to start with. But this option allows you to create chord sheets really quickly, see “Using Make Chord Symbols” on page 642.

Examples and scales
If you are creating scale examples and similar, you can use the Real Book option and manually hide all symbols at the beginning of the first staff to make the score appear like separate unconnected “lines”.

Remember you can also hide the bar lines.

Controlling the order and appearance of grace notes
Normally, grace notes are beamed. Their order under the beam is controlled by their order in the track. It is enough to put a grace note one tick before the next grace note to make them appear in the desired order under the beam.

Initially the grace notes are put in with a 32nd note beam. By double-clicking the note and changing the “flag” type in the Set Note Info dialog, you can change this.

Complex grace notes

Speeding up inserting key changes
If you have a grand staff with many instruments, inserting key changes one by one can take a lot of time.

In this case, activate “Key changes for the entire Project” on the Key context menu or in the Score Settings dialog, on the Project–Notation Style subpage (Keys category). This way, all changes made to the key always affect the entire project.

Speeding up inserting staccato and accents
Symbols linked to notes can also be put in for a number of notes at the same time, even on different staves, see “Adding a symbol to several notes using the Pencil tool” on page 622.

Setting the distance between staves in a piano score
Drag the first bass staff on the first page. This copies the spacing to all staves. Please note that this can only be done in Page Mode.

Frequently asked questions
In this section, you can find some answers to questions concerning adding and editing of notes as well as the handling of symbols and layouts.

I enter a note with one value and it is shown as a note with another value.

Set the Rests value for Display Quantize to a smaller note value. Try deactivating Auto Quantize, especially if you do not have any triplets or triplets only.

Notes are not displayed at the correct positions.
Try changing the Notes value for Display Quantize.
There are a number of short rests after my notes.

Your Rests value for Display Quantize might be set to too small a note value. Raise it. Also check the “Clean Lengths” setting.

When I change the length of a note, nothing happens.

This is because the Display Quantize value puts a restriction on what note values can be displayed. Check that Display Quantize is set to the smallest note value you have in your project.

I have adjusted Display Quantize and the other staff settings best I can. The notes are still shown with the wrong values.

You might need to use one of these three features: inserting Display Quantize events, using polyphonic voicing, or applying “Scores Notes To MIDI”.

In the Score Settings dialog, I change the Display Quantize settings on the Staff page (Main subpage) and nothing happens.

Did you remember to click Apply? Maybe you have already inserted Display Quantize events in the score? These override the staff settings.

Suddenly many Display Quantize events appear in the score.

This is not a malfunction. If you had Auto Quantize on and start inserting Display Quantize events, the auto quantizing is automatically transformed into Display Quantize events.

One long note is shown as many tied notes.

Do other notes occur at the same positions but with different lengths? Then you need to use polyphonic voicing. Are the note(s) syncopated? Then you should try the syncopation feature.

Even though I’ve tried the above, notes are not tied as I want them.

The way notes are tied in Cubase follows basic notation rules. You may need to make exceptions to these rules, by using the Cut Notes tool.

I have an unnecessarily large amount of rests.

Especially with polyphonic voicing, superfluous rests may be created. Try deactivating rests for one or more voices. You might also leave the rests activated in the Score Settings dialog on the Staff page (Polyphonic tab) and then hide the rests you do not need, one by one.

When using polyphonic voices, a number of rests are drawn on top of each other.

As above, you should try hiding rests in the Score Settings dialog on the Staff page (Polyphonic tab), center rests and possibly manually moving or hiding rests.

In polyphonic voices, notes that are on the same musical position are not displayed exactly vertically above each other.

This is not a malfunction. Cubase has built-in automatic algorithms for making the score as legible as possible. Sometimes this includes adjustments of the “graphic” position of notes, especially with small intervals like seconds. You can always move the notes using the Layout tool.

When using polyphonic voices, notes with small intervals “collide”.

As described above, Cubase tries to avoid this, but only for voices 1 and 2 in the upper staff and voices 5 and 6 in the lower. For other voices, please use the Layout tool to manually move the notes.

When I select a note, nothing is shown on the info line.

The note is probably tied to another note. This means that the second note does not really exist, it is just a graphic indication that the main note is long. Try selecting the main note instead.

Symbols from the Layout Symbols tab are sometimes invisible when I open the score.

This is not a malfunction. Those symbols are part of a layout. If you open the score with another layout, for example because you open another combination of tracks, you can see another layout which might not contain any Symbols at all. See the chapter “Working with layouts” on page 655 for details.
I can't select an object on the screen, or I can't select an object without selecting another object.

Drag a selection rectangle around the objects. Then hold down [Shift] and deselect all the objects you do not want included, by clicking on them. You should also check out the lock layer function.

Symbols have disappeared.

Are they layout symbols? Then maybe they belong to another layout than the one you are editing now.

If that is not the reason, maybe you have inserted the symbol into the wrong staff, see "Important! – Symbols, staves, and voices" on page 621.

A symbol doesn't move with its staff. Auto Layout produces far too wide spacing.

Maybe you have inserted the symbol into the wrong staff. Please observe the warning in the section "Important! – Symbols, staves, and voices" on page 621.

A note symbol appears too far from the note I wanted it inserted on.

Do you have activated the correct voice? Note symbols are inserted into voices, just like notes.

The note I recorded is displayed with the wrong length. For example, I recorded a sixteenth and got a quarter note.

You probably have the wrong Display Quantize value set. Open the Score Settings dialog and select the Staff page. If Auto Quantize is activated, deactivate it, unless you have mixed triplets and regular notes. Also check the Notes and Rests Display Quantize values. If the settings are too "coarse", change them to a smaller note value. If you for example need the program to display an eighth note rest, Rests Display Quantize must be set to "8" or a smaller value (please refer to the chapter "How the Score Editor works" on page 551). If No Overlap is activated, you might want to turn it off.

There is a pause after a note that I don't want.

You probably added a note with the wrong note value. Either lengthen the note (physically or graphically – see "Changing the length of notes" on page 582) or delete the one you have (see "Deleting notes" on page 585) and add a new one with the correct note value. If this problem occurs a lot in your score, try selecting a larger Rests Display Quantize value (see “Using Rests as Display Quantize setting” on page 554).

There is no pause after the note although there should be one.

Either the note is too long (use Clean Lengths or change the current note's length), or Rests Display Quantize is set to too high a value. Open the Score Settings, select the Staff page and lower the value.

The note has an accidental when it shouldn't, or it doesn't when it should.

Maybe the note is simply of the wrong pitch? Click on it (using the Object Selection tool) and look at the info line (if this is not shown, see “The info line” on page 560). Move it to the correct pitch (see "Editing pitches of individual notes" on page 581). If this is not the reason, maybe you have the wrong key set? And finally, you can also use enharmonic shifting (see "Accidentals and enharmonic shift" on page 606).

Notes are not grouped under beams the way I want it.

Normally the program groups eighth notes, sixteenths, etc. under beams. This can be deactivated. There is also detailed control of which notes are grouped under a beam. This is described in the section “Handling beaming” on page 608.

If you wish you had a faster computer

Here are some tips for those who find some operations slower than they would like:

- Work on a smaller section of the score at a time. Break the project up into parts and work on those parts individually until the final layout stage.
- Switch on multi-rests as late as possible.
- When working in Edit Mode, set Default Bars Across The Staff to a small value, for example 2.
- In Edit Mode, resize the window so that only one grand staff at a time is visible.
- Consider upgrading your computer hardware.
A

Accelerando 610
Accents
  Above Staves 622
  Above Stems 622
Accidentals
  About 606
  Distance from note 607
ACID® loops 272
Acoustic Feedback 381
  Sample Editor 267
  Score Editor 580
  VariAudio 290
Activate Project button 50
Adapt (Display Quantize) 589
ADAT Lightpipe 496
Advanced Quantize 110
AES/SPDIF Digital Audio 496
Aftertouch
  Deleting 392
  Editing 390
  Recording 103
AIFF files 489
Algorithms
  Sample Editor 271
  Time stretching 259
Align
  Dynamics 635
  Text 647
All MIDI Inputs 21
Appearance 536
  General 536
  Meters 537
Apple Remote 347
Arranger mode 685
Arranger tracks
  Adding 125
  Creating a chain 126
  Flattening 128
  Renaming events 125
Articulations
  Auditioning 420
  Editing on the controller lane 423
  Editing on the info line 423
ASIO
  Direct Monitoring 20, 97
  DirectX Setup 18
  Meter 24
  Ports
    Use for data only 505
  Aspect ratio
    Video Player window 515
Attributes
  About 323
  Defining 326
  Editing in the MediaBay 324
  Managing lists 326
  Marker 140
Audio
  Detecting the tempo 473
  Record modes 98
  Slicing 279
Audio buffer size 23
Audio channels
  Copying settings 161
  Mixing down to file 485
  Saving settings 163
Audio clips
  About 245
  Creating new versions 302
  Definition 58
  Deleting 303
  Locating events 303
  Managing in Pool 302
  Opening in the Sample Editor 306
Audio clock
  About 496
Audio effects
  About 188
  Applying 253
  Editing 200
  External 200
  For output busses (Master inserts) 192
  Freezing 194
  Inserts 189
  Organizing in subfolders 204
  Post-fader inserts 189
  Pre/Post-fader sends 197
  Recording with 98
  Saving 201
Selecting presets 201, 214
Sends 196
Surround 218
Tempo sync 189
Using VST System Link 507
Audio events
  Create from regions 271
  Create parts 75
  Definition 98
  Editing in Browser 479
  Editing in Sample Editor 262
  Editing selections 269
  Fade handles 118
  Making selections 268
  Show in Sample Editor 263
  Slicing 279
  Volume handles 119
Audio files
  Adjusting to the project tempo 273
  Converting 309
  Deleting permanently 303
  Exporting 485
  Format for recording 92
  Formats 306
  Importing into Pool 306
  Importing into Project window 74
  Locating 305
  Minimize size 308
  Reconstructing missing 305
  Removing missing 306
Audio hardware
  Connections 15
  Externally clocked 18
  Setup application 17
Audio loops
  Musical Mode 272
  Tempo matching 272
Audio parts
  About 38
  Creating by gluing events 63
  Creating from events 75
  Drawing 75
  Editing in Audio Part Editor 295
  Editing in Project Browser 479
  Sliding contents 64
AudioWarp
  Unstretch Audio 293
Auditioning
  Acoustic Feedback 267
  Audio Part Editor 296
  MIDI editors 381
  Pool 306
  Project window 58
  Sample Editor 267
  Speaker tool 287
  Using key commands 267, 296
Auto fades
  Global settings 122
  Track settings 123
Auto Layout
  About 672
  Hide empty staves 673
  Move bars 673
  Move staves 673
Auto Quantize 103, 589
  Score Editor 414
Auto Save 52
Automation
  Auto-Latch mode 236
  Cross-Over mode 236
  Delta indicator 229
  Editing in Project Browser 481
  Follow events 234
  Merging part and automation data 241
  MIDI Controller 241
  Opening automation tracks 232
  Showing and hiding 232
  SurroundPanner V5 225
  Tempo 466
  Touch mode 236
  Trim 236
Automation curves
  Editing 231
Automation events
  About 228
  Editing 230
  Removing 231
  Selecting 230
Automation tracks
  Assigning parameters to 232
  Hiding and showing 233
  Muting 234
  Auto-Scroll 47
  Marker window 140
  MIDI editors 380
  Project window 47
  Sample Editor 263
  Score Editor 558
B
  Back up Project 52
  Backup (.bak) files 52
  Bank assignments 359
  Bar handles 631, 689
  Bar lines
    Breaking 674
    Indent 670
    Moving 670
    Selecting type 667
  Bar numbers
    Offsetting 654
    Settings 653
    Spacing 653
  Bars
    Moving 673
    Moving to next/previous staff 669
    Number across page 669
    Resetting spacing 670
  Batch export
    Audio channels 485
  Beams 609
  Across staves 611
  Appearance 612
  Group settings 611
  Grouping 608
  Manual adjustment 612
  On/Off 608
  Slant 612
  Stem direction 604
  Beat Calculator 468
  Bezier slurs 624
  Bit resolution
    Recording 92
  Block text 650
  Bounce (Export Audio) 485
  Bounce MIDI 370
  Bounce Selection
    Pool 307
    Project window 66
    Sample Editor 270
  Box symbol 637
  Braces 672
  Bracket heads 607
  Brackets 672
  Brightness 537
  Brillenbass 609
  Broadcast Wave files
    Exporting 490
    Recording 92
  Busses
    About 26
    Adding 28
    Child busses 29
    Mixing down to file 485
  Bypass
    AudioWarp 290
    Effect sends 197
    Inserts 190
    Pitch changes 290
    SurroundPanner V5 225
C
  Channel Overview
    Insert effects 191
  Channel Settings windows
    Customizing 534
  Channels
    MIDI 100
    Chase events 87
    Child busses 29
    In surround configuration 219
  Chord symbols
    Global settings 643
    Inserting manually 641
    Cleanup 53, 522
  Clefs
    Editing 585
    Inserting 584
    Moving 585
    Selecting automatically 564
    Setting initial 562
    Setting up 414
| Click button 106                | Controller display  
|--------------------------------|-------------------  
| Clips, see "Audio clips"      | About 379         696  
| Clock sources 496             | About lanes 388    538  
| Close project 50              | Controller lane presets 390  
| Color tool                    | Editing events 390  
| Project window 538            | Editing velocity 393  
| Colors                        | Selecting event type 389  
| Assigning to MIDI notes 608   | Controller lanes  
| MIDI editors 382              | Adding 389         310  
| Project window 538            | Removing 389       15  
| Tracks 72                     | Controllers        20  
| Comping 77                    | Deleting 392       371  
| Conforming                    | Editing 390        
| Files 310                     | Recording 103      216  
| Connecting                    | Copy               77  
| Audio 15                      | Notes in score 580  
| MIDI 20                       | Symbols in score 633  
| Constrain Delay Compensation 216 | Count-in 106      52  
| Context menus                 | CPR files 50       335  
| Opening 13                    | Crescendo          186  
| Control Room                  | Drawing 635        379  
| About 173                     | Flipping 635       
| Configuring 173               | Keeping horizontal 635  
| Disabling 176                 | Crop 68            50  
| Exclusive port assignment 175 | Crossfades         78  
| Features 173                  | Creating 121       77  
| Main Mix 181                  | Editing in dialog 121  
| Operations 173                | Equal Gain 122     173  
| Overview 185                  | Equal Power 122    
| Preferences 182               | Presets 122        28  
| Suggested settings 181        | Removing 121       173  
| Control Room channels         | CSH files 52       
| About 174                     | Cue notes 614      174  
| Creating 174                  | Cut                
| External inputs 174, 180      | Notes in score 580  
| Inserts 180                   | Cut Notes tool 613  
| Monitors 174, 181             | Cut Time 68        180  
| Phones 174                    | Cutflag events 613  
| Studios 174                   | Cycle              174  
| Talkback 175, 181             | About 85           177  
| Control Room Mixer            | Cycle markers      177  
| Configuring 180               | About 139          182  
| Overview 177                  | Drawing 142        180  
| Studio Sends 182              | Editing with tools 139  
| Cycle recording               | Resizing 142       180  
| D                             | Using 139          216  
| Damper pedal symbols 636      | Zooming 139        
| DC Offset                     | Cycle recording    
| Removing 251                  |   
| Delay compensation            | Audio 92           50  
| About 189                     | MIDI notes 102     310  
| Constraining 216              |   
| Delete                        |   
| Audio files from disk 303     |   
| Continuous Controllers 371    |   
| Controllers 371               |   
| Doubles 371                   |   
| Events in Project window 66   |   
| MIDI controllers 371, 392     |   
| MIDI drum notes 399           |   
| MIDI notes 386                |   
| Notes 371                     |   
| Notes in score 585            |   
| Score symbols 633             |   
| Delete Overlaps               |   
| Audio 78                      |   
| Mono (MIDI) 372               |   
| Poly (MIDI) 372                |   
| Detect Silence 256            |   
| Deviation (Display Quantize) 589 |   
| Device panels                 |   
| About 362                     |   
| Inspector 40                  |   
| Mixer 156                     |   
| Device ports                  |   
| Selecting for busses 28       |   
| Setting up 27                 |   
| Diminuendo                    |   
| Drawing 635                   |   
| Keeping horizontal 635        |   
| Direct Monitoring             |   
| Control Room 186              |   
| Disk meter 24                 |   

696

Index
Display Quantize 413
   About 553
   Auto 589
   In polyphonic voices 599
   Rests 554
   Tool 554, 571
Display Transpose
   About 414, 591
   Disable 566
   Dithering 193
Drawing
   In Sample Editor 268
   MIDI controllers 390
   MIDI notes 382
   MIDI parts 75
Drum Editor
   Creating and editing notes 398
   Muting drum sounds 399
   Selecting drum maps 401
Drum maps
   About 400
   Editing in score 678
   Making settings 400
   MIDI channel and output 401
   Selecting 401
   Setup dialog 402
Drum name lists 403
Drum notes
   About 677
   Adding and editing 679
   Head pairs 678
   Setting up staves 679
   Single line 679
Drumstick tool 398
Duplicate
   Events and parts 61
   MIDI notes 385
   Notes in score 580
Dynamics symbols
   Adding 635
   Explode 572
   Export audio mixdown 485
      Audio engine settings 488
      Channel Selection 486
      File Naming 486
      In realtime 488
   Exporting
      Markers 143
      Markers as track archive 144
      MIDI files 527
      OMF 525
      Score as image files 566
      Selected tracks 529
      Tempo track 467
   Expression maps
      About 420
      Creating 424
      Drum Editor 422
      In-Place Editor 422
      Key Editor 422
      List Editor 423
      Loading 421
      Score Editor 422
   External effects 200
      About 30
      Favorites 33
      Freezing 33
      Missing plug-ins 33
      Setting up 30
   External instruments
      About 30
      Favorites 33
      Freezing 33
      Missing plug-ins 33
      Setting up 32
   Extracting
      Audio from Video 516
      Audio from video 524
      Audio to MIDI (VariAudio) 291
      MIDI Automation 373
      Voices 602

E
   Edit button
      Audio channel strips 158
      Audio track Inspector 40
      MIDI channel strips 166
      MIDI track Inspector 349
   Edit groups 80
   Edit In-Place 396
   Edits folder 245
   élastique algorithm
      About 259
   Enharmonic Shift 417
      Manual 606
   Envelope
      Process 246
      Realtime 123
   EQ
      Bypassing 161
      Making settings 159
      Presets 161
   Equal Gain
      Crossfades 122
   Equal Power
      Crossfades 122
   Erase tool
      Breaking bar lines in score 674
      Deleting notes in score 585
      Project window 66
   Events
      Audio 58
      Creating from hitpoints 280
      Duplicating 61
      Envelopes 123
      Grouping 64
      Locking 65
      Moving 61
      Muting 66
      Overlapping in Project window 61
      Removing 66
      Renaming 62
      Resizing 63
      Resizing with time stretch 64
      Selecting 59
      Selecting automatically with project cursor 60
      Sliding contents 64
      Splitting 62

697
Index
F
 Fade handles 118
 Fade In/Out functions 119
 Fades
   Auto fades 122
   Creating 118
   Editing in dialog 120
   Presets 120
   Processing 119
   Removing 119
   With Range Selection tool 118
 Fill Loop 62
 Filter bar
   List Editor 404
 Filtering
   MIDI in Project Browser 481
   MIDI messages 105
 FireWire DV Output 511
 Fit Page/Width 558
 Fixed Lengths 371
 Fixed Stem Length 592
 Fixed Tempo 463
 Fixed Velocity 373
 Flat Ties 614
 Flip
   Crescendo 635
   Slurs and Ties 633
   Stems 417, 604
 Folder parts 79
 Folder tracks
   Creating 79
   Group editing 80
   Hiding/showing data 79
   Moving tracks into 79
   Muting and soloing 79
   Working with 79
 Fonts 654
   Score 647
 Frame count 495
 Frame rates
   Mismatch 512
   Synchronization 495
 Video 512
 Free Warp
   About 275
 Freezing Edits 255
 MIDI Quantize 111
 Tracks 194
 VST instruments 211
 FX channel tracks
   About 194
   Adding effects for 195
   Mixing down to file 485
   Routing sends to 196
   Setting up 29, 195
 Gain 247
 Generic Remote Device 345
 Glue tool
   MIDI editors 386
   Project window 63
   Score Editor 417
 Gluing staves 669
 Grace notes
   Converting to normal 616
   Creating manually 615
   Order of 690
   Settings 615
 Groove quantizing 111
 Group channels 165
 Grouping
   Events 64
   Removing in score 610
   Repeats 609
 Grouping notes
   Accelerando 610
   Beam 609
   Brillenbass 609
   Ritardando 810
   Guitar chord symbols 625
   Guitar library 626
 Hardware setup
   Control panel (Mac) 18
   Control panel (Win) 18
 Hiding
   Empty staves 673
   Objects 666
   Pedal markers 636
 Hitpoints
   About 276
   And tempo settings 279
   Beats pop-up menu 277
   Create events 280
   Create markers 280
   Create regions 270, 280
   Detecting 277
   Filtering 277
   Slicing audio 279
 Image files
   Inserting in Score Editor 627
 Importing
   Audio CDs 307
   Audio from video file 524
   Markers 143
   Markers as track archive 144
   Media files in Pool 306
   MIDI files 527
   MPEG files 525
   Ogg Vorbis files 525
   OMF 525
   REX files 524
   Tempo track 467
   Track archives 529
   Video files 511
   WMA files 525
 Independent track loop
   Audio Part Editor 297
   MIDI editors 381
   Indicate Transpositions 135
MIDI notes
Assigning colors 608
Deleting 386
Display Length 582
Drawing 382
Duplicating 580
Editing velocity 393
Grouping automatically 611
Grouping in score 608
Head shape 606
Insert velocity 383
Ledger lines 607
Moving 384, 579
Moving graphically 614
Muting 386
Muting in Drum Editor 399
Resizing 385
Selecting 383
Selecting in score 578
Splitting 582
Splitting and gluing 386
Transpose (function) 367
Transposing (in editor) 384
MIDI outputs
In drum maps 401
Renaming 101
Selecting for tracks 101
Send effects 354
MIDI parts
About 38
Drawing 75
Editing 375
Editing in Project Browser 480
Showing borders 376
Sliding contents 64
MIDI ports
Setting up 21
MIDI reset 104
MIDI Thru
Activating 100
Preference 20
MIDI timecode
Destinations 499
MIDI tracks
Channel Settings window 166
MIDI Modifiers 350
Settings 349
Missing files
Removing 306
Missing Ports dialog 50
Mixer
Audio channels 155
Channel strip width 151
Channel types 147, 149
Channel view sets 151
Common panel 149
Extended channel strips 148, 149
Initialize channels 162
Input gain 153
Input phase 153
Input/Output channels 147
Link/Unlink channels 167
MIDI channels 166
Multiple mixer windows 146
Opening 146
Panning 156
Saving settings 163
Solo and Mute 153
View options 150
Volume 152
MMC Master panel 498
Modifier keys 13, 545
Monitor button
Audio tracks 96
MIDI tracks 100
Monitoring
About 19
Modes 96
Mouse Note Position display 575
Mouse Time Position display 575
Moving
MIDI notes in score 579
Objects graphically 614
Staves 670
Tracks to new folder 79
Using key commands 579
MP3 files
Exporting 490
Importing 525
MPEG files 525
MPEX algorithm
About 259
Pitch Shift 249
Multi processing 24
Multi-channel tracks
Export 485
Multi-Rests
Creating 667
Option 664
Settings 667
Splitting 667
Musical Mode
About 272
Adjusting audio loops 272
Pool 272
Musical time base 74
MusicXML
About 560
Exporting 662
Importing 661
Mute
Events in Project window 66
MIDI notes 386
Mixer 153
Pre-Send 197
Surround channels 222
Tool 66
Tracks 66
N
Noise Gate 247
Normalize
Audio effect 248
Note Expression
About 429
Editing data 434
MIDI controllers 429
Overdubbing 432
Recording 432
Recording via MIDI 433
Setting up parameters 430
VST3 controllers 429
Note layer symbols 619
About 619
Adding 622
Note length
Changing in Score Editor 582
Note symbols
Adding 622
Resizing 632
Notes
Editing via MIDI 387, 581
NPL files 309
Nudge buttons 86
MIDI editors 384
Project window 61
Nudge key commands 631
Nudging notes 579
Numeric keypad 83

Octave symbols 636
Offline Process History 254
Offline processing
VariAudio 282
Ogg Vorbis files
Exporting 490
Importing 525
OMF files 525
O-Notes 400
Opening projects 50
Output busses
About 26
Adding 28
Default 28
Mixer 147
Mixing down to file 485
Surround 219
Output ports 19
Output selection
Multiple audio channels 164
Multiple MIDI channels 101
Outputs
Audio 27
MIDI 100
Overlapping events
Project window 61

Page text 650
Panning
Bypass 158
Multi-channel audio 157
Stereo Pan Law 157
Stereo pan modes 157
Parabola mode
Automation 230
MIDI controllers 391
MIDI velocity 393
Parts
Dissolving (MIDI) 369
Editing the active part only 376
Parts/events in selection range 68
Paste
Events at origin 62
Note attributes 608
Notes in score 580
Symbols in score 633
Paste Time
MIDI editing 385
Selection ranges 68
Patch Banks 359
Pattern banks
Previewing in MediaBay 320
Peak Hold Time (option) 162
Pedal symbols 636
Pedals
To note length 372
Pencil tool 75
MIDI parts 75
Score Editor 622
Phase Reverse 248
Piano staves
Fixed split point 583
Variable split point 596
Pitch & Warp tool
Sample Editor 285
Pitch changes
Disabling in Sample Editor 290
Pitch Shift (function) 249
Pitch shifting
Algorithms 259
Pitchbend
Deleting 392
Editing 390
Recording 103
Play tool
Project window 58
Plug and Play
ASIO devices 17
Plug-in delay compensation 189
Plug-in Information window
MIDI plug-ins 355
VST plug-ins 204
Plug-ins
Applying 253
Getting info 204
Installing VST 2.x 203
Organizing 204
RAM limitation 23, 188
Surround 218
Poly Pressure events 394
Polyphonic voicing
About 594
Automatic 601
Crossed voicings 600
Display Quantize 599
Entering notes 597
Identifying voices for notes 597
Moving notes to voices 598
Presets 596
Rest handling 599
Setting up 595
Stem direction 604
Polyphony
Restricting 372
Pool
About 300
Auditioning 306
Converting files 309
Duplicating clips 302
Handling audio clips 302
Import media files 306
Importing Pool files 309
Locating missing files 305
Record folder 308
Search functions 304
Position cursor 357
Position Info window 630
Position markers
About 139
Post-roll 105
Pre/Post-Crossfade 246
Precount 106
Pre-fader sends 197

702
Index
Index

Reverse (audio processing) 252
Reverse (MIDI function) 373
ReWire
   About 518
   Activating 519
   Channels 520
   Routing MIDI 520
REX files 524
Ritardando 610
Root key
   Setting for unassigned events 133
Routing
   Effect sends 196
   Effect sends (Panning) 197
   For surround setup 219
   Group channels 165
Ruler 561, 630
   About 44
   Additional time scales 45
   Ruler tracks 45
   Sample Editor 265
S
   Sample Editor
      Audio clip information 264
      Audition 267
      Auditioning 267
      Auto Adjust 273
      Auto-Scroll 263
      Free Warp 275
      Info line 264
      Inspector 264
      Manual Adjust 274
      MIDI Input function 288
      Musical Mode 272
      Opening 282
      Overview line 265
      Regions 270
      Ruler 265
      Show Audio Event (button) 263
      Snap function 263
      Tempo matching audio 272
      Toolbar 263
      Zooming 286
   Sample rate 55
   Externally clocked 18
   Saving
      Project as new version 51
      Projects 50
   Scissors tool
      MIDI editors 386
      Project window 62
   Score Editor 417, 582
   Score 590, 669
      Adding notes 576
      Bows 607
      Composite signatures 563
      Creating chord symbols 642
      Deleting notes 585
      Display markers 658
      Displaying 413
      Ending symbols 637
      Explode function 572, 598
      Extended toolbar 560
      Force screen redraw 567
      Gluing notes 582
      Grouping signatures 609
      Hiding stems 607
      Layers 619
      Layout layer symbols 619
      Lock (L) button 579
      Lock layers 628
      Merging staves 601
      No Flag/Beam 607
      No Overlap 590
      Note info dialog 605
      Notes to MIDI 572
      Offsetting bar numbers 654
      Page number indicator 558
      Page setup 559
      Page text 650
      Repeat note groups 609
      Repeat symbols 636
      Selecting note values 575
      Setting the number of bars 669
      Split staves 413
      Staff modes 413
      Staff spacing 689
      Stem length 605
      Score Drum Map
         About 677
         Initializing 678
         Setting Up 677
   Score settings
      About 574
      Switching staves 574
      Values for note input 574
   Score symbols
      Adding 623
      Adding to notes 622
      Aligning 633
      Creating 638
      Deleting 633
      Duplicating 629
      Guitar chords 625
      In palettes 621
      Length 632
      Moving 629
      Moving with keyboard 631
      Note layer symbols 619
      Note-dependent 619
      Relation to staves/voices 621
      Resizing 632
      Selecting 628
   Scrolling 558
   Scrubbing
      Events in Project window 59
      Events in Sample Editor 267
      Project 86
   Segments
      Changing note start/end point 284
      Cutting segments 284
      Deleting 285
      Gluing 284
      Moving horizontally 285
      Saving the segmentation 285
      VariAudio 283
   Select tool
      Show Extra Info 38
Selecting

Events in Project window 59
MIDI notes 383
MIDI notes in score 578
Send effects (Audio) 194

Sends

Disabling 197
Set Note Info dialog 607
Shared copies 62
Shuffle 590
Side-Chain

Drag & drop 200
Using 198
Signal levels 94
Silence 252
Sine mode

Automation 230
MIDI editing 391

Slices

About 276
Creating 279

Slurs

Adding 623
Bezier slurs 624
Inserting 624
Shape and direction 633

Snap

MIDI editors 381
Project window 45
Sample Editor 263
Zero crossings 47
Zero crossings (Sample Editor) 263
Snap modes 579
Snap point

Setting for clips in Pool 306
Setting in Project window 45
Setting in Sample Editor 268
Snap to Zero Crossing

Audio Part Editor 298
Snap types 46

Solo

Audio Part Editor 296
Folder tracks 79
MIDI editors 380
Mixer 153
Surround channels 222
Tracks 66
Solo Defeat 154

Sound sources

Position in surround field 221
Speaker icon

MIDI editors 381
Score Editor 580
Speaker tool

Audio Part Editor 296
Project window 58
Sample Editor 267
Spectral bass 609
Spectrum Analyzer 257
Split tool 669
Splitting

Staves 583
Splitting

Events 62
Range 68
Square mode

Automation 230
MIDI editing 391
Staff settings

About 570
Score display 413
Switching staves 587
System sizes 592
Startup options 54
Static value line (automation) 228
Statistics 259
Status line

Drum Editor 397
Key Editor 378
List Editor 404
Project window 43
Score Editor 560
Score Editor (basic) 411

Staves

Active staff 412, 559
Changing the split point 583
Displaying staff names 653
Long and short names 653
Moving 670, 673
Options 591
Preset 587
Size 665
Spacing 689
Split staves 413

Stem direction

About 804
In polyphonic voices 604
Manual flip 604
Set Note Info dialog 607
Step Input 388
Stereo Flip 252
Stereo Pan Law 157
Stereo panning 157
Strip Silence 257
Studio Connections 364
Studio Manager 364
Studio Sends

Adjusting the volume 184
Configuring 182
Cue mix 183
Outputs 185

Surround

About 218
Applying plug-ins 218
Automation 225
Disable speakers 222
Exporting to file 226
Inspector 220
LFE level 220, 224
Mixer 220
Output bus configuration 219
Panning 223
Routing 219
Setup 16
Solo/Mute speakers 222
Supported configurations 218

SurroundPanner V5

About 220
Constant power 226
Suspend Auto-Scroll 47

705
Index
Swing
Quantizing 113
Sample Editor 275
Symbol palettes
About 560
Available symbols 621
Customizing 621
Displaying 620
Moving and handling 621
Symbols Inspector
Customizing 620
Sync Selection 479
Synchronization
About 494
Operation (Sync mode) 500
Recording in Sync mode 91
Setting up 496
Speed references 496
Timecode 494
Timecode preferences 497
Timecode source 497
System Exclusive
About 407
Bulk Dumps 407
Editing 409
Recording parameter
changes 409
T
Tablature
Automatic Creation 681
Capo 681
Clef 682
Editing 683
Manual creation 682
MIDI channels 681
Tap Tempo 468
Templates 51
Default 51
Tempo
About 463
Analyzing 474
Calculating 468
Correcting the detected tempo 474
Detection 473
Editing 465
Editing in Project Browser 482
Importing and exporting 467
Matching audio to tempo 272
Setting in Fixed mode 466
Symbols 638
Tapping 468
Write definition to files 476
Tempo changes
Recording 466
Tempo editing
Process bars 467
Process tempo 467
Text
Adding 646
Aligning 647
Block text 650
Editing 647
Font, size and style 647
Importing from file 650
Lyrics 648
Regular 648
Text Attribute Sets
About 647
Creating 647
Using 647
Thumbnails
About 513
Thumbnail cache files 513
Ties
About 577, 612
Adding as symbols 623
Cut Notes tool 613
Direction 607
Dynamics 632
Flat 614
Shape and direction 633
Splitting 582
Time display 84
Time formats 44
Time signature
Editing 585
Inserting 584
Modern 685
Time signatures
About 463
Composite 563
Editing 466
For grouping 563
Setting initial 562
Signature track/Tempo Track Editor 563
Time stretch (function) 252
Time stretching
Algorithms 259
Time Warp tool 469
Timecode
Standards 495
Synchronization 494
Tool modifier keys 545
Toolbar
Audio Part Editor 295
Customizing 534
Drum Editor 397
Key Editor 377
List Editor 404
Pool 300
Project window 42
Sample Editor 263
Score Editor 411
Track archives
Importing 829
Track controls
Customizing 535
Track list
About 39
Customizing 535
Dividing 81
Track presets
Previewing 333, 334
Removing 333
Track Quick Controls 347
About 338
Assigning parameters 339
Controlling the Mixer 340
Remote control setup 339
Removing 339
Renaming 339
Replacing 339
Track types 37
Tracks
Adding 72
Adding events 74
Audio channel configuration 93
Coloring 72
Default time base 74
Disabling 76
Disabling/Enabling 86
Duplicating 75
Folding 76
Freezing 194
Importing/Exporting 529
Locking 65
Moving 76
Musical/Linear time base 74
Naming 72
Record-enabling 90
Removing 72
Selecting 75
Soloing 66
Transcription 569
Transferring
Projects and settings 539
Transformer (MIDI effect) 441
Transport menu
Functions 83
Playback options 87
Transport panel
Customizing 534
Display format 84
Hiding and showing 83
Key commands 83
Overview 83
Transpose
Info line 44
MIDI function 367
MIDI Modifier 350
Transposing track
About 132
Transposing
Instruments 565
MIDI notes 581
Triangle mode
Automation 230
MIDI editing 391
Trills
Creating 624
Trim buttons 64
Trim tool 380
Tuplets 616
Display Options 617
Group Symbols 636
N-Tuplets 617
Quantizing 113
U
Undo
Processing 254
Recording 98
Ungroup
Events 64
Unlock Record 107
Unstretch Audio 293
Upbeats 668
Update Origin 301
User panels 40
Audio tracks 156
V
VariAudio
About 281
Applying editing 282
Audition 290
Bypass 290
Changing the pitch 285
Changing the timing 288
Editing segments 283
Extract MIDI 291
Quantize Pitch 286
Reset 290
Segments 281
Straighten Pitch 287
Tilting micro-pitch curves 286
Waveform display 281
Velocity
Editing 393
Editing via MIDI 388
Info line 44
MIDI function 372
Velocity compression 351
Velocity shift 351
Verses (Lyrics) 649
Video
Codecs 510
Device Setup 514
Editing 516
Extracting audio from 516
Formats 510
Frame numbers 513
Importing 511
Muting 513
Output devices 511
Playback 514
Replacing audio 516
Scrubbing 515
Thumbnails 513
Video Player window 514
Aspect ratio 515
Setting the video quality 515
Setting the window size 515
Video track
Editing in Project Browser 482
Virtual Keyboard
About 88
Computer keyboard display 88
Description 88
Modulation 88
Note velocity level 88
Octave Offset 88
Piano keyboard display 88
Pitchbend 88
Voices
About 594
Converting to tracks 602
Display Quantize 599
Moving Notes To 598
Volume curve 123
Volume handle 119
VST
Input ports 19
Output ports 19
VST 3
Suspend plug-in processing 188, 212
VST Audio System 17
VST Channel Settings 158
VST Connections 26
   About 26
   Editing 34
   Exclusive port assignment 175
   Presets 29
   Studio tab 174
VST instruments
   Activating 208
   Browsing for sounds 213
   Channels 208
   Freezing 211
   Presets 212
   Saving presets 215
   Setting up 207
   Using VST System Link 507
VST Performance window 24
VST plug-ins
   Getting info 204
   Installing 203
VST presets
   Removing 333
VST System Link
   About 501
   Activating 503
   Connections 501
   Latency 502
   MIDI 505
   Putting computers online 504
   Requirements 501
   Setting up sync 502
   Settings 503

W
Warp tabs
   Editing 276
   Reset 276
Warping segments
   VariAudio 288
   Wave 64 files 490
   Wave files 490
   Waveform display
   Sample Editor 266
   Waveform zooming 56
   Window layouts 532

Windows Media Audio files
   Exporting 491
   Importing 491, 525
   Surround format (Pro) 491
Word clock
   About 496
   Workspaces 532
   Wrap Controls (track list) 73

Z
Zero crossings
   Snap function 263
Zoom 558
Zooming
   About 56
   History 57
   Horizontal only 56
   Mouse wheel 559
   Pop-up menu 558
   Presets 56
   Sample Editor 266
   To cycle markers 139
   Tool 559
   Undo/Redo 57
   Waveforms 56

W